QuickBooks Point of Sale
Retail Management Software

Easily track inventory, customers & sales

User’s Guide Version 7.0
## Contents

### Section I: Point of Sale Basics

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Point of Sale Overview</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose of This Guide</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>What POS Does for Your Business</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Installation and Setup</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>Hardware Setup Wizard</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Working with Company Data Files</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Help and Learning Tools</td>
<td>18</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 2</th>
<th>Point of Sale Fundamentals</th>
<th>25</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>Lists and Forms</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>Locating Records or Documents</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>Working with History Documents</td>
<td>34</td>
<td></td>
</tr>
<tr>
<td>Temporarily Holding Documents</td>
<td>37</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 3</th>
<th>General Printing Information</th>
<th>39</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing in Point of Sale</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Printing Records or Documents</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>Printing Tags and Labels</td>
<td>43</td>
<td></td>
</tr>
<tr>
<td>Importing Print Templates</td>
<td>51</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 4</th>
<th>Employees</th>
<th>53</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employees Overview</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>Working with Employee Records</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>Tracking Employee Commissions (Pro)</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Employee Time Clock (Pro)</td>
<td>61</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 5</th>
<th>Data and Program Security</th>
<th>65</th>
</tr>
</thead>
<tbody>
<tr>
<td>Why is Security Important?</td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>Requiring Employee Logins</td>
<td>68</td>
<td></td>
</tr>
<tr>
<td>Working with Security Groups</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>Protecting Your Data</td>
<td>74</td>
<td></td>
</tr>
</tbody>
</table>
## Contents

### Section II: Data Entry

<table>
<thead>
<tr>
<th>Chapter 6</th>
<th>Data Entry Basics</th>
<th>85</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Entry Basics</td>
<td></td>
<td>86</td>
</tr>
<tr>
<td>Listing Items on Documents</td>
<td></td>
<td>91</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7</th>
<th>Lists, Forms and Filters</th>
<th>99</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Lists and Forms</td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>Using Filters in Lists and Reports</td>
<td></td>
<td>106</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 8</th>
<th>Importing and Exporting Data</th>
<th>117</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import/Export Overview</td>
<td></td>
<td>118</td>
</tr>
<tr>
<td>Importing Data from QuickBooks Financial Software</td>
<td></td>
<td>118</td>
</tr>
<tr>
<td>Importing Data from a Spreadsheet or Text File</td>
<td></td>
<td>124</td>
</tr>
<tr>
<td>Exporting Data</td>
<td></td>
<td>126</td>
</tr>
</tbody>
</table>

### Section III: Inventory

<table>
<thead>
<tr>
<th>Chapter 9</th>
<th>Inventory Overview</th>
<th>133</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Overview</td>
<td></td>
<td>135</td>
</tr>
<tr>
<td>Using Inventory Reminders</td>
<td></td>
<td>136</td>
</tr>
<tr>
<td>Viewing Item History</td>
<td></td>
<td>142</td>
</tr>
<tr>
<td>Inventory Ratings and Trends</td>
<td></td>
<td>146</td>
</tr>
<tr>
<td>Custom Inventory Fields (Pro)</td>
<td></td>
<td>147</td>
</tr>
<tr>
<td>Serial Number Tracking (Pro)</td>
<td></td>
<td>148</td>
</tr>
<tr>
<td>Printing Your Item List and Tags</td>
<td></td>
<td>149</td>
</tr>
<tr>
<td>Inventory Reports</td>
<td></td>
<td>151</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 10</th>
<th>Merchandise Departments</th>
<th>153</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Departments</td>
<td></td>
<td>154</td>
</tr>
<tr>
<td>Printing your Department List</td>
<td></td>
<td>160</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 11</th>
<th>Item Basics</th>
<th>161</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Overview</td>
<td></td>
<td>162</td>
</tr>
<tr>
<td>Adding Inventory Items</td>
<td></td>
<td>164</td>
</tr>
<tr>
<td>Using Service and Non-Inventory Items</td>
<td></td>
<td>173</td>
</tr>
<tr>
<td>Using Special Order Items (Pro)</td>
<td></td>
<td>174</td>
</tr>
<tr>
<td>Working with Existing Items</td>
<td></td>
<td>175</td>
</tr>
</tbody>
</table>
## Contents

### Chapter 12 Item Quantities, Cost and Price(s) .......................... 181
- Tracking Item Quantities .................................................. 182
- Handling Item Cost and Price ............................................. 189
- Price Manager ................................................................. 196

### Chapter 13 Item Styles, Assemblies, and Groups (Pro) ............ 211
- Working with Item Styles ................................................. 212
- Item Assemblies and Groups ............................................. 222

### Chapter 14 Inventory Counts and Adjustments ......................... 231
- Conducting Physical Inventory Counts ............................... 232
- Adjusting Item Costs and Quantities .................................. 243

### Section IV: Vendors and Purchasing ................................. 251

### Chapter 15 Vendors .......................................................... 253
- Working with Vendors ................................................... 254
- Printing/Exporting your Vendor List .................................. 262
- Using Multiple Vendors for an Item (Pro) ......................... 263

### Chapter 16 Purchasing Merchandise .................................... 265
- Purchase Order Overview ............................................. 266
- Working with Purchase Orders ........................................ 267
- Maintaining Purchase Orders ........................................ 273
- Printing Purchase Orders ................................................ 278
- Having Point of Sale Suggest Purchase Orders (Pro) ............ 279

### Chapter 17 Receiving Merchandise ................................. 281
- Receiving Overview ...................................................... 282
- Receiving Items .......................................................... 283
- Working with Receiving History ....................................... 295
- Printing from Vouchers ................................................... 300
Contents

Section V: Customers and Sales ......... 301

Chapter 18 Customer Records and History ....... 303
  Customer Overview ........................................ 304
  Working with Customers ................................ 305
  In-Store Charge Accounts ............................... 316
  Printing/Exporting Your Customer Records .......... 321
  Customer ID Numbers and Cards (Pro) ............... 322
  Customer Rewards Program (Pro) ...................... 323

Chapter 19 Sales and Tax Overview ............ 329
  Sales Overview ........................................... 330
  Receipt Basics ........................................... 332
  Opening the Cash Drawer .............................. 335
  Paying Money Out of the Cash Drawer (Pay-outs) .. 336
  Shipping Manager (Pro) ............................... 337
  Sales Tax Overview ..................................... 339

Chapter 20 Sales Transactions ................. 347
  Making a Sale ............................................ 348
  Listing a Customer on a Receipt .................... 357
  Receipt Price Levels and Discounts ................. 358
  Collecting Sales Tax .................................. 364
  Adding Shipping Information ......................... 365
  Recording Item Serial Numbers (Pro) ............... 370
  Tracking Sales Commissions (Pro) ................... 371
  Taking Payment and Giving Change .................. 372
  Recording Gratuities (Tips) ......................... 378
  Merchandise Returns and Exchanges ................. 379
  Printing Receipts and Gift Receipts ................. 380

Chapter 21 Receipt Payment Types ............. 381
  Overview .................................................. 382
  Payment by Credit, Debit or Gift Card .......... 382
  Payment by Check ...................................... 399
  Payment By or On Account ......................... 400
  Payment by or Sale of a Gift Certificate .......... 402
Contents

Chapter 22  Returns, Exchanges and Sales History  403
  Working with Sales History  404
  Merchandise Returns and Exchanges  407
  Reversing Receipts  411

Chapter 23  Sales Orders, Work Orders and Layaways (Pro)  415
  Customer Order Overview  416
  Creating a New Customer Order  419
  Filling Customer Orders  426
  Maintaining Customer Orders  428
  Using Work Orders  431
  Customer Order Reports  435
  Printing Customer Orders  435

Section VI:  Reports and Reconciling  437

Chapter 24  End of Day Procedures  439
  Overview  440
  End of Day Procedures  441

Chapter 25  Cash Drawer (X/Z-Out) and Payment Reports  445
  Cash Drawer Reports Overview  446
  Running Cash Drawer Reports  447
  Payment Reports  456

Chapter 26  Reports and Sales Charts  459
  Using Reports to Track Your Business  460
  The Report Center  462
  Sales Charts and Graphs  471
  Using the Reports Dashboard  475
### Section VII: QuickBooks Integration  

<table>
<thead>
<tr>
<th>Chapter 27</th>
<th>Financial Exchange Basics</th>
<th>479</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Exchange Overview</td>
<td>480</td>
<td></td>
</tr>
<tr>
<td>Installing and Preparing QuickBooks for Financial Exchange</td>
<td>483</td>
<td></td>
</tr>
<tr>
<td>The Financial Center</td>
<td>484</td>
<td></td>
</tr>
<tr>
<td>Connecting to QuickBooks Financial Software</td>
<td>485</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 28</th>
<th>Conducting Daily Financial Exchanges</th>
<th>487</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>488</td>
<td></td>
</tr>
<tr>
<td>Initiating Financial Exchanges</td>
<td>488</td>
<td></td>
</tr>
<tr>
<td>Verifying the Exchange of Individual Transactions</td>
<td>490</td>
<td></td>
</tr>
<tr>
<td>Handling Bank Deposits after Financial Exchanges</td>
<td>493</td>
<td></td>
</tr>
<tr>
<td>Resolving Exchange Errors</td>
<td>494</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 29</th>
<th>How QuickBooks Handles Point of Sale Data</th>
<th>497</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point of Sale Data in QuickBooks Financial Software</td>
<td>498</td>
<td></td>
</tr>
<tr>
<td>Account and Payment Type Mappings</td>
<td>513</td>
<td></td>
</tr>
<tr>
<td>Recover QuickBooks</td>
<td>516</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 30</th>
<th>Customizing Financial Exchanges</th>
<th>519</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>520</td>
<td></td>
</tr>
<tr>
<td>Switching to Detailed Document Posting (Item Information)</td>
<td>520</td>
<td></td>
</tr>
<tr>
<td>Custom Mapping of Accounts</td>
<td>524</td>
<td></td>
</tr>
<tr>
<td>Changing How Vendor Billing Information is Handled</td>
<td>527</td>
<td></td>
</tr>
<tr>
<td>Customize Sales Tax Mapping</td>
<td>529</td>
<td></td>
</tr>
<tr>
<td>Change the Order in Which Customer Names are Sent to Financial Software</td>
<td>530</td>
<td></td>
</tr>
</tbody>
</table>

### Section VIII: Point of Sale for Multiple Stores  

<table>
<thead>
<tr>
<th>Chapter 31</th>
<th>Multi-Store Basics</th>
<th>533</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-Store Overview</td>
<td>534</td>
<td></td>
</tr>
<tr>
<td>Company Preferences</td>
<td>536</td>
<td></td>
</tr>
<tr>
<td>Employees &amp; Security</td>
<td>536</td>
<td></td>
</tr>
<tr>
<td>Working with Customers</td>
<td>537</td>
<td></td>
</tr>
<tr>
<td>Recording Sales</td>
<td>537</td>
<td></td>
</tr>
<tr>
<td>Multi-Store Reporting</td>
<td>539</td>
<td></td>
</tr>
</tbody>
</table>
**Contents**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Updates</td>
<td>540</td>
</tr>
<tr>
<td>Multi-Store Financial Exchange</td>
<td>541</td>
</tr>
<tr>
<td>Allowed Activities by Store Type</td>
<td>542</td>
</tr>
<tr>
<td>Chapter 32 Managing a Multi-Store Inventory</td>
<td>545</td>
</tr>
<tr>
<td>Defining Inventory</td>
<td>546</td>
</tr>
<tr>
<td>Purchasing and Receiving</td>
<td>554</td>
</tr>
<tr>
<td>Transferring Merchandise between Stores</td>
<td>557</td>
</tr>
<tr>
<td>Chapter 33 Exchanging Store Information</td>
<td>561</td>
</tr>
<tr>
<td>Store Exchange</td>
<td>562</td>
</tr>
<tr>
<td>Running Store Exchange</td>
<td>569</td>
</tr>
<tr>
<td>Section IX: Customizing Point of Sale</td>
<td>579</td>
</tr>
<tr>
<td>Chapter 34 Customizing the Program</td>
<td>581</td>
</tr>
<tr>
<td>Program Customization Overview</td>
<td>582</td>
</tr>
<tr>
<td>Removing Features from Point of Sale</td>
<td>584</td>
</tr>
<tr>
<td>Customizing the Toolbars</td>
<td>585</td>
</tr>
<tr>
<td>Customizing Columns in Lists</td>
<td>586</td>
</tr>
<tr>
<td>Custom Labels and Custom Fields</td>
<td>589</td>
</tr>
<tr>
<td>Adding Your Logo to Printed Documents</td>
<td>591</td>
</tr>
<tr>
<td>Why are Some Features not Available to Me?</td>
<td>592</td>
</tr>
<tr>
<td>Chapter 35 Customizing Printed Documents (Pro)</td>
<td>593</td>
</tr>
<tr>
<td>Overview</td>
<td>594</td>
</tr>
<tr>
<td>Document Templates</td>
<td>595</td>
</tr>
<tr>
<td>Modifying or Creating a Template</td>
<td>599</td>
</tr>
<tr>
<td>Print Designer Hints and Tips</td>
<td>611</td>
</tr>
<tr>
<td>Importing and Exporting Templates</td>
<td>613</td>
</tr>
<tr>
<td>Customizing Reports</td>
<td>614</td>
</tr>
<tr>
<td>Appendix</td>
<td>Title</td>
</tr>
<tr>
<td>----------</td>
<td>------</td>
</tr>
<tr>
<td>APPENDIX A</td>
<td>Preferences</td>
</tr>
<tr>
<td></td>
<td>Preferences Overview</td>
</tr>
<tr>
<td></td>
<td>Company Preferences</td>
</tr>
<tr>
<td></td>
<td>Workstation Preferences</td>
</tr>
<tr>
<td>APPENDIX B</td>
<td>Information Fields</td>
</tr>
<tr>
<td></td>
<td>Information Fields Overview</td>
</tr>
<tr>
<td></td>
<td>Document and Record Information Fields</td>
</tr>
<tr>
<td>APPENDIX C</td>
<td>Configuring Firewalls</td>
</tr>
<tr>
<td>APPENDIX D</td>
<td>Compatible Hardware</td>
</tr>
<tr>
<td>Index</td>
<td></td>
</tr>
</tbody>
</table>
Section I: Point of Sale Basics

Chapter 1  Point of Sale Overview ......................... 3
Chapter 2  Point of Sale Fundamentals .................. 25
Chapter 3  General Printing Information ............... 39
Chapter 4  Employees ........................................ 53
Chapter 5  Point of Sale Security ....................... 65
# Chapter 1  Point of Sale Overview

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose of This Guide</td>
<td>4</td>
</tr>
<tr>
<td>What Point of Sale Does for Your Business</td>
<td>5</td>
</tr>
<tr>
<td>Comprehensive Reports</td>
<td>5</td>
</tr>
<tr>
<td>Security</td>
<td>5</td>
</tr>
<tr>
<td>Applications that Work With Point of Sale</td>
<td>5</td>
</tr>
<tr>
<td>Point of Sale Levels: Basic, Pro, or Pro Multi-Store</td>
<td>6</td>
</tr>
<tr>
<td>Installation and Setup</td>
<td>7</td>
</tr>
<tr>
<td>About Server and Client Workstations</td>
<td>7</td>
</tr>
<tr>
<td>Point of Sale Licensing</td>
<td>9</td>
</tr>
<tr>
<td>Buying Additional User Licenses</td>
<td>10</td>
</tr>
<tr>
<td>Merging License Numbers</td>
<td>10</td>
</tr>
<tr>
<td>Synchronizing your License with Intuit Servers</td>
<td>11</td>
</tr>
<tr>
<td>Unlocking the Pro or Pro Multi-Store Level</td>
<td>11</td>
</tr>
<tr>
<td>Updating QuickBooks Point of Sale</td>
<td>12</td>
</tr>
<tr>
<td>Hardware Setup Wizard</td>
<td>15</td>
</tr>
<tr>
<td>Working with Company Data Files</td>
<td>15</td>
</tr>
<tr>
<td>Creating, Opening, and Renaming Company Data Files</td>
<td>16</td>
</tr>
<tr>
<td>Cleaning Up Your Company Data</td>
<td>17</td>
</tr>
<tr>
<td>Help and Learning Tools</td>
<td>18</td>
</tr>
<tr>
<td>Glossary</td>
<td>18</td>
</tr>
<tr>
<td>The Learning Center</td>
<td>19</td>
</tr>
<tr>
<td>Getting Started</td>
<td>19</td>
</tr>
<tr>
<td>Using Practice Mode</td>
<td>20</td>
</tr>
<tr>
<td>Starting and Growing Your Business</td>
<td>21</td>
</tr>
<tr>
<td>Getting Help and Support</td>
<td>22</td>
</tr>
<tr>
<td>In-Program Help Files</td>
<td>22</td>
</tr>
<tr>
<td>Troubleshooting and Error Messages</td>
<td>23</td>
</tr>
<tr>
<td>Free, Self-Service Support</td>
<td>23</td>
</tr>
<tr>
<td>Assisted Support Resources</td>
<td>23</td>
</tr>
<tr>
<td>Find a Local Expert</td>
<td>24</td>
</tr>
<tr>
<td>Merchant &amp; Gift Card Services Support</td>
<td>24</td>
</tr>
</tbody>
</table>
Chapter 1: Point of Sale Overview

Purpose of This Guide

This guide provides information about using Point of Sale to help manage your retail business. Point of Sale was designed to benefit each unique retailer by including many customizable features. Although many of these features, controlled by the program level you have licensed as well as preference and security settings, are normally configured during the installation and interview process, you can manually change these later if needed.

If a feature is not available to you, it is probably due to preference or security settings, or the level of the program you have licensed. Features discussed in this guide that are controlled by program licensing level are clearly marked.

Latest Information

Due to print production schedules, it may be possible that program changes were made after this User’s Guide went to print. If you notice discrepancies between this printed document and the program, please consult the electronic version of the User’s Guide (select USER GUIDES from the Help menu) or search the in-program help system for the latest information.

Terminology

Throughout this guide we use terminology that is standard in retail operations, as well as terminology that may be unique to the Point of Sale program.

Refer to the glossary provided in the on-screen Help for definitions of terms used.

Graphics Used in this Guide

Because the screen layouts can differ depending on program level and configuration, the program screenshots used in this guide may not exactly match what you see on your screen. Pro/Pro Multi-Store users will have more menus, fields, and tasks on their screens than Basic level users. Unless otherwise indicated, the screens displayed in this guide are mainly from the Pro level of the software. The general procedures used to carry out an activity are still correct.
What Point of Sale Does for Your Business

QuickBooks Point of Sale (Point of Sale) is an advanced inventory control, sales, customer tracking, and reporting program designed for effective management of retail stores. As you order, receive, and sell merchandise, your inventory quantities and costs are instantly updated.

At a glance, you can view item quantities on hand and on order; review costs, prices and margins; and view detailed reports on sales and merchandise activity. You can track customers and use the resulting purchase history information to customize promotions, mailings and other marketing materials. At the end of your business day, Point of Sale will help you reconcile your cash drawer, settle credit card transactions (optional fee-based service), and backup your data files.

Comprehensive Reports

The Report Center provides extensive predefined reports, all of which can be easily customizable to suit your particular needs.

Security

The security feature allows you do assign different rights to different users, limiting access to program areas and features.

Applications that Work With Point of Sale

Point of Sale can be integrated with QuickBooks Financial Software—Pro and Premier Editions 2005 – 2008 or Enterprise Solutions Version 5.0 – 8.0—to give you unified control over your entire retail operation. Existing inventory items, customers, and vendors from your financial software can be imported into Point of Sale and all of your daily point-of-sale data can be transferred to the financial software at the push of a button.

If you have your current point-of-sale data in another software product or receive vendor-provided lists, the Data Import Wizard allows the import of items, customers, and vendors via Excel® spreadsheets or text files.

Refer to The Data Import Wizard (page 124) for more information.
QuickBooks Point of Sale also integrates with other business software applications to meet your store's specific needs. These applications are created by third-party software companies who are part of the Intuit Developer Network (IDN). To learn about applications that work with Point of Sale, you can search for “IDN” within the Point of Sale Help system or visit The QuickBooks Solutions Marketplace at [http://marketplace.intuit.com](http://marketplace.intuit.com).

You can learn more about the IDN at [http://developer.intuit.com](http://developer.intuit.com).

**Point of Sale Levels: Basic, Pro, or Pro Multi-Store**

The Point of Sale software contains three separate levels of the program, each with a specific set of features. This allows you to license and use only those features that you need, without having to pay for advanced features that you won’t use. As your business grows, you can easily “unlock” the additional features of the next level by simply upgrading your product license over the phone.

The three levels of Point of Sale are:

**Point of Sale Basic.** Includes all you need to purchase and receive merchandise, manage inventory quantities and costs, process sales and returns, automatically collect sales taxes, track customers, run meaningful reports, control access to your company data file, and integrate with your QuickBooks financial software.

**Point of Sale Pro.** Includes all the features of the Basic level, plus:

- Customer orders (layaways, sales orders, work orders)
- Customer Rewards program
- Discount pricing for special or temporary sales
- Assembly, group, and style item tracking
- Inventory item pictures
- Document-tracking of item serial numbers
- Track available and committed item quantities
- Integrated Shipping Manager to make shipments from sales receipts
- Ability to customize printed documents and tags
- Custom fields on item, customer, vendor, and employee records
- Purchase and sell in multiple units of measure
- Track employee commissions
- Track employee hours worked
- And much more...
**Point of Sale Pro Multi-Store.** Includes all the features of the Pro level, plus:

- Centralized purchasing, inventory, and program control at a Headquarters Store
- Ability at each store to view item quantities on-hand and on order for all other stores and to complete inter-store item transfers
- Ability to collect different tax sales tax rates at each store
- Exchange of information between stores via e-mail, direct network connection, or removable media
- Individual store and company (all stores) reporting

For a detailed list of the features available at each level, refer to your on-screen Help. Refer to Unlocking the Pro or Pro Multi-Store Level (page 11) for information about changing your Point of Sale level.

---

**Installation and Setup**

Instructions for installation and the initial configuration of Point of Sale, as well as for integrating Point of Sale with your QuickBooks financial software, can be found in the *QuickStart Guide* that accompanied your Point of Sale software. Configuration and other setup information can be found in the on-screen Help.

If you have not already done so, we strongly recommend you use the *QuickStart Guide* and the on-screen Help to complete the installation and initial configuration.

---

**About Server and Client Workstations**

QuickBooks Point of Sale can be networked to allow up to ten workstations simultaneous access to the program within a store; one Server Workstation and up to nine Client Workstations. You can view your current workstation type and number by selecting ABOUT POINT OF SALE from the Help menu.

**Server Workstation**

The Server Workstation holds your point-of-sale company data. Typically this will be the first workstation to which you installed Point of Sale.

Certain activities can be done only from the Server Workstation:

- Financial Exchange with QuickBooks financial software
- Creation of a company data file
Chapter 1: Point of Sale Overview

- Exchange of information with other stores (Pro Multi-Store)
- Importing data
- Other data or security-related tasks

If you are installing Point of Sale on only one workstation, it must be installed as a Server Workstation. Only one Server Workstation can be installed on a network.

*Important: The Server Workstation must be running for Client Workstations to have access to the Point of Sale data. (Point of Sale does not have to be open on the Server Workstation.)*

**Client Workstation**

Any networked workstation that is not a Server Workstation is a Client. Client Workstations access the Point of Sale company data across the network.

**Non-Tolerant Activities in Point of Sale**

Some activities in Point of Sale are non-tolerant activities, meaning that all other workstations must be out of Point of Sale before they can be performed. Non-tolerant activities include the following:

- Restoring data from backup files
- Changing certain company preferences
- Cleaning up company data
- Manually downloading and/or installing Point of Sale program updates
- Renaming the company data file

The User Information window gives you a summary of the workstations currently in the program. This screen is displayed automatically if you launch a non-tolerant activity to let you know that other workstations must exit before you can continue. You can also access this screen manually.

**To view the User Information window:**

1. From the Tools menu, select **USER INFORMATION**. The workstation, user, and computer names currently in Point of Sale are displayed. Select **REFRESH** to update the information as needed.

2. Select **CLOSE (<Esc>)** to exit.
Installation and Setup

Point of Sale Licensing

One License, Multiple Workstations

In purchasing Point of Sale, you actually purchased one (or more) user licenses. You can only have as many concurrent computers accessing Point of Sale as you have user licenses. All of the networked computers in a store share a “store license” which is managed by the Server Workstation and may include from one to ten user licenses (based on your purchase).

For example, say you want to use a point-of-sale workstation in the front of the store during business hours, but want to use a networked back-office workstation in the evenings to create purchase orders and exchange data with QuickBooks financial software. In this example, only a single copy (with one user license) of Point of Sale is required. It would be installed on the back-office computer as the Server Workstation and also on the front computer as a Client Workstation, using the same license number. Either workstation can access Point of Sale, but only one at any given time. If you require that multiple workstations run Point of Sale at the same time, you would need to purchase additional user licenses.

Benefits of this Licensing Structure

- You can use multiple workstations for sale lanes or specialized roles (purchasing, receiving, etc.). Use a single user license that is accessible via multiple workstations, but only one at a time,

  Or

  Use as many workstations at the same time as the number of user licenses you have purchased. Additional workstation licenses are merged with the Server Workstation license.

- Only one workstation (the Server Workstation) is required to register the Point of Sale software.

User Information Window

If “EFT Server” is listed in the User Information window, wait a few moments and then select REFRESH. This is the component that handles communication for credit, debit, and gift card transactions; once all pending transactions are completed it will shut itself down so you can continue with a non-tolerant task. If a third-party integrated program is listed, you must close that program manually.
• In a Pro Multi-Store installation, you can transfer user licenses from one store to another, or temporarily use a store's user license to run Point of Sale (installed as a Client) on a laptop you take store-to-store.

Buying Additional User Licenses

If you wish to purchase additional user licenses, you can do so online or by phone directly from Intuit. Additional user licenses must be merged with the Server Workstation’s license. (See the following section for more information about merging licenses.) Once that is done, the Server Workstation synchronizes its licensing information with the Intuit licensing servers. Once this process is complete, the new workstation(s) can be used.

To buy additional user licenses:

1. From the Help menu, select MANAGE MY LICENSE ➤ BUY ADDITIONAL USER LICENSE.
2. Follow the on-screen prompts to obtain a validation code to add another license either online or by calling Intuit.
3. Install Point of Sale on the new workstation(s) as Client Workstations.
4. Merge and synchronize licenses as described below.

Merging License Numbers

If you purchase and install additional copies of Point of Sale with different license numbers on Client Workstations, you must merge them with the Server Workstation's license. After merging, the new workstation shares the same license as the Server Workstation and the Client Workstation's original license number is deactivated.

Point of Sale will prompt you to merge licenses when necessary.

If your workstation is connected to the Internet and the Server Workstation is running, the merge happens automatically. If you are not connected to the Internet, the phone merge window is displayed. Call the number shown.

Once the licenses are merged, the Server Workstation will need to synchronize online with the Intuit’s licensing servers as described below.
Synchronizing your License with Intuit Servers

Synchronizing updates both the Server Workstation’s license and Intuit’s records and makes new user licenses available to other workstations. Point of Sale will prompt you to synchronize licenses when necessary.

To synchronize your license data with Intuit records:

1. From the Help menu:
2. To synchronize online, select **MANAGE MY LICENSE ➤ SYNCHRONIZE LICENSE DATA ONLINE**.
3. To synchronize by phone, select **MANAGE MY LICENSE ➤ BUY ADDITIONAL USER LICENSE** and call the number shown. You won’t actually purchase another license; the phone agent will give you a code to activate the licenses you already have.
4. Follow the on-screen prompts or phone agent instructions to synchronize your license data.

Unlocking the Pro or Pro Multi-Store Level

You can unlock the additional features of Pro or Pro Multi-Store levels at any time from the Server Workstation for an additional fee.

### Tip: Try Pro or Pro Multi-Store Features in Practice

You can try out the features at a higher level at anytime in practice mode. If you are a Basic-level user, you can practice in the Pro or Pro Multi-Store levels to determine if the features available are suited for your business. Pro-level users can practice at the Pro Multi-Store level.

Refer to [Using Practice Mode (page 20)] for more information.

To unlock to the Pro or Pro Multi-Store levels:

1. If you are not already there, select **NAVIGATOR** from the Window menu on the Server Workstation.
2. From the How Do I menu at the right of the Navigator, select **BUY QUICKBOOKS POINT OF SALE**.
3. Review the displayed information page to determine which level best fits your needs.
4. Select **BUY NOW** from the displayed page when you are ready to upgrade to a higher level.

Follow the on-screen prompts to contact QuickBooks Customer Service and receive a special activation code.
Chapter 1: Point of Sale Overview

All Point of Sale workstations must be running the same level. You must unlock all workstations at the same time. Workstations that are not unlocked will no longer have access to the company data.

5. Merge and synchronize licenses, as prompted.
You will not need to reinstall the Point of Sale software or transfer company data; the change to the new level is handled automatically. Every unlock comes with a 60-Day, Money-Back Satisfaction Guarantee (ask for details.)

**Updating QuickBooks Point of Sale**

Updates to Point of Sale — such as maintenance releases, bug fixes, and updated help files — can be quickly and easily installed to your computer. This ensures that you have the most up-to-date features, capabilities, and help available.

An automatic update feature can check for and download update files if an Internet connection exists at a workstation. You can have Point of Sale check for updates and automatically download them, notify you without downloading, or you can instruct Point of Sale to not check for updates if you prefer to do it manually at your discretion. You can also configure updates so that all networked workstations can update from a single downloaded update file.

Updating your software is a two-part process:

1. Connect to Intuit's servers and download the update file(s). Depending on your preference settings, this may be automatic or manually accomplished.
2. Install the update. Once an update has been downloaded, you will be prompted to install it.

**Important Information About the Update Service**

- To download update files, you must have an active Internet connection.
- Downloads can occur even when Point of Sale is not running. You'll be notified when you start Point of Sale that an update is available to install.
- Automatic downloads are in the background and do not affect your computer's performance. You can continue working while an update is being downloaded.
- An update must be installed on each workstation. Workstations that have not been updated may not be able to connect to the company data on the Server Workstation.
- To install a downloaded update to the Server Workstation requires that all Client workstations exit Point of Sale. When installing on any workstation, Point of Sale will automatically be closed on the workstation as the installation begins and will restart once complete.
No personally identifying information is read from your computer or sent to Intuit, Inc. during update downloads. Review the PRIVACY STATEMENT (on the Help menu) for more information.

To set your program update preferences:

When you initially begin using Point of Sale, you will be prompted to make an update selection. You can also change your selection at any time as follows:

1. From the Help menu, select SOFTWARE UPDATES ➤ UPDATER PREFERENCES. The Updater Preferences window is displayed.

2. On the General tab, select your preferred method of checking for updates. We recommend you choose DOWNLOAD ONLY. LET ME CHOOSE WHEN TO INSTALL.

3. If you have multiple workstations, on the Shared Downloads tab, indicate whether this workstation will install from a shared download file. Use the help link on this page to learn how shared downloads work and if it is a good choice for you.

4. Select OK to save your preferences.

5. Repeat for other workstations. It is especially important that each workstation select the shared download option if applicable.

To install an automatically downloaded update:

If an update has been automatically downloaded, you are prompted to install it each time you start Point of Sale. The alert window provides information, such as what is included in the update and an estimate of how long it will take to install it.

1. Select OK to install a downloaded update when prompted. Point of Sale will automatically be closed on the workstation as the installation begins.

If you do not wish to install the update at this time, select REMIND ME NEXT TIME...
2. Follow any on-screen prompts to complete the installation.
If you choose not to allow the automatic download of updates, you can manually
check for and download them at anytime.

To manually check for and download updates:
1. From the Help menu, select SOFTWARE UPDATES ➤ CHECK FOR UPDATES.
   Point of Sale connects to the update site and checks for new updates.

2. You will be notified if an update is available. Make your choices from those
   offered in the window and select OK.
3. Follow the onscreen prompts to complete the download and installation of the
   update.

Update History
You can review past update activity, including any errors that occurred, on your
workstation by selecting SOFTWARE UPDATES ➤ VIEW INSTALLED UPDATES.
Hardware Setup Wizard

To simplify setting up hardware, such as receipt printers, bar code scanners and hardware bundles, Point of Sale provides a Hardware Setup Wizard.

IMPORTANT! Launch this wizard before attaching your hardware.

To use the Hardware Setup Wizard:

1. Insert the Point of Sale installation CD into your CD-ROM drive. Cancel the installation wizard if it launches.
1. From the File menu, select HARDWARE SETUP WIZARD.
2. Follow the on-screen prompts to install your hardware.

You can view the list of supported and compatible hardware in Appendix D Compatible Hardware (page 681).

Working with Company Data Files

A company data file is the database file that Point of Sale uses to store all of the information for your business. Point of Sale allows you to create, open, or rename company data files, and to convert from a previous version of the software. These options are available only from the Server Workstation and are subject to security rights.

Upon initial startup of Point of Sale on the server workstation you are prompted to create your company data (or to convert from a previous version of Point of Sale, if detected). If you chose not to do so at that time, or if you decide to start over, you can access these choices at anytime in the future by selecting COMPANY DATA from the File menu.

💡 Locating Your Company Data in Windows Explorer

You can browse to the location your company data in Windows Explorer by selecting FILE ➤ UTILITIES ➤ BROWSE TO DATA. An Explorer window is opened to the default location for company data. Your default backup files are located in the BACKUP sub-folder of this location.
Creating, Opening, and Renaming Company Data Files

To create a new company data file:
1. Close Point of Sale on Client Workstations and close all open windows on the Server Workstation. (Check the Window menu for open windows.)
2. From the File menu, select COMPANY DATA and then select NEW.
3. Enter a unique name for the new company data in the dialog displayed and then select OK.
   Point of Sale displays a status indicator as it creates the new company data.
4. Select OK when the confirmation dialog is displayed.
5. Point of Sale walks you through configuring your new company data file. Follow the on-screen prompts.

To convert company data from a previous version:
1. Close Point of Sale on Client Workstations and close all open windows on the Server Workstation.
2. From the File menu, select COMPANY DATA and then select CONVERT FROM PREVIOUS VERSION.
3. Enter a unique name for the new company data in the dialog displayed and then select OK.
   Point of Sale searches for and detects your prior version and displays the path to it.
4. If the specified path is the correct installation from which you want to convert data, select OK.
   Alternatively, select BROWSE and navigate to a different installation from which you want to convert data and then select OK.
   You can also convert from a previous version’s backup file by selecting that option and browsing to the correct backup folder.
   Point of Sale copies the data files from the previous version and then converts them for use with this version of Point of Sale. This process may take several minutes, depending on the size of your existing data.
5. Select OK to close the confirmation window when displayed.
6. If you require employee logins, the Log In window is displayed. Use your previous version user name and password to log in to the program.

To open a different company data file:
This feature allows you to open any Point of Sale company data file located on the local network. This option is particularly useful for accountants and Point of Sale ProAdvisors or accountants, who may work with copies of several clients’ company data.
Working with Company Data Files

1. Close Point of Sale on Client Workstations and close all open windows on the Server Workstation.
2. From the File menu, select COMPANY DATA and then select OPEN.
3. Point of Sale displays a list of company data files located on the network (Server Workstation).
4. To open one of the files listed, highlight it and then choose OK.

Or

Select ALTERNATE LOCATION and then BROWSE to locate a company data file on your network. Select OPEN after locating the correct file.

Point of Sale opens the specified company data and displays a confirmation dialog.

5. Select OK to close the confirmation window when displayed.

To rename your company data file:

You can rename your company data file at anytime. However, if you do so, Client Workstations will not be able to automatically connect to the new file. Upon next startup on Client Workstations, you will receive a “file not found” message. Browse to the newly-named company data file to connect.

1. Close Point of Sale on Client Workstations and close all open windows on the Server Workstation.
2. From the File menu, select COMPANY DATA and then select RENAME.
3. Enter a new name for the file and select OK.

Cleaning Up Your Company Data

“Trimming the fat” from your company data file can keep Point of Sale lean and efficient. The Clean Up Company Data utility (found in UTILITIES on the FILE menu) optimizes this file to improve program performance. It can also purge (remove) old information from your company file to improve performance. While this will not change the size of your company file, it will speed up searches and other operations.

Non-history documents, (such as held, closed or inactive documents) and history documents, (such as sales, receiving or adjustment documents) can be categorically selected for removal. Point of Sale automatically creates a backup before cleanup.
begins. For more information press <F1> in Point of Sale and search using the keyword “cleanup.”

💡 The Option for Compressing Data

An option is provided in the Clean Up Data process for compressing data. Compressing the company file is a method for creating more hard disk space, it is not specifically intended to improve program performance, and performance improvement results may vary. If you have a large database, the compression process can take several hours to complete, and it cannot be cancelled once it has begun.

This option is recommended only if hard drive space is an issue.

Help and Learning Tools

Point of Sale is full-featured retail management software. While we continually strive to make it simple to learn and use, some degree of training is necessary to be efficient and productive. The program and associated help system provide several tools to get you up and running quickly.

Glossary

The on-screen Help offers a comprehensive glossary of terminology used throughout Point of Sale. From the Help menu, select HELP CONTENTS to display a Help overview. From the list of “books” on the left, select HELP & LEARNING ➤GLOSSARY OF TERMS. Select a letter of the alphabet at the top of the window to quickly navigate the word list.
Help and Learning Tools

**The Learning Center**

The Learning Center starts automatically when you first launch the program to make you aware of the many learning resources available.

The Learning Center contains tutorials and demonstrations for using Point of Sale. We encourage you to use this tool for training yourself and your employees. Most of the tutorials in the learning center include audio, and you will need a sound-card and speakers on your computer to take advantage of this tool. Many of these tutorials are also referenced from the Help system.

Clear the **SHOW THIS WINDOW ON STARTUP** checkbox if you do not want the Learning Center launched on subsequent startups. You can always access the Learning Center later from the Help menu.

**Getting Started**

At the bottom of the home page Navigator, you can access the Getting Started panel, which guides you through a recommended task sequence for setting up Point of Sale quickly and efficiently.

This panel is automatically displayed for new Point of Sale users.
When you select a task from the Getting Started panel, the associated task window is opened and a special Getting Started help sidebar is displayed as shown here. This example is from the inventory list.

The sidebar contains a brief overview of the area, basis steps to complete the task, and links to get more information, watch tutorials, or access more advanced tasks.

The Getting Started sidebars can be hidden at any time by selecting HIDE in the upper-right corner. To reopen the sidebar, from the Help menu, select SHOW GETTING STARTED HELP. Selecting the task again from the Getting Started panel on the Navigator also automatically reopens the sidebar.

When you have completed the Getting Started tasks and feel comfortable using Point of Sale, you can toggle the Getting Started panel on the Navigator to instead display other Help & Support resources.

Select the small down-arrow to the right of GETTING STARTED and select HELP & SUPPORT.

Using Practice Mode

Practice mode affords you the opportunity to learn and try Point of Sale features using a set of included practice data. To make practice more realistic for training employees, you can create practice data from your own store data if you prefer.

**While in practice mode, the following apply:**

- The words “Practice Mode” flash in the title bar and the status bar is bright yellow
- The Point of Sale date is set to December 29, 2010
- You cannot exchange data with QuickBooks financial software, complete payment card transactions, or backup/restore the practice data
In a Pro Multi-Store configuration, you cannot send files between stores.

**To access practice mode:**

1. Close all open windows.
2. From the File menu, select **USE PRACTICE MODE**.
3. Select the data you want to practice with (Server Workstation only):
   - **CONTINUE TO USE CURRENT PRACTICE DATA** to keep working with the same data that was last used for practice.
   - **SELECT OTHER PRACTICE DATA** from the list of available data displayed.
   - **MAKE A COPY OF MY REAL DATA** to practice with your own data. A copy of your company data is made, so your real data is not affected by practicing. The login names, passwords, and hardware settings defined in your company data apply while in practice mode.
4. Select **OK**.
5. Choose a practice level and then select **OK**.
   Basic users can select to practice in Pro or Pro Multi-Store levels, and Pro users can choose to practice in Pro Multi-Store level, to try out the added features in a higher level. If practicing at a higher level, we suggest you go through the Setup Interview to configure Point of Sale for the features you want to test (select **SETUP INTERVIEW** from the File menu).
6. Follow the prompts to confirm creation of the practice data.
7. When done practicing, select **EXIT PRACTICE MODE** from the File menu.

**Starting and Growing Your Business**

Wondering how to put together a business plan? Or whether you should add a Web Store to grow your business? Or how to find expert advice and training in your area?

Visit Intuit's JumpUp at [www.jumpup.intuit.com](http://www.jumpup.intuit.com), a free Website that provides resources and guidance to help you get your business running quickly and successfully:

- Business planning
- Free business tools, resources, and product reviews
- Networking forums to connect with other business owners
- Small Business news
- Marketing ideas
- And more....
Getting Help and Support

In-Program Help Files

Help System

The Point of Sale Help system can assist you in completing a task as well as provide information about optional equipment and help you troubleshoot problems.

You can access the on-screen help in any of these ways:

- Press \(<F1>\), select HELP ON THIS WINDOW from the help menu, or select the HELP button on a dialog or message to open the specific help topic related to your current task.
- From the Help menu, select the HELP CONTENTS to display a Help overview. From here you can use the various options discussed below to find the information you need.

Once you have accessed the help window, you can navigate through the topics to find the information you need in any of these ways.

- The CONTENTS tab presents help topics in a library fashion, with each “book” of the library covering a major program area or function. Click on a book to view and select a topic contained therein.
- The INDEX tab provides a topic title word index covering all program features and help topics. Simply enter a word for the feature you are working with to locate that topic.
- The SEARCH tab provides a word search index that includes every word contained in the help system. You must first setup the Find database; follow the on-screen prompts. Building an index for maximum search capability can take several minutes.

- Once you have located a topic on any of the tabbed panels, double-click it to view the topic.
- Once a topic is displayed, click the underlined blue links to jump to related topics. Links including the □ icon expand to show additional information on the same page.
- Select BACK to move back to the previously displayed topic.
- Select HIDE/SHOW to toggle on/off the display of the navigation pane.

From the Help menu, you can also access various other help tools: electronic versions of the printed user guides, the Learning Center, and a Send Feedback link that allows you to give us your comments and suggestions, or report a program bug.
Troubleshooting and Error Messages

If you received an error message or need troubleshooting help, try these resources:

• If available, click the help button or link on the message. These links will provide detailed instructions to correct the issue that caused the message.
• Search the help file index using the keyword “troubleshooting” or a specific word related to the problem you are experiencing.
• Issues related to installation, upgrading, and certain error messages may be covered for 12 months under our Customer Care policy. Refer to Installation, Upgrade, and Error Message Assistance (page 24) for more information.

Free, Self-Service Support

Support Website. For the latest information about your product and immediate answers to most questions, go to our Support Web Site at www.quickbooks.com/support/pos.

Point of Sale User Community. Connect with other Point of Sale users and experts to ask questions and share advice at www.quickbooksgroup.com/pos.

Assisted Support Resources

Terms and Conditions

The assisted support options discussed below are subject to the fees, hours of operation, and other terms and conditions detailed at www.quickbooks.com/support/pos.

Free Support for 30 Days

Free support is available for 30 days from registration when you submit your questions online. Submit your question online at www.quickbooks.com/contactme.

We will respond by e-mail or phone, usually in 30 minutes or less. You won't have to wait on hold, and we'll be better able to route your issue to the appropriate support team.

Support Plans

Intuit offers a variety of support plans, providing expert assistance when and as often as you need it; one-time or for an unlimited number of issues. (Fees apply.)
Learn more about Point of Sale Support Plans at [www.quickbookspost.com/plans](http://www.quickbookspost.com/plans).

**Already have a Support Plan?**

Submit your question online at [www.quickbooks.com/contactme](http://www.quickbooks.com/contactme).

We will respond by e-mail or phone, usually in 30 minutes or less. You won't have to wait on hold, and we'll be better able to route your issue to the appropriate support team.

For a fee, support is also available by calling 800-348-0254.

**Installation, Upgrade, and Error Message Assistance**

Free Customer Care support is available for installation and upgrade issues and certain Point of Sale-specific error messages for 12 months from your initial software registration when you submit your questions online at [www.quickbooks.com/contactme](http://www.quickbooks.com/contactme).

We will respond by e-mail or phone, usually in 30 minutes or less. You won't have to wait on hold, and we'll be better able to route your issue to the appropriate support team.

Learn more about Customer Care support at [www.quickbooks.com/customercare/pos](http://www.quickbooks.com/customercare/pos).

**Find a Local Expert**

Get onsite assistance from a local expert who can help you set up, customize, and learn your Point of Sale software. Choose from certified QuickBooks Point of Sale ProAdvisors® or Retail Solution Providers, both have been tested and certified by Intuit on Point of Sale.

**Certified QuickBooks Point of Sale ProAdvisors** can provide accounting advice tailored to your business needs. Visit: [www.FindAProAdvisor.com/posadvice](http://www.FindAProAdvisor.com/posadvice).

**Certified Point of Sale Retail Solution Providers** are your local retail business and technology experts that can help you with any retail technology questions. Visit: [www.quickbooksgroup.com/pos_form.html](http://www.quickbooksgroup.com/pos_form.html).

Note: Fees apply and are set by the expert. QuickBooks Point of Sale ProAdvisors have also been certified in QuickBooks Financial Software.

**Merchant & Gift Card Services Support**

Call 800-558-9558, 24 hours a day, 7 days a week.
Chapter 2

Point of Sale Fundamentals

Overview ................................................................. 26
Point of Sale Preferences .......................................... 26
The Navigator ........................................................... 26
Getting Around in Point of Sale ................................. 28
  Keyboard Navigation .............................................. 28
  Using a Mouse or Touchscreen ................................. 29
  Open Windows ..................................................... 30
Lists and Forms ....................................................... 31
Locating Records or Documents ................................. 31
  Using Quick Find ................................................ 33
Working with History Documents ............................... 34
  Viewing Document Financial Exchange History ........... 34
  Editing or Reversing History Documents .................... 35
Temporarily Holding Documents ................................. 37
Overview

This chapter focuses on fundamental Point of Sale procedures that are used across all areas of the program, such as navigating through menus, windows, lists and forms, finding records, and listing items on documents.

We recommend that you return to this chapter as needed as you progress through the rest of the user guide.

Point of Sale Preferences

Point of Sale preferences allow you to configure the program to work with your hardware and accessories, establish data control, and customize many of the Point of Sale features.

When a preference setting affects the appearance or function of a task, a preference note will point to the menu path to find the setting and provide a brief explanation as shown in this example:

For a complete listing of all program preferences, refer to Appendix A Preferences (page 617).

The Navigator

The Navigator is the startup screen for Point of Sale, as shown in the image on the following page, containing clickable workflow links that take you to the various task areas, help and learning resources, reminders, and shortcuts to various tools and activities.

Familiarizing yourself with the terminology related to the Navigator components will help you learn the program and follow the procedures given in this guide.

The following image is that of a Pro Multi-Store level installation. Not all features and options shown will be available at all levels of Point of Sale. Refer to the explanations on the following page for each numbered area.
Windows standard text menus provide access to all areas and features of Point of Sale. These menus can be used to locate the area you need to complete a task, even if you have turned off the main toolbar.

The toolbar provides shortcuts to your most frequently used program tasks. Right-click the toolbar to customize the task icons that are displayed and their order. You can also turn off this toolbar if you want more screen space for the display of task windows.

This panel provides easy access to common questions about doing tasks in Point of Sale.
Chapter 2: Point of Sale Fundamentals

<table>
<thead>
<tr>
<th></th>
<th>Reports</th>
<th>This panel provides quick access to the Report Center and to memorized reports.</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Reports Dashboard Tabs</td>
<td>These tabs provide quick access to the Reports Dashboard pages.</td>
</tr>
<tr>
<td>6</td>
<td>Navigator Links</td>
<td>The Navigator graphically represents the retail workflow of merchandise through your store(s) and contains clickable links to take you directly to the area you need to complete a task as well as links to get help in using the program. The Quick Find feature allows you to quickly locate records for customers, items, receipts and customer orders.</td>
</tr>
<tr>
<td>7</td>
<td>Drop-Down Menus</td>
<td>Specific menus for each area containing the most common tasks.</td>
</tr>
<tr>
<td>8</td>
<td>Status Bar</td>
<td>The status bar identifies important information about the currently active window or module, such as whether List Edit is on or off, whether you have inventory reminders, which workstation you are using, and the logged in user’s name.</td>
</tr>
</tbody>
</table>

Refer to Chapter 34 Customizing the Program (page 581) for instructions for customizing toolbars and removing features and related menu and Navigator icons.

**Getting Around in Point of Sale**

Point of Sale is designed to make moving between program modules, selecting buttons, and entering data both intuitive and efficient. The program offers keyboard, mouse, and touchscreen compatibility.

**Keyboard Navigation**

Specific keyboard keys are indicated by angle brackets around the word or symbol appearing on the keyboard, such as `<ENTER>`. Keyboard users can use the arrow keys, `<TAB>`, or `<ENTER>` to accept an entry and move from field to field and various keyboard shortcuts to select a button or task. For
maximum efficiency at point of sale, we recommend you learn and use the keyboard shortcuts available throughout the program.

Keyboard users can navigate the program and make selections in a variety of ways:

- Press `<ALT>` to activate the text menus, then press the underlined letter, when displayed, to directly access or activate a menu and/or menu item.
- With the text menus activated, you can also use the arrow keys to navigate left, right, down (open menu and move through choices), and then `<ENTER>` to select an option.
- Press `<F10>` to move the focus from the menus back to the open task window.
- Press `<ALT + PAGE UP/PAGE DOWN>` to cycle through the open windows.
- Press `<ALT + O>` to open the I Want To list, arrow to an option and then press `<ENTER>`.
- Press `<TAB>` to accept an entry and move to the next field on a form and `<ENTER>` to accept and move to the next field in a list.
- Press `<F5>` to refresh the window.
- Press `<F3>` or `<CTRL + F>` to open the Find window for the active field.

Select **KEYBOARD SHORTCUTS** from the Help menu to view a more detailed listing of shortcuts for the area you are working in.

### Using a Mouse or Touchscreen

Instructions in this guide typically refer to “selecting” a button or field and then entering data. When the documentation says to select, highlight, or place the focus on a toolbar button, field, window name, task, or menu selection, mouse and touchscreen users can simply click or touch that component. To facilitate touchscreen use, a navigation toolbar and virtual keyboards are added to the screen and in appropriate dialogs.

[Enable touchscreen features](#)

Using the touchscreen interface will reduce the amount of available on-screen “real estate” for viewing lists and forms.
**Touchscreen Tips**

- Reducing your video resolution to 800 by 600 can make touching small fields easier. However, be aware that at this resolution you may have to scroll in Point of Sale windows to view all available fields.
- Double-touching in quick succession has the same effect as double-clicking with a mouse.
- The size of your scroll bars can be changed to make touch scrolling easier. Go to the Windows **CONTROL PANEL ➤ DISPLAY ➤ APPEARANCE**. Select **SCROLLBAR** from the Item list and set the size that works best for you. This changes the scroll bar size for all of your Windows programs.
- Touchscreen monitors are ideal for certain activities, such as when ringing up sales. However, when data must be entered into records, you will find that a hybrid system including a keyboard (for entering data) is more efficient.
- Use the **ACTIVATE** button to access the list or pop-up control associated with the active field.

**Open Windows**

Point of Sale allows you to have multiple task windows open at one time. You can access the list of currently open windows from the **WINDOWS** button on the main toolbar. Simply select a different window from the drop-down list to switch to it.

You can also access this list or quickly close all open windows from the **WINDOW** text menu.
Lists and Forms

Records in Point of Sale can normally be viewed in either of two ways; in a list or in a form.

**List.** A list is simply a collection of records, such as item records or customer records, displayed together in rows and columns, much like a spreadsheet.

**Form.** A form displays the details of a single record, and is the most common place to make edits to a record.

Refer to Chapter 7 Lists, Forms and Filters (page 99) for more information.

Locating Records or Documents

When you want to locate a specific record (item, customer, vendor, receipt, etc.) you can conduct powerful and fast searches by keyword, name, number, barcode, or date to quickly find what you need.

Searching allows you to search lists for a record across multiple information fields and throughout your entire document history in any give area.

To search for a record or document:

1. Display the record list and select **FIND** from the window toolbar.
   
   **Or**
   
   From anywhere in the program, select **FIND RECORD ▶ <record type>** from the Edit menu. With this selection, you can search for any record type from anywhere, without first displaying the associated list.
   
   **Or**
   
   Place the cursor in a lookup field on the record which you are working. Refer to Using Lookup Fields (page 90) for more information.
   
   **Or**
   
   Place the cursor in The Quick Find field on the Navigator. Refer to the explanation of Using Quick Find (page 33) in the next section.

2. Enter a search keyword or keywords by which you want to search.
Keywords can include selected number entries (such as Item # or UPC for items, serial numbers for documents, or dates for some document types).

If searching from a lookup field, enter your search criteria directly in the field and then press **<ENTER>** or select the **FIND** button or the magnifying glass icon adjacent to the field. The keyword you entered will be automatically transferred to the Find window.

You can scan bar codes from an item tag or sales receipt.

On the Find window, optionally select **ADVANCED FIND OPTIONS** to narrow your search to a specific field or select other search criteria.

Select **HELP** on the Find window for additional information.

3. Select **FIND** press **<ENTER>** to begin the search.

The search results are displayed in the Find window, as shown in the following item search example.

From this sample Find Item window, you have these options:

- Highlight an item and choose **SELECT ITEM** (or double-click the record) to work with it. If searching from the item list, the selected item is displayed in a form for reviewing or editing; if searching from a document item list, the selected item is listed on the document.
- Select **ADD NEW ITEM** to add a new item to inventory.
Locating Records or Documents

- Select **GO TO ITEM LIST** (only available if searching from a document) to go to your full item list, with the highlighted item pre-selected.
- Search again by entering new keywords/numbers and selecting **FIND** again, optionally changing the advanced search criteria to narrow your search.

***Searching Different Record Types***

The search fields and options available from the Find window may vary depending on the record type for which you are searching. Select **HELP** from the Find window anywhere in the program to see specific instructions for the type of search you are performing.

Refer to  **Listing Items on Documents (page 91)** and  **Listing a Customer on a Receipt (page 357)** for more examples of searching from documents.

***Searching for Dates and Phone Numbers***

When searching for dates, you can enter m/d/y (01/24/2005) or just m/y (01/2005).

When searching for phone numbers, Point of Sale ignores spaces, dashes, parenthesis and periods. This enables you to perform a search without having to remember the exact format used in the record you are trying to locate. This applies to search/find fields only.

---

**Using Quick Find**

The Navigator offers a Quick Find field to locate customers, items, receipts and customer orders. You can scan item or receipt barcodes into this field, or manually type serial numbers, customer names, document numbers, or any search keyword and select **FIND**.

The Quick Find results window breaks down your search results into the different record types and displays how many results were found in each category.

Select the appropriate tab on the left and use the scroll-bar to locate the record you are seeking. Highlight the appropriate record and select **GO TO SELECTED**. To narrow or change the search, type a new keyword and
select **FIND**. You can also go directly to an associated list by selecting it from the Jump To menu.

---

**Working with History Documents**

Transactional documents—receipts, vouchers, memos (and transfer slips in Pro Multi-Store)—are stored in document history lists, called *Sales History*, *Receiving History*, *Adjustment History*, etc., after being saved.

These history documents can be viewed in the corresponding list, copied to create new documents, or reversed if they need to be canceled or corrected. Editing history documents is limited to certain informational fields as outlined later in this section.

**To access a document history list:**

1. Select **RECEIVING HISTORY**, **SALES HISTORY**, or **ADJUSTMENT HISTORY** from the appropriate menu (Purchasing, Point of Sale, and Inventory, respectively). Pro Multi-Store users also can select **TRANSFER HISTORY** from the Inventory menu.
2. Use normal sort, search, and filtering procedures to locate the document you need. Searching for a history document (via the **FIND** button) is done across all documents included in your history list, even if the list is filtered to display only selected documents.

---

**Viewing Document Financial Exchange History**

The I Want To menu of each document history list offers the ability to view the Financial Exchange history of documents with QuickBooks financial software.
Highlight a document and select **FINANCIAL** from the I Want To menu to open the Financial History window for that document.

Select the **OPEN IN QUICKBOOKS** button to view the associated entry in your financial software.

Refer to **Verifying the Exchange of Individual Transactions (page 490)** for more information about Financial History document links.

---

**Editing or Reversing History Documents**

Editing of history documents is limited to certain informational fields. These documents affect your inventory value, record the exchange of monies from/to your customers, and may have already been sent to and updated your financial records in QuickBooks. Limiting the ability to edit these documents ensures that you always have an audit trail of all activities affecting your inventory and financials.

The informational fields that can be edited vary by document. For example, on receiving vouchers, if you have elected to enter vendor billing information in Point of Sale (a preference setting), you can edit to add the invoice information, freight, fees, and discounts, because that information may not have been available when the item was received. You can edit certain information fields on a sales receipt, however, you cannot edit any field affecting the item quantities, amounts, payments, or total transaction amount. The editable fields on a saved document are indicated by their color; white fields can be edited, grayed out fields cannot be edited.

If you exchange information with QuickBooks financial software, editing becomes even more restrictive once the information has been sent to your financial software (with some exceptions on receiving vouchers). Likewise, multi-store users at remote stores cannot edit documents once they have sent the information to Headquarters.

To correct a history document other than for the editable information fields you must instead reverse the original document and then, if necessary, create a new corrected document with the intended effect. This procedure corrects document errors and properly updates inventory, referenced order documents, and your financial software, as well as providing an audit trail of changes.
A Reverse, Copy, and Correct approach can be used to make a new document and correct any mistakes made on the original document. First, reverse the original, incorrect document. Then begin a new document by copying the original one. Finally, make corrections to the copy and save as usual.

Reversing a history document has the opposite effect on inventory of the original. For example, if the original document was a sales receipt that subtracted items from inventory, then reversing it adds the items back to inventory. It does this by creating a new reversing document. In the case of a sales receipt, the reversing document is a return receipt. A receiving voucher is reversed with a return voucher, and so on.

If an original transactional document referenced an order document, reversing the document also updates the order document's fill status and balances (assuming the order document has not been deleted).

Refer to individual chapters for specific information about the effect of reversing specific document types.

To reverse a history document:
When this procedure is completed, the original history document will be flagged Reversed in the Status field and the new document that was created will be flagged Reversing. The Status field is displayed in the history list only.

1. Highlight or display the document to be reversed.
2. Select REVERSE <DOCUMENT TYPE> from the I Want To menu.
   The Reversing Document window is displayed.
3. Enter your name in the Associate field.
   The Associate field will be auto-filled with the current user's name if security is being used. Otherwise, you can select your name from the drop-down list.
4. Select OK to confirm the reversal.
   A reversing document is automatically created and added to the history list.
   A corrected document can then be made as described below.

To copy and correct a reversed document:

1. Reverse the original document as described above.
2. Highlight or display the original document again (status Reversed).
3. Select COPY. A new document is opened with the same information as the original.
4. Make any necessary edits to correct the information on the new document. If the document is a receipt, record payment method(s) and amounts as usual.
5. Select SAVE & PRINT or SAVE ONLY.

(Pro Multi-Store) Reversing a document is available only until the document has been sent to Headquarters in a Store Exchange. However, a remote can correct the effect of
Temporarily Holding Documents

a history document after sending to Headquarters by manually creating a return document of the same type with the same items, costs, prices, quantities, etc.

Refer to Chapter 33 Exchanging Store Information (page 561) for more information.

Items Deleted From Inventory

If an item listed on a reversed document no longer exists in inventory, the reversing action adds it back to inventory. This is necessary because the quantity or cost change effected by the original document can only be reversed if the item is in your item list.

Effect of Reversing and Correcting on QuickBooks Financial Records

When you reverse a document and then create a new corrected one, your QuickBooks financial software records are updated accordingly when the documents are sent to your financial software during the next Financial Exchange.

Temporarily Holding Documents

The hold feature, available on all transactional documents, allows you to temporarily place a document on hold before you save it. Meanwhile, you can create other documents, carry out other activities, or even exit from Point of Sale.

For example, if you begin to ring up a sale but the customer forgot something and needs to go retrieve it, you can put their receipt on hold. Then, while the customer is gone, instead of waiting or losing the data you have already entered, you can perform other activities, including making another sales receipt. When the first customer returns, simply un-hold the receipt and complete it. Holding a document does not affect inventory.

Held documents are stored in a separate list for each transaction area. Held documents can be printed. The ability to hold documents is controlled by security rights if you are requiring users to log in. If the user does not have sufficient security rights, the Manager Override function can be used. Refer to Manager Override (page 70) for more information.

To hold and un-hold a document:

1. From the document in progress, select HOLD <DOCUMENT TYPE> from the bottom toolbar.
   Another blank form of the same document type opens so you can immediately make another document
2. To retrieve the held document, select **HELD <DOCUMENT TYPE>** from a new document of the same type or from the appropriate text menu, for example, you would select from the Point of Sale menu for held receipts.

3. From the list of held documents displayed, locate and select the document with which you wish to work.

4. Select **UNHOLD <DOCUMENT TYPE>** from the bottom toolbar.

5. Complete the document and print or save normally.

**Notes about held documents:**

- The document number is temporarily replaced with *Held* and then renumbered with the next available number when taken off hold. If you print a held document the word *Held* is printed in place of the document number.
- To view a held document without unholding it, highlight it and then select **VIEW <DOCUMENT TYPE>**
- To delete a held document, select **DELETE** from the I Want To menu.
- To leave the list without unholding a document select **CLOSE** at the bottom of the window.

---

**Held Documents in a Multi-Workstation Installation**

A held document can be accessed and un-held from any networked workstation within a store.

**Held Documents Retain Original Information**

If changes are made to data in other modules while a document is on hold, such as inventory prices or costs, sales tax rates, vendor terms, or a customer discount, that document will not automatically reflect the new information when it is un-held. The un-held document retains the original information you entered. If you know changes have been made in these values while the document was on hold, you will need to clear and re-list the item(s), vendor, and/or customer, as applicable, in order to reflect the new values.
Chapter 3  General Printing Information

Printing in Point of Sale ................................................................. 40
Changing Print Options at Time of Printing ................................ 41
Printing Records or Documents ...................................................... 42
  Ordering Receipt Supplies .......................................................... 42
Printing Tags and Labels ............................................................. 43
  Supported Tag and Label Styles .................................................. 43
  Ordering Tags and Labels ............................................................. 44
Printing Price Tags ................................................................. 44
  Inventory Price Tags ................................................................. 45
  Bar Codes on Tags .................................................................... 46
Printing a Reference Price (MSRP) on Tags ................................. 47
Printing the Cost and Last Received Date in Code on Tags .......... 47
Multi-Store: Printing Tags For Other Stores ................................. 48
Markdown or Discount Tags from Price Manager .......................... 48
Printing Mailing or Shipping Labels ............................................. 50
Importing Print Templates ......................................................... 51
Printing in Point of Sale

When you print documents, records, or tags, the layout is determined by the document template you specify in workstation preferences. A selection of document template files is provided with Point of Sale. To allow for each workstation to have a different printer configuration, printing instructions are set up for each workstation independently.

Preferences: Specifying Printers and Print Templates

EDIT ➤ PREFERENCES ➤ WORKSTATION ➤ DOCUMENTS AND PRINTERS ➤ Printing. For each document type, specify a printer to use, a template (make sure it matches your printer, i.e., don't choose a letter-size template to print on a 40-column printer), and the number of copies to be printed. Use the PREVIEW or PRINT TEST PAGE options to see the results of your selections. These choices are the defaults for printing each document type.

Preferences: Print Options

EDIT ➤ PREFERENCES ➤ WORKSTATION ➤ PRINT OPTIONS. Specify print options, such as for printing gift receipts, pausing between pages, and whether the Print dialog should be displayed when printing. The Print dialog lets you change printer, template, and number of copies for that specific print job.

Pro Tip: Customizing Document Templates

Pro users can customize document and tag templates using Print Designer. Refer to Chapter 35 Customizing Printed Documents (Pro) (page 593) for more information.

Printing and Saving

If you select PRINT from the Print menu on a voucher, memo, or slip as you are creating it but before saving, the document will be both printed and saved. Receipts cannot be printed until after payment has been accepted.

Supported and Compatible Printers

These instructions assume you use a QuickBooks-sold and supported printer. Other compatible printers may be used with Point of Sale, but the procedures for printing with these may vary and Intuit does not support these printers. Refer to Appendix D Compatible Hardware (page 681) for more information.
Changing Print Options at Time of Printing

If need be, you can change your printer, template, and other print options on-the-fly from the Print dialog. This feature is controlled by settings in workstation preferences.

To change your print options at time of printing:

1. Select to print the document as you normally would.
   The Print dialog is displayed.
2. Change the printer if needed.
3. To change the document template, select **MORE OPTIONS**.
4. Select the template you wish to use from the drop-down list.
   You may preview the template as needed.
5. Select **PRINT** to print the document using the new settings.

Changing Your Default Template

While previewing a template from this dialog, you can make it your default template for future printings by selecting the checkbox labeled **MAKE THIS THE DEFAULT TEMPLATE WHEN PRINTING THIS DOCUMENT AT THIS WORKSTATION.**
Chapter 3: General Printing Information

Printing Records or Documents

**To print a non-document record or list of records:**

This procedure applies to your item, customer, vendor, department, and employee lists.

1. Display the list you wish to print.
   
   If you want to print a group of records in a list, filter your list to display only the records you want to print. You can use the multi-select feature to select multiple records by holding down the `<CTRL>` key while selecting the records in a filtered or unfiltered list. See [Selecting multiple records (page 102)](#) for more information on using the multi-select feature.

2. From the Print menu, select **PRINT**.

**To print documents:**

Transactional documents (receipts, vouchers, memos, and transfer slips) are normally printed at the time you save them. Use this procedure to reprint those documents from your history list or to print order documents.

1. Highlight (list) or display (form) the individual document you wish to print. You can also use the multi-select feature to select multiple documents by holding down the `<CTRL>` key while selecting the documents. See [Selecting multiple records (page 102)](#) for more information on using the multi-select feature.

2. From the toolbar, select **PRINT**.

3. If presented with the Print Options dialog, you can:
   - Change the printer you want to use, if necessary
   - Specify a print quantity
   - Select **PREVIEW** to view the document before printing or **PRINT** to immediately print
   - Order documents provide the additional option to print all items on the document or just the due items.

**Ordering Receipt Supplies**

Receipt paper designed to work with the Point of Sale Receipt Printer can be ordered directly from QuickBooks. To order, please call 1-800-926-6066 or visit our web site at [www.intuitmarket.com/pos6](http://www.intuitmarket.com/pos6).
Printing Tags and Labels

Item tags can be printed from inventory, purchase and receiving documents, and when doing a physical inventory or changing prices in Price Manager.

Mailing and shipping labels can be printed from your customer list. Pro-level users also have the ability to print shipping labels from sales receipts and customer orders.

Tags and labels can be printed from dedicated tag and label printers as well as with most laser and inkjet printers. Point of Sale provides tag and label templates for a variety of shapes and sizes for both printer types.

Supported and Compatible Printers

Intuit sells and supports a tag and label printer for use in Point of Sale. In addition, other compatible printers (tested but not supported) may be used with Point of Sale, but the procedures for printing with these may vary from what is described in this section. Refer to Appendix D Compatible Hardware (page 681) for a list of supported and compatible printers.

Supported Tag and Label Styles

Most tag and label templates in these tables have multiple versions available to meet your needs. Look at the template suffix to identify a specific version; for example, “Intuit Label ALU” means the tag includes the item alternate lookup description rather than item name from inventory.

Roll-stock tags/labels for dedicated printers

Templates are provided for several types of roll-stock tags/labels. Not all templates are suitable for all compatible printers.

<table>
<thead>
<tr>
<th>Tag/Label Type</th>
<th>Size (Approx.)</th>
<th>Use Template Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hang Tags</td>
<td>2.25” x 1.35”</td>
<td>Intuit Hang Tag</td>
</tr>
<tr>
<td>Jewelry Tags with Flaps</td>
<td>2.1875” x 0.5”</td>
<td>Intuit Jewelry Tag</td>
</tr>
<tr>
<td>Jewelry Tags without Flaps</td>
<td>2.1875” x 0.5”</td>
<td>Intuit Jewelry Tag</td>
</tr>
<tr>
<td>Small Labels, adhesive</td>
<td>1.19 x 0.84</td>
<td>Intuit Label (small)</td>
</tr>
<tr>
<td>Labels, adhesive</td>
<td>2.25” x 1.25”</td>
<td>Intuit Label</td>
</tr>
<tr>
<td>Labels, adhesive</td>
<td>4” x 3” (460 labels per roll)</td>
<td>Label (4 x 3)</td>
</tr>
<tr>
<td>Labels, adhesive</td>
<td>4” x 6” (230 labels per roll)</td>
<td>Label (4 x 6)</td>
</tr>
</tbody>
</table>
Sheet labels for laser/inkjet printers

<table>
<thead>
<tr>
<th>Tag/Label Size</th>
<th>Labels Per Sheet</th>
<th>Use Document Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>1&quot; x 2.625&quot;</td>
<td>30 (3 across)</td>
<td>Avery 5160</td>
</tr>
<tr>
<td>1&quot; x 4&quot;</td>
<td>20</td>
<td>Avery 5161</td>
</tr>
<tr>
<td>0.5&quot; x 1.75&quot;</td>
<td>80 (4 across)</td>
<td>Avery 5167</td>
</tr>
<tr>
<td>3.33&quot; x 4&quot;</td>
<td>6</td>
<td>Avery 8164 or 5524*</td>
</tr>
</tbody>
</table>

* Avery 5524 is a weatherproof label suitable for printing with a laser printer only.

Ordering Tags and Labels

To order tags or labels directly from Intuit, please call 1-800-926-6066 or visit our web site at www.intuitmarket.com/pos6.

Printing Price Tags

You can print price tags for a single item or for all item displayed in a list or on a document. The default appearance of printed tags is determined by the tag template you have specified in workstation preferences. This can be changed at the time of printing. Refer to Changing Print Options at Time of Printing (page 41) for more information.

Tag printing is supported for a dedicated tag printer (Zebra LP2824 and LP2844 or compatible, using roll stock) and to inkjet/laser printers (using sheet labels).

Changing the Price on Tag Templates (Pro)

Print Designer allows you to change your tag template designs to specify other than the regular price. See Chapter 35 Customizing Printed Documents (Pro) (page 593) for more information.

Tip: Don’t Want to Print Tags for an Item?

If you never print tags for an item, clear the PRINT TAGS checkbox field on the item record in inventory. This way you will not inadvertently print tags for the item when printing tags for all the items received on a voucher, ordered on a PO, or displayed in a filtered list.
Inventory Price Tags

Tags printed from inventory or a document always print at your regular price. To print tags at other prices, set up a price change or discount in Price Manager (see below) and print markdown or discount tags.

To print tags from inventory or a document:

1. Highlight or display the item, item list, or document for which you want to print tags.
2. Select the item in inventory or on a document for which you want to print tags:
   • If you want to print tags for a group of items in inventory, filter your item list or use the Style window (Pro) to display the specific group of items for which you wish to print tags.
   • To print tags for only some of the displayed items, hold down the <CTRL> key on your keyboard and select multiple items. See Selecting multiple records (page 102) for more information on using the multi-select feature.
3. From the Print menu, select PRINT TAGS.
4. Depending on your printer and template, Print Options dialogs are displayed where you may:
   • Change the printer you want to use
   • Choose to print tags for the selected item, all items, or all style items
   • Specify a quantity of each tag to print: the on-hand quantity, the document quantity, or any specified quantity
   • Change the tag template
After specifying options, select PREVIEW or PRINT

If you are using a dedicated tag printer, your tags will immediately be displayed or printed. If you are using a laser or inkjet printer and sheet labels, the Print Tags/Labels window is displayed and the following steps apply.

5. Specify where you want to begin printing on the first page:
   • Choose the Column and Row numbers where you want the tags to begin printing, if necessary. (The default is Column 1, Row 1.) This adjustment makes it possible to print on partial sheets of labels.
6. Optionally, select ALIGNMENT to check the start position of printed text and to adjust by 1/100-inch increments.
Chapter 3: General Printing Information

Select **PRINT SAMPLE** to print a test sheet for confirmation. *(Tip: use plain paper and hold up to a tag/label sheet to check alignment).*

7. At the **Print Tags/Labels** window, select **CONTINUE** to print or preview your tags (as selected in Step 4).

---

**Tip: Calibrating the Zebra LP2824 or LP2844**

When you change label types, or anytime printing is misaligned on labels, you should calibrate the Zebra printer by selecting the **CALIBRATE** button on the Select Document Template window. Several labels will be fed through the printer during this operation. When calibration is complete, you can roll the labels back into the printer to avoid waste.

An additional checkbox option may appear when using the LP2844 with jewelry tags.

---

**Tip: Printing Tags from Other Documents**

If you need to print tags from documents other than receiving vouchers or purchase orders, choose **SELECT** from item list from the I Want To menu to inventory first. You can print the tag from inventory.

---

**Multiple Units of Measure (Pro)**

If you are using multiple units of measure, tags will only be printed for the default sell by unit. Entering the UPC for other quantities on the item record will allow you to scan the manufacturer barcode for the other unit quantities. For example: if you usually sell sodas by the can, but also sell by the 6-pack or case, your default sell by unit would be the can, and you can scan the UPC barcode for the 6-pack or for the case as long as you have the UPC entered for that unit of measure.

*See Multiple Units of Measure (Case-to-Unit) (Pro) (page 185) for more information on multiple units of measure.*

---

**Bar Codes on Tags**

The default tag templates use inventory item numbers to print bar codes on tags. Using the item number for bar codes has several advantages:

- You can print bar-coded tags for any item in inventory, even if you do not have a vendor-provided UPC code.
- The relatively small bar codes created from item numbers fit well on smaller tag sizes.
- If a tag bar code is not scannable due to damage, it is quicker to manually enter an item number (also printed on the tags) than the longer UPC or alternate lookup values.
Bar codes on tags allow you to lookup and list any item in your inventory using a bar code scanner.

Refer to Using Bar Codes and Scanners (page 90) for more information.

(Pro) If preferred, you can use Print Designer to change the bar code field on printed tags to reflect UPC or alternate lookup values. Refer to Working with Bar Codes (page 612) for more information.

### Printing a Reference Price (MSRP) on Tags

You can demonstrate savings to your customers by printing the manufacturer’s suggested retail price (MSRP) on your tags along with your own price.

MSRP is automatically printed on price tags (space permitting) if you have entered a price in the **MSRP** field in an item’s record in inventory.

Refer to Item Information Fields (page 647) for information on entering information in item records.

### Printing the Cost and Last Received Date in Code on Tags

You can include an item’s cost and its last received date in a specialized code that is defined in preferences. Only informed employees will know what the code means.

For the cost and last received dates to be included in code on tags (assuming you have already defined the code in preferences), you must select a tag template with a suffix of “+ cost”. Example: Avery xx60 series + cost.

These templates contain the **Cost Code** and **Last Received Code** fields and the information in these fields will be printed in code.
Example: Using the code shown above, an item with a cost of $100.00 and last received on 09/08/05 would result in printed tag codes as shown below. With a defined code \( a = 1 \) and \( j = 0 \) the cost in code is \( aijj j \) (including decimal places). Decimal points and date separators are ignored.

Multi-Store: Printing Tags For Other Stores

Multi-store users have the ability to print tags for other locations from Headquarters.

To print for other locations:

1. Begin the process of printing tags as you normally would.
2. When the Print dialog window appears, select from the drop-down list to choose the store for which you want to print tags.
3. Make any other needed changes in the Print dialog.
4. Select PRINT.

Markdown or Discount Tags from Price Manager

When using Price Manager to change item prices or, for Pro-level users, offer discount prices, you can print, markdown, discount, or regular inventory price tags. Markdown and discount tags are a good way to communicate savings to your customers.

Markdown and discount tag templates, different than your inventory tag template, are specified in your Documents & Printers workstation preferences. See Price Manager (page 196) for general Price Manager instructions.
Printing Tags and Labels

**Markdown Tags.** Includes both old (lined out) and new price. Both prices come from the price level you specify for the price change.

![Markdown Tag]

**Discount Tags.** Includes the regular item price and the discount terms and price. Shown is a sample tag for a “X for $Y” discount type.

![Discount Tag]

**Inventory Tags.** Includes the current item price only. This is the same as printing tags from your item list. Note that on a price change, this value will be different depending on the status of the price change. If “pending,” the old price is printed since the new price has not yet been applied. If “applied” the tag will print with the new price. And if “restored,” it will again print the old price.

**To print tags in Price Manager:**

1. Calculate a price change or set up a discount price and display the record.
2. On a price change, select **ITEMS WITH NEW PRICES** from the View drop-down to display only those items for which you have changed prices.
3. If printing tags for a single item, select it. You can also use the multi-select feature to select multiple items by holding down the `<CTRL>` key while selecting the items. See **Selecting multiple records (page 102)** for more information on using the multi-select feature.
4. From the Print menu, select the type of tag you wish to print.
5. Change options in the Print Tags dialog as necessary and select **PRINT**:
   - Choose to print tags for the selected item or all displayed items
   - Specify to print tags for the on-hand quantity or a quantity you specify
   - Change the tag print template used
   - For sheet labels, specify where you want to begin printing on the first page
Chapter 3: General Printing Information

Printing Mailing or Shipping Labels

You can print mailing/shipping labels from your customer list or from individual customer records.

To print mailing/shipping labels from customer records:

1. Display your customer list or an individual customer record.
2. If on an individual customer record, select **PRINT A LABEL** below the customer address fields.

   OR

   If in the customer list, select the customer or customers for whom you want to print labels and then select **PRINT BILL TO ADDRESS LABEL** (Pro users can also choose **SHIP TO ADDRESS LABEL**; the default shipping address is used).

To print for a group of customers, such as by ZIP Code, filter the list first to display just those customers. You can also use the multi-select feature to select multiple records by holding down the `<CTRL>` key while selecting the records. See **Selecting multiple records (page 102)** for more information on using the multi-select feature.

3. Specify the following print options in the Print dialog:
   - Change the printer used, if necessary
   - Specify to print labels for the selected customer(s) or for all displayed customers
   - Specify the number of labels to print for each customer
   - Preview and/or change print template (select **MORE OPTIONS**, if necessary, to access).

4. Select **PRINT** or **PREVIEW**.

5. If printing to sheet labels, specify a start position (for printing on partial pages of labels) and then select **CONTINUE**. If necessary, you can also align your printer from this dialog.

(Pro) A label can be printed from any of the addresses entered on the customer record and from sales receipts and customer orders. When shipping information is added to a sales receipt, the shipping information, including carrier and tracking number is printed on the receipt given the customer. If you use Shipping Manager, the shipping address from Point of Sale is sent to Shipping Manager and used to print a bar-coded shipping label meeting carrier specifications. Refer to **Recording Shipping Information (Pro)** (page 365) for more information.
Importing Print Templates

From time to time it may be necessary to get updated print templates to meet legal requirements for printed documents in your area or to more effectively reflect your business practices. Pro-level users of Point of Sale can create their own custom templates, but Basic-level users may at times have access to updated templates through QuickBooks Point of Sale advisors, accountants, or Intuit technical support. This option allows you to import those templates into Point of Sale.

**To import print templates:**

6. Obtain and save the print template file to your computer. (Print template files end in an .xml file extension.)
7. From the File menu, select **UTILITIES ➤ IMPORT PRINT TEMPLATES**.
8. Select **IMPORT** on the message displayed.
9. Browse to the template file in the Import Document Templates window and select **OPEN**.
10. Select the new template(s) in your workstation Documents & Printers preferences. Pro-level users refer to [Chapter 35 Customizing Printed Documents (Pro) (page 593)](#) for information on editing or creating print templates.
## Chapter 4  Employees

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employees Overview</td>
<td>54</td>
</tr>
<tr>
<td>Working with Employee Records</td>
<td>55</td>
</tr>
<tr>
<td>Employee List</td>
<td>55</td>
</tr>
<tr>
<td>Adding a New Employee</td>
<td>56</td>
</tr>
<tr>
<td>Custom Fields (Pro)</td>
<td>57</td>
</tr>
<tr>
<td>Copying Employee Records</td>
<td>57</td>
</tr>
<tr>
<td>Viewing or Editing Employee Records</td>
<td>58</td>
</tr>
<tr>
<td>Deleting Employees</td>
<td>58</td>
</tr>
<tr>
<td>Printing and Exporting Employee Lists and Reports</td>
<td>59</td>
</tr>
<tr>
<td>Tracking Employee Commissions (Pro)</td>
<td>60</td>
</tr>
<tr>
<td>Calculating Commissions on Sales</td>
<td>60</td>
</tr>
<tr>
<td>Employee Time Clock (Pro)</td>
<td>61</td>
</tr>
<tr>
<td>Using Time Clock</td>
<td>62</td>
</tr>
<tr>
<td>Clocking In/Out</td>
<td>62</td>
</tr>
<tr>
<td>Managing Time Entries</td>
<td>62</td>
</tr>
<tr>
<td>Time Clock Reports</td>
<td>63</td>
</tr>
</tbody>
</table>
Employees Overview

In the Employees area, you can maintain employee contact information and, for Pro users, set up employee commissions and hourly time tracking.

If you require employees to log in to use Point of Sale (highly recommended), you also designate the employee login name, password, and security group on the employee record.

The security features of Point of Sale are detailed in Chapter 5 Data and Program Security (page 65) but since they are so integral to working with employee records, we will assume that security is being enforced as we go through this chapter.

Point of Sale employee and security features allow you to:

- Record and maintain detailed employee contact information
- Limit employee access rights to program features and data by assigning user names, passwords, and security rights
- Customize security rights by group to meet your changing security requirements
- Allow employees to change their own passwords, without them viewing their entire record
- (Pro) Track employee sales commissions, with individualized commission rates
- (Pro) Track hours worked and then send time records to your QuickBooks financial software to assist with payroll

Point of Sale provides a number of specialized employee reports in the Report Center. Available reports vary depending upon the level of Point of Sale you have purchased and the features you choose to use. See Chapter 26 Reports and Sales Charts (page 459) for more information on reports in Point of Sale.
Employee List

There is one default user, called Security System Administrator (Sysadmin or Administrator), that is automatically defined in Point of Sale. This user has full rights to all program features and cannot be renamed or deleted.

If you have turned on the security features in Point of Sale, only the Administrator has the right to add and delete employees, assign or change passwords for other employees (though each user can change their own), turn on/off the requirement to log in to use Point of Sale, and complete other data maintenance tasks.

If security logins are already set up, access to the Employee list is restricted by the security rights granted.

To access the employee list:

1. From the Employees menu, select **EMPLOYEE LIST**.
   
   Your employee list is displayed

2. Select an action from the toolbar, such as **NEW EMPLOYEE** to add an employee record.

   The employee list can be sorted by any of the included columns/fields. To sort the list, click any column header. Click the same header again to sort in the opposite order (ascending or descending).

   Once sorted, you can locate an employee by scrolling through the sorted list. Double-click an entry to open the individual employee record for viewing or editing.

   You can add, remove and/or rearrange the columns and adjust their widths to suit your needs. Refer to **Customizing Columns in Lists (page 586)** for more information about customizing list columns.
Adding a New Employee

If employee logins are required, only the Administrator can add new employees.

To add a new employee:

1. With the Employee list displayed, select NEW EMPLOYEE from the window toolbar.
2. Enter employee information in the various fields as described below:
   - Login Name: Assign a unique alphanumeric employee login name (spaces and special characters cannot be included). This name will be used only for logging in. Once saved, it cannot be changed.
   - Employee Name and Contact Information: Enter the employee’s first and last name, address, phone, and e-mail address as appropriate.
   - Create Password: If a password is entered into the employee record and logins are required to use the program, then the employee must enter this password upon logging in. Enter a password and enter it a second time for confirmation. Refer to
   - Security Group: Displays the available security groups that can be assigned to the employee. Select from the drop-down list to assign a security group.

To view the rights assigned to each security group, select VIEW/EDIT SECURITY RIGHTS from the I Want To menu.
Working with Employee Records

- **Employee Notes**: Select the Custom tab and enter optional notes concerning schedules, vacations, etc.

- **Commission % (Pro)**: If you pay your employees a commission on sales, enter the employee’s commission percentage. Refer to Tracking Employee Commissions (Pro) (page 60) for more information.

- **Hourly (Pro)**: If the Time Clock feature is being used, check this box to track time for the employee. Refer to Employee Time Clock (Pro) (page 61) for more information.

3. Select **SAVE**.

### Custom Fields (Pro)

You can add up to seven custom fields to record additional employee information important to your business. You can access these fields on the Custom tab of the employee record. Custom fields can be used as filters for on certain reports. Refer to Custom Fields (Pro) (page 590) for more information.

### Copying Employee Records

You can quickly add a new employee by copying information from an existing employee’s record. Copying opens a new employee record with most of the same information as the original. Simply edit as needed and save.

Only the Administrator can use this feature.

**To copy an employee record:**

1. Display your employee list.

2. Highlight or display the employee whose record is to be copied. (Note: You cannot copy the Administrator’s record.)

3. From the window toolbar, select **COPY**.

   All information except the Login name and password is copied to a new record.

4. Enter or edit the new employee’s Login name, personal information, security group assignments, password, and so on.

5. Select **SAVE**.
Chapter 4: Employees

Viewing or Editing Employee Records

The default Owner, Manager, and Assistant Manager security groups can access employee records to change contact information and other non-critical settings. Only the Owner group and the Administrator can change the security rights granted to the employees.

To view or edit employee records:

1. Display your employee list.
2. Select the employee whose record you want to view or edit and select EDIT EMPLOYEE from the window toolbar, or double-click the record in the list. The employee’s record is displayed.
3. Edit the employee’s record as needed.
4. Select SAVE.

Tip: Use List Edit Mode to Quickly Edit Several Employee Records

With list edit mode turned on, you can simply move down through a column making changes similar to working in a spreadsheet. Display your list, then select EDIT ➤ TURN LIST EDIT ON. Make changes as needed, then select EDIT ➤ TURN LIST EDIT OFF. This is a quick way to re-assign security groups, change a ZIP Code, or make other wholesale changes. Refer to Working with Lists and Forms (page 100) for more information.

Deleting Employees

Only the Administrator can delete employees.

To delete an employee record:

1. Display your employee list.
2. Select the employee record(s) you want to delete.
3. From the I Want To menu, select DELETE EMPLOYEE. A confirmation window is displayed.
4. Select DELETE to delete the employee record(s).

Important: When an Employee Leaves

When an employee leaves your company, we recommend that you delete their record or, if you want to keep the record for other purposes, immediately assign a new password unknown to the employee and assign a security group with no rights.
Printing and Exporting Employee Lists and Reports

You can print your employee list and you can run a number of employee reports, including an Employee List report. The report gives you more flexibility in formatting and filtering the printout.

To print your employee list:
1. Display your employee list.
   If you want to print just part of the list, filter it to display only the records you want to print or multi-select records directly in the list. See Selecting multiple records (page 102) for more information on using the multi-select feature. To print the entire list, make sure the list filter is set to display all records.
2. Select PRINT.
3. Choose to print the selected records or all displayed records and select OK.

To print your employee list as a report:
1. From the Reports menu or the Report Center, select EMPLOYEES ➤ EMPLOYEE LIST.
   The employee list report is displayed, with default settings.
2. Select MODIFY to change report criteria, filters, and display options as needed.
3. Select OK.
   The report will re-generate with your settings and be displayed on the screen.
   Select PRINT PREVIEW, PRINT, or EXCEL to respectively view, print, or export the report.

Other employee reports include Employee Sales (report or graph) and, for Pro-level users, Employee Commissions. Refer to Chapter 26 Reports and Sales Charts (page 459) for more information on running reports.

To export your employee list:
You can export your employee list via a report as described above, or use the procedure to print your list but, instead of selecting print, select EXPORT TO EXCEL from the I Want To menu. Refer to Exporting Data (page 126) for more information on exporting lists.
Tracking Employee Commissions (Pro)

If you pay your employees sales commissions, Point of Sale can calculate and report the commissions for you. Each employee can be assigned a commission rate and items can be marked in inventory as eligible or not for commission.

To assign or change employee commission rates:
1. Highlight an employee record in your Employee list and select **EDIT**.
2. Enter a commission percentage in the **Commission** field.
   Acceptable entries are 0.00 to 99.99.
3. Select **SAVE**.

To assign commission status to an item:
1. In inventory, display an item record (while adding or editing).
2. On the Additional Info tab, select the checkbox labeled **ELIGIBLE FOR COMMISSION**.
   • If the box is checked, commissions are calculated on sales of the item. If commission is not to be paid on the item, be sure the checkbox is cleared.
   • If you use styles, you can change this setting for all style items at once on the Style window.
3. Select **SAVE**.

Calculating Commissions on Sales

The commission calculation is based on the employee name in the **Associate** field on the sales receipt and the employee’s assigned commission rate. If security is being used, the **Associate** field is suggested as the logged in employee, but can be edited (if, for example, you have floor sales people but a cashier is the user logged in).

The **Associate** field can be edited on a sales receipt on either a document level or on an item-by-item basis. In the example shown, Ron is the receipt associate but Dan will collect the commission on the second item sold. This allows you to pay commissions to multiple employees on a single sales receipt.
You can report on employee sales and commissions by running a *Employee Commission* report. Commission information is not sent to QuickBooks financial software.

Refer to *Chapter 26 Reports and Sales Charts (page 459)* for instructions on running reports.

---

**Employee Time Clock (Pro)**

You can use the Time Clock feature in Point of Sale to track employee hours worked. Employees clock in and out at the beginning and end of their shifts. Managerial tools are available for when adjustments are needed and Time Clock reports can help you with your payroll. In a multi-store environment the Time Clock information is sent to Headquarters from remote stores.

To utilize this feature you must turn on time tracking in Point of Sale and specify which employees’ hours you wish to track. Security logins are not required for this feature.

If you are integrated with QuickBooks Financial Software 2008, time records can also be sent to your financial software for payroll purposes. Refer to *Employee Time Records (Pro) (page 511)* for more information.

**To turn on employee time tracking:**

1. Go to *PREFERENCES ➤ COMPANY ➤ GENERAL ➤ OPTIONS* and select *I WANT TO TRACK EMPLOYEE HOURS*.
2. Select *SAVE*.
3. Access the employee list from the Employees menu.
4. Open the record for the employee whose hours you wish to track.
5. Select the **HOURLY** checkbox to begin tracking hours worked for this employee.
6. Select **SAVE**.
7. Repeat steps 4-5 for additional employees as needed.

**Using Time Clock**

**Clocking In/Out**

This is where employees will clock in and out to record their hours. It is not necessary for the user that is clocking in/out to be logged in to complete this task.

**To clock in or out:**
1. From the Employee menu, select **CLOCK IN/OUT**.
2. Select your user name from the drop-down list.
3. Enter your password (if applicable).
4. Select **CLOCK IN** or **CLOCK OUT** as appropriate.

**Managing Time Entries**

The following management features for Time Clock are available from the Employees menu. It is recommended that you use security rights to restrict access to these features.

**To make a new Time Clock entry for an employee:**
1. From the Employee menu, select **NEW EMPLOYEE TIME ENTRY**.
2. Select the employee’s login name from the drop-down list.
3. Select the correct date and time the employee should have clocked-in.
4. If employee isn’t still working, select the date and time the employee should have clocked-out.
   
   **Or**
   
   In the **Elapsed Time** field, enter the number of hours the employee worked in the hh:mm format (4:00, 6:30, etc.) and then select `<ENTER>`. The time **Out** field will be automatically populated with the correct clock-out time.
5. Select **SAVE**.
**Time Clock History.** From the Time Clock History window, you can review, edit, copy, or delete time records or select a Time Clock report from the I Want To menu. If you send time entries to QuickBooks, you cannot edit a time record in Point of Sale after it has been sent to QuickBooks.

**Manage Clocked-in Employees.** Displays a list of employees that are currently clocked in. You can clock employees out from this panel, if necessary.

**Time Clock Reports**

Time Clock Reports can be accessed either from the Report Center, or from the I Want To menu in the Time Clock History window. The available reports are:

- Weekly Time Sheet; hours worked by day and totaled for the week by employee (same format as used by QuickBooks financial software)
- Time Clock Detail; a listing of individual time entries
- Time Clock Summary; totals the time worked by employee
Chapter 5  Data and Program Security

Why is Security Important? .................................................. 66
About the System Administrator ........................................ 67
About Passwords ............................................................... 67
Requiring Employee Logins ............................................... 68
Logging In/Out ................................................................. 69
Manager Override ............................................................ 70
Employees Changing their own Passwords ......................... 71
Working with Security Groups .......................................... 71
Viewing and Editing Security Groups ................................. 72
Adding Custom Security Groups ....................................... 73
Deleting Groups ............................................................. 74
Protecting Your Data ......................................................... 74
Backing Up Your Data ...................................................... 76
Types of Backups ............................................................ 77
Backup Methods ............................................................. 77
Rotating Backups ............................................................ 80
Restoring Your Data from Backups ................................... 81
Why is Security Important?

As with any small business, the data that you accumulate and the investment you make in inventory, your employees, and your computer system is very valuable and very vulnerable if you don’t take steps to protect your investment. Carefully consider each of these aspects of your business to ensure that you have an adequate level of protection at each point.

Many areas in Point of Sale can be restricted; from holding a receipt, to giving a discount, to viewing critical financial information about your company operations, such as item costs or your vendor contacts.

Taking advantage of Point of Sale security features to safeguard this information only makes sense and, if you use the QuickBooks POS Merchant Service to process credit or debit card transactions, is a requirement to protect cardholder’s data (see note below).

Restricting access to your company data and Point of Sale features requires that you assign each a user name, password, and security group assignment, and then require them to log in to use Point of Sale. Only the features you specify will be available, based on the logged-in user’s assigned security group. Another benefit of requiring employees to log in is that the employee name is then automatically added to all documents created, giving you the ability to run sales reports, track sales performance, and maintain accountability by employee.

Securing your business also includes such things as using a firewall and anti-virus software, not leaving workstations unattended when a employee is logged (especially the Administrator account), making backups of your data, and physically securing the systems that are the lifeblood of your business.

---

**Important: Not Requiring Logins**

If you don’t require logins, every employee has access to all features, areas, and data in Point of Sale. You are strongly encouraged to require employee logins and assign security rights to control access.

---

**Complying with the Payment Card Industry Data Security Standard (PCI DSS)**

If you use the QuickBooks POS Merchant Service to authorize and settle credit and/or debit card transactions, you have a responsibility to comply with PCI DSS requirements. This industry standard sets requirements for the configuration, operation, and security related to processing, transmitting, and storing cardholder data. Refer to Protecting your Customer’s Card Data (page 383) for more information on these requirements.
**About the System Administrator**

There is one default user, called the Security System Administrator (Sysadmin or Administrator), that is automatically defined in Point of Sale. This user has full rights to all program features and data and cannot be renamed, copied, or deleted.

Once security is initially turned on, only the SysAdmin has the right to turn on/off the requirement to log in to use Point of Sale, to add and delete employees and assign passwords (though each user can change their own), and to complete certain sensitive data-related tasks.

After the administrator has added employees and turned on the requirement to log in, each employee must use their designated login name and password to access the program. The rights assigned to the logged-in user are then enforced.

---

**Important: Use the SysAdmin Login Only for System or Employee Setup**

It is strongly recommended that the SysAdmin log in only when required to configure system settings, define employees and passwords, or complete data tasks that require it.

At all other times you should log in as a user with only the security rights needed to complete your routine activities.

---

**About Passwords**

The Sysadmin should initially set employee passwords to a unique value and then require each individual to change it upon first login. If you allow vendors or advisors to access your data, it is recommended you provide them with user accounts and passwords, but only for the duration of time required for them to perform their services.

Do not use group, shared, or generic accounts or passwords. If you write your password down, store it in a physically secure place. Never leave written passwords in the physical vicinity of your workstations.

In Point of Sale, we recommend the use of “complex” passwords for all users and all processes. This is especially important for the SysAdmin, who has access to virtually all data and features.

---

**PCI DSS Requires Complex Password for SysAdmin**

While Point of Sale does not enforce complex passwords, it is a requirement for PCI compliance that the SysAdmin account be protected by a complex password. Refer to Protecting your Customer's Card Data (page 383) to learn more about PCI requirements.
Chapter 5: Data and Program Security

What is a complex password?

While the definition of a complex password may vary in other programs, for purposes of Point of Sale a complex password meets these rules:

- Is at least seven characters long
- Include at least one each of numerals, lower-case letters (a,b,c...), upper-case letters (A, B, C,...), and special symbols (any other keys)
- Is changed at least every 90 days

Important: When an Employee Leaves

When an employee leaves your company, we recommend that you delete their record or, if you want to keep the record for other purposes, immediately assign a different password and security group. We suggest you set up a security group with no rights and assign former employees to this group if keeping the record intact.

Requiring Employee Logins

The requirement to log in, which turns on the security controls in Point of Sale, as well as automatic logout options, are set in preferences. Once enabled, only the SysAdmin can change this setting.

Preferences: Requiring Employees to Log In

PREFERENCES ➤ COMPANY ➤ GENERAL ➤ ✓ Require users to log in. Select to require employee login by name and password to use the program. This setting turns on the security features of Point of Sale. You are prompted to enter a password for the System Administrator (SysAdmin) when turning this requirement on. See password note below.

Preferences: Automatic Logout After Each Sale

PREFERENCES ➤ COMPANY ➤ GENERAL ➤ OPTIONS: ✓ Automatically log out user after each sale. Select to immediately and automatically log out after each sale is completed. An employee must log in to continue working in the program. This setting applies to all workstations on your network. This preference is often used when several employees are sharing a workstation and you want to ensure the employees are properly tracked on sales transactions.

Preferences: Automatic Logout After a Period of Inactivity

PREFERENCES ➤ WORKSTATION ➤ GENERAL ➤ SECURITY ➤ ✓ Automatically logout. Select to automatically log out the current user after a defined period of inactivity on this workstation. Specify the time period to be anywhere from 1 to 999 minutes.
Requiring Employee Logins

Tip: Tracking Employees without Requiring Logins
If you do not wish to restrict program access by requiring logins, you may still want to add your employees so that you can track sales and run reports that can be sorted by employee.

If logins are not required, but employees have been defined, they will be available for selection on any document that contains the Associate or Cashier fields. Many reports can be filtered by these fields.

Be advised that this setup allows all employees to access all features of Point of Sale, making your system and data less secure.

Changing Security Settings with Other Workstations in Program
If you change the login requirements or modify security groups, rights, and so forth, at one workstation while other workstations are working in the program, your changes do not go into effect at the other workstations until they either save a record, or they log out and then log back in.

Logging In/Out
When using security, users can easily log in and out of the program, and the security rights assigned to the logged in user will control the features that are available.

The log in/out procedure below assumes that login names, passwords, and security rights have been assigned to your employees. Refer to Working with Employee Records (page 55) for information about employee records and to Working with Security Groups (page 71) for more information on setting up security rights.

To log in:

1. You will be prompted to log in when Point of Sale is launched. Otherwise, from the File menu, select LOG IN/OUT (CTRL+Q) if the Login window is not already displayed.
2. Enter your user name and password. Note that passwords are case sensitive.
3. Select LOG IN.

The login window identifies the company data in use and the current date. The date displayed here will be suggested on all receipts and other documents created, but can be changed (security rights permitting).
The name of the logged in user is displayed on the status bar at the bottom of the Point of Sale screen.

**Touchscreen Login**

Touch **KEYBOARD** to access a touchscreen keyboard to enter your user name and password.

**To log out:**

In most cases, logging out is automatic, happening anytime:

- You exit the program
- Another user logs in (replaces the current login)
- An automatic logout takes place after a sale or due to inactivity

If none of these occur, and you need to manually logout for security purposes, select **LOG IN/OUT** from the File menu, choose your user name, and then select **LOG OUT**.

**Manager Override**

Many tasks can only be accessed or accomplished by users with sufficient security rights to perform them. The Manager Override function provides an option for those times when it may be necessary to accomplish a sales task for which the current user does not have sufficient rights.

For example, suppose a customer's file is flagged “Do Not Accept Checks.” A cashier in the Associate user group does not have the security right to accept payment by check in this case. However, a manager or owner with security rights to do so, can override the security limitations of the cashier and accept the check to complete the sale. The manager's security rights are only in effect for the specific action.

Only certain sales-related activities provide the Manager Override feature, such as the example above, or for exceeding a customer’s account limit, or applying a discount to a sale.

When a user attempts to perform an action for which they do not have sufficient rights, a message alerts them. This notification will vary depending on the particular action; however, the notification will provide an **OVERRIDE** button as shown to the right.
When the **OVERRIDE** option is selected, another user with appropriate security rights for the task can enter their user name and password in the Manager Override window to authorize the task.

The program is immediately returned to the previous user’s rights on task completion.

---

**Employees Changing their own Passwords**

All employees can change their own password when they are logged into Point of Sale. The employee does not have access to their full record during this procedure. Employees should be encouraged to change their passwords at least every 90 days.

**To change your own password:**

1. From the Employees menu, select **CHANGE EMPLOYEE PASSWORD**.
   
The change password window is displayed.
2. Enter your old password.
3. Enter a new password. Confirm the new password by entering it a second time.
4. Select **OK**.
   
You must use the new password the next time you log in to Point of Sale.

---

**Working with Security Groups**

By designating security groups for your employees, you can limit access to sensitive financial information and reports, and manage access to most Point of Sale features. Security groups specify the access rights for all employees assigned to that group.

Four predefined security groups are included in Point of Sale:

- Owner (all rights, except those restricted to the SysAdmin)
- Manager
- Assistant Manager
- Associate (fewest rights)
Individual employees can be assigned to specific groups, depending on the program access they require.

You can modify these groups, granting access rights of your choosing or create custom groups if needed.

The Point of Sale menus and toolbar buttons for features controlled by security rights are disabled if the logged-in employee does not have rights to access them.

### Viewing and Editing Security Groups

Using the predefined security groups, users can edit the rights of security groups and an employee’s group assignment as follows:

**Owner.** Edit the rights within a security group and change an employee’s group assignment.

**Manager, Assistant Manager.** View the security rights by group and view the employee’s group assignment, but cannot edit either (can edit other employee information).

**Associate.** Cannot access employee or security records.

**To view and edit a group:**

1. Select **SECURITY** from the Employees menu.
2. From the **View** drop-down list in the Security window, select the Point of Sale area for which you want to assign rights.
3. In the **SECURITY RIGHTS** column, select the checkboxes to grant specific security rights or clear the checkboxes to remove rights for each group.
   **Tip:** Use the **Find** field at the top of the list to locate specific rights by keyword. Searches are done only in the area currently selected in the **View** drop-down. Change the view to All Security Rights first, if necessary.
4. Repeat for all Point of Sale areas.
5. Select **SAVE**.
5. Assign employees to groups as necessary using the Security Group drop-down field on the employee records. Use the procedures described in Viewing or Editing Employee Records (page 58).

---

**Restoring Default Security Settings**

To return the default security groups to their default state, select REVERT DEFAULT GROUPS at the bottom of the security window, and then REVERT TO DEFAULTS in the confirmation window. Custom security groups will not be affected.

---

**Adding Custom Security Groups**

There are two ways to add a custom security group. You can copy an existing group and then edit the rights to create a new group with similar rights, or you can create a new group from scratch. In the latter case, the new group starts with no rights at all and you can build the group as necessary; this is a good choice for granting a user access to a very limited set of rights.

Assign employees to the new group as necessary using the Security Group drop-down field on the employee records. Use the procedures described in Viewing or Editing Employee Records (page 58)

**To copy a group:**

Employees assigned to the original group are not copied to the new group; you must manually assign them to the new group. You can copy the predefined groups or your custom groups to create a new custom group.

1. From the window toolbar in the Security window, select COPY GROUP.
2. Select which group to copy and provide a name for the new security group.
3. Select COPY GROUP.
   
   A new security group is created with the same security rights as the original.
4. Change the assigned security rights, as needed.
5. Select SAVE.

**To add a new security group:**

1. From the window toolbar of the Security window, select NEW GROUP.
2. Assign a unique group name and select OK.
   
   A column for the new security group is added to the Security window. No rights have been assigned.
3. Select the checkboxes for the rights you wish to grant the group.
4. Select SAVE.
Chapter 5: Data and Program Security

5. Assign employees to groups as necessary using the Security Group drop-down field on the employee records. Use the procedures described in Viewing or Editing Employee Records (page 58).

Deleting Groups

Only your custom groups can be deleted.

To delete a custom group:

1. In the Security window, select DELETE GROUP from the I Want To menu.
2. Select the group you want to delete.
3. Select which group you wish employees assigned to the group being deleted to now be reassigned.
4. Select DELETE GROUP.
5. Reassign employees on an individual basis if necessary.

Protecting Your Data

The data you accumulate in your business is extremely valuable. Keeping it safe should be a top priority. Point of Sale provides several methods to help you protect your data:

• By requiring password logins and assigning security rights you can limit access to your data and program features. Refer to Logging In/Out (page 69) for more information.

• If using security, changes that affect your inventory value (costs and quantities) are automatically tracked on transactional documents, leaving a paper audit “trail.”

• Your data files are automatically backed-up once a day when the Server Workstation exits the software or according to your defined schedule, and you can create back-ups each time you run the End of Day process. We strongly urge you to follow a comprehensive manual backup procedure in addition to this automatic protection. Additional protection can be gained by following a regular manual back up routine. Refer to Backing Up Your Data (page 76) for more information.
• Your data files are automatically checked for integrity as backups are made. This procedure is automatic and no user action is necessary.
• The security encryption keys used to protect cardholder data when processing payment card transactions in Point of Sale are automatically regenerated at least once per year. In addition, you have the ability to regenerate these keys manually at anytime should you suspect a security breach. Read the note below about the Payment Card Industry Data Security Standards and how to get further information about requirements to protect cardholder data if you use the QuickBooks POS Merchant Service to process card payments.

Complying with the Payment Card Industry Data Security Standard (PCI DSS)
If you use the QuickBooks POS Merchant Service to authorize and settle credit and/or debit card transactions, you have a responsibility to comply with PCI DSS requirements. This industry standard sets requirements for the configuration, operation, and security related to processing, transmitting, and storing cardholder data. Refer to Protecting your Customer's Card Data (page 383) for more information on these requirements.

General System and Network Protection
While the steps above are intended to protect your Point of Sale data, you should also be concerned about general system protection. Here are several more suggestions for protecting your data and the systems on your company network.

Use Windows User Accounts and Windows Update. Assign Windows-level user names and passwords and require they be used to log in to Windows. Keep your operating system up-to-date with the latest security enhancements. Find out more about Windows security and Windows Update services from Microsoft: www.microsoft.com/security/.

Restrict operating system security rights. Define your Windows security rights so that they are appropriate for your business and meet your needs for allowing your employees to access specific features and data. Pay particular attention to activities that might present a risk to your system such as Internet or wireless connections and remote access.

Lock workstations when unattended. When your computer is unattended, the workstation should be locked. This is especially important if you have scheduled tasks to occur overnight. You can quickly lock your computer by pressing the Windows logo key on your keyboard and <L> simultaneously. Unlock the computer using your Windows user name and password.
**Back up your data frequently.** Keep backups of your data file in a safe location. Keep your backups in a fireproof safe, or at a business records management facility.

**Install a UPS.** A UPS (uninterruptible power supply) helps ensure data integrity in the event of a sudden power loss. Without a UPS, transactions in progress are usually lost and, as with any software, the data file can become corrupt if disk write operations were in progress when the power is lost. We recommend a UPS on each Point of Sale workstation, but most importantly on the Server Workstation which stores your data.

**Install anti-virus software.** And keep it up to date!

**Install a network-based or PC-based firewall.** If you install a firewall on your Internet connection, you can reduce the likelihood that uninvited persons will use the Internet to access systems on your network. Firewall products will help you to ensure that your computers conduct only the traffic you allow. Most major brands of anti-virus software also offer firewalls.

---

**Firewall Configuration**

Firewalls may have to be configured to allow Point of Sale to communicate between workstations on a network. Anytime you perform an update on Point of Sale, it is important to update your firewall software: the updated firewall software will recognize any changes in Point of Sale. If you do not update the firewall software, it may attempt to block some activities in Point of Sale.

*Refer to the Appendix C Configuring Firewalls ([page 669](#)) for more information.*

---

**Backing Up Your Data**

The data that retailers accumulate during day-to-day business operations must be saved and protected for strong business continuity. Power failures, media defects, or hardware problems can quickly wipe-out critical data and other important company records. Regularly backing up your data enables you to recover from such events with minimal business impact. Failure to do so can put your entire business at risk.

Once per day, when the Server Workstation exits the program, files are automatically backed up, or you can schedule a backup to be completed at a certain time each day. This is in addition to any other backups made and requires no action on your part. Your data is backed up to the default location on the local hard drive, with a date/time stamp. Point of Sale maintains the ten most recent backup files.

It is important to note that Point of Sale only backs up your Point of Sale company data. Therefore, it should serve as only one component of a comprehensive data
Protecting Your Data

You need to take separate action to back up other important information for your business (e.g., financial records, etc.).

If a backup is created while other workstations are still working in Point of Sale, only those transactions that have been updated (saved) are included in the backup file.

(Pro) If you are using item pictures you have the option of including these pictures in your backup. This may have the effect of increasing the size of the backup file and the time involved in the process. (Refer to Pictures in your Item Records (Pro) (page 170) for more information about item pictures.)

### Backing Up in End of Day Procedures

An option in the End of Day procedure is backing up your company data. By default, the backup is saved to a folder on your local hard disk; however, for maximum data protection, you are strongly encouraged to make regular backups to a separate location. This may mean saving the data to floppy disks or CDs and storing those disks off-site.

### Types of Backups

There are a number of different types of backup in Point of Sale.

**Routine/scheduled backups.** This includes backups created automatically upon program shutdown, backups created during the End of Day procedure, manual backups made to the default location, and scheduled backups.

**Data Cleanup backups.** Created automatically in the default location at the beginning of a Data Cleanup process.

**Program update backups.** Created automatically in the default location before applying a program update.

**Data import backups.** Optionally created in the default location before importing.

*(Pro Multi-Store) Multi-store configuration change backups.* Created in the default location when changing the store type.

### Backup Methods

**Backups to the Default Location**

Your data is backed up to the hard drive on the Server Workstation in a compressed file format. While backing up to the default location affords a degree of protection in
the event your working data becomes damaged, there are some important limitations to this protection. For example, your working data and backup file are on the same hard drive and thus both could be lost in the event of a major disk problem, natural disaster, or theft.

The default backup location and file names are:

Windows XP: \DOCUMENTS AND SETTINGS\ALL USERS\SHARED DOCUMENTS\INTUIT\QUICKBOOKS POINT OF SALE 7.0\DATA\YOUR COMPANY NAME\BACKUP.

Windows Vista: \USERS\PUBLIC\PUBLIC DOCUMENTS\INTUIT\QUICKBOOKS POINT OF SALE 7.0\DATA\YOUR COMPANY FILE NAME\BACKUP

File name: YYYYMMD0001.QBP, where the yyyyymmdd is the date, and 00001 is a sequential backup number

Example: 200508300001.qpb for first backup on August 30, 2005.

To manually backup to the default location:
1. From the File menu, select BACK UP DATA.
2. In the Backup Data window, select DEFAULT BACKUP LOCATION.
3. Select OK.

Or, you can select BACK UP YOUR COMPANY DATA and DEFAULT BACKUP LOCATION when running your End of Day procedure. Refer to Backing up Your Company Data (page 442) for more information on the End of Day backup option.

Backups to an Alternate Location

Making backups to an alternate location affords a greater level of security because you can back up to removable media or a network drive (on a different computer) and you can rotate your backup media so that you always have two or more generations of backups.

Making backups to a network drive provides additional protection because the data can be stored on a different hard drive, but it still leaves the data vulnerable to hazards that could affect both computers if they are located in the same building.

Backing up data to removable media protects your data in the event of a computer system malfunction. Storing the backup media off-site affords even greater data protection from catastrophic events, such as fire, flood, etc.
Protecting Your Data

To make backups to an alternate location:

1. If backing up to removable media, insert a blank disk (or other removable medium) into the appropriate drive.
2. Select BACK UP DATA from the File menu.
3. Select ALTERNATE BACKUP LOCATION in the Backup dialog displayed and enter the path or browse to the alternate backup location.
4. Enter a filename for the backup file.
5. Select OK. Point of Sale will verify the integrity of your data and perform the backup to the designated location.

Scheduling Backups

Instead of using the daily automatic backup feature, you can set a schedule for daily backups to be run. However, for a scheduled backup to work, Point of Sale must be running on the Server Workstation and, if user logins are required, a user with adequate security rights must be logged in at the time.

Important: Lock Your Workstation

It is strongly recommended that you lock your Windows workstation if you will leave your computer unattended for the scheduled backup. Most Windows computers can be locked by pressing the Windows logo key and \texttt{<L>} on your keyboard at the same time. Refer to your Windows Help for instructions on locking your workstation. Be sure that the procedure you choose will not close any running programs.

Don't Use Automatic Logouts with This Feature

As indicated above, Point of Sale must be running with a user logged in that has adequate rights to back up data. If an automatic logout option (explained earlier in this chapter) logs out that user, the scheduled backup will not happen.

Backing Up to Multiple Disks or CDs

Even though backup files are compressed, your data files may require multiple disks to successfully complete a backup, especially if backing up to 3.5" floppy disks. It is recommended you have several blank, formatted disks available before starting the backup procedure. Point of Sale does not write directly to a CD. If you wish to store your backup files on CD, you will need to create the backup onto your hard drive and then write the file to the CD using appropriate CD-writing software.
Chapter 5: Data and Program Security

To schedule backups:

1. From the Edit menu, select PREFERENCES ➤ COMPANY.
2. On the General page, set the time for the backup and specify a location in the Data Safeguard area on the right.
3. (Pro) If you are using Item Pictures, select or clear the checkbox to indicate whether you wish the pictures to be included in the daily scheduled backup.
4. Select SAVE.

Rotating Backups

You should back up your data frequently. The data you can restore in an emergency is only as current as your most recent backup. Daily backups are recommended, and we suggest using a different set of media (diskettes, tapes, and so forth) for each day of the week. By using a different set of media every day, you have multiple backups from which you can restore.

This is important because file or media damage may go undetected for several days. If you use only one set of backup media, by the time you realize you have damaged data or media, you may find yourself in a situation where your only backup also has the damage. If you use a separate media set for each day of the week, it is likely that you will still have a backup containing a good data file that can get your business back up and running.

Rotating backup example:

Take the disk or other form of removable media containing the oldest remaining data...  
...and use it to backup the most recent data, overwriting the old file.  
Place the newest data at the end of the line. Repeat the process daily, overwriting the oldest data each time.

If a file becomes damaged or corrupted, you can restore it from any one of these backup copies without losing everything.
Restoring Your Data from Backups

If it becomes necessary to recover from data loss, your files can be easily restored from your backups. This is when you will be very glad you have consistently followed your backup routine!

To restore your data:

1. From the File menu, select RESTORE BACKUP FILE.
   The last backup to the default location is automatically suggested. However, you should restore from the most recent backup you have made.

2. If you are restoring from a backup made to a default location, make the appropriate selection from the Backup Type drop-down list and choose the needed backup file from the Available Backup list.

   Or

   If you are choosing the RESTORE FROM ALTERNATE LOCATION option, browse to the backup file you wish to use.
   
   • If restoring from removable media, you will need to have the first disk (or other medium) in the drive.

3. Select OK.
   Point of Sale will decompress and copy the backup files back into your working directory. You will be prompted to insert sequential restore disks if required.

4. Type “YES” to confirm and select OK.
Section II: Data Entry

Chapter 6  Data Entry Basics  .........................  85
Chapter 7  Lists, Forms and Filters  ..................  99
Chapter 8  Importing and Exporting Data  ..........  117
## Data Entry Basics

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Entry Basics</td>
<td>86</td>
</tr>
<tr>
<td>Read-Only Fields</td>
<td>86</td>
</tr>
<tr>
<td>Fields with Suggested Entries</td>
<td>87</td>
</tr>
<tr>
<td>Numeric Fields (Cost, Price and Quantity)</td>
<td>87</td>
</tr>
<tr>
<td>Date and Time Fields</td>
<td>87</td>
</tr>
<tr>
<td>Using Lookup Fields</td>
<td>90</td>
</tr>
<tr>
<td>Using Bar Codes and Scanners</td>
<td>90</td>
</tr>
<tr>
<td>Listing Items on Documents</td>
<td>91</td>
</tr>
<tr>
<td>Using Item Lookups</td>
<td>91</td>
</tr>
<tr>
<td>Listing Special Order Items on Documents</td>
<td>95</td>
</tr>
<tr>
<td>Editing Listed Items</td>
<td>97</td>
</tr>
</tbody>
</table>
Data Entry Basics

This section summarizes common data entry procedures that are consistent throughout the program. Refer to individual chapters for more specific information on a particular record or document type.

Use standard navigation techniques (such as arrow keys, <TAB>, <ENTER>, click, or touch) to access the field in which you wish to enter data. To accept an entry, or bypass the field, press <TAB>. Most data entries require that you navigate out of the field to record the entry.

Editing in a List

Normally, editing records is done in record forms. To enable editing in the List, select TURN LIST EDIT ON from the Edit menu. List edit allows you to edit multiple records in the list. When done editing, select TURN LIST EDIT OFF from the Edit menu to disable this feature. Leaving the list in any manner also turns off List Edit Mode.

Edit Records with Caution

Use caution when editing Information fields for records that are components of other records or documents. For example, if you edit a department or vendor, you must also edit any items in inventory that contain that department or vendor as part of the item record.

Touchscreen Entry

If you are using a touchscreen, select BRING KEYBOARD or BRING NUMPAD and then enter the information. If necessary, turn on the touchscreen controls in workstation preferences.

Read-Only Fields

Point of Sale auto-fills some fields with information that you cannot edit. These fields cannot be selected and are grayed out in forms to identify them. Examples are the Account Balance, and Available Credit fields on a customer record. These values are calculated and cannot be edited.

Read-only fields are shown in brackets [ ] in the field tables of each chapter.
Fields with Suggested Entries

Point of Sale suggests entries in some information fields. You can edit a suggested entry. For example, on a purchase order, Point of Sale populates the Order Date and Ship Date fields with today’s date, but these entries can be changed as needed. Suggested entry fields are also shown in brackets [ ] in the field tables in Appendix B.

Numeric Fields (Cost, Price and Quantity)

Numbers are the only acceptable entries in cost, price or quantity fields. Point of Sale supports entering currency amounts with up to five decimal places, but displays only two on-screen (if you enter more than five, Point of Sale rounds to and stores only five). Decimal quantities are also allowed; Point of Sale will round your entry to two decimal places and does not display trailing zeroes, i.e., if you enter 2.50, the display will be 2.5.

In the case of item cost and price on documents, the extended cost/price is calculated using the stored five decimal places. You can also edit the extended cost/price on a document and enter a quantity, and Point of Sale will calculate the appropriate unit cost/price. This feature makes it easier to order, price, and track items whose cost or price is in fractional cents or when less than a penny.

To enter negative numbers, press <- before entering the amount.

Date and Time Fields

There are two types of Point of Sale dates: fixed dates and dynamic dates.

Fixed dates are fixed in time. For example, if you enter 5/20/00, then no matter how much time has passed that will remain the recorded date.

Dynamic dates allow you to define a single date or date range relative to the current date, such as last 10 days, or month-to-date. As the current date changes, so do the dynamic dates.

⚠️ Warning: System Date

Never change your operating system date to change the date on a Point of Sale document. You could lose data.
The current date is suggested as the default date for most date fields on documents. Security permitting, you can edit the date as necessary while creating the document. However, you cannot edit the date on transactional documents after they have been saved.

Dates are always displayed in the format specified in your operating system. You can enter dates in other formats, such as via the quick entry options discussed below, but when you press `<TAB>` or exit the field, the date will be converted to the format set up in your operating system.

**To enter fixed dates:**

1. Select the date field and do one or a combination of the following:
   - Select the `button `<F4>` to access a pop-up calendar. Use the arrow keys to move from date to date or click/touch on a new date. To view a new month, select `>` or `<PAGE DOWN>`. To view the previous month, select `<` or `<PAGE UP>`. Select `<F4>` again to exit the calendar.
   - Enter the date directly using one of the quick entry formats shown below.

2. Press `<TAB>` or navigate to the next field.

<table>
<thead>
<tr>
<th>Quick Entry Formats</th>
<th>Display Formats and Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>mmddyyyy</code></td>
<td>Example: September 8, 2003 could be entered in any of these formats: 09082003, 090803, 08Sep03, or 08Sep2003. When entering month’s letters, they are not case-sensitive, e.g. “Sep” can also be entered “sep’ or “SEP”. No matter which way you enter the date, it will be displayed according to your operating system's date format, i.e. could be 08-Sep-2001, 09-08-03, 09/08/2003, etc., depending on your settings.</td>
</tr>
<tr>
<td><code>mmddyy</code></td>
<td></td>
</tr>
<tr>
<td><code>ddmmmyy</code></td>
<td></td>
</tr>
<tr>
<td><code>ddmmmyyyyy</code></td>
<td></td>
</tr>
</tbody>
</table>

You can also use the following keyboard commands to quickly enter dates. If a date is specified in a field then the following commands will be relative to the displayed date. If there is not a date specified, the resultant entry will be relative to the current date.

<table>
<thead>
<tr>
<th>Quick Entry Formats</th>
<th>Display Formats and Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;T&gt;, &lt;ENTER&gt;</code></td>
<td>Enter today’s date.</td>
</tr>
<tr>
<td><code>&lt;-&gt;, &lt;NUMBER&gt;, &lt;ENTER&gt;</code></td>
<td>Move date forward the number of days entered.</td>
</tr>
<tr>
<td><code>&lt;-&gt;, &lt;NUMBER&gt;, &lt;ENTER&gt;</code></td>
<td>Move date back the number of days entered. Note: This option is not available if your operating system is set to use hyphens (-) as the date separator.</td>
</tr>
</tbody>
</table>
To enter dynamic dates:

- Choose a dynamic date range from the drop-down list in the date field. Start and end dates/times are automatically populated based on your selection.

Dynamic dates are most often used on reports and sales charts to specify a date range for the report.

Choose CUSTOM at the top of the list if you want to enter a fixed date range instead. An open range cannot be defined with this option.

To enter times:

Time fields are typically used on some reports in conjunction with dates to define the range of data to be included. For example, you can run a report for the range of 7/3/01 12:00 AM – 7/9/01 11:59 PM, or for the range 7/3/01 8:00 PM – 7/4/01 4:00 AM.

Time fields are useful if your business has shifts that span across two days, such as a business that is open 24 hours or overnight might have, or if you want to run a report for a specific time range within one day.

- Enter the time to begin the range on the From date. Enter the time to end the range on the To date.
- Use the up/down arrow keys adjacent to the field to scroll the time backward or forward or simply type in the time and change the AM/PM indicator as necessary.
- By default, the time fields for a particular report are as they were last defined.
Using Lookup Fields

Lookup fields are used to locate and bring information from a related list to the document or record on which you are working. Department, Vendor, and Customer fields on documents or on item forms are examples of lookup fields.

From a lookup field, you can:

• Type the first few characters of the record you want to list; if one unique match is found it is immediately listed in the field. For example typing ABC in a Vendor field immediately lists the vendor with that code.
• Enter a search keyword and press <ENTER> or select the magnifying glass icon to go to the associated list for a match. Refer to Locating Records or Documents (page 31) for more information about searching for records or documents.
• Activate the drop-down list in the field and select from the entire list.
• Select ADD NEW from the drop-down list to open a new, blank form in the associated list.

The Enter Items field on documents is also a lookup field and is discussed in detail later in this chapter.

Using Bar Codes and Scanners

Point of Sale supports the use of bar code scanners to list items on documents, to fill information fields, or to search for items or documents by scanning information that is printed in bar code.

Use the Hardware Setup Wizard (access from File menu) to attach and test your scanner for use with Point of Sale.

To scan barcodes containing UPC codes, item numbers, or Alternate Lookup values to list on documents, you must have this information recorded in the corresponding field in your item records.

When scanning items on documents, a quantity of one is assumed for each scan. To record a different quantity, select EDIT ITEM (<F5>) or use the Qty + and Qty - buttons in the item list to manually enter the correct quantity after each scan.

Although scanning is extremely accurate, scanning errors can occasionally occur, especially when tags have been damaged or defaced. Errors due to defaced tags are typically rejected by the reader and never reach Point of Sale. Point of Sale reports an error if the scanned number is not currently defined in inventory or if it is not unique.
Scanning a printed receipt bar code or price tag on an item is also a quick way to find the receipt or item when doing searches. Refer to Locating Records or Documents (page 31) for more information about searching for records or documents.

Listing Items on Documents

Scan item bar code, or type UPC code, Item #, or Alternate Lookup and press <ENTER>

Activate drop-down item list; automatically activated by text entry

Press FIND ITEM icon to open the Item Find window to locate an item

Customize, move, and sort columns using column headers

Use the buttons to edit a listed item, add or subtract quantities, or to remove the item from the document

Using Item Lookups

Each inventory item is assigned an item number when it is first added to inventory. In addition, a UPC number and an Alternate Lookup (ALU) identifier can also be recorded for each item. All three of these item identifiers can be used for item lookups to instantly list items on documents. See Item Identifiers (page 166) for more information on item numbers, UPC codes, and alternate lookups.

The item lookup field on a document (Enter Item(s) field) also incorporates the Find feature described in Locating Records or Documents (page 31), allowing you to quickly search for and find an item by entering a keyword or number that is part of the item record.

Item information is scanned or typed into the Enter Item(s) field located above the document item list. Entering or scanning a number in this field that matches any
item's UPC, Alternate Lookup, or Item # will instantly bring the one unique matching item to the document with a quantity of one, assuming there is one unique match.

**To list an item on a document:**

1. Scan or type item information in the **Enter Item(s)** field.
   - If you *scan* a bar code, and there is one unique match in inventory it is instantly listed on the document with a quantity of one.
   - If you typed a UPC code, Item # or Alternate Lookup, press **<ENTER>**. If there is one unique match in inventory it is instantly listed on the document with a quantity of one.
   - If you typed an item search keyword, the drop-down item list is displayed. This list sorts and searches by the **Item Name**. Other identifying information is displayed to help identify your items.

   ![Item List](image)

   From this list, you can:
   - Click on an item, or use your arrow keys to highlight an item and press **<ENTER>**, to list it on the document.
   - Scroll through the list to locate and select an item.
   - Press **<ENTER>** before highlighting an item to open the Find Item window, from which additional search options are available. See **Locating Records or Documents (page 31)** for specific instructions for using the Find window.
   - Select **ADD NEW** to enter a new item in inventory and immediately list it.

2. To immediately edit the item just listed (quantity, price, cost, and so forth) select **EDIT ITEM (<F5>)**. Refer to **Editing Listed Items (page 97)** for more information.

3. After all items are listed, press **<TAB>** to move through the other receipt fields.

**A Note About Item Lookups**

Item lookups are done in the following order: UPC, Alternate Lookup, Item #, and then other search keywords. If a unique match to your entry is found in any item's UPC, Alternate Lookup, or Item # fields, that item is instantly added to the document. If there is more than one item matching your entry in these three fields, the Find window is displayed and all matches are displayed, including matches in any other searchable fields. The matches with UPC, ALU, or Item # will be at the top of the list for easy selection.
Ensuring these three numbers/identifiers (UPC, Alternate Lookup, and Item #) are unique for each item in inventory makes the item listing procedure more efficient.

For example, if you enter 31 in the **Enter Item(s)** field and you have an Item # 31 and a second item with an Alternate Lookup of 31, both items are considered matches, as are items with “31” in any other search field. In this case, the program will display a list of all matching items in the Find window; from which you can choose the item you wish to list on the document, as shown in the following example.

For this reason, if you are going to use Alternate Lookups it is recommended that you make them unique and do not match existing item numbers. An easy way to do this is to start every Alternate Lookup with a letter rather than a number.

Refer to **Item Identifiers (page 166)** later in this chapter, for more information about UPCs, alternate lookups, and item numbers.

---

**To locate and list items from inventory:**

If preferred, you can go directly to inventory to locate an item to list on a document. Once in inventory, the item list can be sorted, searched, or filtered to locate the correct item.

1. From anywhere in the document, choose **SELECT FROM ITEM LIST** (<F4>) from the **I Want To** menu.

   Your item list is displayed in a special selection screen. Shown here is the item list when coming from a sales receipt to locate items. Note the addition of the **Doc Qty** and **Doc Price** fields (displayed on-screen in yellow).
2. Filter, search, or sort and scroll your item list (as described earlier) to locate the item(s) you want to list. You can also add or edit items while in inventory, and then immediately list those items on the document.

3. Once you have located the correct item(s), use one of the following methods to list them on the document:
   - To immediately return one item to the document, double-click it. The item is listed with a quantity of one.
   - In the item list, enter the quantity of each item to be listed in the Doc Qty column. Optionally, you can specify the Doc Price (if making a receipt or customer order) or Doc Cost (if making a PO, voucher, or cost memo). Navigate through the item list making entries for all items you want to list on the document. When done choose SELECT or SAVE AND SELECT (if you edited or added a new item) to return selected items to the document with the specified quantities and prices/costs.
   - (Pro) If you need to list a large number of style items, as you might on a PO, voucher, or adjustment memo, switch to the Style window and enter document quantities directly in the style grid cells corresponding to each style item. When done, choose SELECT. All items for which you have entered a quantity are listed on the document.
   - (Pro) In some cases, when a quantity doesn’t need to be specified for selected items, the Doc Qty and Doc Price fields are replaced by checkboxes along the left-side of the item screen. In this case, select the checkboxes to choose items.

4. Repeat Steps 2-3 until you have located and listed all items you need.

---

**Tip: Inventory Actions after Choosing SELECT FROM ITEM LIST**

Coming from a document, full item editing is possible while in inventory. Items can be added, edited, or deleted, all while you are still also actively working on the document. This feature gives the flexibility to perform tasks, such as adding new items while making purchase orders or receiving vouchers. Any edits made to items after choosing SELECT FROM ITEM LIST from a document affects your inventory items, not just the document in which you are working.


**Listing Special Order Items on Documents**

Typically, special order items are used for custom or one-of-a-kind merchandise with little chance of repeat sales, or to customize an existing item for a sale. There are two ways of using special order items on documents. The use of special order items is not allowed on adjustment memos or transfer slips.

- **Edit an Existing Item** – List an existing item on the document and then edit its descriptive information to reflect customizations. Use this option when you do not want to create a new inventory item, but do want the document and any other documents that reference this document to reflect your changes (such as a voucher referencing a purchase order.) Editing an existing item on a document does not in any way affect the original item’s inventory descriptive information.

  *Example:* You carry men’s sport shoes in sizes 8 through 14, but have a customer that requires a size 15. You list the size 14 shoe on a PO and then edit its size and other information on the order to buy the size 15 shoe from your vendor. A receiving voucher referencing this PO would also list the size 15 but would add the received quantity to inventory as the original item (size 14). Using this method, you have fulfilled the customer request without creating a new item in inventory that has little chance of repeat sales.

  (Pro) In this scenario, you may want to initially use a sales order; you can generate the PO right from the sales order with the edited information. By using a sales order, your edits are carried to the PO, voucher, and eventually to the sales receipt that sells the item (so that printouts for the vendor and customer list the correct size).

- **Create a New Special Order Item** (Pro) – With this option, a new special order item is created in inventory. Once defined in inventory, you can list the special order item on a purchase order, receive it on a voucher, and sell it on a receipt. Later, if you decide to continue carrying the new item in inventory, you can convert it to a regular inventory item. Special order items can only be added to inventory while creating a customer order, receipt, voucher, or purchase order.

  (Pro Multi-Store) The special order item provides a means for a remote store to create a customer order for a new item and generate a purchase order for it. The special order item is sent to Headquarters with the first transactional document listing it. Headquarters can review the item and change the special order item type in inventory to a regular inventory item if needed. *Refer to Handling Special Order Items (page 549)* for more information on using special order items in a multi-store operation.
To create and list a new special order item on a document:

When you list a special order item, you are prompted to define the item in the normal manner, simply select **SPECIAL ORDER** as the item type.

1. Start the document in the normal fashion.
2. Select the drop-down arrow in the Enter Item field and choose **ADD NEW**.
3. You are taken to the New Item screen.
4. Select **NEW SPECIAL ORDER ITEM** as the item type.
5. Define the item in the normal manner in the New Item window.
   
   Use normal new item procedures to enter information about the item. Certain item fields/features are not available when defining special order items, such as item type, reorder point, the ability to define multiple vendors, creating assemblies or groups, and printing tags.

6. When done, choose **SAVE & SELECT** to record the item in inventory and list it on the document.
7. Edit item information as necessary on the document, such as quantity or price.
8. Add additional items, services, or charges, as appropriate.
9. List the customer.
10. Take a deposit, if required (applies to customer orders).
11. Save and print the document.

---

**Item Numbers**

Special order items do not have an item number assigned to them when created. If the special order item is converted to a regular inventory item later, an item number is assigned.

---

If making a customer order, you can generate a purchase order right from the order to obtain the item from your vendor. Refer to **Generating Purchase Orders from Customer Orders (page 424)** for more information.
Editing Listed Items

Edits made to items listed on a document do not affect the item record in inventory. The fields that can be edited vary by document and are discussed in the individual document chapters. On transactional documents, editing items is only possible until the document has been saved. Items on order documents can be edited at anytime.

To edit items listed on a document:

1. Highlight the item you wish to edit in the document item list.
2. Select EDIT ITEM (<F5>) to access the Item Information window.
3. Make necessary changes to any of the editable fields in the window.
4. Select OK (<F5>) to save item edits and return to the document. You can also make changes to editable fields directly in the document item list by navigating to the field and entering a new value.
5. Repeat for other items as needed.
6. Select SAVE & PRINT or SAVE, as applicable.

Deleting Listed Items

Depending on the document type and security settings, the methods available to you may vary. These procedures only remove the item from the document, they do not affect inventory.

Method 1

1. Highlight the item you want to delete in your document item list.
2. Select REMOVE ITEM.

Method 2

This method will zero-out the item, but will leave it listed on the document. Cashiers that do not have the right to delete items can use this procedure, and managers still have a record of all items that were listed.

1. Highlight the item you want to delete in the document item list.
2. Navigate to the Qty field. Alternatively, select EDIT ITEM to access the Item Information window.

3. Enter 0 as the item quantity. Press <ENTER> or navigate out of the field. (Close the Item Information window first, if necessary.)
Chapter 7  Lists, Forms and Filters

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Lists and Forms</td>
<td>100</td>
</tr>
<tr>
<td>Viewing, Navigating and Selecting in Lists</td>
<td>100</td>
</tr>
<tr>
<td>Information Panel</td>
<td>103</td>
</tr>
<tr>
<td>List Summary</td>
<td>104</td>
</tr>
<tr>
<td>Viewing and Navigating Forms</td>
<td>105</td>
</tr>
<tr>
<td>Using Filters in Lists and Reports</td>
<td>106</td>
</tr>
<tr>
<td>Filtering a List</td>
<td>106</td>
</tr>
<tr>
<td>Filtering Report Data</td>
<td>108</td>
</tr>
<tr>
<td>Defining Filter Criteria</td>
<td>108</td>
</tr>
<tr>
<td>General Filter Criteria Tips</td>
<td>109</td>
</tr>
<tr>
<td>Selecting Values in a Multiple Selection Field</td>
<td>110</td>
</tr>
<tr>
<td>Defining a Range in Numeric Fields</td>
<td>110</td>
</tr>
<tr>
<td>Filtering by ZIP Code</td>
<td>111</td>
</tr>
<tr>
<td>Free-form Criteria</td>
<td>111</td>
</tr>
<tr>
<td>Using And/Or Statements</td>
<td>112</td>
</tr>
<tr>
<td>Range Criteria</td>
<td>114</td>
</tr>
<tr>
<td>Include/Exclude Criteria Option</td>
<td>115</td>
</tr>
<tr>
<td>Filtering by Dates &amp; Times</td>
<td>115</td>
</tr>
<tr>
<td>Managing Memorized List Filters</td>
<td>115</td>
</tr>
</tbody>
</table>
Chapter 7: Lists, Forms and Filters

Working with Lists and Forms

There are two standard ways to view Point of Sale records and documents: Lists and Forms, each with its distinct uses and advantages.

💡 Tip: Right-Click Context Menus in Lists and Forms

Many task options can be quickly accessed from the right-click context menus available in record lists and forms. Simply right-click in the list or form to access options such as Find, Copy, Delete, View History, Make Document, Zoom, etc.

Viewing, Navigating and Selecting in Lists

Lists display all or a subset of your records in an area in a format similar to a spreadsheet. The list can be easily filtered, sorted and searched to help you find a particular record or to display a group of related records. The following is an example of a customer list.

Add/remove and rearrange columns You can customize the displayed list columns to meet your needs. To move a single column, click the column header and drag it to the preferred position. To rearrange all columns, or to add or remove columns, right-click a column header and choose CUSTOMIZE COLUMNS from the popup menu. There are several columns available which are not included in the default list layout. Refer to Customizing Columns in Lists (page 586) for more information about customizing columns.

Sort the records in the list Columns with a ▶️ in the column header can be sorted. The ▼️ indicates the column entries by which the list is currently sorted. Click or touch any column header displaying a ▶️ to sort by the values in that
column. To sort by multiple columns, select **SORT LIST** ➤ **SORT BY MULTIPLE COLUMNS** from the View menu. Enter up to three columns and their priority, choose to sort in ascending or descending order, and then select **APPLY**.

**Change the sort order**  Click or touch the currently sorted column header a second time to change the sort order (ascending/descending by alphanumeric values). Records with no entry in the sorted column appear either at the beginning or end of the list, depending on the sort order.

**Go to a specific record in the currently sorted column**  Sort by the preferred column, then begin typing the first few characters of the entry you wish to go to. The characters you type are not displayed on-screen but the closest matching record in the list is highlighted.

**Scroll through a sorted list**

Sort by the preferred column, then use the vertical scroll bar on the right side of the window to scroll up or down through the list. As you scroll, the scroll bar indicator displays your position in the list. Release the mouse when the value you are looking for is displayed. The indicator displays the values in the currently sorted column.

If there are too many columns to display on a single screen, a list will have a horizontal scroll bar as well.

**Search for a record**  You can search for a record in lists by keyword. Searches can be done across all record fields or in a selected field. To search for a record, select **FIND** from the window toolbar and enter keyword(s) by which to search. Refer to **Locating Records or Documents (page 31)** for more information.

**Filter the list display**  You can filter a list to display only those records matching criteria you specify. All lists have at least one predefined filter of **ALL <RECORDS>** and some lists have additional predefined filters (such as by creation dates: **THIS MONTH**, **YEAR-TO-DATE**, etc.). You can also define and save your own custom filters. Refer to **Using Filters in Lists and Reports (page 106)** for more information.
Navigating columns Use <→> and <←> to move one column right or left between fields in the selected row. Press <Home> or <End> to move to the first field or last field in the selected row.

Navigating rows Use <↑↓> to navigate through the rows to select a different record. Use <Ctrl+Home> to move to the first record in the list and <Ctrl+End> to move to the last. Use <Page Up> and <Page Down> to page through the list.

Selecting a record The selected record is highlighted and has an indicator (↕) pointing to it.

- Mouse/Touchscreen: Click or touch a record to select it.
- Keyboard: Use <↑↓> to navigate through the rows to select a different record. Use <Ctrl+Home> to move to the first record in the list and <Ctrl+End> to move to the last. Use <Page Up> and <Page Down> to page through the list.

Selecting multiple records The selected records are highlighted.

- Mouse: Click the first record you wish to select in a series to select it and drag your mouse cursor from the first record until the adjacent records you wish to select are also highlighted.

Tip: Multi-Select when Editing a List

When in lists which can be edited, such as Price Manager or with List Edit turned on (see next page) in your customer, vendor or item list, you must select the first record and then click on that record again to drag your mouse for multiple selection.

Or

Click the first record you wish to select in a series to select it and scroll (if necessary) until you can see the last item in the series. Hold the <Shift> key and click the last record in the series to select it and all intervening records.

Or

To select non-adjacent records, hold the <Ctrl> key while clicking a record to add it to those selected.

- Touchscreen: Touch the first record you wish to select in a series to select it and drag on the screen from that record until the adjacent records you wish to select are also highlighted.
- Keyboard: Use <↑↓> to navigate through the rows to select a different record. Hold <Shift> and then use <↑↓> to select adjacent records.
Or

To select non-adjacent records, hold <CTRL> and use <↑↓> to scroll to the next record and use <SPACE BAR> to select records. <CTRL+A> selects all.

Make edits in the list  Typically, editing of a single record is done on the record form. To protect against inadvertent modification of records, editing directly in a list is disabled by default. You can, however, manually turn on List Edit mode. This feature is useful if you wish to make edits to multiple records from a single screen (similar to working in a spreadsheet).

To activate list edit mode, select LIST EDIT ON from the Edit menu (or select the down arrow to the right of the EDIT button on the window toolbar and then choose LIST EDIT ON). Navigate through the list columns making edits; press <ENTER> to accept an entry and move to the next field. Your changes are saved when you move out of a row. When done editing, select LIST EDIT OFF in the same manner. Closing the list also turns off List Edit mode.

Switch to a form view  Select EDIT <RECORD TYPE> from the list toolbar (<F8>) or double-click a record to view it in a form. You are automatically placed in edit mode when displaying a form (editing may be limited on documents).

Information Panel

Most lists in Point of Sale can be collapsed to show an information panel for the selected record. Essentially, in collapsed mode you are viewing a “mini” list limited to three columns and a modified form for the selected record simultaneously.

To toggle between a full list and the collapsed list, select the COLLAPSE/EXPAND button at the top of the list.
The previous example image shows an information panel from the item list. The three columns to the left can be customized as in any list. Refer to Customizing Columns in Lists (page 586) for more information on setting up columns in lists.

The top portion of the information panel is a customizable panel that contains details for the selected record and task buttons.

The image to the right is an example of the customization window; follow the on-screen instructions to add, remove, or rearrange fields and task buttons.

You can right-click some fields for more options.

The bottom half of the information panel displays either a transaction history report (for items, customers, and vendors) or a list of the items included in a transaction (for documents). When the QuickZoom icon is displayed, you can drill down for a better view at the detail of the documents or items listed.

**List Summary**

On the status bar at the bottom of every list, summary information for that list can be accessed and displayed, such as on-hand quantity or how many items are in a list. In the example of an item list shown, the total number of items in the list is shown.

⚠️ Pro: Quantity Summaries Do Not Reflect Available or Committed Quantities

Quantities in a list summary refer only to on-hand quantity; available and committed quantities are not reflected. When using multiple units of measure, the quantity shown is for the base unit.

By clicking the down-arrow, you can select a different statistic to be displayed.
Placing your mouse cursor over the displayed statistic will activate a pop-up window displaying all summary information for the current list.

Each list in Point of Sale has its own set of statistics, including the number of records in that list. If you filter your list, the summary information will only refer to the filtered list, not the full list. Cost information will only be displayed if the current user has been granted the security rights to view cost information.

Some customer and item list statistics can be added to your report Dashboard. Refer to Using the Reports Dashboard (page 475) for more information.

**Viewing and Navigating Forms**

A Point of Sale form is a more detailed view of a single record or document, displaying all the information fields on a single screen, sometimes with tabbed pages. Records or documents are typically created and edited in a form.

**Navigate form fields** Only editable fields (white) can be selected. Use standard list procedures for navigating within the rows of an item list that appears on a form (not pictured below).

- **Mouse/Touchscreen:** Click or touch a field. Click/touch the field a second time to edit an existing value character-by-character.
- **Keyboard:** Use `<LEFT> <RIGHT> <UP> <DOWN> <TAB> <SHIFT+TAB>` to move through the fields. Press `<LEFT> <RIGHT>` to edit an existing value character-by-character.
Below is an example of a customer form.

![Customer form screenshot]

**Select tabbed pages** Access the tabbed pages of a form to enter or view additional information.

- Mouse/Touchscreen: Click/touch the tab.
- Keyboard: Press `<CTRL + 1>`, `<CTRL+2>`, and so forth, to cycle through the tabs.

**Cycle through records** Press `<CTRL+PAGEUP>` to display the previous form in the current list. Press `<CTRL+PAGEDOWN>` to display the next form in the current list.

**Go to list** Select **LIST** (<F8>) from View menu to switch to the associated list. If in the process of creating or editing a record, this action will prompt for a save before continuing.

---

**Using Filters in Lists and Reports**

**Filtering a List**

Filtering a list allows you to group and view only the records that meet certain criteria that you specify. This is a highly useful feature when you want to view or work with a group of specific records, without all the unwanted records cluttering your view.

Filtering is available in all record lists except the employee list. If you find yourself using the same filter criteria often, you can memorize that “view” and from then on it
Using Filters in Lists and Reports

will be available from the drop-down filter list at the top of the record list. Some lists have default and predefined views for easy selection.

For example, if you are viewing and selecting items from your item list to order, rather than scrolling through the entire item list looking for items belonging to that particular vendor, you can simply use a filter to display only the items belonging to that vendor (as shown above.)

Document lists, such as the Sales History list (receipts) shown below, have predefined filters for date ranges, such as receipts made for the current day, this week, this month, year-to-date, all receipts, etc.

**Warning:** Choosing to show all receipts might be slow if you are a large volume store. For this reason, the default filter in most document lists is to show the current month's documents.

**To filter a record list:**

1. Display your list, and then select one of the following from the drop-down filter list at the top of the window:
   - A predefined filter (such as ALL RECORDS, THIS MONTH, THIS WEEK, etc., choices vary by list)
   - A previously defined and memorized custom filter (your custom name)
   - CREATE FILTER to enter custom filter criteria which can optionally be saved for future use
   - MANAGE FILTERS to edit, rename, delete, or rearrange the order of your previously saved filters

*Refer to Managing Memorized List Filters (page 115) for more information.*
If you select a predefined or memorized filter, the list is immediately filtered and the steps below do not apply.

2. Review and/or enter criteria values in any of the available fields and then select APPLY (or SAVE, if you want to memorize the filter criteria for future use).
   If saving, give your new filter a unique name and then select OK.

3. Your list is filtered by the entered criteria.
   Refer to the following sections for more information on entering filter criteria.

**Filtering Report Data**

Filtering criteria allow you to run reports or graphs that display specific information. When you define filter criteria, only documents or records that match your criteria are accessed for the report. Detailed information about specific filter procedures follow later in this section.

**To define filter criteria:**

1. Select MODIFY REPORT, and then select the FILTER DATA.
2. Define your filter criteria and then select SAVE.
3. Make other report modifications as necessary, and then select RUN.

**Defining Filter Criteria**

Point of Sale provides an extensive set of filtering options, allowing you to view record lists or run reports broken down in many ways. The filter criteria instructions in this section apply to both list and report filtering.

Shown below is a sample filter window from the receipt list, in this case to include only return receipts with a status of “Regular”. The fields available for filtering vary depending on your current list or report.

![Filter Window Example](image)

**To enter filter criteria:**

1. Click the field in which you want to enter data.
2. Type your criteria or select the icons (F4) to the right of the field to make selections. These icons open selection dialogs, calendars, or drop-down lists, depending on the field type.

3. By default, the filtered data includes all data matching the entered criteria. To exclude matching criteria (i.e. show all other data), click in the Include/Exclude column and change the setting to EXCLUDE.

4. When done, select APPLY to filter your list or report data accordingly.

Other options on the filter dialog may include:

- **Clear All** - clear all entered filter criteria from all fields.
- **Revert** - reset all filter criteria to default settings (reports only).
- **Save** - memorize this filter criteria for later use (lists only, reports can be memorized after displaying).

---

**General Filter Criteria Tips**

- By default, records matching the specified criteria will be included in a filtered list. To exclude records matching a particular criterion, select **EXCLUDE** from the drop-down list in the Include/Exclude column.

- Point of Sale does not distinguish between upper- and lower-case when filtering. Example: navy, Navy, and NAVY are all matches for *navy*.

- The current filter view is always displayed at the top of the list. If records you are expecting to see are not visible, check the View field to see if the list is filtered by criteria that is excluding them.

- **Spaces**: A space that is made by pressing the spacebar is a keyboard character—the same as any other entered character. When a space is included in a value, a matching space is required in the data record for the record to be a match during filtering.

- **Descriptive Fields**: *(Examples: Item Name, Item Description, Attribute)* Records that have a string of characters anywhere in the field that exactly match the value entry are included. Example: The filter value of *buckle* would include such records as *ladies buckle shoe*, *buckle girls dress shoe*, and *boys casual shoe buckle* in the filter results. For an exact match, enclose the string of characters within quotes: “*buckle*” will only include record that match *buckle* exactly.

- **Dynamic Dates**: *(Available in most date fields.)* Dynamic dates define a time period in relation to the current date instead of using specific start and end dates. For more information refer to Date and Time Fields (page 87). The rest of this section gives specific instructions for entering criteria in the various field types included in the Filter View window.
Selecting Values in a Multiple Selection Field

Multiple selection fields are available when values are restricted to a predefined list (as shown by the list of vendors at right).

- If you want to select a single value for this field and you know what the value is, you can type it directly into the field.
- To open the selection list, click in the field to activate it and then click the icon to the right of the field (<F4>).
- To select a value from the list, click it, or highlight it and press <SPACE>. To clear that value, click it or press <SPACE> again.

Or

Choose the SELECT ALL or CLEAR ALL buttons.

- Select OK to return the selected values to the field.

The field on the Filter View window displays (Selection) if more than one possible value is selected.

Defining a Range in Numeric Fields

Initially, the program displays both the starting and ending values of range fields with an ellipsis (…). If no entry is made, all records are included.

<table>
<thead>
<tr>
<th>Sample Filter Criteria</th>
<th>Records Included</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item #: (…) to (…)</td>
<td>All item records.</td>
</tr>
<tr>
<td>Item #: 100 to 500</td>
<td>Records with item numbers 100 through 500, inclusive.</td>
</tr>
<tr>
<td>Item #: 3000 to (…)</td>
<td>Records with item numbers 3000 and up.</td>
</tr>
<tr>
<td>Item #: (…) to 40</td>
<td>Records with item numbers 40 or less.</td>
</tr>
</tbody>
</table>

To define a range, enter the lowest value you want in the left field and the highest value in the right field. Open ranges can be specified by entering nothing in one of the range fields. (The following example is of an Item # filter range.)
Filtering by ZIP Code

When defining ZIP Code ranges, keep in mind that all ZIP Codes are treated as 9-digit entries, and that, in a sort sequence, spaces are listed before any digits. (Whether the dash is required depends on how the codes were entered. If dashes were not used, then omit them when specifying filter criteria.)

Example: Point of Sale treats 5-digit ZIP Codes, such as 94488, as 94488 followed by 4 spaces. If you define a range of 94488-0000 to 94488-9999 (using ZIP+4 Codes), any record with 94488 ZIP Code (without the +4 code) would be omitted. To include all 94488 ZIP Codes, including the 5-digit 94488 code, define the range from 94488 to 94488-9999.

Free-form Criteria

There are report filter elements that allow free-form criteria. Free-form criteria can be used with elements that have variable text entries, such as Item Name. You define each criterion by entering a string of alphanumeric characters. When running the report, the program searches for a matching string anywhere in the corresponding field, ignoring upper/lowercase. In addition, AND/OR statements (described later in this section) can be used with free-form criteria.

**Exact Matches** Enclose the criterion in quotation marks to require an exact match, i.e. to require the characters enclosed by the quotation marks to match the entire field entry, character for character. A matching data field cannot contain any characters (even leading spaces) that are not also in your criterion.

Example: If your criterion were blue, both blue and sky blue would be matches. To find only exact matches for blue, i.e. include blue but exclude sky blue, use “blue” as your criterion. Since the entire field entry must match what is contained within the quotation marks, only blue is a match.

**Blank Fields** To filter for records with a blank field, use empty quotes, i.e. two quotation marks with nothing in between (““”).

**Excluding Matches** If you start your criterion with a tilde (~), Point of Sale excludes all records that match the criterion and includes those that do not. Think of the tilde as meaning not or exclude.

To exclude all blank records, enter a tilde and empty quotes (~““).
**Examples:**

| ~blue | (not blue) Excludes any records that include the word *blue* anywhere in the specified field. *Example:* Field entries of *BLUE*, *SKY BLUE*, *DARK BLUE*, and *BLUE GREEN* would cause their respective records to be excluded from the results. |
| ~“blue” | (not an *exact* match to what is in the quotation marks, i.e. not *exactly/only* blue) *Example:* A field entry of *BLUE* would cause its respective record to be excluded. Records with field entries of *SKY BLUE*, *DARK BLUE* and *BLUE GREEN* would be included in the results. |

**Using Wildcards and Masks in Filters** When entering free-form text in filter criteria, you can type an exact match, use “*” as a wildcard to represent any number of unknown or variable characters, or “?” as a mask to represent a single unknown or variable character.

Example: D?N returns Dan and Don. D*N returns Dan, Don, Dean and Diana. 650* returns all numbers beginning with “650”. *650* returns all numbers containing “650”.

**Using And/Or Statements**

Descriptive fields allow filtering with **AND/OR** statements. If **AND** is selected, then values meeting all of the defined values must be present for a record to pass through the filter. If **OR** is chosen, meeting just one of the defined criteria will allow a record to pass through the filter. You can also use a combination of **AND/OR** statements. To access the and/or dialog window, place your text cursor in the required field and select the button which appears to the right or press <F4> on your keyboard.

**AND/OR** statements, combined with other filter options, such as **INCLUDE/EXCLUDE**, allow advanced users to define complex filter criterion such as filtering your customer list to display only men or married woman, who have made a purchase in the current year, and live in ZIP codes 94326 and 94327.

To use these types of filters you must be dutiful about recording specific information, such as the title of customers (Mr., Mrs., Ms., Miss, etc.), addresses, phone numbers, etc.

This is an example of a customer “and/or” filter by title. This filter, by default, would include only customers with the title of Ms. or Miss, but those with a title of Mr. or Mrs. would not be included.
If the **EXCLUDE** option was also selected for the title field in the Filter View window, the opposite effect would be achieved; the filtered customer list would include those customers with a title of Mr. or Mrs. only.

Suppose that for your shoe department you include a color and description in **Item Name** (BRWN, BLCK, NAVY, WHITE, RED / TIE = tie/lace-up, SLON = slip-on, BUCK = buckle). Using **AND/OR** statements as your **Item Name** criteria, you could select such combinations as *all black tie shoes, all black and brown tie shoes, or all slip-on shoes.*

<table>
<thead>
<tr>
<th>ITEM #</th>
<th>ITEM NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>000101</td>
<td>BRWN TIE</td>
</tr>
<tr>
<td>000201</td>
<td>BRWN BUCK</td>
</tr>
<tr>
<td>000301</td>
<td>WHITE SLON</td>
</tr>
<tr>
<td>000401</td>
<td>BLCK SLON</td>
</tr>
<tr>
<td>000501</td>
<td>BRWN SLON</td>
</tr>
<tr>
<td>000601</td>
<td>WHITE TIE</td>
</tr>
<tr>
<td>000701</td>
<td>NAVY SLON</td>
</tr>
<tr>
<td>000801</td>
<td>WHITE SLON</td>
</tr>
</tbody>
</table>

**AND/OR Rule #1**

If two or more criteria are joined by **AND**, the entry in the record’s field must meet *all* of the criteria in order to be included in the filter results.

<table>
<thead>
<tr>
<th>Goal: Filter for all brown tie shoes</th>
<th><img src="image" alt="Description 1" /></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Criterion:</strong> (an AND statement)</td>
<td><strong>BRWN and TIE</strong> must both be in the Item Name field</td>
</tr>
<tr>
<td><strong>Item(s) Selected:</strong> Item #101</td>
<td><img src="image" alt="Description 1" /></td>
</tr>
</tbody>
</table>

Longer chains of criteria that are joined by **AND** can be built in the same manner.

**AND/OR Rule #2**

If two or more criteria are joined by **OR**, the entry in the record’s field must meet *any* one of the criteria in order to be included in the filter results.

<table>
<thead>
<tr>
<th>Goal: Filter for all brown or navy shoes</th>
<th><img src="image" alt="Description 1" /></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Criterion:</strong> (an OR statement)</td>
<td><strong>Either BRWN or NAVY</strong> must be in the Item Name field</td>
</tr>
<tr>
<td><strong>Item(s) Selected:</strong> Items #101, #201, #501, #701</td>
<td><img src="image" alt="Description 1" /></td>
</tr>
</tbody>
</table>

Longer chains of criteria joined by **OR** can be built in the same manner.
**AND/OR Rule #3**

When three or more criteria are joined by any combination of **ANDs** and **ORs**, the criteria joined by the **ANDs** are grouped together and evaluated first. Then the **OR** statements are evaluated.

| Goal: Select all shoes that are brown tie or black slip-on. |
|Criterion: (a mixed AND/OR statement) | BRWN and TIE or BLCK and SLON must be in the Item Name field |
|Item(s) Selected: Items #101, #401, #801 |

When designing these more complex statements, it can be helpful to visualize the **AND** statements enclosed within brackets and treated as a unit. Rewriting the criteria above would yield:

```
[BRWN and TIE] or [BLCK and SLON]
```

The program evaluates **AND** requirements first. In this example, it identifies all items that meet the first **AND** requirement, i.e. that were both **BRWN** and **TIE** (Item #101). Then it identifies all the items that meet the second **AND** requirement (**BLCK** and **SLON**, Items #401 and #801).

After evaluating all the **ANDs**, the program looks at the **OR** statements. All items that satisfy *either* of the requirements joined by an **OR** are selected.

In this case, Item #101 is selected because it satisfies the **AND** statement to the left of the **OR**, and Items #401 and #801 are selected because they satisfy the **AND** statement to the right.

**Tip: Using Quotation Marks and Tildes in AND/OR Statements**

Quotation marks, empty quotation marks, and the tilde (~) can be used in your **AND/OR** criteria to specify exact matches, blank fields, and non-matches, respectively.

**Range Criteria**

**Range criteria** allow both open-ended and closed ranges of data, except for date/time ranges. For date/time ranges, you must specify a fixed or dynamic date/time range. With a simple selection, you can specify to have the report span *month-to-date, year-to-date, last year for this same year-to-date range*, etc. There are a number of predefined dynamic date/time ranges available for your use.
Include/Exclude Criteria Option

The **INCLUDE/EXCLUDE** option lets you choose how to filter—inclusively or exclusively. If you want to filter for all vendors except one, you could select that vendor as the criteria and toggle the include/exclude option to **EXCLUDE**. All vendors except that one specified vendor will be included in the report results (that is, the one vendor is *excluded*).

Filtering by Dates & Times

Date and time fields are used throughout the program. Entry of these values is detailed in *Date and Time Fields (page 87)*.

Managing Memorized List Filters

You can rename, delete, or revise the criteria in any of your memorized list filters and change the order in which they appear on the list filter drop-down list.

**To manage memorized list filters:**

1. Select **MANAGE FILTERS** from the filter drop-down list. The Manage Filter Views dialog is displayed.

2. Select one of your memorized filters, and then select an action:
   - **RENAME** — enter a new name for this filter
   - **EDIT** — opens the saved filter criteria; edit the criteria as necessary and select **SAVE**
   - **DELETE** — to remove the filter view from your filter drop-down list
   - **MOVE UP/DOWN** — to change the position the filter view appears on your drop-down list
Import/Export Overview

There is no way to avoid the chore of entering your inventory items, vendors, and customers when just getting started. However, Point of Sale does supply some tools and a lot of assistance to help complete this task. Importing data saves you time and helps avoid errors that can occur with manual entry.

You may also need to have your Point of Sale information available outside of the program. To this end, Point of Sale provides tools to assist you in exporting data in a variety of ways as well.

With Point of Sale you can:

• Import existing data from your QuickBooks financial software company file
• Use the Data Import Wizard to bring in data via an Excel spreadsheet or as a comma-delimited text file (saved as *.csv) that you have received from vendors or exported from another application
• Export lists to an Excel spreadsheet
• Export reports to an Excel spreadsheet
• E-mail documents to customer and vendors
• Write letters with data from your records using Microsoft Word
• (Pro) Import and export item pictures

Importing Data from QuickBooks Financial Software

If you already have a QuickBooks financial software company file with existing customers, vendors, and inventory items when you start to use Point of Sale, that data can be imported to Point of Sale. Importing your existing financial software data greatly reduces the data entry time in Point of Sale and gets you up and running more quickly.

Importing/Sharing Vendors and Customers

Existing, active QuickBooks financial software vendors and customers are automatically imported when you complete your first Financial Exchange and routinely shared thereafter.
You should review the imported records and edit them, as necessary, if you want to take advantage of additional Point of Sale features. Refer to Importing Data from QuickBooks Financial Software (page 118) for tips on editing your imported vendors and customers.

If you prefer not to share customers or vendors between the programs, use the options on the customer and vendor record respectively, to indicate that choice. See the respective chapters for instructions.

(Pro) When importing customers, the default import template allows for importing up to ten shipping addresses for each customer.

**Importing Items**

Importing your QuickBooks financial software inventory items is optional. You can import all your financial software items, selected items, or no items.

After importing, the imported items should be ordered, received, and sold only through your Point of Sale inventory. Inventory item records are not routinely exchanged between the programs.

**Benefits Of Importing Your QuickBooks Items**

You are not required to import your QuickBooks financial software items, but it is recommended that you do so.

- Importing saves you time and eliminates data-entry errors.
- The imported items are immediately available to order, receive, and sell in Point of Sale.

**Choosing Items to Import**

Most users will want to import all items. However, there may be good reasons to not import all items.

- You have store supply items, such as shopping bags or cleaning supplies, that you do not resell. You need these items in your financial software to accurately track of supply costs, but there is no need for the items to be in Point of Sale. You could choose not to import these items, and continue to track them in QuickBooks financial software.

- You have a large number of outdated items, which you no longer use in your financial software. Rather than delete such items or make them inactive in the financial software, you may prefer simply not to import them. This way, you still have an active record of these items in your financial software in case you need them in the future.
Chapter 8: Importing and Exporting Data

Maintaining a Separate Inventory in QuickBooks Financial Software

If you “divide” your inventory, meaning you track certain items in your financial software and others in Point of Sale, you should only conduct activities related to those items in the program you are using to track them. For example, if you track cleaning supplies in your financial software, then you should purchase, receive, and sell the cleaning supplies only in your financial software, not in Point of Sale.

What If I Choose Not to Import Items from QuickBooks?

While there are many benefits of importing items, there are some circumstances in which you might not want to import. If you choose not to import, you will need to enter the items you plan to sell in Point of Sale manually.

Until you import your QuickBooks items, or specify that you do not want to, Point of Sale will remind you each time you enter your Point of Sale item list. Choose **ASK ME AGAIN LATER** on this dialog if you plan to import, but are not ready to do so at that time.

To import your QuickBooks financial software items:

Select the **HELP** button or blue text links on any of the import screens for additional explanation.

1. Select **YES, I WANT TO IMPORT ITEMS FROM QUICKBOOKS NOW** when prompted.

   Or

   Select **IMPORT ITEMS NOW** from the Advanced Options page of the Financial Center.

2. In the Item Fields window displayed, specify how you want the item information in your financial software transferred to each Point of Sale item description field.
3. On the Item Selection window, answer **YES** if you want to import only selected financial software items or **NO** to import all of your items.

4. If importing only selected items, use the Select Items to Import page to specify which of your financial software items should be imported and then select **OK**. If the checkbox to the left of an item is checked, that item will be imported. Clear the checkbox if you do not want to import an item. Using the **SELECT ALL**, **UNSELECT ALL**, and **FILTERED VIEW** options at the bottom of the page can help you locate and make item selections quickly. Select **HELP** on this page for more information.

---

**Notes About Importing QuickBooks Financial Software Items**

- Imported items should be reviewed in Point of Sale as described in the next section to add or edit information not included or handled differently in the QuickBooks item records.

- The on-hand quantity of imported items is zeroed out in your financial software and a corresponding general journal entry made to adjust the Inventory Asset account. To balance against these entries, adjustment memos are created in Point of Sale and sent to your financial software with the next Financial Exchange so that your inventory value is unchanged. From this point on, quantities of the imported items is tracked in Point of Sale, and transactional documents created in Point of Sale will update your inventory value accordingly as they are sent to your financial software.

- Specific item information (quantities, cost, prices, and so forth) is not shared between Point of Sale and your financial software in routine Financial Exchanges.

---

**Warning: Not Importing Items and Manually Adding Them in Point of Sale**

If you have existing items in your financial software: if you choose not to import them and then manually add those same items and quantities to Point of Sale, your financial software inventory value can be erroneously increased. This is because when you manually add items and quantities in Point of Sale, the program will send inventory adjustments (as General Journal transactions) showing increases in inventory value. In this case, you will need to make a compensating one-time adjustment in QuickBooks Financial Software to correct your inventory value. Refer to the instructions in your QuickBooks Financial Software documentation for more information about adjusting inventory amounts.
Reviewing Data Imported from QuickBooks

Point of Sale tracks certain information and offers some features that were not available in QuickBooks financial software, and other information fields, while included in both programs, are handled slightly differently. To take full advantage of Point of Sale features and tracking capability, you should review and make necessary edits to all imported data as described here.

**Imported Customers**

We recommend you review and edit imported customer records for the following:

- Ensure that the **USE WITH QUICKBOOKS** checkbox is selected if you want to continue sharing information for imported customers.
- Review and edit customer information fields for price discounts, sales tax handling, notes, and, for Pro users, any custom customer fields you use, as this information can be imported from and shared with your financial software as long as you have named them exactly the same in both programs.

Refer to Chapter 18 Customer Records and History (page 303) for more information about maintaining customer records.

---

**Preferences: 'Use with QuickBooks' Default Setting for New Customers**

PREFERENCES ➤ COMPANY ➤ CUSTOMERS ➤ Use with QuickBooks: You can select to have the **USE WITH QUICKBOOKS** flag selected or cleared by default for all new customers added in Point of Sale. If you’d like to ensure that all new customers are shared with your financial software, make sure this option is set to YES. If you do not wish to send customer information to your financial software, select NO. By default, this option is set to YES.

---

**Imported Vendors**

Non-merchandise vendors, such as utility companies and the agencies to which you pay sales tax, are stored in the vendor list in QuickBooks financial software. As such, these agencies are imported to Point of Sale as vendors.

Do not delete these vendors in Point of Sale. If you prefer not to see these vendors in your vendor list, select the **INACTIVE** checkbox on the vendor records and filter the vendor list to show only active vendors.

You may also want to enter or edit other imported vendor information:

- Vendor Website addresses for one-click access (requires Internet connection).
- Ensure the vendor account number and payment terms are what you want applied to purchase orders and receiving vouchers created in Point of Sale.
- (Pro) Enter any information for custom vendor fields you may have set up in Point of Sale, as this information can be imported from and shared with your
Importing Data from QuickBooks Financial Software

You can import your financial software as long as you have named them exactly the same in both programs.

Refer to Chapter 15 Vendors (page 253) for more information about maintaining vendor records in Point of Sale.

Imported Inventory Items

If you chose to import existing QuickBooks financial software items, they are assigned the following item types in Point of Sale:

<table>
<thead>
<tr>
<th>QuickBooks Item Type</th>
<th>Point of Sale Item Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Part</td>
<td>Inventory</td>
</tr>
<tr>
<td>Non-Inventory Part</td>
<td>Non-Inventory</td>
</tr>
<tr>
<td>Service</td>
<td>Service</td>
</tr>
<tr>
<td>Other Charge</td>
<td>Non-Inventory</td>
</tr>
<tr>
<td>Assembly</td>
<td>Assembly</td>
</tr>
<tr>
<td>Group</td>
<td>Group</td>
</tr>
</tbody>
</table>

Review the entries in the following fields for your imported items in Point of Sale and modify them as needed:

<table>
<thead>
<tr>
<th>Point of Sale Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Type</td>
<td>Review the assigned item types and modify as necessary.</td>
</tr>
<tr>
<td>Department</td>
<td>QuickBooks financial software does not use departments, so all imported items will be assigned to a single department, named QuickBooks. If you want to track and report sales using departments that are more pertinent to your business, you should define new departments and then assign your imported items to them in inventory. Refer to Chapter 10 Merchandise Departments (page 153) for more information.</td>
</tr>
<tr>
<td>Attribute (default label)</td>
<td>QuickBooks financial software does not have a comparable field. Make entries in this field to further classify your items by color, a second size, a pattern, or any other product trait that varies within your item groupings.</td>
</tr>
<tr>
<td>Size (default label)</td>
<td>QuickBooks financial software does not have a comparable field. If your merchandise is categorized by sizes, you can make an entry in this field to facilitate purchasing and reporting.</td>
</tr>
<tr>
<td>Price Levels</td>
<td>The price from your financial software is placed in the Regular Price field on imported items. Additional price levels, if used, are not calculated for imported items. Manually enter a price or markdown percentage for each price level on the item record, as needed. Refer to Setting and Updating Item Prices (page 191) for more information on managing item prices.</td>
</tr>
</tbody>
</table>
Chapter 8: Importing and Exporting Data

QuickBooks Point of Sale

Importing and Exporting Data

Importing Data from a Spreadsheet or Text File

The Data Import Wizard

The Data Import Wizard is designed to spare you from the time-consuming task of manually entering large amounts of existing data into Point of Sale.

The wizard takes customer, vendor, or item information entered into a Microsoft® Excel® spreadsheet or a comma-delimited text file (renamed with a .csv extension) and transfers this information into the corresponding data fields in Point of Sale.

The wizard can be used to import data:

- You enter into a pre-defined Excel import template provided with Point of Sale
- You have in a custom Excel spreadsheet or comma-delimited text file:
  - exported from another point-of-sale software
  - provided by vendors, such as catalog information for new inventory items or updates to existing items

<table>
<thead>
<tr>
<th>Point of Sale Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Styles (Pro)</td>
<td>To use the styles feature, all items to be grouped into a style must be modified so that they have identical Department and Item Name fields. Refer to Working with Item Styles (page 212) for more information on using styles.</td>
</tr>
<tr>
<td>UPC Codes</td>
<td>Enter or scan your item UPCs into the UPC field in Point of Sale inventory if you want to list items on documents by scanning the UPC codes.</td>
</tr>
<tr>
<td>QuickBooks Information</td>
<td>Review and edit the financial software accounts (COGS, Income, and Inventory Asset) used when posting item sales data to your financial software. Refer to Mapping Individual Item Accounts in Inventory (page 525) for more information.</td>
</tr>
<tr>
<td>Other Item Fields</td>
<td>Review and edit other Point of Sale item fields to take advantage of features important to your business. Refer to Chapter 11 Item Basics (page 161) for more information about working with items.</td>
</tr>
<tr>
<td>Custom Fields (Pro)</td>
<td>Custom field information can be imported from and shared with your financial software as long as you have named them exactly the same in both programs.</td>
</tr>
</tbody>
</table>
When using your own import file, you have complete control over how the import fields are mapped to your Point of Sale data fields, and how record duplicates, updates, and errors are handled.

**To use the Data Import Wizard:**

It is recommended that you backup your company data file before importing.

1. From the File menu, select **UTILITIES ➤ IMPORT**.
   The Data Import Wizard launches.

2. Follow the on-screen instructions to specify the type of data being imported (e.g., items), browse to the file containing the data, and specify field mappings and other import options.
   Point of Sale includes a pre-defined Excel import template and field mappings that you can use or you can import from your own file, or a file provided by a vendor, with custom mappings.

3. Select **IMPORT** to migrate the data to Point of Sale.
   Specific instructions are contained on the default import template, or can be accessed by selecting **HELP** or pressing `<F1>` from within the wizard.

**Importing Item Pictures (Pro)**

If you are using item pictures, you have the option of importing pictures for multiple items instead of assigning them one-by-one to your items. In the import process, Point of Sales associates pictures to items by matching the filenames of the pictures to specific item information. The names of the files to be imported will need to follow one of the below conventions:

- Item name + Attribute + Size
- Item Name
- UPC
- Alternate Lookup (ALU)
- Item Number

You can choose to import default item pictures, alternate item pictures, or both in a single import. If you are importing both default and alternate pictures at the same time, you must include `_def` or `_1` at the end of the filename for the default pictures, and `_alt` or `_2` at the end of the filename for the alternate pictures.

Item pictures are imported using the Data Import wizard described in **The Data Import Wizard (page 124).**

If an item already has an image associated with it, you will be prompted to verify overwriting the existing image with the imported one.
Refer to *Pictures in your Item Records (Pro) (page 170)* for more information about item pictures.

(Pro Multi-Store) If you want to receive an item pictures file sent to your remote store from Headquarters, use the procedure at *Receiving a Mailbag (page 573)* instead.

## Exporting Data

Point of Sale integrates with your default desktop e-mail client and Microsoft Office applications (Excel and Word) for exporting data.

### E-Mailing Documents

You can e-mail Point of Sale documents to your vendors and customers.

When e-mailing documents, Point of Sale automatically launches your default Windows e-mail client, creates the e-mail, and attaches the document. If the e-mail address is entered on the vendor or customer record, Point of Sale will automatically fill in the address field on the e-mail.

(Pro) You can specify the format of the attached document (PDF, Excel, or plain text) and the default message text for purchase orders in company preferences.

### (Pro) Preferences: E-Mail Defaults

EDIT ➤ PREFERENCES ➤ COMPANY ➤ E-MAIL DOCUMENTS

Define default message text and attachment format for each document type. You can edit the default text on individual e-mails.

### To e-mail a document:

1. Enter vendor and customer e-mail addresses on their respective records.
2. Create the document following normal procedures.
3. Display or select the document to be e-mailed:
   - Order documents can be e-mailed while creating them or from the order list.
   - Transactional documents can be e-mailed from the history list after saving.
4. Select E-MAIL from the window toolbar.
   Point of Sale creates the e-mail, attaches the document, and displays it in your default e-mail client.
5. Review and edit the e-mail address, subject line, and message, as necessary, and then select **SEND**

---

**About Your Windows E-mail Client**

Your default e-mail client must be specified in Internet Explorer. This is the e-mail program, such as Outlook or Outlook Express, that automatically launches when you select to send an e-mail from within a Windows application. To see which program is your default e-mail client, open Internet Explorer, select **TOOLS** and then **INTERNET OPTIONS**. Select the Programs from the tabbed panes and note the entry in the E-mail field.

Refer to your Windows or Internet Explorer Help files for more information.

---

**Outlook Express**

There is a known issue with using Outlook Express to send file attachments. If you also have Microsoft Outlook installed, the e-mail and attachment will be generated in Outlook instead. You can either select Microsoft Outlook as your default e-mail client or, if you wish to continue using Outlook Express, use the ADD OR REMOVE PROGRAMS option from the Windows Control Panel to uninstall Microsoft Outlook.

---

**Exporting a List to Excel**

You can export all or selected records from your item, customer, vendor, department, and employee lists to an Excel spreadsheet using the Data Import Wizard.

You can use one of the provided templates, or create your own spreadsheet to use as a target file to receive the exported information mapped as you specify.

**To export a list or report into Excel:**

1. View the list you wish to export. If you will only be exporting some of the records in a list, either filter the list or use multi-select to display or select only those records.

2. From the I Want To menu, select **EXPORT TO EXCEL**. (The following sample screens are for the customer list. However, the steps remain essentially the same for all lists.)

3. Specify which records are to be exported:
Chapter 8: Importing and Exporting Data

4. Select the default file, or enter a path and filename to create a new file, or browse to an existing custom file that will receive the exported information and select it.

5. Select the worksheet in the XLS file that you want to contain the data.

6. Indicate the row on which the imported data should begin. For example, if Row 1 contains header information, you may wish the imported data to begin on Row 2.

7. Select the export template that you wish to use. An export template tells the Wizard which columns are to contain which data. You can select MANAGE TEMPLATES to review, edit, or create export templates.

8. Select NEXT.

Continue following the on-screen prompts to complete the export.

List Export Shortcut

You can also initiate an export of your list data by selecting UTILITIES ▶ EXPORT from the File menu without opening the list. However, with this method all records in the selected list are exported.
Exporting Data

Exporting a Report to Excel

1. Run and view the report you wish to export. Refer to Running a Report (page 463) for information.

2. Select EXCEL at the bottom of the report window.

   The report information will be exported to Excel and the Excel spreadsheet will be displayed.

---

Exporting Very Large Reports

Excel has a display limit of approximately 65,000 rows. If a report exceeds this limit, it will be truncated to fit the display capacity. You can rerun the report, filtering to reduce the size, to ensure the entire report is displayed if this occurs.

---

Exporting Item Pictures (Pro)

At some point after bringing your pictures into Point of Sale, you may have need to retrieve these photos for some other use. There are two methods of getting item pictures out of Point of Sale. In both instances, pictures are only exported in JPG format. If the location to which you are extracting the picture(s) contains a file with the same name as that being extracted, Point of Sale will display a prompt to verify overwriting the existing file.

(Pro Multi-Store) If you want to send item pictures to your remote stores use the procedure in Sending Item Pictures (page 572) instead.

To export a picture by drag-and-drop:

Drag-and-drop requires use of a mouse or touchscreen, and that you have both the file destination location and the Item Pictures section on the Additional Info panel visible on your screen. (You can also drag-and-drop default item pictures from the Inventory Picture Album.)

1. Click the picture in Point of Sale with your left mouse button and hold down the button.

2. Drag your mouse pointer to the location you wish to export the file and release the mouse button.

To export multiple pictures:

You can export a number of pictures at once using the Data Export Wizard. Exporting item pictures differs from other data exports in that it is not populating information into a single file or spreadsheet, but will create a new file for each picture being exported.
1. From the Point of Sale File menu, select UTILITIES ➔ EXPORT.

Or

From either the item list or Picture Album, multi-select the specific item records containing the pictures you wish to export, then from the I Want To menu, choose EXPORT ➔ EXPORT SELECTED ITEM PICTURES. (Proceed to step 4.)

The Data Export Wizard launches.

2. Select ITEM PICTURES as the type of data to export.

3. Follow the on-screen instructions to specify which pictures will be exported.

4. Indicate the destination for the exported pictures, how you wish the exported files to be named, and whether you wish to export the default, alternate or thumbnail picture, or all three, for the items.

5. Select EXPORT to copy the pictures to the destination location.

6. Select OPEN if you wish to view the contents of the destination folder, or select FINISH to exit.

**Writing and Printing Letters**

Point of Sale provides Microsoft Word integration for writing letters to customers and vendors. From many documents within Point of Sale, you can select to write a letter from the I Want To menu. You can also initiate letters from the I Want To menu of the customer list and the vendor list, or from within a customer or vendor record.

**Letter Templates**

Templates are used in order to create letters which can be personalized and sent to multiple recipients at once, or to be used one at a time on an as-needed basis. The templates allow you to have certain information pulled from customer/vendor records, receipts and customer orders, and from purchase orders and vouchers. You can modify existing templates, or create your own.

---

**Tip: Including Point of Sale Data in Letters**

If you want to include data from a Point of Sale document or record, be sure to initiate the letter from the I Want To menu of that document or record. Only the data fields on the current document or record will be available to add to the template.
To create or modify a letter template:

1. From the I Want To menu of a record, document or list, select WRITE LETTERS > MANAGE LETTER TEMPLATES.
2. From the drop-down list, select the type of letter you wish to modify or create.
3. To modify an existing template, select the template from the list and select MODIFY TEMPLATE.

Or

To create a new template, select NEW TEMPLATE at the bottom of the window and provide a name for the template.

The template opens in Microsoft Word. In Word 2003 and earlier, the Point of Sale fields toolbar floats at the top of the document. In Word 2007, select ADD INS from the ribbon at the top of the screen to display the Point of Sale toolbar.

4. Type the letter.
5. Using the Point of Sale Fields toolbar in Word, place your cursor in the letter where you wish the information to appear and then select the information field that you wish to be populated from the record or document. For example, if you are working on a customer letter, you may wish the customer’s name to appear on the letter.

6. When you are finished, save the document in Microsoft Word.

Printing Letters

When printing, you have the option of printing only the currently selected recipient(s) or record(s), or from a filtered list.

To print for the currently selected record or document:

1. Select the record or records for which you wish to print letters.
2. From the I Want To menu of a record, document or list, select WRITE LETTERS > TO CURRENTLY SELECTED [RECORD TYPE].
3. Select the template you wish to use for the current printing.
4. Enter the name and title of the person that the letter will be from and select NEXT. The letter will be opened in Microsoft Word.
5. Review the letter and modify as needed, then print the document from Microsoft Word.
You may save the Microsoft Word document if you wish; doing so will not affect the template.

### Missing Information

Letters will be generated from the templates. However, if the records are missing information that the template tries to populate from the record, the field will be blank. It is recommended that you review letter before printing to ensure that all needed information is present. For this reason, it is also important to have a consistent policy regarding which informational fields are populated in Point of Sale.

### To print for a filtered list:

1. From the I Want To menu of a non-document list, select **WRITE LETTERS ➤ TO FILTERED LIST OF [RECORD TYPE]**.
   
   The Filter dialog window is displayed.
2. Enter the appropriate information to define your filter. See Using Filters in Lists and Reports (page 106) for information on using filters.
3. From the resulting list, select or de-select records to print what is needed.
4. Select the template you wish to use for the current printing.
5. Enter the name and title of the person that the letter(s) will be from and select **NEXT**.
   
   The letters will be opened in Microsoft Word as a single document, each letter will begin on a new page.
6. Review the letter(s) and modify as needed, then print the document from Word.
   
   You may save the Microsoft Word document if you wish; doing so will not affect the template.
## Section III: Inventory

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Inventory Overview</td>
<td>135</td>
</tr>
<tr>
<td>10</td>
<td>Merchandise Departments</td>
<td>153</td>
</tr>
<tr>
<td>11</td>
<td>Item Basics</td>
<td>161</td>
</tr>
<tr>
<td>12</td>
<td>Item Quantities, Cost and Price(s)</td>
<td>181</td>
</tr>
<tr>
<td>13</td>
<td>Item Styles Assemblies and Groups (Pro)</td>
<td>211</td>
</tr>
<tr>
<td>14</td>
<td>Inventory Counts and Adjustments</td>
<td>231</td>
</tr>
</tbody>
</table>
Chapter 9

Inventory Overview

Inventory Overview ................................................................. 136
How Point of Sale Documents Update Inventory .......................... 136
Tracking Quantities and Costs .................................................. 138
Item Types ................................................................. 139
Viewing Your Item List ........................................................ 140
Viewing an Individual Item .................................................... 141
Using Inventory Reminders ...................................................... 142
Viewing Item History ............................................................ 146
Inventory Ratings and Trends .................................................. 147
Custom Inventory Fields (Pro) .................................................. 148
Serial Number Tracking (Pro) ................................................. 149
Searching for a Document by Serial Number .............................. 150
Printing Your Item List and Tags .............................................. 151
Printing your Item List .......................................................... 151
Printing Price Tags ............................................................... 151
Inventory Reports ................................................................. 152
Inventory Overview

The Point of Sale inventory is designed to help you define, track, view, edit, and group your merchandise in a convenient and efficient manner. Each row in your item list represents a unique item. The inventory system is referred to as a perpetual inventory system, because transactional documents created in Point of Sale (receiving vouchers, sales receipts, adjustment memos, and transfer slips) keep the item quantities and costs updated automatically.

If you use QuickBooks financial software, the transactional documents you create in Point of Sale are sent to your financial software to help maintain an accurate valuation of your inventory.

The Point of Sale inventory stores all item information, including on-hand quantity, costs, prices, UPC numbers, tax status, minimum quantities (reorder point), and more.

Point of Sale provides various inventory reports. See Chapter 26 Reports and Sales Charts (page 459) for more information on reports in Point of Sale.

This chapter is an overview of how your Point of Sale inventory works. The following chapters contain most of the specific information and instructions for working with departments and items.

How Point of Sale Documents Update Inventory

There are two document types that track and record your retail activities.

- **Transactional documents** record actual changes in inventory and provide a permanent record of those changes. For example, a sales receipt is a transactional document that permanently records the deduction of an item quantity from inventory when the item is sold. Transactional documents can never be deleted, *see Cleaning Up Your Company Data (page 17) for exception*. For this reason, transactional documents are referred to as *history documents*. Receipts, for example, are contained in your *sales history* list. The information contained in your transactional history is used for running reports, for tracking customer and vendor purchases, and are sent to QuickBooks financial software to update your financial records.

- **Order documents** are used to plan the purchase or sale of merchandise. The information recorded on an order document, such as items, costs, deposits, and terms can be easily transferred to a transactional document when the merchandise is actually received or sold. Typically, once the planned purchase or sale has occurred, the order document is no longer needed.
Inventory Overview

**The Transactional Documents Used in Point of Sale**

**Vouchers.** Receiving vouchers add to inventory the merchandise received from vendors. Vouchers adjust your inventory item on-hand quantity and cost. Return vouchers subtract from inventory merchandise that is returned to vendors. The order document related to vouchers is the purchase order.

**Receipts.** Sales receipts subtract merchandise from inventory when customers make purchases. A return receipt is used to add merchandise back to inventory when returned by a customer. The order document related to receipts is the customer order (includes layaways, sales orders, and work orders; available in the Pro levels only).

**Adjustment Memos.** Adjustment memos can either add or subtract merchandise from inventory or adjust inventory costs. Memos are used when none of the other transactional documents are appropriate. For example, an adjustment memo could be used to deduct shrinkage quantities or quantities donated to a charitable organization, or to correct previous errors.

**Transfer Slips (Pro Multi-Store).** Transfer slips (or “slips”) record the transfer of merchandise quantities from one store to another.
**Tracking Quantities and Costs**

Item quantities and costs have significant impact on inventory value and your financial records. For this reason, you should be careful when editing these values in inventory. Point of Sale maintains an accurate ledger of changes in these values with the use of transactional documents (receiving vouchers, receipts, and adjustment memos) and the Physical Inventory utility.

The table below summarizes the actions taken when quantities and/or costs are updated in various ways.

<table>
<thead>
<tr>
<th>Method</th>
<th>Edits</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Edit</td>
<td>Quantity and Cost</td>
<td>Recommended only when adding pre-existing items during initial program start up. After that, the transactional documents you create update these values. If you manually edit these fields, Point of Sale creates an adjustment memo to send to QuickBooks financial software.</td>
</tr>
<tr>
<td>Receiving &amp; Return Vouchers</td>
<td>Quantity and Cost</td>
<td>Should be used for receiving or returning all new and reordered items into inventory. Vouchers update the on-hand quantity and average unit cost for received (or returned) items. Receiving vouchers also update an item’s order cost, which is then suggested on the next purchase. Refer to Chapter 17 Receiving Merchandise (page 281) for more information.</td>
</tr>
<tr>
<td>Sales &amp; Return Receipts</td>
<td>Quantity</td>
<td>When an item is sold or returned on a receipt, the on-hand quantity is adjusted up or down accordingly.</td>
</tr>
<tr>
<td>Adjustment Memos</td>
<td>Quantity or Cost</td>
<td>An adjustment memo is the recommended way to edit quantity or cost if it is not recorded on another transactional document (such as shrinkage, donations, etc.). Refer to Adjusting Item Costs and Quantities (page 243) for more information.</td>
</tr>
<tr>
<td>Physical Inventory</td>
<td>Quantity</td>
<td>A physical inventory (PI) is used to update inventory on-hand quantities with actual item counts. You can enter counted quantities for all your inventory items on a single screen. Updating a PI automatically creates adjustment memos to update inventory and your financial software. Refer to Chapter 14 Inventory Counts and Adjustments (page 231) for more information.</td>
</tr>
<tr>
<td>Transfer Slips (Pro Multi-Store)</td>
<td>Quantity</td>
<td>A transfer slip updates the quantity at both the sending and the receiving stores. The receiving store should NOT create a receiving voucher when transferred merchandise arrives. Refer to Transferring Merchandise between Stores (page 557) for more information.</td>
</tr>
</tbody>
</table>

Refer to Chapter 12 Item Quantities, Cost and Price(s) (page 181) for more information.
Inventory Overview

**Item Types**

There are several ways Point of Sale can categorize and work with items:

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inventory Items</strong></td>
<td>Most of your merchandise will be inventory items, that you purchase from vendors, sell to customers, and track on-hand quantities. Inventory item quantities and/or costs are updated by transactional documents.</td>
</tr>
<tr>
<td><strong>Service Items</strong></td>
<td>Used for charging for repairs, alterations, warranty work, or other non-merchandise charges. The on-hand quantity of service items is always zero, as they are non-merchandise items.</td>
</tr>
<tr>
<td><strong>Non-inventory Items</strong></td>
<td>Non-inventory items are also typically used to sell non-merchandise items and their quantity is always zero. Non-inventory items offer a way to use non-merchandise items and have them posted to your financial software differently than your service items. Some retailers choose to use non-inventory items for incidental merchandise for which they do not wish to track quantities.</td>
</tr>
<tr>
<td><strong>Assembly Items</strong> (Pro)</td>
<td>An assembly item is “built” of two or more other inventory items. For example, you might sell bicycles, but also accessories. If you put together a bicycle and attach a kickstand, water bottle holder, basket, and bell, you have a new item; assembled from the individual parts. Once the assembly is built, the specific individual item units included are no longer available for individual sale.</td>
</tr>
<tr>
<td><strong>Group Items</strong> (Pro)</td>
<td>A group item provides an efficient means to group and sell two or more items as a package, at a defined group price, by entering or scanning a single item identifier. Group items differ from assemblies in that they are not pre-built and the component items remain in inventory individually and in that the individual items included in a group are always printed on sales documents.</td>
</tr>
<tr>
<td><strong>Special Order Items</strong> (Pro)</td>
<td>Special order items are used to sell custom or one-time merchandise that you do not currently carry in inventory, and may never carry. Special order items can only be added to inventory while creating a document to order or sell them. If you decide later to carry the special order item, you can easily convert it to a regular inventory item.</td>
</tr>
</tbody>
</table>

*For more information on working with the various item types:*

**Overview:** This chapter.

**Inventory, Service, Non-inventory, and Special Order:** Chapter 11 Item Basics (page 161)

**Assembly, Group, and Item Styles:** Chapter 13 Item Styles, Assemblies, and Groups (Pro) (page 211)
To access your inventory items:

From the Inventory menu, select one of the following:

- **NEW ITEM** to add an item to inventory. Refer to *Adding Inventory Items (page 164)* for more information.
- **ITEM LIST** to view, locate, and work with an existing item (described later in this chapter).
- **REMINDERS** to view the inventory Reminders screens for various inventory conditions (described later in this chapter).

The Inventory menu also provides access to other inventory-related areas of the program, such as your department list, inventory adjustment memos, Price Manager, and Physical Inventory. These other areas are covered in their respective sections of this guide.

(Pro Multi-Store) Remote stores can view inventory, but cannot add or edit items, other than special order items. Refer to *Chapter 32 Managing a Multi-Store Inventory (page 545)* for more information about multi-store inventory features.

### Viewing Your Item List

All of your items are displayed in a list as shown below. All normal list procedures, such as filters, sort, and search work in the item list.

To display your items in a list, choose **ITEM LIST** from the Inventory menu. Each item is listed on a separate line.

To display only items that meet specified criteria, make a selection from the view drop-down list at the top of the item list. You can choose a predefined filter, such as all items, or create and save your own custom filters.

Add, remove, or rearrange the list columns to meet your needs. Refer to *Customizing Columns in Lists (page 586)* for more information on customizing list columns.
Inventory Overview

A summary of list statistics, such as number of items, quantity, cost or price, can be displayed at the bottom of your screen. Refer to List Summary (page 104) for more information.

Viewing an Individual Item

The item form is used to take a detailed look at a single item, to add a new item, and (usually) to edit an item. Select FORM from the View menu or double-click an item in your list to display it in a form.

The image below displays an item form for Pro-level users. Select from the available tabs to toggle the view for various item fields.

The tabs and fields on the item form vary, depending on the level of Point of Sale that you use.
For item details, you can also view the Item Information Panel in the item list by selecting **COLLAPSE** while the item is highlighted in the list. This displays the item information panel, which much of the same information as available on the item form.

### Using Inventory Reminders

The Inventory Reminders feature helps you track and manage your inventory by alerting you to situations that may need your attention, such as when item quantities fall below their reorder points.

The Reminders available depend on the level of Point of Sale you use and, in a multi-store configuration, whether you are a Headquarters or remote store.

**The types of Reminders available at each program level are:**

**All Levels:** Reminders to reorder items at or below their reorder points.

**Pro Levels:** Also have reminders for item price changes, new items added to inventory, and filling of customer orders.

**Pro Multi-Store only:** Also have reminders for duplicate items added to inventory. (Pro Multi-Store) Reminders are a handy way to communicate price changes and new items to remote stores. Refer to Chapter 32 Managing a Multi-Store Inventory (page 545) for more information about the Reminders features that are unique to a multi-store configuration.
To be alerted when Reminders are available to view:

Optionally, a Reminders icon can be added to the Point of Sale status bar at each workstation. With this option turned on, a brief Reminders message is displayed upon program startup, as shown to the right, if reminder items are pending for your review. Clicking the icon or message link takes you to the Reminders window.

From the Reminders window, you can double-click any item or document in the list to display that record.

To access the Reminders window:

1. From the Inventory menu, select REMINDERS.
2. Select one of the reminder tabs available to display the affected items.

   Additional information about each type of Reminder is available below.

To print the displayed reminders list:

1. From the Print menu, select PRINT LIST.
2. In the Print Document window, select ALL LISTED RECORDS.
3. Select PRINT.

Reorder Items Reminder

The reorder tab displays all items whose combines on-hand quantity and order quantity, or, for Pro users, available quantity, have fallen to or below their reorder points. This screen can help you identify those items you need to reorder from your vendors.

When you complete a purchase order to reorder an item, it is removed from the reorder Reminder list.

(Pro) You can base item reorder reminders on the on-hand quantities or the available item quantities. You can also have Point of Sale suggest and generate purchase orders to order these items.

Refer to Using Item Reorder Points (page 182) for more information about setting reorder points for your inventory items.
Refer to Having Point of Sale Suggest Purchase Orders (Pro) (page 279) for more information about the Suggest PO feature.

New Items Reminder (Pro)
The New Items tab displays new items added to inventory. This screen alerts users to prepare the store for the arrival of these items. Monitoring this list also allows your associates to better serve customers by letting them know what new merchandise is coming soon. Tags can be printed from this window if prices have been entered for the new items.

The items on this list should be removed as they arrive at the store so that the list remains current and useful.

To select items to print or remove:

- Select a single item, or you can also use the multi-select feature to select a number of specific items by holding down the <CTRL> key and selecting the items. See Selecting multiple records (page 102) for more information on using the multi-select feature.
- Choose SELECT ALL to select all items on the list
- Choose SELECT NONE to clear (uncheck) all previously selected items
- Choose REMOVE SELECTED ITEM(S) to delete the selected items from the list
- Choose PRINT ITEMS or PRINT TAGS from the Print menu to print the selected items

Price Changes Reminder (Pro)
The Price Changes tab displays item price changes. Both the Old Price and New Price at your default price are displayed in the list. This option reminds you to update your price tags, so your inventory records and the tagged items on the shelf match.

The items on this list should be removed after you review and print tags so that the list remains current and useful.

<table>
<thead>
<tr>
<th>Depart.</th>
<th>Item Name</th>
<th>Attribute</th>
<th>Size</th>
<th>New Price</th>
<th>Old Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>FKC</td>
<td>Cleats</td>
<td>Black</td>
<td>10.5</td>
<td>$24.00</td>
<td>$23.00</td>
</tr>
<tr>
<td>FKC</td>
<td>Cleats</td>
<td>Black</td>
<td>11</td>
<td>$24.00</td>
<td>$23.00</td>
</tr>
<tr>
<td>FKC</td>
<td>Cleats</td>
<td>Black</td>
<td>11.5</td>
<td>$24.00</td>
<td>$23.00</td>
</tr>
</tbody>
</table>

To select items to print or remove:

- Select a single item, or you can also use the multi-select feature to select a number of specific items by holding down the <CTRL> key and selecting the items. See Selecting multiple records (page 102) for more information on using the multi-select feature.
Using Inventory Reminders

- Choose **SELECT ALL** to select all items on the list
- Choose **SELECT NONE** to clear (uncheck) all selected items
- Choose **REMOVE SELECTED ITEM(S)** to delete the selected items from the list
- Choose **PRINT TAGS** to print price tags for the selected items

Refer to **Printing Tags and Labels** (page 43) for more information about tag printing.

**Fill Customer Orders Reminder (Pro)**

The Fill Customer Orders tab displays customer orders which can be filled with received items. Monitoring this list also allows you to better serve customers by filling their orders as soon as the ordered merchandise is available. You can select to view orders that can be partially filled, or only orders that can be completely filled.

You can print a Fill Order Report which details all selected orders, or you can print an item pick list which details the items you wish to set aside to fill the customer orders.

**To select orders for print options:**

- Choose individual items by selecting the corresponding checkbox to the left of the item
- Choose **AUTO-SELECT ORDERS** from the I Want To menu to select all orders on the list which can be filled, based upon a date priority of filling oldest orders first
- Select **CLEAR ALL ORDERS** from the I Want To menu to clear (uncheck) all previously selected orders
- Select **PRINT FILL ORDER REPORT** or **PRINT ITEM PICK LIST** from the Print menu to print these reports.
Viewing Item History

Item history allows you to view summarized statistical data for an item, as well as a listing of all transactional documents that have affected the item quantity or cost.

(Pro Multi-Store) Item History is available only at Headquarters. Use the Store drop-down list at the top of the window to display documents for any one store or for the entire company.

To access item history:

1. Highlight or display an item record in the list.
2. Select COLLAPSE at the top of the item list, the ITEM HISTORY tab is displayed by default in the Item Information Panel.
   
   Or

   View the item form and select the HISTORY tab.

To view a listed document:

1. Highlight the document in the history list.
2. Select GO TO DOCUMENT from the I Want To menu in the upper-right corner of the window.

   Or

   Double-click a document in the list when the QuickZoom icon is displayed to view that document.

Tips for Working with Item History

- The Qty Change column lists the effect of a document on the item’s on-hand quantities. For example, a sale results in the on-hand quantity being reduced, therefore the Qty Change is a negative number, while receiving would result in a positive number.
- The New Qty column displays a running total of the on-hand quantity, after being adjusted by the document.
- If the item is listed multiple times on a document, such as a customer exchange for the same item, the document is listed twice; once for the return (as a positive quantity) and once for the new sale (as a negative quantity.)
- The entire history can be printed by selecting PRINT HISTORY from the I Want To menu.
- You can drag-and-drop column headers to re-arrange their order in the list.
- Press <F5> to refresh the screen if transactions have been made while open.
Inventory Ratings and Trends

You can easily see ratings and trends for your inventory items, right from your inventory list. These indicators are based on sales values you select in company preferences.

- Ratings use a five-star system, with five stars indicating your best performers.
- Item trends compare the current period with the prior period and are indicated by up/down arrows.
- Select or mouse-over a rating or trend field to display a popup giving more detailed information for the item.

**Ratings:** Rating stars represent 20% increments between the highest and lowest values for the category being rated. For example, if the rating is based upon sales quantity, if the highest item sales are 100, and the lowest item sales is 1, any item selling 81 to 100 units during the period is rated five stars. Likewise, an item selling 1-20 units in the period would receive a rating of one star. Items with no sales receive no stars, and those with no data (brand new items, perhaps) display question marks as their rating.

**Trends:** For trends to be effective, set your time period to a maximum of 499 days. The memory period for this feature is a maximum of 999 days and for a trend to be meaningful, Point of Sale needs to be able to look at two full periods within that time frame. A single arrow means a change up or down of 1-50%, a double arrow indicates a trend of more than 50%.

**Viewing the Rating and Trends Columns**

You may need to arrange your columns when viewing the list to position the rating and trends columns where they can be easily seen. See [Customizing Columns in Lists](page 586) for more information on rearranging columns.
To set your preferences for ratings and trends:

1. From the Edit menu on the Server Workstation, select **PREFERENCES ➤ COMPANY**.
2. Select **RATINGS & TRENDS** from the list on the left.
3. Use the checkboxes to turn on Ratings & Trends.
4. Select the value on which you want calculations based and the time period.
5. Select **SAVE**.

![Ratings & Trends](image)

**Custom Inventory Fields (Pro)**

Pro-level users have the ability to define five custom fields for inventory items. These fields can be used to record other item information important to your business. For example, a custom field might be used to record vendor-required identifiers that aren’t suited for other Point of Sale item fields.

Once defined, custom fields can be added to your item list and used for filtering and reporting purposes. Select the **CUSTOM** tab on the item form to set up and use custom item fields.

Using Print Designer, custom fields can be added to your printed documents and tags. *Refer to Custom Fields (Pro) (page 590) for more information.*
Serial Number Tracking (Pro)

Item serial numbers can be recorded on documents for purposes of warranty tracking or meeting legal requirements.

**To use serial number tracking:**

1. In inventory, specify those items for which you want to record serial numbers by selecting the checkbox for **Serial # Tracking** (located on the Additional Info tab of the item form).
2. When listing these items on documents (except purchase orders and cost memos), you are prompted to enter a unique serial number for each unit being processed.

The example shown above is representative of the window displayed when a single unit is listed on a document. If listing multiple units of an item for which you record serial numbers, the window would allow you to enter one serial number for each individual unit being processed.

Each unit of an item with serial numbers recorded is listed on a separate line in the document item list. The serial numbers entered are saved and printed with the document.

If serial numbers are recorded on a layaway or sales order, they are carried to the receipt when the items are sold.

**Optional Serial Number Recording**

Even if you do not select the **Serial # Prompt** checkbox on the item record, you can still record serial numbers when listing an item on a document. This is the default
Chapter 9: Inventory Overview

status of all items in inventory. With this option, you are not prompted to enter a serial number when listing an item on a document, but you can still do so by accessing the Serial Number field manually.

To manually record serial numbers on a document:

1. List the item in the normal fashion.
2. Select EDIT ITEM (<F5>) to open the Item Information window, or navigate to the Serial # field in the item list.
   Add this field to the item list, if necessary. Refer to Customizing Columns in Lists (page 586) for more information.
3. If a single unit is being listed, enter the item serial number in the Serial # field. If multiple units are sold, select the button in the field to open the Enter Serial Number window.

<table>
<thead>
<tr>
<th>Item #</th>
<th>Description 1</th>
<th>Qty</th>
<th>Price</th>
<th>Tax %</th>
<th>Ext. Price</th>
<th>Serial #</th>
</tr>
</thead>
<tbody>
<tr>
<td>274</td>
<td>.22 RAD Pistol</td>
<td>2</td>
<td>$90.00</td>
<td>7.750</td>
<td>$100.00</td>
<td>002398712-34</td>
</tr>
</tbody>
</table>

Sample Serial Number entry on a sales receipt. Select the button to enter serial numbers for multiple units

Changing Quantities After Adding Serial Numbers

If you increase the quantity of a serial number item on a document after having entered a serial number, you will be prompted to enter numbers for the new quantities added. If you decrease the quantity listed after having entered serial numbers, the previous numbers are cleared and you are prompted to re-enter numbers for each unit of the revised quantity. This is because the program has no way of knowing which specific unit(s) you are removing when you adjust quantities downward.

Searching for a Document by Serial Number

You can locate a document from history by searching by serial number.

For example, using the example above, the sales receipt for this specific unit could easily be found later by selecting FIND RECEIPT on the sales history screen and entering the serial number 002398712-34 as the search keyword and selecting to search in the Serial Number field (select ADVANCED FIND OPTIONS to designate the specific field).

Refer to the detailed instructions for Locating Records or Documents (page 31).
Printing Your Item List and Tags

See Chapter 3 General Printing Information (page 39) for general information about printing.

Printing your Item List

1. Display your item list.
2. Select the item(s) you wish to print. To print a group of records, filter your list to display only those and select all displayed.
3. From the Print menu, select PRINT.

Printing Price Tags

Tags printed from inventory always print with your regular item price.

To print tags:

1. Highlight or display the item for which you want to print tags.
   If you want to print tags for a group of items, use a filter to display just those items or hold down your <CTRL> key while clicking selected items.
2. From the Print menu, select PRINT TAGS.
3. Follow the on-screen prompts.
   Refer to Printing Tags and Labels (page 43) for detailed tag printing instructions, including how to print the MSRP, and the cost and last received date in code.

💡 Tip: Don’t Want to Print Tags for an Item?

If you never print tags for an item, clear the PRINT TAGS checkbox field in the item record. This way you will not inadvertently print tags for the item when printing tags for all the items received on a voucher, ordered on a PO, or displayed in a filtered list.

💡 Tip: Printing Markdown Tags

If you use Price Manager to markdown prices, you can print markdown tags showing both old and new prices to demonstrate the savings to your customers. Refer to Printing Tags and Labels (page 43) for more information.
Inventory Reports

Inventory reports can not only show you the state of your current inventory, but can also provide you with inventory status for any previous date.

From the Reports menu, select **ITEMS** and then any of the available reports. Modify the report to meet your needs.

These reports can also be accessed and modified from the Report Center. *Refer to Chapter 26 Reports and Sales Charts (page 459) for more information*
Chapter 10  Merchandise Departments

Working with Departments .................................................. 154
Planning your Departments .................................................. 154
Department Names and Codes ............................................. 155
Creating a New Department ............................................... 156
Locating a Department Record ........................................... 157
Editing Department Records .............................................. 157
Using a Department Pricing Formula ................................... 159
Printing your Department List ............................................ 160
Working with Departments

In most retail businesses, related merchandise is grouped into *departments*; manageable categories created to aid in monitoring past performance, manage inventory, and make buying decisions. A well-designed department structure will save you time and give you greater flexibility when conducting a physical inventory, marking down prices, and printing tags.

In Point of Sale, every item in your inventory must be assigned to a department.

Department options, such as default tax codes and profit margin/markup are automatically suggested when you add new inventory items assigned to a department.

**To access your department records:**

From the Inventory menu:

- Select **NEW DEPARTMENT** to add a department
- Select **DEPARTMENT LIST** to view and work with existing departments

Planning your Departments

The number of departments you establish for your business will depend on how you plan to evaluate the sales performance of your merchandise and your buying strategy. You can put all merchandise into a single department if you wish, but you may want to consider the benefits of setting up a more detailed department structure. A carefully planned department structure allows you to view, edit, or run reports for selected groups of merchandise.

**Consider the following when planning your departments:**

- How do you want to break out sales, merchandise and purchasing reports?
- Do you want to be able to filter your item list for purposes of changing prices, printing price tags, or entering physical inventory counts by merchandise categories?
- Do you have categories of merchandise that are taxed differently or that you price differently than others?

**Example:** If you need to be able to compare the performance of two groups of items, each group should be assigned to its own department. If you budget your purchasing dollars differently for golf shoes than for running shoes, you would want separate departments for each of those shoe types.
Point of Sale can maintain a virtually unlimited number of departments. However, too many departments can result in too much detail on reports, which makes it difficult to get useful, consolidated data. It is recommended that you define only as many departments as you need to effectively manage your purchasing and reporting.

**Department Names and Codes**

As you define each item in inventory, you must assign it to a department. Point of Sale can then track the merchandise by department as it is ordered, received, and sold. Name your departments in a consistent way that makes sense to you and your employees; this makes them easier to remember and allows for intuitive filtering of reports. Department codes, while not required, provide a fast way to search for a department record by typing one to three characters instead of the full department name. Department codes are also printed on price tags, where space is limited. You may find it useful to define department names and codes similarly, such as in the example shown below.

**Sample Department Structure**

**Character 1.** Use the first character of the department code to designate a major merchandise area. For example, in a shoe store one major merchandise area is men's shoes and another is women's shoes. As an example, let's assign an M to designate Men's Shoes and a W for women’s shoes.

**Character 2.** Use the second character to identify a less-broad category. The category of athletic shoes is an example. Let's assign A to designate athletic shoes in the second position.

In this example, the department code of MA would designate *Men's Shoes: Athletic* and WA is *Women's Shoes: Athletic*. You might then complete your department structure as follows:

<table>
<thead>
<tr>
<th>Department Name</th>
<th>Department Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Men's Shoes: Athletic</td>
<td>MA</td>
</tr>
<tr>
<td>Men's Shoes: Dress</td>
<td>MD</td>
</tr>
<tr>
<td>Men's Shoes: Casual</td>
<td>MC</td>
</tr>
<tr>
<td>Women's Shoes: Athletic</td>
<td>WA</td>
</tr>
<tr>
<td>Women's Shoes: Dress</td>
<td>WD</td>
</tr>
<tr>
<td>Women's Shoes: Casual</td>
<td>WC</td>
</tr>
</tbody>
</table>
If you want even more detailed merchandise categories, add a third character to your department codes and names. For example, your men’s athletic shoes might be further broken down into tennis shoes (MAT), running shoes (MAR), and golf shoes (MAG).

As you define your departments, consider how they might be used when filtering to generate a report or to group your items for taking a physical inventory.

---

**Imported Items from QuickBooks Financial Software**

If you imported items from QuickBooks financial software, all of the imported items were put into a single department, with a name of QuickBooks Financial Software (Code: QB). To make reports and purchasing records more meaningful and intuitive you should define new departments to meet your needs and then assign the imported items in inventory to the new departments.

Refer to Reviewing Data Imported from QuickBooks (page 122) for more information about reviewing imported data.

---

**Creating a New Department**

Departments can be created as needed to categorize your merchandise in inventory.

**To create a new department:**

1. From the Inventory menu, select NEW DEPARTMENT, or select NEW from the window toolbar if already in your department list.
   - A blank department form is opened.
2. Enter a department name and, if desired, a department code.
3. Enter information in the other fields, as appropriate.
   - Refer to Department Information Fields (page 652) and the rest of this section for more information about the use of each field.
4. Select SAVE.
Using Copy to Create a Department Record

If an existing department is similar to one you want to add, simply copy the department and then edit the copy to reflect the new department information.

To create a department by copying an existing department record:
1. In your department list, highlight the department record to be copied.
2. Select COPY from the window toolbar. All the fields from the original department are copied to a new record.
3. Enter a unique department name/code and modify other information as needed.
4. Select SAVE.

Locating a Department Record

You can locate a specific department record by sorting, scrolling, filtering or searching your department list. Refer to Chapter 7 Lists, Forms and Filters (page 99) for instructions for each method.

Editing Department Records

You can freely edit your department records, as needed. However, read the warning that follows this procedure for important information about the effects of editing.

To edit a department record:
1. Display your department list.
2. Highlight the department record you want to modify.
3. Select EDIT.
4. Modify the department fields as necessary.
5. Select SAVE.

To edit multiple department records right in the department list, select TURN LIST EDIT ON from the Edit menu, then navigate through the rows making your changes. Your changes are automatically saved when you navigate out of each row. Select TURN LIST EDIT OFF from the Edit menu when finished. Closing the department list will also turn off list edit mode.
Warning: Use Caution When Editing Departments

Editing a department name in the department record does not update the name on existing item records in inventory. You must edit the department name for each item assigned to the department in inventory.

Likewise, editing the MARGIN %, MARKUP %, and TAX CODE fields does not affect these values for existing items in inventory. The new values are applied only when adding new items to the department.

Deleting a Department Record

Use this procedure to delete department records that are no longer needed.

To delete a department record:

1. Display your department list.
2. Highlight a department.
3. Select DELETE.

Deleting a Department Record

Deleting a department record does not affect inventory, history documents, or the ability to run reports for the department. The department name remains in place on item records and history documents.
Using a Department Pricing Formula

A predefined pricing formula can be used to calculate new item prices as they are added to inventory. When a new item is added and assigned to a department with a predefined margin, Point of Sale will automatically compute the item’s regular price by applying the predefined margin to the item cost.

Note that pricing formulas affect only prices of new items added to inventory, they do not adjust prices of existing items when costs change.

If needed, the margin can be edited in inventory for individual items by entering a new margin in the Margin % field of individual item records.

If you prefer, you can define a markup instead of a margin. Enter the markup from cost in the Markup % field in the department record. Point of Sale calculates and displays the margin for you.

### Markup May be Recalculated

You can enter either a Markup % or a Margin % to specify your desired profit margin. However, Point of Sale only calculates prices from the margin, which must be a whole number (no decimals). If you enter a markup, Point of Sale will calculate and round the margin to the nearest whole number. Using this figure, Point of Sale then recalculates your markup and displays the result in the Markup % field. This figure may differ slightly from what you entered originally.

If you prefer to manually define your own prices in inventory, it is recommended that you do not enter a margin or markup in the department record.

To define a default department margin or markup:

1. Display the department record.
2. Enter a value in either the Margin % field or the Markup % field.
   Entering either results in the other being calculated and displayed by Point of Sale.
3. Select SAVE.

Repeat this process for each department for which you want to use a pricing formula on new items. Refer to Handling Item Cost and Price (page 189) for more information about how a pricing formula is applied to new items.
Printing your Department List

Refer to Chapter 3 General Printing Information (page 39) for general information about printing.

To print your department list:

1. Display your department list.
2. Select the department(s) you wish to print.
   - To print the entire list, make sure the View drop-down is set to ALL DEPARTMENTS.
   - To print a group, filter the list or use multi-select procedures to display or select only those departments.
3. From the window toolbar, select PRINT.
4. Select to print ALL DISPLAYED or SELECTED records.
5. Select OK.
# Chapter 11  Item Basics

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Overview</td>
<td>162</td>
</tr>
<tr>
<td>Adding Inventory Items</td>
<td>164</td>
</tr>
<tr>
<td>Importing Items</td>
<td>164</td>
</tr>
<tr>
<td>Manually Adding an Item</td>
<td>164</td>
</tr>
<tr>
<td>Item Identifiers</td>
<td>166</td>
</tr>
<tr>
<td>Using Item Numbers</td>
<td>166</td>
</tr>
<tr>
<td>Using UPCs</td>
<td>166</td>
</tr>
<tr>
<td>Using Alternate Lookups</td>
<td>167</td>
</tr>
<tr>
<td>Assigning Item Tax Codes</td>
<td>168</td>
</tr>
<tr>
<td>Assigning Item Accounts for Financial Exchange</td>
<td>169</td>
</tr>
<tr>
<td>Pictures in your Item Records (Pro)</td>
<td>170</td>
</tr>
<tr>
<td>Picture Attributes</td>
<td>170</td>
</tr>
<tr>
<td>Adding Pictures to an Item Record</td>
<td>171</td>
</tr>
<tr>
<td>Viewing Item Pictures</td>
<td>172</td>
</tr>
<tr>
<td>Using Service and Non-Inventory Items</td>
<td>173</td>
</tr>
<tr>
<td>Using Special Order Items (Pro)</td>
<td>174</td>
</tr>
<tr>
<td>Working with Existing Items</td>
<td>175</td>
</tr>
<tr>
<td>Locating an Item</td>
<td>175</td>
</tr>
<tr>
<td>Editing an Item</td>
<td>176</td>
</tr>
<tr>
<td>Deleting an Item</td>
<td>177</td>
</tr>
<tr>
<td>Merging Item Records</td>
<td>178</td>
</tr>
</tbody>
</table>
Chapter 11: Item Basics

Item Overview

This section covers the basic rules and information fields typical for defining inventory items. Detailed instructions on how to create, edit, or delete specific item types are found in later sections of this chapter.

Although many information fields are available in inventory, the essential fields that serve to define each item are:

<table>
<thead>
<tr>
<th>Essential Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Type</td>
<td>Identifies the type of item. Required.</td>
</tr>
<tr>
<td>Dept Name</td>
<td>The department to which the item belongs. Departments serve to categorize merchandise for efficient viewing, reporting, and purchasing. Required.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor of the item. Pro-level users have the option to enter a preferred vendor and up to four alternate vendors. Refer to Using Multiple Vendors for an Item (Pro) (page 263) for more information.</td>
</tr>
<tr>
<td>Item Name</td>
<td>The principal, short description of the item, making it easy to identify. Printed on receipts. Required.</td>
</tr>
<tr>
<td>Item Description</td>
<td>Optional, longer item description.</td>
</tr>
<tr>
<td>Attribute</td>
<td>A field used to describe an item characteristic, typically color, material, pattern, a second size, etc.</td>
</tr>
<tr>
<td>Size</td>
<td>The size or any other characteristic of an item (the field is labeled Size, but is essentially another Attribute field)</td>
</tr>
</tbody>
</table>

Customizing Field Labels

The four item descriptive fields (Item Name, Item Description, Attribute and Size) can be re-named to better suit the merchandise you sell. Throughout this manual, we use the default names when talking about these fields. Refer to Item Field Labels (page 589) for more information.

Each item must be unique in the combination of Department, Item Name, Attribute, and Size. It is not sufficient to record some unique data in Vendor, Item Description or in some other item field.

Required Item Fields

Technically, only ITEM TYPE, DEPT NAME, and ITEM NAME are required item fields. However, we recommend that you enter a VENDOR and at least one of ATTRIBUTE or SIZE to help avoid creating duplicate items. Point of Sale will not allow duplicates items.
A Note About Item Quantities and Costs

You can define initial on-hand quantities, reorder quantities, costs, prices and margin/ markup when you are defining a new item. However, you should use caution in entering on-hand quantities and costs for new items.

- An item's quantity is increased by the quantity received when a receiving voucher is made. If you manually enter the quantity of a new item you are going to be ordering and receiving on a voucher, the quantity will be added a second time when the voucher is saved, thus doubling your inventory. It is generally recommended that you manually enter a quantity only when adding items already physically in your store during program startup.

- Receiving vouchers also automatically update the average item cost and order cost as items are received into inventory. Allowing the voucher to enter this information for items is the best way to ensure accurate cost values and inventory valuation.

Quantity and Cost Memos Automatically Created on Manual Edits

If you manually enter or edit quantities or cost, adjustment memos are automatically created and sent to QuickBooks financial software, where they affect your inventory valuation. See Chapter 14 Inventory Counts and Adjustments (page 231) for more information.

See Chapter 12 Item Quantities, Cost and Price(s) (page 181) for more information on tracking these important values.

Smart Abbreviations

To more easily locate, view, or run reports by color, size, or other attributes, you should establish standard abbreviations for sizes and attributes and be consistent in their usage. For example, you could use Blk or Black for a color, but should not use both. Blk and Black will be treated as two different colors by filters and on reports. However, the program is not case sensitive so Blk, blk, and BLK are all treated as the same color.
Adding Inventory Items

Importing Items

There is no way to avoid the chore of entering your inventory items when just getting started. But if you have an existing item list in another program or from a vendor, importing those items can save you time and helps avoid errors that can occur with manual entry. Point of Sale provides two ways to import existing items:

- You can import existing items from your QuickBooks financial software company file
- You can use the Data Import Tool to import new items or updated item catalogs from vendors via an Excel spreadsheet or a comma-delimited text file

Refer to Chapter 8 Importing and Exporting Data (page 117) for more information and instructions.

Manually Adding an Item

Use this procedure to manually add an inventory item to inventory.

1. From the Inventory menu or from the window toolbar in the item list, select **NEW ITEM**.
   A blank item form is opened.
2. Select an **Item Type**.
   The default item type is **INVENTORY**; a regular merchandise item for which you will track quantities. Refer to later sections of this chapter for uses of other item types.
3. Enter a **Dept Name**, **Vendor**, **Item Name**, and **Size** and **Attribute** if applicable.
   To look up a department or vendor, select the drop-down arrow in the field or choose **SELECT DEPARTMENT FROM LIST** or **SELECT VENDOR FROM LIST** from the I Want To menu. You can add a new department or vendor, if necessary, by selecting **ADD NEW** from the drop-down list.
4. Move through the item form tabs, entering item information as appropriate:
   - We recommend that you enter an **On-Hand Quantity** and **Average Unit Cost** only if you are adding already in-stock items. If this is a new item, being ordered on a purchase order, leave these fields at zero or blank. These fields will be updated when the item is received on a voucher.
• If you prefer to manually define your item prices, enter the **Regular Price**. The prices for your optional price levels are automatically calculated, based on your price level preferences. Access additional pricing fields by selecting the **PRICING** button.

*If you prefer to have Point of Sale calculate your prices, using the default margin or markup recorded in the department record, leave the price fields blank. When the item is received on a voucher, Point of Sale will populate the cost field and calculate the prices at all levels.*

• Specify a **Tax Code**, if applicable.

• Enter **UPC** or **Alternate Lookup** values, if applicable. UPCs can be added by scanning pre-printed tags from your vendor.

• Enter an **Order Cost** and optionally, an **MSRP** reference price.

*Refer to Item Information Fields (page 647) and remaining sections of this chapter for information about other available item fields.*

5. Select **SAVE**.

(Pro) If you work with groups of related items as styles, you may find it is much more efficient to use the **Style window** when creating a new style or adding items to an existing style. Refer to Working with Item Styles (page 212) for more information.

---

### Adding a New Item by Copying an Existing Item

Sometimes the quickest way to add a new item to inventory is to copy an existing similar item and then edit to make it unique.

1. Highlight or display the item you want to copy.

2. From the window toolbar, select **COPY**.

   The information from the existing record is pasted into a new item form.

   Some information fields, such as **On-Hand Qty**, **UPC**, **Alternate Lookup**, and the **Unorderable** flag, are not copied.

3. Enter new values in these fields as appropriate, as well as editing any other fields that differ from the copied item. At least one of **Department**, **Item Name**, **Attribute**, or **Size** must be edited to avoid creating a duplicate item.

4. Select **SAVE**.

---

⚠️ **Using New Item Reminders (Pro)**

The New Item Reminders window can alert your employees to prepare for the arrival of new items added to inventory. Monitoring this list allows your associates to better serve customers by letting them know what new merchandise is coming soon. Price tags can also be printed from this window if prices have been entered for the new items. Refer to Using Inventory Reminders (page 142) for more information about New Item reminders.
Item Identifiers

The term *item identifiers* refer to an item’s UPC, Alternate Lookup, and Item # values in inventory. Item identifiers are used for looking up and listing items on documents and printing tags, as well as in other program features.

Using Item Numbers

Every item (except special order items) has an Item # assigned by Point of Sale when added to inventory. This Item # can be edited but cannot be deleted. Item numbers must be unique, duplicates are not allowed.

Besides being used for item lookups from documents, item numbers are also used to print bar code tags from within Point of Sale. This allows you to look up and list any item in your inventory using a bar code scanner.

Do not enter the item number in any other item field to print bar-coded tags.

Using UPCs

Manufacturer-supplied tags with UPCs can be used to lookup and list items on documents, provided the UPC has been recorded in inventory for the item.

Recording UPC #s in Inventory

The UPC field can be used to record UPC-E, UPC-A, EAN, ISBN, or similar identifiers up to 13 digits. Point of Sale will convert entries of less than 13 digits (such as UPC-A and UPC-E) to a 13-digit form. Every UPC recorded must be unique and contain only numbers.

Do not scan bar codes created from item numbers in Point of Sale into the UPC field in an item's record.

Likewise, if a vendor provides alphanumeric barcodes that are not true UPC codes, do not enter those codes into the UPC field. UPC codes have a required format, and other code formats are not accepted. Consider using the Alternate Lookup field for these codes instead (see below).
Adding Inventory Items

Method 1: Scanning

UPC numbers can be efficiently and accurately entered by scanning the UPC bar code on the manufacturer’s label or tag. Simply position the cursor in the **UPC** field on the item record and scan the tag.

Method 2: Manual Entry

<table>
<thead>
<tr>
<th>Type of code</th>
<th># of digits</th>
<th>If you enter...</th>
<th>Point of Sale will...</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPC-E</td>
<td>6</td>
<td>All 6 digits</td>
<td>Expand those 6 to a 13-digit form.</td>
</tr>
</tbody>
</table>
| UPC-A        | 12          | The first 11 digits  
Example: 12345612345  
All 12 digits | Add the 12th digit (checksum) & leading zero.  
Example: 0123456123458  
Add the leading zero. |
| EAN          | 13          | All 13 digits | Add nothing. |
| Other        | <13         | All digits | Expand the entry to a 13-digit form. |

**UPCs in History**

When an item is sold, received, or adjusted, its UPC from inventory is recorded on the history document. Thus, merchandise can be filtered by UPC when running history reports even after the item has been deleted from inventory. *Refer to Chapter 26 Reports and Sales Charts (page 459) for more information about report filtering.*

Using Alternate Lookups

An *Alternate Lookup* (ALU) is an optional user-defined field in inventory that can be used to lookup and list items on documents. The use of Alternate Lookups is particularly well suited to retailers that do not tag merchandise. This field can contain text descriptions, part numbers, catalog numbers, alphanumeric entries, abbreviated names, etc., anything that allows you to quickly and positively identify a unique item.

Alternate Lookups must be unique for each item for which they are defined.

To be effectively used for item lookups, each Alternate Lookup entry:

- Should be a unique character string that can be easily remembered by cashiers or posted next to your workstations.
- Should not duplicate the *Item #* or **UPC** code of the item or any other item.
- You may want to make your Alternate Lookups start with a letter rather than a number. This helps ensure that they do not duplicate an item or UPC number. If you have an Alternate Lookup of 1234 and item number of 1234,
both will be returned as matches when you enter 1234 in the item lookup field on a document.

**To define alternate lookups:**

1. From the Inventory menu, select **ITEM LIST**.
2. Select **NEW ITEM** or locate an existing item and select **EDIT**.
3. Navigate to the **Alternate Lookup** field and make an entry.
4. Select **SAVE**.

**Example use of alternate lookups:**

If you sell a large volume of one-gallon, two-gallon, and five-gallon clay pots from the vendor Clay Pots International (Vendor Code: CPI) and you don't want to bother tagging them, you could define Alternate Lookups for the three pots as CPI1, CPI2, and CPI5 respectively.

If a customer purchases a five-gallon clay pot, you would simply enter CPI5 in the **Enter Item(s)** field to list that item on the receipt. If necessary, you could post a list of Alternate Lookups at your workstations to ensure cashiers make the correct entries.

**Assigning Item Tax Codes**

If you collect tax on sales, all new items added to inventory are assigned the tax code specified in the associated department. The tax code can be changed for individual items in inventory when adding the item or by editing it later.

**To assign tax codes to items in inventory:**

1. Start a new item record or select **EDIT** from an existing record.
2. Navigate to the **Tax Code** field and select the appropriate tax code from the drop-down list.
3. Select **SAVE**.

**Setting Up Tax Codes**

You set up tax codes and taxing instructions in company preferences. Refer to **Sales Tax Overview** (page 339) for more information.

**Changing the Tax Code for an Item Style (Pro)**

To easily change the tax code for all items in a style, edit the Tax Code field in the upper pane of the Style window. Refer to **Working with Item Styles** (page 212) for more information.
Assigning Item Accounts for Financial Exchange

During program configuration, you probably set your item account mapping preferences by item type in company preferences (or accepted the default mappings). The default item mappings are assigned as new items are added to inventory. This increases the efficiency with which you can add a new item. However, there may be circumstances under which you want individual item sales and costs to be posted to accounts other than the defaults. Use the following procedure to assign different QuickBooks COGS, Income, and Asset accounts on an item-by-item basis.

To assign QuickBooks financial software accounts to an individual item:

1. Start a new item record or select **EDIT** from an existing record.
2. Select the **ADDITIONAL INFO** tab.
3. In the QuickBooks Information area, choose new accounts from the drop-down lists.
4. Select **SAVE**.

Your new account mappings will go into effect on the next Financial Exchange with your financial software.

Refer to **Custom Mapping of Accounts (page 524)** for more information.

---

Account Selection Limitations

With few exceptions related to income accounts, Point of Sale does not place limitations on the QuickBooks account types you can map for COGS, Income, and Asset amounts. You have the same freedom in account usage as you have in QuickBooks financial software.

Mapping Department and/or Store Sub-Accounts

You can also map departments and, for Multi-Store users, store locations to sub-accounts in QuickBooks financial software. Refer to **Map QuickBooks Accounts by Department or Store (page 526)** for more information.
**Pictures in your Item Records (Pro)**

Nothing can replace the simplicity of identifying items by seeing them. There are many in-store advantages to adding pictures or photos to your item records. An item can be mislabeled in error, or the tag swapped intentionally by an unscrupulous customer. By associating an image of the item in the item’s record, you can easily identify if the item has the correct tag. It can also be easier to find an item on the shelf or on a rack if you can first see a picture of what that item looks like. Having pictures for your items is virtually a requirement for a successful e-store, where shoppers can browse through your online inventory and place orders on the Internet.

In Point of Sale, you can associate up to two images with an item or style. The pictures are stored with your data on the Server Workstation, but can be viewed at all workstations on your network.

You must enable the use of item pictures during the Setup Interview or in company preferences.

---

**Preferences: Using Item Pictures**

PREFERENCES  COMPANY  INVENTORY  I want to associate pictures with my inventory items. Select the checkbox, to add the item picture fields and options to Point of Sale screens.

If you require program logins, the ability to add, remove or change the pictures associated with items is determined by the security rights of the signed-in user.

---

**Picture Attributes**

You can assign or import pictures in .jpg, .gif, .bmp and .tif formats. However, Point of Sale converts and stores all pictures in the .jpg format.

The maximum picture size is 500 by 500 pixels. If you use pictures larger than this, Point of Sale will resize it to the maximum dimensions. Since these pictures are intended for viewing on your computer monitor, the recommended resolution is 72 dpi. Higher resolutions can greatly increase file sizes, which in turn increases disk space and loading time. Large picture files can also increase processing time for creating your backup files.

Picture file information is preserved when the picture is brought into Point of Sale. Additionally, information for the picture name, size, and last edit date is also saved.
Adding Pictures to an Item Record

You can associate two pictures with each of your items. One picture will be designated as the default picture, and this will be used to generate the thumbnail picture displayed throughout Point of Sale. A second picture can also be assigned to provide an alternate view of the item. You can switch between the pictures or if you integrate with an e-commerce application, use the second picture for online pages.

Adding pictures to an item record is accomplished from the Item Info tab on the item record. Pictures can also be imported in bulk into Point of Sale rather than assigning them one-by-one to your items. Refer to Importing Item Pictures (Pro) (page 125) for more information. Pictures can also be associated with item styles. Refer to Adding Pictures to Item Styles (page 221) for more information.

To add a picture by browsing to the file:

1. Display the Item Info tab on the item record.
2. In the Item Pictures section, select 
3. In the Open file window, browse to the picture file and double-click it.
4. Edit the Picture Name field as needed.
5. Repeat the above steps for the alternate picture if you have an additional picture you wish to associate with this item.
   The SWAP button switches pictures between the default and alternate positions.
6. Save the item record.

To add a picture by drag-and-drop:

Drag-and-drop requires use of a mouse or touchscreen and that you have both the file location and the Item Pictures section on the Item Info tab visible on your screen.

1. Click the picture file with your left mouse button and hold down the button.
2. Drag your mouse pointer to a picture slot on the item record and release the mouse button.
3. Edit the picture name field as needed and save the item record.

You can also drag-and-drop to replace the default picture in the Inventory Picture Album (described below).

(Pro Multi-Store) Only Headquarters can add, edit or delete item pictures. Headquarters can send the pictures to remote stores. Refer to Sending Item Pictures (page 572) for more information.
Viewing Item Pictures

A thumbnail view of the default picture can be displayed in many areas of Point of Sale. This helps your employees verify an item’s identity. In most areas, you can open the full-size picture from the thumbnail.

In Item Records, Lists, and Reports

You can view a thumbnail image of an item’s pictures in the item record, or in the Item Information panel of the item list; viewable when you select COLLAPSE. Selecting the thumbnail will open a full-sized item picture in a new window.

Your item list can be modified to include a column which indicates whether a picture is assigned to an item. Item reports can also be modified to show whether an item has a picture assigned, and to display the picture name.

You can export your pictures for other uses. Refer to Exporting Item Pictures (Pro) (page 129) for more information.

On Documents

When you add an item to a document, the thumbnail image is displayed for that item. This feature is enabled by default once you have set your preferences to use item pictures. Selecting the thumbnail will open a full-sized item picture in a new window.

You can turn this feature on or off for each document type from the View menu by selecting CUSTOMIZE ➤ SHOW ITEM PICTURE.

In the Picture Album

The Inventory Picture Album is accessible from the I Want To menu in your item list, and displays your default item pictures. The picture album provides an alternate method for viewing and working with your item list; most actions available in the item list are also available from the Picture Album and double-clicking a picture will open the item record for viewing or editing.

The picture album can be sorted or filtered in the same manner as other lists. Refer to Using Filters in Lists and Reports (page 106) for more information.
Using Service and Non-Inventory Items

Both service and non-inventory items are used to charge for non-merchandise services, labor, and miscellaneous fees and charges. The on-hand quantity of both item types is always zero (0).

Having two non-merchandise item types allows you to categorize and report the various uses to different accounts in your financial software. For example, maybe you want to send repair work to one QuickBooks financial software account, and time-of-sale charges, such as tailoring, gift-wrapping, and delivery to a different account. You can define item accounts for each item type or for individual items. Refer to Assigning Item Accounts for Financial Exchange (page 169) for more information.

Some retailers choose to use non-inventory items for incidental merchandise for which they do not wish to track on-hand quantities.

**Example:** You keep a basket of mixed low-cost trinkets near your register. You can see by sight when to reorder and their impact on financials is incidental. You define a single non-inventory item to sell any of the included items, which vary depending on vendor over-runs, closeouts, etc.

To create a service or non-inventory item, simply select the appropriate item type when adding the item in inventory. The items can then be listed on purchase orders, receipts and customer orders (Pro) as needed, and broken out in sales reports.

---

**Tip: Using Service Items to Charge for Services by the Hour**

You can use a service or non-inventory item to charge for services by the hour (or half-hour, quarter-hour, etc.). Define the item, selecting either SERVICE or NON-INVENTORY as the item type. The price for the item should be the price to be charged per unit of time (hour, half-hour, quarter-hour, etc.). When the item is listed on a receipt or customer order, enter the units of time to be charged in the quantity field. For example, if you are charging by the hour, enter 1.5 as the **Qty** to charge for an hour and a half.

If you are not required to charge taxes for labor or service-type charges, you can assign a non-taxable tax code to the item.
Using Special Order Items (Pro)

Special order items are used to order, receive, and sell custom or one-time items that you do not currently carry in inventory, and maybe never will. Later, if you decide to continue carrying the new item in inventory, you can convert it to a regular inventory item.

(Pro Multi-Store) The special order item provides a means for a remote store to create a customer order for a new item and generate a purchase order for it. The special order item is sent to Headquarters with the first transactional document listing it. Headquarters can review the item and change the special order item type in inventory to a regular inventory item, if needed. Refer to Handling Special Order Items (page 549) for more information on multi-store operations.

Creating Special Order Item

Special order items can only be created when coming to inventory from a customer order, receipt, purchase order or voucher.

To define a new special order item:

1. Select NEW SPECIAL ORDER ITEM from the I Want To menu.
2. A new item form is opened, with SPECIAL ORDER pre-selected as the item type.
3. Use normal new item procedures to enter item information. Certain item fields/features are not available for special order items, such as reorder point, the ability to define multiple vendors, creating assemblies or groups, and printing tags.
4. When done, choose SAVE & SELECT to record the item in inventory and list it on the document.
5. Complete and update/save the document.

Special Order Item Numbers

Special order items do not have an item number assigned to them when created. This field will be blank. Later, if the item is converted to a regular inventory item, an item number is assigned.
To convert a special order item to an inventory item:

1. Highlight the item in your item list and select EDIT. Hint: Filter the list by Item Type, and enter Special Order as the filter criteria to locate the item.
2. Change the Item Type to INVENTORY.
3. Make any other edits necessary, such as the Reorder Point, which was previously disabled.
4. Select SAVE.

Working with Existing Items

Locating an Item

Items can be located in your item list by filtering, searching, sorting, or scrolling in the list. Each of these procedures is summarized below.

Refer to Chapter 7 Lists, Forms and Filters (page 99) for detailed explanations of these procedures.

To filter your item list:

Filtering gathers and displays only the records matching specified criteria. By filtering, you can display items of a particular type, from a specific vendor or department, within a specified price or cost range, or for any other item values you have defined. You can create your own filters and save them, making them available from the filter list on the item window.

1. Display your item list, and then select one of the following from the drop-down filter list at the top of the window:
   - The **ALL ITEMS** filter (this is the default when you enter your item list).
   - A previously defined and saved custom filter (your custom name).
   - **CREATE FILTER** to filter your list by new criteria and optionally save the filter for future use.
   - **MANAGE FILTERS** to edit, rename, delete, or rearrange the order of your previously saved filters.
2. If creating a new filter, review and/or enter criteria values in any of the available fields and then select **APPLY** (or **SAVE** first if you want to memorize the new filter).
Your list is filtered by your selected criteria. All normal item procedures are available while in a filtered view. When done, select **ALL ITEMS** from the filter list to return to the default list. Exiting and returning to the item list also resets the filter to **ALL ITEMS**.

**To find an item by sorting and/or scrolling:**

1. Select the column by which you want to sort the list by clicking or touching the header of the column.
   
   To sort by multiple columns, select **SORT LIST ➤ SORT ON MULTIPLE COLUMNS** from the View menu. Enter up to three sort fields and select **APPLY**.

2. Immediately begin typing the first few characters of the column value you wish to locate. The characters you type are not displayed, but the closest matching record to what you typed is highlighted.

   **Or**

   Use the vertical scroll bar to scroll through the list. The visual scrolling indicator displays your progress as you move through the list. Release the mouse button when the value you are looking for is displayed.

**To search for an item:**

1. Select **FIND** (<F3>) from the window toolbar in your item list.

2. Enter the keyword or keywords by which you want to search and select **FIND** (<ENTER>) to begin the search.

   All matching items are displayed in the Find Item window, from which you can select the correct item, search again with new keywords, or choose to add a new item.

   Select **ADVANCED FIND OPTIONS** to narrow your search criteria by specifying a specific search field, multi-word search rules, and other options.

---

**Editing an Item**

**To edit an item:**

1. Highlight an item in your item list and select **EDIT** from the window toolbar.

2. Navigate through the fields, making necessary edits.

3. Select **SAVE**.

   If you want to edit several items at once, it may be easier to do so in list edit mode. List edit mode allows you to make edits directly in the item list. Your edits are saved as you move from row to row. To turn list edit mode on, select **TURN LIST EDIT ON** from the Edit menu (or click the small down-arrow next to the Edit icon). When done,
Working with Existing Items

select **TURN LIST EDIT OFF** in the same manner. Leaving the item list also turns off list edit mode.

---

**Editing Item Quantity or Cost**

Use care when editing the on-hand quantity or average unit cost of an item. These values are important for tracking your inventory value and generally you should let Point of Sale documents update these values. If you do manually edit them, Point of Sale creates adjustment memos and sends them to QuickBooks financial software to update your inventory value. Refer to *Tracking Quantities and Costs* (page 138) for more information.

---

**Deleting an Item**

This process should be carried out with caution so as not to accidentally delete items with an on-hand quantity or those that are listed on open order documents.

(Pro) Items that are part of an assembly or group item, or that are assigned to a discount price in Price Manager, cannot be deleted unless they are first removed from these.

**To delete an item or items:**

1. Select the item you wish to delete from the item list. You can select multiple items by holding down the `<CTRL>` key while selecting the items. See *Selecting multiple records* (page 102) for more information on using the multi-select feature.

2. Select **DELETE** from the I Want To menu.

   A confirmation window shows the status of the item(s) you are deleting. Warnings are shown if the item has an on-hand quantity or is listed on an active order document.

3. Select **DELETE**.

   If you delete an item with an on-hand quantity, Point of Sale creates a quantity adjustment memo to send to QuickBooks financial software. In the memo **Reason** field, enter your name and a reason for the deletion.

   Refer to *Adjustment Memo Overview* (page 243) for more information about adjustment memos.

---

**Deleted Items Added Back to Inventory**

If you delete an item, but then create or reverse a transactional document that lists that item, the item will be added back to inventory by Point of Sale. This ensures that the document will post correctly and that your inventory reflects any change effected by the document.
Merging Item Records

You may sometimes discover that an item has been entered into your inventory more than once. The Merge Items feature allows you to correct this error by combining these multiple entries into a single item record. You choose which item record to keep, and which to discard.

When the items are combined, the quantities are added together; however, all other values, such as cost and price, are retained from the item you elected to keep. If the item you are discarding appears on any of your history documents, such as sales receipts, it is replaced on these documents with the item you have selected to keep.

Other important considerations when merging items:

- The items to be merged must be of the same type. For example, you cannot merge an inventory item with a service item.
- Only two items may be merged at once.
- The merged items will not be synchronized with your QuickBooks financial software inventory or history, nor will costs be recalculated for items already sold. However, if merging has changed the valuation of your inventory, such as when there is a difference in average cost of the merged items, this will be updated in your financial software by cost adjustment memos.
- If you print price tags and there was a price difference between the merged items, review and print new price tags if necessary.
- (Pro) If you are discarding an item that is part of a group or assembly item, it will be replaced in the group or assembly with the item you are keeping. If you are merging two assembly or group items, they must include identical component items.
- (Pro Multi-Store) Merging items can only be done at Headquarters. Inventory will be updated at the remote stores during the next Store Exchange, however item history at your remote stores is not updated to reflect the merged items. Refer to Duplicate Item Reminders (page 550) for more information.

To merge duplicate items:

1. From the item list, select the two items you wish to merge.
   Select the first item and then hold down your \(<\text{CTRL}\>\) key and select the second item.
   (Pro Multi-Store) You can also initiate an item merge from the Duplicate Items reminders screen.
2. Select MERGE INVENTORY ITEMS from the I Want To menu.
Working with Existing Items

The Merge Items window is opened with the two items entered:

3. Ensure that the items displayed in the Merge Items window are the correct items.
   - Make sure the item you want to keep is listed in the Keep This Item column on the left and the item to be discarded is on the right. If necessary, select SWAP between the columns to reverse the item positions.
   - You can use the drop-down item list to select other items if one or both of the displayed items is wrong.

4. Select MERGE ITEMS.
   A confirmation dialog is displayed, showing the various documents and records that will be affected by the merge.

5. Select MERGE ITEMS to complete the task.
Chapter 12  Item Quantities, Cost and Price(s)

Tracking Item Quantities .......................................................... 182
Using Decimal Quantities ......................................................... 182
Using Item Reorder Points ....................................................... 182
Viewing Quantities on Order and Creating Documents ............... 183
Unit of Measure ........................................................................ 184
Multiple Units of Measure (Case-to-Unit) (Pro) .......................... 185
  Definitions ........................................................................... 186
  Setting Up Multiple Units of Measure for an Item ................. 186
  When ordering, receiving, or selling the item ..................... 187
Available Quantities (Pro) ........................................................ 188
Handling Item Cost and Price ..................................................... 189
  Average Unit Cost and Order Cost ....................................... 189
Setting and Updating Item Prices .............................................. 191
  Regular Price ...................................................................... 191
  About Margins and Markups .............................................. 191
  Updating an Item’s Price When Costs Change .................... 193
Using Price Levels .................................................................... 193
Price Manager .......................................................................... 196
  Overview ............................................................................ 196
Creating and Applying Price Changes ....................................... 198
  What’s Important about Price Changes? ............................ 198
  Price Change Fields .......................................................... 199
  Editing a Pending Price Change ....................................... 201
  Copying Prices to Another Price Level ............................... 203
  Rounding Calculated Prices ............................................. 204
  Restoring Your Old Prices .................................................. 204
Using Discount Pricing (Pro) .................................................... 205
  Discount Pricing Fields ...................................................... 206
  Setting Up a Discount ....................................................... 207
  Applying Discounts to Sales .............................................. 209
Tracking Item Quantities

Point of Sale tracks on-hand quantities and (for Pro users) available quantities as you make transactional documents to receive, sell or transfer items. While the actual procedures for creating documents is covered in other chapters of this Guide, Point of Sale offers several inventory features that help track item quantities and remind you when items need reordering.

These features include:

- Tracking items by decimal quantities
- Item reorder points and inventory reminders
- Viewing item quantities already on order
- Ability to initiate item purchases and other transactions from inventory
- Item History window to view a running history of item quantity changes
- (Pro) Viewing available quantity to differentiate between quantity that is on hand and quantities that are actually available for sale (adjusted for items already committed on to customer orders)

Using Decimal Quantities

Sometimes it is beneficial to track items in decimal quantities. For example, you might sell an item by the yard (e.g. fabric) or by weight (e.g. bulk candy). Point of Sale allows you to order, inventory, and sell these items in decimal units.

For example, if you order and price fabric by the yard you can easily sell 1/4 yard or 1-1/2 yards by entering .25 or 1.5 in the Qty field on receipts. When a decimal quantity is entered in inventory (or on a document) trailing zeroes are not displayed.

Quantity decimals can also be used in conjunction with a service item to charge an hourly fee for labor. In inventory, define a service item called Labor, assigning your hourly rate as the price. On a sale, you can now list the service item Labor and charge for partial hours by entering a decimal quantity in the Qty field.

Using Item Reorder Points

You can define a reorder quantity (Reorder Point field) for each inventory item, allowing you to easily see which items have fallen to or below their specified reorder quantity on the Reorder Reminders window. Point of Sale takes into consideration any quantities already on order before adding an item to the reorder reminders list.
Access the reorder reminders list by selecting the REMINDERS from the Inventory menu.

Reviewing the reorder reminders list can assist in the task of making replenishment purchase orders. The reorder items can also be viewed by running a Reorder Point report under the Items report type in the Report Center. Refer to Chapter 26 Reports and Sales Charts (page 459) for more information about running reports.

(Pro) For assembly items, a reorder point indicates that quantity at which you want to build more of the assembly item. Similar to a Reorder Point report, a Build Point report lists the assembly items that have fallen below the specified level.

(Pro Multi-Store) Reorder points are based on quantities for the company as a whole, not on individual store quantities.

**Flagging an Item as Un-orderable**

When an item is marked as unorderable (the UNORDERABLE checkbox selected on the item record), its reorder point is ignored and you are warned if you list the item on a purchase order. This field is helpful in temporarily suspending purchasing of seasonal items or for flagging an item that has been discontinued by you or a vendor. Items marked as unorderable can still be received and sold.

**Reminders Based on Available Quantity (Pro)**

You can specify in company preferences whether to use on-hand quantities or available quantities when calculating reorder reminders. Available quantities take into consideration item quantities that may already be committed for customer orders.

See Available Quantities (Pro) (page 188) for more information about using the available quantity field.

**Viewing Quantities on Order and Creating Documents**

You can view the quantity of an item on order (listed on open purchase orders) as you work in inventory and initiate additional orders without leaving inventory.

(Pro) You can also view a list of the open purchase orders for an item from the item record.
To view on-order quantities or initiate an order:

1. Display your item list and locate the item(s).

The quantity on order is displayed in the On Order column. You may have to scroll left/right or add this column to your list. Refer to Customizing Columns in Lists (page 586) for more information about customizing list columns.

2. To order an item, locate and select it in your item list, then right-click in the item row and select ORDER THIS ITEM from the pop-up menu.

A purchase order is opened with the item already listed. Adjust the order quantity and cost for this item, add other items if necessary, and save.

You can also initiate selling, receiving, and transferring (Pro Multi-Store), of items from this menu.

To view an item’s open purchase order list (Pro):

1. Display the item form.

2. Select AVAILABLE from the Quantities area of the item form.

The Available Quantities window is displayed showing the available, on-order and pending quantities for the item. See Available Quantities (Pro) (page 188) for a sample image of this window.

3. Select MAKE PURCHASE ORDER to add this item to a new purchase order.

(Pro Multi-Store) This dialog also contains a list of the on-hand quantities at each store and allows you to initiate a transfer of an item to another store.

**Unit of Measure**

Unit of Measure allows you to define and manage the units of measurement or quantity by which your items are purchased and sold, such as each, inch, yard, gallon, case, gross, etc.

You can add, delete or rearrange the order units of measure from PREFERENCES ➤ COMPANY ➤ INVENTORY ➤ UNIT OF MEASURE. Once defined here, you can specify a unit
Tracking Item Quantities

for individual items in inventory as well as using this field to filter lists or reports. You can also specify the default unit to be assigned to new items.

**Multiple Units of Measure (Case-to-Unit) (Pro)**

Some merchandise may be purchased in one size and sold in another, or sold in several sizes. For example, you may buy soda by the case, but sell the soda in single cans, six-packs, and 12-packs. Point of Sale allows you to define multiple units of measure for an item, specify default order-by and sell-by units, and assign separate UPCs and prices to each. This feature must be turned on in company preferences.

**To turn on the multiple units of measure feature:**

1. From the Edit menu, select **PREFERENCES ➤ COMPANY**.
2. Select **INVENTORY ➤ UNIT OF MEASURE** from the preferences list on the left.
3. Use the **ADD** button to enter the various units you wish to use, such as *single*, 6-pack, 12-pack and case.

4. Use the checkboxes to turn on the multiple unit of measure feature and to specify how you would like to print and display multiple units of measure fields in Point of Sale.
5. Select **SAVE**.
Chapter 12: Item Quantities, Cost and Price(s)

Definitions

**Base Unit:** The smallest unit you stock or sell for a given item. In our soda example, this would be the single can. Each of your other units of measure is specified in terms of the number of base units it includes. Point of Sale reports also reflect the base unit.

**Default Sell-By Unit:** The unit you most often sell by; suggested on sales receipts but can be changed. Price tags print the price for this unit.

**Default Order-By Unit:** The unit you most often purchase the item by; suggested on purchase orders but can be changed.

Point of Sale handles the calculations between the various units once you have set them up. Shown below is an example item record, showing multiple unit of measure information. Note that the normal cost, price and on-hand quantity fields all reflect your base unit of the item, while this information for other units is added in the Units of Measure section added to the form.

### Setting Up Multiple Units of Measure for an Item

1. On the Item Info tab of the item record, enter information for your base unit of measure in the fields indicated.

2. In the Units of Measure section, select your base unit from the drop-down list and then for each other unit, enter a) the number of base units included, and b) the regular price when selling each unit.
3. Select the **MANAGE UNITS OF MEASURE** button.

![Manage Units of Measure](image)

4. Specify your default order-by and sell-by units at the top of the window. Use the help link to learn more about these choices.
   If prompted, enter cost information for your default order-by unit.

5. Enter a UPC, alternate lookup and/or edit pricing information as needed for each unit of measure. Separate prices at each of your price levels can be entered for each unit by selecting the **PRICING** button for each.
   Notice that if a base unit quantity has been entered, Point of Sale calculates and displays the equivalent on-hand quantities for each of your units.

6. When done, select **CLOSE** and save the item record.

---

Changing the Base Unit

If you change the base unit at some later point, be sure to change any other applicable fields. For example, if you no longer sell single cans of soda you could change the base unit to a 6-pack. Making this change does not automatically update all the unit of measure fields. Review and update your other units, quantities, prices, and so forth, as needed.

---

**When ordering, receiving, or selling the item**

When you add the item to a document, the default order-by unit (purchase order or receiving voucher) or sell-by unit (sales receipt or customer order) is suggested, along
with its assigned cost or price, unless one of the conditions listed below apply. Shown
is a sales receipt, with our default sell-by unit of a 6-pack listed.

To use a different unit for the current document, select one of your other units from
the drop-down list in the **Unit of Measure** field. The cost or price will be
automatically updated to reflect the new unit. Customize the columns in the list if
necessary to display this field.

![Image of sales receipt with unit of measure]

**When listing items with multiple units of measure on a document the following apply:**

- If a unique UPC or alternate lookup is defined for each unit and you scan a
  bar code or manually enter the unique value, the corresponding unit is listed
  with its associated price or cost.

- The available and on-hand quantities shown on a sales receipt are in the unit
  of measure being sold. This may result in fractional quantities when the unit
  being sold is not the base unit. For example, if an item has case and bottle
  units defined, with bottle being the base unit and 12 bottles in a case, then
  with 15 bottles on-hand, listing a case on a receipt will show an on-hand
  quantity of 1.25 cases.

**Available Quantities (Pro)**

Point of Sale keeps track of your available quantity as well as your on-hand quantity.
Available quantity is equal to the on-hand quantity less quantities already committed
to customer orders.

By default, your reorder reminders are based on available quantities. If you prefer,
you can elect to have reorder reminders based on the on-hand quantity. **Refer to
Using Item Reorder Points (page 182) for more information.**

The available quantity is displayed on the item form as shown below, and you can add
the **Available Quantity** column to your item list, to the item lists on transactional
documents, and to item reports.

![Image of available quantities form]
You can view specific details by selecting AVAILABLE on the item record. The Available Quantities window shows you quantity detail for the item as well as a listing of the open orders. Double-click a document to view it. Note that in this example, we have only one on hand, but have ten on open customer orders. We also have six currently on order from our vendor.

<table>
<thead>
<tr>
<th>Quantities for this Item</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity On Hand</td>
<td>1</td>
</tr>
<tr>
<td>Quantity on Customer Orders</td>
<td>10</td>
</tr>
<tr>
<td>Quantity On Order</td>
<td>6</td>
</tr>
<tr>
<td>Quantity Pending</td>
<td>0</td>
</tr>
</tbody>
</table>

**Available Quantities**

**Quantity Available**
-9

**Pending Quantities**

Items on customer orders with a status of “pending” are not considered committed and do not affect the available quantity. The total of the items on these documents is displayed in the “pending” field. Refer to Tracking Orders by Status (page 430) for more information.

**Handling Item Cost and Price**

**Average Unit Cost and Order Cost**

Two cost fields are maintained in inventory for each item. The **Average Unit Cost** field displays the averaged cost of the on-hand quantity of the item. The **Order Cost** field displays the current cost of the item from your vendor, and is suggested when you make a new purchase order or receiving voucher. Both fields are updated when a receiving voucher with a new cost is made.

Over time, it is normal for the order cost to be a higher value than the average unit cost, as at any point in time you may have some on-hand units that were received at a lower cost than the current order cost.
You can view these fields in the item list or form. If you are using multiple vendors for an item, the **Order Cost** for your alternate vendors can be entered or viewed on the Additional Info tab of the item form.

### Entering and Editing Cost Values

We recommend that you manually enter a value in the **Average Unit Cost** field only when adding already in-stock items to inventory during program startup. If a new item is going to be ordered on a purchase order and received on a voucher, leave the average unit cost at zero (0) and allow the receiving voucher to populate this field.

If you manually edit the average cost, Point of Sale creates an adjustment memo and sends it to your QuickBooks financial software.

You can enter or edit the **Order Cost** of an item at any time, but typically you enter new order costs on a purchase order. The new order cost is then carried to a receiving voucher that references the PO. When the voucher is saved, the **Order Cost** field in inventory is updated.

### How Point of Sale Calculates Average Unit Cost

An item's unit cost is always averaged when a receiving voucher is made at a cost different than what is currently recorded in inventory. The program proportionally averages the old cost and the new cost based on existing and received quantities to arrive at the new average unit cost.

For example, if you have five units of an item on hand with an average cost of $10 and a voucher is made to receive ten new units into inventory costing $12 each, the new averaged inventory cost is calculated as follows:

\[
\frac{(\text{On-Hand Quantity} \times \text{Current Cost}) + (\text{Received Quantity} \times \text{Purchase Cost})}{(\text{On-Hand Quantity} + \text{Received Quantity})}
\]

Or, in our example:

\[
\frac{(5 \times 10) + (10 \times 12)}{5 + 10} = \frac{170}{15} = 11.33
\]

**QuickBooks Financial Software Users**: During the next Financial Exchange, the receiving voucher updates the QuickBooks financial software inventory value for the received items at the purchase cost. The averaging of costs in Point of Sale's inventory has no additional net effect on inventory value.
Setting and Updating Item Prices

Point of Sale allows you to set a regular price and, optionally, up to four additional price levels for each item in inventory.

Regular Price

Your regular price is the price you typically charge when selling an item. You can manually define your regular price or you can let Point of Sale calculate it for you as you add new items to inventory.

To manually define your own regular price:

- Don’t enter a margin/markup on your department records
- When adding or editing an item, enter a price in the **Regular Price** field
- Point of Sale will calculate and display the margin and markup on the item record for your information
- If you edit the margin or markup on the item record, Point of Sale recalculates the regular sale price

To have Point of Sale calculate new item prices, do the following:

Point of Sale can automatically calculate your regular price as you add or receive new items into inventory. Note this auto-calculation of price only occurs if you leave the Regular Price field at zero (0) when you add the new item and it does not apply to existing or reorder items.

- Specify a default margin or markup percentage for each of your departments; when you add a new item the department margin/markup is automatically assigned to the item
- Do not make an entry in the **Regular Price** field when adding new items to inventory
- When the cost is added to an item record, either by you or via a receiving voucher the first time the item is received, Point of Sale calculates the regular price by applying the specified margin/markup to the item cost

About Margins and Markups

Margin and markup are two ways to express the profit level you want to achieve on item sales. You can enter either value on your department records or for individual items in inventory, and Point of Sale will calculate and display the other.
**Margin.** Margin expresses the relationship between what you paid for an item (cost) and its selling price. It is expressed as margin percentage (Margin % field). Mathematically, margin is expressed like this:

\[
\text{Margin }\% = \frac{(\text{Price} - \text{Cost})}{\text{Price}} \times 100
\]

**Markup.** Markup (Markup % field) is an alternative way for you to enter your profit level, as a straight percentage markup over the cost. Mathematically, markup is expressed like this:

\[
\text{Markup} = \frac{(\text{Price} - \text{Cost})}{\text{Cost}}
\]

The pricing formula Point of Sale uses to calculate your regular price uses the margin and looks like this:

\[
\text{Regular Price} = \frac{\text{Cost} \times 100}{100 - \text{Margin }\%}
\]

**Example:** With an item cost of $12.50 and a margin of 50 % (markup = 100 %), your regular price would be calculated as follows:

\[
\frac{(12.50 \times 100)}{100-50} = \frac{1250}{50} = 25.00
\]

---

**Markup May be Recalculated**

You can enter either a Markup % or a Margin % to specify your desired profit margin. However, Point of Sale only calculates prices from the margin, which must be a whole number (no decimals). If you enter a markup, Point of Sale will calculate and round the margin to the nearest whole number. Using this figure, Point of Sale then recalculates your markup and displays the result in the Markup % field. This figure may differ slightly from what you entered originally.

You can manually change an individual item’s margin/markup, regular price, or average unit cost. An edit to any of the fields always causes a compensatory change to one or more of the other values:

- Edit your margin or markup; your regular price is recalculated
- Edit your regular price; your margin and markup are recalculated
- Edit the average unit cost, and:
  - If the regular price was previously zero, it is calculated from the margin and new cost
  - If the regular price was previously non-zero, the margin and markup are recalculated and the price is left unchanged
Updating an Item’s Price When Costs Change

Your regular price is not automatically updated when you reorder the item at a new cost. When an item’s average unit cost has changed due to a cost increase from your vendor, Point of Sale alerts you and provides you the opportunity to change the price right from the receiving voucher.

One good way to determine if a price change is needed is to decide on a lowest acceptable profit margin. As costs increase on a reorder item, the margin on the item record is recalculated to show you the new profit level based on the new average unit cost. If your cost has changed enough to cause the margin to fall below your acceptable lower limit, it is time to adjust your price.

A quick way to update your price to reflect the new cost is to edit the margin or markup back to the profit level you wish to maintain. Point of Sale applies the margin/markup to the current average unit cost to calculate a new regular price.

If you want to change the prices for a large number of items at one, consider using Price Manager to do so. Refer to Price Manager (page 196) for more information.

(Pro) Price Change Reminders: Whenever you change an item’s price, Point of Sale adds the item to the New Price Reminders list. This can alert you that new price tags might be needed.

(Pro Multi-Store) Only Headquarters can change item prices. If remote stores tag merchandise or display price shelf stickers, they can view price changes on the inventory Reminders screen. This alerts them so that tags and shelf stickers can be updated accordingly. Refer to Using Inventory Reminders (page 142) for more information.

Using Price Levels

The use of price levels is optional. Price levels allow you to offer different prices for different purposes or to different groups of customers.

Price levels are often used to:

- Offer reduced prices to employees, family members, and VIP customers
- To offer a wholesale price
- For special sales, e.g., “10% Off Sale”
- To offer special prices for online shoppers

Point of Sale can maintain up to four price levels in addition to your regular price for each item in inventory (i.e., five separate prices). Each price level is a markdown price from your Regular Price.

A typical price level setup is shown on the next page.
The price at each level is recalculated anytime your regular price is changed, either manually or when Point of Sale applies its pricing formula. On the other hand, editing the price or markdown percentage of any of your price levels has no affect on any other price.

**Exception: Changing Regular Price in Price Manager Doesn’t Update Price Levels**

If you use Price Manager to make changes in your regular price, the prices at each price level are not automatically updated. Refer to Price Manager (page 196) for more information.

To automatically use a price level for sales to a customer, associate the price level with the customer on his customer record. Refer to Using Customer Discounts and Price Levels (page 311) for more information.

**To define price levels:**

1. Close all open windows.
2. From the Edit menu, select **PREFERENCES ➤ COMPANY**.
3. Select **PRICING** from the preference list on the left.
4. Enter a name for each price level you wish to use.
5. Enter a markdown percentage for each price level.
6. Select a default price to be used for sales from the **DEFAULT PRICE** drop-down list.
   
   ![Default Price Table](image)

   You can specify your regular price or one of your markdown price levels. The default price selected will be suggested for all sales. However, you can change the price on individual sales receipts, as needed.
7. Select **SAVE**.

**Price Change Reminders Cleared if Default Price Changed (Pro)**

Price Change Reminders display the old and new prices for whatever price you have selected as your default price. If you change your default price, the Price Change Reminders list is cleared since it reflects old and new prices at your previous default prices.

It is recommended that you print the list for reference before making changes. Refer to Using Inventory Reminders (page 142) for more information about Price Change Reminders.
Handling Item Cost and Price

Editing Price Levels from an Item Record

You can also define or edit your price level names and markdown percentages while working with an item in inventory. Display the Pricing window from an item record and select **EDIT PRICE LEVELS**.

It is important to note that changes made here are the same as if you are making them in company preferences. Your changes affect your default price levels on all items; not just the item you are currently viewing.

**Tips for using price levels:**

- Any action that changes your regular price will also cause the prices at each markdown price level to be recalculated, including:
  - Manually editing the regular price or editing the margin/markup (which causes a change in the regular price)
  - Point of Sale’s pricing formula, when it is applied to new items
- The default price level markdowns specified in company preferences are suggested for all new items. Editing the markdown percentage or price at a specific price level for an individual item will not affect default markdowns.
- Your default price is applied to all sales, unless you change it on an individual receipt or if the customer has a different price level assigned on his record.
- The price used on a sale is called the “active” price, and any additional item discounts given at time of sale are applied against the active price.

Refer to **Changing the Receipt Price Level (page 359)** for more information about applying price levels and discounts on sales.

(Pro Multi-Store) Remote stores cannot define price levels but they can set the default price to use for sales at their store.
Price Manager

Overview

Retailers often need to adjust merchandise prices for sales events to encourage sales of slow-moving merchandise or to reflect changing costs. Using Price Manager, you can conveniently change prices or implement discount pricing (Pro) for selected items and have Price Manager calculate those changes for you in a variety of ways.

Price Manager is particularly useful for changing the prices of many items at once. There are two components to Price Manager:

**Change Item Prices:** This is used to mark up or mark down the prices of selected items. The wizard will walk you through defining how the new prices will be calculated from current cost or price using a variety of formula options and optionally rounding the new prices.

Price changes can be saved in-progress or immediately applied to inventory. If saved, you can return to it later, edit if necessary, and then apply to inventory when you are ready.

Each price change, which can include any number of items, is stored in your Change Item Price list. Price changes can be restored (revert to prior prices) and copied to quickly start a new, similar price change. You can also print markdown tags with both the old and new prices.

**Discount Pricing (Pro):** This is used to define and apply price discounts, based on any of three discount models:

- Get Y % off
- Buy X quantity for SY price
- Buy X quantity and get Y % off

Discounts can be made active/inactive at any time, be scheduled to automatically start and stop by day and/or time, and be selectively applied to items. Each discount you set up is maintained as a record in your Discount Pricing list. These records can be reviewed, edited, printed, or copied. You can also print discount price tags for your items to demonstrate potential savings to your customers, such as “Regular price: $15.00, Buy 3 and Get 15% Off.”
Price Manager

While the features and use of the two Price Manager components are different, some things will hold true for both components:

- You always have an opportunity to review price changes or discounts before applying them to inventory.
- If requiring users to log in, you can control access to Price Manager using security right assignments.
- (Pro Multi-Store) Price changes or discounts can be created or edited only at Headquarters; with the resulting changes sent to remote stores. Remotes can view the price changes and discounts and use them to print tags.

To access Price Manager

1. From the Inventory menu, select **PRICE MANAGER**.

Or

Select **PRICE MANAGER** from the Navigator.

Shown is the Pro-level Price Manager window with both components.
Creating and Applying Price Changes

Price Manager is a powerful, flexible price utility that allows you to calculate price changes based on the current cost or price at any of your price levels and then apply the new prices to the same, or any other, price level.

Point of Sale calculates new prices based on formula criteria you specify and then applies the changes to the items you have selected.

After calculating price changes, you must apply the price change to Point of Sale inventory to make the price changes effective.

Changing Regular Price in Price Manager Doesn't Change Other Price Levels

When you make price changes to your regular price directly in inventory, the prices at your price levels are automatically recalculated to maintain your specified markdown percentages. This is not true when making price changes in Price Manager. Price changes in Price Manager affect only the price level you specify when you apply the new prices to your inventory.

What's Important about Price Changes?

- A “price change” refers to one Price Change operation. It can include any number of your items. Each price change is stored as a single record in your Change Item Prices list.
- Changing item prices at one price level has no effect on the prices at your other price levels.
- You can calculate new prices from one price level but then apply them to a different price level if desired. This feature allows you to quickly calculate prices for one level relative to another.
- You always have an opportunity to review price changes before applying them to inventory.
- A price change can be temporarily saved without the new prices being applied to inventory. This allows you to prepare a price change ahead of time and then apply it when ready.
- You can calculate item prices in different ways for different groups of items in a single price change. For example, you could reduce all items in your shoe department by 10%, in your clothing departments by 20%, and in your Accessories department by 30% and apply all to inventory at one time.
- (Pro) If you use multiple units of measure for an item, the Unit of Measure field is added to the Price Manager item list. This field reflects your default sell-by unit of measure, and price changes apply to this unit only. If no default sell-by unit is defined, the base unit of measure is displayed and affected.
Price Change Fields

This table lists the name and usage of the price change fields. Reference to these fields is made in the procedures that follow. Fields that have an obvious purpose or item fields whose purpose is explained in Item Information Fields (page 647) have been omitted from this table.

If one of the fields below is not visible in the list, you can customize your list columns to include it. Refer to Customizing Columns in Lists (page 586) for more information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Prices</td>
<td></td>
</tr>
<tr>
<td>Current Price</td>
<td>Current Price \ is the price from inventory for the price level you have selected to change. After applying the price change to inventory, this becomes the Old Price.</td>
</tr>
<tr>
<td>Old Price</td>
<td>New Price \ is the price that has been calculated by Price Manager and will be applied to inventory. You can also manually enter new prices in this field.</td>
</tr>
<tr>
<td>New Price</td>
<td></td>
</tr>
<tr>
<td>[% Price Change]</td>
<td>The difference between the Current/Old Price and the New Price, expressed as a percentage.</td>
</tr>
<tr>
<td>New Profit</td>
<td>The profit amount in dollars after the price change is applied.</td>
</tr>
<tr>
<td>New Margin %</td>
<td>The new profit expressed as a percentage after the price change is applied.</td>
</tr>
</tbody>
</table>

To create a price change:

1. From the Price Manager, select **MAKE PRICE CHANGES**.
2. Select the price level to which you would like the changes to apply.
3. Enter a name for this price change and, optionally, any applicable notes.
4. Choose how you want to select items for the price change:
   - **By Vendor**: To select all items supplied by one or more vendors. You’ll select the specific vendors in a subsequent window.
   - **By Department**: To select all items in one or more departments. You’ll select the specific departments in a subsequent window.
   - **By Item Name**: To select all items with a particular item name or names. You’ll select the specific item names in a subsequent window.
   - **All Items**: To select all the items in your inventory.
   - **By Filtering Items**: To select a group of items by filtering your item list (create a new filter or use a previously saved filter).
5. Follow the steps in the wizard to build a price change formula. See the example on the facing page.
Chapter 12: Item Quantities, Cost and Price(s)

- Note: The second step on this screen asks for the price level you wish to calculate the new prices from. Your choice here can be the same price level you chose earlier to which the changes will be applied or it can be any of your other price levels.
- If you want to round your new prices, select the **SHOW ME ROUNING OPTIONS...** checkbox at the bottom of the page.

6. Select **NEXT** to continue.
   - If rounding, choose an option in the window displayed and select **NEXT**. Refer to **Rounding Calculated Prices (page 204)** for more information.

7. Select **FINISH** to view the calculations.
   The calculated prices are displayed in the **New Price** column.

New Price Change

Select an option below to begin building a pricing formula

1. Calculate new item prices from:

   - Price

2. Select a price level to calculate prices from:

   - Regular Price

3. Calculate the new price by:

   - Subtracting

4. Subtract from current price by:

   - A percentage

5. Percentage to subtract:

   - 15

Example:

Subtract 20% from price level "Regular Sales Price"

- **Show me Price Rounding options before calculating new prices**

<table>
<thead>
<tr>
<th>Item</th>
<th>Price Level</th>
<th>Current Price</th>
<th>New Price</th>
<th>Change</th>
<th>Price Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>$65.00</td>
<td>$76.40</td>
<td></td>
<td>$11.40</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>$65.00</td>
<td>$76.40</td>
<td></td>
<td>$11.40</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>$65.00</td>
<td>$76.40</td>
<td></td>
<td>$11.40</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>$65.00</td>
<td>$76.40</td>
<td></td>
<td>$11.40</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>$65.00</td>
<td>$76.40</td>
<td></td>
<td>$11.40</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>$65.00</td>
<td>$76.40</td>
<td></td>
<td>$11.40</td>
</tr>
</tbody>
</table>

QuickBooks Point of Sale
8. Review the price changes before saving or applying to your inventory.
   If you have made an error in defining your price change calculations, you can select **CLEAR NEW PRICES** and redefine the calculations by selecting **CALCULATE PRICES**, or you can manually enter item prices in the **New Price** column.

9. Select **SAVE** if you do not yet wish to apply the changes, or **APPLY CHANGES TO INVENTORY** at the bottom of the screen to save and apply this change now.

You can print markdown price tags, if needed, either before or after saving/applying the price change. Refer to *Markdown or Discount Tags from Price Manager* (page 48) for instructions.

**To view a price change record:**

1. From Price Manager, select **VIEW ALL** under Change Item Prices.
   - Your price changes each display a status: **Pending** - prices calculated but not yet applied; can still be edited; **Applied** - prices have been applied to inventory; this price change can be restored; **Restored** - the previous prices have been restored.
   - From the price change list, you can edit, delete, copy, or print tags for a price change, create a new price change, or restore a previously applied price change.

2. To work with a price change record, locate and select it from the price change list.
   - If necessary, use the View drop-down to filter the price change list. Predefined filters are available for the three status conditions.

3. Double-click the price change or select **EDIT** from the toolbar.

**Editing a Pending Price Change**

A pending price change can be edited to:

- Change how the new prices are calculated.
- Apply rounding.
- Add or remove items affected by the change.

When you reopen a pending price change record, the items for which new prices have been calculated are displayed (the View drop-down list is pre-filtered for **ITEMS WITH NEW PRICE**).

**Important considerations when editing a price change**

- Price calculations affect the currently displayed items. Observe the current state of the View drop-down and filter the item list or use the **SELECT ITEMS** option to ensure the correct items are displayed before calculating new prices.
• When you apply changes to inventory, all items with a new price entry are affected, whether it is currently displayed or not. Always do a final review of the price changes, with the View drop-down set to ITEMS WITH NEW PRICE, and be sure the # of Items count on the window is what you expect, before applying the changes to inventory.

• You can change prices for different groups of items using different formulas in a single price change by filtering (or using the wizard to select items) for the first group and entering the price change criteria, then filter for the next group and enter different price change criteria, etc. Do not apply the new prices to your inventory until all price changes have been entered and reviewed as described above.

To edit or modify a price change:

1. Display the price change record you wish to modify.
2. Display the items for which you would like to enter a price change.
   • To display and make changes to the items with new prices already entered, select ITEMS WITH NEW PRICE in the View drop-down list.
   • To display and enter new prices for additional items, do one of the following:
     ■ From the View drop-down, select CREATE FILTER to add items matching criteria you enter or ALL ITEMS to change prices for your entire inventory. Refer to Using Filters in Lists and Reports (page 106) for more information.
     ■ Choose SELECT ITEMS in the options section to use the wizard to select additional items by vendor, department, or item name.
3. Select and/or complete an edit action:
   • CALCULATE PRICES to calculate new prices for the displayed items.
   • ROUND PRICES to round the new prices to the ending values you prefer. Refer to Rounding Calculated Prices (page 204) for more information.
   • Enter prices manually in the New Price column.
   • CLEAR NEW PRICES to remove all new item prices and start over.
   • To remove an individual item from a price change, delete the value in the New Price field.
   • PRINT PRICE TAGS for all or selected items with new price.
4. Repeat if necessary for another group of items.
5. Select ITEMS WITH NEW PRICES from the View drop-down list to display all changed prices. Review the proposed price changes.
6. Select SAVE or APPLY CHANGES TO INVENTORY.
Copying Prices to Another Price Level

Price Manager makes it easy to copy prices from one price level to another. For example, you can copy prices from your regular price level to a newly created price level.

To copy existing prices to another price level:

1. From the Price Manager, select MAKE PRICE CHANGES.
2. Select the price level to which you would like to copy prices.
3. Enter a name for this price change and, optionally, any applicable notes.
4. In the Price Change wizard, choose ALL ITEMS.
5. Select to calculate from PRICE.
6. Select the price level from which will copy prices.
7. Select AS IS.
8. Select NEXT.
9. Select FINISH.
Chapter 12: Item Quantities, Cost and Price(s)

Rounding Calculated Prices

When using Price Manager you have the option of having your new prices rounded to any ending value that you prefer.

Your rounding choices are:

- Round all prices to the nearest dollar (Examples: $1.00, $2.00, $9.00, $75.00)
- Round all prices to the nearest ten cents (Examples: $0.10, $0.20, $1.90, $25.70)
- End all prices with 99 cents (Examples: $0.99, $1.99, $2.99, $59.99)
- End all prices with 9 cents (Examples: $0.09, $0.19, $6.49, $99.99)
- End all prices with custom values that you define

If you select the last option, you can enter up to four ending values for your prices. You can view how rounding works with this option by entering trial prices in the test field provided on the Round New Prices window.

Rounding is applied only to prices that are changed in Price Manager. Other program-generated prices, such as when using pricing formulas for new items, are not rounded.

Tip: Round All Prices at a Price Level in one Procedure

To round all prices at a price level at one time, use the Copying Prices to Another Price Level procedure, previously in this section, with the following differences:

1. Select the same price level to calculate prices from and to be applied to.
2. Enter your rounding instructions on the appropriate screen and then select APPLY CHANGES TO INVENTORY.
3. Repeat the procedure for other price levels as necessary.

Restoring Your Old Prices

When you use Price Manager to create and apply price changes, Point of Sale remembers the old prices. The restore function returns the item prices to the previous value.

Important: This procedure restores the prices for all the items included in the original change, and at the price level originally affected, to the OLD PRICE. If the prices of any of the included items have been changed in the interim, in another price change or manually, those interim changes will be overwritten by this procedure.

This feature allows you to undo a price change made in error. It also allows you to change prices temporarily, such as for a weekend sale, and then revert to the old prices once the sale is finished.
To restore old prices from a price change:

1. Locate the price change record in the Change Item Prices list as described earlier.
2. With the record selected or displayed, select **RESTORE OLD PRICES** from the I Want To menu.
3. Read and select **CONTINUE** to acknowledge the warning about overwriting interim price changes.
4. Select **OK** in the confirmation window.

All of the item prices affected by the original price change are restored to their level prior to that change.

---

**Using Discount Pricing (Pro)**

Price Manager’s discount pricing option allows you to predefine discounts for an item or group of items. Once defined and saved, Point of Sale automatically applies the discount when qualifying item(s) are listed on sales receipt or orders. The discount pricing feature provides three discount models to choose from:

- **% Off.** This allows you to take a percentage off the regular price when qualifying items are purchased.

- **Buy X for $Y.** This allows you to set a different price when a specified quantity of qualifying items is purchased.

  *Example:* You have assorted styles, colors, and sizes of silk-screened T-shirts that normally sell for $15 to $20 each. To spur sales you define a discount price for the T-shirts of 3 (x) for $40 (y). When you list any combination of three qualifying T-shirts on a sales receipt, Point of Sale discounts the individual shirt items so that the total extended price for the three is $40.

- **Buy X and get Y% off.** This allows you to set a percentage off the regular price when a specified quantity of qualifying items is purchased.

**Important notes about discount pricing:**

- You can include any combination of items, except group items, in a discount.
- An item can be included in more than one discount, subject to some restrictions. *Refer to your on-screen help for more information.*
- Discounts can be turned on and off. For example, you can offer a discount price on the weekend but inactivate it during the week. The discount remains saved and can be turned back on at any time.
• The combination of customer and item(s) on a document may qualify for more than one discount, e.g., discount pricing plus a customer-assigned discount. In this case, Point of Sale will give the customer the lowest price for which they qualify. In the case of an item being included in two discount prices, the discount with the most recent start date is applied. If other discount conflicts occur, Point of Sale will provide a notification, and present options, if available. Read more about how multiple discounts are applied to sales in Price and Discount Priority (page 363).

• If you use multiple units of measure, a quantity discount can be set up for any one of the defined units.

Discount Pricing Fields

This table lists the name and usage of the discount pricing fields. Reference to these fields is made in the procedures that follow.

Fields that have an obvious purpose or item fields whose purpose is explained in Item Information Fields (page 647) have been omitted from this table.

If a listed field is not visible in the list, you can customize your list columns to include it. Refer to Customizing Columns in Lists (page 586) for more information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Created] Created By</td>
<td>Date that the discount was created. If logins are required, the logged in employee. If logins are not required, but employees are defined, select a name from the drop-down list.</td>
</tr>
<tr>
<td>Discount Name</td>
<td>Required. User-defined name to identify the discount. Must be unique for each discount; facilitates reporting.</td>
</tr>
<tr>
<td>Discount Reason</td>
<td>Required. User-defined reason for the discount. Cannot duplicate manual item discount reasons defined in preferences. Populated to the Discount Reason field on sales receipts when the discount is applied; facilitates reporting.</td>
</tr>
<tr>
<td>Discount Sales Statistics</td>
<td>Fields available to add to the discount record (where they indicate discount sales info for entire discount) or to the discount item list (where they indicate discount sales by item). Use these statistics to assess the effectiveness of the discount. You may have to add these fields/columns to your Price Manager windows to view. Refer to Chapter 34 Customizing the Program (page 581) for more information.</td>
</tr>
</tbody>
</table>
Setting Up a Discount

To set up a new discount:

1. Access Price Manager and then select SET UP A NEW DISCOUNT from the overview page (or NEW DISCOUNT from your Discount Pricing list). The New Discount wizard is opened.

2. Enter a name, reason, and appropriate notes to identify the discount and select NEXT.
   
   Name is required and must be unique for this discount.
   
   Reason is required and cannot duplicate a manual item discount reason as entered in company preferences.

3. Select a discount type: % OFF, BUY X FOR $Y, or BUY X AND GET Y% OFF and enter the requested information to define the discount.

4. When you are creating a quantity discount, select or clear the checkbox to discount additional quantities. If this option is selected, the required quantity is used as a threshold above which all quantities receive the discount. If this option is not selected, only multiples of the required quantity receive the discount.

5. Select NEXT.

6. Select the price levels to which this discount applies:
   
   At least one price level must be selected (your regular price is pre-selected by default). The discount will only be applied to sales when the active price level on the sale is one of those selected on this window.
7. Select FINISH. The wizard is closed and the discount record is displayed.

![Discount WizardScreenshot](image)

8. Review the discount information at the top of the window and then add items and choose options using the buttons on the screen:

- **Adding Items:** List the items that are eligible for the discount, using normal item listing procedures or add groups of items by department, vendor, item name, or other criteria using the **SELECT ITEMS** button.
  - If you go to your item list to select items, the normal **Doc Qty** field is replaced with item selection checkboxes to the left of the items. Select the items to include in the discount by selecting the checkboxes.
  - If you attempt to add an item that is included in another active discount price, you will be blocked or warned.
  - You may find it helpful to rearrange or customize the columns in the item list to show prices for the price level(s) to which the discount will apply.

- **Scheduling:** Select **SCHEDULE** and enter a start and end time for the discount. Point of Sale will automatically apply the discount only to sales in the defined date/time range.

- **Discount Price Tags:** Use the Print Price Tags drop-down menu to print discount tags if desired.

- **Editing the discount:** You can revise the discount type, items, schedule, or make the discount inactive at anytime.
9. Select SAVE.

💡 Tip: Copying Discounts

If you are creating a discount similar to a discount you have previously used, you can copy the discount and make appropriate changes. Copying can be done from the discount list or from within a discount record.

To edit a discount:

1. From the Discount Pricing list, select the discount you want to edit from the list.
2. Select **EDIT DISCOUNT**.
3. Use normal editing procedures to add or remove items, or change the discount formula.
4. To make the discount inactive, select the **INACTIVATE** button. To reactivate the discount later, return here and select **ACTIVATE**.
   - When a scheduled discount expires, Point of Sale automatically makes it inactive.
   - To edit the schedule or discount type of an inactive discount, you will need to activate it first.
   - If activating a previously scheduled discount and the schedule dates have expired, you are prompted to define a new schedule.
   - When activating a discount, Point of Sale checks for conflicting items with other active discounts and alerts you if any are found.
5. Select **SAVE**.

To delete a discount:

1. Select the discount from the Discount Pricing list.
2. Select **DELETE DISCOUNT** from the I Want To menu.

Applying Discounts to Sales

Active discount prices are automatically applied to qualifying sales, subject to a defined schedule. Refer to Receipt Price Levels and Discounts (page 358) for more information on applying discounts to sales.
# Item Styles, Assemblies, and Groups (Pro)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Item Styles</td>
<td>212</td>
</tr>
<tr>
<td>Style Grid Basics</td>
<td>214</td>
</tr>
<tr>
<td>Grid Values</td>
<td>214</td>
</tr>
<tr>
<td>Adding a New Style</td>
<td>215</td>
</tr>
<tr>
<td>Editing a Style</td>
<td>217</td>
</tr>
<tr>
<td>Deleting a Style or a Style Item</td>
<td>218</td>
</tr>
<tr>
<td>Using Style Templates</td>
<td>219</td>
</tr>
<tr>
<td>Adding Pictures to Item Styles</td>
<td>221</td>
</tr>
<tr>
<td>Item Assemblies and Groups</td>
<td>222</td>
</tr>
<tr>
<td>Key Differences between Assemblies and Groups</td>
<td>222</td>
</tr>
<tr>
<td>Using Assembly Items</td>
<td>223</td>
</tr>
<tr>
<td>Adding and Building Assembly Items</td>
<td>223</td>
</tr>
<tr>
<td>Breaking an Assembly</td>
<td>225</td>
</tr>
<tr>
<td>Editing Assembly Items</td>
<td>226</td>
</tr>
<tr>
<td>Using Group Items</td>
<td>227</td>
</tr>
<tr>
<td>Defining Group Items</td>
<td>227</td>
</tr>
</tbody>
</table>
Working with Item Styles

Style Definition

In Point of Sale, an item style is a means of grouping inventory items that share basic information but differ in one or two item traits, such as size, color, pattern, etc.

For example, a line of running shoes might be carried in ten sizes and two colors. The 20 different size/color combinations of this shoe line constitute an item style. Size and color are typically how items within a style are differentiated (though there can be many other methods) and will be used in describing how to use item styles.

From a data standpoint, a style is defined as a group of items that share the same Department and Item Name entries on their item records. Items within a style can have a different size, attribute, item description, alternate lookup, UPC, price, cost, and so forth. Data can be summarized by style on reports, and many program actions can be conveniently applied to all the members of a style at once.

Point of Sale provides a way to view and work with all of the items of a style in a single window, called a style grid. In a style grid, you can immediately see the on-hand quantities of each size, each color, and the total for the entire style, as well as being able to use the grid to quickly add items to inventory or to enter order quantities when creating a purchase order or receiving voucher.

The use of styles is optional and not all business types benefit from their use.

Turning the Style Feature Off

If you prefer to not work with styles, this feature can be turned off in company preferences, which will remove the Style view option. Refer to Removing Features from Point of Sale (page 584) for more information on turning off Point of Sale features.

Items Belonging to a Style

If you use styles, and add more than one item with the same Dept Name and Item Name, a style grid will automatically be created for the items. If you add another new item with the same department and Item Name as an existing item in inventory, the program will give you the option to join the new item to the existing style.

The Style Window

The Style window displays an item style in a split-screen view, with the top pane showing general information for the style as a whole, and the bottom pane displaying all items/quantities in the style in a style grid format. Each cell of the style grid represents a style item with a unique size/color (or other attribute) combination.
To use this view, highlight or display any style item and then select **ADD/EDIT STYLE** from the I Want To menu. This example is a Style window for an item style of adult baseball bats that vary in length and weight.

**Important Note:** Edits made in the upper pane of this window affect all style items. Make edits in this pane carefully.

Style items can also be viewed in your item list, where each item is a separate inventory row and has its own item number.

Members of the same style may be scattered throughout the item list because new items can be added to a style at any time. You can sort by **Item Name** and **Dept Name** to sort items by style (from the View menu, select **SORT LIST ➤ SORT ON**).
MULTIPLE COLUMNS to sort by both columns at once). You can also filter by these fields to group all items of a particular style together.

Style Grid Basics

Two of the Point of Sale item descriptive fields (Size and Attribute) make up the two axes of a style grid. If you have renamed these fields, your custom names are displayed. Refer to Custom Labels and Custom Fields (page 589) for more information about renaming item descriptive fields.

This sample style grid shows the size/attribute combinations for a style of sweatshirts. The grid is formed by listing the available sizes along the horizontal axis and the colors along the vertical axis.

The point where a row and column intersect is called a cell. Each cell is a unique size/color combination that corresponds to one item or row in your item list.

Even a relatively small grid like the sample above contains a great deal of information. This example shows 15 possible size/color combinations (i.e., 15 items) in the style and the current on-hand quantity of each. The style has three colors and five sizes.

The number of items that can be included in a style is virtually unlimited. You may have to use the vertical and horizontal scroll bars to view all of the style items in the grid.

The bottom and right-hand side of the grid displays totals for each column (size), each row (color), and for all style items. You can turn on/off the display of totals values by right-clicking in a row or column header and selecting the SHOW TOTALS option.

Grid Values

When viewing the inventory, the values displayed in the style grid are the on-hand quantities of each item. A blank cell means that particular size/attribute for the style is not carried.

When accessing inventory using SELECT FROM ITEM LIST from a purchase order or other document, the style grid cells are initially blank and are used to enter the quantity to be listed on the document (i.e. the document quantity being sold, ordered, received, etc.).
(Pro Multi-Store) The **Quantities for Store:** field at the top of the style grid allows you to view quantities for the entire company or for any specific store by making a selection from the drop-down list.

**Style Templates**

Many retailers carry styles of merchandise that is very similar in terms of the sizes, colors, or other attributes. For example, a shoe store might carry dozens of different shoe lines, but all tend to have the same or similar size and color combinations. Having to re-enter the sizes and colors for every shoe you carry would quickly become tedious.

Enter the *style template*. A style template is a user-defined array of item attributes: sizes, colors, patterns, material, etc., that is used to quickly add a similar item style to inventory.

Refer to **Using Style Templates (page 219)** for more information on working with style templates.

**Adding a New Style**

**To add a new style:**

1. From your item list, select **EDIT/ADD STYLE** from the I Want To menu, and then select **NEW STYLE** in the Style window.
   A new, blank Style window is displayed.

2. In the upper pane, make entries in the required **Dept Name** and **Item Name** fields.
   These essential fields define the style.

---

**Tip: Simplify Your Data Entry**

When choosing your style descriptions, keep them simple. This will make your data entry faster and makes it easier to locate the style items later.
3. Enter information or make selections in the other available fields, such as Item Description, cost, prices, tax code, and so forth, for which you want to record data for this style.

Refer to Item Information Fields (page 647) as necessary.

Remember, information entered in the upper pane is applied to all style items. If the items in the style will have different prices, for example, leave the price fields blank and edit them later for each item individually, or enter the most common price and then edit only the ones that differ later.

4. Enter the sizes/attributes for the style:
   - To use a style template, click the down arrow in the Select a Style Template list and select a pre-defined template or choose ADD NEW to create, save, and apply a new template. Refer to Using Style Templates (page 219) for more information about using templates.

   And/Or

   - Click in the CLICK TO ADD fields in the rows/columns and enter the sizes and attributes for the style items.

     If using a template, the sizes and attributes can be edited for this individual style.

5. Enter 0 (zero) in each attribute/size cell corresponding to the items in your style.

This creates a new row in inventory for those items.
Working with Item Styles

Leave the cell blank if you won’t carry a particular attribute/size combination. *(If the items are already physically in the store and not being received on a voucher, you can enter the actual on-hand quantities instead of zeroes.)*

6. Select **SAVE**.
7. If you need to edit information fields for individual style items, such as for cost or price, use the procedure below or the normal item editing procedures covered in **Editing an Item** *(page 176).*

**Editing a Style**

Existing styles can be edited to add/delete items, rearrange the order in the style grid, or make general edits to pricing and other information fields.

**To edit an existing style:**

1. Display the style in the Style window.
2. Make necessary edits in the top pane.
   The values initially displayed are those of the specific item that was selected when the Style window was entered. Changing the values in the displayed fields, however, will change that value for *all* members of the style.
   Be careful making changes here.

3. To edit item sizes/attributes, select a column or row header in the grid and type a new entry.

Note that editing a size/attribute definition in the grid changes the definition for all items in that column or row. Select **CHANGE SIZE/ATTRIBUTE LABEL** in the confirmation dialog displayed to proceed.
4. To add a new size or attribute, select **CLICK TO ADD** and type the new entry. Enter 0 (zero) in the new cells created to add the item to inventory.

5. To delete, move, rearrange rows or columns, or to save the grid as a new template, right-click on a column or row header and choose the appropriate action from the pop-up menu.
   - **AUTO-ARRANGE** orders columns/rows numerically or alphabetically
   - **AUTO-ADJUST** adjusts all column widths to the width of the longest entry

6. To edit the on-hand quantity of a style item, click in a cell and type the new value. Just as on an item form, manually editing a quantity results in Point of Sale creating an adjustment memo. The adjustment is sent to QuickBooks financial software to update your inventory value.

7. Select **SAVE**.

---

**Deleting a Style or a Style Item**

You cannot delete a style (or an item) if any of the style items are included in an assembly or group item, or if they are included in a defined discount price until they are removed.

This process should be carried out with caution so that items with on-hand quantities or that are listed on active documents are not accidentally deleted. When you delete an entire style, all items in the style are deleted.

If there were quantities on hand for the item(s) deleted, Point of Sale creates an adjustment memo to update your inventory value.

**To delete an entire style:**

1. Display the style in the Style window.
2. Select **DELETE** from the window toolbar.
3. Select **DELETE ENTIRE STYLE** from the drop-down list.
4. A series of windows may be displayed. If the any style items still have a quantity on hand or is listed on an open order you will be warned. Confirm the deletion or
select **CANCEL** to exit without deleting. Proceed through any on-screen prompts to delete the style.

Alternatively, right-click in the style grid and select **DELETE STYLE** from the context menu.

**To delete a style item:**

1. Display the style in the Style window.
2. Highlight an item (cell) in the style grid.
3. Select **DELETE** from the window toolbar.
4. Select **DELETE SELECTED STYLE ITEM** from the drop-down list.

   If the item still has a quantity on hand or is listed on an open order you will be warned. Confirm the deletion or select **CANCEL** to exit without deleting.

## Using Style Templates

A style template is a user-defined array of item attributes (sizes, colors, patterns, etc.) that is used to create style grids. Each template can be used for an unlimited number of styles. If you prefer, you can create each style grid from scratch in inventory. However, using templates makes the process much faster since all the predefined sizes and attributes are written on the new grid for you.

For example, if you sell several lines of shoes that tend to have common and repeatable sizes and colors, you could create a shoe template with all of the common sizes and colors represented. Each time you add a new style of shoes, you attach the shoe template to the style to simplify the task.

During the Setup Interview, you may have elected to install default style templates typical for your business type. If so, you can apply one of the pre-defined templates to styles as you add them. You can also create new templates or edit your existing templates. Both procedures are outlined in the following pages.

If a template contains any sizes or attributes that you do not need for a particular style, you do not have to define items for those cells. An inventory row will be assigned only to those cells where you enter a quantity.

## Creating a Style Template

1. From the Style window, select **ADD NEW** from the Select a Style Template drop-down list.
Chapter 13: Item Styles, Assemblies, and Groups (Pro)

The Select a Style Template window is displayed, with a new template, named *New Template*, opened (see next page).

2. Type a unique name to overwrite the default name.
3. Select **CLICK TO ADD** and enter item attributes and sizes along the two template axes.
4. Select **SAVE**.

**OR**

If you want to apply this template to the style you were working on, select **APPLY SELECTED TEMPLATE**.

---

**Tips for Creating Style Templates**

- If an existing template is similar to the one you want to create, highlight it and then select **COPY SELECTED TEMPLATE** from the Options drop-down menu. Edit the new template as needed and then save with a unique name.
- It is not required that you make entries on both axes of the template. If your merchandise is only consistent on one attribute, make entries on only one axis of the template. You can add attributes for the other axis, if needed, for each style in inventory.
- The Edit menu under the displayed template grid contains choices to move or delete columns or rows and to undo edits.

---

**Editing, Deleting, and Copying Style Templates**

1. From the Style window, select the magnifying glass to the right of the **Select Style Template** field.
2. Select a template from the list and complete actions as needed in the Select Style Template window:

<table>
<thead>
<tr>
<th>Edit</th>
<th>Use the same procedures to edit a template as for creating it. Additional choices for moving or deleting rows/columns and undoing edits are on the Edit menu under the displayed template.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Choose DELETE SELECTED TEMPLATE from the Options menu. Deleting a template does not affect existing styles that were created with the deleted template.</td>
</tr>
<tr>
<td>Copy</td>
<td>Select COPY SELECTED TEMPLATE from the Options menu. Enter a name for the new template and edit as needed.</td>
</tr>
<tr>
<td>Rename</td>
<td>Select RENAME SELECTED TEMPLATE from the Options menu. Renaming a template does not affect existing styles that were created with the template.</td>
</tr>
</tbody>
</table>

### Adding Pictures to Item Styles

If item pictures are turned on, pictures can be associated with an entire style. This can often be more efficient than associating individual pictures to each item. If you already have a picture associated with an item in a style, and you then associate a picture with the style, the individual item’s settings will be overwritten and the style picture will be displayed for that item.

**To add pictures to a style:**

1. From any item record within the style, select EDIT/ADD STYLE.
   - The Item Pictures area will be displayed on the right above the style grid.
2. Select 📸 and browse to the image file and double-click it.
3. Edit the Picture Name field as needed.
4. Select SAVE.

*Refer to Pictures in your Item Records (Pro) (page 170) for more information about adding pictures.*
**Item Assemblies and Groups**

Item assemblies and groups provide two ways to sell a predefined set of items by listing a single item on a sales document. However, the two item types vary in several ways, as outlined in the table below.

**Key questions to ask when deciding between an assembly and a group?**

- Do you want to physically pre-build the set, thus removing the individual component items from inventory?
- Do you want the component items in the set to remain available for individual sale?
- Do you want the individual items printed on customer receipts or just the set as a single item?
- Do you sell more of the items individually or in the set?

**Key Differences between Assemblies and Groups**

<table>
<thead>
<tr>
<th>Option</th>
<th>Assembly</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-built?</td>
<td>Yes*</td>
<td>No</td>
</tr>
<tr>
<td>Can you sell component items individually?</td>
<td>No*</td>
<td>Yes</td>
</tr>
<tr>
<td>Can you include assembly item as component?</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can you include group item as component?</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Can assembly/group items be printed on receipts?</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can assembly/group prices be printed on receipts?</td>
<td>Yes</td>
<td>Optional**</td>
</tr>
<tr>
<td>Can component items be printed on receipts?</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Can component item prices be printed on receipts?</td>
<td>No</td>
<td>Optional**</td>
</tr>
<tr>
<td>Can include both taxable and non-taxable items?</td>
<td>No***</td>
<td>Yes</td>
</tr>
<tr>
<td>Can a discount price be defined for this item?</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can you track cost and quantities?</td>
<td>Yes</td>
<td>No****</td>
</tr>
</tbody>
</table>

* Quantities of component items not pre-built into assemblies can be sold individually and built assemblies can be broken, freeing the component items for individual sale.

** Set by preference.  *** The assembly item has a single tax code, taxable or non-taxable; the entire assembly is taxed according to this code.

**** Quantities and costs of group component items are tracked individually, not as a group.
Using Assembly Items

An assembly item is an item that is itself composed of two or more other inventory items and sold as a set. For example, a “Ski Slope Package” could be defined as an assembly item made up of a pair of skis, bindings, and boots, all of which already exist in your inventory as individual items. Assembly items are often used to sell a set of items at a discount.

You “build” assembly items from existing items in inventory, referred to as the component items. An assembly item can be a component item of another assembly.

When you build an assembly, the on-hand quantity of each component item is reduced by the quantity of the item included in the assembly and the on-hand quantity of the assembly item is increased by one. The number of assemblies you can build is dependent on the on-hand quantity of the component items. Assemblies can also be broken, thus freeing the component items to be sold individually again.

Once an assembly has been built, it can be listed on receipts and customer orders in the same manner as regular inventory items. Sales reports include assembly items as unique items and do not report on the component items that are included in the assembly. Keep reporting needs in mind when you assign department, vendor, and descriptions to your assembly items.

Adding and Building Assembly Items

(Pro Multi-Store) Assembly items must be created at Headquarters, but remote stores can build or break assembly items to meet local sales demand.

To define and build an assembly item:

1. Be sure all component items have been added to inventory individually, following the procedures earlier in this chapter.
2. With your item list displayed, select NEW.
3. In the Item Type field, select ASSEMBLY.
4. Specify a Department name and optionally, a vendor.
   If the items included in the assembly come from more than one department, you might want to set up a new department called Assemblies, or similar, to track and report the sale of assembly items.
5. Enter a descriptive name for the assembly in the Item Name field, e.g. Holiday Ski Package.
6. Enter information in other fields:
   • You cannot enter an On-Hand Quantity or Average Unit Cost. Point of Sale calculates and auto-fills these fields when you build the assemblies. The
average unit cost is calculated as the sum of the costs of the component items. This cost is recalculated each time you build additional assemblies.

- Optionally, enter a **Regular Price**. If a price isn’t entered, Point of Sale will auto-fill the field as the sum of the component item prices after they are added. You can edit the price later, if needed.
- Enter a **Tax Code**. Tax (or none) will be computed on the total price of the assembled item according to this code. Use judgement and observe local tax regulations if mixing taxable and non-taxable component items in an assembly. Consider using an item group if this is unavoidable.
- Specify a Reorder Point value if you want to be reminded on Build Point reports that more assemblies need to be built. Refer to Chapter 26 Reports and Sales Charts (page 459) for information about running a Build Point report.
- Any other fields appropriate for the item. Refer to Item Information Fields (page 647) for more information.

7. Select **ADD/EDIT ITEMS IN ASSEMBLY**.
   The Assembly components window is displayed. The previously entered information is shown in the top pane and the assembly item list is in the lower pane.

8. Use standard item listing procedures to add the assembly component items and quantities. Refer to Listing Items on Documents (page 91) for complete item listing procedures.

9. Select **BUILD ASSEMBLY**. If you do not have sufficient quantities of an item to build the assembly item, Point of Sale will inform you which items you are missing.
Point of Sale saves the information you have entered and the Build Assembly dialog is displayed, notifying you of the maximum number of assemblies that can be built. This number is based on the on-hand quantities of the component items.

(Pro Multi-Store) You are prompted to specify the store for which you are building the assemblies before specifying the number to build.

10. Specify the number of assemblies you would like to build and then select **BUILD**. The on-hand quantity of the assembly item is increased by the quantity you choose to build. The on-hand quantity of each component item is reduced by the total number included in the built assemblies.

The assembly component items are displayed on the item form for reference.

**Breaking an Assembly**

Breaking an assembly again makes the component items available for sale individually.

**To break an assembly:**

1. Highlight or display the assembly item.
2. Select **ADD/EDIT ITEMS IN ASSEMBLY** from the I Want To menu.
3. Select **BREAK ASSEMBLY**.
   (Pro Multi-Store) You are prompted to specify the store for which you are breaking the assemblies.
   The Break Assembly dialog displays the number of existing assemblies that can be broken.
4. Specify the number of assemblies you would like to break and then select **BREAK** in the dialog.

If an assembly item includes a second assembly item as one of its components, then breaking the first assembly does not break the second assembly contained therein.
Breaking an assembly reduces the on-hand quantity of the assembly item by one (for each assembly broken) and increases the on-hand quantity of each component item by the total number included in the broken assemblies.

---

**Quantity and Cost Memos Automatically Created for Assemblies**

Quantity and cost memos are automatically created to adjust inventory when building or breaking assembly items. The logged on user’s name will be entered on the memo, along with the reason (“CreatAsm/Brk Asm”). If users are not required to log in, you will be prompted to enter a user name for the memo(s).

---

**Editing Assembly Items**

Assembly item descriptive fields, price, vendor, and so forth, can be edited at any time using standard inventory editing procedures. Refer to Editing an Item (page 176) for more information.

If it is necessary to make changes to the component items of an assembly all previously built assemblies must be broken before the changes are allowed.

**To edit components in an assembly item:**

1. Break all existing assemblies, as described earlier.
   
   (Pro Multi-Store) You must break all existing assemblies for all stores before you can make changes to component items. Remote stores should discontinue selling this assembly item until you make changes and conduct a Store Exchange to update their inventories.

2. Use standard procedures to add, delete, or edit the component items.

3. Select **SAVE** to record your changes.

4. Rebuild assemblies as needed using the normal build procedure.

**To delete an assembly item:**

Deleting an assembly item requires that you first break all existing built assemblies and remove the component items in the Assembly components window.

1. Break all existing assemblies, and remove all component items as described above and select **SAVE**.

2. With the assembly item highlighted or displayed, select **DELETE** from the window toolbar.

3. Confirm the deletion. The item will be deleted and cost/quantity memos created to adjust inventory.
Using Group Items

A group item provides an efficient method to list and sell two or more items, at a defined group price, by entering or scanning the group item’s identifier (UPC, Alternate Lookup, or Item Number) on a document. In a strict sense, an item group is not really an item at all, even though it is defined in inventory in the same manner as other items.

Group items differ from an assembly items in several important ways:

- Groups are not pre-built, i.e. the component item quantities included in a group remain in inventory and can be sold individually
- Quantities, costs, and so forth, are tracked for the individual component items, not for the group item
- Each item in the group can be taxed differently according to the tax code assigned the individual item
- The printed receipt given the customer can include the group price, the individual item prices, or both at your discretion
- One group item cannot be a component of another group; any other item type is allowed in the group

Defining Group Items

To define a group item:

1. Be sure all individual items to be in the group have been added to inventory individually, following normal procedures.
2. From your item list, select NEW.
3. In the Item Type field, select GROUP.
4. Specify a Dept Name (department).
   If the items to be included in the group come from more than one department, you might want to set up a new department called Groups, or similar, to track and report the sale of group items.
5. Enter a descriptive name for the group in the Item Name field.
6. Enter information in other fields:
   - You cannot enter an On-Hand Quantity, Average Unit Cost, or a Reorder Point or any other values that are not tracked for a group item.
   - Optionally, enter a Regular Price. If a price isn’t entered, Point of Sale will auto-fill the field as the sum of the component item prices after they are added. You can edit the price later, if needed.
   - Any other fields appropriate for the item. Refer to Item Information Fields (page 647) for more information.
7. Select **ADD/EDIT ITEMS IN GROUP**.

   The Group components window is displayed. The previously entered information is shown in the top pane and the group item list is in the lower pane.

![Item List> Group Item](image)

8. Use standard item listing procedures to add the group component items and quantities. Refer to **Listing Items on Documents (page 91)** for complete item listing procedures.

9. Select **SAVE**.

   **To edit a group item:**

   1. Locate the group item in your item list and select **EDIT**.
   2. Make changes to the editable fields as needed on the item form.
   3. From the I Want To menu, select **ADD/EDIT ITEMS IN GROUP** and use normal procedures to add, delete, or edit the quantity of each component item.
   4. Select **SAVE**.

   **Selling a Group Item**

   When a group item is listed on a sales receipt or customer order, all included items are listed and the price of each item is proportionally discounted, as necessary, so that the total equals the group price defined in inventory. Individual item prices can be further edited on the document, if needed.
You have options for how prices are printed on receipts. With the default setting, the component item prices and discounts are printed but the group item price is not.

<table>
<thead>
<tr>
<th>Item #</th>
<th>Description 1</th>
<th>Attribute</th>
<th>Size</th>
<th>Qty</th>
<th>Price</th>
<th>Ext Price</th>
<th>Tax</th>
</tr>
</thead>
<tbody>
<tr>
<td>288</td>
<td>Sweat Suit</td>
<td></td>
<td></td>
<td>1</td>
<td>$34.99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>99</td>
<td>Sweatpants</td>
<td>Black</td>
<td>SML</td>
<td>1</td>
<td>$17.90</td>
<td>$17.90 AD1425566</td>
<td></td>
</tr>
<tr>
<td>164</td>
<td>Sweatshirt</td>
<td>Black</td>
<td>SML</td>
<td>1</td>
<td>$17.09</td>
<td>$17.09 AD2466165</td>
<td></td>
</tr>
</tbody>
</table>

Sample Sales Receipt Screen - Group Item Listed

Default Printed Receipt - Group Price Not Included

By selecting the option in Preferences > Company > Sales > [Check] When Printing Group Item on Sales Receipts and Orders.

Select an option from the drop-down list: PRINT GROUP PRICE ONLY, PRINT GROUP AND ITEM PRICES, or PRINT ITEM PRICES ONLY (default).
Chapter 14

Inventory Counts and Adjustments

Conducting Physical Inventory Counts ........................................... 232
Overview .................................................................................. 232
Filtering the Physical Inventory Item List .......................... 233
Printing a Store Count Worksheet ................................................. 233
Entering Physical Inventory Counts .............................................. 234
Entering Counts Using the Add Counts Window ........ 235
Entering Counts with a Physical Inventory Scanner ....... 237
Applying Changes to your Inventory ........................................... 241
Store Count Reports ................................................................. 242
Viewing or Reversing the Last Physical Inventory .......... 243
Adjusting Item Costs and Quantities ........................................... 243
Adjustment Memo Overview ..................................................... 243
Adjustment Memo Types .......................................................... 244
Accessing Adjustment Memos .................................................... 244
Creating an Adjustment Memo .................................................. 245
Notes on Old, New, and Difference Fields ................ 246
Actions that Generate Adjustment Memos ..................... 246
Canceling or Holding a Memo in Progress ...................... 247
Working with Adjustment History .............................................. 248
Locating an Adjustment Memo ................................................ 248
Copying an Adjustment Memo ................................................. 249
Reversing an Adjustment Memo .............................................. 249
Printing Adjustment Memos ..................................................... 250
Chapter 14: Inventory Counts and Adjustments

Conducting Physical Inventory Counts

Overview

A “physical inventory” is an actual count of the merchandise that is in stock. That information is used to confirm or correct the on-hand quantities recorded in inventory. We recommend that a physical inventory be completed when first beginning to use Point of Sale and periodically thereafter.

A physical inventory involves someone going through the store and recording individual item quantities. Individual items might be in various locations in the store, so some items may have multiple entries.

(Pro Multi-Store) Headquarters can enter physical inventory counts for any store. Remote stores can only conduct physical inventories for their own locations.

Basic Steps to a Physical Inventory

Detailed procedures for each step are discussed on the following pages.

1. From the Inventory menu, select START PHYSICAL INVENTORY. (Pro Multi-Store) Select the store for which you are conducting the physical inventory.
   The Physical Inventory window is displayed.

2. Physically count on-hand quantities and enter them in the Physical Inventory Count window:
   • Filter your item list first if taking and entering counts by logical groupings, such as department, vendor, or physical location
   • Take and enter counts using the Store Count Worksheet or with the optional physical inventory scanner (sold separately)

3. Review your counts.

4. “Apply changes to inventory” is the action of accepting entered counts as the actual on-hand quantities.

Only One Workstation at a Time can Run Physical Inventory

When one workstation is working in a physical inventory, other workstations are blocked from performing the same activity.
Filtering the Physical Inventory Item List

In larger stores it may be advisable to break the process of conducting a physical inventory down into several phases, such as taking and entering counts by particular department, vendor, physical location, or some other logical grouping. Filtering your item list can make your job easier and save you time by organizing your data appropriately, especially if you are manually entering physical counts.

To filter the item list:

Choose one of the filters from the drop-down view list on the Physical Inventory window:

- **ALL ITEMS** if you want to view all inventory items.
- **COUNTED ONLY** if you want to view only the items for which you have already entered counts in the Counted field. (This is usually used to for reviewing entered counts before applying them to inventory.)
- **DIFFERENCES ONLY** if you want to view only the items for which the counted quantity was different from the expected on-hand quantity.
- **CREATE FILTER** if you wish to create and optionally save new filter criteria. You can restrict the view to a specific department, vendor, etc. Saving your filter adds it to the filter drop-down list for future use.
- **MANAGE FILTERS** to create or edit filters.
- **[Your custom name]** One of your previously saved filters.

Refer to Chapter 7 Lists, Forms and Filters (page 99) in Chapter 2 for detailed instructions.

Printing a Store Count Worksheet

If you intend to manually count your inventory, you can print a Store Count worksheet on which to record your counts. If conducting your physical inventory by department or other physical location, filter the Physical Inventory item list accordingly and print a separate worksheet for each area.

Before printing, you can modify the worksheet as you would modify any report. Columns can be moved, added, removed and sorted by. See Modifying Report Options (page 466) for more information.

To print a store count worksheet:

With the filtered list displayed in the Physical Inventory window:

1. Select RUN A REPORT ➤ PI WORKSHEET from the I Want To menu to be able to modify the worksheet as a report.
Select **PI WORKSHEET** from the Print menu to print the worksheet according to the currently applied filter in the list.

2. Select **PRINT**.

3. When done recording counts for an area, return to Point of Sale and transfer the counts to the Physical Inventory Count window as described below.

---

**Entering Physical Inventory Counts**

There are three ways to enter physical inventory counts:

- **Use the Add Counts option:** This speeds up the manual data entry process. You simply type in an item identifier (UPC, Alternate Lookup, or Item #) and a physical quantity. After each entry, the focus moves back to the **Item** field, so you can immediately make the next entry. When you are finished, multiple entries are consolidated.

- **Edit the Counted field:** For individual items on the Physical Inventory Count window. This is convenient for entering physical quantities for items that are grouped near each other, but it may be time consuming if the items are scattered throughout your store or item list.

- **Use the optional physical inventory scanner:** To scan bar codes and enter quantities, which can then be uploaded to Point of Sale.

You can use any combination of these methods to get your counts on the Physical Inventory Counts window. All counts entered on this window will be written to inventory when you apply the changes to your inventory.
Conducting Physical Inventory Counts

Entering Counts Using the Add Counts Window

To enter physical inventory counts using the Add Counts window:

1. From the I Want To menu in the Physical Inventory window, select **ADD COUNTS BY HAND**. The Add Counts window is displayed.

2. Select the preferred workflow in the **After pressing Enter key** area:
   - **QUANTITY FOR CURRENT ITEM** for most efficient data entry. After you enter an item identifier (UPC, Alternate Lookup, or Item #) the focus moves to the **Quantity** field so you can enter the item count.
   
   _Or_
   
   - **NEXT ITEM**, to list items with a default quantity of 1. After you enter an item identifier, focus returns to the **Enter Item** field.

3. Scan a bar code or enter an item identifier (UPC, Alternate Lookup, or Item #) and press `<ENTER>`. Audio and visual warnings are given if an unrecognizable identifier is entered.

   The program will search items in order of UPC, Alternate Lookup, and then Item #. The first match to the entry is listed, e.g. if you have item Alternate Lookup that matches an Item # an entry matching both will cause the item with the Alternate Lookup match to be listed.

4. If you selected **QUANTITY FOR CURRENT ITEM** in Step 2, enter a quantity and press `<ENTER>`. If the item quantity is zero (0), enter a zero. Only items with an entered quantity will be updated.

   If you selected **NEXT ITEM** in Step 2, the program enters a quantity of 1 for the item. You can edit this quantity later, after closing the Add Counts window. **Refer to the procedure for entering manual counts below.**
5. Repeat Steps 3 and 4 until you are finished entering all the items and their counts. To remove an item and its count, highlight the item and select DELETE ITEM.

6. Select SAVE. The Physical Inventory window is displayed again, with your counts entered in the Counted field for each item.

7. Review your counts, filtering the list as appropriate. The Totals area displays a summary for easy review before applying changes.

8. Proceed to the section titled Applying Changes to your Inventory (page 241) or make additional manual adjustments as described below.

**To enter counts in the Physical Inventory Count item list:**

1. Use sort, search, or filtering procedures to locate and display an item or group of items, as appropriate.

2. Enter a quantity in the Counted field for each item.
   If your item list shows an on-hand quantity, but none were counted, enter a zero (0) in the Counted field. Only items with an entry in the Counted field will be updated.

3. Proceed to the section titled Applying Changes to your Inventory (page 241).

---

**Multiple Units of Measure (Pro)**

If you are using multiple units of measure for your items and are manually entering counts, enter the number of base units. If you have entered an identifier for different units of measure, you can scan the identifier to have the correct quantity entered.
Conducting Physical Inventory Counts

Entering Counts with a Physical Inventory Scanner

Using a physical inventory scanner is an easy and efficient way to record and update your physical inventory. Since it is portable, you can move freely around your store, scanning the barcodes of your inventory items and entering counts. This option not only saves you time, but also helps to reduce counting and transfer errors.

The standard QuickBooks-approved physical inventory scanner allows you to scan thousands of units, allowing you to complete your scans for an entire department, aisle, or other physical location before stopping to upload data to Point of Sale. You can complete your physical inventory all at once or in a series of batches, depending on the size of your inventory.

After scanning/entering counts, return the unit to its base to upload the items to Point of Sale’s Physical Inventory window. You have the opportunity to review the retrieved item counts and resolve any errors before you apply them to inventory.

Basic Steps of Using the Physical Inventory Scanner

Each step is detailed in the following sections.

1. Scan your items and enter counts.
2. Upload the scanned data to Point of Sale.
3. Review the retrieved data for unrecognized scans.
4. Accept the scans to the Physical Inventory Count window.
5. Apply the counts to your inventory.
6. Clear scans from the physical inventory scanner, making it ready for the next scanning session.

Physical Inventory Scanner Navigation

The physical inventory scanner cradle is for storing and recharging your device while not in use, or when uploading data into Point of Sale.

- **ESC KEY**: Back out of a screen or go to main menu
- **ARROW KEYS**: Scroll through menu options or lists
- **ENTER KEYS**: Enter/select
- **ORANGE KEY**: Scan bar code
- **NUMBER KEYS**: Select menu options or enter data manually
• **FN/ALPHA (FUNCTION) KEY:** Hold in conjunction with a number key for specific actions

**Scanning Options**

There are two scanning options with the physical inventory scanner:

- Scan each and every unit of an item; the unit enters a quantity of one for each scan
- Scan one unit of an item, and then enter the counted number of units manually

With either mode, you can also manually key in an item’s UPC or item number; a useful feature if you don’t tag everything or if a bar code is unreadable.

**To scan each and every unit of an item:**

1. Turn the physical inventory scanner on.
2. From the main menu, select **COLLECT DATA**.
3. Select **SCAN BARCODE**.
4. Hold the physical inventory scanner at a slight angle so that you see the red reflection from the infrared light on the barcode.
5. Press the orange button to scan the item (or manually key in the UPC or item number and then press the Enter button).
   
   A beep confirms a successful scan and a quantity of “1” is assigned to each scan.
6. Repeat until all units have been scanned, for all items being counted.

**To scan one unit and enter the item count:**

1. Turn the physical inventory scanner on.
2. From the main menu, select **COLLECT DATA**.
3. Select **SCAN & ENTER QTY**.
4. Scan the bar code for one unit of an item.
5. Use the keypad to enter the total number of units of the scanned item.
6. Press either **Enter** button.
7. Repeat for all items being counted.

**To view, edit and/or delete a scan from the physical inventory scanner:**

1. From the main menu, select **UTILITIES**.
2. Select **BROWSE RECORDS**.
3. Use the arrow keys to scroll through the displayed scans.
   
   A typical scan will look something like this: 4680923459823, 6

   The character after the comma is the entered quantity.
Conducting Physical Inventory Counts

4. To edit a scan:
   a. Hold down the Function FN/ALPHA key on the bottom left of the keypad while pressing 8 to edit the selected scan.
   b. Edit the bar code number or quantity for the scan; use the arrow keys on the scanner to scroll between characters.
   c. When you have finished editing, press either Enter button to save.

5. To delete a scan:
   a. Hold down the FN/ALPHA key on the bottom left of the keypad while pressing 9 to delete the selected scan.
   b. Press 7. YES to delete or 9. NO to cancel.

6. Press 1. YES to confirm or 3. NO to cancel.
7. Repeat until done; then press ESC to return to the Main menu.

To clear scans from physical inventory scanner memory:

Use this procedure to clear the physical inventory scanner memory after accepting your scans to the Physical Inventory Count window and updating inventory and before starting another scanning session.

1. From the final screen in the Upload Scans window in Point of Sale, select CLEAR COUNTS FROM SCANNER.
2. Select NEXT.
3. When the memory has been cleared, select CLOSE.

Or

1. From the scanner main menu, select UTILITIES.
2. Press 3. CLEAR RECORDS.
3. Press 1. ALL to clear all scans from memory or 2. LAST COLLECTED to delete only the last scan.
4. Press 1. YES to confirm or 2. NO to cancel.
5. Press ESC to return to the main menu.

Clearing the Last Scan

Deleting the last scan removes the last item record entered, even if you have scanned an item and manually entered a quantity greater than “1”.

Uploading Scanned Data to Point of Sale

To upload scanned data:

1. Place the physical inventory scanner in its cradle (make sure the adapter is plugged into a USB port on your workstation) and turn it on.
The physical inventory scanner icon is displayed at the bottom right of your screen.

2. If the Physical Inventory window is not already open, select **START (or CONTINUE) PHYSICAL INVENTORY** from the Inventory menu.

3. From the I Want To menu, select **ADD COUNTS FROM SCANNER**.

4. Follow the on-screen instruction in Point of Sale to upload the scans.

When the upload is complete, the Get Scans window displays the number of valid scans (the Item Scans tab) and any unrecognized scans (listed on the Unrecognized Scans tab). You are prompted to **CLEAR SCANNER MEMORY**.

Uploaded scans are not added to the Start/Continue Physical Inventory window until they have been saved. See next section.

5. Clear scans or select **CLOSE**. You can now view your scans.

**Working with Uploaded Scans**

After your scans are uploaded from the physical inventory scanner, the Get Scans window is displayed and you can choose from the following tasks:

- View scanned items and select items to save into the Physical Inventory Count window
- View and print unrecognized scans

Unrecognized scans mean that either there was an error in the scan (unusual, but possible with a torn or marred tag) or that the item identifier you scanned does not exist in your Point of Sale inventory. For example, if you are scanning UPC bar codes, those UPC codes must be entered in the item records in inventory so that Point of Sale recognizes them when they are retrieved from the physical inventory scanner.

Refer to **Item Identifiers (page 166)** for more information about working with item numbers, UPCs, and Alternate Lookup identifiers.

**To view unrecognized scans:**

On the Get Scans window, select the **UNRECOGNIZED SCANS** tab. The unrecognized scans screen displays the scanned items not in inventory. To make these items easier to identify, the last item scanned before the unrecognized scan is displayed in green.

You can enter these counts manually later or correct the situation (bad tags or item identifiers not entered in inventory) and scan these items again in the next batch.
Conducting Physical Inventory Counts

To save uploaded scans to the Physical Inventory Count window:

1. Select the ITEM SCANS tab.
2. To accept all scans, choose SELECT ALL.
   
   Or
   
   To add just some of the uploaded items, select the checkbox next to those items.
3. Select SAVE.

Saving these counts will not update your inventory quantities. Refer to the next section for applying counts to inventory.

Applying Changes to your Inventory

Applying changes to your inventory replaces your current inventory on-hand counts with the counts you have entered on the Start/Continue Physical Inventory window.

It is strongly recommended that you review your entered counts for accuracy before applying them to your inventory. All items with a count entered (zero counts as an entry) are updated in inventory.

Important Note: Zero Quantities

You have two option for entering zero (0) counts in the COUNTED field for out of stock items so that they will be included in the physical inventory count.

- Enter zero (0) in the COUNTED field manually.

Select the SET ALL ITEMS NOT COUNTED TO ZERO checkbox. Warning! Selecting this checkbox will set ALL uncounted item quantities to zero when you apply changes to your physical inventory.

Saving and Returning Later

Once you have started entering information for your physical inventory count, you can pause and resume later by selecting SAVE & CONTINUE. You can later resume your Physical Inventory by selecting CONTINUE PHYSICAL INVENTORY from the Inventory menu.

If transactions occur which change item quantities for items already counted, these items will be flagged in the Physical Inventory window indicating a possible discrepancy that should be investigated before applying counts to your inventory.

If you have made errors after resuming, you can undo your additions by selecting REVERT TO LAST SAVE from the I Want To menu.
**Chapter 14: Inventory Counts and Adjustments**

---

**Starting Over**

If you have entered counts and wish to cancel them and start again, you can easily do so by selecting **CLEAR COUNTS AND RESTART** from the I Want To menu in the Physical Inventory window.

---

**To apply changes to your inventory:**

1. Set the filter to **ALL ITEMS**.

2. Select **APPLY CHANGES TO INVENTORY** from the bottom toolbar. A confirmation window is displayed.

3. Select **YES** to update inventory quantities. Select **NO** if you want to cancel the update.

4. You will receive a prompt which allows you to print reports if desired.

---

**Adjustment Memos Created**

Quantity adjustment memos are generated by Point of Sale, if necessary, when physical inventory counts are applied to inventory. “Physical” is listed as the memo’s **Reason**. If requiring logins, the current logged-in employee is entered as the **Associate** on the memo. If not using security, the **Associate** field is left blank.

*Refer to Adjusting Item Costs and Quantities (page 244) for more information about adjustment memos.*

---

**Reminder: Clear the Physical Inventory Scanner Memory**

After successfully applying counts to your inventory; if you have not already done so, you should clear the physical inventory scanner memory before scanning another batch.

Select **CLEAR MEMORY** from the Physical Inventory I Want To menu or follow the instructions in **Scanning Options (page 238)**.

---

**Store Count Reports**

Besides the Physical Inventory Worksheet, several reports are available from the I Want To menu in the Physical Inventory window.

**PI Detailed Report:** Shows all item counts.

**PI Difference Report:** Shows counts that are different from the expected quantity.
PI Detailed Report (Previous): Shows all item counts for a previous physical inventory count.

PI Difference Report (Previous): Shows counts that were different from the expected quantity for a previous physical inventory count.

Viewing or Reversing the Last Physical Inventory

To review the last physical inventory for errors, you can view the counts and, if necessary, undo the changes to your inventory from last physical inventory save.

To reverse the last physical inventory:
1. In the Physical Inventory window, select SHOW LAST PHYSICAL from the I Want To menu.
2. Select REVERSE PREVIOUS PI from the I Want To menu.
3. Confirm that you wish to reverse when prompted.
   If you do not wish to reverse the last PI at this point, select CANCEL. You can return to the display of your current PI by selecting SHOW CURRENT PHYSICAL from the I Want To menu.

Adjusting Item Costs and Quantities

Adjustment Memo Overview

Adjustment memos are Point of Sale transactional documents that track changes to inventory quantities and/or costs. The changes tracked are those that would not otherwise be recorded on another transactional document (vouchers, receipts, or transfer slips).

When you create an adjustment memo, the affected On-Hand Qty or Average Unit Cost fields are automatically updated in inventory and the memo serves as a permanent record of the change. Some actions in Point of Sale, such as deleting an item with a non-zero on-hand quantity, conducting a physical inventory, manually entering or editing item cost or quantity, and building or breaking assembly items, automatically create adjustment memos to update inventory.

Adjustment memos are stored in your adjustment history list. Saved adjustment memos cannot be edited, but they can be reversed to correct mistakes.
Typical uses for manually created adjustment memos include:

- Adjust quantity for theft and other shrinkage
- Adjust quantity for donated items
- Correct errors in inventory

QuickBooks Financial Software Users

Changes in inventory quantity and costs recorded on adjustment memos are aggregated and sent to QuickBooks financial software as General Journal transactions during routine Financial Exchanges. This keeps the inventory valuation in your financial software accurate and up-to-date. Refer to Adjustment Memo Overview (page 244) for more information.

Pro Multi-Store Users

Headquarters can create cost and quantity adjustment memos for all stores. Cost memos made at Headquarters affect item costs for all locations. Remote stores can manually create only quantity memos (although both quantity and cost memos are generated automatically at remote stores for certain activities). Refer to Chapter 32 Managing a Multi-Store Inventory (page 545) for more information.

Adjustment Memo Types

There are two types of adjustment memos: quantity and cost. Each type records changes to the specified value.

- A quantity adjustment memo records changes in item on-hand quantities (Pro Multi-Store: in a specific store)
- A cost adjustment memo records changes in item average unit cost

Accessing Adjustment Memos

To access adjustment memos:

Select one of the following choices from the Inventory menu:

- NEW QUANTITY MEMO
- NEW COST MEMO
- QUANTITY ADJUSTMENT HISTORY (list of saved quantity memos)
- COST ADJUSTMENT HISTORY (list of saved cost memos)
- HELD QUANTITY MEMOS (list of quantity memos created, but not yet saved, e.g., “on hold”)
- HELD COST MEMOS (list of cost memos created, but not saved, e.g., “on hold”)
Creating an Adjustment Memo

You can manually create memos as needed to adjust inventory values.

To create a memo:

1. From the Inventory menu, select the memo type: NEW QUANTITY MEMO or NEW COST MEMO.
2. List the items to be adjusted by entering or scanning the UPC, Alternate Lookup, or Item # or typing a search keyword in the Enter Item(s) field.

   Or

   Choose SELECT FROM ITEM LIST to view and select items from inventory.

   Refer to Listing Items on Documents (page 91) for detailed item listing procedures.

3. Enter the adjusted value in the appropriate column (New Qty or New Cost) for each item or select EDIT ITEM (<F5>) to open the Item Information window and enter new values there.

4. Enter information into other memo fields as appropriate for the adjustment. For details on each field, refer to Adjustment Memo Information Fields (page 652).

   An entry in the Reason field is required.

   • (Pro, on quantity memo) If you track item serial numbers, record the serial numbers for adjusted item quantities in the Serial # field. See Serial Number Tracking (Pro) (page 149) for more information.

   • (Pro Multi-Store; Headquarters) If you are creating a quantity memo for another store, select the store from the drop-down list in the Store field. This field defaults to Headquarters.

5. Select SAVE ONLY or SAVE & PRINT

A new adjustment memo can also be created by copying a previous memo. This feature is useful if the new memo is very similar to a memo in history. Refer to Working with Adjustment History (page 249) later in this chapter.

Tip: Changing the Quantities for a Large Number of Items (or a Style)

If you are adjusting quantities for a large number of items, using Physical Inventory may be a more efficient method than a quantity adjustment memo. In Physical Inventory, enter a new quantity in the Counted field for each item you want to change. Apply the counts from the Physical Inventory as usual and Point of Sale will generate the necessary adjustment memos.

Refer to Applying Changes to your Inventory (page 241) for more information.
Pro Tip: Changing the Quantities for a Large Number of Items (or a Style)

If you are changing the quantities for all items in a style, start a quantity adjustment memo as usual. Choose **SELECT FROM ITEM LIST** and display the style in the Style window. Enter the adjusted (new) quantities into the style grid. Choose **SAVE AND SELECT**. The style items and their adjusted quantities are carried to your adjustment memo.

---

### Notes on Old, New, and Difference Fields

Old, new, and difference fields for adjusted values are included in the item list on adjustment memos.

For example, on a cost adjustment memo, the **Old Cost** field shows the pre-adjustment average unit cost of an item. You enter the adjusted value in the **New Cost** field (decimal cost entry allowed, up to five decimal places, but only two displayed). The difference between the old and new cost is displayed in the **Diff Cost** field.

Likewise, on quantity adjustment memos, you have **On-Hand Qty**, **New Qty**, and **Diff Qty** fields.

<table>
<thead>
<tr>
<th>Item</th>
<th>Item Name</th>
<th>Attribute</th>
<th>Size</th>
<th>New Cost</th>
<th>Old Cost</th>
<th>Diff Cost</th>
<th>Current Qty</th>
<th>Emp Qty</th>
<th>All Item</th>
<th>Available Qty</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Downhill Ski</td>
<td>Red</td>
<td>200</td>
<td>$86.00</td>
<td>$100.00</td>
<td>$-4.00</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

Similar fields in the totals area of the memo (**Old Value**, **New Value** on cost memo, and **Old Qty**, **New Qty**, **Diff Qty** on quantity memo) summarize the total adjustment to inventory for all items included on the memo.

One more totals field, **Value Change**, is used on both memo types to show the dollar change in inventory value resulting from the memo. These totals fields cannot be edited.

---

Memo Fields

For a list of Memo fields, refer to [Adjustment Memo Information Fields](#) (page 652).

---

### Actions that Generate Adjustment Memos

The actions below will result in adjustment memos being created. Some tasks result in system-generated memos, in these cases you may be prompted for your name and a reason but the memo is automatically created. The **Source** and **Type** columns refer to the entries recorded in the corresponding fields in the adjustment memo header.
Adjusting Item Costs and Quantities

### Canceling or Holding a Memo in Progress

You can cancel (discard) a memo anytime before updating it. If you want to return to the memo later to complete it, you can put it on hold. While the memo is on hold, you can carry out other activities, make other memos, or even exit from Point of Sale. Holding a memo does not affect inventory quantities or costs. Later, you can un-hold the memo and complete it.

**To cancel the creation of a memo:**
1. From the bottom toolbar, select **CANCEL (<Esc>)**.
2. In the dialog displayed, select **YES**.

**To place a memo on hold:**

Select **HOLD <TYPE> MEMO** from the bottom toolbar.

**To un-hold a memo:**
1. Select **HELD QUANTITY MEMOS** or **HELD COST MEMOS** from the Inventory menu.

A list of held memos of the type selected is displayed.

---

<table>
<thead>
<tr>
<th>Action</th>
<th>Who Creates Memo</th>
<th>Reason</th>
<th>Source</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually creating a memo</td>
<td>User</td>
<td>User Defined or selected (Damaged, Shrinkage, etc.)</td>
<td>Manual</td>
<td>Quantity or Cost</td>
</tr>
<tr>
<td>Reversing a memo</td>
<td>Point of Sale</td>
<td>ManAdj</td>
<td>Reverse</td>
<td>Quantity or Cost</td>
</tr>
<tr>
<td>Deleting an item with a non-zero quantity on hand in inventory.</td>
<td>Point of Sale</td>
<td>User Defined or selected (Damaged, Shrinkage, etc.)</td>
<td>Inventory</td>
<td>Quantity</td>
</tr>
<tr>
<td>Applying item counts in a Physical Inventory</td>
<td>Point of Sale</td>
<td>Physical</td>
<td>Physical Inventory</td>
<td>Quantity</td>
</tr>
<tr>
<td>Manually entering quantity or cost in inventory</td>
<td>Point of Sale</td>
<td>ManAdj</td>
<td>Inventory</td>
<td>Quantity or Cost</td>
</tr>
<tr>
<td>Building an Assembly Item</td>
<td>Point of Sale</td>
<td>CreatAsm</td>
<td>Assembly</td>
<td>Quantity or Cost</td>
</tr>
<tr>
<td>Breaking an Assembly Item</td>
<td>Point of Sale</td>
<td>Brk Asm</td>
<td>Assembly</td>
<td>Quantity or Cost</td>
</tr>
</tbody>
</table>
2. Highlight or display the memo you want from the list, then select **UNHOLD <TYPE> MEMO**.

   To leave the held memo list without un-holding a memo, select **CLOSE**.

### Working with Adjustment History

Memos are stored in your adjustment history lists, one each for quantity and cost memos. Adjustment history provides a record of the changes to inventory that are not recorded in sales, receiving, or transfer history.

### Locating an Adjustment Memo

There are a number of ways to view and locate a specific memo in your adjustment history lists. You can filter the list, sort and jump to a record, scroll, or search by keyword. These procedures are summarized here. Refer to Chapter 7 Lists, Forms and Filters (page 99) for detailed instructions on each procedure.

#### To filter your memo lists:

1. Display either the quantity or cost adjustment history.
2. Select one of the following from the drop-down filter list at the top of the window:
   - A predefined filter (such as **LAST MONTH**, **LAST 90 DAYS**, etc.).
   - A previously defined and saved custom filter (your custom name).
   - **CREATE FILTER** to enter new filter criteria, and optionally save it for future use.
   - **MANAGE FILTERS** to edit, rename, delete, or rearrange the order of your previously saved filter views.

   If you select a predefined or previously saved filter, the following step does not apply.
3. Review and/or enter criteria values in any of the available fields and then select **APPLY** or **SAVE**. Enter a name for your filter if saving.

   Your list is filtered by your selected criteria.

#### To find a memo by sorting or scrolling:

1. Select the column by which you want to sort the list by clicking or touching the header of the column.
2. Immediately begin typing the first few characters of the column entry you wish to locate. The characters you type are not displayed, but the closest matching record to what you typed is highlighted.
Adjusting Item Costs and Quantities

Or

Use the vertical scroll bar to scroll through your list. The scrolling indicator displays your progress as you move through the list. Release the mouse button when the value you are looking for is displayed.

To search for a memo:

1. Display your adjustment history list and the select FIND <TYPE> MEMO (<F3>) from the window toolbar.
2. Enter the keyword or keywords by which you want to search.
   • On the Find window, optionally select ADVANCED FIND to narrow your search to a specific memo field or to specify other search criteria.
3. Select FIND (<ENTER>) to begin the search.
   All matching adjustment memos are displayed.
4. Select a memo to work with and choose SELECT <TYPE> MEMO.

Copying an Adjustment Memo

To copy an adjustment memo

Copying a prior adjustment memo may be the quickest way to create a new memo.

1. Highlight or display the memo that you want to copy.
2. Select COPY. The program will open a new adjustment memo in the form window containing the same information as the memo from which the information was copied.
3. Make edits as needed in any of the fields.
4. Select SAVE & PRINT.

Reversing an Adjustment Memo

Saved adjustment memos are records that cannot be edited. To undo an error made on an adjustment, you must reverse the memo. The original memo can then be copied and the copy used to create a new, corrected adjustment memo.

• Reversing a quantity adjustment memo reverses the change in quantity made by the original memo. If the original memo removed three of an item from inventory, the reversal will return three units to inventory. It does not restore inventory to the OLD QTY recorded on the original memo because other documents affecting inventory quantities may have been recorded in the interim.
• Reversing a cost adjustment memo creates a new memo that reverses the total value adjustment of the original memo and adjusts the current average unit cost in inventory for each listed item.

When completed, the original adjustment memo will be marked *Reversed* in the **Status** field. The new memo that is created to reverse the original will be marked *Reverse* in its **Source** field and *Reversing* in the **Status** field.

**To reverse an adjustment memo:**

1. Highlight or display the memo that you want to reverse.
2. From the I Want To menu, select **REVERSE MEMO**.
3. Confirm your name in the dialog displayed and select **OK**.

A reversing memo is created and placed in your adjustment history list. If necessary, a corrected adjustment memo can then be created from the original using standard copy procedures. Refer to **Copying an Adjustment Memo (page 250)**.

(Pro Multi-Store) A remote store can only reverse an adjustment memo up until the time it has been sent to Headquarters. After that time, the memo can still be reversed at Headquarters. In the case of a quantity adjustment memo, a remote store can also create a new memo adjusting the quantity back to the original value to undo the effects of the original.

---

**Effects of Reversing an Adjustment Memo**

Reversing a memo does not alter or remove the original memo (other than marking its **Status** as *Reversed*); instead it creates a new adjustment memo that has the opposite effect.

---

**Printing Adjustment Memos**

Memos are automatically printed when you select **SAVE & PRINT** to complete the memo. You can also reprint memos.

1. Use normal sort, search, or filter procedures to locate and highlight the memo in your Adjustment History.
2. From the bottom toolbar, select **REPRINT MEMO**.
3. If presented with a print option dialog, you can:
   • Change the printer you want to use, if necessary.
   • Specify a print quantity.
   • Select **PREVIEW** or **PRINT**.

Refer to **Chapter 3 General Printing Information (page 39)** for more information about printing and print options.
Section IV: Vendors and Purchasing

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 15</td>
<td>Vendors</td>
<td>253</td>
</tr>
<tr>
<td>Chapter 16</td>
<td>Purchasing Merchandise</td>
<td>265</td>
</tr>
<tr>
<td>Chapter 17</td>
<td>Receiving Merchandise</td>
<td>281</td>
</tr>
</tbody>
</table>
## Vendors

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Vendors</td>
<td>254</td>
</tr>
<tr>
<td>Adding a New Vendor</td>
<td>254</td>
</tr>
<tr>
<td>Locating a Vendor Record</td>
<td>255</td>
</tr>
<tr>
<td>Editing a Vendor Record</td>
<td>256</td>
</tr>
<tr>
<td>Making a Vendor Inactive</td>
<td>257</td>
</tr>
<tr>
<td>Deleting a Vendor Record</td>
<td>258</td>
</tr>
<tr>
<td>Merging Vendor Records</td>
<td>258</td>
</tr>
<tr>
<td>Vendor Payment Terms</td>
<td>260</td>
</tr>
<tr>
<td>Viewing a Vendor’s History</td>
<td>260</td>
</tr>
<tr>
<td>Printing/Exporting your Vendor List</td>
<td>262</td>
</tr>
<tr>
<td>Using Multiple Vendors for an Item (Pro)</td>
<td>263</td>
</tr>
</tbody>
</table>
Working with Vendors

Each vendor from whom you purchase merchandise should be added to your vendor list. A vendor entry is required on purchase orders and receiving vouchers. When you associate vendors with items in inventory and list them on purchasing documents, Point of Sale can track and report the merchandise by vendor as it is ordered, received, and sold.

The receiving history for a vendor can be instantly displayed at anytime and provides summarized statistical data of the purchases and returns you have made for the vendor, as well as listings of all receiving vouchers and non-deleted purchase orders.

Importing Vendors from QuickBooks Financial Software

If you had active vendor records in QuickBooks financial software when you began using Point of Sale, they were imported and added to your Point of Sale vendor list. You should review and edit vendor records as appropriate and complete other fields to fit your needs. Also, be aware that new vendor names created in Point of Sale should not duplicate a name already in your financial software vendor, customer, employee, or "other name" lists.

Refer to Reviewing Data Imported from QuickBooks (page 122) for more information.

Importing Vendor or Updating Vendor Information

You can use the Data Import Wizard to import vendor item catalogs, vendors, or updated information about your vendors or items from an Excel spreadsheet or from a text file. Refer to The Data Import Wizard (page 124) for more information.

Adding a New Vendor

To add a new vendor:

1. From the Purchasing menu, select NEW VENDOR. A blank vendor form is opened.
2. Enter vendor information in the fields. COMPANY is the only required field.
If you do not want this vendor to be sent to QuickBooks, select the **INACTIVE** checkbox. Refer to Appendix B Information Fields (page 643) for information about each field.

3. Select **SAVE**.

**Using Copy to Add a Vendor Record**

If an existing vendor is similar to one you want to add, simply copy the existing vendor and edit the fields to reflect the new vendor information.

**To copy a vendor record:**

1. Highlight or display an existing vendor record and select **COPY**. All the information from the original vendor, except the **QB Status** field, is copied to a new record.
2. Edit the fields to reflect the new vendor information.
   You must assign a unique **COMPANY** name.
3. Select **SAVE**.

**Locating a Vendor Record**

You can locate a specific record in your vendor list by sorting, scrolling, filtering, or searching by keyword. Each method is summarized below.

Refer to Chapter 7 Lists, Forms and Filters (page 99) for more information about each method.

**To find a vendor record by sorting or scrolling:**

1. Select the column by which you want to sort the list by clicking or touching the header of the column.
2. Immediately begin typing the first few characters of the column entry you wish to locate. The characters you type are not displayed, but the closest matching record to what you typed is highlighted.

   Or

   Use the vertical scroll bar to scroll through your list. The scrolling indicator displays your progress as you move through the list. Release the mouse button when the value you are looking for is displayed.
To filter your vendor list:

1. Display your vendor list.
2. Select a filter option from the View drop-down at the top of the list:
   - **ALL VENDORS** displays your full vendor list (default)
   - **ACTIVE VENDORS** displays all vendors except those that have been flagged as inactive
   - A previously memorized filter (your custom name displayed)
   - **CREATE FILTER** to define new filter criteria
   - **MANAGE FILTER VIEWS** allows you to edit previously memorized filters
   The first three choices immediately display your filtered vendor list, and the next step does not apply.
3. Enter or edit filter criteria as necessary and then select **APPLY**. Your vendor records are filtered and displayed accordingly.
   If defining new criteria and you want to memorize it for future use, select **SAVE** before selecting **APPLY**.

To search for a vendor:

The Search feature allows you to search across multiple fields, not just the sorted column.

1. From your vendor list, select **FIND** (<CTRL+F>) from the window toolbar.
2. Enter a keyword by which you want to search.
3. Optionally, select **ADVANCED FIND OPTIONS** and select a specific field in which the search is to be conducted or specify other search options. Select **HELP** in the Find window for more information on search fields.
4. Select **FIND** or press <ENTER>.
   All vendors matching your search criteria are displayed in the Find window; you can then select a vendor to work with, return to the full vendor list, or start a new vendor record.

**Editing a Vendor Record**

**To edit a vendor record:**

1. Highlight the vendor record in your vendor list.
2. Select **EDIT**.
3. Modify the vendor fields, as needed. Read the warning below about editing vendor names.
4. Select **SAVE**.
Working with Vendors

If you want to edit multiple vendor records right in the vendor list, select **TURN LIST EDIT ON** from the Edit menu. Navigate field-to-field within the vendor list to edit. Your changes are saved as you navigate out of a row. Select **EDIT ➤ TURN LIST EDIT OFF** when finished.

⚠️ **Warning: Changing a Vendor Name**

Changing a vendor name in the vendor record has no effect on inventory or your receiving history. However, if you change a vendor name, you should update item records for that vendor. In inventory, edit the **Vendor Name** field for each item you purchase from the vendor. Refer to **Editing an Item** (page 176) for more information.

---

**Making a Vendor Inactive**

Vendors in Point of Sale can be flagged as inactive, in which case they are not displayed when you filter your vendor list for active vendors.

This allows you to flag utilities and miscellaneous vendors (which may have been imported from QuickBooks financial software) or any other vendor not currently used in Point of Sale as inactive, so they do not clutter your active vendor list display.

**To make a vendor inactive:**

- Select the **INACTIVE** checkbox on the vendor record. To make the vendor active again, clear the checkbox.

**To view inactive vendors:**

- Filter your vendor list selecting the **ALL VENDORS** filter or create a custom filter to display only inactive vendors.

⚠️ **Inactive Vendors and Financial Exchange**

Inactive vendors are not exchanged with QuickBooks financial software. However, if you make a voucher for an inactive vendor, the vendor is sent to your financial software with the voucher. From that point on, the vendor is shared unless set to inactive again in both programs.
Deleting a Vendor Record

Vendors can be deleted from Point of Sale at any time.

If you delete a vendor, you will no longer have access to that vendor’s history, but the vendor will remain listed on order and history documents and can be included in reports that are generated from those documents.

If you are deleting a vendor because you have a duplicate, consider using the Merging Vendor Records (page 258) procedure instead, as this will combine the two vendor histories into one record and remove the other.

To delete a vendor record:
1. Highlight or display the vendor record that you want to delete.
2. Select DELETE.
3. If prompted, indicate if you want to delete the vendor from QuickBooks financial software as well.

Merging Vendor Records

Occasionally, you may end up with two records for the same vendor. This would most likely happen by entering the vendor twice with slightly different spellings of the name. The Merge Vendors feature can be used to combine the receiving history of the duplicate vendors into a single record and then delete the other. Merging vendors cannot be undone, you may wish to back up your company file before merging.

If you also use QuickBooks financial software, you have the option of deleting or making inactive the duplicate vendor in your financial software so that it is not re-created in Point of Sale on the next data exchange.

To merge duplicate vendors:
1. In your Point of Sale vendor list, select the two vendor records you wish to merge.
2. Select MERGE VENDORS from the I Want To menu.
The Merge Vendors window is displayed.

3. Make sure that the vendors displayed in the Merge Vendors window are correct. The vendor to keep should be listed under “Keep this vendor,” and the vendor record that will be removed should be listed under “Remove this duplicate.” If you use QuickBooks financial software, the name currently displayed in your financial software vendor list is shown at the bottom of the window to help you verify you have the correct vendors selected.

If necessary, you can reverse positions of the vendors (which to keep and which to remove) by selecting the **SWAP** button located between them. You can use the drop-down list to navigate to other vendors if one or both of the displayed vendors is wrong.

4. Select **MERGE VENDORS**.

A confirmation dialog is displayed if either vendor record is listed on a voucher or purchase order, showing the various documents and records that will be affected by the merge.

5. Select **MERGE VENDORS**.
6. If prompted, specify if you want to delete the duplicate from your financial software as well. The deletion in your financial software will occur with the next Financial Exchange.

### Deleting QuickBooks Financial Software Vendors

If the vendor to be deleted is listed on any QuickBooks financial software documents, your financial software will not allow the deletion. In this case the vendor is made inactive in your financial software so that it is not re-created in Point of Sale on the next Financial Exchange.

### Vendor Payment Terms

In the Terms field of the vendor record, you can specify default payment terms that are then suggested when you create purchase orders and vouchers for the vendor.

If exchanging data with QuickBooks financial software and vendors were imported, the Terms field is populated with the default terms from your financial software. If you edit the default terms in either program, they are sent to the other and become the new default terms in both.

You can edit the terms on individual purchase orders as you create them. Refer to [Vendor Terms on Purchase Orders (page 272)] for more information.

#### To define default terms for a vendor:

1. Display the vendor record.
2. Select the button (<F4>) adjacent to the Terms field. The Terms dialog is displayed.
3. Enter term information in the three fields. The entries shown here would result in terms of \[5\% \text{ } 10 \text{ Net } 30\] being suggested on documents.
4. Select OK.

### Viewing a Vendor’s History

Vendor history allows you to view summarized statistical data for the merchandise you have purchased from or returned to the vendor, as well as displaying a list of vouchers and non-deleted purchase orders.
To access vendor history:

1. Highlight a vendor record in the list
2. Select COLLAPSE to access the Vendor Information Panel which displays the vendor history.

Or

View the vendor form and select the HISTORY tab.

Drilling-Down With QuickZoom

You can "drill-down" into a vendor's history to see document item detail or to view the entire document in a separate window. Select the + sign on a line to expand the document and view item detail. When the QuickZoom icon is displayed, click to open the document.

To view or copy a voucher or purchase order:

1. Highlight a document on the Vendor History window.
2. Use QuickZoom as described in the tip above to display the document or select GO TO DOCUMENT from the I Want To menu.

   With the document displayed, you can copy, edit (subject to normal editing guidelines), or reverse it as needed.

If you have a voucher or purchase order window open when you come to Vendor History, you will have to switch back to the open document window and cancel or complete it before you can copy from history to another new document of the same type. Only one of any document type can be open at a time.
Notes about vendor history:

- Press `<F5>` to refresh the vendor’s history, if necessary (e.g. documents are created while viewing).
- You cannot edit the information displayed on the Vendor History window.
- You can drag-and-drop column headers or separators to rearrange and resize columns respectively.
- If you delete purchase orders once they are filled, the deleted purchase orders are no longer displayed on the Vendor History window, and their information is not included in the summarized statistical information. However, the receipt of the merchandise on deleted purchase orders is reflected in the receiving vouchers and receiving information in the window.
- (Pro Multi-Store) Remote stores can only view receiving vouchers and purchase orders created for the vendor at the local store.

Refer to Chapter 17 Receiving Merchandise (page 281) for more information about working with receiving vouchers.

Printing/Exporting your Vendor List

Refer to Chapter 3 General Printing Information (page 39) for printing instructions to print your vendor list.

See Exporting a List to Excel (page 127) for detailed information on exporting your vendor list.

Vendor List Reports

You can print your vendor list using Point of Sale reports, which gives you more freedom to customize the list for your particular needs. Refer to Chapter 26 Reports and Sales Charts (page 459) for more information.
Point of Sale allows you to track up to five separate vendors for any inventory item, each with a unique UPC, Alternate Lookup, and order cost. This allows you to purchase the same item from any of several vendors as availability and costs dictate.

**To use the multiple vendor feature:**

1. Add each vendor in the normal manner.
2. Define the item in inventory in the normal manner, entering your most-used (preferred) vendor in the **Vendor** field on the **Item Info** tab of the item record.
3. Enter the **UPC**, **Alternate Lookup**, and **Order Cost** for the preferred vendor.
4. On the **Additional Info** tab, select **ADD/EDIT ALTERNATE VENDORS**.
5. In the dialog displayed, enter information for up to four alternate vendors. Leave the **UPC** and **Alternate Lookup** fields blank if they are the same as those for the primary vendor.

Averaged inventory cost, on-hand quantities, and prices are combined for an item once received into inventory, no matter how many vendors the item may have been purchased from. However, reports showing merchandise on order, on hand, or received, if filtered by vendor, are broken down by each vendor from which you have purchased an item.

When you are creating purchase orders or receiving vouchers, enter any of your vendors. You can then list the items to be purchased using the specific vendor’s **UPC** or **Alternate Lookup** values. The appropriate order cost will be suggested on the document for the vendor entered.

When creating other document types, scanning or entering any of the defined **UPCs** or **Alternate Lookups** for the item will list the item on the document.

---

**Printing Tags with Alternate Vendor UPC**

If you are using multiple vendors and you wish to print tags with the UPC for an alternate vendor, you must print tags from either a purchase order or voucher for that vendor.
Purchase Order Overview

When merchants need to restock or add new merchandise, they create and send documents called *purchase orders* (POs) to vendors. A PO typically includes the following information:

- The vendor’s name
- Order, shipping, and cancel dates
- A list of the items to be ordered and information about those items, including description, cost, and the quantity ordered
- The total cost of the order, including discounts and fees
- Optionally, terms of payment and payment due date (for tracking purposes)
- A summary of the purchase order fill status (what has been received and what has not)

The merchandise ordered on a purchase order is added to inventory when the merchandise has been physically received and recorded on a receiving voucher that references the purchase order. When a purchase order has been filled or cancelled, it can safely be deleted. Receiving vouchers provide the permanent record of the items purchased.

(Pro Multi-Store) Purchase orders are typically created only at the Headquarters and sent to remote stores. The exception to this rule is that remote stores can generate purchase orders from a customer order to order special order items from vendors. Remote stores receive the purchase orders created at Headquarters for merchandise destined for their store and can reference those POs to create receiving vouchers.

Point of Sale provides various purchasing and receiving reports. See Chapter 26 Reports and Sales Charts (page 459) for more information on reports in Point of Sale.

Purchase Orders Not Exchanged with QuickBooks Financial Software

Purchase orders are not exchanged between Point of Sale and QuickBooks financial software. If you have existing purchase orders in your financial software that you want to track in Point of Sale, you must enter them manually. It is strongly recommended that after integrating with your financial software that you only create new purchase orders in Point of Sale, unless you intend to track an item completely within your financial software. Refer to Section VII of this manual for a discussion about tracking items in QuickBooks financial software.

Maintaining Accurate Vendor Histories

Do not mix items from different vendors on purchase orders or receiving vouchers if you want to maintain accurate vendor histories and be able to run meaningful vendor reports.
Working with Purchase Orders

Accessing Purchase Orders

From the Purchasing menu, select:

- **PURCHASE ORDER LIST** to view existing purchase orders
- **NEW PURCHASE ORDER** to create an order for merchandise from your vendor(s)
- **(Pro) SUGGEST PO** to have Point of Sale recommend purchase order quantities for items that have fallen below their reorder point

Using Reorder Point Reminders

You can define a reorder quantity (**Reorder Point** field) for your inventory items. When item quantities fall to or below the reorder point, the Reminders feature will alert you. This option can help you identify those items you need to order from your vendors. See **Using Item Reorder Points** (page 182) for more information about defining your reorder points.

**WARNING**

- (Pro) Preferences: Reorder Reminder Preferences

PREFERENCES ➤ COMPANY ➤ INVENTORY ➤ Create order reminders based on:

Choose **ON-HAND QUANTITY** or **AVAILABLE QUANTITY**. Point of Sale will use the specified quantity to determine when reorder reminders are displayed. Refer to **Available Quantities (Pro)** (page 188) to learn more about tracking available quantities in Point of Sale.

**To view the Reorder Items Reminders:**

1. From the Inventory menu, select **REMINDERS**.
2. Select the **REORDER ITEMS** tab.

(Pro) Point of Sale can suggest and generate purchase orders for these items. Refer to **Having Point of Sale Suggest Purchase Orders (Pro)** (page 279) later in this chapter.
Basic Steps to Create a Purchase Order

The following procedure explains the basic steps for creating a new purchase order. Specific instructions for each step are covered in the following sections, as necessary.

1. From the Purchasing menu, select NEW PURCHASE ORDER
2. Accept the suggested PO # (sequential order) or enter a unique alphanumeric number of your own
3. Enter a vendor in the Vendor field
   - Select a vendor from the drop-down list, choose the FIND VENDOR icon to search for a vendor, or press <F4> to go to your vendor list and locate a vendor.
   - When the vendor is listed, the default payment terms you have defined in the vendor record are suggested on the PO.
   - (Pro) If you order the same item(s) from multiple vendors you can list any of the item’s vendors on the PO.
     Refer to Using Multiple Vendors for an Item (Pro) (page 263) for more information on using multiple vendors for items.
4. Enter or edit the Order, Ship, and Cancel dates. Refer to the following section for more information on how these dates are used.
5. List the items you want to order, entering the order quantity and changing the cost, if necessary, for each item selected.
   The various methods for listing items on purchase orders are discussed later in this chapter. The purchase order Cost is suggested as the Order Cost of the item from inventory, but can be edited as necessary.

6. Enter instructions, discounts and/or fees that will apply to the order.
7. Select SAVE
(Pro) Creating Purchase Orders from Customer Orders

A purchase order can be created from a customer order for out-of-stock or special order items. Refer to Generating Purchase Orders from Customer Orders (page 424) for more information.

Working with Purchase Order Items

Listing Items on a Purchase Order

This procedure is summarized here. See Listing Items on Documents (page 91) for detailed instructions.

To list items on a purchase order:

With the cursor in the Enter Item(s) field, use any of these procedures:

• Enter or scan the UPC, Alternate Lookup, or Item #, and press <ENTER>
  If a single item match is located, it is immediately listed on the document with a quantity of one (1). If multiple matches are found, the Find window is displayed with all item matches.

• Enter an item description search keyword. As you type, the drop-down list of your items is displayed with the closest match highlighted. Select an item.

• Choose SELECT FROM ITEM LIST (<F4>) to go to your full item list and locate items.

  Use standard filter, search, or sort procedures to locate the item(s) you wish to list, and then return them to the purchase order by:
  ■ To quickly list a single item, with an order quantity of one and at the current order cost, double-click the item.
  ■ To list multiple items, enter the order quantity for each in the Doc Qty column and if needed, a new order cost in the Doc Cost column. When done, choose SELECT from the bottom toolbar.
  ■ (Pro) If you are ordering several members of the same style, switch to the Style window enter order quantities in the individual cells of the style grid. When done, choose SELECT from the bottom toolbar. The items are
To add and order a new inventory item while creating a purchase order:

Use this procedure to add a new item to inventory while also creating a purchase order to order the item from your vendor.

1. Select **ADD NEW** from the drop-down item list in the purchase order **Enter Item(s)** field. A blank new item form is opened.

2. Enter information to define the item.
   - Enter an **Order Cost**, but leave the **Average Unit Cost** and **On-Hand Quantity** fields empty. The voucher made when receiving the item(s) will update these fields.
   
   Refer to **Adding Inventory Items** (page 164) for more information.

3. Choose **SAVE AND SELECT** to save the item and list it on the purchase order with a quantity of one (1) and the order cost you defined.

4. If necessary, edit the order quantity and order cost on the purchase order as described in **Editing Listed Items** (page 271).

5. Save and/or print the purchase order.

(Pro) Adding a New Style While Creating a Purchase Order

To add a style while making a purchase order, select **EDIT/ADD STYLE** after Step 2 above. Define the style attributes as needed and then enter **order** quantities in the style grid. Remember that these are **order** quantities you are entering, not **on-hand** quantities. Only style items for which you enter an order quantity are created in inventory. Choose **SAVE AND SELECT** to save the style in inventory and bring the specified order quantities back to the purchase order.

(Pro) Creating and Ordering a Special Order Item

You can create special order items from a purchase order to order custom or one-time items that you do not plan to carry in inventory as regular new items. Refer to **Listing Special Order Items on Documents** (page 95) for more information.

Tip: Using Filtered View in Inventory to Display a Single Vendor's Items

When selecting items from inventory, you may find it helpful to filter your item list to display only items from the current vendor. Saving the filtered view adds it to the item list filters for future use. Select **CREATE FILTER** from the filter view drop-down list, select the vendor and then select **SAVE**.

added to the PO at the current order cost. You can edit the order cost on the purchase order if necessary.
Working with Purchase Orders

Editing Listed Items

If additional changes in quantity or order cost are required on listed items, highlight an item and select EDIT ITEM (<F5>). Make the necessary changes in the Item Information window and then choose OK (<F5>) to close. Alternatively, navigate to the relevant fields in the item list and make changes directly there.

Deleting Purchase Order Items

To delete a listed item from a purchase order:

1. Highlight the item you want to delete.
2. Select REMOVE ITEM.
(Pro) If you generated the purchase order from a customer order, the items on the purchase order cannot be deleted.

Marking Items as Un-orderable

If you or a vendor discontinues an item, or you want to temporarily suspend ordering a seasonal item, you should flag the item as UNORDERABLE in inventory. The item will no longer be added to your reorder reminders list and if you try to list the item on a new purchase order you will be alerted but can proceed at your discretion. Un-orderable items can still be received, sold, transferred, etc.

Refer to Flagging an Item as Un-orderable (page 183) for more information.

Order Cost on Purchase Orders

A purchase order is a document that asks a vendor to deliver goods at a certain cost. When listing items on a purchase order, Point of Sale will suggest the item Order Cost from inventory as the cost on the purchase order. You can change the cost on the purchase order by manually editing it. This does not affect the Order Cost assigned in inventory.

If entering a unit cost with more than two decimal places (up to five decimal places can be entered), the extended cost (quantity times unit cost) is calculated using all of the decimals entered, but then rounded to two decimal places for display purposes. You can also enter the quantity and extended cost and Point of Sale will calculate the appropriate unit cost with up to five decimal places stored (though only two will be displayed). This feature makes it easier to order, price, and track items whose cost or price is in fractional cents or less than a penny.
When a receiving voucher is made referencing the purchase order, the cost entered on the purchase order, including decimals, will be carried to the voucher. When the receiving voucher is saved, the inventory Average Unit Cost and Order Cost will automatically be updated to reflect the change in the item cost. If applicable, the stored decimals are used for all program calculations.

(Pro) Refer to Using Multiple Vendors for an Item (Pro) (page 263) for more information on handling order cost for multiple vendors.

**Vendor Terms on Purchase Orders**

When you create a purchase order, the default vendor terms from the vendor’s record are suggested on the purchase order. If the terms for this order are to be different than the default terms, you can edit the terms by selecting the icon adjacent to the Terms field.

The net due days specified in the purchase order terms are added to the Ship Date to arrive at the Payment Due Date displayed on the purchase order. This date is for reference and can be used for tracking payment in Point of Sale purchasing reports.

When you create a receiving voucher that references a purchase order, the terms recorded on the purchase order are carried to the voucher.

**Purchase Order Discounts and Fees**

Sometimes vendors will offer discounts or charge a miscellaneous fee on merchandise. You can add a discount and/or a fee in the totals area at the bottom of the purchase order.

**To enter a discount or fee on a purchase order:**

1. Enter a discount in the Discount (amount) or Disc % fields. When you make an entry in one field, Point of Sale automatically recalculates the other.

   **And/Or**

   Enter a fee amount in the Fee field.

2. Select SAVE.

Note that discounts entered on a purchase order are proportionally carried to receiving vouchers that reference the purchase order. For example, if a purchase order has a discount totalling $50.00 and you receive only half (calculated by value) of the ordered items on a voucher, then $25.00 of the discount is applied to that voucher.
Maintaining Purchase Orders

The remaining discount amount will be carried to subsequent vouchers that receive the remaining due items.

When a receiving voucher references a purchase order with a fee entered, you are alerted and can transfer the fee to the voucher at your discretion. This is because fees may not be related to the value of ordered/received items, and may need to be applied differently if a partial shipment is received. Transferring a fee to vouchers that reference the purchase order is at your discretion.

Optionally, the discounts and fees carried to a receiving voucher can be spread over the costs of individual purchased items. Refer to Voucher Discounts, Freight, and Fees (page 289) for more information on spreading discounts and fees.

E-mailing Purchase Orders to Your Vendors

You can e-mail your purchase orders to your vendors from within Point of Sale.

You must have the vendor’s e-mail address entered on their Point of Sale record. With the purchase order selected (list) or displayed (form), select E-MAIL from the window toolbar. An e-mail will be automatically created with the purchase order attached. Use normal procedures to review and send the e-mail.

Refer to E-Mailing Documents (page 126) for more information.

Maintaining Purchase Orders

After saving, purchase orders are stored in your purchase order list. Since purchase orders are planning documents with no direct effect on inventory, they can be edited or deleted at anytime. The items ordered on a purchase order can be quickly transferred to a receiving voucher when the merchandise arrives at your store.

Locating a Purchase Order

There are a number of ways to locate a specific purchase order in your purchase order list. You can filter the list, resort and jump to a record, scroll, or search by keyword. These procedures are summarized here. Refer to Chapter 7 Lists, Forms and Filters (page 99) for detailed instructions on each method.
To filter your purchase order list:

1. Display your purchase order list, and then select one of the following from the drop-down filter list at the top of the window:
   - A predefined filter (such as **OPEN PURCHASE ORDERS**, **ALL PURCHASE ORDERS**, or **THIS MONTH**). This choice immediately filters your list, displaying only the matching records.
   - A previously defined and saved custom filter (your custom name).
   - **CREATE FILTER** to enter new filter criteria, and optionally save it.
   - **MANAGE FILTERS** to edit, rename, delete, or rearrange the order of your previously saved filter views.

2. If you selected **CREATE FILTER**, enter criteria values in any of the available fields and then select **APPLY** or **SAVE**.
   Your list is filtered by your selected criteria.

To find a purchase order by sorting or scrolling:

1. Select the column by which you want to sort the list by clicking or touching the header of the column.

2. Immediately begin typing the first few characters of the column entry you wish to locate. The characters you type are not displayed, but the closest matching record to what you typed is highlighted.

   Or

   Use the vertical scroll bar to scroll through your list. The scrolling indicator displays your progress as you move through the list. Release the mouse button when the value you are looking for is displayed.

To search for a purchase order:

1. Enter the keyword or keywords by which you want to search in the **FIND PO** field and select the magnifying glass icon.
   - Matching purchase orders are displayed in the Find window. I
   - If the list of displayed purchase orders is very long, you can select **ADVANCED FIND** to narrow your search to a specific purchase order field or to specify other search criteria.

2. To open the purchase order you wish to work with, double-click it or highlight it and then choose **SELECT PURCHASE ORDER** at the bottom of the window.
Maintaining Purchase Orders

Receiving Against a Purchase Order

When the ordered merchandise arrives, you add it to inventory by creating a receiving voucher. The quickest and most accurate way to receive the items ordered on a purchase order is to reference that purchase order on a voucher.

This process is best initiated from a receiving voucher and instructions are provided in Chapter 17 Receiving Merchandise (page 281).

Tip: Initiating Receiving from a Purchase Order

If you have a purchase order displayed and are ready to receive against it, you can select RECEIVE ITEMS from the I Want To menu to initiate the creation of a receiving voucher. The procedure is the same as documented in the receiving chapter.

Tracking Orders by Status

There are two ways to track the status of an order.

- The document status of the order can be tracked using the Status field. This field records the standing of the order as open, closed, or pending, or with custom statuses you have defined in company preferences.
- The fill status of the order is indicated by the Qty Ordered, Qty Received, Qty Due, and Unfilled % fields grouped together in the totals area of the order form (they are also shown in the purchase list). At a glance, these fields communicate quantity information for the entire order.

Tracking Order Document Status

By default, Point of Sale uses three basic status types to track orders: OPEN, CLOSED and PENDING.

New orders, by default, are always assigned the OPEN status. Orders that have been filled (all items received) are automatically changed to the CLOSED status. Purchase orders that have been generated by Point of Sale Pro-level users using the Suggest PO feature are defaulted to the SUGGESTED status.

Pending Purchase Order Status

Purchase orders that you have made but are not immediately placing with your vendor should be changed to PENDING status. This status prevents the purchase order from affecting your reorder reminders and for Pro users, your available quantity calculations, and allows you to filter these purchase orders out from purchasing reports.
If it fits your needs, you can rename the descriptions of these status types and define more of your own in company preferences. For example, maybe you have intermediary steps in the order process, such as waiting for approval, back-ordered, or in-transit, which you want to indicate and use for order tracking. An order’s status can be manually changed as an order is made and as it proceeds towards completion.

Point of Sale maintains a record of the changes in an order’s status, which can be viewed by selecting the icon adjacent to the Status field on the purchase order form.

### Preferences: Define Status Field Entries

**EDIT ➤ PREFERENCES ➤ COMPANY ➤ PURCHASING ➤ Purchase Order status.** To change the description of an existing status, click in the Status Description column and type a new description. Select **ADD** to define new status types and descriptions. You can also rearrange the order the possible choices appear in the Status field drop-down list on order forms, and remove status types no longer used.

### To change the status of an order:

1. Display the purchase order.
2. Select a new status from the drop-down list in the Status field.
3. Select **SAVE**.

### Tracking Purchase Order Fill Status

The Qty Ordered, Qty Received, Unfilled % and Qty Due fields are grouped together in the totals area of the PO form (they are also shown in the purchase order list). Together, they communicate the fill status of the entire purchase order.

POs start with an initial Qty Received of 0 and Unfilled % of 100. The Qty Received increases, and the Qty Due and Unfilled % decrease as items are received on vouchers. For example, if you ordered 54 of a certain item on a purchase order, but received only 30 on a voucher, the purchase order would show a remaining Qty Due of 24 and an Unfilled % of 44.44.

If a vendor substitutes items or quantities or can’t fill an order, the purchase order will still show a remaining Qty Due and Unfilled %. If you want to accept the substitution or simply close the purchase order to show the order was completed, you can edit the purchase order to match the merchandise received, so that each item on the purchase order has a Qty Due of zero (0). The Unfilled % will be adjusted to 0% and the purchase order document status changed to **CLOSED**.

To see the fill status of individual items, look at the Ordered and Due fields for each item in the purchase order item list.
Maintaining Purchase Orders

Editing Purchase Orders

Purchase orders are order-planning documents, not transactional documents; therefore, they can be edited even after saving. Most fields are editable.

1. Highlight an order in your purchase order list, and then select **EDIT PO**.
2. Navigate through the editable fields on the purchase order form, making changes as needed.
3. Select **SAVE**.

(Pro Multi-Store) Remote stores cannot edit or delete purchase orders sent to them from Headquarters.

Copying Purchase Orders

If you frequently order the same merchandise from the same vendors, it is often easier to copy a previous purchase order and edit it as needed to create a new one. When you copy a purchase order, the new purchase order will be identical to the old purchase order except for the purchase order number, date information, and received quantities.

To copy a purchase order:

1. In your purchase order list, highlight the purchase order to be copied.
2. Select **COPY PO**.

A new purchase order with the same information as the old purchase order is displayed.
3. Make changes as needed to the new purchase order.
4. Select **SAVE**.

Deleting Purchase Orders

Purchase orders are planning documents that do not directly affect inventory. Once a purchase order has been filled (status of **CLOSED**) it can be safely deleted. The receiving vouchers made to add the ordered items into inventory provide a permanent record. While it is not necessary to delete closed purchase orders, you may find that it helps keep your purchase order list compact and efficient.

Deleted POs cannot be recovered, printed, or copied. Also, be aware that if POs are deleted, they are no longer displayed in a vendor’s history, though receiving the ordered items is reflected in the vouchers included in history.
To delete a purchase order:

1. Highlight or display the purchase order to be deleted and select **DELETE PO** from the I Want To menu. You can use the multi-select feature to select multiple orders by holding down the **<CTRL>** key while selecting the orders. See **Selecting multiple records (page 102)** for more information on using the multi-select feature.

2. Select **YES** in the confirmation window.

Printing Purchase Orders

After completing a purchase order, you can print out a copy to send to a vendor or keep for your own records.

**To print a purchase order:**

1. Highlight or display the purchase order that you want to print.

2. From the Print menu, select **PRINT**.

3. If presented with a print option dialog
   - Change the printer and template you want to use, if necessary
   - Specify to print all PO items or just items still due
   - Specify the number of copies you want to print
   - Select **PREVIEW** to view the purchase order before you print it or **PRINT** to immediately print

** Preferences: Print Options**

**PREFERENCES ➤ WORKSTATION ➤ DOCUMENTS & PRINTERS ➤** Designate the default printer, purchase order template, and number of copies to print.

**Pro: Item Printing Options**

Using Print Designer, you can change your template to print items using a style grid rather than as a list. Refer to **Chapter 35 Customizing Printed Documents (Pro) (page 593)** for more information.
**Printing Tags from a Purchase Order**

You can print tags ahead of time for merchandise that has been ordered but not yet received. If the purchase order lists a new order cost, you may want to wait until the merchandise is received and you have made any needed price changes in inventory before printing tags.

**To print tags from a purchase order:**

1. Display the purchase order.
2. Select the item or items for which you want to print tags. See *Selecting multiple records (page 102)* for more information about selecting multiple records in a list.
   
   To print tags for all purchase order items, you need not select a specific item.
3. From the Print menu, select **PRINT TAGS**.
   
   Depending on your tag printer, your options will vary. Make changes in the print option dialog and/or the Print Tags/Labels dialog (such as tag template, printer, number of tags to print, start position on page, and alignment).
4. Select **PREVIEW** or **PRINT**.

*Refer to Printing Tags and Labels (page 43) for detailed tag printing instructions.*

---

**Having Point of Sale Suggest Purchase Orders (Pro)**

Point of Sale can suggest and generate purchase orders for items that fall to or below their reorder points (defined in inventory). Suggest PO is available from the Purchasing menu or from the Reorder Point Reminders screen.

When **SUGGEST PO** is selected, Point of Sale displays a list of proposed items to order. This list includes all items whose on-hand quantity, plus currently on-order but not yet received quantities, are at or below their reorder point.
Add the **Order From** field to the Suggest PO list if you use multiple vendors for items. *Refer to Customizing Columns in Lists (page 586) for more information.*

**Current on-hand quantity**  
**Quantity on order, but not yet received**

![Suggest POs dialog box](image)

**Enter quantity you wish to order**  
**If multiple vendors exist for an item, you can change the vendor in the Order From field**

---

**To have Point of Sale suggest purchase orders:**

1. Select **SUGGEST POS** from the Purchasing menu or from the Reorder Items Reminders window. Point of Sale produces a list of suggested reorder items.

2. Enter an order quantity for each item. Purchase orders are not generated for an item if you leave the **Order Qty** field blank.

3. Change the vendor, if necessary, and you have multiple vendors defined for an item.

4. From the bottom toolbar, select **CREATE POS**.

Point of Sale generates purchase orders as specified. If multiple items exist for a vendor, they are combined on a single purchase order for that vendor. A confirmation message displays the number of purchase orders created.

The purchase orders can be viewed, edited, or sent to your vendor in the normal manner from your purchase order list.
Chapter 17  Receiving Merchandise

Receiving Overview ......................................................... 282
Accessing Vouchers and Receiving History ...................................... 282
Receiving Items ................................................................. 283
  Receiving without a Purchase Order ........................................ 283
  Receiving against a Purchase Order ....................................... 284
Working with Voucher Items .................................................. 287
  Editing Voucher Items ....................................................... 287
  Deleting Voucher Items ..................................................... 287
  Handling Item Substitutions ................................................ 287
Handling Costs and Prices .................................................... 288
  Updating Costs ............................................................... 288
  Updating Item Prices ....................................................... 289
Voucher Discounts, Freight, and Fees ........................................ 289
  Spreading Discounts, Freight, and Fees .................................. 290
Entering Vendor Billing Information ........................................ 291
Holding or Canceling a Voucher in Progress .................................. 292
Receiving the Same Item from Multiple Vendors (Pro) ...................... 293
Recording Item Serial Numbers on Vouchers (Pro) .......................... 293
Effects of Saving a Receiving Voucher ..................................... 294
Working with Receiving History .............................................. 295
Locating a Voucher ............................................................ 295
Copying a Voucher to Create a New One .................................... 296
Editing a Voucher .............................................................. 296
Reversing a Voucher .......................................................... 297
Returning Merchandise to a Vendor ......................................... 299
Printing from Vouchers ...................................................... 300
  Printing a Voucher .......................................................... 300
  Printing Tags from Vouchers ............................................... 300
Receiving Overview

A receiving voucher is a Point of Sale history document that provides a record of merchandise received into inventory. When a shipment arrives from a vendor, you create a receiving voucher to update inventory. A return voucher, on the other hand, records merchandise returned to the vendor and removed from inventory.

When a voucher is saved, it is stored in your receiving history list, accessible from the Purchasing menu or the Navigator. The term voucher is used throughout this chapter to refer to both receiving and return vouchers, unless otherwise specified.

When receiving merchandise against a purchase order (PO), you can bring any or all of the items ordered on the PO to the voucher. The PO fill status will be updated when the voucher is saved. Saving a voucher always updates the received items’ cost and order cost in inventory. To keep accurate track of the value of your inventory, it is important to enter the correct item cost information on vouchers.

If an item’s price has not been previously defined, and you have a margin or markup specified for it, then saving a voucher receiving the item results in the item’s regular price being automatically calculated and displayed in inventory. Once an item’s price is defined in inventory, reordering and receiving does not automatically update the item price even if the cost has changed. However, if the cost changes, you are alerted and have the option to update the price from the voucher.

(Pro Multi-Store) Both Headquarters and remote stores can create receiving vouchers and reference POs while doing so. Headquarters can create vouchers for any store; remote stores can only create vouchers for themselves. Refer to Purchasing and Receiving (page 554) for other information about purchasing and receiving in a multi-store configuration.

Maintaining Accurate Vendor Histories

Do not mix items from different vendors on a purchase order or receiving voucher if you want to maintain accurate vendor histories and be able to run meaningful vendor reports.

Accessing Vouchers and Receiving History

From the Purchasing menu, select one of the following:

- NEW RECEIVING VOUCHER to receive merchandise into inventory
- NEW RETURN VOUCHER to remove merchandise from inventory and send back to the vendor
- RECEIVING HISTORY to view or work with previous vouchers
- HELD VOUCHERS to view or unhold a voucher previously held
Receiving Items

Receiving without a Purchase Order

1. From the Purchasing menu, select NEW RECEIVING VOUCHER.
2. In the Enter Item(s) field, list the items to be sold by any of these methods:
   - Scan the bar code on the item tag.
   - Type the UPC, Alternate Lookup, or Item # and press <Enter>. If one matching item is found it is immediately listed on the receipt.
   - Begin typing the first few letters of the item’s Item Name entry. A drop-down list of your items is displayed with the closest match on top. Select an item from the list to add it to the receipt or, if no match is found: Press <Enter> to open the full Find window with additional search options.

   Or

   Select ADD NEW to add an item to inventory and then immediately receive it.

   - From the I Want To menu, choose SELECT FROM ITEM LIST to locate and enter items from inventory.

   Refer to Listing Items on Documents (page 91) for complete item listing instructions.

3. Review the listed items, and if necessary, select EDIT ITEM (<F5>) and edit the quantity and cost of each item. These values are important in maintaining an accurate inventory valuation.
   - If you receive items costing fractional cents, you can enter the received quantity and extended cost and Point of Sale will calculate the unit cost for you with up to five decimals (only two are displayed).

4. Enter information in other voucher fields, as appropriate. Other common entries are:
   - Discounts, Freight and Fees. Enter amounts in their respective fields. Optionally, select the checkbox to spread these amounts across the items being received. Refer to Voucher Discounts, Freight, and Fees (page 289) for important information about spreading fees and discounts.
   - Invoice # and other vendor billing information, if known. The availability of these fields depend on your company preferences. Refer to Entering Vendor Billing Information (page 291) for more information.

   Refer to Voucher Information Fields (page 657) for more information about other available fields on the voucher.

5. If you want to print tags for the items, select PRINT TAGS from the Print menu.
If item costs have increased, you will be alerted—you may want to review or update your prices in inventory before printing tags. Refer to Printing Tags from Vouchers (page 300) for more information.

6. Select SAVE & PRINT or SAVE ONLY to finish the voucher and update inventory.

If you reorder the same merchandise repeatedly from a vendor, the quickest way to create a new voucher may be to copy a previous voucher, edit as needed, and then save. Refer to Working with Receiving History (page 295) for more information.

(Pro) When receiving an out of stock item which appears on a customer order, Point of Sale will give you an on-screen notification that these items are needed for a customer order. Refer to Updating Item Prices (page 289) for more information.

Receiving against a Purchase Order

When the ordered merchandise arrives, you add it to inventory by creating a receiving voucher. The quickest and most accurate way to receive the items ordered on a purchase order is to reference that purchase order on a voucher.

When receiving merchandise against a purchase order, you can transfer some or all of the ordered items, with quantities, costs, and other information, from the purchase order to the voucher. The purchase order’s fill status will be updated when the voucher is saved.

Receiving Against Multiple Purchase Orders

You can receive against multiple purchase orders on a single voucher, but proceed carefully if you choose to do so. If the purchase orders have different values for discounts, freight, fees, or vendor terms, you may lose the ability to track these amounts back to the specific items and order to which they belonged. Point of Sale will alert you if detects these differences.

To receive against purchase orders:

1. From the purchase order, select RECEIVE ITEMS from the I Want To menu and go to Step 2.

Or

From a new receiving voucher, specify the vendor in the Vendor field.
You are alerted and asked if you want to receive against open purchase orders for the vendor. Answer **YES** and then, from the list of the open purchase orders displayed:

1. In the Select Items to Receive window, do either of the following:
   - Enter quantities for the items you want to bring to the voucher in the **Doc Qty** field
   - Choose the **SELECT ALL** button to bring all due items and quantities to the voucher

Sample PO Item Selection Dialog

**⚠️ Tip: When you Need to Bring Most, But Not All, Items from the Purchase Order**

A quick way to bring most purchase order items to a voucher is to choose **SELECT ALL** and then revise the Doc Qty for the items not being received.

3. Select **CONTINUE**.
Chapter 17: Receiving Merchandise

- If a fee is entered on the purchase order, you are alerted, and can transfer the fee at your discretion. Answer YES or NO in the dialog displayed.

- The receiving voucher is displayed with selected items, order costs, quantities, and other information from the purchase order pre-filled. The purchase order number is cross-referenced in the PO # field on the voucher.

4. Add or edit item quantities or costs, and make entries in other voucher fields as appropriate:
   - Discounts, Freight and Fees. Enter amounts in their respective fields. Optionally, select the checkbox to spread these amounts across the items being received. Refer to **Voucher Discounts, Freight, and Fees (page 289)** for important information about spreading fees and discounts.
   - Invoice # and other vendor billing information, if known. The availability of these fields depend on your company preferences. Refer to **Entering Vendor Billing Information (page 291)** for more information.

5. Save and optionally print the voucher.

The received quantities are added to inventory and the purchase orders fill status is updated accordingly.

---

**The Fill Status of a Referenced Purchase Order**

Saving a voucher that references a purchase order will automatically update the purchase order’s fill status and, if the purchase order is 100% filled, change the status to **CLOSED**.

**Cancel Dates**

If the purchase order is past its cancel date and your company preferences are set to warn you when receiving against a cancelled purchase order, a message is displayed and you can proceed or cancel at your discretion. See the preference box below for more information.

---

**Preferences: Receiving Against a PO Whose Cancel Date Has Passed**

PREFERENCES ➤ COMPANY ➤ RECEIVING ➤ RECEIVING VOUCHERS ➤ Warn when receiving against PO past its Cancel Date: ☑ Select to have the program alert you when a referenced purchase order is past its cancel date. You can still receive the purchase order items at your discretion. If this preference is not selected, you will not be alerted when receiving against a cancelled purchase order.
**Working with Voucher Items**

**Editing Voucher Items**

You can modify any editable item field after listing the items on a voucher (but before saving):

- Highlight the item and select **EDIT ITEM (<F5>)**. Make your changes in the Item Information window and then select **OK**.
- Alternatively, navigate to the applicable field in the voucher item list and enter the new information.

**Deleting Voucher Items**

The method available to you may vary based on your security rights.

**Method 1 - To delete an item from a voucher:**

1. Highlight the item to be deleted in the document item list.
2. Select **DELETE ITEM** from the window toolbar.

**Method 2 - To zero-out an item but leave it on the voucher:**

1. Move the cursor to the **Qty** field of the item.
2. Change the quantity to zero and then press **<ENTER>** or navigate out of the field.
   The item will remain listed on the voucher with a quantity of zero.

**Handling Item Substitutions**

Items that are substituted or over-shipped do not make up for other units that were ordered but not received. If you ordered five orange sweaters but instead received five green sweaters, the referenced purchase order will still show a **Qty Due** of five for the orange sweaters. This is useful if the order is open and you are still expecting shipment of the five orange sweaters.

To substitute the green sweaters for the orange sweaters and show the order as filled, edit the purchase order first to match the merchandise received and then reference the edited purchase order when making the new voucher, leaving no unfilled items. If you don’t want to accept the substitution, do not list the items on the voucher; send the items back to the vendor. No return voucher is necessary if they have not been received on a receiving voucher.
Handling Costs and Prices

Updating Costs

Point of Sale *averages* the cost of inventory items. This means that when items are received at a cost different than the current inventory average unit cost, the received quantities and costs are averaged together with the existing inventory quantities and costs to determine the new average unit cost of the item. For example, if you have 10 of an item that was purchased at an average cost of $5 and then receive 10 more purchased at an order cost of $10, the new averaged unit cost of the item is $7.50.

This enables merchants to set an accurate profit margin for items and maintains an accurate inventory valuation when using Point of Sale in conjunction with QuickBooks financial software.

The **Order Cost** in inventory is not averaged when items are received at a different cost. Instead, the cost at which the items were received becomes the new **Order Cost** in inventory and is suggested as the order cost on future purchase orders and vouchers.

You can elect to spread discounts, freight, and fees across the items received on a voucher. This will affect the voucher cost of the items, and thus the average order cost. Refer to **Voucher Discounts, Freight, and Fees** (page 289) for more information.

It is important to ensure the correct order cost is recorded on receiving vouchers.

**To change the voucher cost for an item:**

1. Highlight the item in the voucher item list.
2. Select **EDIT ITEM** (*<F5>*), enter the cost being paid the vendor, and then select **OK** (*<F5>*).

   **Or**

   Navigate to the **Voucher Cost** field in the item list and make changes directly there.

Tracking Items Costing Less than a Penny

The cost and price fields on vouchers and in inventory support decimal values to facilitate ordering, receiving, and tracking items costing less than a penny or in any decimal cost. You can enter up to five decimal places in any cost or price field (only two decimals are displayed, but all five are stored and used for calculations). On a purchase order or receiving voucher you may find it easier to enter the quantity and extended cost for an item, and let Point of Sale calculate the unit cost for you.
Receiving Items

QuickBooks Financial Software Users - Vouchers Update Inventory Value

The receiving voucher, when sent to QuickBooks financial software, increases your inventory value for the received quantity at the voucher cost. Conversely, when a return voucher is sent, your inventory value is decreased for the returned quantity at the voucher cost. The process of averaging inventory costs does not result in any additional net change in total inventory value.

Refer to Receiving Vouchers (page 503) for more information about how vouchers are sent to your financial software, and Average Unit Cost and Order Cost (page 189) for more information about inventory costs.

Updating Item Prices

If the new items received on a voucher do not yet have prices defined in inventory, but do have a margin or markup defined, Point of Sale will apply the margin or markup to the voucher cost and write the result to the Regular Price field in inventory. If you use additional price levels, those prices are also calculated based on the percentages specified on the item record (and defined in company preferences).

On future orders of the same item, a change in cost does not automatically result in the price being updated. Instead, you are alerted and given the opportunity to change the price from the voucher.

Tip: Changing Voucher Costs and Pricing

If the voucher cost is different from the cost listed in your inventory, you will receive a prompt asking if you would like to edit the item price. If you answer yes, you will be returned to the voucher where you will need to select EDIT ITEM and change the price for each item as needed.

The margin and markup displayed in the voucher’s Edit Item window is based upon the voucher cost, NOT on your average cost. Margin and markup percentages shown here will be vary slightly from those displayed in your inventory item record which are based upon average unit cost.

See Updating an Item’s Price When Costs Change (page 193) for more information.

Voucher Discounts, Freight, and Fees

By default, discounts, freight charges, and vendor fees are entered separately and are not spread across the cost of the items on a voucher. These amounts can be edited even after saving a voucher, since the values may not be known when the voucher is
initially created. If you prefer, you can choose to spread these amounts across the received items.

**Discounts.** A voucher discount, by default, is global, meaning it is applied to the voucher subtotal. Discounts are not applied to freight charges or fee amounts. Discounts entered on a referenced purchase order are proportionally carried to receiving vouchers (based on the proportion of the ordered items being received). The discount amount can be edited on the voucher.

**To add a discount:**
- Place the cursor in the **Discount %** or **Discount** field and enter a percentage or amount. The other field is automatically calculated.

**Freight ad Fees.** Freight and fees are not automatically transferred to a voucher from a referenced purchase order, but you are alerted that they existed on the purchase order so that you can apply them at your discretion. This is because these charges generally are not based on the value of the ordered/received items, and may or may not apply if a partial shipment is received.

**To add freight charges:**
- Place the cursor in the **Freight** field and enter an amount.

**To add a fee:**
- Place the cursor in the **Fee** field and enter an amount.

**Spreading Discounts, Freight, and Fees**

If desired, these amounts can be “spread” over the cost of the items listed on the voucher. To do so, select the checkbox in the totals area on the voucher. Spreading these amounts can help you track a truer average cost for your items.

**Important notes about spreading the amounts:**
- The total amount of discounts, freight, and fees is distributed across all voucher items received proportionally based on each item’s extended cost.
- Clearing the spread checkbox *before saving* the voucher will restore the costs to their prior state and make the discount, freight, and fee fields
Receiving Items

editable again. Once the voucher has been saved, this setting cannot be changed.

- After spreading and saving the voucher, the discount, freight, and fee fields at the bottom of the voucher form are zeroed and no longer editable, since these amounts are now reflected in the individual item costs.
- If the voucher is saved without spreading, it cannot be edited later to spread.

💡 Tip: Use Care when Spreading Fees, Freight and Discounts

If you choose to spread these amounts, they are allocated across every item on the voucher, even if these items are from different purchase orders or different vendors. Once you have saved the voucher, you cannot change or edit the “spread fees” setting.

Spreading freight, fees and discounts has no effect on order cost or voucher total, but it does affect the average unit cost of the received items.

Entering Vendor Billing Information

You have the option of entering vendor billing information in Point of Sale. By default, the vendor billing fields are not on the receiving voucher form; the assumption being you will want to handle all vendor billing activities in your QuickBooks financial software. You can change this behavior by changing your company preference settings. If you are not using QuickBooks, it is recommended that you make this changes. This setting affects how vouchers are sent to QuickBooks financial software.

💡 Preferences: Entering Vendor Billing Information

PREFERENCES ➤ COMPANY ➤ RECEIVING ➤ Enter vendor billing information in Point of Sale: ☑ Select to add the vendor billing fields to the voucher form in Point of Sale. You can then enter vendor billing information (Payee, Invoice/Ref #, Due Date, etc. If you wish to enter billing information in QuickBooks financial software, make sure this checkbox is not selected.

If billing information is entered in QuickBooks financial software:

- Vouchers are sent as item receipts. When you enter the vendor billing information in QuickBooks financial software, they are converted to bills.
If billing information is entered in Point of Sale:

- The vendor billing fields (payee, terms, bill date, invoice/reference #, etc.) are added to the voucher form in Point of Sale.

![Billing Information](image)

- When the billing information is received enter it on the voucher. If the voucher has already been saved, edit the voucher to enter the billing information along with any freight charges or fees.

- Receiving vouchers are sent to QuickBooks in different ways, depending on whether billing information (Invoice/Ref#) has been entered:
  - If billing information is received and entered when the voucher is created, the voucher is sent directly to Accounts Payable as a bill.
  - If billing information has not been entered, the voucher is sent to the Unbilled Purchases liability account. When billing information is entered later, the voucher is sent a second time as a bill to Accounts Payable and removed from the Unbilled Purchases account.
  - If the ALREADY PAID checkbox is selected, whether billing information is entered or not, the voucher is sent as an item receipt. This option can be used, for example, if the merchandise has been prepaid for with a credit card or cash.
  - The terms, bill date, due date, and invoice/reference number are added to the QuickBooks financial software bill when created.

Refer to Changing How Vendor Billing Information is Handled (page 527) for more information.

Holding or Canceling a Voucher in Progress

Incomplete vouchers or vouchers that are not ready to be saved can be put on hold while you carry out other activities, make other vouchers, or even exit from Point of Sale.

For example, you might temporarily hold a voucher while you make a sale, then “unhold” it after the sale is completed. Holding a voucher does not affect inventory quantities or costs.

To hold a voucher:

- With the voucher displayed, select HOLD VOUCHER.
Receiving Items

To un-hold a voucher:

1. From the Purchasing menu or a voucher form, select **HELD VOUCHERS**. A list of the vouchers currently on hold is displayed.
2. Find the voucher you want from the list, and then select **UNHOLD VOUCHER**. Un-holding a voucher returns it to active status.
3. Complete and save the voucher using normal procedures.

---

Held Vouchers in a Multi-Workstation Installation

In a multi-workstation environment, a held voucher can be accessed and un-held from any Point of Sale workstation on the network.

---

To cancel a voucher in progress:

1. Select **CANCEL** in the lower right corner of your screen.
2. Select **YES** to confirm.

---

**Receiving the Same Item from Multiple Vendors (Pro)**

If you order the same item from multiple vendors you can list any of the item vendors on the receiving voucher and then add items using that vendor's unique UPC or Alternate Lookup values.

If the items were ordered on a purchase order, the correct vendor and order cost will be carried to the voucher when you reference the purchase order.

Refer to **Using Multiple Vendors for an Item (Pro) (page 263)** for more information on using multiple vendors for items.

---

**Recording Item Serial Numbers on Vouchers (Pro)**

You can record a serial number for each unit of an item received as you make the voucher. Later, you can locate the voucher by searching or sorting for serial numbers or run reports listing the serial numbers received in this shipment.

If you want to be prompted to enter a serial number when making a voucher receiving a particular item, ensure the **Serial Number Tracking** field in inventory is set to **PROMPT** for the item.
To enter item serial numbers:

1. List the item on the voucher in the normal fashion.
2. Select EDIT ITEM (<F5>).
3. Enter the serial number in the Serial # field.
4. If multiple units are being received, select the icon to the right of the field to open and enter serial numbers for each unit being received.

Refer to Serial Number Tracking (Pro) (page 149) for more information about tracking item serial numbers.

Effects of Saving a Receiving Voucher

When you save a voucher, Point of Sale will:

- Add the quantities received into inventory (subtracts if a return voucher)
- Update an item’s Average Unit Cost and Order Cost in inventory, if receiving at a new cost
- Update an item’s Regular Price if the price was formerly zero and a margin or markup is defined for the item (typical for new items being received for the first time), or if the item price was updated from a voucher on reorder
- Update the Last Received Date in inventory for all received items
- Update each item’s Margin % and Markup % fields if the cost has changed and the item price was not formerly zero (typical for reorder items)
- Add the voucher to the receiving history list
- (If the voucher references a purchase order) Update the purchase order fill status
Working with Receiving History

A voucher that has been saved is stored in the receiving history list. Vouchers provide a permanent record of merchandise received into inventory or returned to vendors. Receiving and return vouchers are stored together in the same history list and share the same voucher numbering sequence.

Locating a Voucher

You can locate a voucher by filtering, sorting, or searching your receiving history. These procedures are summarized here.

Refer to Chapter 7 Lists, Forms and Filters (page 99) for detailed instructions.

To filter your voucher list:

1. Display your receiving history, and then select one of the following from the drop-down filter list at the top of the window:
   - A predefined filter (such as ALL VOUCHERS, THIS MONTH, THIS WEEK, etc.)
   - A previously defined and saved custom filter (your custom name)
   - CREATE FILTER to enter new filter criteria, and optionally save it for future use
   - MANAGE FILTERS to edit, rename, delete, or rearrange the order of your previously saved filter views
2. If you selected CREATE FILTER, enter criteria values in any of the available fields and then select OK or SAVE.
   Your list is filtered by your selected criteria.

To find vouchers by sorting and/or scrolling:

1. Select the column by which you want to sort the list by clicking or touching the header of the column.
2. Immediately begin typing the first few characters of the column entry you wish to locate. The characters you type are not displayed, but the closest matching record to what you typed is highlighted.

Or

Use the vertical scroll bar to scroll through your list. The scrolling indicator displays your progress as you move through the list. Release the mouse button when the value you are looking for is displayed.
To search for a voucher

1. From the Receiving History window toolbar, select FIND VOUCHER (<F3>).
2. Enter a keyword or keywords by which you want to search.
3. Select FIND (<ENTER>) to begin the search.
   All matching vouchers are displayed.
4. Select a voucher to work with or select ADD NEW or CLOSE to create a new voucher or return to the full receiving history list respectively.
   If you need to narrow your search results, select ADVANCED FIND OPTIONS on the Find Voucher window, and select a specific field to search in or select from other search criteria.

Copying a Voucher to Create a New One

To copy a voucher:

1. Locate and highlight/display the voucher you want to copy.
2. Select COPY VOUCHER.
   A new voucher form is opened. All of the fields on the copied voucher are identical to the original, except the voucher number and date.
3. Make any necessary edits to the new voucher, paying particular attention to the accuracy of the Qty and Voucher Cost fields.
4. Select SAVE & PRINT.
   Copying a voucher is also a quick way to create a return voucher for the same items. Follow the procedure above, but select CHANGE TO RETURN VOUCHER from the I Want To menu before saving.

Editing a Voucher

The vendor billing information, if included, and the discount, freight, and fee information (provided it wasn’t spread) can be edited on a voucher after saving.

If you are recording vendor billing information in Point of Sale, editing a saved voucher is typically done when the vendor’s invoice for the merchandise is received sometime later. Refer to Entering Vendor Billing Information (page 291) for more information on this option.

Editing a voucher affects the voucher record in receiving history and updates your financial software records (is sent a second time). It has no effect on inventory or on a referenced purchase order.
If you need to correct a voucher that is in error, use the procedure for reversing a voucher below instead.

(Pro Multi-Store) Remote stores cannot edit vouchers.

**To edit a voucher:**

1. Locate and select the voucher in your receiving history.
2. From the window toolbar, select **EDIT VOUCHER**. The voucher is opened in edit mode. Editable fields are white in color.
3. Edit the available fields as needed.
4. Select **SAVE**.

---

**Reversing a Voucher**

If an error is discovered on a voucher, other than the editable fields discussed above, it is necessary to reverse the voucher and then create a new, corrected voucher to update your receiving history, inventory, and financial software. A receiving voucher is reversed through the automatic creation of a return voucher listing the same items. A return voucher is reversed with the automatic creation of an identical receiving voucher.

If the original voucher referenced a purchase order, reversing it will also update the purchase order’s fill status and balances (assuming the purchase order has not been deleted).

A **Reverse**, **Copy**, and **Correct** approach can be used to undo the effects of the original voucher and make a new, corrected voucher. First, **reverse** the original, incorrect voucher. Then, begin a new document by **copying** the original one. Finally, make **corrections** to the copy and save as usual.

(Pro Multi-Store) A remote store can only reverse a voucher prior to the voucher being sent to Headquarters via a Store Exchange. If an error is discovered after sending the voucher to Headquarters, it can be corrected in one of two ways: 1) reverse the voucher at Headquarters, or 2) use the copy procedure described above to copy and make an identical return voucher at the remote store. Refer to Multi-Store Purchasing and Receiving (page 554) for more information.

**To reverse a voucher:**

When this procedure is completed, the original voucher will be marked **Reversed** in the **Status** field. A new voucher is created that reverses the effects of the first voucher; the status for this new voucher is **Reversing**. The **Status** field is only displayed in the receiving history list.
1. Locate and highlight/display the voucher to be reversed.

2. From the I Want To menu, select **REVERSE VOUCHER**.

3. The Reversing Document dialog is displayed. If not using security, select your name from the **Associate** field and then select **OK**.
   A reversing document with your name is automatically added to the receiving history list. A corrected voucher can then be made as described below.

---

### Cannot Reverse or Copy a Reversing Voucher

You cannot reverse or copy a voucher that has been created to reverse an earlier voucher. However, you can still copy the original voucher that was reversed. This is helpful in creating a new, corrected voucher after reversing the original.

---

### Item Cost Re-Averaged If Necessary

Reversing a receiving voucher with items at a cost different than the current average unit cost results in the average unit cost being recalculated for the remaining on-hand quantity.

---

## To copy and correct a voucher:

Copying and correcting a reversed voucher allows you to adopt the parts of the voucher that you want to keep, and correct the parts that were in error, to make a new, correct voucher.

1. Reverse the original voucher as described above.

2. Highlight or display the original voucher again (marked **Reversed** in the **Status** field in your receiving history).

3. Select **COPY VOUCHER**. A new voucher is created with the same information as the original.

4. Make any necessary edits to correct the information on the new voucher.

5. Select **SAVE & PRINT**.
Working with Receiving History

Returning Merchandise to a Vendor

Use a return voucher if you need to send back items that have already been received into inventory. For example, you create a receiving voucher and only later when unpacking the merchandise, you find items that were damaged during shipping or aren’t what you ordered.

The procedure for creating a return voucher is the same as for creating a receiving voucher. A return voucher deducts the returned item quantities from inventory, updates the fill status of referenced purchase orders, and is reflected in your receiving history.

Note that a return voucher should not be used unless the returned items were previously received into inventory on a receiving voucher.

To create a return voucher:

1. From the Purchasing menu, select NEW RETURN VOUCHER.
2. List the quantities and cost of the items being returned.
   • The current order cost from inventory is suggested as the voucher cost; edit the cost if necessary to reflect the cost paid
   • List the return quantities as positive numbers
3. Save the voucher.

Copying the original receiving voucher is also a quick way to create a return voucher for the same items, and helps ensure the same cost is recorded. After copying the original voucher, select CHANGE TO RETURN VOUCHER from the I Want To menu. Refer to Copying a Voucher to Create a New One (page 296) for more information.

Including Return Items on Regular Vouchers

You can list items being returned to a vendor on the same voucher being used to receive items at the same time. Simply select MAKE THIS ITEM A RETURN for the items being sent back to the vendor. Be aware, however, mixing received items and returned items on the same voucher will result in only the net amount being shown on the vendor bill created in QuickBooks. This may make it more difficult to match-up the bills created in QuickBooks with the invoices received from the vendor.
Printing from Vouchers

Printing a Voucher

Typically, new vouchers are printed when with saving. You can reprint vouchers in your receiving history with this procedure.

To print a saved voucher:

1. Display the voucher that you want to print.
2. From the Print menu, select PRINT VOUCHER.
3. If presented with a print option dialog, you may:
   • Change the printer or voucher template.
   • Specify the number of copies you want to print.
   • PREVIEW or PRINT the voucher.

Refer to Printing in Point of Sale (page 40) for more information on printing documents.

Printing Tags from Vouchers

To print tags from a voucher:

1. Display the voucher.
2. Select a specific item for which you want to print tags.
   • To print tags for all voucher items, you need not select a specific item. To print tags for only some of the items, select multiple items by holding down the <CTRL> key while clicking the items. See Selecting multiple records (page 102) for more information on using the multi-select feature.
3. From the Print menu, select PRINT TAGS.
4. In the print option dialog, you may:
   • Change the printer or tag template.
   • Specify the number of copies you want to print.
   • Change the start position or alignment for sheet labels.
5. Select PREVIEW or PRINT.

Refer to Printing Tags and Labels (page 43) for detailed tag printing instructions.
## Section V: Customers and Sales

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>Customer Records and History</td>
<td>303</td>
</tr>
<tr>
<td>19</td>
<td>Sales and Tax Overview</td>
<td>329</td>
</tr>
<tr>
<td>20</td>
<td>Sales Transactions</td>
<td>347</td>
</tr>
<tr>
<td>21</td>
<td>Receipt Payment Types</td>
<td>381</td>
</tr>
<tr>
<td>22</td>
<td>Returns, Exchanges and Sales History</td>
<td>403</td>
</tr>
<tr>
<td>23</td>
<td>Sales Orders, Work Orders and Layaways (Pro)</td>
<td>415</td>
</tr>
</tbody>
</table>
# Chapter 18: Customer Records and History

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Overview</td>
<td>304</td>
</tr>
<tr>
<td>Working with Customers</td>
<td>305</td>
</tr>
<tr>
<td>Adding a New Customer Record</td>
<td>305</td>
</tr>
<tr>
<td>Locating a Customer Record</td>
<td>306</td>
</tr>
<tr>
<td>Editing a Customer Record</td>
<td>308</td>
</tr>
<tr>
<td>Deleting a Customer Record</td>
<td>309</td>
</tr>
<tr>
<td>Merging Customer Records</td>
<td>310</td>
</tr>
<tr>
<td>Using Customer Discounts and Price Levels</td>
<td>311</td>
</tr>
<tr>
<td>Handling Special Customer Sales Tax</td>
<td>312</td>
</tr>
<tr>
<td>Tracking Customers by Type</td>
<td>313</td>
</tr>
<tr>
<td>Viewing a Customer's Purchase History</td>
<td>313</td>
</tr>
<tr>
<td>Customer Ratings</td>
<td>315</td>
</tr>
<tr>
<td>In-Store Charge Accounts</td>
<td>316</td>
</tr>
<tr>
<td>Customer Account Fields</td>
<td>316</td>
</tr>
<tr>
<td>Tracking Customer Charge Accounts</td>
<td>318</td>
</tr>
<tr>
<td>Past Due Accounts</td>
<td>319</td>
</tr>
<tr>
<td>Printing/Exporting Your Customer Records</td>
<td>321</td>
</tr>
<tr>
<td>Printing a Customer List Report</td>
<td>321</td>
</tr>
<tr>
<td>Printing Customer Labels</td>
<td>322</td>
</tr>
<tr>
<td>Customer ID Numbers and Cards (Pro)</td>
<td>322</td>
</tr>
<tr>
<td>Customer Rewards Program (Pro)</td>
<td>323</td>
</tr>
<tr>
<td>Legal Considerations for Rewards Programs</td>
<td>324</td>
</tr>
<tr>
<td>Reward Program Terminology</td>
<td>324</td>
</tr>
<tr>
<td>Defining your Rewards Program</td>
<td>326</td>
</tr>
<tr>
<td>Enrolling Customers in the Rewards Program</td>
<td>327</td>
</tr>
<tr>
<td>Managing Individual Customer Rewards</td>
<td>327</td>
</tr>
</tbody>
</table>
Customer Overview

Point of Sale can store and track a great deal of customer information. Not only can customer names, addresses, phone numbers, and e-mail addresses be recorded, but other useful features, such as customer-specific price levels, discounts, a check acceptance status indicator, and extensive notes can be used. Customer information can be used for marketing purposes, reporting, and printing mailing labels.

Recording customer information allows you to:

- Build and maintain customer sales histories by recording customer names on receipts
- Offer store charge accounts
- Automatically apply customer price levels, tax locations, or give discounts when making sales
- (Pro) Record and use customer shipping addresses on sales documents
- (Pro) E-mail customer orders to customers from within Point of Sale
- (Pro) Offer a Customer Rewards program

Point of Sale also provides various customer reports. See Chapter 26 Reports and Sales Charts (page 459) for more information on reports in Point of Sale.

Pro Multi-Store

Customers can be added, edited, or deleted at any store. During the next Store Exchange changes to customer records are propagated to all stores.

Refer to Working with Customers (page 537) for more information on customers in a multi-store configuration.

Preferences: Require Customer Information on Receipts

PREFERENCES ➤ COMPANY ➤ CUSTOMERS ➤ Customer Tracking Options: Require recording customers on all receipts. Select to require listing a customer on receipts. If this option is selected, payment cannot be taken on a receipt until a customer is listed.

To access your customer records:

- From the Point of Sale menu, select CUSTOMER LIST or NEW CUSTOMER

To find out how to view summary statistics about your customer list, refer to List Summary (page 104).
Working with Customers

Adding a New Customer Record

It is a good idea to be as consistent as possible when entering information in customer records. Consistently using the same data format makes it easier to sort, search, and look up customer records, particularly when adding a customer to a receipt at point of sale. You can either add a new customer from scratch, or, if two customers are similar, you can add a new customer record by copying an existing customer record.

To add a customer record:

1. From the Customers menu, select NEW CUSTOMER (or NEW from the window toolbar if already in your customer list).

   A blank customer form is displayed.

2. Move through the tabbed pages, entering information in the customer fields. Refer to the following sections and to Customer Information Fields (page 660) for descriptions of available fields.

   The Last (name) field is required to save a customer record.

3. Select SAVE.

Importing Customer Information

If you have existing customers in QuickBooks financial software they will automatically be imported to Point of Sale. You can also use the Data Import Wizard to import new customers or to update information for existing customers.

Refer to Chapter 8 Importing and Exporting Data (page 117) for more information.
Using Copy to Add a Customer Record

You can quickly add a new customer that has much of the same information as another customer by copying the existing record to create a new one. You can then edit the new record as needed.

To add a new customer record by copying:
1. Select the customer record to be copied.
2. From the window toolbar, select **COPY**.
   A new customer form is opened, with most of the information copied from the original record. Some sensitive information, such as account limits/balances, are not copied to the new customer record.
3. Modify the copied information to reflect the new customer.
4. Select **SAVE**.

Locating a Customer Record

Customer records can be located by sorting, scrolling, filtering, or searching your customer list. Each of these procedures is briefly explained below. Refer to Chapter 7 Lists, Forms and Filters (page 99) for a more detailed description of each method.

To find a customer by sorting or scrolling:
1. Select the column by which you want to sort the list by clicking or touching the header of the column.
2. Immediately begin typing the first few characters of the column entry you wish to locate. The characters you type are not displayed, but the closest matching record to what you typed is highlighted.

   Or

   Use the vertical scroll bar to scroll through your list. The scrolling indicator displays your progress as you move through the list. Release the mouse button when the value (in the current sort column) you are looking for is displayed.

Filtering Customer Records

Filtering gathers and displays customers that have information in common, such as the same ZIP code, the same city, and so forth. You enter the criteria and the program sorts and displays only those customers.

When you filter and have only the relevant set of customer records displayed, you have full editing capability. For example, to print mailing labels only for customers in
a specific ZIP code, filter your customer list by that ZIP Code and then select **PRINT LABELS**. Labels can be printed for the customers that are displayed.

**To filter your customer records:**

1. Display your customer list.
2. Select a filter option from the drop-down list at the top of your customer list:
   - **ALL CUSTOMERS** displays your full customer list (default).
   - **CREATE FILTER** to define new filter criteria.
   - **MANAGE FILTER VIEWS** allows you to edit previously memorized filters.
   - Or select a previously memorized filter (your custom name displayed).
3. Enter or edit filter criteria as necessary and then select **APPLY**.
   - If defining new criteria and you want to memorize it for future use, select **SAVE** before selecting **APPLY**.
   - The customer records are filtered and displayed accordingly.

**Searching for Customer Records**

**To search for a customer:**

1. Display your customer list.
2. From the window toolbar, enter a search keyword, such as last name or phone number, and select **FIND CUSTOMER (<CTRL+F>).**
3. Enter a keyword or keywords by which you want to search.
   - Optionally, select **ADVANCED FIND OPTIONS** and select a specific field in which the search is to be conducted or specify other search options. Select **HELP** in the Find window for more information on search fields.
4. Select **FIND (<ENTER>).**
   - All customer records containing your search keyword are displayed. Highlight the customer you want to work with and choose **SELECT CUSTOMER**.
   - From the Search window, you can also:
     - Select **ADD NEW CUSTOMER** to open a form for adding a new customer record.
     - Select **CLOSE** to return to your full customer list.

**Tip: Searching for a Customer from Other Program Areas**

When customers walk in the door, you want to service them efficiently. There are several other ways to search for a customer without first opening your customer list:

- From a sales receipt, enter customer search keywords directly in the **Customer** field.
- From the Navigator, enter customer search keywords in the **Quick Find** field.
- From any window, select **FIND RECORD ➤ CUSTOMER** from the Edit menu.
**Editing a Customer Record**

Edit customer records as necessary to reflect changes in addresses, phone, or other options.

**To edit a single customer record:**

1. Select the record you wish to edit in your customer list.
2. Select **EDIT**. The customer record is opened.
3. Edit as necessary.
4. Select **SAVE**.

**To edit customer records in the list:**

This procedure is useful when you need to edit many records at once, such as when a phone area code changes.

1. In your customer list, sort or filter to display only the records you want to edit.
2. From the Edit menu, select **LIST EDIT ON**.
3. Navigate through the fields and rows as necessary, editing customers as needed. Your changes are saved automatically as you move between rows.
4. When finished, select **LIST EDIT OFF** from the Edit menu.

---

**Tip: Verifying and Editing Customer Information from a Sales Receipt**

After listing a customer on a sales receipt, key customer information is displayed on the document, such as address, phone number, accept check status, and account balance/limit. You can access the customer history from the I Want To menu. This allows you to get to know and service your customers better, and also lets you verify that the information is current. If an update is necessary, select **EDIT** to open the record in edit mode.

Activate the drop-down customer list; automatically activated by text entry in the **Customer** field.

Select the **EDIT** button to edit the listed customer’s record.

Select the **FIND** button to search for a customer.
Deleting a Customer Record

Customers can be deleted from Point of Sale at any time, provided that:

- They do not have an account balance
- (Pro) They are not listed on an open customer order with deposits taken

If you delete a customer record, you will no longer have access to that customer’s history, but the customer will remain listed on past documents and can be included in reports that are generated from those documents.

If you are deleting a customer because you have duplicates of the same customer, consider using the Merging Customer Records (page 310) procedure instead, as this will combine the two customer histories into one record.

To delete a customer record:

1. Select the customer record you wish to delete in your customer list. You can also select multiple records by holding down the <CTRL> key while selecting the records. See Selecting multiple records (page 102) for more information on using the multi-select feature.

2. From the I Want To menu, select DELETE CUSTOMER.

   A confirmation dialog will be displayed. If the customer has an outstanding account balance, you will not be able to delete the customer record.

3. If prompted, confirm the deletion and specify if you want to delete the record from QuickBooks financial software as well.

Deleting Customers If You Exchange Data With QuickBooks Financial Software

QuickBooks financial software users that share customer information must delete the customer record in their financial software in addition to deleting it in Point of Sale or it will be re-created in Point of Sale with the next Financial Exchange. If the customer is listed on documents in the financial software, it cannot be deleted in that program so it is made inactive instead. This also prevents it from being re-created on the next exchange.

(Pro) If you delete a customer, but later list that customer on a sales receipt (by referencing a customer order for the customer) the customer is re-created in both Point of Sale and QuickBooks financial software with the next Financial Exchanges.
Merging Customer Records

Sometimes two associates may enter the same customer with slightly different name spellings. This may result in duplicates in your Point of Sale customer list. The **Merge Customers** feature can be used to combine the sales history of both customers into a single record.

If you use QuickBooks financial software, you have the option of deleting or making inactive the duplicate customer in your financial software so that the record is not added back to Point of Sale with the next Financial Exchange.

**To merge duplicate customers:**

1. From the customer list, select the two records you wish to merge.
   - Select the first item and then hold down your `<CTRL>` key and select the second item.
2. Select **MERGE CUSTOMERS** from the I Want To menu.
   - The Merge Customers window is displayed.
3. Ensure that the customers displayed are the correct customers.
   - Make sure the customer you want to keep is listed in the Keep This Item column on the left and the customer to be discarded is on the right. If necessary, select **SWAP** between the columns to reverse the positions.
   - If necessary, you can use the drop-down item list to select other customers if one or both of the displayed customers is not correct.
   - If you use QuickBooks financial software, the customer names currently displayed in your financial software customer list is shown at the bottom of the window to help you verify you have the correct customers selected.
4. Select **MERGE CUSTOMERS**.

   A confirmation dialog will be displayed, showing the various documents and records that will be affected by the merge. The deleted customer will be replaced by the retained customer on the records listed.

5. Select **MERGE CUSTOMERS**.

   If prompted, specify if you want to delete the duplicate from QuickBooks financial software as well. The deletion in your financial software will occur with the next Financial Exchange.

---

**Using Customer Discounts and Price Levels**

Discounts and price levels associated with a customer are automatically suggested when making a sale to the customer.

Either a percentage discount or one of your price levels can be associated with a customer, but not both. Point of Sale will alert you to the discount when you list the customer on a receipt. You have the option of applying the discount or price level at the time of sale.

To define a customer discount:

1. Access the Additional Info tab on the customer’s record.
2. Select the **APPLY A FIXED PERCENTAGE TO ALL ITEMS** in the Customer Discounts section.
3. Enter a discount percentage in the field (do not enter the % sign).
4. Select **SAVE**.
   
The discount is taken from the active price level for the sale.

**To define a customer price level:**

1. Access the Additional Info tab on the customer’s record.
2. Select **USE A DISCOUNTED PRICE LEVEL FOR THIS CUSTOMER** in the Customer Discounts section.
3. Select one of your predefined price levels in the drop-down list.
4. Select **SAVE**.

---

**Handling Special Customer Sales Tax**

A customer can be associated with a sales tax location or flagged as tax-exempt so that the correct tax rate is applied on sales to the customer.

When a tax location is specified for a customer, that tax location is suggested when the customer is listed on sales documents. You can choose whether or not to apply the tax location to each sale.

If flagged tax-exempt, Point of Sale automatically uses a special *Exempt* tax location for the sale with a 0% tax rate.

**To associate special tax handling with a customer:**

1. Select the Additional Info tab on the customer’s record.
2. Select a tax location from the **USE THIS TAX LOCATION** drop-down list.

   or

   Select the **TAX-EXEMPT** checkbox.

3. Select **SAVE**.

Refer to **Sales Tax Overview (page 339)** for more information about configuring and collecting sales taxes.
**Tracking Customers by Type**

Customer types let you categorize your customers in ways that are meaningful to your business. For example, you could set up your customer types so that they indicate whether a customer is a business or individual customer, their geographic location, or how they first heard about your business.

You can create reports and do special mailings that are based on your customer types. For example, if you use customer types to categorize your customers by location, you could print mailing labels for all the customers in a particular region.

Define your customer types in company preferences and then associate a type with each customer on their individual records.

**Preferences: Tracking Customer Types**

PREFERENCES ➤ COMPANY ➤ CUSTOMERS ➤ Customer Types: Define the categories or types you wish to use to track customers. You can add, edit, delete, and arrange the order in which the types will be displayed on the drop-down list in the Customer Type field on the customer form.

**Notes on using customer types:**

- You can print customer mailing lists from the reports area. Choose REPORTS ➤ CUSTOMERS ➤ CUSTOMER LIST and filter the report by customer type. If needed, a customer list report can be exported to Microsoft Excel.
- It's generally better to use customer types to categorize customers for only one purpose. For example, trying to set up customer types for both tracking geographic area and how customers heard about you is not recommended.
- (Pro) To be able to identify customers by more than one category, you can for example use customer type for geographical information and define a custom field for customer source.

**Viewing a Customer’s Purchase History**

Customer history allows you to view summarized statistical data for customer purchases and returns, as well as displaying a list of receipts and, for Pro users, all non-deleted customer orders made for the customer.

**To access customer history from the customer list:**

1. Highlight a customer record in the list.
2. Select the COLLAPSE button at the top of the customer list.

The Information Panel for the customer is displayed, which includes the customer’s purchase history, as shown in the following image.
Or

View the customer form and select the HISTORY tab.

To refresh the screen press <F5> (this may be necessary if a sale has been made while the window is open).

(Pro) If you delete customer orders once they are filled, the deleted orders are no longer displayed in the customer’s history, and the information from deleted orders is not included in the summarized statistical information. However, the sale of the merchandise on deleted customer orders is reflected in the receipt and sales information shown in the window.

(Pro Multi-Store) Customer history at remote stores includes only the receipts and/or customer orders created for the customer at the local store.

Drag-and-drop column headers or separators to rearrange their positions and width as preferred.

💡 Drilling-Down With QuickZoom

You can “drill-down” into a customer’s history to see document item detail or to view the entire document in a separate window. Select the + sign on a line to expand the list and view item detail. With the QuickZoom icon is displayed, double-click to open the document.

To view or copy a receipt or customer order:

1. Highlight a document on the Customer History window.
2. Use QuickZoom as described above or select an option from the I Want To menu:
   - **GO TO DOCUMENT** to view the document. Once you are in the document, you can view, copy or reverse it as needed.
   - **RETURN ITEM ON THIS SALE** to copy the original receipt information to a new return receipt.
   - **EXCHANGE ITEM ON THIS RECEIPT** to make an item exchange for the customer.
• **PRINT HISTORY** to send the customer history to your printer.

If you came to the Customer History window from a sales receipt, you will have to switch back to that receipt and cancel, hold, or complete it before you can copy from history to another new receipt. *(Only one of any document type can be open at a time.)*

**To view customer history from a sales document:**

1. List the customer on the document
2. Select **VIEW CUSTOMER HISTORY** from the I Want To menu at the top of the screen.

**Customer Ratings**

Customer ratings use a familiar five star system, reflecting the performance of the customer over the specified time period (1-999 days). Each star represents 20% of the range between your highest volume customer and your lowest.

For example, if ranking by sales volume and the range of customer purchases for the period is from $1 to $100, customers buying from $1 and $20 would receive 1 star, buying $21-40 is rated two stars, etc., up to a five-star rating for purchases of $81-100. In theory, all of your customers could be five-star performers.

You can add the ratings column to your customer list and to the customer information panel displayed when you view your list in a collapsed format.

Customer rating work in the same manner as item ratings in inventory. See **Inventory Ratings and Trends (page 147)** for more information on using and defining preferences for ratings.

![Customer Ratings Table](image)
Chapter 18: Customer Records and History

In-Store Charge Accounts

Point of Sale allows you to offer and manage in-store charge accounts for your customers. If you are integrated with QuickBooks financial software, account information is shared; sales on account can be made in Point of Sale and invoices can then be created in your financial software.

This section gives an overview of store charge accounts and explanations of the related fields on the customer record. Refer to Payment By or On Account (page 400) for more information about recording sales by account charge or accepting payments on account.

Point of Sale integration with Microsoft Office enables you to easily write letters to charge account customers. Refer to Writing and Printing Letters (page 130) for more information.

Issuing a Store Credit

If you wish not to offer cash refunds on merchandise returns, one option is to issue a store credit by giving the customer an in-store charge account and applying the credit amount as a payment on account. The customer can later use this positive balance for purchases.

Customer Account Fields

The image at right includes Point of Sale customer fields that are used for allowing charges to account. These fields can be seen on the Additional Info tab of the customer record.

Use charge account for this customer. Select this to activate the in-store charge account for this customer.

Account Limit. The maximum charge balance allowed for the customer. If you are using QuickBooks, this can be edited in either program. During Financial Exchanges, the last edit overwrites the limit in the other program. In QuickBooks, the corresponding field is called Credit Limit.

Account Balance. The customer’s current account balance. The account balance is updated by Point of Sale when making a new charge or taking payment on account. If you are using QuickBooks, the balance in Point of Sale is overwritten.
In-Store Charge Accounts

with the balance from QuickBooks with every Financial Exchange. This ensures the Point of Sale balance reflects any finance or other charges you may have added in QuickBooks

**Available Credit.** This is a calculated field:

Account Limit minus Account Balance equals Available Credit.

When you go to take payment by account charge in Point of Sale, the program checks the available credit and does not allow the charge if the amount exceeds this value. Sufficient security rights allow the user to override this block. If you are requiring users to log in and the user does not have sufficient security rights, the Manager Override function can be used to allow the charge. *(Refer to Manager Override (page 70) for more information.)*

**Past Due.** Past due amount as reported by QuickBooks financial software. With preferences set accordingly, if an account is past due, Point of Sale alerts you and blocks additional charges. *(Refer to Past Due Accounts (page 319) for more information on tracking past due accounts.)*

**Using Charge Accounts with QuickBooks Financial Software**

If you have Point of Sale integrated with QuickBooks, the following apply to customer charge accounts:

- Sales charged to account are sent to QuickBooks with each Financial Exchange and create customer invoices and are added to the account balance.
- QuickBooks can inform Point of Sale regarding accounts that are past due by 30, 60, or 90 days, as well as the amount due. Point of Sale can block additional charges until payment is made.
- Payments on account can be taken in either program; this will update the other with the next Financial Exchange. If taken in Point of Sale, a customer payment is created in QuickBooks. It is important that you apply this payment to open customer invoices in your financial software so that the corresponding account balances are updated accordingly. If payment is taken in QuickBooks, the payment is reflected in the updated account balance sent to Point of Sale with the next exchange.

**Setting a Customer’s Account Limit in QuickBooks Financial Software**

The customer’s in-store account limit can also be defined in QuickBooks financial software:

1. From your customer list in QuickBooks financial software, open the Edit Customer window for the customer.
2. Select the Payment Info tab.
3. Type in the preferred credit limit and then select OK.
Chapter 18: Customer Records and History

**Importing Existing Account Balances**

If you have customers with existing charge accounts and balances when beginning to use Point of Sale, you can use the Data Import Tool to bring the entire customer record or just the balances into Point of Sale. Select UTILITIES > IMPORT from the File menu and follow the on-screen instructions. Refer to The Data Import Wizard (page 124) for more information.

---

**Tracking Customer Charge Accounts**

Whether you manage customer account balances within Point of Sale or within your financial software, it is helpful to view account status and activity in Point of Sale.

**Account Balances and Available Credit**

Charging a new sale or taking a payment on account updates the account balance and, if applicable, the past due amount and status in Point of Sale immediately, without requiring a Financial Exchange with QuickBooks. The information will be synchronized on the next Financial Exchange.

You can view account balances at a glance by adding the Account Balance column to your customer list. Refer to Customizing Columns in Lists (page 586) for more information on adding columns to your customer list. You can also view account balanced and available credit on a sales receipt after adding the customer.

---

**Multi-Store: Exceeding a Customer's Account Limit**

If you make two or more sales at different store locations charged to a customer's account between Store Exchanges, neither individually exceeding the customer's available credit, it is possible for the total to exceed the credit limit. Once you have performed a Store Exchange, the customer is not allowed to make further charges until a payment is made.

---

**Account Activity Report**

Point of Sale offers a special report that displays all account activity, including charges to an account, and payments toward account balances.

**To view the Account Charges report:**

1. From the Report Center, select PAYMENTS > PAYMENTS AND RECONCILIATION.
2. Select the ACCOUNT CHARGES report.
3. Edit the report as desired.
   Payments made on account are displayed in parenthesis.
Past Due Accounts

If you use QuickBooks financial software, Point of Sale can let you know when a customer’s account is past due and block additional charges to the account. By default, alerts and blocking of additional charges takes effect when an account is past due by 30 days. You can turn off blocking or change the past due period to 60 or 90 days in company preferences.

The past due amount and periods are received from QuickBooks during Financial Exchange.

Preferences: Setting Your Past Due Reporting and Blocking Charges

PREFERENCES ➤ COMPANY ➤ SALES ➤ RECEIPT TENDERING ➤ Past Due Payments:
Select a 30-, 60-, or 90-day time period when indicating that you wish to block new charges to past due accounts.

Past Due Calculations in QuickBooks

The past due amount and time is calculated in your QuickBooks financial software and sent to Point of Sale during Financial Exchange. You can adjust your QuickBooks settings to determine how this feature works:

- Customer terms in QuickBooks determine payment due dates for charge transactions made in Point of Sale. Terms cannot be set in Point of Sale.
- Your preference setting for the QuickBooks A/R Aging Report determines if past due aging is based on the payment due date or the transaction date. In QuickBooks, set this preference by selecting EDIT ➤ PREFERENCES ➤ REPORTS AND GRAPHS ➤ COMPANY PREFERENCES ➤ Aging Reports.
- If no terms are defined in QuickBooks for the customer, due dates are based upon the transaction date.

Overriding Account Blocking

When a customer with a past due amount makes a new purchase, both the receipt and the payment window (shown below) display an alert and the past due amount.
Additional charges to the account are blocked. However, if you are using Point of Sale security logins, you can set security rights that determine who can override an account charge block. Of the default security groups, only the Associate group cannot override past due charge blocking.

The Manager Override function can be used to allow the charge if blocked to your Associates. (Refer to Manager Override (page 70) for more information.)

For more flexibility, you can customize your security groups. Refer to Working with Security Groups (page 71) for more information.

**Locating Past Due Accounts**

You can identify which customer accounts are past due by sorting your customer list by the Account Balance column. Refer to Customizing Columns in Lists (page 586) for more information on displaying and arranging columns.

If you view the customer list in collapsed view, three columns are displayed to the left. You can customize which columns are displayed. By displaying the Account Balance column, you can sort by this column to bring all past due accounts together. You can then easily select the customer records to view specific transaction details for a customer in the Information panel, including charges and payments on account. Refer to Information Panel (page 103) for more information.

The Past Due field is also available to add to customer reports in the Report Center.

**Letters to Charge Account Customers**

Point of Sale integrates with Microsoft Word. This allows you to write letters to customers either one at a time or to a group of selected customers. A letter template is included for past due accounts. Refer to Writing and Printing Letters (page 130) for more information.
Printing/Exporting Your Customer Records

To print/export your customer list:

1. Display your customer list.
2. To include only selected customers, filter the list to display only those customers. You can also select multiple records by holding down the `<CTRL>` key while selecting the records. See Selecting multiple records (page 102) for more information on using the multi-select feature.
3. From the Print menu, select PRINT

OR

To export to Excel, select EXPORT TO EXCEL from the I Want To menu. See Exporting a List to Excel (page 127) for more detailed information on exporting to Excel.

Refer to Chapter 3 General Printing Information (page 39) for additional printing information.

Printing a Customer List Report

Printing customer lists from the reports area gives you more flexibility in customizing the layout, data to be included, font, and other display properties, as well as allowing you to export the list to Excel.

To print a customer list report:

1. From the Reports menu, select either:
   - CUSTOMERS ➤ GENERAL - CUSTOMER LIST to print a general customer list report.
   - CUSTOMERS ➤ GENERAL - CUSTOMER SALES to print a customer list filtered by purchases made. Customers who have not made a purchase will not be included on this report.

The selected report is displayed.

2. Select MODIFY to change report options as needed, e.g. filtering the data, display options, sorting, etc.

3. Select OK. The report is displayed on-screen.

Select MEMORIZE and give the report a unique name if you want to save these report options for future use.
4. Select **PRINT** to print the report, or **EXCEL** to export the report to an Excel file. Refer to Chapter 26 Reports and Sales Charts (page 459) for more information on running reports.

**Printing Customer Labels**

Use this option to print customer name labels or shipping/mailing labels from your customer form or list. Refer to Printing Mailing or Shipping Labels (page 50) for details.

(Pro) Shipping labels can also be printed while adding shipping information to a sales receipt. Refer to Recording Shipping Information (Pro) (page 365) for more information.

**Customer ID Numbers and Cards (Pro)**

Customer IDs are automatically assigned to new customers and can be used to print scannable ID cards. ID cards can be scanned while making a sales receipt, in either the **Enter Items** or **Customer** fields, to quickly add the customer to the receipt.

ID card print templates are included in Point of Sale. When printing paper customer ID cards, it is recommended that these be laminated to protect the legibility of the barcode on the card. ID cards can be printed from the customer record; select the **PRINT ID CARD** button on the Name & Address tab.

**About ID Number Formats**

Customer ID numbers are generated automatically in Point of Sale in a special format that allows scanning the ID barcode in either the item or customer fields on a receipt. While you can edit these numbers or use your own format, be aware that you will lose this ability, and in fact may inadvertently list an item on a receipt if you scan a differently formatted ID card in the item field. If you change the format you will need to be in the customer field to utilize barcode scanning for listing the customer.

If you are having customer ID cards created for you, consider requesting this 13-digit format:

```
04 00001 00001 4
```
Using the previous example, the format is defined as follows:

04: 2-digit System Identifier. This ensures the ID is not seen as a UPC or other identifier. Always use this system identifier to indicate a customer ID.

00001: 5-digit Store Number. A second store would be 00002, etc.

00001: 5-digit Customer Number. Increments for each new customer.

4: Check-digit. This is a calculated number used to verify the ID format.

To assign an ID card using a different numbering system to a customer record, remove the generated number and, with the focus still in the Customer ID field, enter the number or scan the barcode you are assigning.

Customer Rewards Program (Pro)

Many retailers offer return incentives to customers by providing extra savings to repeat customers, based upon their spending level. Also referred to as a Customer Loyalty program, this can be a very effective tool for maintaining and expanding your customer base.

You define the parameters of your rewards program in the Rewards Manager, available from the Customer menu. New customers can be added to the program automatically or selectively as you make sales (or on their customer record).

Point of Sale tracks purchases for each program member and alerts the cashier when a reward is earned or when a reward is available for redemption. Merchandise returns are subtracted from the current purchase tracking balance. By default, rewards earned and rewards redeemed are printed on customer receipts, as is the spending amount needed to qualify for the next reward.

Reward Redemption reports are available for tracking purposes, and reward discounts are also added to the item grid of saved receipts for later viewing. If you are requiring employees to log in, access to the Rewards Manager and to redemption reports are controlled by security rights.
Legal Considerations for Rewards Programs

Legal requirements for a rewards program may vary depending on where and how you do business.

It is your responsibility:

- To know and abide by any local, state, or federal laws regarding reward and coupon issuance applicable to your situation
- To draft rewards program Terms and Conditions and/or other limitations and communicate those terms and conditions to customers as required by applicable laws
- To include (or exclude) on the printed sales documents given to customers, information regarding your rewards program or individual rewards as required by applicable laws and your own program terms and conditions

If necessary, printed sales documents can be customized within Point of Sale using the Print Designer. Refer to Chapter 35 Customizing Printed Documents (Pro) (page 593) for more information.

Reward Program Terminology

**Reward Manager:** Point of Sale program window where you define the parameters of your Rewards program.

**Rewards Member:** Any customer that has been enrolled as a member in your program. Point of Sale automatically tracks reward members’ purchases and rewards.

**Purchase Threshold:** The amount a customer must purchase during the purchase tracking period to earn a reward. Another reward is earned each time the customer purchases reach this amount.
**Purchase Tracking Period:** Time period within which purchases must be made to qualify for rewards. Specify a start and end date; or leave end date open-ended.

**Reward Amount:** The reward value earned when a customer meets the purchase threshold. This can be defined as a dollar amount or as a percentage off a future purchase.

**Expiration Date:** (Optional) Date an issued reward is no longer valid for redemption.

**Earned Reward:** Pending reward that has been earned but not yet redeemed.

**Purchase Balance:** A customer’s current sales accumulation toward earning her next reward.

**Reward Redemption:** The act of applying a customer reward to discount a new purchase.

**Redemption Blocking Period:** Period after the qualifying sale in which redemption of an earned reward is not allowed. This can be set to the length of your return policy to help avoid returns of items for which a customer has already earned and redeemed a reward.

**Qualifying Purchases/Redemptions:** Qualifying purchase and redemption items are indicated in the table below. To qualify, items must be purchased within the purchase tracking period. The return of a qualifying item reduces the customer’s current purchase balance.

<table>
<thead>
<tr>
<th>Item/Payment Type</th>
<th>Qualifies for Reward Earning</th>
<th>Qualifies for Reward Redemption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory, Non-Inventory, Service, Assembly, and Group items</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sales tax</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Shipping charges</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Gift card/certificate purchase</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Gift card/certificate redemption</td>
<td>No impact</td>
<td>No impact</td>
</tr>
<tr>
<td>Charges to customer account</td>
<td>No impact</td>
<td>No impact</td>
</tr>
<tr>
<td>Payment on customer account</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Defining your Rewards Program

All settings for your Customer Rewards program are controlled through the Rewards Manager.

To define your rewards program:

1. Select **REWARDS MANAGER** from the Customer menu.
2. Enter an amount for **Purchase Threshold**.
3. Specify the **Reward Amount**. Select from the drop-down list to define if the reward will be in dollars or a percentage off.
4. Specify a **Reward Expiration** period. Be sure to consider local legal requirements when making this choice.
5. Specify the **Reward Tracking Period**. You must enter a Start date; the End date is optional. To leave the program open-ended, select the **NO END DATE** checkbox.
6. In the Rewards Options area, make selections for how you wish to enroll members, be alerted when rewards are earned, and set a redemption blocking period.
7. If not already set, select **TURN TRACKING ON**.
8. Select **SAVE**.

Links to two Rewards Program reports are provided in the Status area.
Enrolling Customers in the Rewards Program

To enroll all existing customers:
1. Select **REWARDS MANAGER** from the Customer menu.
2. Select **ENROLL ALL EXISTING CUSTOMERS** from the I Want To menu.

To enroll individual customers:
Depending on your program options, you may be prompted to enroll non-members as sales are made to them. Simply elect to do so at that time.

You can also enroll a customer at anytime by editing their record or while adding a new customer.
1. Display the customer record.
2. On the Name & Address tab, select **REWARDS MEMBER**.
   Or
   On the Rewards tab, select **TRACK THIS CUSTOMER FOR REWARDS**.
3. Select **SAVE**.

Managing Individual Customer Rewards

Individual customer rewards are managed from the Rewards tab of the customer record. This panel allows you to do the following for the displayed customer:

- Turn reward tracking on or off for this customer
- Manually add or remove earned rewards
- View rewards status
- View a participation summary
- Print a detailed redemption history
At the bottom of the panel, the details of your rewards program are displayed, as well as a button to launch the Reward Manager.

Re redeeming Customer Rewards

When making a sale to a rewards member, you can view the reward status by placing your mouse pointer over the green Rewards icon near the bottom of the receipt.

If the sale includes qualifying items and a reward is available for redemption, Point of Sale will alert you when you select **TAKE PAYMENT**. You (or the customer) can elect to apply the reward or save it for a future purchase.

Refer to **Redeeming Customer Rewards (Pro) (page 362)** for more information on redeeming rewards.
Chapter 19  
Sales and Tax Overview

Sales Overview .......................................................... 330
Receipt Types ........................................................... 330
Tracking Sales and Returns ........................................... 331
General Sales Preferences .............................................. 331
Receipt Basics ........................................................... 332
Accessing Receipts and Sales History ............................... 332
The Receipt Form ....................................................... 332
Effects of Saving a Receipt ............................................ 333
Cancelling and Holding Receipts ..................................... 333
Opening the Cash Drawer .............................................. 335
Paying Money Out of the Cash Drawer (Pay-outs) ............... 336
Shipping Manager (Pro) ............................................... 337
  Important Information about Shipping Manager: ................. 337
  Setting Up Shipping Manager .................................... 338
Sales Tax Overview ..................................................... 339
  Sales Tax Codes and Locations ................................... 340
    Tax Codes .......................................................... 340
    Tax Locations ...................................................... 341
Setting Up Your Sales Taxes .......................................... 342
Sales Overview

This chapter introduces sales receipts and discusses some of the basic features related to making sales and setting up sales tax.

- For step-by-step instructions in making a sale, see Chapter 20 Sales Transactions (page 347).
- For specifics related to each payment type accepted in Point of Sale, see Chapter 21 Receipt Payment Types (page 381).
- For information on running various sales reports, see Chapter 26 Reports and Sales Charts (page 459).
- (Pro Multi-Store) Both Headquarters and remote stores can create sales receipts; Headquarters for any store, remotes for their own store only. Refer to Chapter 31 Multi-Store Basics (page 533) for more information about recording sales and returns in a multi-store configuration.

Receipt Types

There are four types of receipts in Point of Sale:

- Sales receipts provide a permanent record of merchandise sold from inventory or returned from a customer.
- Pay-out receipts record money paid out of the cash drawer for various reasons, such as to buy office supplies, donate to a local charity, or simply to remove some of the cash in the drawer for security reasons.
- Return receipts provide an alternative method to record the return of merchandise from customers.
- (Pro) Deposit receipts record deposits taken on customer orders.

Merchandise Returns and Exchanges

While Point of Sale provides both sales and return receipts, you can just as easily process a return on a sales receipt. This is particularly useful, when doing a merchandise exchange, as you can list both the item being returned (enter as a negative quantity) and the new replacement item (enter as a positive quantity) on a single receipt. Point of Sale will calculate any payment or change due from/to the customer. Refer to Chapter 22 Returns, Exchanges and Sales History (page 403) for additional information on handling returns and exchanges.
Tracking Sales and Returns

All saved receipts are stored in your sales history list. Saved receipts are permanent transactional documents that allow only limited editing and that can be deleted only by using the Cleanup Company Data utility.

Saved receipts can be easily looked up to confirm an earlier sale, be reprinted, or be copied to quickly create a new identical receipt. Your sales history is drawn upon when you run Point of Sale sales reports.

To learn more about sales history, refer to Chapter 22 Returns, Exchanges and Sales History (page 403).

If you record customers on receipts you are building a sales history for each customer that can be a valuable customer service and marketing tool. Refer to Viewing a Customer’s Purchase History (page 313) for more information.

If you integrate Point of Sale with QuickBooks financial software, all receipts are sent to your financial software during Financial Exchanges to update your financial records and to post customer charges and payments to their accounts. Refer to Chapter 29 How QuickBooks Handles Point of Sale Data (page 497) for more information.

General Sales Preferences

Sales preferences allow you to define various options related to sales transactions, including:

- Printed receipt messages
- Which payment types and credit cards you accept
- Which payment types open your cash drawer
- When to block charges to past due accounts
- Whether you want to collect tips on non-cash sales
- (Pro) Shipping providers and using Shipping Manager

To learn more about sales preferences, refer to Appendix A Preferences (page 617).
Receipt Basics

Accessing Receipts and Sales History

From the Point of Sale menu, select one of the receipt options:

- NEW SALES RECEIPT
- NEW RETURN RECEIPT
- NEW PAY-OUT
- SALES HISTORY (to view saved receipts)
- HELD RECEIPTS (to view or un-hold receipts that are currently on hold)

The default main toolbar layout also has a shortcut button to the NEW SALES RECEIPT option for convenience.

The Receipt Form

Shown above is the Point of Sale receipt form. Your receipt form may look slightly different, depending on your level of Point of Sale and any customizations you have made. Refer to the following explanations that correspond to the numbered callouts.
Receipt Basics

1 Receipt Item List
Displays the items being sold or returned. You can add, remove, resize, and rearrange the item columns to meet your needs. Refer to Customizing Columns in Lists (page 586) for more information.

2 Customer Information
If you list customers on your receipts, basic information is displayed here, such as address and whether to accept checks, and you can access and view or edit the customer record.

3 Totals Area
Displays the sale price level, subtotal, and total amount due, as well as global discounts, sales tax amount, and, for Pro users, shipping charges.

Effects of Saving a Receipt

- Deducts quantities from inventory (sale) or adds returned quantities back to inventory
- Updates the Last Sale date on the customer’s record
- Updates customer account balance and available credit on applicable sales
- Files the receipt in the sales history file
- Advances the receipt numbering sequence by 1
- Opens the cash drawer and displays the change window, on relevant sales
- (Optionally) Prints a copy of the receipt for the customer
- (Optionally) Logs the current user out of the program (preference setting)
- Returns you to a new blank sales receipt form (if not logged out)
- (Pro) Updates a referenced customer order (if the order has not been deleted)

Cancelling and Holding Receipts

A receipt in progress can be canceled or put on hold before saving. Canceling a receipt permanently discards it. No record is kept and inventory is not affected. With a receipt on hold, you can carry out other activities, make other sales, or even exit from Point of Sale. Holding a receipt does not affect inventory quantities. Later, you can
return to a held receipt, “unhold” it, and complete the sale, at which time inventory will be updated.

---

**Cannot Hold Authorized Credit, Debit, or Gift Card Receipts**

If you use QuickBooks POS Merchant or Gift Card Services, you cannot place a receipt on hold once the transaction has been authorized. However, you can cancel or void credit card and gift card receipts before saving. In the case of voiding a credit card payment, the cardholder’s account is not charged. Canceling a gift card receipt after authorizing results in the gift card payment amount being returned to the gift card balance (Point of Sale connects to the service a second time to accomplish this).

---

**To cancel a receipt in progress:**

1. Select **CANCEL** in the lower right corner of your screen.
2. Select **YES** to confirm.

**To hold a receipt in progress:**

- Select **HOLD RECEIPT** in the lower left corner of your screen.

Held receipts are stored in the held receipts list. If you have already entered payment information, with the exception of payment cards as explained above, that information is stored with the held receipt.

**To retrieve a held receipt:**

1. Select **HELD RECEIPTS** from Point of Sale menu or from the bottom of a new receipt form to display the list of held receipts.
2. Locate and highlight the required receipt, and then:
   - To unhold the receipt, select **UNHOLD RECEIPT**.
   - To view the held receipt, without unholding it, double-click it.
   - To leave the held list without unholding a receipt, press `<ESC>` or make any other menu selection.
   - To delete the held receipt, select **DELETE**.

Unholding a receipt returns it to active status. Items can be added, deleted, or edited as necessary. Take or edit payment information, as necessary, and save/print the receipt normally.
Opening the Cash Drawer

If you have a properly configured compatible cash drawer, it will open when you save a receipt using the payment methods you have specified in company preferences. The cash drawer can also be opened manually, subject to security rights.

Preference: Payment Methods that Open Cash Drawer

PREFERENCES ➤ COMPANY ➤ SALES ➤ Open Cash Drawer: If you have a cash drawer installed, select the payment methods that open it when you save and print a receipt. Defaults are cash and check.

To open the cash drawer manually:

• From the Point of Sale menu, select OPEN CASH DRAWER (CTRL+ F8).
Paying Money Out of the Cash Drawer (Pay-outs)

Cash sometimes needs to be removed from the cash drawer for various purposes. For example, you may remove cash from the cash drawer to buy office supplies, donate to a local charity, or to purchase pizza for the office party. Retailers may also routinely conduct “cash drops,” where a portion of the cash is removed from the cash drawer to lessen the amount exposed to possible theft or loss. The Pay-out feature allows you to record the removal of cash from the cash drawer.

**To conduct a pay-out:**

1. From the Point of Sale menu, select **NEW PAY-OUT**.
   The Cash Paid Out dialog is displayed.
2. Enter your name in the **Cashier** field (if logins are required, this field is populated with the logged-in user’s name).
3. Enter the amount being removed from the cash drawer in the **Amount** field.
4. If you are using QuickBooks financial software, select a QuickBooks account from the drop-down list in the **Account** field. This is the account that the pay-out amount will be balanced against in your financial software. *Refer to Cash Drawer Pay-Outs (page 502)* for more information about how Pay-outs are handled in QuickBooks financial software.
5. Enter a comment in the **Comment** field. A comment is required. This field is typically used to record what the cash was used for.
6. Select **OK**. A Pay-out receipt is generated and put in your sales history. The amount of the pay-out is recorded as a negative amount.

**Preferences: Default Pay-out Account**

**PREFERENCES ➔ COMPANY ➔ FINANCIAL ➔ ACCOUNTS ➔ ADVANCED:** Specify the default QuickBooks financial software account to which pay-outs are posted. This account is suggested when pay-outs are conducted, but is editable. Default: Pay Out Expenses.

**Paid Outs on Cash Drawer (X/Z-Out) Reports**

On Cash Drawer reports, the term “paid out” refers to payment given to the customer for any reason, such as change or refunding a returned item. However, in the list of non-currency media contained at the end of Cash Drawer reports, there is a list of Pay-Outs, meaning cash removed from the cash drawer using the Pay-Out feature as described above.
Shipping Manager (Pro)

The QuickBooks Shipping Manager is an integrated shipping solution that allows you to obtain shipping quotes, add the shipping charges and information to sales receipts, and print shipping labels. With the QuickBooks Shipping Manager, you can process a shipment and prepare a shipping label—with the “ship to” information pre-filled—directly from Point of Sale sales receipts and customer orders. You can also track or cancel shipments, and view online shipping reports.

Important Information about Shipping Manager:

- You must have an account with UPS to use Shipping Manager. Links are provided within Shipping Manager to sign up for an account, if necessary.
- The UPS functionality of this product is available only for packages shipped from the United States of America.
- You must set up Shipping Manager on each workstation that will use it. You can share the same account number on all your workstations.
- The workstation(s) on which you will use Shipping Manager must have Internet access.
- Shipping Manager has its own help system to assist you with settings and its shipping forms. Select HELP from the right-hand menu within Shipping Manager.
- All amounts from Shipping Manager are estimates only, based on information provided by you, and subject to final verification by the carrier.
- To ship items sold in Point of Sale, select a shipping option from the receipt and not from the Point of Sale menu. Shipments made from the Point of Sale menu are not “attached” to a specific sale and will not show up in Point of Sale shipping reports (although they will be in Shipping Manager reports).
- If integrated with QuickBooks financial software, Shipping Manager shipments made from QuickBooks appear on the same shipping history in Shipping Manager as those made from Point of Sale (unless you have set up separate accounts).
Setting Up Shipping Manager

To use Shipping Manager, you must first turn the feature on in company preferences. You will also need a shipping account with UPS.

To configure Shipping Manager:

1. From the Point of Sale menu, select **QUICKBOOKS SHIPPING MANAGER ➤ UPS SHIPPING OPTIONS ➤ SETTINGS**.
   The Shipping Manager Setup Wizard is launched.

2. Follow the wizard's instructions to enter your account number, company information, and other basic shipping options.
   The wizard will connect and confirm your account is set up.

3. When the Shipping form is displayed, select **SETTINGS** from the menu at the right to configure more advanced options, such as:
   - Rate options, such as a preset shipping markup, minimum charge, or handling charges
   - Printer and label setup
   - Electronic scale setup (Shipping Manager supports the Mettler Toledo PS60 USB scale)
   - Other default shipping and connection settings

4. Select **OK**.

Shipping Manager is now ready to use on your sales! Refer to **Recording Shipping Information (Pro)** (page 365) for information on using Shipping Manager from a sales receipt.

Tip: Shipping Reports

**Point of Sale**: Shipping reports are available in the Sales category of the Report Center. These reports include Shipping Manager and non-Shipping Manager shipments made from a sales receipt.

**Shipping Manager**: Within Shipping Manager, you can view your shipping history and run a Shipping Detail report. Select **VIEW** from the right-hand menu within Shipping Manager.
Sales Tax Overview

If you charge sales tax, you can setup a sales tax structure in Point of Sale so that sales taxes are automatically collected on sales of taxable merchandise.

Point of Sale sales tax features include:

- **Sales tax codes** - to collect sales tax based on the type of merchandise being sold. You can set up an unlimited number of sales tax codes and assign them to your inventory items. Within your tax codes, you set up tax options:
  - Single tax rate for all items assigned this code.
  - Multiple tax rates to collect taxes for multiple agencies.
  - Price-dependent tax taxes, which can be used with single or multiple tax rates, to collect taxes based on item price thresholds.

- **Sales tax locations** - to apply different taxing instructions for your tax codes based on where or to whom the items are sold, such as for sales to out-of-state customers or to collect different tax rates for stores located in different areas.

- **Customer tax flags** - to automatically collect tax on sales to a specific customer based on the tax location or tax-exempt status identified on the customer’s record. Refer to **Handling Special Customer Sales Tax** (page 312) for more information.

- **Changing tax codes or locations at time of sale** - to meet special tax circumstances. Refer to **Changing Tax Codes/Locations at the Time of Sale** (page 364) for more information.

- **Collecting tax on shipping charges** - to meet local requirements.

- **Sales tax reports** - to report on sales tax collected.

As you complete the Setup Interview, you are asked to enter your sales tax rate and the agency to which you pay the sales taxes collected. Based on this information, Point of Sale creates two default sales tax codes (one taxable and one non-taxable) for a single tax location, identified as *Local Sales Tax*. If your situation requires additional taxing flexibility, you can add, delete, or edit sales tax codes or locations in company preferences at anytime.

When you make a sale, sales tax is automatically calculated and added to all taxable items according to your tax structure. The item tax code identifies an item as taxable or non-taxable, but the sales tax locations, rates, and price thresholds you have defined determine the amount of tax collected on each sale.
Sales Tax Codes and Locations

Tax Codes

Sales tax codes identify the tax status of items in your inventory, such as taxable and non-taxable, and the specific taxing instructions for those items.

You may be required to tax different item categories differently, to collect tax for more than one taxing agency, or to collect tax based on item price thresholds. In these cases, you should set up separate tax codes to meet these various requirements and then assign the codes to applicable items in inventory.

Example: Different Tax Rates based on Merchandise Category

In your area, sale of jewelry is taxed at one rate, sale of other taxable merchandise at another rate, and other merchandise not taxed at all. You would set up three sales tax codes:

<table>
<thead>
<tr>
<th>Tax Code</th>
<th>Tax Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jewelry</td>
<td>10.0%</td>
</tr>
<tr>
<td>Tax</td>
<td>7.5%</td>
</tr>
<tr>
<td>Non Tax</td>
<td>0%</td>
</tr>
</tbody>
</table>

In inventory, assign these tax codes to your items based on the category of merchandise they fall in. When making sales, the correct tax rate will be applied to each item and the sales tax collected.
Example: Price-Dependent Tax

In your area a 7.5% tax rate applies to clothing only if the unit price exceeds $100, but other taxable items are taxed at any price. Add a separate tax code for clothing with a $100 price threshold.

<table>
<thead>
<tr>
<th>Tax Code</th>
<th>Applied to:</th>
<th>Price Threshold</th>
<th>Tax Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clothing</td>
<td>Clothing</td>
<td>over $100</td>
<td>7.5%</td>
</tr>
<tr>
<td>Taxable</td>
<td>All other taxable items</td>
<td>any price</td>
<td>7.5%</td>
</tr>
<tr>
<td>Non Tax</td>
<td>Non-taxable items</td>
<td>n/a.</td>
<td>0%</td>
</tr>
</tbody>
</table>

Tax codes can also be created which contain multiple tax rates with or without price thresholds. Once created, a tax code will be available in every tax location in Point of Sale, and if needed, you can apply a different tax rate and other taxing options to each location by editing the tax code for that location. Refer to Setting Up Your Sales Taxes (page 342) for more information.

Tax Locations

Multiple sales tax locations can optionally be used to define the specific taxing instructions for each tax code in different geographical areas or for customers requiring special tax handling. Sales tax locations work in conjunction with tax codes to apply the correct tax to sales transactions based on geographic location or special tax handling needs.

One default location, named Local Sales Taxes, is entered for you; you must have at least one tax location and the default location cannot be deleted unless you enter new locations. Add as many tax locations as you need. Two examples of the use of tax locations are presented below.

Example 1: Tax-Free Sales Based on Customer Location

Sales to customer within your state are taxed at your normal tax rate. However, you also make sales by mail order or Internet sales where you do not collect tax if the order is from out-of-state. You can easily collect the correct amount of sales tax on these out-of-state sales by setting up a separate tax location to apply to them.

<table>
<thead>
<tr>
<th>Tax Location: Local Taxes</th>
<th>Tax Location: Out of State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Rate</td>
</tr>
<tr>
<td>Tax</td>
<td>7.5%</td>
</tr>
<tr>
<td>Exempt</td>
<td>0%</td>
</tr>
</tbody>
</table>
There are two ways to apply the out-of-state tax location rates to these sales:

- Specify the **OUT OF STATE** tax location on the customer’s record. Point of Sale will automatically use this location to apply the 0% sales tax rate to sales made to the customer, even though the items being sold may be assigned to the *Tax* code.
- Manually change the tax location when making a qualifying sale by choosing **SELECT TAX LOCATION** from the receipt I Want To menu and selecting **OUT OF STATE**.

**Example 2: Two Stores in Different Tax Jurisdictions (Pro Multi-Store)**

Ben’s Flower Shop is a Pro Multi-Store user that operates one store in Daisyville and another in Rose City. The sales tax rate in Daisyville is 6.5%, while in Rose City it is 7.0%. The easiest way for Ben’s stores to handle this is to set up two tax locations as follows:

<table>
<thead>
<tr>
<th>Tax Location: Daisyville</th>
<th>Tax Location: Rose City</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code</strong></td>
<td><strong>Rate</strong></td>
</tr>
<tr>
<td>Tax</td>
<td>6.5%</td>
</tr>
<tr>
<td>Exempt</td>
<td>0%</td>
</tr>
</tbody>
</table>

The Daisyville store selects the Daisyville tax location as its default tax location, meaning tax will automatically be applied at a rate of 6.5% to all items assigned to the *Tax* code. Likewise, the Rose City store should specify the Rose City tax location as its default to ensure the 7.0% tax rate is applied to sales there.

**Setting Up Your Sales Taxes**

You probably set up your primary sales tax while completing the Setup Interview. You can use the procedures below to add, edit, delete, or revise your sales tax codes or locations as necessary.

**To access the Sales Tax page of company preferences:**

1. From the Edit menu, select **PREFERENCES ➤ COMPANY**.
2. Select the Sales Tax preference page from the list on the left.
Sales Tax Overview

If you will be setting up multiple tax locations, it is recommended that you first add all tax codes you will be using to the default tax location, (Local Sales Tax) then add other locations and edit the tax codes in each as necessary to reflect the different taxing instructions.

To add or edit tax codes:

1. Select ADD TAX CODE or EDIT TAX CODE.
2. Enter a tax code and a tax code name.
3. Optionally, enter a “mark” to identify items with each code on sales receipts.
4. Select NEXT.
5. Select a tax option and enter specific taxing instructions:

For uniform, single-rate tax application:

a. Select SINGLE-RATE TAX and select NEXT.
b. Enter the tax rate for this tax code. (You can change this rate for other locations later.)
c. Enter the name of the government agency to which the taxes are paid.
d. If you would like this tax mapped to particular QuickBooks financial software tax items, groups, or codes, make the appropriate selections from the drop-down lists in the QuickBooks Tax Info section. If these fields are left blank, Point of Sale will auto-fill them with the default tax mappings, and will create the corresponding tax items/codes in your financial software if necessary.
e. Select **FINISH**.

**For price-dependent single-rate taxes** (a single tax rate applying when the item unit price exceeds a certain amount):

a. Select **PRICE-DEPENDENT SINGLE-RATE TAX** and select **NEXT**.
b. Enter the tax rate for this tax code. (You can change this rate for other locations later.)
c. Enter the name of the government agency to whom the taxes are paid.
d. Enter the threshold amount at which this tax will be activated.
e. If the tax should only be applied to the portion of the price above the threshold, check the box to indicate this.
f. If you would like this tax mapped to particular QuickBooks financial software tax items, groups, or codes, make the appropriate selections from the drop-down lists in the QuickBooks Tax Info section.

**For multiple-rate taxes** (either price-dependent or non-price-dependent multiple tax rates.)

Each separate tax rate is entered individually as a component of the tax code. You might, for example, set up components for each agency to which you pay a portion of the total tax collected, or for each price threshold/range that applies.

a. Select **MULTIPLE-RATE TAX** and then **NEXT**.
b. Enter a name for the component you are currently defining.
c. Enter the tax rate for this component.

d. Enter the name of the government agency to whom this component of the tax is paid.

e. If this tax only applies when the item unit price is within a certain range, enter the price range. If there is no upper end cut-off, leave the ending limit field blank. If the tax is only to be applied to that portion of the price within the range, check the box to indicate this.

f. If you would like this portion of the tax mapped to a particular QuickBooks financial software tax item or group, make the appropriate selection from the drop-down list.

g. Select **ADD ANOTHER TAX RATE** as needed and repeat steps b-f until all tax rates which are part of this tax code have been entered.

6. Select **FINISH** and then **SAVE**.

Refer to **Assigning Item Tax Codes (page 168)** for information about assigning tax codes to individual items.

**To add or edit a tax location:**

1. Select **EDIT TAX LOCATION** next to the location you wish to edit, or select **ADD TAX LOCATION** at the bottom of the list.

2. Enter (or edit) a name for the tax location.

3. (Pro) In the Shipping section, you can specify whether shipping charges are taxable for this location and select the applicable tax code from the drop-down list.

4. Select **OK**.
5. Edit the tax codes in this location to specify specific taxing instructions for each. See next section.

Sales Tax Codes Shared by all Locations
While sales tax codes can be edited for each location to change the tax rate, agency, and other taxing instructions, keep in mind the tax codes themselves are shared by all locations. If you edit the tax code or tax code name, your changes are applied to the tax code in all locations.

Basic Users: Collecting Sales Tax on Shipping Amounts
Basic-level users can charge for shipping and collect sales tax on those amounts by setting up a service or non-inventory item in inventory called "Shipping Charges" and assigning the appropriate tax code to the item. List this item on sales receipts like any other item. Sales tax will be calculated on the shipping amount and added to the sale according to the instructions specified for the tax code assigned.

To define sales tax codes for specific locations:
When you create a new a tax location, it automatically contains all of the tax codes previously defined. However, the tax codes in the new location do not include the specific taxing instructions (rate, agency, etc.). Edit the taxing instructions for each code as necessary in the new location.

1. Select EDIT TAX CODE for the location you are defining.
2. Edit the taxing instructions for the code, as described earlier. See the note above about shared tax codes between locations.
3. Repeat for each tax code in the location.
4. Save your changes.

To set your default tax location and department tax code:
Do the following in the Default Tax section of the Sales Tax page in company preferences.

1. Select the default tax location for this store from the drop-down list of your defined tax locations.
   All sales made in the store will have the taxing instructions from the specified location applied.
   (Pro Multi-Store) This selection can be made independently at each store.
2. Specify the default tax code to be associated with new departments.
   This tax code will be suggested when a new department is added. Then when items are added to inventory in this department, the department tax code will be suggested for those as well.
3. Select SAVE.
Chapter 20  Sales Transactions

- Making a Sale .......................................................... 348
- Creating a New Receipt ................................................. 348
- Listing Items on Receipts ............................................ 350
  - Lookup and List Items From the Receipt ......................... 350
  - Locate and List Items from Inventory .......................... 351
- Selling Service or Non-Inventory Items ......................... 352
- Selling One-Time Items ............................................. 353
- Selling Assemblies and Groups (Pro) ......................... 353
- Editing Items on Receipts ........................................... 355
- Deleting Receipt Items .............................................. 356
- Listing a Customer on a Receipt .................................. 357
- Receipt Price Levels and Discounts ............................. 358
  - Changing the Receipt Price Level ............................... 359
- Manual Item Discounts ............................................. 360
- Customer Discounts .................................................. 360
- Global Discounts ...................................................... 361
- Discount Pricing (Pro) .............................................. 361
- Redeeming Customer Rewards (Pro) ............................ 362
- Price and Discount Priority ......................................... 363
- Collecting Sales Tax .................................................. 364
  - Changing Tax Codes/Locations at the Time of Sale .......... 364
- Adding Shipping Information ....................................... 365
  - Using Service or Non-inventory Items for Shipping Charges 365
  - Recording Shipping Information (Pro) ......................... 365
  - Editing and Deleting Shipping Information .................... 369
- Recording Item Serial Numbers (Pro) ......................... 370
- Tracking Sales Commissions (Pro) ............................... 371
- Taking Payment and Giving Change ................................ 372
  - The Receipt Payment Window ................................... 372
  - Entering Payment Types and Amounts .......................... 373
  - Giving Change ..................................................... 376
  - Correcting or Deleting Payment Amounts ...................... 377
- Recording Gratuities (Tips) ........................................ 378
- Merchandise Returns and Exchanges ............................ 379
- Printing Receipts and Gift Receipts ............................. 380
  - Printing a Custom Logo on Receipts ........................ 380
Making a Sale

Creating a New Receipt

This is the basic procedure to make a sale. Refer to explanations in the following sections for more detailed information on each step.

1. From the Point of Sale menu, select **NEW SALES RECEIPT**.
2. Enter your name in the **Cashier** field, if it’s not pre-filled.
3. In the **Enter Item(s)** field, list the items to be sold by any of these methods:
   - Scan the bar code on the item tag.
   - Type the UPC, Alternate Lookup, or Item # and press **<ENTER>**. If one matching item is found it is immediately listed on the receipt.
   - From the I Want To menu, choose **SELECT FROM ITEM LIST** to locate and enter items from inventory.
   - Begin typing the first few letters of the item description (**Item Name** field entry). Select an item from the drop-down list displayed.
     If no match is found:
     Press **<ENTER>** to open the full Find window with additional search options.

   **Or**

   Select **ADD NEW** to add an item to inventory and then immediately sell it.
4. If necessary, edit the item just listed:
   - Use the **QTY +** and **QTY -** buttons to quickly change the sales quantity.
   - Choose **MAKE THIS ITEM A RETURN** if this item is being returned by the customer or **REMOVE THIS ITEM** to delete the item from the receipt.
   - Choose **EDIT ITEM** (**<F5>**) to open the Item Information window to edit other item information such as price, tax code, or to give a discount.

The cursor returns to the **Enter Item(s)** field, ready for the next item entry. Repeat until all items being sold are listed.

5. *(Optional)* List the customer on the receipt. Begin typing the customer’s last name; as soon as you see a match in the drop-down list, press **<ENTER>**. If prompted, choose to apply customer-associated discount, price level, or tax location to the sale.

6. Enter any other applicable information for this sale, such as a global (non item-specific) discount, promotional code, or shipping information (Pro).
7. Select **TAKE PAYMENT** to go to the Payment screen.
8. Enter amounts for payments tendered by the customer and/or change returned until the “Payment Complete” message is displayed:
   • Enter amounts paid by the customer in the Amount Tendered column and press <ENTER> or click ACCEPT PAYMENT after each entry.
   • Likewise, enter change returned to the customer in the Change Amount column.

Complete any additional information requested to complete the payment(s), such as check number or credit card information.

9. Select SAVE & PRINT.

If change is due the customer, the Change window is displayed. Select OK to close the window.

**Copying a Receipt to Create a New One**

Copying a receipt is often the quickest way to create a new one if you re-sell the same merchandise repeatedly to a customer or when a customer returns previously purchased merchandise. Note that deposit and pay-out receipts cannot be copied.

1. From the Point of Sale menu, select SALES HISTORY.
2. Locate the receipt to be copied as described in Locating a Receipt (page 404).
3. Select COPY RECEIPT.
   A new receipt is created with the same information as the original (Note: Payment information and serial numbers are not copied.)
4. Make any necessary corrections (edits) to correct the information on the new receipt.
5. Take payment(s) and give change for the receipt as usual.
6. Select PRINT & SAVE.
Listing Items on Receipts

Scan item bar code, or type UPC, Item #, Item Name or Alternate Lookup and press <Enter>

Activate drop-down item list; automatically activated by text entry

Press FIND ITEM icon to search for the item

Use buttons to edit or remove a listed item, to adjust quantity up or down, or to make the item a return.

Lookup and List Items From the Receipt

1. Scan or type item information in the Enter Item(s) field.
   - If you scan a bar code, and there is one unique match in inventory it is instantly listed on the document with a quantity of one.
   - If you typed a UPC code, Item # or Alternate Lookup, press <Enter>. If there is one unique match in inventory it is instantly listed on the document with a quantity of one.
   - If you typed an item search keyword, the drop-down item list is displayed. This list sorts and searches by the item’s Item Name. Other identifying information is displayed to help identify your items.

From this list, you can:
   - Click on an item, or use your arrow keys to highlight an item and press <Enter>, to list it on the receipt.
Making a Sale

- Scroll through the list to locate and select an item.
- Press <Enter> before highlighting an item to open the item Find window, from which additional search options are available. Refer to Locating Records or Documents (page 31) for specific instructions for using the Find window.
- Select ADD NEW to enter a new item in inventory and immediately sell it.

2. To immediately edit the item just listed (quantity, price, etc.) select the EDIT ITEM (<F5>) button. Refer to Editing Items on Receipts (page 355) for more information.

3. After all items are listed, press <Tab> to move through the other receipt fields.

Adding a New Item to Inventory and Immediately Selling It

Defining a new inventory item while making a receipt and then immediately selling the item may result in a discrepancy in your inventory value if no cost is defined for the item. If you are integrated with QuickBooks financial software, a compensating adjustment will have to be made in your financial software if this occurs. One way to do this is to conduct periodic physical inventories and then make an aggregate adjustment in your financial software. Refer to Chapter 14 Inventory Counts and Adjustments (page 231) for more information on conducting a physical inventory.)

Locate and List Items from Inventory

If preferred, you can go directly to inventory to locate an item to list on a receipt. Once in inventory, the item list can be sorted, searched, or filtered to locate the correct item.

1. From the I Want To menu, choose SELECT FROM ITEM LIST (<CTRL+F4>). This selection displays your item list in a special selection mode with the Doc Qty and Doc Price fields added.

2. Filter, search, or sort and scroll through your item list to locate the item(s) you are selling.
3. Once you have located the correct item(s), use one of the following methods to bring them to the receipt:
   - To immediately return one item to the receipt, double-click it. The item is listed with a quantity of one.
   - Enter the quantity of each item to be sold in the Doc Qty column. Optionally, you can specify a Doc Price (sales price, suggested from active receipt price level) for the selected items. Navigate through the item list making entries for all the items being sold. When done choose SELECT to return the selected items to the receipt at the specified quantities and prices.

4. Repeat Steps 2-3 until you have located and listed all sale items.

**Tip: Inventory Actions after Choosing Select From Item List**

Full item editing is possible when coming to your item list from a receipt. Items can be added, edited, or deleted, all while you are still also actively working on the document. This feature gives the flexibility to perform tasks, such as adding new items while making the receipt. It is important to realize that any edits made to items after choosing SELECT FROM ITEM LIST from a document affects your actual item records, not just the document in which you are working.

Refer to **Listing Items on Documents (page 91)** for additional information about listing items on documents, including receipts

### Selling Service or Non-Inventory Items

Service items and non-inventory items are usually used for charging for repairs, alterations, warranty work, or other non-merchandise charges or fees. These items always have a zero on-hand quantity in inventory. Service items can be defined in inventory to charge for labor by the hour or for a set price for a specific purpose. Some retailers choose to use non-inventory items for incidental merchandise for which they do not wish to track quantities. Having a second item type for which quantities are not tracked allows you to categorize and send sales information to separate accounts in your QuickBooks financial software. Service or non-inventory items are listed on a receipt in the same manner as other items. Refer to **Using Service and Non-Inventory Items (page 173)** for more information.

**Tip: Using Service or Non-Inventory Items to Charge by the Hour**

You can use service or non-inventory items to charge for services by the hour or fraction thereof. To do so, define the item in inventory (e.g. Tailoring, Repair Labor, etc.) and make sure that you choose either Service or Non-Inventory as the item type. Enter your inventory price as what you charge per unit of time (hour, half-hour, quarter-hour, day, etc.) When the item is listed on a receipt, simply enter the units of time to be charged for as the item’s quantity. For example, if you are charging by the hour, enter 1.5 in the Qty field to charge for an hour and a half.
Selling One-Time Items

Typically referred to as special order items, these items are used for custom or one-of-a-kind merchandise with little chance of repeat sales, or to customize an existing item for a sale. There are two ways of using special order items on receipts.

- **Edit an Existing Item** – With this option, you list an existing item on the receipt and then edit its descriptive information to reflect customizations to the item. Use this option when you do not want to create a new inventory item, but do want the receipt to reflect the changes. Editing an existing item on a document does not in any way affect the original item’s inventory descriptive information.

  **Example:** If you carry plain white T-shirts in inventory, but then print custom logos, team names, or graphics on them, you could list the white T-shirt on the receipt and then use normal item editing procedures to change the descriptive information, e.g. “Baseball Logo Shirt – Bears.” In this way, the receipt stores detailed information on the customization and is printed for the customer.

- **Create a New Special Order Item (Pro)** – With this option, a new special order item is created in inventory. Once defined in inventory, you can list the special order item on a receipt. Later, if you decide to continue carrying the new item in inventory, you can convert it to a regular inventory item. Special order items can be created while making a receipt, but most often are done from a customer order. When a receipt is made to sell a special order item from a customer order, the item is carried to the receipt.

  Refer to **Listing Special Order Items on Documents (page 95)** for more information on using special order items.

Selling Assemblies and Groups (Pro)

**Assembly Items**

An assembly item is “built” of two or more other inventory items. For example, a Christmas Ski Package could be built from of a pair of skis, bindings, and boots, all of which already exist in your inventory as individual inventory items. Once an assembly is built, the specific individual item units included are no longer available for individual sale. The built assembly item is a discrete item that can be listed on receipts in the normal manner.

**When listing an assembly item on a receipt:**

- List the assembly item, not the component items
- The assembly item price (defined in inventory) and tax code is used
Chapter 20: Sales Transactions

- Normal item editing procedures are available
- If necessary, an assembly item can be “broken” to free the individual items for sale

See Chapter 13 Item Styles, Assemblies, and Groups (Pro) (page 211) for more information about defining, building, and breaking assembly items.

**Group Items**

A group item provides an efficient method to list and sell two or more items, at a defined group price, by entering or scanning a single item identifier (UPC, Alternate Lookup, or Item Number).

Group items differ from assembly items in several important ways:

- Groups are not pre-built, i.e. the items included in a group remain in inventory and can be sold individually
- The individual items in the group can be printed on a customer’s receipt

When a group item is listed on a receipt, all included items are listed and the price of each item is proportionally discounted, as necessary, so that the total equals the group price defined in inventory. Individual item prices can be further edited on the receipt, if needed.

Group items differ from assembly items in several important ways:

- Groups are not pre-built, i.e. the items included in a group remain in inventory and can be sold individually
- The individual items in the group can be printed on a customer’s receipt

When a group item is listed on a receipt, all included items are listed and the price of each item is proportionally discounted, as necessary, so that the total equals the group price defined in inventory. Individual item prices can be further edited on the receipt, if needed.

- Use normal procedures to list the group item on the receipt.
- You have the option of printing only the group item price, only the component item prices, or both the group and item prices on the receipt you give the customer. The group description and individual item descriptions are always printed, regardless of whether their prices are included.

<table>
<thead>
<tr>
<th>Description</th>
<th>Price</th>
<th>Quantity</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Youth Baseball Starter Set</td>
<td>$172.35</td>
<td>1</td>
<td>$172.35</td>
</tr>
<tr>
<td>Youth Baseball Bat</td>
<td>$77.77</td>
<td>1</td>
<td>$77.77</td>
</tr>
<tr>
<td>Youth Baseball Glove</td>
<td>$55.98</td>
<td>1</td>
<td>$55.98</td>
</tr>
<tr>
<td>Hard Ball</td>
<td>$13.98</td>
<td>1</td>
<td>$13.98</td>
</tr>
<tr>
<td>59 Minute Baseball Practice</td>
<td>$24.50</td>
<td>1</td>
<td>$24.50</td>
</tr>
</tbody>
</table>

See Chapter 13 Item Styles, Assemblies, and Groups (Pro) (page 211) for more information about defining group items.
Making a Sale

Editing Items on Receipts

Editing receipt items is most frequently done to change the quantity being sold, to give item discounts, to change tax codes, or to enter item serial numbers (Pro). The ability to edit item descriptions, prices, or apply discounts on a receipt can be controlled by security rights only if you are requiring users to log in. If the user does not have sufficient security rights, the Manager Override function can be used to authorize the changes. (Refer to Manager Override (page 70) for more information.)

There are three ways to edit item information on a receipt:

- Use the **QTY + / -**, **MAKE THIS ITEM A RETURN**, and **REMOVE THIS ITEM** buttons to quickly change the sales quantity.
- Navigate to the editable fields in the receipt item list and enter new values directly. Refer to Customizing Columns in Lists (page 586) for information on adding columns.
- Choose **EDIT ITEM** (<F5>) to open the Item Information window to edit other item information such as price, tax code, or to give a discount. (Pro) You can review/edit commissions, unit of measure, and serial numbers.

![Item Information Window](image)

Editing Item Prices

To edit individual item prices or give item discounts make an entry in the item’s **Price** or **Discount** fields in the receipt item list or the Item Information window. Refer to Manual Item Discounts (page 360) for more information.

To apply a global discount to the entire receipt, make an entry in the **Disc %** or **Discount** fields in the totals area of the receipt. A global discount is subtracted from the receipt subtotal. Refer to Global Discounts (page 361) for more information.
Deleting Receipt Items

Items can be deleted from a receipt, provided the receipt has not been saved.

To delete an item from a receipt:

1. Highlight the item to be deleted in the receipt item list.
2. Select the REMOVE THIS ITEM button for the applicable item.

To zero-out the item:

With this procedure, the item will remain on the receipt with a quantity of zero. You might do this to keep a record of an item the customer wanted, but the sale couldn’t be completed for some reason.

1. Edit the Qty field to zero in either the receipt item list or the Item Information window.
2. Navigate out of the field or select OK (F5) to close the Item Information window.

Editing Item Prices and Discounts

Any time you manually edit the original inventory price of an item on a receipt, up or down, Point of Sale considers it a discount. Increasing the price of an item is counted as a negative discount. These amounts are included in the discount amounts shown on reports (including X/Z-Out reports) and, if you are sharing data with QuickBooks financial software, will be transferred to your financial software under the account assigned as your Merchandise Discount account in company preferences. However, changing the receipt Price Level is not considered a discount.
Listing a Customer on a Receipt

Listing customers on receipts is optional, but necessary if you want to use customer-based discounts or tax locations, offer charge accounts, or to track customer purchase history. Any customer on file can be quickly listed on a receipt and new customers can be easily added while completing a receipt.

At a glance you can view important customer information and receive alerts. You can also access customer history from the I Want To menu.

To list a customer on a receipt:

1. In the Customer field, begin typing customer identifying information (last name is the recommended entry).
   - If you type last name, Point of Sale attempts to recognize the name and auto-fill the field for you. A drop-down list of your customers with the closest match highlighted is also displayed. Press <ENTER> to accept the highlighted name or select another name from the list.

Or enter other customer information (first name, company name, phone number, etc.) and select FIND.
   - If one unique match is found, the customer is listed.
   - If multiple matches are found, the Find Customer window is displayed, from which you can select the correct customer or refine your search (see following image).
• Select **ADD NEW** from the drop-down list or the Find Customer window to add a customer as you make the receipt.

![Find Customer window - Showing multiple matches of “444” in phone numbers](image)

From the Find Customer window, you can:

• Highlight a customer and choose **SELECT CUSTOMER** (or double-click) to list that customer on the receipt.

• Select **GO TO CUSTOMER LIST** to go to the list of all customer records.

• Select **ADD NEW CUSTOMER** to add a new customer record and then immediately list that customer on the receipt.

• Search again by entering new keywords/numbers or selecting **ADVANCED FIND OPTIONS** to refine your search by field or other criteria.

If the listed customer has a customer discount, price level, or tax location associated with their record, you are alerted and can apply to the current sale at your discretion. See **Adding a New Customer Record** (page 305) for more information on adding customers.

---

**Receipt Price Levels and Discounts**

The ability to give discounts or change price levels on a receipt can be controlled by security rights if you are requiring users to log in. If the user does not have sufficient security rights, the Manager Override function can be used. Refer to **Manager Override** (page 70) for more information.
Changing the Receipt Price Level

If you use markdown price levels, the default price specified in company preferences will be automatically set as the active receipt price level, unless you list a customer with an associated price level different than the default. In the latter case, the customer’s associated price level becomes the active price level. The active price level is always noted on the status bar and in the **Price Level** field in the body of the receipt. You can change the receipt price level manually to give a customer a different price. Any discounts subsequently given are applied against the currently active price level.

To change the receipt price level:

1. Navigate to the **Price Level** field and select a new price level from the drop-down list.
   
   If you have already listed items on the receipt, you are asked how you want to handle the prices of those items.

2. Select **YES** to update the prices of the listed items to the new price level. Any previous item discounts given are cleared.

   Or

   Select **NO** to leave the prices of the already-listed items at the default price level. Any new items listed after the change will be priced at the new price level. This option allows you to sell items at different price levels on the same receipt.
Chapter 20: Sales Transactions

The next receipt made will automatically switch back to the default price specified in company preferences.

Preferences: Default Price
PREFERENCES ➤ COMPANY ➤ PRICING ➤ Default price: Specify the default price to be active on sales.

Manual Item Discounts

Whenever an item discount is entered using the Price field or one of the discount fields in the item list, the program calculates the other fields automatically. For example, if you discount by entering a percentage in the Discount % field, Point of Sale will recalculate and auto-fill the Price field for you.

To manually discount an item price:
1. Select an item in the receipt item list, and then select EDIT ITEM (<F5>).
   • To discount to a certain price, enter the new amount in the Price field
   • To discount by a percentage, enter the percentage in the Discount % field
2. Select a discount reason from the drop-down list in the Discount Reason field.
3. Select CONTINUE (<F5>) to record the discount and return to the receipt.
   Or
   Navigate to the one of the discount fields in the receipt item list and enter the appropriate discount directly.

Preferences: Define and/or Require Item Discount Reasons
PREFERENCES ➤ COMPANY ➤ SALES ➤ DISCOUNTS: Predefine up to eight item discount reasons to make them available for selection when giving manual item discounts at the time of sale. Select the REQUIRE A DISCOUNT REASON... option if you wish to make it mandatory for the cashier to specify the reason for a discount on the sales receipt.

Customer Discounts

You can associate a discount with your customers. For example, you may do regular business with a non-profit organization and wish to extend a 15% discount for all purchases made by that company.
Receipt Price Levels and Discounts

Enter the discount percentage on the customer record. When making a sale to the customer, Point of Sale will alert you to the associated discount. You can elect to apply the discount to the current sale or not.

Customer discounts are applied as item discounts (reduce the price of each item on the sale). Customer discounts are not applied to the purchase of a gift card or certificate.

Refer to Using Customer Discounts and Price Levels (page 311) for information on setting up customer discounts.

Global Discounts

Global discounts are given against the receipt subtotal (i.e., the entire sale), rather than on individual items. To give a global discount, use the discount fields in the totals area of the receipt form.

To give a global discount:

1. Enter a percentage in the Disc % field or an amount in the Discount field.
2. Press <TAB> or navigate to the next field.

An entry in either global discount field will result in the program automatically calculating and entering a value for the other. If you need to remove a previously entered global discount, simply highlight one of the values and press <DELETE> on your keyboard or overtype the entry with a zero (0).

Global discounts are not spread across the items on the receipt (except for purposes of calculating sales tax, if applicable).

Discount Pricing (Pro)

Discount pricing allows you to predefine and optionally schedule discount prices in Price Manager for groups of items. For example, you might have a “Buy 3 for $45” sale for a group of sweatshirts for the weekend.

Refer to Using Discount Pricing (Pro) (page 205) for information on setting up discount pricing.

When a qualifying sale is made, Point of Sale automatically applies the discounts.
These discounts are always given as line item discounts and the **Discount Reason** field for included items is populated by the reason you assigned the discount in Price Manager. The original price and unit/total discounts are also provided for reference. In this example, three sweatshirts purchased during the weekend sale qualified for the discounted price.

<table>
<thead>
<tr>
<th>Item Name</th>
<th>Size</th>
<th>Attribute</th>
<th>Qty</th>
<th>Original Price</th>
<th>Unit Discount</th>
<th>Total Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sweatshirt</td>
<td>LRG</td>
<td>Black</td>
<td>2</td>
<td>$15.00</td>
<td>$5.99</td>
<td>$11.98</td>
</tr>
<tr>
<td>Sweatshirt</td>
<td>XL</td>
<td>Navy</td>
<td>1</td>
<td>$15.00</td>
<td>$5.99</td>
<td>$5.99</td>
</tr>
</tbody>
</table>

**Redeeming Customer Rewards (Pro)**

When you are ringing up a sale, if a customer has a reward to redeem you will be prompted to apply it when going to the payment window. It can be redeemed at that time, or saved for another purchase at a later date.

In the case of a customer having earned multiple rewards, a list of available rewards will be displayed. Only one reward redemption is allowed per sales receipt. (You may wish to include this fact in the terms and conditions for your rewards program.)

Rewards cannot be redeemed to purchase gift cards or gift certificates, to make a payment on account, or to pay for sales tax or shipping charges.

**To apply a reward:**

1. Choose the reward to apply and select **APPLY NOW**.
   
The reward is applied to the sale and you are taken to the payment window.
2. Continue to accept the remainder of the balance due for the sale.

Percentage-off rewards are applied to each qualifying sale item individually as item discounts. The **Discount Reason** field is auto-filled with *Reward*. Dollar-off rewards are added as a separate line item to the receipt and act like a global discount.

*Refer to [Customer Rewards Program (Pro) (page 323)](page323) for more information about setting up a Customer Rewards program.*
Price and Discount Priority

Because there are several ways to apply discounts to sales, it is important to understand how they work together and which discount will take priority if the items or customer qualifies for more than one.

**General discount priority rules:**

- Item discounts, no matter their origin, are always taken from the active price level on the receipt.
- An item can be discounted only once on a receipt; there is no “stacking” of item discounts.
- If one item discount has been applied and then another discount is manually applied, the second discount replaces the first.
- If the customer/item qualifies for two automatic discounts, Point of Sale will apply the discount that gives the customer the best price.
- Global discounts do not affect item discounts; you can give an item discount and also a global discount on the same sale.

**(Pro) Price Manager discount pricing rules:**

If an item is included in more than one active discount, only one of the discounts will be applied:

- Scheduled discounts take priority over non-scheduled discounts.
- Among two active scheduled discounts, the one with the latest start date takes priority.
- If you choose to apply a customer discount and a Price Manager discount also applies to the same item, the greater of the discounts (lower price) is applied. (The customer discount is applied to other items on the same receipt not included in the Price Manager discount.)

**(Pro) Customer Reward discount rules:**

- If it is a %-off reward, and other item discounts are already given, the bigger discount is applied to each item.
- If the %-off reward discount isn’t the better discount for any of the items, you cannot apply it (it is preserved for a future sale).
- If it is a $-off reward (amount), it is added as a separate line item and functions in the same manner as a global discount, i.e., is in addition to any item discounts given.

For more information on discount priority, search the on-screen help using the keywords discount priority.
Collecting Sales Tax

Point of Sale automatically calculates and collects tax on sales based on your tax configuration. Refer to Setting Up Your Sales Taxes (page 342) for information on configuring sales taxes.

If you list a customer on a receipt with an associated tax location (or flagged as tax-exempt) the applicable tax location or 0% tax rate is applied to the sale. Refer to Handling Special Customer Sales Tax (page 312) for information on configuring sales taxes.

Changing Tax Codes/Locations at the Time of Sale

While making a receipt, you can manually change the tax code for individual items or the tax location applied to the entire receipt. Tax locations offer a convenient way to change the tax instructions for different tax areas or for making sales to organizations that qualify for special tax handling.

To change the tax code of an item being sold:

1. Highlight the item in the receipt item list and then select EDIT ITEM (<F5>) to open the Item Information window.
2. Select another tax code from the drop-down list in the Tax Code field.
3. Select CONTINUE (<F5>) to record the tax code change and return to the receipt.
4. Repeat for additional items, as necessary.

The tax amount will be recomputed to reflect your changes. If sold items are taxed at different rates, the TAX % field in the totals area of the receipt will be disabled.

Tip: Quick Tax Code Changes

Alternatively, if you have added the TAX CODE field to the receipt item list, you can simply select the TAX CODE without opening the Item Information window.

Refer to Customizing Columns in Lists (page 586) for more information.

To change the tax location for the entire sale:

1. From the receipt I Want To menu, choose SELECT TAX LOCATION.
2. Select a new tax location in the Change Tax Location dialog that is displayed. Only the tax locations you have predefined are available for selection.

3. Choose **SELECT**. The sales tax on the receipt will be computed for the new tax location.

---

# Adding Shipping Information

## Using Service or Non-inventory Items for Shipping Charges

One way to add shipping charges to a sale is by using a service or non-inventory item. Create the item, naming it “Shipping Charges.” Assign a tax code to the item if shipping is taxable in your area. List the item on the receipt like any other item.

You can set up a single item, leaving the inventory price at $0. Edit the price on each individual sale as necessary. Or, if you charge flat shipping amounts, set up one item for each defined amount, e.g., a $10 item, a $15 item, etc.

*Refer to Using Service and Non-Inventory Items (page 173) for more information on using service and non-inventory items.*

## Recording Shipping Information (Pro)

Pro-level users have two other choices to add shipping information and charges to sales receipts:

- Manually enter the shipping provider, charges, tracking numbers, etc.
- Use Shipping Manger to arrange for shipment with UPS online, and then transfer the shipping information, including a tracking link, to the receipt

*Refer to Shipping Manager (Pro) (page 337) for important information about Shipping Manager, including how to set it up to use with Point of Sale.*

With either choice, multiple shipping addresses can be captured on customer records and then used to complete or record shipments on the receipt. Shipping labels and packing lists can be printed from the receipt as well.

Shipping information, with the exception of the amount, can be added or edited on a receipt even after the receipt has been saved, until the receipt has been sent to QuickBooks financial software.
To add the shipping fields to the receipt form, and optionally make Shipping Manager available, ensure the following preferences are set:

Preferences: Add Shipping Fields to Sales Receipt

PREFERENCES ➤COMPANY ➤GENERAL ➤SELECT FEATURES TO USE: Select the checkbox labeled: I WANT TO RECORD SHIPPING ADDRESSES ON SALES RECEIPTS. This makes the shipping fields available on the receipt form.

Preferences: Shipping Providers

PREFERENCES ➤COMPANY ➤SALES ➤SHIPPING ➤SHIPPING PROVIDERS. Review the default list of shipping providers and add or remove providers as needed. If you make most shipments with one particular carrier/service level, select it and then select MAKE DEFAULT so it is suggested on receipts.

Preferences: Use Shipping Manager

PREFERENCES ➤COMPANY ➤SALES ➤SHIPPING ➤QUICKBOOKS SHIPPING MANAGER: Select the checkbox to make Shipping Manager available on sales receipts (and customer orders) and from the Point of Sale menu. If you ship from receipts but do not want to transfer the shipping charges to receipts, select the checkbox labeled I DO NOT CHARGE MY CUSTOMERS FOR SHIPPING. Additional setup is required for Shipping Manager. Refer to Shipping Manager (Pro) (page 337) for instructions.

What’s important about adding shipping information to receipts?

- If requiring user logins, the security right POS ➤EDIT SHIPPING AMOUNT can be used to allow or prevent editing of the shipping amount on a receipt.
- You can apply sales tax to shipping amounts if required. Refer to Setting Up Your Sales Taxes (page 342) for more information about setting up a tax location for this purpose.
- If selling customer order items on the receipt, the shipping information and quote recorded on the customer order is carried to the sales receipt. If the order is only being partially filled (i.e. some items remain due), you are asked if you want to apply the shipping charge to the current receipt.
- You can customize your packing slip and store shipping label print templates if needed using Print Designer. Shipping Manager’s shipping label cannot be customized.
- The ability to add or edit shipping information or amounts after saving a receipt may be limited.
To manually record shipping information on a receipt:

1. Create the receipt and list the customer.
2. In the Shipping Info area, select **SHIP THESE ITEMS**.
   The Shipping address window is displayed.
3. Select a shipping address, edit this address if needed, and select **OK**.

   **Or**

   Select **ADD AN ADDRESS** and enter a new shipping address, and select **OK**.

4. Enter the shipping amount and date.
5. Your default shipping provider (specified in company preferences) is suggested in the **Ship By** field. Pick a different provider from the drop-down list if necessary, and optionally enter a tracking number.
6. Select **OK** to close the window. The shipping date and amount are carried to the receipt and the specified shipping address is saved and can be printed on the receipt.
7. Select **PRINT PACKING SLIP** or **PRINT SHIPPING LABEL** from the Options menu, as needed, to fulfill the order. The currently selected address will be used for printing.
8. Complete the receipt normally.

To ship with Shipping Manager:

1. List the items and customer on the sales receipt.
2. Select **SHIP THESE ITEMS** at the bottom of the receipt.
   The Shipping window is opened.
3. Select **SHIP VIA UPS**.
4. Choose an existing customer shipping address or select **ADD AN ADDRESS**. If you add or edit an address in this window, you have the option to save the changes to the customer record.
5. If using an electronic scale, place the parcel on the scale.
6. Select OK.

Shipping Manager is launched and the shipping form is displayed. The customer's shipping address and the weight (if using scale) is pre-filled.

7. Enter the shipment weight and other shipping options.

Missing, but required, fields will be highlighted in red.

8. Select options as needed from the shipping form:
   - **ADD** in the upper right to add additional parcels to this shipment.
   - **ESTIMATE COST, TRANSIT TIME**, or **LIST ALL SERVICES** across the bottom to get estimates of costs and shipping times.
   - **VIEW** to display a list of prior shipments made, track or cancel them, and run reports.
   - **CANCEL** to return to the receipt without making the shipment.
   - **HELP** for assistance.

9. Select **SHIP** to complete the shipment and print a shipping label. A confirmation is displayed that can be printed or copied. Select **OK** to return the shipping information to the sales receipt.

10. Complete the receipt and take payment in the normal manner.

The shipping Options drop-down list on the receipt has additional shipping choices. If integrated with QuickBooks financial software, this menu is available only until the receipt has been sent to QuickBooks.

   - **TRACK SHIPMENT** to connect to the carrier's Web site and get tracking information for this shipment. After the receipt has been sent to QuickBooks, this option is still available from the I Want To menu.
   - **DELETE** to remove the shipment from the receipt. Available only until shipment has been physically made, and once the receipt has been saved the shipping amount cannot be removed.
   - **RE-PRINT UPS SHIPPING LABEL** to print another copy of the Shipping Manager shipping label.
   - **PRINT STORE MAILING LABEL** to print a Point of Sale shipping label.
   - **PRINT PACKING SLIP** to print a list of items and the Ship To/Bill To addresses.
Editing and Deleting Shipping Information

The ability to edit or delete shipping information may be limited as follows:

- Before a receipt has been saved: No restrictions. The shipping information or shipping amount can be edited or deleted.
- After a receipt has been saved: The shipping information, except amount, can be edited or removed. The amount cannot be removed because payment has already been taken with the shipping included.
- After a receipt has been sent to your QuickBooks Financial software: No changes can be made.
- In Shipping Manager: If the shipment was made through Shipping Manager, the shipment or a specific parcel can be edited or deleted in Shipping Manager until the carrier has physically received the package, even if it can no longer be edited or deleted in Point of Sale. However, a change initiated in Shipping Manager does not update the receipt in Point of Sale.

To edit or delete shipping information on sales receipts:

1. Open the receipt from Sales History (or return to the receipt from the payment screen if not yet saved).
2. In the Shipping Info section of the receipt, make a selection from the drop-down Options list. The available options vary depending on how the shipment was made.

If shipping information was manually added:

- **EDIT or CLEAR SHIPPING ADDRESS**: Allows you to change or remove the shipping address from the receipt.
- **EDIT or CLEAR SHIPPING DETAILS**: Allows you to change or remove the shipping provider, ship date, tracking number, and, if the receipt hasn't been saved, the shipping amount.
- **PRINT STORE MAILING LABEL**: This option prints a shipping/mailing label using the printer and template set up in Point of Sale.
- **PRINT PACKING SLIP**: Prints a listing of items to be shipped and both the Bill To and Ship To addresses.

If shipment was made via Shipping Manger:

- **TRACK SHIPMENT**: If a tracking number is recorded on the receipt, this option will connect to the carrier's web site to look up the tracking number. This is only available until the receipt has been sent to QuickBooks financial software. Once the receipt has been sent, you can select **TRACK PACKAGE** from the I Want To menu, use the tracking link on the information panel in your sales history list, or track shipments from within Shipping Manager.
- **DELETE SHIPMENT**: Deletes the shipment from the receipt, including the shipping amount if the receipt hasn't been saved. Deleting the shipment from
the receipt also deletes it in Shipping Manager unless the shipment has physically been made.

Be aware that deleting a shipment in Shipping Manager does not delete it from the receipt in Point of Sale. A good practice is that anytime you change or delete a shipment in one place, check or take action in the other to ensure that the information is updated there as well.

- **RE-PRINT SHIPPING LABEL**: Reprints the Shipping Manager shipping label for the specified carrier.
- **PRINT STORE MAILING LABEL**: This option prints a shipping/mailing label using the printer and template set up in Point of Sale.
- **PRINT PACKING SLIP**: Prints a listing of items to be shipped and both the Bill To and Ship To addresses.

3. Select **SAVE**.

---

**Deleting and Editing Shipping Information**

The only way to remove or edit the shipping amount after a receipt has been saved is to reverse the receipt and then create a new corrected one with the updated shipping information. If canceling the shipment, you may find it quicker to create a new receipt to refund the shipping amount to the customer.

Since they are just estimates, shipping information on customer orders can be edited or removed at anytime.

---

**Recording Item Serial Numbers (Pro)**

You can record item serial numbers as you make a receipt. In this way your sales history will contain a permanent record of the sale of each tracked item.

If the **Serial # Tracking** field in inventory is set to **PROMPT** for the item, you will be prompted to enter a serial number for each unit of the item being sold. If the serial number tracking status is set to **OPTIONAL**, use the following steps to manually enter serial numbers.

**To record serial numbers on a receipt:**

1. List the item on the receipt using normal procedures.
2. Select **EDIT ITEM (<F5>)** to open the Item Information window, or navigate to the **Serial #** field in the item list.
3. If a single unit is being listed, enter the item serial number in the **Serial #** field. If multiple units are sold, select the button in the field to open the Enter Serial Number dialog.

<table>
<thead>
<tr>
<th>Item #</th>
<th>Description 1</th>
<th>Qty</th>
<th>Price</th>
<th>Tax %</th>
<th>Ext. Price</th>
<th>Serial #</th>
</tr>
</thead>
<tbody>
<tr>
<td>274</td>
<td>.22 RPD Pistol</td>
<td>2</td>
<td>93.00</td>
<td>7.750</td>
<td>160.00</td>
<td>00239871234</td>
</tr>
</tbody>
</table>

Sample Serial Number entry on a sales receipt. Select the button to enter serial numbers for multiple units.

---

**Changing Quantities After Adding Serial Numbers**

If you increase the quantity of a serial number item on a receipt after having entered serial number(s), you will be prompted to enter numbers for the new quantities added. If you decrease the quantity listed after having entered serial numbers, the previous numbers are cleared and you are prompted to re-enter numbers for each unit of the revised quantity. This is because the program has no way of knowing which specific unit(s) you are removing when you adjust quantities downward.

Refer to [Serial Number Tracking (Pro) (page 149)] for more information about tracking item serial numbers.

---

**Tracking Sales Commissions (Pro)**

If you pay your employees a commission for sales, Point of Sale can calculate and report on commission sales for you. Each employee can have his own commission rate and items can be marked in inventory as eligible or not for commission.

The **Associate** field is used on sales receipts to identify the employee to be paid the commission. The Associate can be assigned for the entire receipt or on an item-by-item basis.

**To record commissions on sales receipts:**

1. Select a name in the **Associate** field at the top of the receipt form (it is suggested as the logged in user).

   The employee selected is credited for all item sales on the receipt unless changed for individual items as explained in the following steps.

2. To credit employee commissions on individual item basis, highlight an item and select **EDIT ITEM (<F5>)** to open the Item Information window.

3. Change the name in the **Associate** field for the item and then select **CONTINUE**.

4. Repeat for other items as necessary.
5. Point of Sale calculates and displays the commission amount for each eligible item on the receipt, based on the assigned employee’s rate.

You can report on employee sales and commissions by running either a Commission or a Sales Performance by Associate sales summary report.

Refer to Tracking Sales Commissions (Pro) (page 371) for more information about assigning commission rates to employees.

Refer to Chapter 26 Reports and Sales Charts (page 459) for instructions on running reports.

---

Taking Payment and Giving Change

This section covers the basic procedures for taking payment and giving change on a sale. Refer to Chapter 21 Receipt Payment Types (page 381) for detailed information about each payment type accepted in Point of Sale.

The Receipt Payment Window

When you have entered all the information for the sale onto the receipt and the customer is ready to pay, select TAKE PAYMENT (<F12>) from the bottom toolbar.

The Receipt Payment window is displayed as shown on the next page.

To return to the receipt form:

- From the bottom of the Receipt Payment window, select BACK TO RECEIPT.
Taking Payment and Giving Change

Enter Payment Types and Amounts

To take cash payment:

When you reach the Payment Window, the amount due from the customer is pre-filled in the Amount Tendered column for the payment method you have set as your default in company preferences (see following note).

We’ll assume the customer is paying by cash and cash is your default payment method for this example.

1. If the customer is giving you the exact cash amount due, press <ENTER> or select the ACCEPT PAYMENT button. The payment is complete.

Or
If the customer tenders a different amount, simply type it over the displayed cash payment amount and then press <ENTER> or select the ACCEPT PAYMENT button. You do not have to delete the displayed amount if it is highlighted (blue background); simply type a new amount and it will replace the current amount.

The change, in this case 0.05, is automatically assigned as cash in the Change Amount column and the payment is complete.

2. Select SAVE & PRINT.

If you have a cash drawer connected, it will open, and the change due the customer is displayed. Select OK to close the change window when ready.

---

Preference: Accepted and Default Payment Methods (Tenders)

PREFERENCES ➤ COMPANY ➤ SALES ➤ RECEIPT TENDERING: Select or clear checkboxes for payment methods. Clearing a checkbox removes that method from the Receipt Payment window. Also, specify a default payment method (total payment will be suggested by this method), and indicate the credit card types you accept.

Preference: Payment Methods that Open Cash Drawer

PREFERENCES ➤ COMPANY ➤ SALES ➤ Open Cash Drawer: If you have a cash drawer installed, select the payment methods that open it when you save and print a receipt.

---

To take payment by a different payment type:

When you enter the Payment Window, the total amount due is suggested by your default payment method. When the customer wishes to pay by a different method you can easily move the amount due to the other method.

1. Leaving the amount due highlighted, click in the cell of the Amount Tendered column adjacent to the payment type being used.

   Or

Use the <TAB> or arrow keys on your keyboard to move the highlighted total amount to another payment type. As you press the keys the amount will move up or down through the cells in the Amount Tendered column; you do not have to delete or re-enter the amount.
2. Press <Enter> or click ACCEPT PAYMENT to take full payment by the selected payment type or use the same procedure described above to type over the suggested amount with the amount the customer is tendering.

3. Enter (or scan) any additional information requested, such as check number or credit card information, for the payment method selected.

Specific procedures for each payment type are in later sections of this chapter.

4. When the Payment Complete message is displayed, select SAVE AND PRINT RECEIPT (<F12>).

Moving and Accepting Payment Amounts with Mouse or Touchscreen

Mouse users can move a highlighted payment amount by simply clicking in the cell for a different payment method and can accept a highlighted or entered payment amount by double-clicking the amount. Touchscreen users can touch the amount field for the correct payment method to move an amount and touching the ENTER button on the navigation toolbar to accept the amount.

To take a split-payment:

A split-payment is one in which the customer uses two or more payment types for the purchase. For example, the customer might pay $50.00 with a gift certificate and the remaining $24.18 in cash to complete a $74.18 sale.

When you enter the Payment Window, the total amount due is suggested by your default payment method.

1. Leaving the total amount due highlighted, move the total amount to the first payment method being used, as described earlier.
   In our example, it would be better to record the gift certificate payment first. Point of Sale will then calculate and display the balance needed in cash to complete the payment.

2. Type 50.00 in the Amount Tendered column for gift certificate and press <Enter> or click ACCEPT PAYMENT.
   The remaining amount due is displayed for the next payment method in the list.

3. Use the same procedure to move this remaining amount to the second payment method (cash in our example) and press <Enter> or click ACCEPT PAYMENT.
   The Payment Complete message is displayed.

Note: If the customer overpaid, use the same procedures to assign the change to one or more change methods until the payment is complete.
4. Select **SAVE/PRINT RECEIPT (<F12>)**.

![Receipt Payment](image)

**Giving Change**

**Cash Payment**: If part or all of the payment was taken by cash, change is automatically assumed as cash and the *Payment Complete* message is displayed. Simply save and print the receipt.

**Non-Cash Payment**: If the payment did not include cash, the change method is suggested as *Cash*, but can be returned to the customer in one or more change methods of your choice, just as payments could be taken from the customer by different payment methods. Use the same procedures to define the change amounts and methods as you did for taking payments.

**To return a specified amount of cash when ringing-up a sale:**

If a customer wants a certain amount of cash back (e.g. $50) while paying for a purchase by a method other than cash, follow these steps.

This method eliminates arithmetic error by the cashier. By entering the cash change amount first, the new amount required from the customer is calculated and displayed. This method works equally well to calculate the total payment amount needed when selling a gift card or certificate in addition to merchandise purchases.

1. Enter the amount of cash to be returned to the customer in the **Change Amount** column first. In our example, enter *50.00* as cash change and press <ENTER>. 
Taking Payment and Giving Change

The new amount due from the customer (purchase amount plus $50.00) is now displayed in the **Amount Tendered** column.

2. Move the new amount due to the payment method being used and press <**ENTER**> to accept it.

3. Save and print the receipt normally. The Change window is displayed to remind you of the amount of change to return to the customer.

**Correcting or Deleting Payment Amounts**

If one or more payment or change amounts are entered in error, they can be corrected or deleted and new payments entered prior to saving the receipt.

1. Highlight the payment amount that is in error.

2. Press <**DELETE**>

   Or

   Select **CLEAR PAYMENT** or **CLEAR CHANGE** to remove the amount.

3. Enter new payment types and/or change until the **Payment Complete** message is received.

4. Save and/or print normally.

**Notes about deleting or clearing payment amounts:**

- If a credit card has already been authorized, you will be prompted to void the transaction to reverse the charge. In this case, the card is never charged and nothing will appear on the cardholder’s account. Create a new receipt and apply the correct payment as necessary.

- Debit payments, if authorized through the QuickBooks POS Merchant Service, have already been debited to the customer’s bank account. Therefore, the debit payment cannot be deleted from the receipt, nor can the receipt be canceled or voided. The receipt must be finished or the cashier must manually enter an equal amount by another payment type, such as cash, to balance the receipt and refund the debit amount to the customer.

- Any entered or assigned check, gift certificate, or credit card numbers are cleared.
• If the receipt has already been saved, you will have to reverse the receipt and create a new one. Refer to Reversing Receipts (page 411) for more information.

(Pro) If deposits have been used as payment on the sale (as might be the case when selling customer order items), the deposits will be removed and returned to the referenced customer order.

Recording Gratuities (Tips)

Point of Sale will accommodate taking tips when accepting payment by non-cash methods (credit card, gift card, or charge to customer account).

This feature must be turned on in company preferences.

Preference: Accepting Tips

PREFERENCES ➤ COMPANY ➤ SALES ➤ RECEIPT TENDERING: Select or clear the checkbox for collecting tips. Once this setting is turned on, you will receive a prompt when taking payment by credit card, gift card, or charge to account.

To collect a tip:

1. Enter the sale as normal and enter the payment type.
2. Select COLLECT TIP when prompted.
   If using the QuickBooks POS Merchant or Gift Card Service, you can print a temporary tip receipt for the customer to enter the tip amount and sign.
3. Enter the amount of the tip the customer has indicated and specify the employee to which it is to be paid, then select CONTINUE.
4. Select SAVE & PRINT RECEIPT.
   Save the signed receipt for your records and give the customer the second receipt.
Notes about tips:

- A receipt cannot be put on hold while processing a tip
- To collect a tip on an ATM/Debit transaction, utilize a cash-back procedure and allow the customer to leave a cash tip
- Cash tips, including tips from cash-back on ATM/Debit payments and from writing checks for more than the due amount, are not tracked in Point of Sale
- Reports on tips collected are available in the Sales area of the Report Center
- Tips may be paid to employees using a Pay-Out receipt; select **EMPLOYEE TIPS PAYABLE** from the Account drop-down list in the Cash Paid Out window

Merchandise Returns and Exchanges

Merchandise returns are typically recorded on regular sales receipts as negative quantities. This deducts the return total from the current day’s sales and adds the item(s) back into inventory. Additional merchandise can also be purchased on the same receipt.

For detailed information on handling returns and exchanges, refer to Chapter 22 Returns, Exchanges and Sales History (page 403)

**Tip: Using Charge Account to Give Store Credit on Returns**

Merchants offering customer charge accounts can issue store credit on merchandise returns. To do this, create a normal return receipt. On the Receipt Payment window, enter the change amount in the **ACCOUNT PAYMENT** field. The customer’s charge account will be credited and, if integrated with QuickBooks financial software, a credit memo or customer payment (depends on version) will be created in your financial software.

**Tip: Removing Unsalable Merchandise from Inventory**

Doing a return or exchange adds the returned items back to inventory. If the merchandise returned is unsalable, you should create an adjustment memo to remove it from inventory or a return voucher if the item is to be returned to the vendor. Refer to Creating an Adjustment Memo (page 245) or Working with Receiving History (page 295) for more information.
Printing Receipts and Gift Receipts

Receipts are normally printed when saved and then given to customers for their records. The layout, information printed, and other print options are determined by the receipt template and print options selected in workstation preferences.

For some transactions, you may wish to print more than one copy of the receipt. For example, on credit card transactions you may want to print one copy of the receipt for the customer and a second signature line copy to keep on file at the store.

During the holiday season, you may wish to enable printing of gift receipts without item, price, and payment information. If the gift recipient needs to return or exchange the gift, you can quickly locate the original receipt in your sales history by scanning or typing the receipt number from the bar code printed on the gift receipt.

See the preference note below for instructions to turn on these printing options. Refer to Chapter 3 General Printing Information (page 39) for general information about printing documents.

To print a receipt:

1. Complete a new receipt normally and accept payment or select a receipt from the Sales History list.
2. Select PRINT & SAVE RECEIPT on a new receipt or select PRINT RECEIPT from the bottom toolbar on a previously saved receipt.
3. If print option dialogs are displayed (based on your preference settings), you can:
   - Change the printer, if necessary
   - Specify the number of copies to print or if a gift receipt should be printed
   - Select PREVIEW to view the receipt on-screen, or PRINT to immediately print

Printing a Custom Logo on Receipts

You can add your own logo to printed sales documents by specifying the logo in company preferences. If a logo is specified, it will automatically be printed on receipts and gift receipts. For Pro-level users, the specified logo is also printed on customer orders and packing slips. Refer to Adding Your Logo to Printed Documents (page 591) for the procedure and logo size requirements.
Overview .......................................................... 382
Payment by Credit, Debit or Gift Card ....................... 382
  QuickBooks POS Merchant and Gift Card Services .......... 382
  Using Another Payment Card Service ....................... 383
  Protecting your Customer’s Card Data ...................... 383
About Card Readers and PIN Pads ............................ 384
Payment by Credit Card ......................................... 385
  General Credit Card Guidelines ............................. 385
  Cardholder Address and Card Verification ................... 389
  Canceling and Reversing Credit Card Transactions ........... 390
  Settling Credit Card Transactions ......................... 391
Payment by Debit/ATM Card ..................................... 392
  General Debit/ATM Guidelines .............................. 392
  Canceling or Reversing a Debit/ATM Transaction ............ 394
  Settling Debit Card Transactions ............................ 395
Payment by or Sale of a Gift Card ............................. 395
  Selling or Recharging a Gift Card ......................... 395
  Redeeming a Gift Card ...................................... 397
  Checking Gift Card Balances ............................... 397
  Gift Card Service Reports .................................. 398
  Troubleshooting Card Service Communications ............... 398
Payment by Check ............................................... 399
Payment By or On Account ..................................... 400
Payment by or Sale of a Gift Certificate ..................... 402
Overview

Point of Sale allows you to record payment from customers by cash, check, credit card, debit/ATM card, gift card, and gift certificate, and supports charges to customer accounts. You can give change or refunds to customers by all of the same methods, except debit/ATM.

Taking payment and giving change by cash was discussed in the general payment procedure in the previous chapter. This chapter provides detailed instructions for each of the other payment type options.

Related Information

Sales Preferences. There are several general sales preferences you can set, including: payment methods you accept, which payments open an attached cash drawer, and how the customer’s receipt is printed. These options are discussed in General Sales Preferences (page 331).

Payment Reports. Several payment reports are available in the Report Center. Refer to Payment Reports (page 456) for additional information.

Payment by Credit, Debit or Gift Card

QuickBooks POS Merchant and Gift Card Services

The QuickBooks POS Merchant and Gift Card Services are optional services. Fees apply, and hardware is sold separately. To learn more about the requirements, terms, and conditions or to sign up for an account with either of these services, select the links from the Learn About Services section of the home-page Navigator, or select SETUP INTERVIEW from the File menu and visit the appropriate page.

QuickBooks POS Merchant Service

If you have an account with the QuickBooks POS Merchant Service, provided by Innovative Merchant Solutions, LLC (IMS), an Intuit company, you have an integrated credit and debit/ATM card processing solution that allows you to authorize, settle, and record these transactions within your Point of Sale software.
While a credit card reader is not required, it may qualify you for lower “swipe” rates on credit card transactions. A PIN pad device and card reader is required for PIN debit transactions.

**QuickBooks POS Gift Card Service**

You can sell, redeem, and track the balances of gift cards within your Point of Sale software with an account with the QuickBooks POS Gift Card Service. A card reader is recommended for this service, but not required. Use of this service requires the purchase of gift cards, which are sold separately.

**Using Another Payment Card Service**

If you do not have an account with the QuickBooks POS Merchant or Gift Card Services, you can still record credit, debit, and gift card transactions in Point of Sale, using the general payment procedures. However, you cannot:

- Authorize and settle credit and debit transactions from within Point of Sale
- Authorize or track gift card balances from within Point of Sale
- Payment card settlement reports are not available (you can print a simple listing your payment card sales)

Enter the customer’s payment, redemption, or purchase amounts on the appropriate lines of the payment window, using the general payment procedures. Follow your service’s instructions for authorizing/settling the transactions.

Point of Sale does not store any payment card information for these transactions.

Procedures in the rest of this chapter that talk about credit, debit/ATM, or gift card transactions are specifically written for users of the QuickBooks Merchant and Gift Card Services and do not strictly apply to you.

**Protecting your Customer's Card Data**

When you, as a retailer, begin accepting credit and/or debit cards for payment, you have a responsibility to comply with the requirements of the **Payment Card Industry Data Security Standard** (PCI DSS) to protect your customer's card data.

Point of Sale and the QuickBooks POS Merchant Service have been designed to provide you the tools and information you need to comply with these requirements if you authorize and settle credit and/or debit card transactions in Point of Sale. If you use another Merchant Service for these transactions, the cardholder data is not stored in Point of Sale and you should refer to the information provided by your service for compliance requirements in your configuration.
The PCI DSS includes requirements for the configuration, operation, and security of your system and the payment card transactions you process. Adherence to the standards not only is good for your business, as it assures your customers that their transactions are being handled in a secure manner, but also is fiscally important—a security breach could result in significant fines. (*For details, please consult: www.visa.com/cisp*)

When determining the measures that need to be taken for compliance, you need to review your entire system configuration:

- Your operating system (Windows) configuration and account controls
- Your network architecture and, as applicable, remote, wireless, and Internet access to it
- Implementation of security software, such as antivirus and firewall applications
- Implementation of, and access controls to, Point of Sale (requiring user logins, password controls, and security restrictions)
- Your policies and procedures for implementing and monitoring all of the above

A separate, electronic PCI DSS Implementation Guide is included with Point of Sale to help you learn about and comply with these requirements. To access this guide, from the Point of Sale Help menu select **USER MANUALS** and then **PCI DSS IMPLEMENTATION GUIDE**.

You can learn more about and get a copy of the PCI DSS standard at the PCI Security Standards Council™ site: [www.pcisecuritystandards.org](http://www.pcisecuritystandards.org).

### About Card Readers and PIN Pads

Point of Sale supports the use card readers and compatible PIN pad for processing of credit, debit/ATM, and gift card transactions.

Credit card and gift card transactions do not require the use of a card reader, but the use of one is highly recommended. Swiping a card through a card reader speeds entry, helps avoid errors of hand-keying, and qualifies you for the lowest fees on credit card transactions. PIN debit transactions require the use of a PIN pad.

The procedures for taking payment cards may vary depending on your installed hardware and configuration.

**Card Reader.** Ideal for retailers who accept credit and gift card payments but not PIN debit payments, or who will use the card reader in conjunction with the Ingenico 3010 (see below) for processing all card transactions.
Ingenico i3070 and Ingenico eNcrypt 2100 PIN pads. These PIN pads have an integrated card reader which can be used to process credit, debit/ATM, and gift card transactions. An added benefit with these device are their ability to store authorization information, allowing the customer to swipe their card, enter their PIN, and select cash back (if you allow it), all while your cashier is still completing the receipt. When the cashier goes to the Payment window, the PIN pad device will send the approved amounts to the correct payment and change fields.

Ingenico 3010 PIN pad. This PIN pad has no integrated card reader and requires that a card reader also be installed on the system. Typically, the customer hands their card to the cashier who swipes it through their existing card reader. The customer uses the PIN pad to enter their PIN, optionally request cash back, and approve the total amount.

Refer to PIN Pads (page 683) for information regarding PIN pads that are sold and supported by Intuit.

The procedures that follow assume you have a card reader and/or supported PIN pad connected and have configured Point of Sale preferences with your QuickBooks POS Merchant Service account number, communication method, and PIN pad.

Refer to the Point of Sale QuickStart Guide for more information about configuring your system for a Merchant Account. To connect and configure hardware, use the HARDWARE SETUP WIZARD from the File menu.

Payment by Credit Card

General Credit Card Guidelines

- Up to three credit card payments can be accepted on a single transaction.
- A card reader is not required to process credit card transactions. However, you may get a lower “swipe” rate when using a card reader. Refer to About Card Readers and PIN Pads (page 384) for more information about card readers.
- The credit card does not have to be present to authorize a transaction; however, higher fees apply and you do need the customer’s name, ZIP Code, card number, and expiration date. “Card not present” rates apply. Refer to your QuickBooks POS Merchant Service agreement for more information.
• Point of Sale performs an address verification check on all **manually entered (not swiped)** credit card transactions processed by the QuickBooks POS Merchant Service. The service checks if the ZIP Code and, optionally, the numeric portion of the street address, given by the customer matches the address currently on file at the cardholder’s bank and alerts you if there is a mismatch.

• On manually entered transactions, you can also check the card verification code against the card issuer’s records and be alerted if there is a mismatch. Select the “What is this?” link on the Credit Card Payment window for instructions to locate and enter this code.

*Address and card verification checks are important security features that can help you avoid credit card fraud. See the following preference note to specify how you want to handle verification failures.*

**Fraud Prevention Tips:** Search the in-program Help index by keywords “fraud prevention” for additional information and suggestions that can help you recognize and prevent fraudulent credit card use.

### Credit Card Sales Preferences

**Preferences: Print Two Copies of Credit Card Receipts**

PREFERENCES ➤ WORKSTATION ➤ PRINT OPTIONS ➤ Print two copies of credit card receipts: Select to always print two copies of credit card receipts—one for the customer and one for the merchant (signature copy). If you are using double-ply paper, you may want to turn off this setting.

**Preferences: Pause Between Printing to Allow Tearing Off Printed Receipt**

PREFERENCES ➤ WORKSTATION ➤ PRINT OPTIONS ➤ Pause between printing to allow tearing off printed receipt: Select if you want the printer to pause briefly between receipts so you have time to tear them off. Applies only if you have selected to print two credit card receipts (see above).

**Preferences: Automatically Print/Save Receipt Upon Card Approval**

PREFERENCES ➤ COMPANY ➤ MERCHANT AND GIFT SERVICES ➤ Automatically print and save receipt upon credit, debit, or gift card approval: Select to automatically print/save receipt once the transaction has been approved. This allows you to return to servicing your customer sooner.

**Preferences: Allowed Card Types**

PREFERENCES ➤ COMPANY ➤ SALES ➤ RECEIPT TENDERING ➤ Allowed card types: Specify the credit cards you accept. Only those cards you accept will be available when making credit card sales.
Payment by Credit, Debit or Gift Card

Preferences: Address and Card Verification for Manually Entered Transactions

PREFERENCES ➤ COMPANY ➤ MERCHANT AND GIFT SERVICES ➤ ✓ Do not allow transactions that fail address verification, and ✓ Do not allow transactions that fail card verification: Select to disallow manually entered transactions (not swiped) if the address information or card verification code provided by the customer do not match bank records. Default: Not selected. This preference applies only to users of the QuickBooks POS Merchant Service. Refer to Cardholder Address and Card Verification (page 389) for more information.

To take payment by credit card:

1. Start the receipt normally, listing items and other information.
   *If using the Ingenico i3070 or 2100 PIN pad:* The customer can swipe their card at anytime; they do not have to wait for you to go to the Receipt Payment window.

2. Select TAKE PAYMENT after completing the receipt.

3. Move the receipt amount to the Credit Card payment field and accept the entry. The Credit Card authorization window is opened.

4. Swipe the credit card or select MANUAL ENTRY. If manual entry, enter the card information and, optionally, the fraud prevention information, and then select AUTHORIZE. At the prompt, specify whether the card is present or not. If using a PIN pad, have the customer OK the amount.

5. Point of Sale connects to the Merchant Service to obtain authorization.
   *If all of the following are true, Point of Sale will process the transaction and print the receipt without further action on your part. This allows you to return to servicing the customer.*
   - The card was swiped
   - The transaction is authorized
   - You are configured to automatically save/print upon authorization
   *If any of these are not true, continue with the following steps.*

6. You will see one of the following messages:
   - **Authorized:** The charge has been approved. Select OK to close the window.
**Declined:** The charge was not approved. Select cancel to return to the payment screen. Ask the customer to provide a different form of payment, or select **AUTHORIZE** to try again.

**Referral:** Voice authorization is required. The cursor is automatically placed in the Authorization field. Call the number listed on-screen and give the operator your Merchant Number. Enter the authorization number the operator gives you and press **ENTER**.

**Failed address or card verification check:** The address or card verification code entered does not match the issuer’s records. Depending on your merchant service preferences, you may be allowed to continue or the transaction may be automatically voided.

7. Wait for the receipt to print, if configured to print automatically.

   **Or**

   Select **SAVE & PRINT** to record and print the receipt.

8. Have the customer sign the merchant copy of the receipt.

**To accept split payments including credit cards:**

Split payment transactions involving credit cards are allowed. Up to three credit cards can be used on one transaction. Credit cards can be used in combination with other payment methods.

Follow the same procedure as above, modified as explained below.

**Do not swipe the customer’s card until directed to do so below.**

1. Complete the receipt and select **TAKE PAYMENT**.

2. Enter the amount for the first credit in the **Credit Card 1** field and press **ENTER**.

3. Swipe the customer’s card or manually enter the card information. If using a PIN pad, have the customer **OK** the amount.

   Point of Sale connects to the Merchant Service for authorization in the same manner as in the previous procedure.

4. After authorization is received for the first card, enter or accept the amount for the second card in the **Credit Card 2** field, or move the amount to another payment method, and press **ENTER**.

5. If using a second card, swipe or enter card information now and follow the same process to complete the second authorization.

   **Or**

   If using another payment method, enter any requested information.

6. Repeat for a third card or another payment type, if necessary.

7. Select **SAVE & PRINT** (if not configured to print automatically.)
8. Have the customer sign the merchant copy of the receipt.

Cardholder Address and Card Verification

Address Verification (AVS)

When you manually enter credit card information, the QuickBooks POS Merchant Service verifies the cardholder's address by comparing the ZIP Code, and optionally the street address, you enter with the customer's credit card bank records.

This check is carried out using the Address Verification Service (AVS). Address verification helps merchants avoid credit card fraud and chargebacks for transactions in which the credit card information is manually entered or not physically present at the point of sale.

Only the customer’s ZIP Code is required to complete the verification check, but you can also include street address for extra protection. Only the number portion of the street address is used in the verification check, but the credit card dialog allows you to enter the street name as well.

If a customer denies having made a particular credit card purchase, showing the credit card company that you collected the customer's street address may help prove that the charge was legitimate.

Card Verification

Credit card verification is an important security check for manually entered (non-swiped) credit card transactions. The code helps verify that the customer, presumably the legitimate cardholder, has the actual card in their possession. The use of this feature is optional, but highly recommended, as one component of a fraud prevention strategy.

Card Verification Terminology

Depending on the card issuer, the card verification feature may be referred to as a card verification code (CVC), card verification value (CVV), card identification number (CID), or cardmember ID. All of these terms are synonymous and mean the same thing.

When you enter the card verification code on a credit card transaction, the processor verifies that the code matches issuer records. A mismatch can be one potential indicator of fraudulent use of the card.

Handling the Verification Results

The processor returns a message indicating whether the entered address and/or card verification information matches that on file at the cardholder’s bank. The results of
these checks are for your information only. You can choose to block or allow the credit card payment even if the verification indicates a mismatch. Blocking a transaction that fails verification affords you a degree of protection against fraudulent transactions, but also may block some legitimate transactions.

Refer to Credit Card Sales Preferences (page 386) for more information.

**Manual Voice Authorizations**

If there is a problem with your connection, Point of Sale will prompt you to do a voice authorization after three failed connection attempts.

You can also force a manual voice authorization. This may be necessary when your regular connection method is unavailable or to enter transactions later that were taken while your connection was down.

**To force a manual authorization:**

1. With the manual credit card payment window displayed, enter the credit card number, expiration date, and optionally the credit card verification code and street address. 
   
   *Do not enter the customer's ZIP Code at this point.*

2. Select the ENABLE VOICE AUTHORIZATION button next to the Authorization field.

3. Call for authorization at the number displayed. Your Merchant number is also displayed for your convenience.

4. Listen to the authorization menu choices carefully, you can choose to authorize with address verification or without. Follow the phone prompts to enter necessary information. The operator will give you an authorization code.

5. Enter the authorization code you are given in the Authorization field.

6. Enter the customer's ZIP Code and, optionally, street address.

7. Select OK.

**Canceling and Reversing Credit Card Transactions**

If a customer cancels a credit card purchase, the following apply:

- If the receipt has not been saved/printed; cancel out of the Credit Card window if necessary, and then clear the payment or cancel the entire receipt, as applicable. If the credit card has already been authorized, it is voided and the charge does not show up on the cardholder’s account.

- If the receipt has been saved, but the transaction not yet settled; display the original receipt and select REVERSE RECEIPT from the I Want To menu. Both the original and reversing receipt retain the credit card charge information.
but are marked as being voided. The transactions are not sent for settlement, nor does either transaction show up on the cardholder’s statement.

- If the transaction has already been settled, reversing the original receipt automatically credits the cardholder’s account. Because settlement has already occurred in this circumstance, both the original and return/reverse transactions show up on the cardholder’s statement. The ability to reverse credit card transactions expires 60 days after the transaction date. Refer to Reversing Receipts (page 411) for more information.

## Settling Credit Card Transactions

Although your credit card transactions are authorized immediately as you take payment, funds are not transferred from the cardholder's account to yours until the transactions are “settled.” With a QuickBooks POS Merchant Service account, you can send each day's Merchant Service batch to the processor for settlement as part of the End of Day procedure or you can send batches manually whenever you want.

**Important:** You must send your credit card transaction data to the processor within a day of authorizing the transactions to avoid paying higher fees.

---

### Settlement Batch Transaction Limit

A credit card settlement batch is limited to 500 transactions or a total dollar amount of $999,999.99. If you reach either of these limits before settling, Point of Sale does not allow any more credit card transactions until settlement is completed.

Once settled, transaction funds are deposited into your bank account, less the merchant discount fee. If you are integrated with the 2008 version of QuickBooks financial software, credit and debit card transactions are added to your Undeposited Funds account and Payments to Deposit window grouped by settlement batch. This makes it easy to match credit and debit card payments taken in Point of Sale to your bank deposits in your financial software and to identify discrepancies and fees.

Refer to Chapter 24 End of Day Procedures (page 439) and Chapter 25 Cash Drawer (X/Z-Out) and Payment Reports (page 445) for more information on settlement procedures and reports.
Payment by Debit/ATM Card

General Debit/ATM Guidelines

- QuickBooks POS Merchant Service does not support the collection of transaction fees on debit/ATM payments.
- There are two ways a customer’s debit/ATM card can be accepted for purchases:
  - PIN debit transactions, which require the use of a PIN pad, take payment directly from the cardholder’s associated bank account, and allow cash back. This section applies to this type of transaction.
  - Processing the customer’s debit/ATM card like a credit card, which does not require the use of a PIN pad and does not allow cash back. Typically, the card must display a credit card logo (e.g., Visa, MasterCard) to be used this way. Process these transactions using the instructions in Payment by Credit Card (page 385).
- PIN debit payments, once authorized, cannot be deleted from the receipt, nor can the receipt be canceled or voided. If necessary to cancel the receipt after authorization, the cashier can manually enter an equal amount by another payment type to balance the receipt, save, and refund the debit amount to the customer.

Debit/ATM Sales Preferences

Preferences: Accept Debit/ATM Card Payments and Allow Cash Back

PREFERENCES ➤ COMPANY ➤ MERCHANT AND GIFT SERVICES ➤ ✅ Accept debit/ATM card payments: Select to allow payment by debit/ATM card. Default: selected. ✅ Allow cash back: Select to allow cash back to customers on PIN debit sales. Also, specify the maximum cash back per transaction (up to $200). Selecting this option enables the cash back option on the PIN pad device. Default: not selected (no cash back).

Preferences: Automatically Print and Save Receipt Upon Approval

PREFERENCES ➤ COMPANY ➤ MERCHANT AND GIFT SERVICES ➤ ✅ Automatically print and save receipt upon credit, debit, or gift card approval: Select to automatically print/save receipt once the transaction has been approved.

To take payment by debit/ATM card:

1. Start the receipt normally, listing items and other information.

   If using the Ingenico i3070 or eNcrypt 2100: The customer can swipe their card at anytime; they do not have to wait for you to go to the receipt Payment window.
The customer should select **DEBIT/ATM** as the transaction type, enter their PIN and, optionally, select a cash back amount.

2. Select **TAKE PAYMENT** to go to the Payment window.

   *If using the Ingenico i3070 or eNcrypt 2100:* If the customer finished entering information on the PIN pad before you reached the Receipt Payment window, the receipt amount is auto-filled in the **Debit/ATM** field and the Debit Card window is opened. Skip to Step 5 in this case. If you selected **TAKE PAYMENT** before the customer finished, complete Step 3 and then skip to Step 5.

3. Move the receipt amount to the **Debit/ATM** payment type and accept it.

   The Debit Card window is opened.

4. Swipe the debit card and, if applicable, enter a cash back amount.

5. The customer must select **OK** on the PIN pad to approve the sale amount. (You will see the “Waiting for user input” message until customer approves the amount.)

   Point of Sale connects to the Merchant Service to obtain authorization.

   If both of the following are true, Point of Sale will process the transaction and print the receipt without further action on your part. This allows you to return to servicing the customer.

   - The transaction is approved
   - You are configured to automatically print and save the receipt upon approval

   If either of these is not true, continue with the following steps.

6. You will see one of the following messages:

   **Authorized:** The debit has been approved. Select **OK** to close the card dialog.

   **Declined:** The debit was not approved. Select **CANCEL** to return to the payment screen. Ask the customer to provide a different form of payment, or select **AUTHORIZE** to try again.

7. Wait for the receipt to print, if configured to print automatically on approval.

   *Or*

   Select **SAVE & PRINT** to complete and print the receipt.

8. If applicable, the change window displays the cash amount to give the customer. Select **OK** to close the window.
To accept split payments including debit cards:

Split payment transactions involving debit/ATM cards are allowed, however only one debit card payment is allowed on a sale. Debit/ATM cards can be used in combination with other payment methods, including credit cards.

Follow the same procedure as above, modified as follows.

Do not swipe the customer’s card until directed to do so below.

1. Complete the receipt and select PAYMENT.
2. Enter the amount for the debit in the Debit/ATM field payment field and press <ENTER>.
3. Swipe or have the customer swipe their card and, optionally, enter a cash back amount.
4. Have the customer OK the amount on the PIN pad.
   Point of Sale connects to the Merchant Service for authorization in the same manner as in the previous procedure.
5. After authorization is received for the debit card, enter and accept the amount for the second payment method, and press <ENTER>.
6. If using a credit card, follow the credit card authorization process.

   Or

   If using another payment method, enter any requested information.
7. Repeat for another payment type, if necessary.
8. Once payment is balanced with the amount due, the transaction will immediately save/print (if configured to do so) or you can select SAVE AND PRINT to complete the transaction.

Canceling or Reversing a Debit/ATM Transaction

PIN debit payments, if already authorized through the QuickBooks POS Merchant Service, cannot be cleared from the receipt, nor can the receipt be canceled or voided.

- If the receipt has not been saved yet and the customer wants to complete the sale, the cashier can take an equal amount by another payment type to balance the receipt, save, and refund the debit amount to the customer.
- Reversing a debit receipt does not create a credit back into the customer’s bank account. When you reverse a debit receipt, the change is automatically assigned to cash. If you want to return the money to the customer by another method, create a return receipt instead and choose any payment method. Then create a new, corrected receipt if necessary. Refer to Chapter 22.
Settling Debit Card Transactions

PIN debit card transactions are not settled in the same sense as credit cards are. PIN debit transactions immediately debit the cardholder’s account when processed, therefore no settlement is required. However, your debit transactions are batched with your credit card transactions, to facilitate grouping and reconciling the payments with your bank deposits.

Refer to Chapter 24 End of Day Procedures (page 439) and Chapter 25 Cash Drawer (X/Z-Out) and Payment Reports (page 445) for more information on settlement procedures and reports.

Payment by or Sale of a Gift Card

Gift cards are sold, recharged (additional value added), or redeemed from a sales receipt. Up to three gift cards can be sold or redeemed on a single receipt.

The procedures below assume you have an account with the QuickBooks POS Gift Card Service and have configured Point of Sale company preferences with your account information. Refer to the QuickStart Guide that accompanied your Point of Sale software for more information about setting up a gift card account.

Selling or Recharging a Gift Card

When a customer buys a gift card, there is no net sale. The customer is paying the amount of the card purchase by one payment method (such as cash or credit card) and receiving the same amount as change in the form of a gift card.

Ingenico 2100 and i3070 PIN Pads

If you use the customer-facing Ingenico 2100 or i3070 PIN pad to swipe cards, you must use the alternative procedure below for selling gift cards, or set up a separate card reader for gift card sales.
To sell or recharge a gift card:

1. Start a new sales receipt with or without other items listed.
2. In the Enter Items field, swipe the gift card or begin typing Gift... and then from the drop-down list, select GIFT CARD.
3. Enter the gift card amount and number in the dialog displayed and select OK. If you swiped the card, the number is pre-filled.
4. Repeat if selling additional cards; up to three on a single receipt.
5. Select TAKE PAYMENT.
   Point of Sale connects to the Gift Card Service and updates the balance for the card(s). A confirmation message is displayed when this process is complete.
6. Enter/accept payment and change amount(s) as applicable until the Payment Complete message is displayed.
7. Save/print the receipt.

Alternative Procedure for Selling Gift Cards

1. Start a new receipt with or without items listed.
2. Select TAKE PAYMENT to display the Receipt Payment window.
3. Enter the amount of the gift card being sold in the Gift Card Sell field and press <ENTER> or select ACCEPT SALE.
4. The Gift Card window is displayed.
   Swipe or type the gift card number and then select AUTHORIZE.
   Point of Sale connects to the Gift Card Service and updates the balance for the card; a confirmation message is displayed and the amount due will change to reflect the payment that must be taken from customer.
5. Repeat if selling additional cards; up to three on a single receipt.
6. Enter/accept payment and change amount(s) as applicable until the Payment Complete message is displayed.
Payment by Credit, Debit or Gift Card

7. Save/print the receipt.

To Return a Gift Card or to Cancel a Gift Card Purchase

- Reverse the original receipt. This will automatically cancels the gift card transaction. Reversing the purchase of a gift card removes the balance on the card. Reversing a receipt that was paid by gift card returns the amount to the card.

Or

- Create a new receipt with no items and from the payment window, redeem the card and return equivalent change to the customer by another means.

Redeeming a Gift Card

To redeem a gift card for payment on a sale:

1. List the items to be sold on the receipt and then select TAKE PAYMENT (<F12>).
2. Move or enter the amount due to the Gift Card Redeem field and press <ENTER>. The Gift Card window is displayed.
3. Swipe or enter the gift card number and then select AUTHORIZE. If using a PIN pad, have the customer OK the amount.
Point of Sale connects to the Gift Card Service and checks the balance of the card and a confirmation message is displayed.
If the balance is equal to or more than the amount due, the payment amount is deducted from the card balance and payment is complete.
If the card balance is less than the amount due, the card balance is adjusted to zero and the authorized amount is auto-populated to the Gift Card Redeem field. You will need to take additional payment by another gift card or other payment method for the remaining amount due. After entering one transaction, a new gift card line is added to the payment window.
4. Save/print the receipt.

Checking Gift Card Balances

To check the balance of an individual gift card:

1. Start a new sales receipt with or without items listed.
2. Select TAKE PAYMENT.
3. Select CHECK A CARD BALANCE to the right of the Gift Card line.
The Gift Card Balance Inquiry window is displayed.

4. Swipe or enter the card number, and then select **CHECK NOW**.

Point of Sale connects to the service and displays the card balance.

To check the balance of all outstanding gift cards, run a gift card balance report as described below.

**Gift Card Service Reports**

Users of the QuickBooks POS Gift Card Service can run two reports summarizing or detailing their gift card transactions.

**Gift Card Balance Summary.** A list of all outstanding gift cards and their current balances.

**Gift Card Activity Detail.** Details of gift card activity in a specified date range.

Refer to **Payment Reports (page 456)** for more information on gift card reports.

**Troubleshooting Card Service Communications**

Point of Sale provides a troubleshooting utility that is designed to resolve communication problems that may occur when authorizing or settling payments for card transactions with QuickBooks POS Merchant Service or QuickBooks POS Gift Card Service.

The EFT (Electronic Funds Transfer) Troubleshooter can be launched from the Help menu or by right-clicking the icon in the Windows system tray, the troubleshooter walks you through possible causes and solutions to errors received during communication attempts.

Below is an example of the first screen of the EFT Troubleshooter.
Payment by Check

Follow the on-screen instruction to troubleshoot and correct the problem.

![EFT Troubleshooter](image)

### Payment by Check

Whether or not checks are accepted from a given customer can be indicated in the **Accept Checks** field on the customer’s record. Clear this checkbox to block payment by check.

<table>
<thead>
<tr>
<th>Accept Checks Setting</th>
</tr>
</thead>
</table>

If requiring user logins, a cashier with sufficient security rights can override the customer’s **Accept Checks** setting (if set to not accept checks). A cashier that does not have security rights to override this setting will not be allowed to accept the check and a different payment type will have to be used to complete the sale. If you are not requiring users to log in, anyone can override this setting. *Refer to Chapter 5 Data and Program Security (page 65) for more information about assigning security rights to employees.*

If the user does not have sufficient security rights, the Manager Override function can be used to allow payment by check. *(Refer to Manager Override (page 70) for more information.)*

Follow the general payment procedures outlined earlier in the previous chapter to accept a check for the exact sale amount.

**To accept a check for more than the purchase amount:**

1. Complete the sale normally, entering the full amount of the check in the **Amount Tendered** column for Check.
2. Press *<ENTER>*. When prompted, enter the check number.
Any overpayment will be suggested as cash for the change. The change can be returned by another method if needed; simply move or enter the change amount by a different method. See the Tip on giving back cash in the To return a specified amount of cash when ringing-up a sale: (page 376) section.

To cash a check without a purchase:
1. Create a receipt with no items listed and a zero total balance.
2. Select TAKE PAYMENT to display the Receipt Payment window.
3. Enter the payment amount as a check. Enter the check number or complete verification procedures as requested.
4. The entire amount will show as change due and will be suggested as cash. Press <ENTER> to accept the amount and change method.
5. Save the receipt normally. The Change window will display the cash amount to return to the customer.

Payment By or On Account

Point of Sale alerts you and, depending on your security settings, may block a new account charge if insufficient credit is available. If you are integrated with QuickBooks financial software, and have enabled past due account blocking, the charge may also be blocked if the account is reported as past due. Refer to In-Store Charge Accounts (page 316) for more information about allowing account charges, setting credit limits, and receiving past due alerts.

Overriding Account Charge Blocking

If requiring user logins, a cashier with sufficient security rights can override the block to a new charge on account. A cashier that does not have this right will have to use a different payment type to complete the sale or request another user with sufficient rights use the Manager Override function to allow the charge. Refer to Manager Override (page 70) for more information.

If you are not requiring users to log in, anyone can override these settings. Refer to Chapter 5 Data and Program Security (page 65) for more information about assigning security rights to employees.

If you exchange information with QuickBooks financial software, customer account charge receipts and payments on account are sent and posted to the customer’s account. Refer to Chapter 29 How QuickBooks Handles Point of Sale Data (page 497) for more information on how account transactions are posted to QuickBooks.
Payment By or On Account

To record a sale paid by charge to customer account:

1. List the items and customer on the receipt normally.
2. Enter/accept the payment amount using Account as the payment method (enter/accept the amount in the Charge field).
3. Save or print the receipt normally.
   If needed, you can configure Point of Sale to automatically print two copies of the charge account receipt. See Print Options (page 641) for more information.

To record payments on account in Point of Sale:

1. From the customer record, sales history, or while creating a receipt, select TAKE PAYMENT ON ACCOUNT from the I Want To menu.
   If on a new receipt, you can add new purchases to the same transaction.
2. In the Payment on Account window, select the customer from the drop-down list, enter the amount being paid, and then select ACCEPT PAYMENT.
   The Receipt Payment window is opened. The account payment amount is pre-filled into the appropriate field.
3. Enter/accept payment amount(s) until the Payment Complete message is shown.
4. Select SAVE & PRINT or SAVE ONLY.
   The Account Charge method is not available on the payment window when accepting a payment on account, as a customer cannot make a payment on account by charging it to their account.

Payments on account can be entered directly into your financial software if you prefer, using the CUSTOMERS ➤ RECEIVE PAYMENT option (see your QuickBooks financial software documentation for more information). If choosing this method, do NOT enter the payment in Point of Sale as well. Payments on account recorded in your financial software will be reflected in Point of Sale after the next Financial Exchange.
Payment by or Sale of a Gift Certificate

When a customer buys a gift certificate they are paying in the amount of the certificate in one currency (such as cash) and receiving the same amount as change in the form of the gift certificate. Certificate numbers can be recorded on both the sale and the redemption of gift certificates for tracking purposes. You cannot both take and sell a gift certificate on the same transaction.

To sell a gift certificate:

1. Start a new sales receipt with or without other items listed.
2. In the Enter Items field, begin typing Gift... and then from the drop-down list, select GIFT CERTIFICATE.
3. Enter the gift certificate amount and number in the dialog displayed and select OK.
4. Select TAKE PAYMENT to display the payment window.
   The gift certificate amount is pre-filled to the Gift Certificate Purchase field and the total amount due from the customer (any purchases plus the gift certificate amount) is suggested in the amount column.
5. Enter/accept payment amount(s) as applicable until the Payment Complete message is displayed.
6. Save/print the receipt. The Change window displays the amount of the gift certificate to give the customer.

To accept a gift certificate for payment:

1. Process the payment normally, entering the amount in the Gift Certificate Redeem field.
2. Record the certificate number when prompted.
3. Take additional payments and/or return change in the normal way.
4. Save/print the receipt.
Chapter 22  Returns, Exchanges and Sales History

Working with Sales History .................................................. 404
Locating a Receipt .......................................................... 404
Editing a Receipt .......................................................... 406
Merchandise Returns and Exchanges .................................. 407
Reversing Receipts ......................................................... 411
  Notes on Reversing Receipts of Specific Payment Types .... 412
Chapter 22: Returns, Exchanges and Sales History

Working with Sales History

After a sales transaction is saved, the receipt is stored in your sales history list. Receipts provide the permanent record of merchandise sold from (and returned to) inventory, as well as deposits on customer orders and payouts. All receipt types are stored in the same list and share the same numbering sequence.

Locating a Receipt

The sales history list is displayed when you select SALES HISTORY from the Point of Sale menu or from the I Want To menu while working on a receipt. You can view and locate a receipt by searching sales history or customer history, or by standard sorting and filtering in the sales history list.

Once you have located a receipt in sales history, it can be viewed, copied, reprinted, or reversed. These procedures are summarized here.

Refer to Locating Records or Documents (page 31) for detailed instructions.

To search for a receipt:

1. Access the receipt Find field in one of these ways:
   - From the Navigator, use the Quick Find window
   - From the window toolbar of a new receipt form or sales history, select FIND RECEIPT (<CTRL+F>)
   - From the Edit menu, select FIND RECORD ➤ SALES RECEIPT

   Quick Find from Navigator

   Find field on New Receipt form
2. Enter the search criteria into the Find field and select **FIND**. Use information from the original receipt if the customer has brought it into the store for a return or exchange. You can search for:
   - **Date** the receipt was made
   - **Receipt #** — Type the receipt number or scan the bar code at the bottom of the receipt
   - **Customer** or **Company name**
   - **Associate** who made the receipt
   - **(Pro) Serial Number** or shipping **Tracking #**

   If more results than expected are returned, narrow the search results by selecting **ADVANCED FIND OPTIONS** on the Find window, and select to search only in a specific field or another advanced option. (Advanced search not available on the Quick Find window.)

3. Select a receipt from those displayed.

**To search for a receipt in customer history:**

1. Access the customer’s sales history:
   - From the customer list, highlight the customer and select **COLLAPSE** to view the Customer Information Panel showing the customer history

   **Or**

   If you have the customer listed on a receipt, select **VIEW CUSTOMER HISTORY** from the I Want To menu at the top of the screen

   The displayed purchase history shows a summary of customer purchases and a list of the receipts. You can expand a receipt to view the items purchased.

2. Select a receipt and select **GO TO DOCUMENT** from the I Want To menu on the right or double-click it to display the receipt.

   Refer to **Viewing a Customer’s Purchase History** (page 313) for more information about working with customer purchase history.
To filter your sales history list:

1. Display your sales history, and then select one of the following from the drop-down view list at the top of the window:
   - A predefined filter (such as ALL RECEIPTS, THIS MONTH, or THIS WEEK)
   - A previously defined and saved custom filter (your custom name)
   - CREATE FILTER to enter custom filter criteria, and optionally save it
   - MANAGE FILTERS to edit, rename, delete, or rearrange the order of your previously saved filter views

   Caution: Choosing ALL RECEIPTS could slow the list display.

2. If you selected CREATE FILTER, enter criteria values in any of the available fields and then select APPLY or SAVE. Refer to Using Filters in Lists and Reports (page 106) for more information.

   Your list is filtered by your selected criteria.

To find a receipt by sorting or scrolling:

1. Select the column by which you want to sort the list by clicking or touching the header of the column.

   You can also sort on multiple columns by selecting SORT LIST ➤ SORT ON MULTIPLE COLUMNS from the View menu. To customize the columns visible in the sales history list, right-click in any column header and choose CUSTOMIZE COLUMNS.

2. Immediately begin typing the first few characters of the column entry you wish to locate. The characters you type are not displayed, but the closest matching record to what you typed is highlighted.

   Or

   Use the vertical scroll bar to scroll through your list. The scrolling indicator displays your progress as you move through the list.

Editing a Receipt

Point of Sale allows you to go back and correct certain informational entries on saved receipts. However, you cannot edit any field affecting the receipt amounts, items, or payments.

If you are exchanging information with QuickBooks financial software, editing is even more limited after the information has been sent to your financial software. To correct receipts at that point you must reverse the receipt and create a new receipt with the corrected information. Refer to Reversing Receipts (page 411) for more information.
To edit a receipt:

1. Access and open the receipt from Sales History.
2. Edit the informational fields as needed. Editable fields include the comments and shipping information (not amount), and until sent to QuickBooks, the customer and promotional code.
3. Select SAVE.

---

**Multi-Store: Remote Stores Editing Receipts**

Once transactions have been sent via Store Exchange to Headquarters, you can no longer edit the receipt.

---

**Merchandise Returns and Exchanges**

Returned merchandise is recorded on a receipt which adds the item(s) back to inventory and deducts the amount from the current day’s sales. Additional merchandise can be entered on the same receipt, for doing an exchange or for purchase.

There are several ways to complete a return. Use whichever is most convenient for you.

- On a sales receipt, list the returned item and then select **MAKE THIS ITEM A RETURN**. This will change the item quantity to negative. This is a quick way to return one or a few items and also works well if you are selling replacement or additional items on the same receipt.

- Locate and display the original receipt from sales history or customer history. Then, from the I Want To menu, select **ACCEPT RETURN ITEM(S)**. If the original sale included only a single item, that item is immediately added to a new sales receipt as a return item, with a negative quantity and at the same price as the original.
If the original sale included multiple items, the Merchandise Return wizard is opened and displays a listing of the items, quantities, and original sales prices. Select the checkboxes of the items being returned, edit the quantity if necessary, and then select **ACCEPT RETURN**. The selected items are added to a new sales receipt with negative quantities and the at same price at which sold.

With this method, you ensure that the return is processed at the same price as originally sold.

- If the original sales receipt sold many items, all of which are being returned, this method is the most efficient way to quickly return them all at the same price as paid. Locate and display the original receipt from your sales or customer history and then select **COPY RECEIPT**. From the I Want To menu of the new receipt, select **CONVERT TO ➢ A RETURN RECEIPT**. All items from the original receipt are added to a new receipt with the same quantities and price as the original; edit as necessary.
Unlike the previous methods, this method creates a *return receipt* and the returned quantities are *positive numbers*. If you choose to sell additional items on a return receipt, enter the sales items with negative quantities.

If a return results in the customer being due a refund, the normal **TAKE PAYMENT** button at the bottom of the receipt is changed to say **REFUND PAYMENT**. When you go to the payment window, the refund amount is suggested in the Change column.

- If refunding by credit or gift card and using the QuickBooks POS Merchant or Gift Card Service, swipe the customer’s card and/or enter information as requested. A credit will appear on the cardholder’s account or the refund value will be added back to the gift card, respectively.
- Refunds cannot be made to a debit/ATM card. Return the money to the customer by another change method per your store policy.

---

**Tip: Using Charge Account to Give Store Credit on Returns**

Merchants allowing charges on account can issue store credit on merchandise returns. To do this, on the payment window, enter the change amount in the **Account Payment** field. The customer’s charge account will be credited.

If you are integrated with QuickBooks financial software, a credit memo or customer payment (depending on your version of QuickBooks) will be created in your financial software. Be aware that if you put both return and sales items on a single receipt, only one document is created in your financial software, based on the net amount of the receipt. If negative, a customer payment or credit memo is created. If positive, a customer invoice is created. If you always want customer payments/credit created for returns and invoices for sales, record returns and sales on separate receipts.

**Tip: Removing Unsalable Merchandise from Inventory**

A return adds the returned item quantities back to inventory. If the merchandise returned is not saleable, you should create an adjustment memo to remove it from inventory or a return voucher if the item is to be returned to the vendor. Refer to **Creating an Adjustment Memo** (page 245) or **Returning Merchandise to a Vendor** (page 299) for more information.

---

**Items Deleted from Inventory**

If any item listed on the original receipt no longer exists in inventory, it will not be copied to the new receipt.

**Review Copied Information**

When copying a receipt, it is recommended that you review the various information fields that contain information from the original receipt, such as comments, shipping information or associate. Many of these fields may need to be updated for the new receipt.
To make a merchandise exchange:

A merchandise exchange is simply the combination of a return and a sale on the same receipt. Use any of the methods listed above to process the return and then add the sales items to the same receipt. Or, you can use the Merchandise Exchange wizard to help process an exchange.

1. From the I Want To menu on a new sales receipt or from sales or customer history, select **EXCHANGE ITEMS(S)**.

   The Merchandise Exchange wizard is opened.

2. Using normal item listing procedures, enter the item(s) and quantities being returned in the top portion of the window.

   If a receipt was selected in sales or customer history prior to selecting **EXCHANGE ITEMS**, the items from that receipt are pre-filled to the return item list in the window. Select the checkboxes to designate the item(s) are being exchanged and adjust the quantity as needed.

3. Enter the new (replacement) item(s) and quantities in the bottom portion of the window.

4. Select **ACCEPT EXCHANGE**.

5. Complete the transaction, taking additional payment or giving change if required.
Reversing Receipts

Receipts cannot be deleted, and editing is restricted to informational fields. However, they can be reversed to correct errors. Reversing is not recommended to handle customer returns. Refer to Merchandise Returns and Exchanges (page 407) for more information about returning merchandise.

Reversing a receipt corrects your sales history and adjusts inventory and customer records by creating a new receipt with the opposite effect of the original. i.e., a sales receipt is reversed with a return receipt. When completed, the original receipt is marked Reversed in the Status field and the new receipt that was created will be marked Reversing. The Status column is available to add to your sales history list.

You can use a Reverse, Copy, and Correct approach, to make a new receipt to replace the original with the correct information. First, reverse the original, incorrect document. Then begin a new document by copying the original one. Finally, make corrections to the copy and save as usual to create a new corrected receipt.

The ability to reverse a receipts is controlled by security rights.

See the notes on reversing receipts of specific payment types at the end of this section.

To reverse a receipt:

1. Locate and select the receipt in sales history.
2. Select REVERSE RECEIPT from the I Want To menu.
   The Reversing Document dialog is displayed.
3. Select your name from the Associate field and then select OK. If security is used, you cannot change the name in the dialog; it will automatically be entered as the logged in user.
   A reversing document with your name is automatically created and added to the receipt file.
   A corrected receipt can then be made as described below.

To copy and correct a receipt:

Copying and correcting a reversed receipt allows you to adopt the parts of the original receipt that you want to keep, and then correct or edit the parts that were inaccurate on the original, to make a new, correct receipt.

1. Reverse the original receipt as described above.
2. Locate the original receipt in Sales History a second time (status of Reversed).
3. Select COPY RECEIPT. A new receipt is created with the same information as the original.
4. Make any necessary corrections (edits) to correct the information on the new receipt.
5. Process payments for the receipt as usual.
6. Select PRINT & SAVE.

**Tip: Changing the Date on Receipts**

When you reverse a receipt more than a day old and create a new corrected one, you might want to date the new receipt the same as the original so that your sales reports reflect the date the merchandise was actually sold. Simply change the date (security allowing) on the receipt. The next receipt made will automatically revert back to the current date.

(Pro Multi-Store) Receipts can only be reversed at a remote store up until the time they are sent to Headquarters via a Store Exchange. After this time, the receipt can be reversed at Headquarters, or the remote store can manually cancel the effect of the original by copying it and making a return receipt with the same information. A corrected new receipt can then be made as described above.

**Notes on Reversing Receipts of Specific Payment Types**

When you reverse a sales receipt, the amounts taken in payment on the original receipt are returned as change (a credit) to the customer on the return receipt created. In this way, the accounting is automatically corrected along with the other changes you make on the receipt. This action is usually done to correct a receipt after the customer has left the store.

The following are brief descriptions of how reversing a sales receipt of specific payment types, and then creating a new corrected receipt, are handled. Reversing a return receipt works the same way but the payment and change (credit) amounts are the opposite.

**Cash.** The reversed receipt shows the original payment returned to the customer as cash change. Record payment on the new corrected sales receipt as cash as well. If there is a difference between the amounts on the two receipts, you will need to handle collecting or refunding from/to the customer according to your store policy.

**Check.** The reversed receipt shows the original payment returned to the customer as change by check. Record payment on the new corrected sales receipt by check as well. If there is a difference between the amounts on the two receipts, you will need to handle collecting or refunding from/to the customer, changing the
amount of the check, or getting a new check according to your store policy and legal requirements in your area.

Credit Card. The reversed receipt shows the original payment returned to the customer as change by credit card. If you use the QuickBooks POS Merchant Service and the receipt has already been settled, this receipt will automatically be sent to the card processor as part of the next settlement batch. This will result in a credit on the cardholder's account. Record payment on the new corrected sales receipt by the same credit card, authorizing and updating the charge by entering the card information in the normal manner (if not present, you may have to contact the customer for this information). This new receipt will also be sent with the next settlement batch, resulting in a new charge on the cardholder's account. If you do not use the QuickBooks POS Merchant Service, follow the same procedure but use the third-party processor's instructions for handling the card credit and new authorization. The ability to reverse credit card receipts expires 60 days after the transaction date.

Debit/ATM Card. Reversing a debit receipt does not create a credit back into the customer’s bank account. When you reverse a debit receipt, the change is automatically assigned to cash. If you want to return the money to the customer by another method, create a return receipt instead and choose any change method. Then create a new, corrected receipt.

Gift Card. If using the QuickBooks POS Gift Card Service, reversing a gift card transaction restores the value being reversed on the gift card by creating an opposite transaction. For example, if you are reversing a sales receipt that included a $100 gift card redemption, reversing the receipt adds $100 back to the gift card, increasing the stored value of the card by that amount. A new corrected receipt can again redeem the gift card value or use any other payment type.

Gift Certificate. The reversed receipt shows the original payment returned to the customer as change by gift certificate. Record payment on the new corrected sales receipt by gift certificate as well. If you track gift certificates by number, enter the same number as the original certificate. If there is a difference between the amounts on the two receipts, you will need to handle collecting or refunding from/to the customer according to your store policy and legal requirements in your area.

Account. The reversed receipt shows the original payment returned to the customer as a payment on account (and, if applicable, results in a customer payment or credit memo in QuickBooks). Record payment on the new corrected sales receipt by account charge.
QuickBooks Financial Software Users

In all cases, both the reversed receipt and the new corrected receipt will be sent to QuickBooks financial software as part of the next Financial Exchange, thus automatically updating your financial records accordingly.
Chapter 23  

Sales Orders, Work Orders and Layaways (Pro)

Customer Order Overview ........................................... 416
Typical Workflows for Customer Orders .............................. 417
  Layaways ............................................................. 417
  Sales Orders ......................................................... 417
  Work Orders ......................................................... 418
Basic Customer Order Procedures ..................................... 419
Creating a New Customer Order ....................................... 419
  Working with Special Order Items ................................. 420
Entering Shipping Information ......................................... 421
Taking Deposits on Customer Orders ................................. 422
  Refunding Deposits ............................................... 423
  Deposit/Payment History .......................................... 424
Generating Purchase Orders from Customer Orders ............... 424
E-mailing Orders to Your Customers ................................ 426
Filling Customer Orders .............................................. 426
  Filling Customer Orders from the Reminders Page ................ 427
Maintaining Customer Orders ......................................... 428
  Locating a Customer Order ........................................ 428
  Editing Customer Orders .......................................... 429
  Copying a Customer Order ........................................ 429
  Tracking Orders by Status ........................................ 430
Deleting Customer Orders ............................................ 431
Using Work Orders ..................................................... 431
  Defining Service Items for Work Orders ......................... 432
    Defining an Item Discount for Warranty Service .............. 432
Assigning Work Orders ............................................... 433
Using the Status Field to Track Work Orders ....................... 433
  Printed Work Order Message ..................................... 434
Customer Order Reports .............................................. 435
Printing Customer Orders ........................................... 435
Customer Order Overview

Point of Sale offers three customer order documents: layaways, sales orders (SO), and work orders (WO). These versatile documents are used to record planned sales of merchandise and/or services, such as:

- Layaway of in-stock items, usually paid for through a series of deposits
- Orders for out-of-stock merchandise
- Special orders of new or custom merchandise
- Customer quotes for merchandise and/or services
- Tracking of service orders, repairs, alternations, or warranty work

Typically, customer orders involve taking a deposit when the order is placed, optional additional deposits over a period of time, and a final payment, if necessary, when the merchandise or service is delivered. The actual sale of the merchandise or service is recorded on a sales receipt when delivered.

Items listed on customer orders are deducted from inventory only after the sales receipt is made to fulfill the order. The quantity of an item on open customer orders is considered “committed” and is subtracted from the on-hand quantity to arrive at the available quantity of the item. Refer to Available Quantities (Pro) (page 188) for more information on tracking and viewing your available quantities.

You can sell all the items on a customer order at one time, or partially fill the order by delivering only some of them as merchandise is received or services completed. When the sale is recorded, deposits previously taken are applied towards the final payment on the sale receipt. A permanent record of the order and sale is provided by the receipt(s) in sales history. Fulfilled customer orders can be safely deleted at your discretion.

(Pro Multi-Store) Customer orders are created and maintained separately at each store. Only the receipts created to take deposits and later sell the ordered merchandise are sent to Headquarters.

To access customer orders:

- Select one of the options below from the Point of Sale menu.
  - NEW LAYAWAY, NEW SALES ORDER, or NEW WORK ORDER to create a new customer order
  - LAYAWAY LIST, SALES ORDER LIST, or WORK ORDER LIST to locate and work with an existing customer order
Typical Workflows for Customer Orders

This section is intended to give you some ideas for how customer orders can be used. Specific procedural instructions for each document type follow in later sections.

Layaways

A layaway is generally used to hold an in-stock item while a customer makes a series of payments over time against the total price.

1. Start a new layaway and list the items to be held for the customer.
2. Set aside the merchandise tagged for the customer. Many retailers have a dedicated layaway shelf for this purpose.
3. Record an initial deposit and then a series of deposits over the agreed schedule.
4. When the final payment is due, record the sale on a receipt, applying the deposit balance amount towards payment.
5. Deliver the item to the customer, thus removing the quantity from inventory.

Sales Orders

Sales orders (SOs) allow you to record the planned sale of items currently out of stock, back-ordered, or items that you do not carry at all. When receiving an out of stock item which appears on a sales order, Point of Sale will alert you that open orders exist for the item and add the item to the Fill Customer Orders reminder list.

Sales orders can also be used to create and give a customer a quote for merchandise and/or services.

Sales Order for Out-of-Stock Merchandise

1. List the out-of-stock item on the SO.
2. Take an initial deposit, if you require one.
3. Print a copy of the order for the customer.
4. Order and receive the merchandise from your vendor.
5. When the customer picks up the item, record the sale on a receipt, applying the deposit towards final payment.

Sales Order for One-Time Merchandise

1. Start a new sales order and then select NEW SPECIAL ORDER ITEM from the I Want To menu.
2. Define the special order item in inventory and then list it on the sales order.
3. Edit the price, quantity, etc. on the sales order, if needed.
4. Take a deposit, if you require one.
5. Save and print the order for the customer.
6. Select **GENERATE PO** from the I Want To menu on the sales order to create a purchase order for the new item and create a receiving voucher when it arrives.
7. When the customer picks up the item, record the sale on a receipt, applying the deposit towards final payment.

**Sales Order for a Customer Quote**

1. List the items and/or services included in the quote on the sales order. Use service or non-inventory items for listing services; or special order items for merchandise you do not currently carry.
2. Set the order status to **PENDING**. This step prevents the order from affecting your available quantity. Since this is just a quote, the quantities are not committed.
3. Give the customer a copy of the quote/sales order.
4. When the customer accepts your quote, set the order status to **OPEN** (now its committed) and order the merchandise if necessary.
5. When merchandise has been received, record the sale on a receipt, deliver the merchandise and/or services and accept payment as usual.

**Work Orders**

Whereas layaways and sales orders typically involve merchandise orders, work orders generally are for service jobs, such as alterations, repairs, or warranty service. If merchandise is recorded on a work order it is usually consumed in performing the service, such as repair parts. The actual item being worked on (if there is one) is generally not sold via the work order.

**Work Orders to Track Service Jobs**

1. Define service items in inventory for the various services provided.
2. List the service items and any related parts on the work order form.
3. Enter the customer, a descriptive explanation of the work to be performed, and assign due dates and an employee to perform the work.
4. Assign a status to the work order for tracking and reporting, such as New, Waiting for Parts, or Completed.
5. Take an initial deposit, if required.
6. Generate a purchase order from the work order form for any needed parts.
7. When the job is completed, record the sale on a receipt, applying the deposit amount toward final payment.
Creating a New Customer Order

Basic Customer Order Procedures

The procedures in this section cover the basic steps to create, edit, take deposit on, and fulfill customer orders of any type.

Many of the procedures involved in creating a customer order (such as listing and editing items, listing customers, entering prices and discounts, collecting sales tax, etc.) are identical to those used on sales receipts, so they are either not presented here or presented in an abbreviated fashion.

The information entered on a customer order is transferred to the sales receipt when the order is filled, so none of it has to be re-entered. Refer to the sales chapters in Section V: Customers and Sales (page 301) for more information on these common sales procedures.

Creating a New Customer Order

To create a new customer order:

1. From the Point of Sale menu, select NEW <order type>.

2. In the Enter Item(s) field, list the items or service items being ordered by any of these methods:
   - Enter or scan the UPC, Alternate Lookup, or Item #, or enter an item search keyword.
   - From the I Want To menu, choose SELECT FROM ITEM LIST to locate and enter items from your inventory.
   - Select NEW SPECIAL ORDER ITEM if ordering a one-time item or service you do not currently carry. Refer to Listing Special Order Items on Documents (page 95) for more information.

3. Edit individual item information, such as quantity, price, tax code, and discounts, as necessary.

4. Enter a customer (required on all customer orders).

5. Enter any special instructions, the work to be performed, shipping information, or change the status of the order in the appropriate fields. Refer to the following sections and Customer Order Information Fields (page 665) for information about specific fields.
   - On work orders, you may also want to enter a due date and/or assign the job to an employee.

6. From the I Want To menu, select TAKE DEPOSIT/PAYMENT to take a deposit on the order.
If a minimum initial deposit is required or suggested, the Deposit window is automatically displayed if **SAVE** is selected before a deposit is taken. *Refer to Taking Deposits on Customer Orders* *(page 422)* for more information.

7. Select **SAVE**.

---

### Giving Discounts

You can apply item or global discounts on customer orders in the same manner in which they are used on sales receipts. You can also select a different price level to discount the entire order. *Refer to Receipt Price Levels and Discounts* *(page 358)* for more information.

### Using the “Pending” Order Status

Orders with a status of anything other than **PENDING** or **CLOSED** affect your available quantity calculations in inventory. If creating an order as an estimate or quote, and you do not want the order to affect your available quantity calculations, select **PENDING** as the order status.

---

### Working with Special Order Items

Typically, special order items are used for custom or one-of-a-kind merchandise with little chance of repeat sales, or to customize an existing item for a sale. There are two ways of using special order items on customer orders.

- **Create a new Special Order item** – With this option, a new special order item is created in inventory. You can list the item on the order, generate a purchase order, receive it on a voucher, and sell it on a receipt that references the order. Later, if you decide to carry the new item in inventory, you can convert it to a regular inventory item. Special order items can only be added while creating a document (customer order, receipt, voucher, or purchase order).

- Special order items can be created while making a customer order, as well as all from sales receipts, purchase orders, and receiving vouchers. Detailed procedures for using special order items are provided in *Listing Special Order Items on Documents* *(page 95)*.

(Pro Multi-Store) The New Special Order Item provides a means for a remote store to create a customer order for a new item and generate a PO for it. The special order item is sent to Headquarters when it is listed on a transactional document (voucher, receipt, memo, or transfer slip). Headquarters can review the item and change the special order item type into a regular inventory item, if needed. *Refer to Handling Special Order Items* *(page 549)* for more information.
Creating a New Customer Order

**Entering Shipping Information**

Shipping information and an estimate of the charges can be entered on a sales order or work order. Shipping information cannot be added to a layaway.

If not using Shipping Manager, follow the same procedure as on a sales receipt. However, you cannot enter the actual shipment information, such as the ship date and tracking number.

If using Shipping Manager, you can retrieve an estimate of the shipping charges from UPS and enter that estimate on the order. You cannot complete the shipment from the order; that is done when the sale receipt is made.

**To record a Shipping Manager estimate on an order:**

1. Add the items and customer to the order and then select **ESTIMATE SHIPPING CHARGES**.
2. On the Shipping window, select **ESTIMATE SHIPPING FOR UPS** and fill in any missing address and weight information. Required fields are indicated by an asterisk (*).
3. Select **GET ESTIMATE**.

Point of Sale connects to Shipping Manager and retrieves the estimate (Shipping Manager is not opened). To see how the shipping charges vary you can change any of the information (method, weight, address) and select **GET ESTIMATE** again.

4. Select **OK** to transfer the shipping information and estimate to the order.

If necessary, you can select **GO TO SHIPPING MANAGER** from this window to access other options, such as checking transit times, changing settings, or check for requirements on oversize packages.

Shipping information and the estimated charges are transferred to the sales receipt when the order is filled. Once on the receipt, you can edit or enter additional shipping information or charges as necessary, and if using Shipping Manager complete the shipment.
Taking Deposits on Customer Orders

A virtually unlimited number of deposits can be recorded for each customer order. Deposits are recorded on deposit receipts.

You can configure Point of Sale so that a minimum initial deposit is suggested or required on all new customer orders.

**Preferences: Initial Customer Order Deposits**

EDIT ➤ PREFERENCES ➤ COMPANY ➤ LAYAWAYS/SALES ORDERS/WORK ORDERS ➤ INITIAL DEPOSIT

The same options are available for all three types of customer orders and can be set independently. This preference applies only to the first deposit taken. Subsequent deposits can be for any amount.

**DO NOT REQUIRE OR SUGGEST AN INITIAL DEPOSIT:** If selected, no initial deposit is required or suggested when you create a new customer order.

**SUGGEST AN INITIAL DEPOSIT:** If selected, an initial deposit amount is suggested for each new order. Enter a percentage of the order total to be suggested. When you create a new order, the Take Deposit window opens with the suggested amount pre-filled. This suggested amount can be changed or deleted, at your discretion.

**REQUIRE AN INITIAL DEPOSIT:** If selected, an initial deposit is required for the order. Enter a percentage of the order total to be required. When you create a new order, the Take Deposit window opens with the required amount pre-filled. You can enter a larger amount, if you wish, but you cannot reduce or delete the required amount.

When taking deposits, keep in mind the following:

- You cannot take a deposit for an amount greater than the **Balance Due**.
- The items listed on an order are not deducted from inventory when you accept a deposit. They are deducted when you create the receipt on which they are eventually sold.
- Reversing a deposit receipt updates the **Deposit Balance** and **Balance Due** amounts, and is added to the Payment History/Deposits window for the associated order.

To take a deposit:

1. While creating the order (after listing items and customer) or with a saved order displayed, select **TAKE DEPOSIT/PAYMENT** from the I Want To menu.

The Take Deposit window is displayed. If this is the initial deposit and there is a suggested or required minimum deposit amount, it will be auto-filled.
2. Enter an amount or accept the suggested/required amount.
3. Select OK. The Deposit Payment window is opened.

Move or accept the amount for the payment method (cash, credit card, etc.) and then save/print the deposit receipt.

---

**Deposit Receipts Sent to QuickBooks Financial Software**

Although orders created in Point of Sale are not sent to QuickBooks financial software, deposit receipts and receipts applying deposit amounts as payment for the final sale are.

Refer to [Customer Order Deposits (Pro)](page 508) for details on how deposits are recorded in your financial software.

---

**Refunding Deposits**

When an order is canceled, by you or the customer, the deposit amount can be refunded. The entire amount on deposit is refunded; you cannot refund just a portion of the total deposited amount.

**To refund deposited amounts:**

1. Highlight or display the customer order.
2. From the I Want To menu, select **REFUND DEPOSIT**.

   The refund confirmation window is displayed.

3. Select **YES**. The Deposit Payment window is opened with the refund amount listed in the Change column.

4. Move or accept the amount for the change method (cash, credit card, etc.) you will use to refund the deposit and then save/print the refund receipt.

   The change window (if applicable) displays the refund amount and type.

5. You are asked if you would like to close the order. Select **YES** to change the status to closed or **NO** to leave it in the appropriate active order list.
Deposit/Payment History

The Deposits window displays all deposits and payments by deposit for a particular order. Included in the payment history for each deposit is the deposit amount, date, deposit receipt number, form of payment, and whether or not a deposit receipt has been reversed (REVERSED) or whether the receipt reversed a deposit (REVERSING).

You can take additional deposits or refund the amount on deposit directly from the Deposits window.

When you print customer orders, the deposit/payment history is included.

To display an order’s deposit/payment history:
1. Highlight or display the customer order.
2. From the I Want To menu, select PAYMENT HISTORY.
3. Select DEPOSIT/PAYMENT to take an additional deposit.
   Or
   Select REFUND to refund the amount currently on deposit.
4. Select CLOSE to close the Deposits window.

Generating Purchase Orders from Customer Orders

You can quickly create purchase orders from a customer order to obtain the items from your vendor(s). Point of Sale will propose a list of items to order (all items on the customer order except service or non-inventory items), but allow you to review and adjust the items and quantities before creating the PO. Multiple items from a vendor are combined into a single purchase order. If the order includes items from more than one vendor, a PO is created for each vendor.

The customer name and order number is displayed on the POs created, and also on the receiving vouchers that reference the POs.

To generate purchase orders from a customer order:
1. Complete and save the order document.
2. From the I Want To menu on the customer order, select GENERATE PO.
   Or
Creating a New Customer Order

From the Customer Order list, select one or more orders from which to generate purchase orders, and from the I Want To menu, select GENERATE PO.

3. The Select Items to Generate PO window is displayed, with all items from the customer order(s) listed.

4. Enter the quantity of each item to order from your vendor(s) in the Doc Qty column.
   - If you do not wish to order an item, enter 0 or leave the quantity blank.
   - To order all of the items in the quantity needed for the customer order (Qty Due column) choose SELECT ALL from the bottom of the window.

5. Select CONTINUE. The purchase order(s) will be automatically created.

6. Choose the desired action from the window and select OK.

The following apply to purchase orders generated from customer orders:

- You can generate multiple purchase orders from a single customer order. For subsequent purchase orders, the Qty Due values are reduced by sold quantities.
- Purchase orders generated from customer orders are numbered by combining an order type prefix, the order number, and a sequential suffix. For example, the first purchase order generated from Sales Order # 24 would be numbered SO241, the second SO242, etc. Purchase orders generated from layaways or work orders would begin with LAY or WO respectively.
- Select VIEW PO'S from a customer order I Want To menu to view the purchase orders generated from it. Your purchase order list, pre-filtered for the generated purchase orders, is displayed.

Use your normal procedure to communicate the generated purchase orders to your vendor(s).
E-mailing Orders to Your Customers

You can e-mail customer orders to your customers from within Point of Sale, in the same manner that you e-mail other documents.

To e-mail an order:

1. Create the order.
2. With the order displayed (or selected in your list), select E-MAIL from the window toolbar.
   The e-mail is created, with the document attached in the format selected in company preferences, and then displayed in your default e-mail client.
3. Review and edit the e-mail address, subject line, and message, as necessary, and then select SEND.

Refer to E-Mailing Documents (page 126) for additional information about setting e-mail preferences.

Filling Customer Orders

You fill a customer order by selling the items listed on it on a sales receipt. You can sell items listed on a customer order at any time. Selling items updates the order’s Ordered (qty), Due, and Sold fields for individual items and the entire order. When all the items on the order have been sold and its Deposit Balance and Balance Due are both zero, it is completely filled, and Point of Sale changes the status of the order to CLOSED.

The information recorded on the order, such as sales tax, discounts, shipping information, edited item information, and so forth, is transferred to the sales receipt. If you added shipping charges to the order and are only selling some of the order items, you are asked if you want to apply the shipping charges to the current receipt.

To sell the items listed on a customer order:

1. Highlight or display the customer order.
2. From the I Want To menu, select SELL ITEM(S).
Filling Customer Orders

The Select Items to Sell window is displayed.

3. Click **SELECT ALL** if you want to sell all the items on the order.

Or

Enter a quantity in the **Doc Qty** column for each item you want to sell.

4. Select **CONTINUE**. The items you selected are listed on a new sales receipt.

5. Add any additional items or enter other information on the receipt, as necessary.

6. Select **TAKE PAYMENT**.

   If deposits have been taken on the order, the total amount of the deposits is suggested as payment. If partially filling the order, you can reduce or clear the deposit amount used, if you wish. You might do this if you wish to maintain a deposit balance against the remaining items still due.

7. If there is a remaining balance due for the current sale, enter amounts for additional payment methods, then save/print the receipt.

Refer to **Entering Payment Types and Amounts (page 373)** for more information about taking payments.

---

Filling Customer Orders from the Reminders Page

When received items are listed on open customer orders, Point of Sale alerts you and adds the orders to the Fill Customer Orders reminders so that you know you can fill the order(s).

Refer to **Fill Customer Orders Reminder (Pro) (page 145)** for more complete information.
Maintaining Customer Orders

Locating a Customer Order

Customer orders are maintained in lists, one list for each type of order. Use normal filtering, searching, or sorting procedures to locate an order within your customer order lists. Orders that have been deleted do not appear on your order list(s).

Some suggestions specific to locating customer orders are given in this section. Refer to Data Entry Basics (page 86) for detailed instructions on these procedures.

Tips for Locating a Customer Order Quickly

When a customer is standing at your counter to make an additional deposit or to complete the sale of merchandise previously ordered, it is important that you be able to find the original customer order quickly.

Point of Sale offers several ways to do just that. The table below lists the common information fields included on a customer order that can be used for searching or filtering to help locate the order.

<table>
<thead>
<tr>
<th>Customer Order Field</th>
<th>Search</th>
<th>Filter</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Last Name</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Phone Number</td>
<td></td>
<td>X</td>
<td>Enter 7 or last 4 digits, no dashes</td>
</tr>
<tr>
<td>Order Date</td>
<td>X</td>
<td>X</td>
<td>Formats: mm/dd/yyyy or mm/yyyy</td>
</tr>
<tr>
<td>Associate</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Customer Order #</td>
<td>X</td>
<td>X</td>
<td>From customer copy, if available</td>
</tr>
<tr>
<td>Status</td>
<td></td>
<td>X</td>
<td>Can add custom statuses in company preferences</td>
</tr>
<tr>
<td>Serial #</td>
<td></td>
<td>X</td>
<td>Enter full string</td>
</tr>
</tbody>
</table>

The fastest way to locate the order may depend on what window you have displayed when the need arises. Use any of the methods outlined below.

If at the Navigator:

- Type a search keyword (see table above) in the Quick Find field
Maintaining Customer Orders

If in the customer order list:

- Click or touch on the Last Name column header and type the first few characters of the customer’s last name; you are taken to closest match
- Select FIND from the window toolbar, and enter a search keyword
- From the filter drop-down, select a predefined date range (today, yesterday, last week, etc.) or select CREATE FILTER and enter filter criteria (see table above)

If the customer record is displayed:

- Display the customer’s history and double-click the customer order to display it

From anywhere:

- From the Edit menu, select FIND RECORD ➤ <TYPE> ORDER and enter a search keyword

Editing Customer Orders

You can edit most of the information on an order at anytime, provided its status is not CLOSED (if necessary, you can change the status back to OPEN). The exception to this is that if deposits have been taken, you are not allowed to change the customer. If you need to change the customer after deposits have been taken, you will have to refund the deposits first.

To edit an order:

1. Locate the order in your order list.
2. From the window toolbar, select EDIT <order type>.
3. Make any necessary changes and take additional deposits as needed.
4. Select SAVE.

Copying a Customer Order

You can quickly create a new customer order by copying an existing one. This is useful if you have customers that often place very similar orders. Once copied, you can edit the new order as necessary. Deposits on the original document are not copied to the new document.

1. Select the appropriate order list from the Point of Sale menu.
2. Locate and highlight the customer order that you want to copy.
3. From the window toolbar, select COPY <order type>.
4. Make changes to the items, customer, and other fields as necessary.
5. Take a deposit, if required.
6. Select SAVE.

**Tracking Orders by Status**

The **Status** field on orders allows you to track orders, filter order lists, and create reports based on the current entry. By default, Point of Sale assigns two order status types: **OPEN** is initially assigned to all new orders created, and **CLOSED** is automatically assigned to orders that have been filled.

If it fits your needs, you can rename the descriptions of these two status types and define more of your own in company preferences. For example, maybe you have intermediary steps in the order process, such as out for repair, waiting for parts, or ready for pickup, that you would like to be able to track via the status field. An order’s status can be manually changed as an order is made and as it proceeds towards completion. Status entries can be defined for each order type independently.

As the status of an order is changed, Point of Sale records the date and the employee who made the change, so you have a running history of an order’s progression.

---

**Preferences: Define Status Field Entries**

EDIT ▶ PREFERENCES ▶ COMPANY ▶SALES ORDERS/LAYAWAYS/WORK ORDERS. To change the description of an existing status, click the existing description in the **Status Description** column and type a new description. Select ADD to define new status types and descriptions. You can also rearrange the order the possible choices appear in the **Status** field drop-down list on order forms, and remove status types no longer used.

---

**Using the “Pending” Order Status**

Orders with a status of anything other than **PENDING** or **CLOSED** affect your available quantity calculations in inventory. If creating an order as an estimate or quote, and you do not want the order to affect your available quantity calculations, select **PENDING** as the order status.

---

**To change the status of an order:**

1. Display the order form.
2. Select a new status from the drop-down list in the **Status** field.
3. Select SAVE.
Using Work Orders

To view the status history of an order:
1. Display the order in the form window.
2. Click the icon next to the Status field.

Deleting Customer Orders

After all the items on a customer order have been sold (Qty Due = 0) and closed, the document can be safely deleted. The sales receipt provides a permanent record of the transaction. Deleting a customer order removes it from corresponding customer order list and from the customer’s purchase history (although the sales receipts that filled the order remain).

You are not required to delete customer orders after they have been filled, but if there is little chance you’ll ever want to view or copy it in the future, you may want to delete it just to keep your order list compact. Once deleted, a customer order cannot be recovered.

To delete a customer order:
1. Highlight or display the customer order you want to delete.
2. From the I Want To menu, select DELETE.
   - If the customer order has a remaining deposit balance, you are prompted to refund it. Select OK to complete the payment screen to refund the entire deposit amount.

Using Work Orders

Whereas layaways and sales orders usually involve merchandise orders, work orders generally are for service-only jobs, such as equipment repairs, clothing alterations, warranty service, or even for scheduling appointments.

Items recorded on a work order are usually service items. Service items often comprise labor-related charges necessary to complete the job. Other regular inventory items necessary to the order, such as replacement parts, cleaning supplies, or incidentals can also be listed on work orders, but a work order generally does not include the actual item that is being serviced. Typically, that item has been sold previously on a sales receipt.

Work orders can be assigned to the employee who is to perform the service, a due date can be specified, and the completion status can be tracked and reported.
All of the general customer order procedures described earlier in this chapter apply to work orders. This section provides additional tips for the use of those procedures in a way that facilitates tracking of work orders.

Defining Service Items for Work Orders

Service items are defined in inventory and typically are for labor charges to complete the job. Use normal new item procedures to define service item in inventory, selecting the SERVICE item type.

Use the following guidelines in defining service items in inventory:

- To charge for labor by the hour, enter a description of the labor in the Item Name field and a price equal to what you charge per hour (or per job). If you charge by the hour, you can charge for partial hours by listing the labor item on a work order and entering a decimal quantity, e.g., 0.5, 2.75, etc. Point of Sale will calculate the correct labor charge as the work order price.
- Generally service items have no cost, but there may be exceptions, such as when you out-source the work and pay the third party a fee for the service. Make an entry in the item Cost field if this is the case.
- You may want to map custom Income, Cost of Goods Sold (COGS), and Asset accounts on the item form so the charges (when recorded on a receipt) are posted to your financial software in the manner you prefer.

Refer to Using Service and Non-Inventory Items (page 173) for more information on defining service items.

Defining an Item Discount for Warranty Service

If you do warranty work, you may have to list repair parts or labor at a reduced or zero price to the customer on the work order. Yet, you may want the actual time and items listed for purposes of tracking and billing to the manufacturer. One way to accomplish this is to define an additional item discount reason in company preferences called “Warranty.”

When you list items for warranty work on a work order, you can give a 100% discount and select warranty in the Discount Reason field. When you need a report of warranty work competed, run the report filtered by the discount reason “Warranty.”
Description of Problem or Instructions

The work order’s Description of problem or services field provides a very large amount of space for additional information to be recorded in support of warranty or insurance repairs. This information is included on printed work orders.

Assigning Work Orders

The Assigned field can be used to record the employee that will perform the service (as opposed to who took the order). Select a name from the drop-down list of defined employees. If an order involves multiple employees, each performing some aspect of the work, this field can be edited as the order progresses.

Using the Status Field to Track Work Orders

The Status field is particularly pertinent to the tracking of work orders.
Example: You use work orders to do alterations to clothing that you sell. Some of the alterations are done in-house while others are sent out to a third party. You could define and assign different statuses for the varying stages of a job:

**New.** Received but not yet assigned to an employee or outside service.

**Assigned.** To an in-house employee. We recommend you also use the *Assigned* field to indicate the specific employee.

**Out.** Sent out to a third-party for service.

**Back-ordered.** Awaiting parts or supplies needed to finish the job.

**Ready.** Alteration is complete and ready for customer pickup.

As a work order progresses, you can update the status field appropriately. Used in combination with the Assigned field, you now have the ability to filter your work order list by status or by assigned employee, and to generate reports filtered by these field values. Status tracking of customer orders works in the same way described in *Tracking Orders by Status* (page 430).

### Printed Work Order Message

Disclaimers, warranty information, or any custom message can be defined in company preferences and printed with every work order. A common use for this feature is to print a disclaimer for insurance purposes and or/limiting your responsibilities for additional work found necessary after beginning the service.

![Preferences: Printed Work Order Comments](image)
Customer Order Reports

Point of Sale offers several reports to help you track, order, and follow-up on the merchandise needed for planned sales. These reports are available from the Customer Order category on the Reports menu. Filtering by order status, date, assigned employee (work orders), or due quantities can help you track and manage these versatile documents. You can customize the filters and memorize reports as fits your needs.

Using the QuickZoom feature you can drill down into report detail or view the associated documents.

Refer to Chapter 26 Reports and Sales Charts (page 459) for more information about reports.

You can also view non-deleted customer orders made for a specific customer by accessing the customer's sales history. Refer to Chapter 18 Customer Records and History (page 303) for more information.

Printing Customer Orders

After completing an order, you can print a copy to give to the customer or keep for your own records. Printed orders include the payment history, instructions, quantities sold and remaining due, and any customer message you have defined in preferences.

To print an order:

1. Highlight or display the customer order that you want to print.
2. From the toolbar, select PRINT.
3. If presented with a print option window:
   - Change the printer you want to use, if necessary
   - Specify the number of copies you want to print
   - Select PRINT

Refer to Chapter 3 General Printing Information (page 39) for more information.

Preferences: Printed Customer Messages

PREFERENCES ➤ COMPANY ➤ LAYAWAY/SALES ORDER/WORK ORDER ➤ Printed Customer Message: Define an optional text message that is printed on customer orders. You may define a different message for each of the three order types.

Refer to Chapter 3 General Printing Information (page 39) for more information.
## Section VI: Reports and Reconciling

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 24</td>
<td>End of Day Procedures</td>
<td>439</td>
</tr>
<tr>
<td>Chapter 25</td>
<td>Cash Drawer (X/Z-Out) and Payment Reports</td>
<td>445</td>
</tr>
<tr>
<td>Chapter 26</td>
<td>Reports and Sales Charts</td>
<td>459</td>
</tr>
</tbody>
</table>
The day is over and the doors are locked; it’s time to tally up the sales, count the money, exchange information with QuickBooks financial software, and backup your data before you head home.

Four essential activities make up the End of Day procedure:

- Running your End of Day report(s)
- Sending the day’s credit and debit transaction batch for settlement
- Updating QuickBooks financial software with the day's transactions and other new information
- Backing up your Point of Sale company data file

When you initiate the End of Day procedure, these activities are carried out as you specify, prompting you for input as needed.

(Pro Multi-Store) You also have the option of including Store Exchange Out to send information to your other stores in the End of Day procedure. Refer to Chapter 33 Exchanging Store Information (page 561) for more information.

**Activity Tolerance**

In a multiple-workstation environment, only the workstation initiating End of Day can be actively working in Point of Sale while the procedure is running. If you attempt to run End of Day while other workstations are still actively working in Point of Sale, the program alerts you with a warning dialog.

This message could also result if any workstation running Point of Sale was improperly shut down. If you receive this warning, you should:

1. Make sure that all other users are out of Point of Sale. You can see which workstations are currently logged into the program by selecting **USER INFORMATION** from the Tools menu.
2. Select **CONTINUE**.

Point of Sale will continue with the current activity or, in the case of an improper shutdown, take the measures necessary to stabilize the system.
End of Day Procedures

Basic Steps to Run the End of Day Procedure

1. From the Point of Sale menu, select **END OF DAY**.
   The End of Day window is displayed.

2. Specify the individual procedures you want to include by selecting or clearing the appropriate checkboxes and choosing other options:
   * Run an End of Day report
   * Back up your company data
   * (Pro Multi-Store) Send data to remote stores (or to Headquarters if at a remote)
   * Settle Merchant Account (credit and debit card processing)
   * Exchange data with QuickBooks financial software

3. Select **OK**.
4. Enter additional information as prompted.
End of Day Reports

As part of your End of Day procedure, you may wish to run one of the “X/Z-Out” reports. X/Z-Out reports provide a summary of your workstations’ sales activities for the day, optionally reconcile the cash drawer, and provide information to help prepare the bank deposit for the day.

To run an End of Day report:

1. Select the specific type of End of Day report you wish to run.
   - Typically, this would be a Z-Out (“zero” out) Drawer Count report in a single workstation installation, or a Z-Out Store Close report in a multi-workstation installation (this would be done after each workstation had run a drawer count report).

2. Select the time period from the drop-down list. TODAY is suggested.
   - Select a different dynamic date range from the drop-down list or CUSTOM to specify a fixed date range.

3. To skip the report preview, select the PRINT IMMEDIATELY checkbox.

Refer to Chapter 25 Cash Drawer (X/Z-Out) and Payment Reports (page 445) for more information about running X/Z-Out reports.

Back up Your Company Data

You have the option here to create a backup during the End of Day procedure. Pro-level users can select to include item pictures in the backup (may significantly increase backup time and file size). See Backing Up Your Data (page 76) for more information on backup options and procedures.

Settling a Merchant Account

If you have an account with the QuickBooks POS Merchant Service, select the checkbox to SETTLE MERCHANT ACCOUNT. You should send each day’s Merchant Service batch to the processor as part of the End of Day procedure. Not sending transaction data to the processor within 24 hours of authorization will result in higher fees being charged.

The remainder of this process is automated. Point of Sale transmits the data on each authorized credit and debit card for settlement. Once the data has been transmitted, QuickBooks POS Merchant Service does the rest. The service routes the transaction to the bank that issued the credit card, secures the funds, and then transfers the money to your designated bank account.
End of Day Procedures

Your Merchant Service statement shows the total amount of each day’s transactions during that statement cycle and the fees that were charged.

Sending Credit Card Transactions Multiple Times a Day

Credit card transactions are usually sent for processing only once a day, during the End of Day procedure. However, you can send transactions to the processor whenever you want. To send credit card transactions to the processor without running the other End of Day functions, launch the End of Day normally but select only the **SEND MERCHANT SERVICE BATCH NOW** option (clear the other options), then select **OK**. Only transactions not already sent are included in each batch processing. **Important:** You must send your credit card transaction data to the processor within 24 hours of authorization to avoid paying higher fees.

Merchant Service Reconciliation in QuickBooks Financial Software 2008

If integrated with Version 2008 of QuickBooks financial software, your credit and debit card receipts are sent to QuickBooks with batch and store/merchant number information, so they show up on your Payments to Deposit window grouped accordingly. This helps to match these transactions with your bank deposits during reconciliation, and to identify account fees and other charges.

Merchant Service Reports

Reports about your credit and debit card transaction batches are available in the Payments area of the Report Center.

You can also sign up for and use the online Merchant Services Center to view your transactions, check on funding status, and complete basic account management tasks. Transactions show up in the center one day after processing. From the Report menu, select **Merchant Service Center** (Internet connection required).

*For more information on payment reports, refer to Payment Reports (page 456).*

Financial Exchange with QuickBooks

If integrated, information from Point of Sale can be exchanged with QuickBooks financial software, where it can be used for accounting and financial record-keeping. In addition, certain types of information that have been added in your financial software are sent to Point of Sale.

Retailers that use this exchange capability, known as Financial Exchange, have the option of conducting an exchange of information as part of the End of Day process. Only information that has been added since the last exchange will be transferred. A progress dialog confirms successful exchange or, in the event of an error, will identify where the error occurred and provide a link to the Activity Log (see below) to help you troubleshoot the issue.
Refer to Section VII: QuickBooks Integration (page 477) for more information about Financial Exchange, including how to customize the way in which data is sent.

**Integrated Applications Preference in QuickBooks:**

QuickBooks financial software and your financial company file must be open during this procedure unless you have set your Integrated Applications preferences in QuickBooks to allow Point of Sale to automatically log in. Refer to Connecting When QuickBooks Financial Software is not Running (page 486) for more information about allowing automatic login to your financial software.

**Error Handling**

If you receive an error message during the Financial Exchange process, refer to the Activity Log for further information about the error. It could be that a specific record or document (customer record, vendor record, receipt, voucher, etc.) is causing the error. If this is the case, you might attempt to correct the error by editing or altering the record, and then running Financial Exchange again. Refer to Resolving Exchange Errors (page 494) for more information.

**Sending Store Exchange Files**

Sending Store Exchange files as part of the End of Day procedure is optional. In a multi-store environment, you will be able to select this option to a compressed file, called a mailbag, containing the information being sent.

Refer to Chapter 33 Exchanging Store Information (page 561) for more information on this process.
Chapter 25  Cash Drawer (X/Z-Out) and Payment Reports

Cash Drawer Reports Overview .................................................. 446
Running Cash Drawer Reports .................................................. 447
  Basic Steps ............................................................................ 447
  Define Report Options and Filter Criteria ............................... 448
  How Point of Sale Actions are Handled on Cash Drawer Reports (X/Z-Outs) ........................................ 449
Closing Reports (Z-Outs) ............................................................. 450
  Closing Report Recommendations ........................................... 453
  Media Counts and Cash Drawer Reconciliation ....................... 453
  Viewing Drawer Count History ............................................... 456
Payment Reports ........................................................................ 456
  Payment Reconciliation Reports .............................................. 456
  Merchant Service Reports ....................................................... 457
    Merchant Service Center ...................................................... 458
  Gift Card Service Reports ...................................................... 458
Cash Drawer Reports Overview

The Report Center offers two types of reports under the Cash Drawer category that can provide an up-to-the minute accounting of point of sale activities for the current sales period. These are called status reports and closing reports (X-Out and Z-Outs).

**Status reports (X-Out).** Can be run at any time for a quick check on sales activity or to obtain a non-currency media listing up to the time the report is run. The status report can also be used to report sales activity at the end of a shift without doing media counts.

**Closing reports (Z-Out “zero” out).** Are run when closing out a cash drawer at the end of a shift or the end of the day, and to close out the entire store for the day.

- The Drawer Count report is run at the end of a cashier’s shift or whenever you want to conduct a manual media count.
- The Store Close report is usually run at the end of each day as part of the End of Day procedure, after the Drawer Count report(s) has been run at each workstation.

All of these reports:

- Include all sales activity for the specified period
- Include net sales, cash flow, and breakouts for discounts

In addition, a closing report can:

- Report the day’s cash flow, including overages and shortages, and cash drawer reconciliation
Running Cash Drawer Reports

- Assist in recording manual counts of currency
- Simplify bank deposit preparation by calculating a deposit amount and printing the list of deposit items

Report Terminology

**Breakouts:** Listings of the total amount paid in, the amount paid out, and the net amount for each discount reason. These listings are included in all status and closing reports.

**Media:** A general term for currency and non-currency items used as payment.

**Currency:** Bills and coins used as payment.

**Non-Currency Media:** Media other than currency used as payment. Non-currency media are payment documents such as checks, credit card and ATM/debit receipts, store credits, gift certificates, and so on.

**Paid Out and Pay-Outs:** The term “paid out” refers to payment given to the customer for any reason, such as refunding on a returned item. However, in the list of non-currency media contained at the end of status and closing reports, there is a list of Pay-Outs, meaning cash removed from the cash drawer using the Pay-Out feature as described in Paying Money Out of the Cash Drawer (Pay-outs) (page 336). The two terms, though similar, are distinct.

Preferences: Printing

**PREFERENCES ➤ WORKSTATION ➤ DOCUMENTS & PRINTERS/PRINT OPTIONS ➤ X/Z-Out:** Designate the default printing options for these reports: printer, template, number of copies, or to display the Print Option dialog at time of printing.

Running Cash Drawer Reports

**Basic Steps**

These basic steps assume you are running the cash drawer reports from the Report Center. *For steps to run these reports from the End of Day window, refer to [End of Day Procedures](#) (page 441).

**To run a status (X-Out) or closing (Z-Out) report:**

1. Select **CASH DRAWER** as the report type.
2. Choose **X-OUT STATUS REPORT, Z-OUT DRAWER COUNT, or Z-OUT STORE CLOSE.**
3. Define a date/time range for the report.
The report will only include information from receipts in the specified range. You can either enter a fixed range, spanning from one specific date/time to another, or select from a list of predefined dynamic ranges such as today, month-to-date, year-to-date, last year for this same year-to-date, etc.

4. Select MODIFY REPORT (<ALT+M>) to customize report options and define filter criteria. Refer to Modifying Report Options (page 466).

5. Select MEMORIZE to save the report options, if needed.

6. Select how you want to output the report:
   - Select PRINT (<ALT+T>) to print the report
   - Select DISPLAY (<ALT+S>) to preview the report
   - Select EXCEL (<ALT+X>) to send the report to Excel as a spreadsheet

If you are running a Drawer Count report and requiring them, perform manual media counts as described in Media Counts and Cash Drawer Reconciliation (page 453).

**Define Report Options and Filter Criteria**

The report options and filter criteria allow the definition of any combination of workstations, cashiers, and date/time range for the report. Not all reports have all of the options.

To define report options and filter criteria:

1. Select MODIFY REPORT (<ALT+M>).
2. On the Display tab, select a date/time range for the report. (This may also be defined on the main screen of the Reports window and the Filters tab.)
3. On the Filters tab, enter filter criteria.

| Date | The date entered previously is displayed. You can revise it here and select to include/exclude data from the specified date range. |
| Store | (Pro Multi-Store) Select  (<F4>) to access and select from the list of stores. If left blank, all stores are included. |
| Workstation | Select  (<F4>) to access and select from the list of workstations. If left blank, all workstations are included. |
| Cashier | Enter an individual employee’s name or all employees. If left blank, all associates are included. |

While editing filter criteria, you can select REVERT to erase your changes and revert to default options.

4. Make changes to the header/footer and security (access level) settings, if needed as described earlier in this chapter.
Running Cash Drawer Reports

5. Select **OK** to display the report.
6. If you want to save your report options, select **MEMORIZE REPORT** from the Report window. Enter a report name and select **OK**.

**How Point of Sale Actions are Handled on Cash Drawer Reports (X/Z-Outs)**

**Sales and Returns**

- Sales recorded on sales receipts are reported in the **Gross Sales** column in the first section of the report.
- Payments to customer accounts are reported in the **Gross Sales** column in the first section of the report.
- Amounts recorded on return receipts are shown in the **Gross Returns** column.
- Refunds for returned merchandise are recorded as paid-out amounts for the type of payment used.

**Accepting More than One Payment Type**

- When the customer pays for a transaction using more than one payment type, amounts are credited to the individual payment types. If a sale were paid for with $50 cash and $75 on a credit card, the report would show a $50 cash paid-in amount and a $75 credit card paid-in amount.

**Discounts**

- The sales figures in the first section of the report are calculated from the receipt totals after any discount. Discount dollars or types are not identified there.
- The discount breakout section reports all discounts identified by type.
- User-defined discount reasons from preference settings are used to identify item discounts given at point of sale.
- **GLOBAL** is assigned if you discounted the receipt total.

**Gift Cards and Gift Certificates**

- Purchase of a gift card/certificate is reported in the **Sales** column in the first section of the report.
• Redemption of a gift card/certificate: The receipt total is shown as amounts paid in by Gift and any other payment types used. The cash flow is adjusted for the gift amount.

Non-Currency Media

• Cash drawer reports include itemized listings of the individual amounts paid for by non-currency media, such as by check, credit card, ATM/debit, or gift card/certificate

Refer to the sample Store Close (Z-Out) report in the next section to see how transactions are reported.

Closing Reports (Z-Outs)

Closing reports contain all the information included in a status report, with additional information.

Drawer Count: A Drawer Count report is typically run at the end of a shift or end of the day. Drawer count reports summarize the sales activity over the course of the period, and can be filtered by associate, workstation, and date/time range (if using Pro Multi-Store, you may also filter by store). In addition, manual media counts can be recorded on the Drawer Count report. For maximum accountability, it is recommended that you require your associates to conduct manual media counts when running the drawer count report.

Preferences: Requiring Manual Media Counts

Preferences ➤ Company ➤ Sales ➤ Require a manual media count for X/Z Out: ☑
Select to require a manual media count on Drawer Count reports. When this preference is selected, Drawer Count reports cannot be printed until a manual media count is entered.

Store Close: The Store Close report is typically run at the end of the day when closing the store. It is particularly well suited for retailers with multiple workstations, where each workstation runs their own Drawer Count report and then a Store Close Report is run to include activity from all workstations. Unlike the Drawer Count report, manual media counts are not available for the Store Close report.

The following shows a sample Store Close report (Z-Out):
## Z-Out Store Close

**Date:** 2/27/2006 12:00:00 AM to 2/27/2006 12:00:00 PM

### Sales Activity

<table>
<thead>
<tr>
<th>Gross Sales</th>
<th>Gross Returns</th>
<th>NET</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Taxable Sales:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3,139.83</td>
<td>11.99</td>
<td>3,127.84</td>
</tr>
<tr>
<td><strong>Tax:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>243.34</td>
<td>0.93</td>
<td>242.41</td>
</tr>
<tr>
<td><strong>Subtotal:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3,383.17</td>
<td>12.92</td>
<td>3,370.25</td>
</tr>
</tbody>
</table>

- **Deposits:** 77.80
- **Gift Cards:** 0.00
- **Gift Cert.:** 0.00
- **Shipping:** 0.00
- **Payments:** 50.00
- **Tips:** 31.00

**Total Activity:** 3,541.97

**Net Sales activity:** 3,409.25

**Charged to account:** (1,047.50)

**Gift certificate used:** (50.00)

**Gift cards used:** (175.59)

**Net Deposit Used:** 0.00

**Pay-Outs:** 33.45

**Total available for deposit:** 2,102.71

### Discounts Given on Sales, Returned Discounted Items and Net Discounts

<table>
<thead>
<tr>
<th>SALES</th>
<th>RETURNS</th>
<th>NET</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Global :</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14.44</td>
<td>0.00</td>
<td>14.44</td>
</tr>
<tr>
<td><strong>Unknown :</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.05</td>
<td>0.00</td>
<td>1.05</td>
</tr>
<tr>
<td><strong>Total :</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15.49</td>
<td>0.00</td>
<td>15.49</td>
</tr>
</tbody>
</table>

### Receipt Counts

<table>
<thead>
<tr>
<th><strong>Sales :</strong></th>
<th><strong>Returns :</strong></th>
<th><strong>Deposits :</strong></th>
<th><strong>Reversed :</strong></th>
<th><strong>Pay-Outs :</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Dollars</strong></th>
<th><strong>Paid In :</strong></th>
<th><strong>Paid Out :</strong></th>
<th><strong>Net :</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1,345.61</td>
<td>166.17</td>
<td>1,179.44</td>
</tr>
</tbody>
</table>

---

Gross sales less returns, equals net sales

Transactions that do not affect your bank deposit are subtracted, such as a payment using a gift certificate.

Available for deposit
### Check
- **Paid In:** 200.71
- **Paid Out:** 0.00
- **Net:** 200.71

### All Credit/Debit Cards
- **Paid In:** 722.54
- **Paid Out:** 0.00
- **Net:** 722.54

### Debit
- **Paid In:** 208.77
- **Paid Out:** 0.00
- **Net:** 208.77

### Visa
- **Paid In:** 513.77
- **Paid Out:** 0.00
- **Net:** 513.77

### Gift Card
- **Paid In:** 175.59
- **Paid Out:** 0.00
- **Net:** 175.59

### Account
- **Paid In:** 1,047.50
- **Paid Out:** 50.00
- **Net:** 997.50

### Gift Certificate
- **Paid In:** 50.00
- **Paid Out:** 0.00
- **Net:** 50.00

### Pay-outs
- 33.45 joe pizza for crew
- 33.45 Total Pay-outs - 1

### Tips
- 11.00 Bob
- 20.00 Joe
- 31.00 Total tips

### Check Listing
- 96.95 123 Sonya
- 50.00 2135
- 32.27 987 Birch, F.
- 21.49 327 Cross, Jo
- 146.95 Total Checks - 4

### Credit Card Listing
- 166.59 Visa xxxxxxxx1010
- 311.18 Visa xxxxxxxx5432
- 36.00 Visa xxxxxxxx6768
- 513.77 Total Credit Card - 3

### Account Listing
- 466.77 Baeck, Aline
- 155.59 Aldoukhov, S.
- 311.18 Leacox, Lena.
- (50.00) Bocharev, E.
Closing Report Recommendations

Following are some general suggestions for determining which closing report to use and when. Use the report types and frequency that best meets the needs of your business and policies.

If you have a single workstation:

- For maximum control, do a Drawer Count at the end of each shift and as part of your End of Day procedure, requiring manual media counts. With a single workstation, it isn’t necessary to run a separate Store Close report.

If you have multiple workstations:

- For maximum control, do a Drawer Count report at each workstation at the end of each shift, including the shift that ends the day, and requiring a manual media count. Filter by workstation number, time period, and cashier, as appropriate at each workstation.

- After the individual workstations have completed their final drawer count for the day, run a Store Close report as part of the End of Day procedure, filtered to include the activity from all workstations/cashiers for the entire day.

Media Counts and Cash Drawer Reconciliation

When you run a Drawer Count report, the Media Totals window is displayed. The Media Totals window lists several currency fields. The total amount of non-currency
media accepted during the time period for the report is also displayed. This amount cannot be edited. The entries for currency are completed as follows:

1. Enter the amount of currency that was in the drawer at the beginning of the period in the **Begin** field. (By default, Point of Sale suggests the amount that was entered in the **Leave** field the last time a Z-Out Drawer Count report was run for this workstation.)

2. If you are performing a manual media count: Select the `<F4>` button in the **Count** field to open the Media Count window. Enter the drawer count for each currency listed and select **OK**. The total of each counted media type is automatically carried from the Media Count window to the Media Totals window.

3. In the **Leave** field, enter the amount of currency that is to be left in the drawer to begin the next period/day. (By default, Point of Sale suggests the amount that was entered in the **Leave** field the last time a Drawer Count report was run for this workstation.)

   The **Deposit** field is calculated by Point of Sale based on your entries and can only be edited by revising the media counts, or entering new Begin or Leave amounts.

4. Select **OK**.

   If discrepancies exist between what was counted and what the program has recorded as paid, a discrepancy notice is displayed.
Running Cash Drawer Reports

The media type where the discrepancy exists is displayed, i.e. Dollars in the example shown above.

At this point, you can select **YES** to continue running the report without addressing the problem, or select **NO** to return to the Media Totals and Media Count windows to attempt to correct the discrepancy.

If the problem can’t be resolved, enter comments explain discrepancies in the Remarks field of the Media Totals window. Remarks are printed at the end of the Drawer Count report.

Once you choose to continue, there is one last opportunity to review or make changes before proceeding with the reconciliation.

5. Answer **YES** to create the Drawer Count report.

**Sample Drawer Count Report**

On Drawer Count reports, Point of Sale calculates the amount of currency that should be in the drawer (Net) and compares that with the currency count to determine the amount over or short. Point of Sale also calculates the cash amount for a deposit.

\[
\text{Net} = \text{Begin} + \text{Paid In} - \text{Paid Out}
\]

\[
\text{Short/Over Balance} = \text{Net} - \text{Count}
\]

\[
\text{Deposit} = \text{Count} - \text{Leave}
\]

<table>
<thead>
<tr>
<th>DOLLARS</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Paid In</td>
<td>437.15</td>
</tr>
<tr>
<td>Paid Out</td>
<td>20.36</td>
</tr>
<tr>
<td>Begin</td>
<td>150.00</td>
</tr>
<tr>
<td>Net</td>
<td>556.79</td>
</tr>
<tr>
<td>Count</td>
<td>556.89</td>
</tr>
<tr>
<td>Short</td>
<td>0.10</td>
</tr>
<tr>
<td>Leave</td>
<td>150.00</td>
</tr>
<tr>
<td>Deposit</td>
<td>416.89</td>
</tr>
</tbody>
</table>

In addition, Point of Sale displays a list of the entered media counts.
Viewing Drawer Count History

Drawer Count reports are stored by Point of Sale, and can be accessed at anytime by selecting VIEW DRAWER COUNT HISTORY from the Reports menu.

You can preview, print, or export the reports.

(Pro Multi-Store) At Headquarters, selecting VIEW DRAWER COUNT HISTORY displays the list of Drawer Count reports from all stores.

Payment Reports

Payment Reconciliation Reports

Payment reconciliation reports can provide listings of non-cash transactions to help you reconcile against your bank deposits. The Payment Summary report includes all such transactions, broken down by payment type. Or you can choose to run reports specific to any one payment type. These reports include all EFT transactions (credit, debit, and gift card), regardless of whether you process them through the QuickBooks POS Merchant or Gift Card Services, as well as payments by check, account charge, and gift certificates.

Users of the QuickBooks POS Merchant or Gift Card Services have additional reports available specifically for those services (see below).

To access payment reconciliation reports:

1. From the report menu or Report Center, select PAYMENTS as the report category and then PAYMENT RECONCILIATION as the report type.
2. Select from the available reconciliation reports.
   The report is immediately displayed, using your last run settings.
3. Modify the report as necessary, such as the date range, report appearance, or filtering to include/exclude data.
If you prefer to modify reports before displaying them, select the checkbox for modifying options before running on the All Reports page in the Report Center. This setting affects reports ran from the Reports menu as well.

Refer to Modifying Report Options (page 466) for more information about modifying reports.

**Merchant Service Reports**

Users of the QuickBooks POS Merchant Service can run reports summarizing or detailing your credit and debit card batches, subtotaled by batch number and/or merchant number. You can also create an account at the online Merchant Service Center to check on account activation, view transaction or funding status, and perform basic account maintenance tasks.

**To run credit and debit card batch reports:**

1. From the Reports menu or the Report Center, select **PAYMENT** as the report category and then **CREDIT AND DEBIT BATCH REPORTS** as the type.
2. Choose a specific report:
   - **Unsettled Summary**: Provides the card type and amount for unsettled transactions, for the specified date range
   - **Unsettled Details**: Provides the details on all unsettled transaction for the specified date range
   - **Activity Summary**: Provides a summary for all transaction, both settled and unsettled, for the specified date range
   - **Activity Details**: Provides the details for all transaction, both settled and unsettled, for the specified date range
3. Sort the report as needed by selecting the column header of the information by which you wish to sort. The possible transaction types are listed below.
4. Select **DISPLAY, PRINT, or EXCEL**, depending on your output needs.

<table>
<thead>
<tr>
<th>Type</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sale</td>
<td>A sale occurs when a credit card is used as payment on a sales receipt.</td>
</tr>
<tr>
<td>Refund</td>
<td>A credit refund occurs when the credit card is used on a return receipt or if the receipt listing the credit card transaction is reversed.</td>
</tr>
<tr>
<td>Voided</td>
<td>Voids occur when payment is cancelled after authorization is received but before the receipt is updated. This occurs at the Payment Screen when the user selects to delete the payment (using the DELETE button) or selects CLEAR PAYMENTS.</td>
</tr>
</tbody>
</table>
Merchant Service Center

To visit the Merchant Service Center:

1. From the Report menu, select MERCHANT SERVICE CENTER. The Merchant Service Center Sign In page is opened in a Web browser window.

2. On first visit, select CREATE AN ACCOUNT, and follow the on-screen instructions to set up your access account. If returning, sign in with your user name and password.

Transactions are available to view in the Merchant Service Center approximately one day after settlement in Point of Sale. Outside of Point of Sale, visit the Merchant Service Center by going to https://merchantcenter.intuit.com/posms.

For more information, refer to the documentation provided by the Point of Sale Merchant Service.

Gift Card Service Reports

There are two additional reports for users of the QuickBooks POS Gift Card Service.

Gift Card Balance Summary. A list of all outstanding gift cards and their current balances.

Gift Card Activity Detail. Details of gift card activity in a specified date range.

To run a gift card report:

1. From the Reports menu or the Report Center, select PAYMENTS ➤ GIFT CARD SERVICE and then either BALANCE SUMMARY or ACTIVITY DETAIL.

2. The selected report is generated and displayed. Use the report MODIFY option if you want to apply report filters or change the appearance of the report. For example, you could filter the balance report to include only cards with a balance over $100 or change the date range to apply to the activity detail report.

Multi-Store: Reports

Reports reflect transactions recorded in Point of Sale. If the report is run at a remote store, it will only include transactions for that store. If a report is run at Headquarters, it will include transactions from all stores as of the last Store Exchange. For the most accurate method of determining the balance of an individual gift card, use the procedure described on the previous page.
Chapter 26  Reports and Sales Charts

Using Reports to Track Your Business ............................................. 460
  Overview ............................................................................. 460
Report Categories ................................................................. 460
Report Access Levels ............................................................ 461
The Report Center ................................................................. 462
  Running a Report ................................................................. 463
    Create a Report Wizard ....................................................... 463
    Running a Report .............................................................. 463
Modifying Report Options ....................................................... 466
Memorizing a Report .............................................................. 468
Manage My Reports ................................................................. 469
Running Multiple Reports ....................................................... 470
Sales Charts and Graphs .......................................................... 471
  Overview ............................................................................. 471
Viewing Charts and Graphs ...................................................... 473
Printing a Chart or Graph ....................................................... 473
Using the Reports Dashboard ................................................... 475
Using Reports to Track Your Business

Overview

Point of Sale reports offer a way to tap into your accumulated data, providing detailed information to help you manage inventory, analyze your sales, reconcile the cash drawer, target customer mailings, evaluate employee performance, make informed purchase decisions, and much more.

Each report category, such as sales reports or purchasing reports, has a variety of ready-to-use reports included. Filters and report options allow you to include or exclude data, change the date range, to customize how it will look.

Once defined, your custom report format can be memorized and easily accessed at any time. Memorized reports can be a valuable aid while creating a purchase order, in identifying items for sales, or viewing employee commission calculations.

Access to reports can be controlled with security rights, protecting your sensitive data.

Report Categories

There are many report categories in Point of Sale. Each category includes various report types and then the specific reports, offering several ways to analyze your data. The information for each report is drawn from the related data sources (documents, inventory, customer records, etc.). For example, sales information is derived from receipts; item information from inventory and transactional documents, and purchasing information is drawn from purchase orders and receiving vouchers. The main report categories are as follows:

**Sales.** View summarized or detailed sales information, such as best and worst selling items, sales by department, vendor, associate, or store, discounts given, and sales taxes collected. A selection of sales charts and graphs are also available.

**Cash Drawer.** Run status (X-Out), drawer count and store close reports (Z-Outs), as well as a listing of cash drawer payouts.

*Note: Cash Drawer and Payment Reports are discussed in Chapter 25 Cash Drawer (X/Z-Out) and Payment Reports (page 445).*
Payments. View lists of all non-cash payment transactions by type to help reconcile with your bank deposits. Users of the QuickBooks POS Merchant or Gift Card Services also can view summarized or detailed credit and debit settlement batch information and gift card activity and balances.

Customers. Print exportable customer lists and analyze sales by demographics or promotional codes. Pro-level users can also run summarized or detailed reports of merchandise and deposits on customer orders, the status of service jobs, and membership lists and reward history for your Customer Rewards program.

Items. Track inventory item, quantities, and costs, including merchandise on hand or on order, reorder points, adjustments, and, in a multi-store configuration, transfers and inventory by store.

Purchasing. View summarized or detailed listings of merchandise ordered and received, projected cash requirements, and vendor lists.

Employees. View employee lists, sales performance, and, for Pro-level users, hours worked and commissions earned.

Financial Exchange. View reports on the information exchanged with your financial software.

Memorized Reports. View and access all reports you have created and memorized.

Report Access Levels

If you are using security to control access to Point of Sale, the reports a user can run or view are determined by the security group to which he/she belongs.

Each report is pre-assigned to an access level: 1, 2, 3, or 4, with 1 being the highest level and 4 being the lowest. You can change the access level for individual reports on the Modify Report window to meet your needs, as described later.

Users will have access to reports that are assigned the same security level or lower than their own. A user that belongs to a group with the rights to run Level 1 reports will be able to run or view all reports. A user with rights to run Level 2 reports will be able to run or view Level 2, 3 and 4 reports, and so on for the other levels. Users assigned to the Associate group, for example, have access only to Level 4 reports.

Reports that the currently logged-on user does not have access rights to will not be available for selection. If security is not being used, all users have access to all reports. Refer to Chapter 5 Data and Program Security (page 65) for more information about setting up employee security rights.
The Report Center

The Report Center allows you to choose and modify the specific report you need, use the Create a Report wizard to create a customized report, and to manage your previously saved reports.

The Overview page of the Report Center, pictured above, provides one-click access to the most common reports, your list of memorized reports, and the Create a Report wizard.

The All Reports page lists all available reports and helps you choose the correct report for your needs by categorizing and sub-categorizing them. The collapsed/expanded state of the reports area is saved upon exit and this view will be restored next time you enter the Report Center.
Running a Report

Create a Report Wizard

This wizard that walks you through creating a report of any kind. We suggest you use the wizard while getting started with Point of Sale as it helps build a report in a logical sequence. Later, when you are more familiar with the options available and process of modifying your reports, you may want to run reports directly from the All Reports page as described below.

Running a Report

To run a report:
1. From the Reports menu, select REPORT CENTER.
   Or
Select a report directly from the Reports menu or sub-menus, bypassing Steps 2 - 4 below.

2. Select a report from the Overview page or, for more options, switch to the ALL REPORTS page.

If using the Overview page:
   - Make modifications in the Run a Report wizard as needed and then choose RUN. Select HELP on any screen for assistance.

If using the All Reports page:
   a. Select a category of report from the tabs on the left side of the window.
   b. Expand the appropriate sub-category to display the report you would like to run. Place your mouse pointer over a report icon to preview the report.
   c. Select the report name or DISPLAY to run and view the report, using the same settings as you last used.

The report is displayed and several options are available to you.

Select MODIFY to change report options or filtering

Change report date range and select APPLY DATE RANGES

Search the report by typing a text string and selecting the magnifying glass icon

Rearrange column order and widths by dragging labels and separators

When displayed, double-click an entry with the QuickZoom pointer to display additional detail or view related document or record

Select an option to print or send the report to Excel
3. If necessary, modify the report to meet your needs:
   • Change the date/time range at the top of the report and **APPLY DATE RANGE**. Your options will vary by report type. Refer to Filtering by Dates & Times (page 115).
   • Select **MODIFY** to filter the data included or customize the appearance of the report. Refer to Modifying Report Options (page 466) and Filtering Report Data (page 108).

4. At the bottom of the window, choose how you want to output the report:
   • Select **PRINT** to send the report to your printer.
   • Select **EXCEL** to send the report data to Excel. Note: Excel must be installed on the computer running the report. Point of Sale passes the data to Excel, where it can be saved as an Excel file.

If you frequently run the same reports together, you can run them all at once from a single selection window. Refer to Running Multiple Reports (page 470) for details.

---

**Finding Specific Information**

Point of Sale reports include a **Find** field to search the report for specific text. Enter your text and select the magnifying glass to locate the next occurrence.

**Viewing Report Details**

When the QuickZoom icon is displayed, you can “drill down” to see more detail or documents by double-clicking an entry line. For example, if you are viewing the Customer Sales report, double-click a customer name to see a listing of all items sold to that customer. Double-click an item line on the second report and all sales for the item are displayed.

You can also rearrange column order and widths in reports to view the information in the manner you prefer. Simply drag-and-drop the column labels (names) and separators as needed.

**Printing Large Reports**

If a report is too wide to be printed within the page width specified for the printer, Point of Sale will print it in sections on multiple pages, which can then be arranged to form the complete report.

**Exporting Very Large Reports**

Excel has a display limit of approximately 65,000 rows. If a report exceeds this limit, it will be truncated to fit the display capacity. You can rerun the report, filtering to reduce the size, to ensure the entire report is displayed if this occurs.
Modifying Report Options

Report options are user-definable instructions that specify the data to be included in the report, the date range, what the report will look like, and the access level for security purposes. The specific options available vary by report type.

Tip: Prompt to Modify Report Before Running

When you run a report from the Reports menu or from the All Reports page of the Report Center, by default it immediately runs and is displayed according to the last settings you used. If you prefer to always have the chance to make modifications before running and displaying the report, select the PROMPT TO MODIFY REPORT OPTIONS BEFORE RUNNING A REPORT checkbox at the bottom of the All Reports page.

To modify report options:

1. While viewing a report, select the MODIFY button.
2. The Modify a Report dialog is opened.

3. Enter a new data range and/or select an action button to change report options. The table at the end of this procedure explains some of the common report options.
   - Add or Remove Columns to add, remove, or rearrange the order of the report columns and set sort order.
• **Filter Data** to define report filter options. Use this page to include/exclude data based on criteria you specify. Filtering options vary by report type. *Refer to Filtering Report Data (page 108)* for specific instructions.

• **Change Report Appearance** to modify the way the page is formatted, such as fonts, the report title, headers and orientation.

• **Set Report Access Level** to change the report security level for this report. *Refer to Report Access Levels (page 461)* for more information about security.

4. Select **RUN** to display the report with your changes.

<table>
<thead>
<tr>
<th><strong>Report Date Range</strong></th>
<th>If necessary, select a date/time range for the report. Date/time ranges are only definable for certain reports. Dates can also be defined directly on the report window. <em>Refer to Filtering by Dates &amp; Times (page 115).</em></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Report Orientation</strong></td>
<td>Select <strong>PORTRAIT</strong> or <strong>LANDSCAPE</strong>.</td>
</tr>
<tr>
<td><strong>Columns</strong></td>
<td>Select the data columns to include in the report. A check mark indicates the selected columns.</td>
</tr>
<tr>
<td></td>
<td>On the report, columns are displayed in the order (from left to right) in which they appear in report options (from top to bottom). Drag and drop the column names to place in the order you want.</td>
</tr>
<tr>
<td></td>
<td>On some reports, certain columns are required and cannot be removed. A lock icon next to the column name indicates a required column.</td>
</tr>
<tr>
<td></td>
<td>Report column order and width can also be rearranged directly on the displayed report in the same manner as columns in lists. <em>Refer to Customizing Columns in Lists (page 586)</em> for more detailed information.</td>
</tr>
<tr>
<td><strong>Sort By</strong></td>
<td>This determines how information is grouped on the report. For example, a sort by department generates a report where information for each department is grouped together. A sort by vendor generates a report where information for each vendor is grouped together. The values available to sort by vary for each individual report and depend on the columns included in the report. The column for the sort value must be included in the report in order to sort by it. Optionally, select to subtotal report values each time the selected sort group changes.</td>
</tr>
<tr>
<td><strong>Sort In</strong></td>
<td>Select to sort in <strong>ASCENDING ORDER (A-Z, 1-10)</strong> or <strong>DESCENDING ORDER (Z-A, 10-1)</strong>.</td>
</tr>
</tbody>
</table>
Chapter 26: Reports and Sales Charts

Memorizing a Report

Memorizing a report saves the report format and other options, not necessarily the data that comprises the report when first ran. For example, if you specify a dynamic date range (e.g. today, this week-to-date), the data included when you run the report tomorrow may be different than what is included today. Even with fixed dates, the data included may vary if you have taken any actions that affect that data, such as reversing an earlier transaction, filling an open order, deleting a customer, etc.

Memorized reports are added to the Reports menu and to the Memorized Reports section of the Navigator, so that you can instantly run the report again when needed.

Upgraders and Memorized Reports

When a new version of Point of Sale is released, there may be changes to the fields and options available on the default reports. If you have modified and memorized these reports, the upgrade will not alter your memorized reports to add new fields. In such cases, to take advantage of new fields or options, you should review and update your memorized reports as needed to include them.
To memorize a report:

1. With the report displayed, select MEMORIZE from the window toolbar and enter a name.

2. If you have not already created custom report types, the default type name of “My Reports” will be supplied. Select the needed report type from the drop-down list.

   Or

   To create a new report type, select MANAGE MY REPORTS, then NEW TYPE and enter a name and description.

3. Select OK.

Manage My Reports

You can use the Manage My Reports window to add, remove, rearrange, or rename your report types and memorized reports.
Drag and drop report types and individual reports or use the MOVE UP/DOWN buttons to arrange them in the order you prefer. Reports can be moved from one report type to another. This will affect the order in which your memorized reports are displayed on the Reports menu and in the Memorized Reports section of the Navigator.

**Running Multiple Reports**

If you find that you frequently run the same reports at the same time, Point of Sale offers the option of grouping those reports and running them all at once with a single selection.

**To run multiple reports:**

1. From the Reports menu, select **RUN MULTIPLE REPORTS**.
2. In the Process Multiple Reports window, select a report type from the drop-down list or select **ALL REPORTS**. A listing of reports available in the selected type is displayed.
3. Select or clear the checkboxes for each report. If a report’s checkbox is selected, the report will be run.
4. Enter a date range for those reports that require one.
5. Select **DISPLAY** to preview the reports on-screen or **PRINT** to send them to your printer.

![Process Multiple Reports window](image)
Sales Charts and Graphs

Overview

The report window can display a summary of the sales for different descriptive elements, such as departments, vendors, attributes, sizes, associates, hours, weekdays, or store (if Pro Multi-Store). The information can be viewed in various graph formats. Only one descriptive element can be graphed at a time and all of the sales information for that element, in the selected analyzed period of time, will be graphed. Graphical formats are useful for making quick comparisons, visualizing trends, and instantly communicating data to others. Several types of graphs are available, each best suited for a particular purpose.

Bar Graph

Bar graphs are particularly effective when making comparisons among members of a group.

For example, this bar graph compares the sales performance of eight vendors. Although only one result may be displayed at one time, you can alternately select five values of merchandise sold (Total Margin $, Ext Price, Qty, Ext Cost, and Margin %) from the drop-down menu and instantly see the resulting graph.
**Pie Charts**

Pie charts enable you to visualize the proportion of total sales contributed by each vendor, department, clerk, and so forth. Thus, the same sales data as used above, plotted as a pie chart, discloses units sold for five different vendors (only non-zero values are plotted for each vendor) over the course of five months.

![Pie Chart Example](image)

Although only one result can be charted at a time in a pie chart, you can toggle between results by using the drop-down list.

**Line Graphs**

Line graphs display your results over a period of time. In this way, you can monitor trends.
In this sample line graph, you can see the fluctuations of sales from week to week. By changing the time period to Hourly, one could use the trends to help determine when additional employees should be scheduled for busier times, or when less business is occurring and fewer employees would be needed.

**Viewing Charts and Graphs**

To view a chart or graph:

1. From the Report Center, select any report listed as a graph.
2. A dynamic date filter dialog is displayed at the top of the chart window. Define the date range as needed and select **APPLY DATE RANGES**.
3. To filter the results, select **MODIFY** and set filters as needed on the **Filters** tab.
4. Select **BAR**, **LINE**, or **PIE CHART** from the drop-down list to indicate how you wish to view your results and select **OK**.
5. You can toggle between the values to be displayed from the drop-down list. (Some values are only available for certain descriptive elements.)
   
   Line graphs will display the results of the values selected over a period of time.
   Pie charts and bar graphs will display a cumulative “snapshot” of the results for the specified time period.

**Printing a Chart or Graph**

To print a chart or graph:

1. With the chart displayed, select **PRINT** from the bottom toolbar.
2. On the Print dialog, change the printer or number of copies if necessary and then select **PRINT** or **PREVIEW**.
   
   The preview option allows changing some of the printing instructions:
Chapter 26: Reports and Sales Charts

- **Orientation**: Specify Portrait or Landscape Mode.
- **Margins (%)**: Adjust the width of any margin. The chart size expands or shrinks automatically to match the new margins. Margins can also be changes by dragging that dropping the preview margin indicator lines with your mouse.
- **Reset Margins**: Click to restore the last saved margin settings.
- **View Margins**: Select to display the margin indicators on the screen.
- **Detail**: Set Detail to More to print the chart at the maximum size possible with the specified margins. When set to Normal, the chart is reduced slightly and the text labels identifying the chart data are enlarged.
- **Proportional**: Select to return the chart to its original relative height and width proportions.

3. When ready, select **PRINT**.
Using the Reports Dashboard

The Dashboard allows you a quick reference for reports, financial information, the Point of Sale online community, and even web pages, right from Point of Sale. The Dashboard is highly customizable and can be changed to more precisely fit your particular needs.

To access the Dashboard:

1. Select the Dashboard tab for the page you wish to view.

The Dashboard has some reports pre-selected for you by default. You have the following options when customizing the Dashboard:
   - In Dashboard reports, click or drag-and-drop column headers or separators to sort report values, re-order, or resize columns respectively, where included
   - Select SHOW FULL REPORT to open the report in the full report window, where you have all the normal report features available
   - Select EDIT to edit the time period and/or sorting for a report
   - Select MODIFY REPORT to access the Modify Report dialog to edit the report parameters and filters
   - Select REFRESH to update the report data at anytime
   - Select CUSTOMIZE DASHBOARD to rearrange, remove, or change the reports displayed on the Dashboard (see following image)

Drilling Down Into Dashboard Reports with QuickZoom

When the QuickZoom icon is displayed, you can view additional detail for the reports on the Dashboard in the same manner as reports accessed from the Report Center.

To customize the Dashboard:

1. From the Dashboard window, select the CUSTOMIZE DASHBOARD link at the top left corner of the Dashboard page.
   The Customize Dashboard panel opens on the left.

2. Make changes as needed:
   - Change the page name for the Dashboard
   - Specify the number of Dashboard pages you wish to appear in POS
   - Specify the number of columns you wish to appear on each page
   - Drag the contents to different positions
   - Add or remove Dashboard contents (see following image)

3. Select OK to close the Customize Dashboard window.
To add content to the Dashboard:

1. Select the small triangle to the left of a content category to expand the list of available reports.
2. Select ADD for the desired report.
3. The report is added to a blank spot on the Dashboard. Drag-and-drop to another location as needed.
## Section VII: QuickBooks Integration

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>Financial Exchange Basics</td>
<td>479</td>
</tr>
<tr>
<td>28</td>
<td>Conducting Daily Financial Exchanges</td>
<td>487</td>
</tr>
<tr>
<td>29</td>
<td>How QuickBooks Handles Point of Sale Data</td>
<td>497</td>
</tr>
<tr>
<td>30</td>
<td>Customizing Financial Exchanges</td>
<td>519</td>
</tr>
</tbody>
</table>
Chapter 27  Financial Exchange Basics

Financial Exchange Overview ........................................... 480
Division of Activities after Integration ............................... 481
Tracking Inventory ......................................................... 481
What Data is Shared? ...................................................... 482
Installing and Preparing QuickBooks for Financial Exchange 483
The Financial Center ....................................................... 484
Connecting to QuickBooks Financial Software .................. 485
Remote Data Sharing ...................................................... 486
Financial Exchange Overview

In this section, you will learn:

- The benefits of integrating Point of Sale with QuickBooks financial software
- Which activities are managed by which application
- What data is shared
- How to use the QuickBooks Connection Wizard to integrate with QuickBooks financial software
- How to initiate Financial Exchanges
- How to verify exchange results and troubleshoot problems
- How to customize your Point of Sale setup for Financial Exchanges
- How Point of Sale data is handled when it reaches QuickBooks financial software
- How to use the Recover feature in case of total data loss in your QuickBooks financial software company file
- Find out about remote data sharing, an optional way for Point of Sale to communicate with QuickBooks financial software across a network

Point of Sale 7.0 is designed for use with QuickBooks financial software: Pro or Premier Editions (2005 - 2008) or Enterprise Solutions (5.0 - 8.0). Some features, as identified in their respective sections of this guide, require integration with the 2008 version of QuickBooks.

Point of Sale helps you run your store, ring up sales, manage inventory, and track customers. QuickBooks financial software helps you pay bills, manage cash flow, and run financial reports. Exchanging information between the two programs is referred to as Financial Exchange and can significantly reduce your workload because you can track retail activities in Point of Sale, and then transfer the resulting data directly into QuickBooks financial software. There’s no need to enter information twice!

Several options are available for you to customize how your Point of Sale data is transferred to your financial software so that it works for your business model and for how you like to have your retail activities reported.

Point of Sale also provides various Financial Exchange reports. Refer to Chapter 26 Reports and Sales Charts (page 459) for more information on reports in Point of Sale.
Financial Exchange Overview

**Division of Activities after Integration**

Financial Exchange allows you to get the most from the specialized features of each program by splitting key business activities between the programs as shown in the following chart.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Point of Sale (Retail Activities)</th>
<th>QuickBooks (Financial Activities)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add and track inventory items</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Order and receive merchandise</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Ring up sales &amp; collect sales tax</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Run sales &amp; merchandise reports</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Add customers or vendors</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Track cost of goods and expenses</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Pay bills and sales tax</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Invoice customers</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Process payroll</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Run financial reports</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Banking activities</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

**Tracking Inventory**

After integration, other than for the optional import of inventory items from QuickBooks to Point of Sale, inventory item records are not shared between the two programs. You should use Point of Sale to order, receive, and track all of your resale items. Point of Sale will send transactions and adjustments to QuickBooks, where you can get the financial information about inventory, such as cost of goods sold and income.

Likewise, if you keep items in your QuickBooks financial software, then those items should be purchased and tracked only in your financial software. Typically, this would be for non-resale item like office and cleaning supplies or customer service items, like shopping bags.

Importing of items (as well as customers and vendors) is discussed in Chapter 8 Importing and Exporting Data (page 117).
# What Data is Shared?

The following table summarizes the data that is shared between Point of Sale and QuickBooks financial software company files.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Point of Sale to QuickBooks</th>
<th>QuickBooks to Point of Sale</th>
</tr>
</thead>
<tbody>
<tr>
<td>New and updated customer records</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Customer account charges, payments, transactions and limits</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Customer account balances, limits, and past due amounts</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Sales receipts, deposits, tips, and sales taxes collected</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Cash drawer pay-outs</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>New and updated vendor records</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Receiving vouchers (receipt of merchandise from vendors)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Vendor billing information, on vouchers</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Vendor payment terms</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Employee time records (Pro)*</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Inventory items</td>
<td>Optional import</td>
<td></td>
</tr>
<tr>
<td>Inventory adjustments (quantity or cost)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Inventory transfers (Pro Multi-Store)</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

* Requires QuickBooks Financial Software 2008

In addition, your QuickBooks financial software chart of accounts, sales tax items, and other preferences are read and made available within Point of Sale for selection when mapping (linking) these items between the programs.

Only new data or data updated since the last exchange is sent.

**The following data is not shared:**

- Employee records
- (Pro) Employee commissions
- Purchase orders
Installing and Preparing QuickBooks for Financial Exchange

- (Pro) Customer orders, though deposits taken on customer orders are sent on receipts

Refer to Chapter 29 How QuickBooks Handles Point of Sale Data (page 497) for more information about how various data types are exchanged with QuickBooks financial software.

Installing and Preparing QuickBooks for Financial Exchange

A prerequisite to sharing data between Point of Sale and QuickBooks financial software is that you have a supported version of QuickBooks financial software installed and that you have set up a financial company file:

When setting up your financial company file in your financial software, make sure you have:

- Sales tax turned on, if you collect sales tax.
- Inventory turned on.
- Created necessary accounts to match the Point of Sale default chart of accounts used to transfer data. Linking to a custom chart of accounts is covered in To map to custom QuickBooks financial software accounts: (page 524).
- Your QuickBooks Integrated Applications company preferences set so that they do not block communication with Point of Sale.

Instructions for the initial preparation of QuickBooks financial software are included in the Point of Sale QuickStart Guide. An electronic version of the QuickStart Guide can be accessed by selecting USER GUIDES from the Help menu in Point of Sale.

Additional information about the various installation configurations that allow communication between the programs can be found in the in-program help system. Access these topics by searching help using the keywords “financial exchange, installation options”.

You do not have to immediately integrate the two programs upon installing Point of Sale. However, if you already have a QuickBooks financial software company file with existing customers, vendors, and inventory, you can save a great deal of time by integrating from the start and importing those records into Point of Sale.
The Financial Center

The Financial Center provides a single access point to all activities related to Financial Exchange with QuickBooks financial software as well as a summary of your connection and last completed exchange.

To access the Financial Center:

- From the Financial menu, select **FINANCIAL CENTER**.

  Or

  Select **FINANCIAL CENTER** from the Navigator.

From the Financial Center, you can:

- Confirm the connection and last exchange status, and the names of the company files for both programs
- Manually initiate a Financial Exchange (select **UPDATE QUICKBOOKS now**)
- View the activity log to see results of previous exchanges
- Set up or modify your connection to QuickBooks financial software
- Import items from QuickBooks financial software
- Recover data (re-send for a specified date range) to your QuickBooks financial software company file in the event of a data loss in your financial software

The last three options are available after selecting advanced options from the Overview page. These activities are detailed in later sections of this chapter.
Connecting to QuickBooks Financial Software

Financial Exchange with QuickBooks is available from the Point of Sale Server Workstation only, and in a Pro Multi-Store configuration, at Headquarters only.

Assuming you have installed and prepared QuickBooks financial software according to the directions in the Point of Sale QuickStart Guide, the QuickBooks Connection Wizard can be used from within Point of Sale to connect the programs.

The connection wizard is automatically launched when a connection is necessary to complete a Financial Exchange task or can be launched manually at anytime from the following areas:

- The Use with QuickBooks page as you complete the Setup Interview
- The Financial page of company preferences (select PREFERENCES > COMPANY from the Edit menu)
- The Financial Center

To use the connection wizard:

1. Start QuickBooks financial software and open your financial company file. Log in as a user with “Admin” rights.
2. Switch to Point of Sale and launch the connection wizard from any of the areas described above.
   Tip: You can use <ALT+TAB> to switch between the programs as necessary during this procedure.
3. Follow the wizard’s on-screen prompts until the connection is completed.
4. Close the connection wizard when done.

Once the connection has been established, Point of Sale will reconnect to the same QuickBooks financial software company file on subsequent exchanges. It is not necessary to run the connection wizard again, unless there has been a change in your configuration, such as when moving, renaming, or creating a
new financial software company file. The wizard will notify you that it cannot locate the prior file in these cases, and will prompt you for the location of the file you wish to use.

**Connecting When QuickBooks Financial Software is not Running**

To complete the initial connection, QuickBooks financial software must be running and the company file open. However, subsequent exchanges can be completed even if your financial software is not running if your QuickBooks Integrated Application preferences are set to allow automatic login to Point of Sale.

You may have had the option to enable automatic login when you ran the QuickBooks connection wizard. If you did not have this option at that time, you can use the following procedure to set this preference.

**To set your QuickBooks financial software preferences to allow automatic login:**

1. From the Edit menu in your financial software, select **PREFERENCES** and then select **INTEGRATED APPLICATIONS**.
2. Select the Company Preferences tab and highlight Point of Sale in the list of applications.
3. Select **PROPERTIES**.
4. Select **ALLOW THIS APPLICATION TO LOGIN AUTOMATICALLY**.
5. Select the user (“Admin” is recommended) and then select **OK**.

**Remote Data Sharing**

Remote Data Sharing (RDS) is an alternative way for advanced users to configure Point of Sale and QuickBooks to exchange data across a network by installing separate Server and Client applications on the two computers. With RDS, your QuickBooks software can be located on any computer on your network, other than the Point of Sale Server Workstation. RDS can provide additional security options but is more complex to set up and use.

**IMPORTANT: Setup and Use of Remote Data Sharing (RDS)**

RDS is developed separately from Point of Sale and due to the complexity of its setup and operation it is recommended only for advanced users. To learn more about RDS or to download the components you need to install and use this method of Financial Exchange, visit the following web site: [http://support.quickbooks.intuit.com/archive/pos/downloads](http://support.quickbooks.intuit.com/archive/pos/downloads)
## Chapter 28  Conducting Daily Financial Exchanges

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>488</td>
</tr>
<tr>
<td>Initiating Financial Exchanges</td>
<td>488</td>
</tr>
<tr>
<td>Verifying the Exchange of Individual Transactions</td>
<td>490</td>
</tr>
<tr>
<td>Viewing Financial History and QuickBooks Transactions</td>
<td>490</td>
</tr>
<tr>
<td>Financial Exchange Reports</td>
<td>493</td>
</tr>
<tr>
<td>Handling Bank Deposits after Financial Exchanges</td>
<td>493</td>
</tr>
<tr>
<td>Resolving Exchange Errors</td>
<td>494</td>
</tr>
<tr>
<td>Financial Exchange Activity Log</td>
<td>494</td>
</tr>
</tbody>
</table>
Overview

By default, Financial Exchanges are carried out using a pre-defined chart of accounts and payment types that “link” the programs and determine how data is posted to QuickBooks financial software.

Also, with the default configuration, Point of Sale sales and receiving information is sent to your financial software in a summarized format that does not include item detail.

If the default accounts and payment types do not exist in your financial software, Point of Sale will create them for you. There are a few exceptions where they must be created manually. If one of the default accounts is missing in your financial software, the connection wizard will alert you and provide instructions for adding it.

If the default accounts do not meet your needs, or if you want to send sales and receiving information with item detail, you can customize your Financial Exchange settings so that Point of Sale data is posted to your financial software in the manner you prefer.

In this chapter, you will learn:

- How to initiate Financial Exchanges
- How to verify a successful exchange and view the documents or records created in QuickBooks financial software from your Point of Sale data
- How to handle bank deposits in QuickBooks financial software
- How to resolve exchange errors

Initiating Financial Exchanges

The easiest way to transfer daily Point of Sale data to QuickBooks financial software, is to include the Financial Exchange in your End of Day procedure. The End of Day procedure can perform a number of store closing actions, including settling credit card batches, running a Z-Out Store Close Report, backing up your data, and exchanging information with your financial software.

You can also initiate a Financial Exchange manually at anytime. A manual exchange does not differ from that conducted during End of Day; both methods send all data that has not yet been sent to your financial software.
You might use this feature, for example, if you want to do mid-day billings from your financial software and want to be sure that you have up-to-the-minute Point of Sale sales data.

If you are in a multiple-workstation configuration, Financial Exchanges must be run from your Server Workstation (usually this is the workstation on which you first installed Point of Sale).

**To run Financial Exchange:**

1. Make sure that QuickBooks financial software is running and your company file is open.
   - This is not necessary if you have set your QuickBooks Integrated Applications preferences to allow Point of Sale to login automatically.
2. On the End of Day window, ensure that the **EXCHANGE DATA WITH QUICKBOOKS** option is selected, along with other options you want to run and select **OK**.
   - OR
   - From the Financial menu or the Financial Center, select **UPDATE QUICKBOOKS**.

As the Financial Exchange occurs, a progress window is displayed. When done, the update summary window is displayed.

The summary includes the overall status, the number of each record type transferred, and indicates if there were any problems encountered.

For help in identifying and resolving potential problems, select **VIEW ACTIVITY LOG**. *Refer to Resolving Exchange Errors (page 494) for more information about using the log to help identify and correct problems.*
Verifying the Exchange of Individual Transactions

Point of Sale offers several ways for you to check the exchange status of individual transactions:

- The **QB Status** field in Point of Sale lists.
- Links to open QuickBooks and view the transactions and/or journal entries created in QuickBooks financial software.
- The Financial Exchange activity log, which is especially useful for troubleshooting exchange errors. *Refer to Resolving Exchange Errors (page 494) for more information.*

Each of these methods is discussed in further detail in the following sections.

**The QuickBooks Status Field in Point of Sale Lists**

The **QB Status** field is available to add to the Point of Sale list for each data type sent to QuickBooks financial software. This field shows the exchange status of the specific document or record:

- **NOT POSTED** - Not yet sent to your financial software. This transaction will be sent with the next Financial Exchange.
- **COMPLETED** - Successfully sent to your financial software.
- **ERROR** - Attempting to send the transaction to your financial software resulted in an error. *Refer to Resolving Exchange Errors (page 494) for more information.*
- **UNBILLED PURCHASES** - (Vouchers only) Merchandise has been received on a voucher but has yet to be billed; document has been sent to Unbilled Purchases in your financial software.

The Unbilled Purchases entry is displayed only if you have selected to enter vendor billing information in Point of Sale. *Refer to Changing How Vendor Billing Information is Handled (page 527) for more information about changing this setting.*

**Viewing Financial History and QuickBooks Transactions**

Once an exchange has occurred, you can quickly open QuickBooks financial software and view the corresponding transaction(s) or records by selecting **VIEW FINANCIAL**.
Verifying the Exchange of Individual Transactions

**HISTORY** from the I Want To menu in Point of Sale lists. This feature is available in the customer, vendor, and all transactional document history lists.

This feature is particularly useful for viewing your financial software documents and journal entries when using the detailed item information posting method. If using the default summarized posting method, the corresponding financial software documents are the summarized documents that combine receipts and vouchers by day.

Refer to **Switching to Detailed Document Posting (Item Information) (page 520)** for instructions to switch to item detail on receipts and vouchers.

**To view a transaction in QuickBooks financial software:**

1. In the Point of Sale list, highlight the record or document of interest.
2. Select **VIEW FINANCIAL HISTORY** from the I Want To menu.
   
   The Financial History window is displayed, showing the exchange status and containing a link to view the transaction. Note that some documents result in more than one financial software document or entry.

3. Select **OPEN IN QUICKBOOKS** to launch your financial software and view the transaction or record.
   
   This window will show the exchange status, as applicable:
Chapter 28: Conducting Daily Financial Exchanges

For documents:

- **Sent to QuickBooks Successfully** - The document has been sent to QuickBooks financial software.
- **Not Sent** - The document has not been sent yet.
- **Problem Sending to QuickBooks** - The document had an error when trying to send it.

For customer and vendors:

- **Synchronized with QuickBooks** - Record has been synchronized and no changes have been made on the Point of Sale side.
- **Pending Synchronization** - Record has data to be shared with your financial software (or it hasn't been shared yet but is flagged to do so).
- **Not Shared with QuickBooks** - Customer or vendor is not flagged to be shared with your financial software.
- **Problem Synchronizing with QuickBooks** - The customer or vendor had a problem exchanging. Refer to Resolving Exchange Errors (page 494) for more information.

Other Options on this window include (availability depends on status):

- **RESEND THIS RECORD DURING THE NEXT EXCHANGE** - Select this checkbox to resend the document during the next Financial Exchange. You might do this if you had to restore an older financial software backup and this document is now missing in your financial software. Note: This may result in the document being listed twice in the financial history window, but the link to the original document will no longer work.

- **MARK THIS DOCUMENT AS SUCCESSFULLY SENT** - Select this checkbox if you do not want this document sent to your financial software during the next Financial Exchange. You might make this choice if you restore a Point of Sale backup that was created before the document was sent to your financial software. Sending it again in this case would result in duplicates in your financial software.

**Resending Documents may Result in Multiple Entries in Financial History**

If you choose to resend a document, the Financial History window will include listings for two exchanges to your financial software. If you resent the document because a restore of an older QuickBooks financial software backup resulted in the document being lost in your financial software, then the original link to view the document will no longer be functional. Also, if you change the document in your financial software, the link from Point of Sale may no longer function (example: converting an item receipt to a bill).
Refer to Chapter 29 How QuickBooks Handles Point of Sale Data (page 497) for more information and examples of how various data types are handled in QuickBooks financial software.

Financial Exchange Reports

The Financial Exchange report category in the Report Center provides a number of reports which detail the information exchanged between Point of Sale and QuickBooks financial software.

Handling Bank Deposits after Financial Exchanges

With the default exchange configuration, sales payments received in Point of Sale sales are placed in the following accounts:

<table>
<thead>
<tr>
<th>Payment Type</th>
<th>QuickBooks Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>Cash in Drawer</td>
</tr>
<tr>
<td>Check, Credit Card, Debit Card</td>
<td>Undeposited Funds</td>
</tr>
</tbody>
</table>

To perform a bank deposit in QuickBooks:

To perform a bank deposit in QuickBooks financial software once you have completed a Financial Exchange, you will need to transfer the funds from the Cash In Drawer account to the Undeposited Funds account.

1. From the Banking menu in your financial software, select **TRANSFER FUNDS**.
2. Select the accounts to transfer from and to.
   Normally this would be a transfer from the Cash In Drawer account to the Undeposited Funds account. If you have set up custom account mappings between Point of Sale and your financial software, you may need to specify the other accounts that you use.
3. Enter the amount of monies to be transferred.
4. Save the transfer.
5. From the Banking menu, select **DEPOSIT**.
6. Select the items in the list you wish to deposit and select OK.

Tip: Alternate Method

1. In QuickBooks financial software, go to the Banking menu and click Make Deposit.
2. Click the items to deposit and then click OK. The cash that was transferred from POS does not appear on the list.
3. Add a new line to the deposit list where the From Account is Cash in Drawer and the amount is the amount of cash in the deposit.
4. Click Save & Close or Save & New.

Merchant Service Reconciliation in QuickBooks Financial Software 2008

If integrated with Version 2008 of QuickBooks financial software, your credit and debit card receipts are sent to QuickBooks with batch and store/merchant number information, so they show up on your Payments to Deposit window grouped accordingly. This helps to match these transactions with your bank deposits during reconciliation, and to identify account fees and other charges.

Resolving Exchange Errors

If an error occurs during a Financial Exchange, you are alerted on the Financial Exchange summary window. The first step to resolving the error is to view the error entry in the Activity Log for that exchange.

Financial Exchange Activity Log

The Activity Log allows you to review details of data shared between QuickBooks financial software and Point of Sale. It summarizes what information has been imported, added, and updated between the two programs.

The Activity Log is a useful tool for troubleshooting problems that arise during Financial Exchange and can help you locate problematic data. If an error occurs
Resolving Exchange Errors

during Financial Exchange, a message is displayed in the exchange summary window.

Select **VIEW ACTIVITY LOG** at the bottom of the window to view additional information related to the error.

Only the last 30 days of active data are stored in the log (days in which no data was exchanged do not count as part of the 30). If data is shared multiple times a day, a separate log entry is made and time-stamped for each. The log will contain information regarding the specific document or data that caused the error, which can help you troubleshoot the problem.
To review the Activity Log for errors:

1. Select a date from the left side of the window, and, if applicable, a time of day to narrow the entries even further.
   
   To see only the errors in the displayed log, select the **SHOW ERRORS ONLY** checkbox. Review the error message for clues as to the problem.

2. Clicking a blue hyperlink in an entry, if available, takes you to the corresponding record or transaction in Point of Sale.
   
   **Example:** For the error shown in the example above, you would click Receipt #13, which would display that receipt. In this case, a sale has been made to this customer that exceeded the customer’s credit limit, so your financial software will not accept the document. (Normally, this would not happen, but could in a multi-store configuration if two sales charged to account were made to the same customer at different in between Financial Exchanges.)

   Resolving this error would require that either 1) the customer’s credit limit be increased or a payment be posted before the next exchange; so the receipt would be accepted, or 2) reversing the receipt in Point of Sale and then re-creating it using a different payment method.

   To print the log, select **PRINT** from the bottom of the window.

3. When finished reviewing logs, select **CLOSE** to exit the window.

To view the Activity Log at other times:

- Select **VIEW ACTIVITY LOG** from the Financial menu or from the Financial Center.

*For additional help in resolving Financial Exchange errors search the in-program help system for keywords “Troubleshooting Financial Exchange.”*
Chapter 29

How QuickBooks Handles Point of Sale Data

Point of Sale Data in QuickBooks Financial Software ............................................. 498
  Sales & Return Receipts ........................................................................... 498
  Cash Drawer Pay-Outs ............................................................................ 502
  Receiving Vouchers ............................................................................... 503
  Return Vouchers ................................................................................... 505
  Adjustment Memos ................................................................................ 506
  Customers .................................................................................................. 506
    Customer Charge Account Information .................................................. 507
  Customer Order Deposits (Pro) ................................................................. 508
  Vendors ..................................................................................................... 510
  Employee Time Records (Pro) .................................................................. 511
  Gratuities/Tips .......................................................................................... 512
  Transfers Slips (Pro Multi-Store) ............................................................... 512
  Account and Payment Type Mappings ....................................................... 513
    Default Item Account Mappings ............................................................. 513
    Default Account Mappings ................................................................... 514
    Default Payment Type Mappings ........................................................... 515
  Recover QuickBooks ............................................................................... 516
Point of Sale Data in QuickBooks Financial Software

This chapter provides detailed information and examples of how QuickBooks financial software handles your Point of Sale data. Unless indicated otherwise, these examples assume you are using the default chart of accounts and summarized posting.

To view a specific record, transaction, or document created in QuickBooks financial software that corresponds to a Point of Sale record or transaction, refer to Verifying the Exchange of Individual Transactions (page 490).

Sales & Return Receipts

Sales receipts in Point of Sale are sent to your financial software as follows:

- **Cost of Goods Sold**: A general journal transaction is created in your financial software. If using summarized posting, a single receipt is created for the cost of goods sold for the day.

  ![Journal Entry Example](image)

  If using detailed item posting, separate journal entries are made for each Point of Sale transaction. This makes it easier to reverse out a specific change if necessary. The Point of Sale receipt number is added to the memo line.

  ![Journal Entry Example](image)

- **Sales receipts paid by cash, credit/debit/gift card, and gift certificate are sent as sales receipts**: If you send summarized data to your financial software, one sales receipt is created in your financial software listing all of your cash, credit/debit/gift card, and gift certificate transactions per day.

  - If using the QuickBooks POS Merchant Service reconciliation feature with QuickBooks 2008, on summarized receipt per settlement batch is created.
Point of Sale Data in QuickBooks Financial Software

Note the following about this summarized receipt:

- Both the sales tax and total at the bottom of the receipt are $0. This is because POS Items (in the item column) are used to allocate the sales amounts to various accounts and balance the receipt before sub-totaling.

- In this example, these POS items affect the following accounts (using default chart of accounts):

<table>
<thead>
<tr>
<th>POS Item</th>
<th>QuickBooks Account (Type)</th>
<th>Increase/Decrease</th>
</tr>
</thead>
<tbody>
<tr>
<td>POS Sta Sales</td>
<td>Sales: Merchandise (Income)</td>
<td>Increased</td>
</tr>
<tr>
<td>POS Subtotal</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>State Tax</td>
<td>Sales Tax Payable (Liability)</td>
<td>Increased</td>
</tr>
<tr>
<td>POS Cash</td>
<td>Petty Cash</td>
<td>Increased</td>
</tr>
<tr>
<td>POS VISA</td>
<td>Undeposited Funds (Bank)</td>
<td>Increased</td>
</tr>
</tbody>
</table>

- “POS Sta Sales” corresponds to taxable sales using the State Tax code. If you use multiple tax codes, each one used on this date would be broken out as a separate item.

- If you sell different item types (service, non-inventory, etc.) you may see multiple entries of the same tax code sales, each reflecting the account mappings of the various item types, so that item sales are allocated to the appropriate accounts.

- Debit, or gift payments, if included in the daily sales, would also result in increases in the Undeposited Funds account.
If you send documents with item detail, each Point of Sale receipt creates a corresponding individual receipt in your financial software with the specific items and customer listed (if customer record set to exchange).

- **Sales receipts paid by check are sent as sales receipts:** These receipts are never consolidated with other transactions, even if you are sending summarized data.

Receipt paid by check exported to QuickBooks Financial Software in detailed format.

- **Sales receipts paid by charge to customer account are sent as invoices:** These invoices are never consolidated with other transactions, even if you are sending summarized data.
### Point of Sale Data in QuickBooks Financial Software

**Invoice**

<table>
<thead>
<tr>
<th>Item Code</th>
<th>Description</th>
<th>Price Each</th>
<th>Amount</th>
<th>Tax Code</th>
<th>Tax Rate</th>
<th>Tax Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>POS Sale</td>
<td>Sales</td>
<td>23.60</td>
<td>25.00</td>
<td></td>
<td>7.75%</td>
<td>1.75</td>
</tr>
<tr>
<td>POS Subtotal</td>
<td>Sales Tax</td>
<td>25.00</td>
<td>1.75</td>
<td></td>
<td>7.75%</td>
<td></td>
</tr>
</tbody>
</table>

**Customer Information**

- **To be printed**: 08/15/2005
- **To be e-mailed**: POS Receipt #1153

**Memo**: POS Receipt #1153

Sale charged to customer account - summarized posting

If sending detailed item information, the same invoice would like this:

**Invoice**

<table>
<thead>
<tr>
<th>Item Code</th>
<th>Description</th>
<th>Price Each</th>
<th>Amount</th>
<th>Tax Code</th>
<th>Tax Rate</th>
<th>Tax Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>POS Sale</td>
<td>Sales</td>
<td>23.60</td>
<td>25.00</td>
<td></td>
<td>7.75%</td>
<td>1.75</td>
</tr>
<tr>
<td>POS Subtotal</td>
<td>Sales Tax</td>
<td>25.00</td>
<td>1.75</td>
<td></td>
<td>7.75%</td>
<td></td>
</tr>
</tbody>
</table>

**Customer Information**

- **To be printed**: 08/15/2005
- **To be e-mailed**: POS Receipt #1153

**Memo**: POS Receipt #1153

Sale charged to customer account - detailed posting

Sending detailed information allows you to send statements to customers from your financial software showing the specific items purchased.

- **Return receipts are sent as credit memos**: If you send summarized data to your financial software, a single credit memo is created listing all return receipt transactions for cash, check, credit/debit/gift card, and gift certificate, per day. Since cash and card amounts are totaled per day, these payment types will only appear on a credit memo if the total amount paid in for cash or a particular credit card type (VISA, MasterCard, etc.) is negative. Return receipts that credit a customer’s account are always sent to your financial software as an individual credit memo. If you send detailed data to your financial software, each return receipt creates an individual, corresponding credit memo.
**Discounts**

Set in preferences, discounts are either incorporated into the net price of the items sent to your QuickBooks financial software, or separate original and discounted prices are sent. The net price is the original price of the item minus any line item discount and the proportional amount of any global discount.

**Multiple Payment Types on a Receipt**

If a receipt paid by check or charge to account also contains other payment types (cash, credit card, etc.), those payments will appear on the same receipt or invoice created in QuickBooks financial software.

**If Returns Exceed Sales for a Payment Type**

If your daily returns for any of the summarized payment types (check, credit card, gift) exceed the daily sales for that payment type, then the daily summarized sales are posted as a credit memo and an invoice instead of as a separate sales receipt and credit memo. This is due to one or more of the following limitations in your financial software documents:

- The POS payment types used by Point of Sale to balance documents cannot be positive on a sales receipt (thus the credit memo/invoice combination is used)
- Negative document total is not allowed
- Negative sales tax total is not allowed

**Adjusting Inventory Value in QuickBooks Financial Software**

If you add new inventory items while making a receipt, but don’t assign an item cost at that time, you may need to periodically make a manual adjustment to your inventory value in your financial software. This action transfers sales data to your financial software but does not make an adjustment in your Cost of Goods Sold (COGS) account because the items sold have a $0 cost at the time of sale.

---

**Cash Drawer Pay-Outs**

Pay-outs are sent to QuickBooks financial software as general journal transactions against the account you specify when creating the pay-out in Point of Sale. In the example shown, $50 was recorded as a payout in Point of Sale to place an ad in a local newspaper. This general journal entry affected the Marketing & Advertising and Petty Cash accounts. If a pay-out in Point of Sale is used to pay tips to employees, the Employee Tips Payable account is used.
Receiving Vouchers

Receiving vouchers can be sent to QuickBooks financial software in a variety of ways depending on where you elect to enter vendor billing information. Refer to Changing How Vendor Billing Information is Handled (page 527) for more information about setting this option.

If you enter vendor billing information in QuickBooks financial software:

Receiving vouchers are always sent to QuickBooks financial software as item receipts to Accounts Payable.

When the bill arrives and you enter the information in your financial software, the item receipt is converted to a bill.

If you enter vendor billing information in Point of Sale:

Receiving vouchers are sent to your financial software in different ways, depending on whether billing information (Invoice/Ref#) has been entered.

- If billing information is received and entered when the voucher is created, the voucher is sent as a bill to Accounts Payable.
Chapter 29: How QuickBooks Handles Point of Sale Data

- If billing information has not been entered, the voucher is sent as a general journal transaction and posted to the Unbilled Purchases liability account.

When billing information is entered later in Point of Sale, the voucher is sent a second time as a bill to Accounts Payable and removed from the Unbilled Purchases account, and the QB Status becomes Complete once the voucher is sent with an Invoice/Ref #.

- If the ALREADY PAID checkbox is selected on the Point of Sale voucher, whether billing information is entered or not, the voucher is sent as an item receipt. This option is typically used if the merchandise has been paid for prior to or at the time of receipt. You will have to manually apply the previous payment to the document in your financial software.

- If the voucher has a negative total and no billing information has been entered, the voucher is sent as a bill. This scenario would suggest that a vendor return was made on a receiving voucher. The Invoice/Ref # field will be auto-filled with an entry of “Credit” and the invoice date will be set to match the voucher date when posting to your financial software. This type of voucher cannot be edited later to add an Invoice/Ref # (a manual adjustment would have to be created, if necessary).

---

**Fees, Freight and Discounts on Vouchers**

If a voucher with fees, freight and/or discounts is sent as a general journal transaction (in other words, the voucher does not have an Invoice/Ref# number recorded on it), the fees and discounts will not be taken into account on the journal entry. Instead, the final bill sent to QuickBooks once an invoice for the voucher has been received will be adjusted to reflect any fees or discounts. If you are spreading fees, freight and discounts, this will affect your item costs. See Voucher Discounts, Freight, and Fees (page 289) for more information.

**Sending Detailed Item Information to QuickBooks**

If you send detailed item information to QuickBooks, individual items will be listed on the bill (or Vendor Credit, in the case of return vouchers) created in your financial software. However, general journal transactions created for vouchers never show individual items.
Return Vouchers

When return or reverse vouchers are sent, a Vendor Credit is created in QuickBooks. When a return or reversed voucher is sent to your financial software after the original voucher was sent during a previous Financial Exchange, the Vendor Credit is not automatically applied to the Vendor Bill that was previously created; this must be done manually in your financial software. In QuickBooks, select Pay Bills and apply the credit to the applicable Vendor Bill.

If you are recording billing information in Point of Sale:

If you enter vendor billing information in Point of Sale and the Invoice/Ref # field on the voucher does not have an entry when sent, then it is auto-filled with “Credit” and if it does have an entry, that entry is carried to the QuickBooks Ref. No. field.

If you do not enter billing information in Point of Sale, the Ref. No. field on QuickBooks credit memo contains an entry of “Paid.”
Chapter 29: How QuickBooks Handles Point of Sale Data

**Adjustment Memos**

A single general journal transaction is made for the aggregate inventory adjustments for each day.

![Image of a general journal entry]

In the example shown above, the Inventory Asset account has been decreased by $185.50 with a balancing entry in the POS Inventory Adjustments expense account.

Many activities in Point of Sale result in the creation of adjustment memos, and thus a general journal transaction in QuickBooks:

- Manually editing an item’s average unit cost or quantity
- Updating a physical inventory
- Building or breaking assembly items
- Deleting an item with an on-hand quantity

*Refer to Tracking Quantities and Costs (page 138) for more information about the actions that create memos.*

**Customers**

New and edited customer records are exchanged between Point of Sale and QuickBooks if the **USE WITH QUICKBOOKS FLAG** is set on the customer record.

**Resolving Duplicate Customers**

Occasionally, you may end up with the same customer with two records in Point of Sale. This occurs, most likely, when two associates enter the same customer with slightly different name spellings. The **Merge Customers** feature in Point of Sale can be used to combine the duplicates into a single record. When merging customers in Point of Sale, you also have the option to delete or make inactive the duplicate in QuickBooks. *Refer to Merging Customer Records (page 310) for more information.*
Customer Charge Account Information

Sales receipts made in Point of Sale that are paid by a charge to a customer account are sent to QuickBooks as invoices, as described in Sales & Return Receipts (page 498).

Customers’ account balances in QuickBooks are adjusted to reflect the charges on account. The updated balance information and any past due information is sent back to Point of Sale and overwrites the corresponding Point of Sale values. In this way, the balance and available credit shown in Point of Sale will include payments or finance charges that may have been applied in QuickBooks. The past due information can be used in Point of Sale to block additional charges to past due accounts.

You can adjust a customer’s credit limit in Point of Sale or in your financial software. The most recent change overwrites the limit in the other program.

(Pro Multi-Store) Exceeding Customer Account Balances

A customer’s account balance is updated immediately only at the store making a new charge or taking a payment on the account. The transactions made at one store don’t show up in customer records at the other store until a complete Store Exchange and Financial Exchange cycle is completed. Because of this, a customer could potentially exceed his/her account limit by making multiple purchases on account at different store locations in a single day.

For example, say a customer had a $100 credit limit. The customer charges $60 on one receipt, then goes to another store location and charges $50 more before a Store Exchange occurs. The second charge is allowed in Point of Sale because the customer’s balance at the second store has not yet been updated to reflect the first charge. Upon receiving both receipts at Headquarters, the second receipt will cause an error upon sending to QuickBooks; the posting of this receipt will not be allowed because it would cause the customer’s balance to exceed his credit limit. To resolve this error, you can 1.) increase the customer’s credit limit (at least temporarily), 2.) request and process a payment on account from the customer, or 3.) reverse the receipt in Point of Sale and ask the customer to pay by another method. If option one or two is used, the receipt will post successfully as soon as there is sufficient available credit for the second charge.

Payments on Account

Payments on account taken in Point of Sale result in the creation of one of the following documents in QuickBooks financial software:

- Customer payment if paid by cash, check, credit card, or debit card
- Credit memo if paid by gift card or gift certificate (this is unusual)
In your financial software, you should apply the payment or credit to open invoices for the customer, so that corresponding account balances are updated.

If you have your Receive Payments preference in your financial software (located under Sales & Customers company preferences) set to **AUTOMATICALLY APPLY PAYMENTS**, the customer payments will be applied to open invoices following the financial software rules. If this preference is not selected, you will have to manually apply the payments.

*Refer to In-Store Charge Accounts (page 316) for more information on customer charge accounts.*

See your financial software help for more information about applying payments and/or credits to open invoices.

---

**Customer Order Deposits (Pro)**

Although customer orders created in Point of Sale are not sent to QuickBooks, deposits and deposits used as payment create either sales receipts or invoices in QuickBooks, depending on the payment type.

**Deposits Taken**

Deposits taken on customer orders are recorded on sales receipts in Point of Sale and sent to QuickBooks in the same manner as other sales receipts.
If you send summarized data to QuickBooks:

Customer order deposits taken by cash, credit card, or gift certificate/card appear on the consolidated sales receipt for the day, and the amount of the deposit is added to the consolidated total for the appropriate payment type(s) and the POS SO Deposit item, which increases the Customer Deposits liability account.

Sales receipt entry for customer order deposit, in this example the deposit amount is also included in the POS Cash payment type.

Note that while these deposit receipts show a link in Point of Sale to the general journal transaction created for the day in QuickBooks, they in fact do not affect the Cost of Goods Sold or Income Asset accounts since the items on a customer order are not actually sold when a deposit is taken.

A customer order deposit paid by check or charge on account is always sent to QuickBooks as an individual sales receipt or invoice, respectively. No general journal entry is created for these transactions.

If you send detailed information to QuickBooks:

Deposits are sent as their own sales receipt (cash, check, card, gift certificate) or invoice (charge to account). Since the items on the order have not yet been sold, the individual items listed on a customer order do not appear on the documents created in QuickBooks and no general journal entry is made.
**Deposits Applied to Sales**

When customer order deposits are applied to the final sales receipt in Point of Sale (to actually sell the items), the new sales receipt is sent in the same manner as other sales receipts and a general journal entry is made to reflect the effect on Cost of Goods Sold and Inventory Asset Accounts. The Customer Deposits (liability) account is decreased by the amount of the deposit used.

If you send summarized data to QuickBooks, deposits used that were originally paid by cash, credit/debit/gift card or gift certificate appear on the consolidated receipt for the day. Sales Order deposits used on receipts paid by check or charge to account will appear on the corresponding receipt or invoice created in your financial software.

If you send detailed information to QuickBooks, deposits used appears on the corresponding sales receipt (cash, check, card, gift certificate) or invoice (charge to account) created in your financial software.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
<th>QTY</th>
<th>RATE</th>
<th>AMOUNT</th>
<th>Tax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ceiling Fan 120...</td>
<td>Ceiling Fan 1208A White Large</td>
<td>1</td>
<td>89.00</td>
<td>89.00</td>
<td></td>
</tr>
<tr>
<td>POS Subtotal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>San Domingo</td>
<td>CA sales tax, San Domingo County</td>
<td></td>
<td>7.5%</td>
<td>6.68</td>
<td></td>
</tr>
<tr>
<td>POS Cash</td>
<td>-70.68</td>
<td></td>
<td>-70.68</td>
<td></td>
<td></td>
</tr>
<tr>
<td>POS SO Deposit</td>
<td>Deposit Used SO#2</td>
<td></td>
<td>-25.00</td>
<td>-25.00</td>
<td>PAN</td>
</tr>
</tbody>
</table>

Deposit used on a receipt sent to QuickBooks financial software

**Vendors**

New and edited vendors are normally shared between Point of Sale and QuickBooks. The exceptions to this are:

- Vendors flagged as INACTIVE in both programs are not exchanged.
- If you check the INACTIVE flag when initially adding a new vendor in Point of Sale, that vendor will not be sent to QuickBooks. However, if you list the inactive vendor on a voucher, when that voucher is exchanged, the vendor will be created in QuickBooks.

---

**Resolving Duplicate Vendors**

Occasionally, you may end up with the same vendor with two records in Point of Sale. This occurs, most likely, when two associates enter the same vendor with slightly different name spellings. The **Merge Vendors** feature in Point of Sale can be used to combine the duplicates into a single record. When merging vendors in Point of Sale, you also have the option to delete or make inactive the duplicate in QuickBooks. Refer to **Merging Vendor Records (page 258)** for more information.
**Vendor Payment Terms**

Vendor terms are used to calculate when a bill is due and what (if any) discount percentage should be applied to the bill.

The default vendor terms defined in QuickBooks are automatically populated to the vendor record in Point of Sale. Changing the default terms in either program updates the other with the same change.

If you are entering vendor billing information in Point of Sale, adding different terms to a voucher in Point of Sale will add those terms to QuickBooks on the next exchange. The new terms will also be carried to the bill created in QuickBooks. Changing the terms on an individual document does not update the default terms specified in either program.

---

**Employee Time Records (Pro)**

If you are using the Time Clock in Point of Sale to record employee hours and use QuickBooks Financial Software 2008, the time records can be sent to QuickBooks for payroll purposes. For this integration to work:

- You must be configured to exchange information with QuickBooks 2008.
- Time tracking must be turned on in both programs.
- The individual employees for who time entries are to be transferred must be set up for time tracking in both programs.
- Employee names must be entered exactly the same in both programs.

Refer to Employee Time Clock (Pro) (page 61) for information on how to turn on employee time tracking in Point of Sale.

**Important facts about exchanging time tracking data:**

- One time activity/entry is created in QuickBooks for each entry in Point of Sale (can be viewed with single entries or on weekly time sheets).
- Once time records have been sent to QuickBooks, they can no longer be edited in Point of Sale.
- Point of Sale does not differentiate between regular and overtime hours. If overtime adjustments are necessary, make them on the QuickBooks time sheet.
- Only employee time is sent to QuickBooks for payroll purposes; commissions, tips and customer job information are not included in the information sent (tips on sales receipts are posted against the Employee Tips payable account, but this is not employee specific - see below for more information).
Chapter 29: How QuickBooks Handles Point of Sale Data

- **Multi-Store:** Time records are sent from remote stores to Headquarters, and then they are sent to QuickBooks.

**To configure Point of Sale to send time records:**

1. Access **PREFERENCES ➤ COMPANY ➤ FINANCIAL ➤ EMPLOYEE HOURS.**
2. Select the check box to **SEND EMPLOYEE HOURS WORKED TO QUICKBOOKS USING PAYROLL ITEM.**
3. Select the QuickBooks payroll item from the drop-down list.

If matching employee records are not found in QuickBooks, Point of Sale will create and configure them for time tracking in QuickBooks.

However, if the employees already exist and are not configured for time tracking, you will need to configure them manually as follows.

**To configure QuickBooks for time tracking:**

1. In your QuickBooks financial software, go to **PREFERENCES ➤ TIME TRACKING ➤ COMPANY PREFERENCES.**
2. Select **YES** for **DO YOU TRACK TIME?**
3. Select **OK.**
4. In the Employee Center, locate the employee you are configuring and select **EDIT EMPLOYEE.**
5. Ensure the employee name is entered exactly as it is entered in Point of Sale.
6. From the Change Tabs drop down list, select **PAYROLL AND COMPENSATION INFO.**
7. Select the option to **USE TIME DATA TO CREATE PAYCHECKS.**
8. Select **OK.**

If all employees are paid hourly, you can change your New Employee Default settings to have this selected.

**Gratuities/Tips**

Tips on non-cash transactions recorded on Point of Sale receipts are sent to the Employee Tips Payable account. If the tips are paid to the employee using the Point of Sale Pay-Out feature, this account will then be decreased by the amount paid.

**Transfers Slips (Pro Multi-Store)**

A transfer of merchandise between stores does not result in any net change in your company inventory value. However, if freight charges are entered on the slip or if you have elected to track stores by class in QuickBooks, transfer slips are sent and create a
general journal transaction to update accounts accordingly. Refer to *Store Tracking and Profit/Loss Reporting by Class (page 541)* for information about class tracking of stores.

Shown below is an example general journal entry for a transfer slip.

<table>
<thead>
<tr>
<th>Date</th>
<th>Entry No.</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/06/2007</td>
<td></td>
<td>Freight and Shipping Costs</td>
<td>105.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>POS Inventory Adjustments</td>
<td>105.00</td>
<td></td>
</tr>
</tbody>
</table>

Freight charges are posted to the Freight and Shipping Costs and POS Inventory Adjustments accounts and, if tracking stores by class, the Inventory Asset accounts for each store class are updated.

---

### Account and Payment Type Mappings

#### Default Item Account Mappings

These default item accounts dictate where Point of Sale will transfer your Point of Sale item sales (Income), cost (COGS), and inventory value (Asset) amounts when the various item types are sold. If needed, you can change the default accounts for each item type at PREFERENCES ➤ COMPANY ➤ FINANCIAL or you can assign accounts on an item-by-item basis on the item record in inventory. Refer to *Mapping Individual Item Accounts in Inventory (page 525)* for more information.

Point of Sale also allows for mapping to sub-accounts based upon department or store. Refer to *Map QuickBooks Accounts by Department or Store (page 526)* for more information.

<table>
<thead>
<tr>
<th>POS Item Type</th>
<th>Income Account</th>
<th>COGS Account</th>
<th>Asset Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory</td>
<td>Merchandise Sales</td>
<td>Cost of Goods Sold</td>
<td>Inventory Asset</td>
</tr>
<tr>
<td>Non-inventory</td>
<td>Merchandise Sales</td>
<td>Purchases: Resale Items</td>
<td>Purchases: Resale Items</td>
</tr>
<tr>
<td>Service</td>
<td>Service Sales</td>
<td>Subcontracted Services</td>
<td>Subcontracted Services</td>
</tr>
<tr>
<td>Assembly</td>
<td>Merchandise Sales</td>
<td>Cost of Goods Sold</td>
<td>Inventory Asset</td>
</tr>
</tbody>
</table>
Chapter 29: How QuickBooks Handles Point of Sale Data

Default Account Mappings

These default QuickBooks accounts are where Point of Sale will post transaction amounts. If needed, you can change these account mappings at **Preferences ➤ Company ➤ Financial.** Changes go into effect with the next Financial Exchange. Refer to **Custom Mapping of Accounts (page 524)** for more information.

<table>
<thead>
<tr>
<th>POS Item Type</th>
<th>Income Account</th>
<th>COGS Account</th>
<th>Asset Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>not applicable</td>
<td>not applicable</td>
<td>not applicable</td>
</tr>
<tr>
<td>Special Order</td>
<td>Merchandise Sales</td>
<td>Cost of Goods Sold</td>
<td>Inventory Asset</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Point of Sale Field</th>
<th>QuickBooks Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash In Drawer</td>
<td>Cash in Drawer</td>
</tr>
<tr>
<td>Check</td>
<td>Undeposited Funds</td>
</tr>
<tr>
<td>Credit Card</td>
<td>Undeposited Funds</td>
</tr>
<tr>
<td>Debit Card</td>
<td>Undeposited Funds</td>
</tr>
<tr>
<td>Gift Certificate</td>
<td>Gift Certificates Outstanding</td>
</tr>
<tr>
<td>Gift Cards</td>
<td>Gift Cards Outstanding</td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>Accounts Receivable</td>
</tr>
<tr>
<td>Sales Tax</td>
<td>Sales Tax Payable</td>
</tr>
<tr>
<td>Customer Order Deposit Taken</td>
<td>Customer Deposits</td>
</tr>
<tr>
<td>Purchase Clearing</td>
<td>Unbilled Purchases</td>
</tr>
<tr>
<td>Voucher Adjustment</td>
<td>Purchase Discounts</td>
</tr>
<tr>
<td>Freight In</td>
<td>Freight and Shipping Costs</td>
</tr>
<tr>
<td>Voucher Fee</td>
<td>Freight and Shipping Costs</td>
</tr>
<tr>
<td>Accounts Payable</td>
<td>Accounts Payable</td>
</tr>
<tr>
<td>Document Offset</td>
<td>POS Inventory Adjustments</td>
</tr>
<tr>
<td>Shipping</td>
<td>Shipping and Delivery Income</td>
</tr>
<tr>
<td>Pay Out Expense</td>
<td>Cash Drawer Payouts</td>
</tr>
<tr>
<td>Tips</td>
<td>Employee Tips Payable</td>
</tr>
<tr>
<td>POS Balancing Adjustments</td>
<td>Balancing Adjustments</td>
</tr>
</tbody>
</table>
Default Payment Type Mappings

Payment type mappings cannot be changed in Point of Sale. They can be changed by adjusting your payment methods/types in your financial software.

**Note:** If using the QuickBooks POS Merchant Service Reconciliation feature with QuickBooks 2008, these default payment type mappings are required. *Refer to Settling a Merchant Account (page 442) for more information.*

<table>
<thead>
<tr>
<th>Point of Sale Payment Type</th>
<th>QuickBooks Payment Method</th>
<th>QuickBooks Payment Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>Cash</td>
<td>Cash</td>
</tr>
<tr>
<td>Check</td>
<td>Check</td>
<td>Check</td>
</tr>
<tr>
<td>Gift Card</td>
<td>Gift Card</td>
<td>Gift Card</td>
</tr>
<tr>
<td>Debit Card</td>
<td>Debit Card</td>
<td>Debit Card</td>
</tr>
<tr>
<td>Credit Card: American Express</td>
<td>American Express</td>
<td>American Express</td>
</tr>
<tr>
<td>Credit Card: MasterCard</td>
<td>MasterCard</td>
<td>MasterCard</td>
</tr>
<tr>
<td>Credit Card: Visa</td>
<td>Visa</td>
<td>Visa</td>
</tr>
<tr>
<td>Credit Card: Discover</td>
<td>Discover</td>
<td>Discover</td>
</tr>
<tr>
<td>Credit Card: Diners Club</td>
<td>Diners Club</td>
<td>Other Credit Card</td>
</tr>
<tr>
<td>Credit Card: JCB</td>
<td>JCB</td>
<td>Other Credit Card</td>
</tr>
</tbody>
</table>
Recover QuickBooks

If your QuickBooks data file is damaged or lost, you can try to restore it from recent backups. However, performing a backup from an outdated file could cause you to lose the sales data that you have been regularly sending from Point of Sale to your financial software. The Recover QuickBooks option allows you to re-send your point-of-sale data to QuickBooks.

This feature should be used in only two situations:

- Your financial software data is corrupted and you have no backup or an outdated backup
- You start a new QuickBooks company file, and want to populate it with Point of Sale data

Recover QuickBooks provides a way to specify a date range and send all data from this range, whether or not previously sent, to QuickBooks. If you use this feature for any purpose other than specified above, you may overwrite important information or create duplicate entries in your company file.

The Recover QuickBooks option is only available from your Point of Sale server workstation. Try to restore your QuickBooks data from your backups before using the recover procedure.

⚠️ If You Need Help Restoring Your Financial Software Data File

If you are unsuccessful restoring your financial software data file, you should contact Intuit technical support for data recovery assistance. There may be a fee for this service.

⚠️ Warning: Data Recovery May Be Time Intensive

Depending on the size of your database, the date range you specify, and your computer speed, the data recovery process may take a considerable amount of time to complete. Once started, the process must be allowed to complete. Errors may result in duplication or missed records if you attempt to stop and restart the process.

To recover from a total QuickBooks data loss (no backup):

Use the steps below if you have been unable to restore your financial software data and/or have started a new company file. All vendors, customers, and transactional data within the specified date range will be sent.

1. Refer to the QuickBooks Integration tab of the Point of Sale QuickStart Guide to prepare the new company for Financial Exchange before selecting **RECOVER QUICKBOOKS**.
2. From the Financial menu, in Point of Sale, select **RECOVER QUICKBOOKS**.
3. Read the Recovery warning, and then select **CONTINUE**.
4. Select a date range as far back as you would like to re-send point-of-sale data to your new company file (typically, the date when you first started using Point of Sale).
5. Type **Yes** to confirm the recovery.
6. Select **CONTINUE** to start the exchange.

**To recover if your QuickBooks backup is out of date:**

This situation means that you have an intact QuickBooks company file but your recent sales activity has been lost due to the backup being outdated. Restore from the QuickBooks backup first, then use the Recover QuickBooks option in Point of Sale to send only the data and transactions from the first day *after* the date of your QuickBooks backup file through the current date.

For example, it is March 1. Your company file is damaged, and the most recent QuickBooks backup you have is from February 27:

1. Restore QuickBooks from the February 27 backup.
2. From the Financial menu in Point of Sale, select **RECOVER QUICKBOOKS**.
3. Read the Recovery warning, and then select **CONTINUE**.
4. Specify a beginning date of February 28 and an ending date of March 1.
5. Type **Yes** to confirm the recovery.
6. Select **CONTINUE** to send the data within the specified dates to QuickBooks.
Overview ................................................................. 520
Switching to Detailed Document Posting (Item Information) ................... 520
Custom Mapping of Accounts ............................................. 524
  Mapping Individual Item Accounts in Inventory .......................... 525
  Map QuickBooks Accounts by Department or Store ..................... 526
Changing How Vendor Billing Information is Handled ......................... 527
Customize Sales Tax Mapping ............................................. 529
Change the Order in Which Customer Names are Sent to Financial Software 530
Overview

Point of Sale offers you several ways to customize how your data is sent to QuickBooks financial software. You can:

- Switch to sending detailed item information on sales and receiving documents and/or account changes
- Map Point of Sale transactions to accounts of your choosing
- Map individual item transactions to Income, Cost of Goods Sold, and Inventory Asset accounts, and optionally, to departments and store sub-accounts, of your choosing
- Change how vendor billing information is handled
- Customize sales tax mapping
- Change the order in which customer names are sent to your financial software

Switching to Detailed Document Posting (Item Information)

By default, sales and receiving documents are sent to QuickBooks financial software in a summarized format. This streamlines Financial Exchange and presents data in a concise format. In most cases, sending summarized data is the most efficient way to transfer data.

If you prefer, you can send these documents with item descriptions for sales with charged to customer accounts only, or all receipts and vouchers. Detailed document posting provides:

- The ability to print reports or statements in your financial software showing item and customer information (such as the specific items sold or received)
- The ability to see individual sales documents in your financial software, rather than consolidated documents
- The ability to run reports or do customer mailings with customer information from receipts
- Detailed document posting DOES NOT mean that inventory information (item quantities, costs, and so forth) are sent to your financial software

We recommend you read the following section about the effects of using detailed document posting before making a change in this setting.
Switching to Detailed Document Posting (Item Information)

To switch to detailed posting of receipts and vouchers:

1. From the Point of Sale Edit menu, select **PREFERENCES ➤ COMPANY**.
2. On the Financial preferences page, select to whether to send detailed information only for sales charged to customer accounts, or to send detailed information for all receipts and vouchers.
3. Select **SAVE**.

**Important Information about Detailed Posting**

Here is how the three formats differ in how they send Point of Sale data to QuickBooks financial software:

**Sending with summarized item totals (Default):**

- Certain documents are consolidated by day. For example, all receipts paid by cash, credit/debit/gift card, and gift certificate for a particular day are consolidated and sent to your financial software as a single receipt for the total amount of sales in each type.
- Sales documents do not list individual items. Instead, items are consolidated by tax code. For example, if you have a tax code called “Tax,” the total amount of all items sold on a document that belong to that tax code are listed under an item called “POS Tax Sales.”
- Bills/credits created from vouchers do not list individual items.
- Customer information is not included on consolidated receipts (but is included on an invoice if the sale was paid by account charge).

**Sending with detailed item descriptions:**

- Receipts are never consolidated.
- Sales receipts and documents created from vouchers (bills, credits, item receipts) list individual items, including serial numbers, if recorded.
- Receipts include customer information, if the **USE WITH QUICKBOOKS** flag is selected in the customer record, regardless of the payment method.

---

*Detailed Information Applies to Certain Sales and Receiving Documents Only*

Detailed posting applies only to receipts and to bills/credits created from vouchers. If you select to send in the detailed format, other documents such as adjustment memos will still be sent in a consolidated format. Likewise, general journal transactions created for receiving vouchers will not show individual items.
Sending detailed item descriptions for documents using account payment method:

- Receipts from customer charge account transactions include customer information
- All documents that did not involve a charge to a customer account are sent in summarized format

Example:

A sales receipt sent to your financial software in summarized format is shown on the following page.

With summarized exchanges, sales amounts for sold items are consolidated into a single item described by tax code. If additional receipts were created in Point of Sale, then depending on the payment type of the receipts, the items on those receipts might also be consolidated onto the document displayed below.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
<th>QTY</th>
<th>RATE</th>
<th>AMOUNT</th>
<th>Tax</th>
</tr>
</thead>
<tbody>
<tr>
<td>POS Tax Sales</td>
<td></td>
<td></td>
<td>112.00</td>
<td>112.00</td>
<td>Tax</td>
</tr>
<tr>
<td>POS Cash</td>
<td></td>
<td></td>
<td>-112.00</td>
<td>-112.00</td>
<td></td>
</tr>
</tbody>
</table>

Here is the same receipt seen in your financial software in detailed format. The individual items on the receipt are shown.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
<th>QTY</th>
<th>RATE</th>
<th>AMOUNT</th>
<th>Tax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ceiling Fan 120W...</td>
<td>Ceiling Fan 120W USA White Large</td>
<td>1</td>
<td>89.00</td>
<td>89.00</td>
<td>Tax</td>
</tr>
<tr>
<td>Fluorescent Lig...</td>
<td>Fluorescent Lights Decorative</td>
<td>1</td>
<td>15.00</td>
<td>15.00</td>
<td>Tax</td>
</tr>
<tr>
<td>Halogen Lightb...</td>
<td>Halogen Lightbulbs 4-pack</td>
<td>1</td>
<td>8.00</td>
<td>8.00</td>
<td>Tax</td>
</tr>
<tr>
<td>POS Cash</td>
<td></td>
<td></td>
<td>-112.00</td>
<td>-112.00</td>
<td></td>
</tr>
</tbody>
</table>

Inactive Items Created in QuickBooks Financial Software for Detailed Exchanges

Before choosing to send data to your financial software in detailed format, consider the following information.

When using detailed item posting, Point of Sale creates an inactive, non-inventory item in your financial software for each item sold or received on Point of Sale documents sent to your financial software. It is these inactive items that are listed on the financial software documents created during Financial Exchanges.
An item is only created once. Subsequent appearances of the item on sent documents will not create another inactive financial software item. The graphic below is a sample financial software item list with Point of Sale-added inactive items.

These items are made inactive, non-inventory items so that they don’t show up in your default financial software item list view. This is because they are tracked in Point of Sale, not in your financial software, and you should not use them in your financial software for other purposes or edit them. These items are meant to be used solely for the purpose of detailed Financial Exchanges.

**Changing Financial Exchange Account Mappings**

If you have changed the account mappings in Point of Sale after inactive items have been created in your financial software, note that the inactive items cannot be edited by Point of Sale to reflect your new account mappings, however Point of Sale data will be posted to the new accounts. This is due to a limitation of the exchange process that does not allow editing of the account field of a financial software item after the item has been initially defined. Refer to Custom Mapping of Accounts (page 524) for more information.

**Item List Limit in QuickBooks Financial Software**

QuickBooks financial software has an item list limit, while Point of Sale does not. If you have a large inventory and you use detailed posting, there is a risk of reaching the maximum number of inventory items allowed in your financial software because of the inactive items created.

If you reach the maximum, additional new items (items that do not already have an inactive item created for them in your financial software) will be listed on documents in the default, summarized format. To free some space in your financial software item list, you can delete old or unused items. Refer to your QuickBooks financial software documentation for more information.

Alternatively, Pro and Premier Edition users may wish to consider upgrading to the Enterprise Solutions version, which approximately doubles the item list limit.
Custom Mapping of Accounts

Use this procedure in Point of Sale company preferences to map (link to) custom QuickBooks financial software accounts. You can select the accounts to which Point of Sale information will be posted. Only the accounts and payment types already defined in your financial software chart of accounts are available for selection here. If necessary, add the accounts and payment types you want to use in your financial software before continuing.

To map to custom QuickBooks financial software accounts:

1. From the Edit menu, select PREFERENCES ➤ COMPANY.
2. Select ACCOUNTS under FINANCIAL on the left of the window.

<table>
<thead>
<tr>
<th>Item type</th>
<th>Income Account</th>
<th>Cost of Goods Sold</th>
<th>Asset Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory</td>
<td>Merchandise Sales</td>
<td>▪ Cost Of Goods Sold</td>
<td>▪ Inventory Asset</td>
</tr>
<tr>
<td>Assembly</td>
<td>Merchandise Sales</td>
<td>▪ Cost Of Goods Sold</td>
<td>▪ Inventory Asset</td>
</tr>
<tr>
<td>Special Order</td>
<td>Merchandise Sales</td>
<td>▪ Cost Of Goods Sold</td>
<td>▪ Inventory Asset</td>
</tr>
<tr>
<td>Non-Inventory</td>
<td>Merchandise Sales</td>
<td>▪ Purchases - Resale Items</td>
<td>▪ Purchases - Resale Items</td>
</tr>
<tr>
<td>Service</td>
<td>Service Sales</td>
<td>▪ Subcontracted Services</td>
<td>▪ Subcontracted Services</td>
</tr>
<tr>
<td>Group</td>
<td>Not applicable</td>
<td>▪ Not applicable</td>
<td>▪ Not applicable</td>
</tr>
</tbody>
</table>

3. On the Basics tab, select an Income, Cost of Goods Sold (COGS), and Asset account for each item type.

Click in a field and then select an account from the drop-down list. All of your financial software accounts are available for selection in each field. The accounts you specify here are assigned to new items added to inventory.

You can change the accounts for individual items in inventory as needed. See the following section for more information.

You can specify sub-accounts for department and store information. Refer to Map QuickBooks Accounts by Department or Store (page 526) for more information.

Your changes will only affect items added to inventory after the changes are made. To apply your changes to your existing inventory items, select APPLY ACCOUNTS TO EXISTING ITEMS. This option globally resets the mapped accounts for all existing items in Point of Sale.
4. On the Advanced tab, for each Point of Sale field on the left, select an account from the drop-down list in the **QB Account** column.

Scroll through each list to view all of the mapping choices. All of your financial software accounts are available from the drop-down selection lists.

To reset your account mappings to the default settings, select **RESET TO DEFAULTS** on this tab.

5. Select **SAVE** to record your changes and exit preferences.

---

### Account Selection Limitations

Generally, Point of Sale does not place limitations on the QuickBooks financial software account types you can map for item Income, COGS (costs), and Asset amounts, with exceptions as listed below. You have the same freedom in account usage as you have in your financial software.

Exceptions: You cannot map item income to Sales Tax Payable, Accounts Payable, Accounts Receivable, Undeposited Funds, or Non-Posting account types.

Mapping to accounts other than Income, COGS, and Asset types may produce unusual results, but can be beneficial. For example, you may want to map costs associated with Point of Sale service and non-inventory items to an expense account if you pay an outside vendor for those services.

---

### Mapping Individual Item Accounts in Inventory

The item account mapping preferences set above are assigned to new items as they are added to inventory. This increases the efficiency with which you can add a new item. However, there may be circumstances under which you want sales and costs for individual items to be posted to accounts other than the defaults.

Use the following procedure to assign different Income, COGS, and Asset accounts on an item-by-item basis.
To map an individual item to different QuickBooks financial software accounts:

1. From your Point of Sale item list, highlight the item you are changing and then select EDIT from the window toolbar.
2. Select the ADDITIONAL INFO tab on the item form.
3. Select new accounts from the drop-down lists.
4. Select SAVE.

Your new account mappings will go into effect on the next conducted Financial Exchange.

Map QuickBooks Accounts by Department or Store

If desired, you can map to QuickBooks financial software sub-accounts according to department. This is a preference that is set in Company Preferences under FINANCIAL ACCOUNTS.

- **Automatically create sub-accounts based on.** When this option is set, default item accounts will be appended with sub-accounts. For example, a service item might normally default to the “Service Sales” income account based upon its type, but when assigned to the Clothing department it would be defaulted to “Service Sales: Clothing.”
Changing How Vendor Billing Information is Handled

In the first drop-down, specify what sub-accounts are based on:

- Department (default)
- Store, then department (Multi-Store only)
- Department, then store (Multi-Store only)

When store and department are used, they are each a level of hierarchy (stores under departments or departments under stores).

In the second drop-down, specify which item accounts to create sub-accounts for:

- Income, COGS and asset
- Income accounts only (default)

These determine whether the sub-accounts will be created for all accounts (income, COGS, and asset) or just for income accounts.

When sub-accounts are being used, this will be indicated in the item record.

---

Changing How Vendor Billing Information is Handled

You can enter vendor billing information for merchandise purchases in QuickBooks financial software or on receiving vouchers in Point of Sale. With either option, you actually pay the vendor bills in your financial software. This setting controls how the vouchers created in Point of Sale become a bill in your financial software Accounts Payable account.

Entering in QuickBooks Financial Software may Cause Discrepancy with Point of Sale

If the vendor billing information received and entered in your financial software includes charges or adjustments not entered on the original voucher in Point of Sale, such as freight charges, discounts, or fees, there will be a difference between the documents in the two programs. This is normal, but should be kept in mind if comparing purchasing reports.
To change where vendor billing information is entered:

1. From the Point of Sale Edit menu, select **PREFERENCES ➤ COMPANY**.
2. On the Receiving preferences page, select the checkbox to **ENTER BILLING INFORMATION IN POINT OF SALE** or clear the checkbox if you want to enter billing information in QuickBooks financial software.
3. Select **SAVE**.

**If you elect to enter billing information in QuickBooks financial software:**

Use this option if you prefer to handle all vendor billing tasks in your financial software. This is the default setting for new Point of Sale users.

- The vendor billing fields (payee, terms, bill date, invoice/reference #) are not available on the voucher form in Point of Sale.
- All vouchers are sent immediately to your financial software as item receipts.
- When the billing information is received from the vendor, enter it in your financial software and the item receipt is converted to a bill in Accounts Payable.

**If you elect to enter billing information in Point of Sale:**

- The vendor billing fields (payee, terms, bill date, invoice/reference #) are added to the voucher form in Point of Sale.

- When the billing information is received from the vendor, edit the voucher to enter the billing information along with any freight charges or fees.
- Depending on whether billing information (Invoice/Ref#) has been entered:
  - If billing information is received and entered when the voucher is created, the voucher is sent directly to Accounts payable as a bill.
  - If billing information has not been entered, the voucher is sent to the Unbilled Purchases liability account. When billing information is entered later in Point of Sale, the voucher is sent a second time as a bill to Accounts Payable and removed from the Unbilled Purchases account.
  - If the **ALREADY PAID** checkbox is selected, whether billing information is entered or not, the voucher is sent as an item receipt. This option can be used, for example, if the merchandise has been prepaid for with a credit card or cash.
Customize Sales Tax Mapping

Sales tax amounts collected in Point of Sale are sent to QuickBooks financial software according to the sale tax mappings specified for each Point of Sale tax code used. Tax codes and the financial software tax mappings used by Point of Sale are defined on the Sales Tax page of company preferences.

In order to post sales tax properly in your financial software, there must be corresponding tax items and codes in your financial software. If necessary, Point of Sale will automatically create these items and codes in your financial software.

In some circumstances, such as when you want to use sales tax groups in your financial software, you may want to set up your own sales tax groups in your financial software and then map Point of Sale’s tax codes to those tax groups. Point of Sale cannot automatically create sales tax groups in your financial software.

To custom map sales tax to QuickBooks financial software:

1. In Point of Sale, select PREFERENCES ➤ COMPANY from the Edit menu, then choose SALES TAX from the list on the left.
2. Select EDIT TAX CODE or ADD TAX CODE as appropriate. The Edit Tax Code wizard is opened.

3. Ensure the information entered on the first page of the wizard is correct, then choose NEXT.
4. If necessary, enter the tax rate and agency at the top of the second page.
Refer to **Sales Tax Codes and Locations (page 340)** for instructions on setting up your Point of Sale tax codes.

5. In the QuickBooks Tax Info section, select the appropriate QuickBooks financial software tax item/group and tax code from the drop-down lists.

6. Select **FINISH** to exit the wizard.

If this same tax code already exists in other Point of Sale tax locations and you want to apply the same changes, repeat to edit the tax code in each location, or leave blank and Point of Sale will map to the QuickBooks tax items/codes of the same name as the Point of Sale tax code name, creating the items/codes in your financial software as needed.

7. When done, select **SAVE** to record your preference changes.

### Change the Order in Which Customer Names are Sent to Financial Software

If you have edited the Customer Full Name field in your financial software to be in a different order than the default, you can change this setting in Point of Sale so names are sent in the same order.

This setting affects how customer name is sent to this field.

These fields are the same in both programs.

To change the customer name order:

1. From the Point of Sale Edit menu, select **PREFERENCES ➤ COMPANY**.
2. On the Financial preferences page, select one of the three name order options.
3. Select **SAVE**.
## Section VIII: Point of Sale for Multiple Stores

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>Multi-Store Basics</td>
<td>533</td>
</tr>
<tr>
<td>32</td>
<td>Managing a Multi-Store Inventory</td>
<td>545</td>
</tr>
<tr>
<td>33</td>
<td>Exchanging Store Information</td>
<td>561</td>
</tr>
</tbody>
</table>
Chapter 31  Multi-Store Basics

Multi-Store Overview ......................................................... 534
Choosing a Headquarters Store ........................................... 535
Company Preferences ....................................................... 536
Employees & Security ....................................................... 536
Working with Customers ................................................... 537
Recording Sales .............................................................. 537
  Sales History ................................................................. 538
Using the Merchant and Gift Card Services in a Multi-Store Environment .... 539
Customer Orders ............................................................ 539
Multi-Store Reporting ....................................................... 539
Program Updates ............................................................ 540
Multi-Store Financial Exchange .......................................... 541
  Store Tracking and Profit/Loss Reporting by Class .................... 541
Allowed Activities by Store Type ........................................ 542
Chapter 31: Multi-Store Basics

Multi-Store Overview

Pro Multi-Store users have access to all the features in Point of Sale Basic and Pro, although activities may be restricted or work slightly differently depending on whether you are the Headquarters or a remote store. Pro Multi-Store users also have additional capabilities, such as transfers of merchandise between stores, the exchange of information between stores, and company reporting. This chapter presents information unique to multi-store users. Refer to the individual chapters related to a feature for basic instructions on using that feature.

With Point of Sale Pro Multi-Store, you can effectively manage up to ten stores with centralized inventory control and purchasing, and company-wide reporting. At a glance, one store can view the quantities available at all other stores, thus minimizing lost sales due to out-of-stock situations.

One store is designated as the Headquarters (Store 1). Headquarters maintains central control over inventory, creates purchase orders, defines company-wide program preferences, exchanges data with QuickBooks, and can run reports that include the activities at all stores. Headquarters also carries on normal store activities, such as receiving merchandise, capturing customer information, and making sales.

Stores 2-10 (called remote stores) receive and sell merchandise, capture customer information, transfer items as necessary to other stores, and run local store reports. Shown below is a typical 2-store configuration.
At the end of the business day, each remote store runs its normal End of Day procedure, including settling its own credit card transactions. Included in the End of Day process is a Store Exchange procedure by which remote stores send their daily information to Headquarters. Headquarters processes the exchange files it receives from the remote stores, updates inventory and related records with the day's activities, exchanges data with QuickBooks, and then sends updated company information back to the remote stores.

<table>
<thead>
<tr>
<th>Headquarters Store (Store 1)</th>
<th>Remote Stores (Stores 2 – 10)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performs typical store activities, plus manages:</td>
<td>Performs typical store activities to:</td>
</tr>
<tr>
<td>• Inventory and related information</td>
<td>• Receive and sell merchandise</td>
</tr>
<tr>
<td>• Purchasing</td>
<td>• Capture customer information</td>
</tr>
<tr>
<td>• Company-wide program preferences</td>
<td>• Transfer items to other stores</td>
</tr>
<tr>
<td>• Company reporting &amp; financial records</td>
<td>• Define employees and security</td>
</tr>
</tbody>
</table>

At the end of the business day, each remote store runs its normal End of Day procedure, including settling its own credit card transactions. Included in the End of Day process is a Store Exchange procedure by which remote stores send their daily information to Headquarters. Headquarters processes the exchange files it receives from the remote stores, updates inventory and related records with the day's activities, exchanges data with QuickBooks, and then sends updated company information back to the remote stores.

**Choosing a Headquarters Store**

The choice of a Headquarters store is important because in addition to performing all of the activities of a typical store, only Headquarters can:

- Add, edit, or delete inventory items and related information, such as departments and vendors; all stores share one item list
- Create purchase orders*
- Consolidate data for the entire company and run company reports; remote stores can run and view local reports only
- Exchange information with QuickBooks Financial Software
- Create documents on behalf of other stores, allowing Headquarters—where management and finance personnel are typically located—to correct or adjust transactions on behalf of remote stores

*The exception to this is for special order items, which can be created and ordered at remote stores.

Follow the instructions in the *Point of Sale QuickStart Guide* to install and configure Headquarters and remote stores.
Company Preferences

Shared company preferences that affect all stores are defined at Headquarters only. At remote stores, these shared preferences are not available for editing in the Setup Interview or on the company preferences pages. Shared preferences include price levels, sales tax codes and locations, deposit requirements for customer orders, store codes and headings, and miscellaneous other controls. You will want to explore the Multi-Store preference pages and make the needed adjustments to setting them up to fit your specific needs.

Store-specific company preferences, such as receipt and customer messages, and the default tax location, price, and payment type used for sales, can be set at each store independently. Workstation preferences can be set independently by each workstation in each store.

The exchange of company preferences is one way, from Headquarters to remote stores, and includes only the shared preferences. The shared company preferences at a remote store are overwritten by the Headquarters file with every exchange.

Employees & Security

Employee records and security rights are added independently at each store and are not exchanged.

Headquarters can run reports on commissions, employee hours and non-cash tips based upon information in remote store transaction documents and Time Clock entries.

If identical employee names are found between different stores, it is assumed that these are the same people and the information will be combined. If two different employees have the same first and last name, you should make a change to one of the employees so that the names are not identical. For example, you may wish to include the middle initial in the first name of one of the name entries. This is especially important if you are tracking hours worked and sending them to your QuickBooks financial software for payroll purposes.
Working with Customers

Customers can be added, edited, or deleted at any store, with the resulting changes propagated to all stores with the next fully completed Store Exchange with Headquarters. Headquarters maintains the master customer list, which is updated with data received from the remote stores, and this updated list is sent to all stores during each Store Exchange.

General guidelines for customers:

- Any store can add, edit, or delete a customer, but the customer record is not revised in the master file at Headquarters until certain synchronization checks are completed during the next Store Exchange cycle.
- Adding, editing, or deleting a customer “flags” the customer record with the action taken and adds a date/time stamp at the originating store. This date/time stamp is used in synchronization checks to ensure proper handling of customer records in the event that the same customer record is edited at multiple stores on a given day.
- If a customer is a charge account customer with an account balance, deletion is not allowed.
- If a store makes a charge account sale or accepts a payment on a customer account, Headquarters sends that information to QuickBooks after receiving it from the remote store (only Headquarters exchanges data with QuickBooks).

Refer to Chapter 18 Customer Records and History (page 303) for basic information about working with customers.

Recording Sales

All sales and return receipt features are available at all stores. In addition, Headquarters can create receipts for any other store. Remote stores can make receipts only for their own store.

The Store field is added to the receipt form for multi-store operations. Headquarters creates receipts to sell or return merchandise for other stores by changing the store code in this field. Receipts made by Headquarters on behalf of another store update that store’s item quantities, but the receipt is not sent to the remote store and, therefore, the sale is not reflected in the remote store’s sales history.
Each store (Headquarters and remote) can setup, process, and settle credit, debit/ATM, and gift card transactions locally, but each must have its own account with the QuickBooks POS Merchant and/or Gift Card Services. Store-specific company preferences related to sales, such as allowed credit card types, default payment method, default sales tax location, and printed receipt comments can be selected at each store from the options defined by Headquarters.

Sales History

Each store maintains its own sales history for receipts made at that store. Headquarters also has the receipts made at all stores in its sales history, allowing it to run company sales reports and view a customer’s history with the entire company.

Reversing Receipts

Headquarters can reverse receipts made at any store. Remote stores can reverse a receipt only up until the time it is sent to Headquarters via Store Exchange. Once sent, a receipt can only be reversed at Headquarters.

Remote stores, however, have two options for correcting a receipt after it has been sent to Headquarters. You should take only one of these actions.

- At the remote store, create a return receipt listing the same customer, items, prices, quantities, and so forth, as the original. The new return receipt will cancel the effect of the original, and update both the sales history and inventory at both Headquarters and remote store. A new sales receipt can then be made with the correct information, if necessary, to record the merchandise that was actually sold.

- Contact Headquarters and have them reverse the receipt there. This will correct inventory at all stores and sales history at Headquarters, but will not correct the local sales history at the remote store. A new, corrected receipt can then be made at either store.

To quickly make a return receipt from the original sales receipt:

1. Locate the original receipt in your sales history.
2. Select COPY RECEIPT.
3. From the I Want To menu, select CHANGE TO RETURN and then save.
   You can also then copy the original again, make changes, and save as a quick way to make a new, corrected sales receipt.

Refer to Chapter 19 Sales and Tax Overview (page 329) for basic information about recording sales and working in sales history.
Using the Merchant and Gift Card Services in a Multi-Store Environment

With multiple physical locations under the same ownership, you can add additional Merchant and Gift Card Service accounts under a single Master Merchant account of each type. Each store would process transactions independently but with linked accounts, the master account would receive consolidated reporting and account statements.

If exchanging data with QuickBooks Financial Software 2008, your credit and debit card transactions are grouped on the Payments to Deposit window by merchant number (store) and settlement batch, helping you more easily reconcile the transactions with your bank deposits.

For more information, contact the QuickBooks POS Merchant and/or Gift Card Services support at 800-558-9558.

Customer Orders

Layaways, sales orders, and work orders can be created and maintained at all stores, but are not exchanged between Headquarters and remote stores. However, Headquarters does receive the information from remote stores for calculation of available quantities. The available quantity information is sent back to the remote stores. Each store maintains its own customer orders and creates deposit and sales receipts to fill them. The receipts created when taking deposits and selling customer order items are sent to Headquarters during routine Store Exchanges.

Each store can define its own printed customer order messages in company preferences, however Headquarters defines any required initial deposit amounts.

Refer to Chapter 23 Sales Orders, Work Orders and Layaways (Pro) (page 415) for basic information about creating and filling customer orders.

Multi-Store Reporting

Headquarters can run reports for any one store, a selected group of stores, or the entire company, while remote stores can only run reports for the activities at their own store.

When running reports at Headquarters, simply use the MODIFY REPORT ➤ FILTERS option to specify the store(s) to be included in the report. Drawer Count Reports (Z-Out) are the only reports sent from remote stores to Headquarters.
Transfer Reports. Transfer reports detail the movement of merchandise between stores. These reports are available at both Headquarters and remote stores and are located under the Items report category in the Report Center.

Store Inventory Summary. Located under the Items reports category, this report can provide on-hand merchandise information for your stores. Available at all stores.

Store Sales Reports. Located under the Sales report category, these reports can include summary or item sales information for all stores, and provide store comparisons. These multi-store reports are available only at Headquarters (remote stores have access to all other sales reports for their store).

Drawer Count Reports (Z-Out). Drawer Count reports are included in the mailbag sent from remote stores to Headquarters. Headquarters can view these reports by selecting VIEW DRAWER COUNT HISTORY from the Reports menu, and then have options to print or export to Excel.

Employee Reports. Reports for tips and commissions are taken from transaction documents, and reports for employee hours are taken from Time Clock entries.

Profit/Loss Reports by Class in QuickBooks. See next section.

Documents Created at Headquarters for Remote Stores Not Reflected in Remote History Reports

When Headquarters creates a document on behalf of a remote store, that document is never sent to the remote store (although the change in store quantity is sent). Since the document is not added to the remote store’s document history file, any reports ran at the remote that draw from those history files will not include the document. Reports run at a remote store that draw their information from inventory are not affected. Since all transactional documents are recorded at Headquarters, no matter where they were made, reports run at Headquarters will include all company transactions (current as of the last Store Exchange).

Program Updates

Program updates can be downloaded and installed by each store. If program updates are available, they should be installed at all stores, and all workstations within a store, to maintain compatibility.

Refer to Updating QuickBooks Point of Sale (page 12) for more information.
Multi-Store Financial Exchange

Only Headquarters exchanges data with QuickBooks. Typically this is done after Headquarters has received and processed in all mailbags from remote stores for the day. The basic procedure for conducting Financial Exchanges in a multi-store configuration is the same as for a single store and is covered in Chapter 28 Conducting Daily Financial Exchanges (page 487). This section covers Financial Exchange procedures unique to a multi-store operation.

Store Tracking and Profit/Loss Reporting by Class

Pro Multi-Store users who also use QuickBooks can run P/L (Profit/Loss) reports for each store as well as the entire company in QuickBooks, by assigning a QuickBooks class to each store.

To use this store-tracking feature you must enable the class tracking preference in both Point of Sale and QuickBooks. Point of Sale will automatically create, link, and send store information using classes named Store 1, Store 2, and so forth.

To enable tracking by class in QuickBooks:

1. From the Edit menu, select PREFERENCES.
2. Select ACCOUNTING, and then COMPANY in the Preferences window.
3. Select the checkbox for USE CLASS TRACKING.
4. Select OK.

During the next Financial Exchange, the classes you assigned to stores in Point of Sale are added to your class list in QuickBooks. As transactions are posted to QuickBooks at Headquarters, QuickBooks categorizes them according to the assigned class.

You can run a report in QuickBooks Financial Software by class to see the Profit/Loss for any store by filtering the report by class. To see the Profit/Loss for all stores at once, run an Unclassified Report.
## Allowed Activities by Store Type

This is not an all-inclusive list of Point of Sale features. It is intended primarily to point out where differences exist between allowed activities at remote stores and Headquarters.

<table>
<thead>
<tr>
<th>Area/Function</th>
<th>Store 1 - HQ</th>
<th>Remote Stores</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inventory</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Item on-Hand Quantities and Information</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View Item History</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Create/Edit/Copy/Delete Items and Styles</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Create Special Order Items</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Convert Special Order Items to Inventory Items</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Enter/Edit Costs, Prices, Tax Codes and other Item Information</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Define Assembly Item Components</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Build/Break Assemblies</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Define Group Items</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Sell Group Items</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View Inventory Reminders: New Items, Price Changes</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View Inventory Reminders: Reorder Items, Duplicate Items</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View Department Information</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create/Edit/Copy/Delete Departments</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>View Vendor Information</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create/Edit/Copy/Delete Vendors</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Merge Vendors</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Define Multi-Vendors for Items</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Perform and Update Physical Inventory for Local Store</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Perform and Update Physical Inventory for other Stores</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Print Tags</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Use Price Manager</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Manually Create Quantity Adjustment Memos</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Manually Create Cost Adjustment Memos</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Put Adjustment Memo on Hold</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View/Copy/Reverse Memos</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create Transfer Slips (Remote restricted to transfers out of store)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Area/Function</td>
<td>Store 1 - HQ</td>
<td>Remote Stores</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>--------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Create Transfer Slips for other Stores</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Put Transfer Slip on Hold</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View/Copy/Reverse Transfer Slips</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Purchasing and Receiving</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Purchase Orders (for all stores)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Generate POs for Special Order Items</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View Purchase Orders for Local Store</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View Purchase Orders for Other Stores</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Delete Filled Purchase Orders</td>
<td>X</td>
<td>Special Order POs only</td>
</tr>
<tr>
<td>E-mail Purchase Orders to Vendor</td>
<td>X</td>
<td>Special Order POs only</td>
</tr>
<tr>
<td>Create Receiving Voucher for Local Store</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create Receiving Voucher by Referencing Purchase Order</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create Receiving Voucher for Other Stores</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Put Receiving Voucher on Hold</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View/Copy/Reverse Vouchers</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Sales</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Sales and Return Receipts for Local Store</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create Sales and Return Receipts for Other Stores</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Put Receipts on Hold</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Accept all Payment Methods</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Authorize and Settle Credit Card Transactions</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Authorize Debit/ATM Transactions</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Sell/Redeem Gift Cards</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Track Employee Sales Commissions</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View/Copy/Reverse Receipts</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Print Gift Receipts</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Print Store Logo on Sales Documents</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Customer Orders</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Customer Orders for Local Store</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create Special Order Items from Customer Orders</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Define Initial Deposit Requirements</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Sell Customer Order Items for Local Store</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Delete Filled Customer Orders</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### Area/Function

<table>
<thead>
<tr>
<th>Area/Function</th>
<th>Store 1 - HQ</th>
<th>Remote Stores</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Customers</strong></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Add/edit/delete Customers</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Offer Customer Charge Accounts (Use with QuickBooks)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Track/Use Shipping Information</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>View Customer History</td>
<td>Local Sales Only</td>
<td></td>
</tr>
<tr>
<td>Merge Customers</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

#### Define Company Preferences for:

| Financial                                         | X            |
| Merchant Service                                  | X            | X             |
| General                                           | X            | X             |
| Multi-Store (change store type)                   | X            | X             |
| Store Exchange                                    | X            | Local settings only |
| Store Headings                                    | X            | Local settings only |
| Price Levels                                      | X            | Default price only |
| Purchase & Receiving                              | X            | X             |
| Sales > Receipts                                  | X            | Limited       |
| Customers                                         | X            |
| Customer Orders                                  | X            | Limited       |
| Sales Tax Locations/Codes                         | X            | Default tax location only |
| Select Local Default Tax Location                 | X            | X             |
| Scales                                            | X            |
| Auto Update                                       | X            | X             |

#### Define Workstation Preferences for:

| All Local W/S Settings                           | X            | X             |

#### Miscellaneous

| Serial Number Tracking                           | X            | X             |
| Define/Edit Security Groups and Rights for Local Store | X            | X             |
| Add Employees for Local Store Only               | X            | X             |
| Run Reports and Sales Charts for Other/All Stores | X            |               |
| View/Print/Export Z-Outs from All Stores         | X            |
| Get Program Updates                              | X            | X             |
| Run Local Reports                                | X            | X             |
| Conduct Pay-Outs                                 | X            | X             |
| Customize List Columns                           | X            | X             |
| Remove Unused Features                           | X            | X             |
Chapter 32  Managing a Multi-Store Inventory

Defining Inventory .................................................. 546
Entering Store Quantities ........................................ 546
Handling Item Costs and Prices ................................. 547
Communicating New Items to Remote Stores ............. 548
Assembly and Group Items ...................................... 549
Handling Special Order Items ................................. 549
Duplicate Item Reminders ........................................ 550
  Editing Duplicate Inventory Items ......................... 551
  Merging Duplicate Inventory Items ....................... 551
Viewing Item Quantities at Other Stores .................... 553
  Adjusting Quantities ........................................... 553
Physical Inventory .................................................. 554
Purchasing and Receiving ....................................... 554
Receiving History .................................................. 555
Transferring Merchandise between Stores ................. 557
  Transfer Slip Overview .................................. 557
  Creating a Transfer Slip .................................. 557
  Holding/Un-holding a Transfer Slip .................... 558
Working with Transfer History ................................ 559
  Locating a Transfer Slip ................................ 559
  Copying a Transfer Slip to Create a New One .......... 559
  Reversing a Transfer Slip ................................ 560
Defining Inventory

Inventory items and related records (departments, vendors, costs, prices, etc.) can only be added or edited at Headquarters, with the exception of special order items (discussed later in this chapter). Remote stores can view this information and use it to create documents, but cannot make changes. The combined item quantities at all stores comprise a single inventory, with Headquarters having central control over that inventory. Point of Sale tracks the quantities located at each store within that inventory.

Entering Store Quantities

When initially setting up inventory, Headquarters enters existing item quantities for itself and for remote stores.

To enter existing item quantities for each store:

1. Select ADD NEW in inventory to add the item. Follow the basic instructions in Adding Inventory Items (page 164) to define the item.
2. Select AVAILABLE in the Quantity section of the item form.
3. Select ON HAND in the drop-down list at the top of the store list.
4. Enter the starting (on-hand) quantity for each of your stores.
5. Select CLOSE.
6. Make other changes on the item record as needed and select **SAVE**.

The Available Quantities window can be used in the future to view all quantity information about an item: on-hand, on-order, committed to customer orders, and a listing of all pending documents affecting the item, for any store. You can initiate the creation of documents to order, transfer, receive, or sell the item from the I Want To menu on this window.

This window is valuable for seeing if an item is in-stock at any other store when you run out and if the item is on order.

**Entering Style Item Quantities**

If you use item styles, you can enter existing quantities for all items in a style at one time by viewing the style, changing the store in the **Quantities for Store** drop-down list and then entering quantities for each style item for the selected store. Repeat for each store. **Refer to Style Grid Basics (page 214) for more information.**

**Importing Item Quantities**

If you have or can get your existing inventory items into an Excel spreadsheet or comma-delimited text file, the Data Import Wizard can be used to not only add those items to inventory but also to enter the existing quantities at each store. Point of Sale includes a pre-defined data import Excel template you can use if you don’t have your own. **Refer to The Data Import Wizard (page 124) for more information about this tool.**

**Handling Item Costs and Prices**

Item costs are averaged, as receiving vouchers are updated/received at Headquarters. Headquarters defines item prices and markdown price levels. Remote stores cannot enter or edit costs or prices; therefore, cost adjustment memos are only available at Headquarters. However, remote stores can choose the default price used on receipts and customer orders.

*Exceptions:* Also, when a remote store builds or breaks an assembly item, cost memos are automatically created and sent to Headquarters.

**Communicating Price Changes to Remote Stores**

Price changes are implemented at Headquarters and communicated to remote stores using the Reminders feature. Remote stores can display the price changes made at Headquarters and print updated tags directly from the Reminders window.
Chapter 32: Managing a Multi-Store Inventory

To view the price changes list:
1. From the Inventory menu, select **REMINDERS**.
2. Select the **PRICE CHANGES** tab.

To print updated price tags:
1. Select the item for which you want to print tags. If you want to print tags for more than one of the displayed items, you can use the multi-select feature to select multiple items by holding down the `<CTRL>` key while selecting the items. See **Selecting multiple records (page 102)** for more information on using the multi-select feature.
2. From the Print menu, select **PRINT TAGS**. Follow the on-screen prompts to specify tag printing option and send the tags to your printer.

Refer to **Using Inventory Reminders (page 142)** for general information about Inventory Reminders.

**Price Manager**

If Price Manager is used to change prices or set up price discounting, remote stores can view the Price Manager records and print markdown or discount price tags, but they cannot create or edit these records.

Refer to **Printing Tags and Labels (page 43)** for detailed tag printing instructions.

**Communicating New Items to Remote Stores**

When Headquarters adds new items to inventory, they show up on the New Items Reminders screen at remote stores after the next completed Store Exchange.

This feature alerts remote stores to prepare the store for the arrival of these items. The new items list and price tags can be printed, and associates can better serve customers by letting them know what new merchandise is coming soon. The items on this list should be removed as they arrive at the store so that the list remains current and useful.
Defining Inventory

To view new item reminders:

1. From the Inventory menu, select REMINDERS.
2. Select the New Items tab on the Reminders window.

Refer to New Items Reminder (Pro) (page 144) for more information on using this feature.

Assembly and Group Items

Only Headquarters can define assembly and group items, but remote stores can build and break assemblies as necessary to meet local sales demand (building is limited to the quantities of the component items on hand at the remote store). When a remote store builds or breaks an assembly item, quantity and cost adjustment memos are automatically created and sent to Headquarters in the next Store Exchange. Refer to Chapter 13 Item Styles, Assemblies, and Groups (Pro) (page 211) for more information about working with assembly and group items.

Handling Special Order Items

Both Headquarters and remote stores can create special order items from documents, generate purchase orders to obtain them from vendors, receive them on vouchers, and sell them on receipts.

When a remote store first lists a special order item on a transactional document, it is sent to Headquarters. Headquarters can review special order items and convert them to regular inventory items, if needed. The new inventory items are then sent to all remote stores with the next Store Exchange, making them available for normal retail transactions.

When creating the special order item, the remote store can only temporarily define all the item fields for use on local documents. However, when the special order item is received at Headquarters, the following fields are not populated with information from the remote and must be redefined by Headquarters:

- MSRP (reference price)
- Prices at all price levels
- Order Cost
- Reorder point
- Tax Code
- Un-orderable Flag

On the next Store Exchange, the new values entered at Headquarters will overwrite the item information at the remote store that created the item in your item list as well as being made available at all other stores.
Duplicate Item Reminders

Resolving Duplicate Items (Headquarters)

Duplicate items can occur for a couple of different reasons.

When Headquarters edits an item number but a remote store sells the item before receiving the updated inventory file during a Store Exchange. When the transactional document is sent to Headquarters the item identifier from the remote store will not match the item number for the same item at Headquarters. Headquarters will show two separate item numbers as having duplicate item identifiers.

Duplicate items can also occur when remote stores create a special order item, unknowingly entering the same UPC or Alternate Lookup (ALU) value as an existing item. The special order items are sent to Headquarters from remote stores on the first transactional document containing them.

The Duplicate Items tab on the Reminders window can help you to identify duplicates and resolve them to keep your inventory accurate. This Reminder window is available only at Headquarters.

Duplicate items are grouped and color-banded, with the duplicate information in bold (UPC in this example) to help you identify them.

To view the duplicate items list:

1. From the Inventory menu, select REMINDERS.
2. Select the DUPLICATE ITEMS tab.


**Defining Inventory**

**Editing Duplicate Inventory Items**

If the items shown as duplicates are actually separate and distinct items, you will need to edit at least one of the items to correct the duplicate values.

**To edit duplicate items:**

1. From the Duplicate Items Reminder screen, select the item you wish to edit and then select **EDIT ITEM IN INVENTORY** from the I Want To menu.
   
   This selection takes you the item form in edit mode.

2. Use normal editing procedures to correct the duplicate values and then save.

After Headquarters resolves the duplicates, updated item information is sent to remote stores with the next Store Exchange. *Refer to Using Inventory Reminders (page 142) for general information about Reminders.*

**Merging Duplicate Inventory Items**

If the items shown as duplicate are actually separate entries for the same item, you can to merge the duplicate items.

For more detailed information on merging items, refer to *Merging Item Records (page 178).*

**To merge duplicate items:**

1. From the Duplicate Items tabbed panel in the Reminders window, select two duplicate items.

2. Select **MERGE INVENTORY ITEMS** from the I Want To menu.

3. Ensure that the items displayed in the Merge Items dialog are the correct items.
   
   You can use the **SWAP** button to change which item record you will keep. You can
also use the drop-down list to navigate to other items if one or more of the displayed items is not correct.

4. Select **MERGE ITEMS**.
A confirmation dialog will be displayed, showing the various documents and records that will be affected by the merge.

5. Select **MERGE ITEMS**.

**Merging Duplicate Items from the Item List**
You can also merge items from the item list by selecting **MERGE INVENTORY ITEMS** from the I Want To menu. Refer to **Merging Item Records (page 178)** for more information on merging items from the item list.
Viewing Item Quantities at Other Stores

Each store can view item quantities at each other store, accurate as of the last successful Store Exchange by all remote stores with Headquarters. Refer to Entering Store Quantities (page 546) for instruction to view item quantities from inventory.

---

Tip: Viewing Store Quantities While Making a Document

Each store can also quickly see the quantities on-hand at other stores while creating a document. List the item on the document and then select EDIT ITEM (F5). The Item Information window includes quantities at each store.

If one store runs out of an item, a cashier can quickly look to see if another store has the item in stock, the oh-hand quantity, on order quantity and the available quantity. Typically, a follow-up phone call is made to confirm that the item is available and to have the item set aside. At this point, the first store can either send the customer to the second store or arrange for the second store to transfer the item to them, in which case the customer can purchase it when it arrives. The second store or Headquarters makes a transfer slip to move the item. Refer to Transferring Merchandise between Stores (page 557) for more information on using transfer slips.

---

The Importance of Store Exchange Sequencing to Viewing Store Quantities

The item quantities viewed for other stores will only be as current as the last completed Store Exchange between remote stores and Headquarters. To ensure that current quantities are displayed for other stores, it is recommended you follow the Store Exchange sequencing suggested in the Chapter 33 Exchanging Store Information (page 561) section of this chapter, i.e. each remote store sends a mailbag to Headquarters as part of its End of Day procedure. Following the recommended sequence ensures that each store begins each day with updated inventory information.

---

Adjusting Quantities

Item quantities can be adjusted at either Headquarters or remote stores, using adjustment memos. Headquarters can adjust quantities for any store, while remote stores can adjust only their own local quantities. Refer to Adjusting Item Costs and Quantities (page 243) for more information about adjustment memos.

---

Automatic Quantity Corrections at Remote Stores

If a remote store creates new transactional documents (receipts, vouchers, adjustment memos, or transfer slips) between sending a Store Exchange file to Headquarters and getting one back, it adjusts the inventory quantities received back from Headquarters to reflect those new documents. In this way, it always has the most current item quantities for its own store.
For example, at the time an exchange mailbag is sent to Headquarters the on-hand quantity of Item #25 is nine (9). Before getting back a mailbag from Headquarters, the remote store sells two more of the item, reducing the on-hand quantity to seven (7). When the Headquarters mailbag arrives and is processed, the inventory quantity is overwritten with the Headquarters information, i.e., back to nine. The remote store will then readjust inventory for the transactions made in the interim, setting its on-hand quantity for the item back to seven (7).

**Physical Inventory**

Remote stores can do local physical inventories. When they update their physical counts, quantity adjustment memos are automatically created and then sent to Headquarters during the next Store Exchange. Headquarters can create and update a physical count for any store. Refer to Conducting Physical Inventory Counts (page 232) for more information about completing a physical count.

**Purchasing and Receiving**

Typically, all purchase orders (POs) are created at Headquarters. The exception to this is that a remote store can generate a purchase order for a special order item. When a remote store receives a Store Exchange mailbag from Headquarters, only the purchase orders destined for that store are copied to the remote store's purchase order list. The purchase orders received from Headquarters overwrite the purchase orders at the store. (Special order purchase orders at remotes are not overwritten, nor are they sent to Headquarters.)

Each store can reference its own purchase orders as it makes receiving vouchers to receive the ordered merchandise into inventory. A receiving voucher updates the fill status of the purchase order both at the local store and at Headquarters, once Store Exchange is run to send the receiving voucher(s).

Remote stores cannot edit or delete purchase orders, except for the special order purchase orders they create themselves. Once a purchase order that was created by Headquarters is filled, Headquarters can delete it, in which case it will be removed from the active purchase order list at the remote store on the next Store Exchange. Since the purchase orders from Headquarters overwrite the remote's purchase orders, the filled purchase order will automatically be removed at the remote store. Likewise, any modifications to a purchase order at Headquarters automatically causes the purchase order to be re-sent to the remote store.
To create a purchase order at Headquarters:

1. Create the purchase order in the manner described in Chapter 16 Purchasing Merchandise (page 265).
2. Specify Ship To (where the vendor will ship the items) and Bill To (where the vendor will send the invoice) stores in the appropriate fields.
3. Select SAVE.

The purchase order is saved to your purchase order list. When you run your next Store Exchange, the specified store will be sent this purchase order, making it available for referencing as receiving vouchers are made at the remote.

A purchase order can indicate only one Ship To store, but can request billing to a different store (such as to Headquarters). If you want to order quantities for all stores you must either make a separate purchase order for each store or make one purchase order for the entire quantity, receive that entire quantity at one store, and then transfer the merchandise to the other stores as needed.

A good practice at Headquarters is to regularly review your purchase order list and delete the purchase orders that have been filled (status of CLOSED). Deleting a purchase order at Headquarters not only removes the purchase order from the list at Headquarters, but also at remote stores after the next Financial Exchange. Your receiving vouchers provide a permanent record of merchandise received.

**Tip: Instill Good Receiving Practices at Remote Stores**

Remote stores should always reference purchase order numbers when creating receiving vouchers if the received merchandise was ordered on a purchase order. This not only speeds the process of creating the voucher, it also ensures that the purchase order fill status is properly updated at Headquarters and that the proper order cost is carried to the receiving voucher. This will facilitate accurate and timely updating of your inventory cost and tracking of purchased merchandise.

---

**Receiving History**

**Editing and Reversing Vouchers**

Remote stores cannot edit receiving vouchers after saving and can only reverse a voucher before it has been sent to Headquarters. Headquarters can edit (vendor billing information, freight, fee, and discount fields only) and reverse a voucher without restrictions.
To correct a voucher at a remote store after it has been sent to Headquarters:

Remote stores have two options for correcting a voucher after it has been sent to Headquarters. You should take only one of these actions.

- Contact Headquarters and have them reverse the voucher there. This will correct inventory, but will not correct the local receiving history at the remote store.

Or

At the remote store, create a return voucher listing the same vendor, items, costs, quantities, etc. as the original receiving voucher. The new return voucher will cancel the effect of the original, and update both receiving history and inventory at both Headquarters and remote store. A new voucher can then be made with the correct information to record the merchandise that was actually received.

To quickly make a return voucher with the same information as the original:

1. Locate the original voucher in your receiving history.
2. Select COPY VOUCHER.
3. From the I Want To menu, select CHANGE TO RETURN VOUCHER and then save.

Tip: Make a Return Voucher by Copying

Copying the original, making corrections, and then saving is also a quick way to make a new, corrected receiving voucher.

Refer to Chapter 17 Receiving Merchandise (page 281) for basic information about working receiving vouchers and history.
Transferring Merchandise between Stores

Transfer Slip Overview

The transfer of merchandise from one store to another is recorded on a transfer slip. A transfer slip is a transactional document that deducts the transferred merchandise from the source store's on-hand quantities and adds it to the destination store's on-hand quantities.

Headquarters can make transfer slips to move merchandise from any store (the “from” store) to any other store (the “to” store). Remote stores are limited to making slips that transfer merchandise out of their store to another store.

Transfers slips are often made at Headquarters to reallocate fast or slow selling merchandise among stores. Since Headquarters has ultimate inventory control, does the purchasing, and has the ability to run company reports, they are in the ideal position to assess when merchandise transfers of this nature are beneficial.

Keep the following in mind as you work with transfer slips:

- Transfer slips update both the sending and the receiving store. The receiving store should NOT record transferred merchandise on receiving vouchers. Doing so would add the transferred item quantity to the receiving store's quantities a second time.
- Transfer slips are not automatically sent from Headquarters to remote stores or between remote stores; they are simply the mechanism that updates store quantities for the movement. You might find it helpful to print a copy of a transfer slip and use it as a packing slip to accompany the merchandise. If creating a slip at Headquarters for other stores, you could FAX it to the store(s) involved to assist with arrangement for the physical movement of the merchandise.
- If preferred, slips can be created and then put on hold, rather than immediately updating them. The held slip can be printed and included with the items to facilitate the physical movement. Once the transfer is completed, the slip can easily be un-held and updated to record the changes in inventory location.
- A transfer slip does not result in any net change in the company total inventory quantity or valuation; it only records the change in location of that inventory. Transfer slips are sent to QuickBooks to record any freight charges that apply and, if you use QuickBooks classes to report by store, to record the transfer between the stores.
Accessing Transfer Slips

To access transfer slips:

- From the Inventory menu, select one of the following:
  - NEW TRANSFER SLIP to record a transfer between stores.
  - TRANSFER HISTORY to view previously made slips.
  - HELD SLIPS to view slips currently on hold.

Creating a Transfer Slip

To create a new transfer slip:

1. From the Inventory menu, select NEW TRANSFER SLIP.
2. Specify the From Store (source of merchandise) and To Store (destination of merchandise).
   Remote stores cannot change the From Store, since remote stores can only initiate sending a transfer to other stores.
3. Enter the items and quantities being transferred. Refer to Listing Items on Documents (page 91) for instructions.
4. Optionally, enter an estimated date of arrival (ETA), Carrier name, Comment, and Freight charges.
5. Select SAVE & PRINT to record the slip and print a copy or SAVE ONLY to record the slip without printing.

When the transfer slip is saved, the quantities for both stores are updated immediately at the store making the slip. The change is not visible at other stores until after the next completed Store Exchange cycle.

Holding/Un-holding a Transfer Slip

A slip can be put on hold to allow you to carry out other activities or if you just choose to hold slips for updating until after a transfer has been physically completed. For example, you might temporarily hold a slip in progress while you make a sale, then un-hold and complete it after the sale is completed.

Putting a slip on hold adds it to the list of held slips. A slip can be viewed, printed, or deleted while on hold. A held slip is not sent to Headquarters (if made at a remote) and does not update store quantities until it has been un-held and saved.
Transferring Merchandise between Stores

Refer to Temporarily Holding Documents (page 37) for specific instructions.

Held Transfer Slips in a Multi-Workstation Installation

In a multi-workstation environment, a held slip can be accessed and un-held from any networked workstation within the same store.

Working with Transfer History

Once saved, transfer slips are stored in the Transfer History list. Slips provide a permanent record of transfers made (remote stores see only slips made at their store; Headquarters sees slips made at all stores). Your transfer history is drawn upon to create transfer reports. A transfer slip can also be copied to quickly create a new slip.

To display your transfer history:

- From the Inventory menu, select TRANSFER HISTORY.

Locating a Transfer Slip

Use standard list sort, scroll, filter, and search procedures to locate a specific transfer slip.

Refer to Chapter 7 Lists, Forms and Filters (page 99) for more information on each option.

Copying a Transfer Slip to Create a New One

A transfer slip can be copied to quickly create a new one.

To create a slip from a copy:

1. Locate the transfer slip that you want to copy.
2. From the main toolbar, select COPY SLIP. A new slip is opened with the same information as the slip that was copied.
3. Make any necessary changes to the new slip.
4. Select SAVE & PRINT.
Reversing a Transfer Slip

Transfer slips cannot be edited. If an error is discovered on a transfer slip, it is necessary to reverse the slip and then create a new, corrected one to correct your transfer history and store quantities. A transfer slip is reversed through the automatic creation of a second slip with the opposite effect. When completed, the original slip will be marked *Reversed* in the **Status** field and the new slip that is created will be marked *Reversing*. The **Status** field is only displayed in the transfer history list.

Reversing a slip undoes the effect the original slip had on store quantities, i.e. if the original slip transferred an item quantity of three from Store 1 to Store 2, the reversing slip records three units transferred back from Store 2 to Store 1. A *Reverse, Copy, and Correct* approach can be used to undo the effects of the original slip and make a new, corrected slip. First, *reverse* the original, incorrect slip. Then, begin a new slip by *copying* the original one. Finally, make *corrections* to the copy and save as usual.

---

Reversing Transfer Slips at Remote Stores

At a remote store a transfer slip can not be reversed once it has been sent to Headquarters via Store Exchange; at that point the transfer slip can only be reversed at Headquarters.

---

To reverse a transfer slip

1. Highlight or display the transfer slip to be reversed.
2. From the I Want To menu, select **REVERSE SLIP**.
3. The Reversing Document dialog is displayed. (If you are not using security, you will need to select your name from the **Associate** field.)
4. Select **OK**.

A reversing slip is automatically created and added to the transfer history list. If necessary, a corrected slip can then made as described below.

To copy and correct a slip:

Copying and correcting a reversed slip allows you to keep the parts of the original slip that you want to keep, and correct the parts that were in error, to make a new, correct slip.

1. Reverse the original slip as described above.
2. Highlight or display the original slip again (marked *Reversed* in the **Status** field).
3. Select **COPY SLIP**. A new slip is created with the same information as the original.
4. Make the necessary corrections to the information on the new slip.
5. Select **SAVE & PRINT**.

Note that you will have three slips in your transfer history after completing this procedure: the original slip (status: *Reversed*), the second slip that reversed the original (status: *Reversing*), and the new corrected slip (status: *Regular*).
Chapter 33  Exchanging Store Information

Store Exchange Overview ................................................................. 562
What is Sent in a Store Exchange? .................................................... 562
Store Exchange Password Security .................................................. 564
Store Exchange Communication Methods ....................................... 564
The Store Exchange Center ............................................................. 565
Recommended Store Exchange Sequences ...................................... 567
Remote Stores ................................................................................. 567
Headquarters ................................................................................... 568
Running Store Exchange ................................................................. 569
Sending a Mailbag ........................................................................... 569
Sending Item Pictures ...................................................................... 572
Receiving a Mailbag ........................................................................ 573
Store Exchange Activity Log ............................................................ 575
Scheduling Store Exchanges ............................................................. 577
Re-sending Documents between Stores ........................................... 578
Store Exchange Overview

The term Store Exchange refers to the procedure of transferring information between Headquarters and remote stores. Data is sent between stores in a compressed file called a “mailbag” (compressed to reduce transmission file size and time).

Store Exchange has two components: Send Files to compress and send mailbags, and Receive Files to process mailbags received. During program startup, Headquarters sends and remote stores receive to “initialize” each remote store with inventory information and other company data. All stores then routinely exchange information in both directions to keep both Headquarters and remote stores up to date with the most current information.

Only the Server Workstation at each store can run Store Exchange.

What is Sent in a Store Exchange?

Sent from Headquarters to remote stores

Headquarters has central control over inventory, purchasing, and most company preferences, so the exchange file sent from Headquarters includes this information in its entirety:

- Inventory, including all related information: item list, departments, vendors, quantities, costs, and prices
- All new or changed purchase orders (designated by store)
- Shared company preferences
- Customers and all customer information added, edited, or deleted since last exchange (if using multiple shipping addresses, only the default shipping address will be sent)
- Customer Rewards activity
- If you are using item pictures, you can create a special mailbag to send the pictures to your remote stores (refer to Sending Item Pictures (page 572) for more information)

Not sent to remote stores:

- Transactional documents created at Headquarters
- Customer orders
- Employees and security settings
- Store-specific company preferences and workstation preferences
Mailbag files sent from Headquarters are in the format HQ00001.QBT, where:

- **HQ** = Headquarters
- **00001** = Sequential number of mailbags created at Headquarters, incrementing by one for each mailbag created at Headquarters, e.g. the second mailbag file created would be named HQ00002.QBT
- **QBT** = The file extension used on all Store Exchange mailbags

**Sent from remote stores to Headquarters:**

Remote stores send the following to Headquarters:

- Transactional documents, including documents created for receiving, sales, inventory adjustments, and transfers (vouchers, receipts, transfer slips, and adjustment memos; includes adjustment memos automatically created as a result of a store Physical Inventory or the building/breaking of assembly items)
- Customers and all customer information added, edited, or deleted since last exchange (if using multiple shipping addresses, only the default shipping address will be sent)
- Customer Rewards activity
- Time Clock records
- Customer Orders (for calculation of available quantities only)

**Not sent from remote stores to Headquarters:**

- Inventory and related records
- Customer orders (except for calculation of available quantities)
- Store-specific company preferences and workstation preferences
- Employee records (except Time Clock records) and security settings

The exchange file (mailbag) sent to Headquarters from remote stores in the format S0200001.QBT, where:

- **S02** = Store number, e.g. Store 02
- **00001** = Sequential number of mailbags created at the store, incrementing by one for each mailbag created, e.g. the second mailbag file created at Store 2 (s02) would be named S0200002.QBT
- **QBT** = The file extension used on all Store Exchange mailbags
**Store Exchange Password Security**

To ensure that your information is secure, passwords are required to send or receive Store Exchange mailbags. Passwords are case-sensitive and must be entered exactly the same in the Store Exchange preferences of each store. We strongly recommend you use a “complex” password and change the password every 90 days. Select the help link on the password dialog for more information about defining passwords.

**To set up a Store Exchange password:**

1. From the Edit menu, select **PREFERENCES ▶ COMPANY**.
2. Select **MULTI-STORE ▶ STORE EXCHANGE** from the preferences list on the left.
3. On the Options tab, select **CHANGE PASSWORD**.
4. Enter a password, and enter it a second time to confirm, then select **OK**.
5. Select **SAVE**.

**Store Exchange Communication Methods**

There are five communication methods supported for Store Exchange. The same method does not have to be used for each remote store. For example, one remote could exchange with Headquarters via e-mail, while another uses removable media. If not done during the setup interview, Store Exchange methods can be defined or modified on the Store Exchange pages in company preferences.

*Search the in-program help files using keyword “Store Exchange” for additional information about each communication method. Refer to the Point of Sale QuickStart Guide for configuration instructions for Store Exchange.*

The five Store Exchange communication methods available are:

<table>
<thead>
<tr>
<th>Communication Method</th>
<th>2 - Store 2</th>
<th>Intuit Service</th>
<th>Configure</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 - Store 3</td>
<td>Desktop e-mail client</td>
<td>Configure</td>
<td></td>
</tr>
<tr>
<td>4 - Store 4</td>
<td>Intuit Service</td>
<td>Configure</td>
<td></td>
</tr>
</tbody>
</table>

**Intuit service.** This is a free, Internet-based exchange service provided by Intuit. This method requires an Internet connection. Your Store Exchange files are protected by your Store Exchange password and other confidential information from your Point of Sale license. If you are using more than one Point of Sale company file, you will need to use a different password for each to ensure the correct file is updated during Store Exchanges.
**Desktop e-mail client.** Files are sent as an attachment to an e-mail automatically created and sent via your default e-mail program, specified in Internet Explorer. This is the e-mail program that automatically launches when you select to send an e-mail from within a Windows application.

*Examples: Outlook, Outlook Express, and Netscape Mail*

---

**E-mail Client**

To see which program is your Desktop e-mail client, open Internet Explorer, select **TOOLS** and then **INTERNET OPTIONS**. Select **PROGRAMS** from the tabbed panes and note the entry in the E-mail field.

---

**Web-based e-mail.** Files are sent as an attachment to an e-mail you create send via an e-mail service you access on the Internet through your browser.

*Example: Yahoo mail*

**Network file transfer.** This is a direct file transfer to and retrieval by other computers via a network, phone line, or Internet connection using mapped drives or UNC (Universal Naming Convention) locations.

*Examples: LAN (local area network), WAN (wide-area network), or VPN (Virtual Private Network)*

**Removable media.** This is removable storage media that is physically transported to other stores.

*Examples: USB memory sticks, CDs, Zip drives, floppy disks*

---

**The Store Exchange Center**

The Store Exchange Center provides a central point from which to configure stores and Store Exchange, send and receive files, access the Store Exchange Activity Log, and more.

Access to the Store Exchange Center is controlled by security rights. *Refer to Working with Security Groups (page 71) for information about assigning security rights.*
Chapter 33: Exchanging Store Information

Accessing the Store Exchange Center:

- The Store Exchange Center can be accessed two ways:
  - Select **STORE EXCHANGE CENTER** from the Stores menu.
  
  **Or**
  - Select the Store Exchange Center icon in the Other Tasks section of the Navigator.
The Status panel of the Store Exchange Center can also be added to the Dashboard for easy viewing.

You can be alerted in the Store Exchange Center if a specified period of time has passed without a Store Exchange with another store. You specify how many days you wish to use as the interval, and an alert will be displayed in the Status panel if that time period has passed without a Store Exchange occurring.

---

**Recommended Store Exchange Sequences**

**Remote Stores**

At the end of each sales day, each workstation in the store should run a Drawer Count report to “close” for the day. Then, perform the following activities on the Server Workstation:

- Run a Store Close report (include all workstations)
- Settle credit and debit card transactions with the QuickBooks POS Merchant Service, if applicable
- Perform a backup of your Point of Sale data
- Send a Store Exchange mailbag with the day's information to Headquarters

Generally, it is recommended that you make these activities part of the automated End of Day procedure for remote stores.

**Receiving Updated Information Back From Headquarters**

Before opening for the next day, remote stores should receive and process a Store Exchange mailbag from Headquarters on the Server Workstation. It is recommended that no other workstation be working in Point of Sale during this process, as the procedure will automatically close all open windows if necessary to update files.

**Headquarters**

Headquarters has two distinct End of Day responsibilities and you may find it beneficial to keep the activities related to each separate. It may be helpful to think of these responsibilities as store activities and Headquarters activities.
**Store activities include:**

- Running a Drawer Count report at each workstation.
- Running a Store Close report at the Server Workstation.
- Settling credit card transactions with the QuickBooks POS Merchant Service.

**Headquarters activities include:**

- Processing in the Store Exchange mailbags received from remote stores, thus updating inventory and related records with the day's activities.
- Exchanging information with QuickBooks.
- Backing up the company data.
- Sending updated information back to the remote stores before the next business day begins.

We recommend you run the normal automated End of Day procedure to handle the store activities, but that you do the Headquarters activities manually after the store close is completed and you have processed in the Store Exchange mailbags from remote stores (or run End of Day a second time, with just Financial Exchange and Store Exchange selected). There are several reasons for this:

- It keeps the two procedures separate, making it easier to understand and follow the correct procedure for each.
- It may take some time for remote stores to get their Store Exchange mailbags to Headquarters, especially if using removable media or relying on e-mail delivery and you can complete your normal store close activities in the meantime. If necessary, you could even put off Headquarters activities until the following morning.
- If your goal is to maintain the most accurate information possible at all stores, it is important that Headquarters receive and process in a mailbag from every remote store before they in turn update inventory and QuickBooks and send information back.

**Variations on the Recommended Sequence**

Depending on operational requirements and management's need for updated information, the Store Exchange process can be run more or less frequently. Some variations include:

- Remote stores could be required to run **SEND FILES** several times a day. The Headquarters could then process in those files and have an up-to-the-minute snapshot of company activity. With information flowing to Headquarters throughout the day, it would be less critical that every remote store's final mailbag of the day be received before Headquarters processes to close out
Running Store Exchange

the day. Any transactions not making it in one day would automatically be updated during the first exchange the next day.

• If your need for updated information is not critical, you could run Store Exchange less frequently; say once every few days or once a week.

• If using the Intuit Service, or Network File Transfer methods, you can schedule Store Exchanges to occur once per day at any time of the day or night. Be advised though that the exchange of information with your QuickBooks financial software cannot be scheduled to occur between Headquarters processing in mailbags from remotes and sending updated information back. Refer to Scheduling Store Exchanges (page 577) for more information on this option.

With experience, you will find the sequence and frequency that works best for your circumstances. It is not required that the recommended sequence be followed, but by adhering to it you ensure that all stores have the most current information for each business day.

Running Store Exchange

Sending a Mailbag

Sending Store Exchange mailbags can be initiated in any of these ways:

• From the Stores menu or the Store Exchange Center, select SEND FILES.

• Include the Store Exchange option in your End of Day procedure.

• If using the Intuit Service or Network File Transfer methods, and you have scheduled Store Exchanges, they occur automatically. Refer to Scheduling Store Exchanges (page 577) for more information on this option.

Before you send files, it is a good practice to check for and process any mailbags that you may have received and not yet processed. Refer to Receiving a Mailbag (page 573) for instructions.

To prepare and send a mailbag:

1. Initiate sending a file in any of the manners described above.

The Store Exchange dialog is displayed. At Headquarters, this dialog will have a list of all of your remote stores with the exchange method and the e-mail address/
file path for each, as specified in company preferences. At a remote store, only the Headquarters location is listed.

Options in the Store Exchange dialog include:

- Changing the Store Exchange method for communication with other store(s).
- Changing the e-mail address or destination folder for each store (click the EDIT button to the right of the Store line).
- Select VIEW LOG to read the entries in the Store Exchange Log. This is helpful in troubleshooting any errors that occur during the preparations/sending of a mailbag.
- Headquarters only: Select or clear store checkboxes. The mailbag will be prepared and/or sent only to the selected stores.

Changes in communication method made on this dialog affect only the current Store Exchange. To make permanent changes, select CONFIGURE STORE EXCHANGE from the Stores menu (takes you to the Store Exchange page of company preferences).

2. Select SEND to initiate the mailbag creation, then follow the appropriate instructions below. When creating/sending of the mailbag is complete, a confirmation message is displayed.

To send via Intuit service:

- The mailbag file is created and automatically sent via your Internet connection to a secure online database where it can be retrieved by the other store(s).
To send via desktop e-mail client:

1. Your e-mail client is launched and a single e-mail is created with the mailbag file attached. The e-mail is automatically addressed to the store(s) specified, and if you are online, automatically sent as well. A default message instructs the receiving store(s) how to process the attachment. If you are not online when you select SEND, the e-mail is placed in your e-mail outbox ready for you to manually send later. When ready to send, connect to your Internet service provider, access your e-mail client and initiate a Send of the e-mail(s) in your outbox.

2. Answer Yes if you receive a message asking if you want to allow a program to automatically send an e-mail (this may or may not happen depending on your desktop e-mail client and security settings).

Using Outlook and Microsoft Exchange Server

If you use Outlook as your desktop e-mail client and use Exchange Server, you must be connected to Exchange Server when you select SEND. Otherwise, the e-mail will fail and it will not be placed in your e-mail outbox. In this case, you will have to re-send after your connection to Exchange Server is restored.

SPAM Filters, Virus Detection, or “Unrecognized Format” Messages

Some e-mail programs or SPAM filters may flag a Store Exchange file attached to an e-mail as unrecognizable or as junk e-mail when received. You will be given the option on how to handle the attachment—select the option to open it with the default program (Point of Sale) and it will be processed normally.

Internet browsers (such as Internet Explorer), e-mail applications, and virus detection software programs often have user-definable security options related to handling of e-mail attachments. Depending on your applications and settings, it is possible that Store Exchange mailbag files (.QBT file extension) will be blocked from being opened or downloaded. If this is the case, changing your settings to identify the .QBT files as “safe” or removing them from the application's “unsafe file” list should solve the problem. Some programs also allow you to designate “safe” e-mail sources, from which file attachments are allowed. Consult the documentation or help files of the applications you use to determine what your choices are if this pertains to you.

To send via web-based e-mail:

1. The mailbag is created and placed in the destination folder specified. A Windows Explorer window is opened, showing you this location.

2. Access the Internet and your e-mail service; follow their instructions to create the e-mail, enter e-mail address(es), add a message/instructions, browse to and attach the mailbag file, and then send the e-mail.

To send via network file transfer:

- The mailbag file is created and then copied to the destination folder specified for the other store(s) (e.g. their “in folder”).
To send via removable media:

1. You will be prompted to enter the media (floppy disk, memory stick, etc.) in the appropriate drive or USB port. The mailbag file will be copied to the media.

2. Headquarters only: If sending to multiple stores, you will be prompted to enter separate media for each store. Separate media must be used for each store.

3. Transport the media to the other store(s).

---

Using CDs for Store Exchange

Point of Sale does not write directly to CD drives. You must have a CD-writing application installed to use this media and the process will vary depending on the application's capabilities and the type of CD you use.

For best results using CDs, it is recommended you use formatted CD-RW disks and a compatible drive and software. These disks allow you to reuse the disk, copying and deleting mailbag files as needed.

If you have problems sending mailbag files to a CD drive, it is recommended that you choose web-based e-mail as your Store Exchange method. This method sends a single mailbag file to a folder of your choice on your hard drive. You can then use your CD-writing software to write the copy to as many CDs as you need for your other stores.

---

Sending Item Pictures

If you assign pictures to your inventory items at Headquarters, you can send those pictures to remote stores, where upon receiving them they will automatically be displayed for items. Due to the potentially large file sizes, item pictures are not included in the normal Store Exchange process; a separate and distinct procedure is required. You may want to periodically send item pictures so that additions or edits made at Headquarters are reflected at your remote stores.

Pictures can only be sent to remote stores by using removable media, such as a CD, USB flash drive, external hard-drive, and so forth.
Running Store Exchange

To send your item pictures:

1. From the Store Exchange Center, select **PREPARE PICTURES**.
2. In the Send Pictures window, **BROWSE** to the location or drive to which you wish the mailbag to be saved and select **OK**.
3. Select **NEXT** to continue.
4. Select **EXPORT**.
5. Select **CLOSE** to exit once the process is complete.
6. If you did not specify for the file to be created on removable media, you will need to copy the file to your removable media in order to physically transport to your remote store(s).

Receiving a Mailbag

Remote Stores: Close Open Windows Before Receiving Store Exchange Files from Headquarters

When receiving Store Exchange mailbags at remote stores, all open windows must be closed before proceeding. If you proceed with open windows, you will be prompted to close them before your files are updated.

Receiving Store Exchange mailbags can be initiated in any of these ways:

- From the Stores menu or the Store Exchange Center, select **RECEIVE FILES**. This option checks for and processes any received mailbags waiting in your Store Exchange “in folder”, from the online Intuit Service, or from a location to which you browse.
- Open or double-click a received file or an e-mail attachment with the `.QBT` extension (after downloading to your “in folder”, if using web-based e-mail).
- If using the Intuit Service or Network File Transfer methods, and you have scheduled Store Exchanges, they occur automatically. Refer to **Scheduling Store Exchanges (page 577)** for more information on this option.
- To receive an item picture mailbag, place or attach the media in the appropriate drive and then select **RECEIVE PICTURES** from the Stores menu.
Chapter 33: Exchanging Store Information

To receive via Intuit Service:

• Ensure you have an Internet connection and initiate receiving files as discussed above. No additional action is required on your part.

To receive via desktop e-mail client:

1. Launch your desktop e-mail client application.
2. Locate and display the e-mail from the other store, and then double-click the .QBT file attachment to process it immediately.

Alternatively, you can save the file to your Store Exchange “in folder” (not the e-mail client's in box), where you can access and process it by selecting RECEIVE FILES from the Stores menu or Store Exchange Center, and then PROCESS IN on the Store Exchange dialog.

Refer to the e-mail notes in Sending a Mailbag (page 569) for more information related to sending/receiving Store Exchange files via e-mail.

To receive via web-based e-mail:

1. Access your e-mail application on the Internet and display the Store Exchange e-mail from the other store.
2. Follow the e-mail application's instructions to download and save the attached .QBT file to your Store Exchange "in folder."

Tip: Setting A Default "In Folder"

If you always use the same folder to receive files or, for removable media, the same drive/port, specify this location or drive as your default "in folder" at PREFERENCES ➤ COMPANY ➤ MULTI-STORE ➤ STORE EXCHANGE. When you select process in on the Store Exchange dialog, Point of Sale will automatically process any files located in your in folder. Specifying an in folder is not necessary if using the Intuit Service as your Store Exchange method.

Automatic Prompting to Process In

Anytime mailbags are waiting in your "in folder" when you launch Point of Sale, you will be alerted and given the option to process them immediately. The “Store Exchange Files Waiting” icon is also displayed in the status bar at the bottom of the program window until the mailbag(s) are processed. Processing of files can be initiated by double-clicking the icon.

The method of receiving and processing mailbags will vary, depending on your Store Exchange method, as described below:
Running Store Exchange

3. *Headquarters only:* Repeat with e-mails received from other remote stores.
4. Close the e-mail application.
5. From the Stores menu or Store Exchange Center, select **RECEIVE FILES** and then **PROCESS IN** on the Store Exchange dialog to process the file(s) in your “in folder.”

**To receive via network file transfer:**

- From the Stores menu or Store Exchange Center, select **RECEIVE FILES** and then **PROCESS IN** on the Store Exchange dialog to process the file(s) in your “in folder.”

**To receive by removable media:**

1. Insert the received disk or other type of media in the appropriate drive or USB port.
2. From the Stores menu or Store Exchange Center, select **RECEIVE FILES**.
3. If you have identified the drive/port as your default “in folder” location, you can immediately select **PROCESS IN** to process the mailbag on the media. Otherwise, choose **BROWSE** and navigate to the mailbag file at the drive/port being used and then select **PROCESS IN**.
4. *Headquarters only:* Repeat with the media received from other stores.

A confirmation message is displayed when processing is completed. If the message indicates that errors have occurred, select **VIEW LOG** to review the Store Exchange entries for clues to the problem. The next section describes the Store Exchange Log.

**Store Exchange Activity Log**

All activities that occur during Store Exchange are recorded in the Store Exchange activity log file. A separate log is maintained at each store. If an error is encountered, the first step should be to check the log entries for messages that might help identify the problem.

**To access the Store Exchange log:**

1. Select **VIEW ACTIVITY LOG** from the Store Exchange dialog, Store Exchange Center, or Stores Menu.
2. Select a date and time from the Available logs list on the left. One log entry is made for each time Store Exchange is run.
3. Select the **SHOW ERRORS ONLY** checkbox to remove routine entries and make identification of errors easier.

![Sample Store Exchange Activity Log](image)

Once an error has been located, select **PRINT** to send a copy of the displayed entries to your printer. In most cases, a more detailed description of the error will be provided than that shown in the example above. Select **HELP** to access a list of error codes and possible causes and corrections.

**Automatic Recovery**

The Store Exchange process has a built-in recovery mechanism that automatically resends and synchronizes data between stores in the event that a mailbag is late, lost, received out of order, or arrives with corrupted data. If you do not receive a mailbag from a remote (or from Headquarters if a remote store), it is not necessary that you suspend any normal activities. Mailbags will automatically be resent and data synchronized on the next Store Exchange.

---

**Warning: Automatic Recovery Does Not Replace the Need for Regular Data Backups**

While the automatic data protection and recovery features can fix many instances of missed or lost exchange mailbags, it is still vitally important that you implement and follow a regular program of data backups, especially at Headquarters, where your master inventory and related records are maintained. Refer to **Backing Up Your Data** (page 76) for more information about implementing a regular data backup routine.
Scheduling Store Exchanges

If you use the Intuit Service or Network File Transfer methods of Store Exchange, you can schedule a once-per-day Store Exchange to occur automatically.

At Headquarters, at the scheduled time, Point of Sale will check for received mailbags in your network in folder or at the Intuit Service online database, process all waiting files, and then send updated files back out to your remote stores.

At remote stores, separate send and receive schedules can be set. This allows you to synchronize actions by scheduling to send out information, allow adequate time for Headquarters to process files and send files back out, and then have receive files before the beginning of the next business day.

There are some things that you should consider when implementing an automated schedule for Store Exchange:

- Point of Sale must be running (do not have automatic lookouts turned on in preferences) and a user with adequate security rights logged in for the Store Exchange to take place at the scheduled time. If you schedule your Store Exchanges to occur in the middle of the night while the store is closed, you will need to leave your computer running overnight.

- Financial Exchange is not automated. If you are using QuickBooks financial software and schedule your Store Exchanges, Headquarters will not exchange information with QuickBooks before sending files back to remote stores. Scheduling Store Exchange may not be the best choice if you use customer charge accounts or for some other reason need updated information from QuickBooks available at remote stores at the beginning of each day.

- The schedule for Store Exchange runs once per day; if you prefer to have up-to-the-hour data at all stores, you could supplement a schedule with manual exchanges during the day.

Store exchange schedules are defined in company preferences.

> PREFERENCES ➤ COMPANY ➤ MULTI-STORE ➤ STORE EXCHANGE ➤ OPTIONS ➤ Scheduled Store Exchange. Select the checkbox and set a time for daily Store Exchanges to be run.
If Point of Sale is not running when an exchange is scheduled to occur, you are notified on the next startup and can choose to run the Store Exchange at that time.

Re-sending Documents between Stores

If documents need to be re-sent to or from Headquarters, such as when the Point of Sale company data has been restored from an earlier point, this can be initiated from the File menu.

The following information will be resent with this option.

From remote store to Headquarters:

- Transactional documents (receipts, vouchers, memos, transfer slips; based on document date)
- Drawer count reports (Z-Outs) (based on last edit date)

Re-sending documents to Headquarters will update inventory and add the documents to the sales history.

From Headquarters to remote store:

- Open purchase orders

To re-send documents:

1. At the Server Workstation, select **FILE ➤ UTILITIES ➤ RESEND FILES.**
2. **Headquarters:** Select the store(s) to which you are sending and the communication method.
   - **Remote Store:** Indicate a resend date; all documents made on or after the specified date will be resent to Headquarters.
3. Select **SEND.**
Section IX: Customizing Point of Sale

Chapter 34  Customizing the Program  ................. 581
Chapter 35  Customizing Printed Documents (Pro)  ........... 593
# Chapter 34 Customizing the Program

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Customization Overview</td>
<td>582</td>
</tr>
<tr>
<td>Preferences in Point of Sale</td>
<td>582</td>
</tr>
<tr>
<td>Security Rights Affecting Program Options</td>
<td>583</td>
</tr>
<tr>
<td>Font Size and Screen Resolution</td>
<td>583</td>
</tr>
<tr>
<td>Removing Features from Point of Sale</td>
<td>584</td>
</tr>
<tr>
<td>Customizing the Toolbars</td>
<td>585</td>
</tr>
<tr>
<td>Customizing Columns in Lists</td>
<td>586</td>
</tr>
<tr>
<td>Add/Remove/Arrange Columns</td>
<td>586</td>
</tr>
<tr>
<td>Resize Column Width</td>
<td>588</td>
</tr>
<tr>
<td>Reverting Lists to Default Layouts</td>
<td>588</td>
</tr>
<tr>
<td>Custom Labels and Custom Fields</td>
<td>589</td>
</tr>
<tr>
<td>Item Field Labels</td>
<td>589</td>
</tr>
<tr>
<td>Custom Fields (Pro)</td>
<td>590</td>
</tr>
<tr>
<td>Adding Your Logo to Printed Documents</td>
<td>591</td>
</tr>
<tr>
<td>Why are Some Features not Available to Me?</td>
<td>592</td>
</tr>
</tbody>
</table>
Program Customization Overview

Point of Sale provides you with many ways to customize how you work with the program. As every business has its own unique needs, it is important that you are able to match Point of Sale with your own business processes as closely as possible. This chapter provides information on the various ways you can customize Point of Sale for your company, your store(s), and your workstations.

The ability to customize various aspects of Point of Sale are dictated by the security rights of the currently logged-in user.

Preferences in Point of Sale

Point of Sale preferences allow you to configure the program to work with your hardware and accessories, establish data control, and customize many of the Point of Sale features.

There are two categories of preferences:

- **Company Preferences:** those affecting the entire application and all workstations
- **Workstation Preferences:** for configuring individual workstations and their attached equipment

This arrangement allows you to maintain central control over critical program features through the company settings, while also allowing individual workstation setups to be optimized for a particular purpose or for specific hardware.

You initially configure many preferences during the Setup Interview, but you can directly edit them at anytime by selecting **PREFERENCES** and then either **COMPANY** or **WORKSTATION** from the Edit menu.

**Pro Multi-Store Company Preferences**

Most company preferences can be defined only at Headquarters. Refer to Chapter 31 *Multi-Store Basics (page 533)* for more information.

Where a feature’s execution is affected by a preference setting, a note box explaining the options is included in the User Guide section pertaining to that feature. The preference note identifies the location in preferences where the setting is configured and a brief explanation.
Program Customization Overview

A complete summary of all program preferences can be found in Appendix A
Preferences (page 617).

⚠️ Warning: Close Open Windows to Edit and Save Company Preferences

Editing and saving company preferences, either directly or through the Setup Interview, requires that all open windows be closed. If you try to save company preferences and any other windows are open, you will have to switch to and close them before you can continue. We recommend you save all work in progress and close open windows before making changes to your company preferences. Other workstations must exit and restart for changes to take effect.

Security Rights Affecting Program Options

When implemented, the security rights assigned to users will affect the program options available to them when they are logged in.

*For more information on security groups and settings, refer to Working with Security Groups (page 71).*

**Feature not available to you?**

Check the list of reasons that a feature might not be available to you in Why are Some Features not Available to Me? (page 592).

Font Size and Screen Resolution

The fonts in Point of Sale can be adjusted using the Windows display settings. When you adjust these settings, the Point of Sale display will be scaled accordingly. Refer to your Windows documentation for instructions on adjusting your display settings.

While a minimum of 800 X 600 resolution is required for Point of Sale, this resolution will disable some of the Navigator functionality. A screen resolution of 1024 X 768 is recommended.
Removing Features from Point of Sale

Certain Point of Sale features, and related screens, menu options, data fields, and toolbar icons, can be removed from the program interface if you choose not to use them. By removing features you will not use, your screens are less cluttered and you can complete tasks more efficiently.

To remove Point of Sale features:

1. From the Edit menu, select **PREFERENCES ➤ COMPANY**.
2. Select **GENERAL** from the list on the left.
3. Select or clear the checkboxes as appropriate to the features you want to use. Clearing a checkbox removes all options related to that feature from the program.

4. Select **SAVE** to implement your changes.

**Interdependent Options**

Some options will automatically be disabled when other options are “turned off.” For example, if you do not track customers, documents requiring customer information, such as layaways, customer orders and work orders, will not be available.

**Change Your Selections at Anytime**

Removing a feature only removes the options for that feature from the program interface. Any previously created records or documents related to a turned off feature are not deleted from your company file. You can turn the feature back on at any time and the prior data remains intact.
Customizing the Toolbars

You can turn on/off the display of the main toolbar and you can add, delete, or rearrange the task icons appearing on the main toolbar. Customizing the toolbar with the task icons you use most often can help make your workflow more efficient.

To turn on/off the display of the main toolbar:

1. From the View menu, select **CUSTOMIZE**.
2. Select or clear (<ENTER>) the check mark for the **TOOLBAR**. A check mark means that the component is displayed.

If you turn off the toolbar, the same options are available from the text menus and/or task button on the bottom of the open window.

To add, delete, or arrange icons on the toolbar:

1. From the View menu, select **CUSTOMIZE**.
2. Select **CUSTOMIZE TOOLBAR**.
3. Select or clear (<SPACE>) the check marks for the available task icons. Tasks with a check mark are displayed on the toolbar.
4. To rearrange tasks on the toolbar:
   - Mouse or touchscreen users: Select a task, then drag and drop it into the preferred position
   - Keyboard users: Highlight a task and then hold down <CTRL> while using your up/down arrow keys to move the task to the preferred position
5. Select **OK**.
Chapter 34: Customizing the Program

Customizing Columns in Lists

Point of Sale is designed to accommodate a wide variety of businesses and business models. Not all of the data available in a particular list may be applicable to your business. For this reason, lists include the ability to add, remove and rearrange columns so that your view is clutter-free and only shows information fields that you actually use.

The columns displayed in a list can be customized in much the same manner as the columns in most spreadsheet programs. These customizations only affect the workstation on which they are implemented. You can have each workstation displaying lists differently, or you can set each workstation to view them in the same manner.

The following instructions will provide you with details for adjusting the layout of your lists to best suit your workflow needs.

Add/Remove/Arrange Columns

The following example shows how to add or remove columns from the receipt item list. The same procedure would be used for other lists in Point of Sale.

To add, remove or arrange columns:

When viewing a list such as the receipt item list:

1. From the View menu, select **CUSTOMIZE ➤ CUSTOMIZE RECEIPT ITEM COLUMNS**.

   Or

   Right-click a column header and select **CUSTOMIZE COLUMNS**.

*Upgraders and Customized Layouts*

When new Point of Sale versions are released which include changes to default layouts, if you have modified your layouts the upgrade process will not remove your customizations. In such cases, if new fields have become available they will not appear in your previously modified layouts unless you add them yourself.

If you have upgraded from a previous version and were using customized layouts, you may wish to review your layouts to determine if you wish to add any new fields that may now be available.
Customizing Columns in Lists

The following window is displayed:

![Customize Columns window](image)

2. Using the **ADD**, **REMOVE**, **MOVE UP**, and **MOVE DOWN** buttons, arrange the column names into the sequence you would like them to be displayed in the list. Selections appearing under **Chosen Columns** will appear in the list display.

3. Select **SAVE** to save your choices. Select **DEFAULT** to return the list columns to the program default.

---

**List Display in Collapsed View**

When viewing a list in collapsed view, three columns can be selected to display at the right of the Information Panel. With the Information Panel displayed, you can edit the columns shown on the right using the method described above.

**Removing Columns**

Removing columns from a list does not affect the data in your company data file. Only the list display is affected.

---

**Pro Tip: Customizing Printed Documents**

Adding or removing columns here will not affect the information displayed on printed documents. See Chapter 35 Customizing Printed Documents (Pro) (page 593) for information on customizing printed documents.
To rearrange columns:

- To rearrange the column order while in a list, you can simply drag-and-drop the column headers to arrange the columns into the order you prefer. The order you set will remain in effect until you change it again.

Resize Column Width

Drag-and-drop the header separators to change column width. To adjust all columns to the width of their largest entry, right-click in the header and select **ADJUST COLUMN WIDTHS** from the pop-up menu.

Reverting Lists to Default Layouts

To re-set lists to the original program defaults:

1. From the Edit menu, select **PREFERENCES ➤ WORKSTATION**.
2. Select **GENERAL** from the list on the left.
3. Select the **RESET NOW** button.
4. Select **SAVE**.

⚠️ **Warning: Customizations will be Lost**

Reverting to the default layouts will affect columns displayed as well as sequence and width for all lists. All customizations done to lists will be lost.
Custom Labels and Custom Fields

Different business practices require the use of different types of information. In order to assist you to most effectively use Point of Sale for your business model, some of the labels for fields in Point of Sale can be edited according to your specific needs.

(Pro) You can also add and use custom fields to track additional information about items, customers, vendors, and employees. These fields can be named however you want and added to your lists and printed documents, as well as being used to filter Point of Sale reports.

**Item Field Labels**

Point of Sale allows you to change the text label for four of your item description fields. These changes will flow through to your program displays as well as your printed documents when applicable.

The inventory field labels you can rename are:

- Item Name
- Item Description
- Attribute
- Size

**To define item field labels:**

1. From the Edit menu, select **PREFERENCES ➤ COMPANY**.
2. Select **GENERAL ➤ MY FIELD LABELS** from the list on the left.
3. Edit the text in the **My Label** column as needed.
4. Select **SAVE**.
Custom Fields (Pro)

You can add and use custom fields to track additional information about items, customers, vendors, and employees.

For example, you may wish to add fields in the customer record for spouse name, birthdays, customer sizes, or to keep track of a particular piece of art for which a customer is searching. Or, maybe your vendors require you to include some specific item information on purchase orders that the basic item fields won’t accommodate.

Custom fields can be named however you want and added to your list display and printed documents, as well as being used to filter your lists and many Point of Sale reports.

There are two ways you can add custom fields in Point of Sale. You can define the custom labels from a record form in the area of Point of Sale in which they appear. This allows you to add and define your custom fields on-the-fly as the need arises.

You can also define them in Company Preferences as described in the previous procedure, activating the custom fields with checkboxes and entering a custom name. Defining fields in Company Preferences allows you to add and define all custom fields in Point of Sale in one place.

To define custom fields on a record form:

1. Display any record form in the area you wish to define field labels (by selecting new or edit from the window toolbar).
2. Select the CUSTOM tab.
3. Select DEFINE FIELDS.
4. Select the checkboxes to activate needed fields and edit the field labels as needed.
5. Select OK.
Adding Your Logo to Printed Documents

You can add your store logo to printed sales documents by specifying the logo in company preferences (see preference note below). If a logo is specified, it will automatically be printed on receipts and gift receipts. For Pro-level users, the logo is also printed on customer orders and packing slips and can be added to other documents using the Print Designer.

Guidelines for Logos

- The graphic formats supported are .bmp, .jpg, and .gif.
- It is recommended you keep your graphic files to 100 KB or less in size; larger file sizes may slow printing. The maximum allowed size is 1.5 MB.
- Point of Sale will scale your logo, if necessary, to fit in the allotted space on your selected document template.

Some loss in quality may be experienced when scaling graphics, so it is best to resize your logo in a graphics application to these sizes before using in Point of Sale:

**40-column documents:** 248 pixel maximum width

**Letter-size documents:** 381 pixel maximum width

- (Pro) You can customize logo size and location for each printed document in Print Designer. Refer to Chapter 35 Customizing Printed Documents (Pro) (page 593) for more information.
- (Pro Multi-Store) Each store can define their own logo.

Preferences: Printing a Logo on Documents

EDIT > PREFERENCES > COMPANY > GENERAL > STORE INFO > Logo: Select the USE IMAGE AS DEFAULT LOGO and then select SPECIFY to open the Images Collection window. Select ADD to add images to use as logos. Choose the SELECT button to indicate which image you wish to be used as the default logo on printed documents. A preview of your selected graphic is displayed. Pro users can customize their printed documents to use different logos on each document.
Why are Some Features not Available to Me?

There are a number of reasons that a feature may not be available to you in Point of Sale:

- You do not have security rights to access that feature. Refer to Working with Security Groups (page 71) for more information.
- The feature has been turned off in company preferences. Refer to Preferences in Point of Sale (page 582) for more information.
- An interdependent feature has been turned off or not set up (for example, to use customer orders requires tracking customers turned on, and so forth). Refer to Preferences in Point of Sale (page 582) for more information.
- The level of Point of Sale you are licensed for does not include that feature. Refer to Point of Sale Levels: Basic, Pro, or Pro Multi-Store (page 6) for more information.
- You are on a Client Workstation and the feature is limited to the Server Workstation. Refer to About Server and Client Workstations (page 7) for more information.
- You are in Practice mode, where certain features such as MAS, Financial Exchange, and Store Exchange are not available. Refer to Using Practice Mode (page 20) for more information.
- You are trying to use a Financial Exchange feature but your connection with QuickBooks has not been set up. Refer to Chapter 27 Financial Exchange Basics (page 479) for more information.
- You are at a remote store in a multi-store configuration and the feature is not available to remote stores. Refer to Allowed Activities by Store Type (page 542) for more information.
- You upgraded from a previous version and had customized lists, reports, or documents in the prior version. Point of Sale does not automatically reset your custom layouts to the new defaults, so the fields, columns, or report options related to new features may not be available until you further customize your layouts or, in the case of reports, select REVERT on the Modify Report window and then re-memorize.
**Chapter 35**  
**Customizing Printed Documents (Pro)**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>594</td>
</tr>
<tr>
<td>Document Templates</td>
<td>595</td>
</tr>
<tr>
<td>Template Sections</td>
<td>595</td>
</tr>
<tr>
<td>Template Spacing and Display</td>
<td>596</td>
</tr>
<tr>
<td>Template Elements</td>
<td>597</td>
</tr>
<tr>
<td>Default Templates</td>
<td>598</td>
</tr>
<tr>
<td>Modifying or Creating a Template</td>
<td>599</td>
</tr>
<tr>
<td>Recommended Design Sequence</td>
<td>600</td>
</tr>
<tr>
<td>Adding and Removing Elements</td>
<td>601</td>
</tr>
<tr>
<td>Positioning Elements</td>
<td>603</td>
</tr>
<tr>
<td>Sizing Elements</td>
<td>604</td>
</tr>
<tr>
<td>Changing Fonts, Field Labels and Other Attributes</td>
<td>605</td>
</tr>
<tr>
<td>Customizing an Item List or Style Grid</td>
<td>607</td>
</tr>
<tr>
<td>Aligning Elements Using &quot;Snap&quot; and the Toolbar</td>
<td>609</td>
</tr>
<tr>
<td>Print Designer Hints and Tips</td>
<td>611</td>
</tr>
<tr>
<td>Importing and Exporting Templates</td>
<td>613</td>
</tr>
<tr>
<td>Customizing Reports</td>
<td>614</td>
</tr>
</tbody>
</table>
Overview

Print templates for the following Point of Sale documents can be modified using Print Designer:

- Sales receipts
- Gift receipts
- Price tags
- Sales orders
- Layaways
- Work orders
- Customer ID cards
- Purchase orders
- Receiving vouchers
- Transfer slips
- Packing slips
- Labels
- Adjustment memos

Point of Sale comes with default templates for each document and tag type. You can directly edit the default templates or copy them and then modify the copy to create and save new templates. Once modified, templates can be exported and imported to share them with other workstations or stores.

With Print Designer, you can:

- Add, remove, size, and position data fields, static text, and logos
- Add borders and graphic lines
- Change the printed labels on fields
- Change the fonts used for printing
- Control certain printing characteristics, such as the behavior of document headers and footers

Note that not all options are available on every template.
Template Sections

Most document design templates (e.g. receipts, purchase orders, etc.) are divided into five logical sections which each containing certain types of information. Specific data fields included will vary depending on the document type the template will be affecting. Some document templates, such as tags, labels and 40-column templates, will not have all five sections.

The template sections are identified along the left side of the template. Click a section name to make that section active (white color) and work with it. The following descriptions will provide a general understanding of how the template sections are used and how each section behaves.

The five template sections are as follows:

**Repeating Header.** This section prints at the top of each page of the printed document. Information in this section would include such things as the date, page number, document/transaction number, and associate/cashier name.
**Body Header.** This section prints only on the first page of a document. Information in this section would typically include your store name and address as well as the customer/vendor’s billing and shipping addresses, as applicable.

**Body.** This section contains the item detail. The body section automatically sizes itself to accommodate the number of items included in the transaction and can span multiple printed pages.

**Body Footer.** This section prints once, following the body section. The information in this section would normally be such things as document totals, balances, savings, payment type, messages and comments.

**Repeating Footer.** This section prints at the bottom of each page of the document. The same type of information can be placed in this section as in the Repeating Header section, depending on whether you wish this information to be displayed at the top or bottom of each page.

**Template Spacing and Display**

The sections of a document template cannot be rearranged or deleted. You can, however, add or remove “white space” at the top and bottom of each section by dragging and dropping the top or bottom section dividers. Adding some space gives you room to manipulate elements within the section. Removing space when your design is complete helps prevent wasting paper when printing.

When in the Print Designer, keep in mind that the display is not an accurate representation of how the printed document will appear. For example, if a receipt template includes the customer address fields, but you do not list a customer when creating the receipt, the address fields and the vertical space they normally occupy will be omitted from the printed document and everything below the address field will be moved up to fill the void.
The End of the Document or Section

Sections in the template and particularly at the end of the document will vary depending upon the particular type of document and the printer being used. It is recommended that you build each section from the top down and then set the placement for the end of each section and the end of the document according to the lowest field placed in that section.

The image to the right shows the divider at the end of the document moved to just below the end of the last field. This ensures that no wasted space is added to the printed documents. If more space is needed, the divider can be moved down.

Template Elements

Objects and fields that are placed in the different sections of a template are referred to here as elements.

Types of Elements:

Static Text or Label. This is any unchanging text that you want to appear on the printed document.

Data Field or Group of Fields. Data fields are populated from information in your company data file. This could be store information, customer information, item information and so forth.

A “data field” represents one piece of information from the record, such as the city for the billing address.

A “group of fields” represents a set of data fields. Each section of a template has predefined groupings of individual elements. For example, a “Ship To” group element would have available all information pertinent to the shipping location. The most common information will be preselected for this group. However, item information would not be available for this group element. In most cases, the
group element should meet your needs. However, should you need a more specific design, you can add individual field elements and place them accordingly. In most cases, you will not be able to have the same information field appearing in multiple locations in the template.

**Store Logo.** By default, this is the graphic assigned as the logo in Company Preferences. However, you can specify a different image in each template if you wish, or even multiple images.

**Graphic Line.** This is a horizontal line which can be placed as a separator on the page. This is different than using borders, which are explained in *Changing Fonts, Field Labels and Other Attributes* (page 605).

### Default Templates

Point of Sale provides pre-defined templates for each document type. These default templates can be modified, or you can make a copy to use as a starting point to create a new template.

If you modify a default template, you will always have the option to revert this template back to the default design. If you create or edit a template, Point of Sale will prompt you to assign the template as the default for printing that document type. To make changes to default template assignments directly, you can make changes on the Documents & Printers page of workstation preferences.

**Preferences: Specifying Document Templates**

EDIT ➤ PREFERENCES ➤ WORKSTATION ➤ DOCUMENTS & PRINTERS ➤ Define printing instructions. For each document type, specify the template to use when printing (make sure it matches your printer, i.e. don't choose a letter-size template to print on a 40-column printer). Other print options, such as the printer to use, number of copies to print, whether you want to display the Print Dialog the time of printing, etc. can be specified as well.

**Deleting Templates**

Default templates cannot be deleted.

**Upgraders and Modified Templates**

When new Point of Sale versions are released which include changes to default templates, if you have modified the default templates, the upgrade process will not alter your modified designs. In such cases, if new fields have become available they will not appear in your previously modified templates unless you add them yourself using Print Designer.

If you have upgraded from a previous version and were using modified templates, you may wish to review your templates to determine if you wish to add any new fields that may now be available.
Modifying or Creating a Template

To select a template to modify or copy:

1. From the Tools menu, select PRINT DESIGNER.
2. Select the document category you wish to modify from the Select a Document Type drop-down list.
3. Select the specific template you wish to open from the Available Templates list.
4. To copy a default template as a starting point for a creating new one, choose COPY SELECTED from the Options menu.

   Or

   To edit an existing template, select MODIFY at the bottom of the window.
5. Customize the template as needed. Refer to the following sections for detailed instructions.
6. Select SAVE or SAVE AS when done. If creating a new template, enter a unique name for the template.
**Displaying Example Text**

When you view a template in Print Designer, the information fields can either be populated with example information or with labels identifying the type of information that will appear in the printed document. You can select either view and switch between them if needed. Each view has its advantages.

**To turn on/off example text:**

1. With a template displayed, select **PREFERENCES** in the lower left corner.
2. Select or clear the **SHOW EXAMPLE TEXT FOR DATA FIELDS** checkbox as needed.
3. Select **OK**.

**Recommended Design Sequence**

There are no hard and fast rules for the order in which you must modify templates. But you may find this recommended sequence helpful in accomplishing your goals in an efficient manner. Specific instructions for each action are contained in the following pages.

1. Click anywhere in the section with which you want to work to make it active.
2. Remove elements from the template that you do not wish included on the printed document. This helps create space for adding other fields or moving fields around.
   - Use the Zoom controls to make selecting and working with individual elements easier.
   - If additional space is needed while working in a section, drag the bottom section divider downward.
3. Add all new elements as needed, placing them in their approximate location by dragging-and-dropping.
4. Resize elements and make any necessary changes to element properties. Use the Preview feature to see how your changes will look as you progress.
5. Use the alignment tools to precisely place elements in their final position, working from the top of a section downward.
6. Remove any extra white space at the bottom of the section by dragging the bottom divider upward.
7. Do a final preview and save your template.
Modifying or Creating a Template

Adding and Removing Elements

It can be helpful to remove unwanted elements before adding new elements to a section. This will provide more space in the template to position the new element.

To remove elements

1. Select the element in the template you wish to remove.
2. From the toolbar, select REMOVE.
   
   Or

   Press <DELETE> on your keyboard.

Non-Deletable Elements

Some elements are required for the document. Required fields may be moved, but cannot be deleted. These elements are displayed in gray.

Selecting Multiple Elements

To select and move multiple elements, hold down the <Shift> key and click on each, or simply drag your mouse to encompass elements to select them. You can now move the elements together.

To add a data field or group of fields:

1. Select the section of the template to which you are adding the field(s).
2. From the toolbar, select ADD DATA FIELD OR GROUP OF FIELDS.
3. Select the individual data field element or group element you wish to add.
4. Select OK. The element is placed in the active section.
5. Drag the field or group into the preferred position in the section.
6. Resize width as needed.

Available Elements

The elements available to add vary by section. Some elements can be added to more than one section, while others can be placed on the template only once. It may be necessary to remove the element from one section before it can be added to another section.

Adding or Changing Bar Code Fields on Tags

Refer to Working with Bar Codes (page 612) for important information about bar codes.
To add a text field:
1. Select the section of the template to which you are adding the text.
2. From the toolbar, select ADD ➤ STATIC TEXT OR LABEL.
3. Type the message in the Text field.
4. Select LEFT, CENTER or RIGHT for the text justification.
5. Change the font if preferred.
6. Apply borders from the Border panel if wanted.
7. Select OK.
8. Drag the text field into the preferred position in the section.
9. Resize width as needed.

To add your store logo:
You must have specified a logo in company preferences before this option is available. Refer to Adding Your Logo to Printed Documents (page 591).
1. Select the section of the template to which you are adding the logo.
2. From the toolbar, select ADD ➤ STORE LOGO.
3. Select OK.
4. Drag the logo into the preferred position in the template.
5. Resize the logo as needed.

To use an alternate logo image:
You must have specified more than one image in company preferences to use for logos before this option is available. Refer to Adding Your Logo to Printed Documents (page 591).
1. Add the logo to the template as described above.
2. With the image selected, click the PROPERTIES icon on the toolbar.
3. Select ALTERNATE IMAGE and SPECIFY.
4. Choose from the available images (or add another image if needed) and choose SELECT.
5. Select OK.

To add a graphic line:
1. Select the section of the template to which you are adding the line.
2. From the toolbar, select ADD ➤ GRAPHIC LINE.
3. Drag the line into the preferred position in the template.
4. Resize width as needed.
Positioning Elements

To quickly place an element on the template, simply drag-and-drop it where needed. You can then use additional positioning tools to fine-tune the alignment.

To use drag and drop positioning:

1. Select the section of the template you wish to modify.
2. Select an element within the section.
3. Drag and drop the element to the preferred position.

Or

Use the arrow keys on your keyboard to move the element to the preferred position.

Other Positioning Tools

X/Y Position Guides. You can also use the X/Y position guides in the lower right-hand corner to assist in positioning elements. With an element selected, you can use your arrow keys to move the element. Holding <CTRL> while using the arrow keys moves the element at 10 times the speed.
Chapter 35: Customizing Printed Documents (Pro)

X = Horizontal position on the page of the left-hand edge of the element
Y = Vertical position on the page of the top edge of the element
W = Element width
H = Element height

**Side and Top Rulers.** Turn on the display of the side and top rulers by selecting PREFERENCES in the lower-left corner of the template window and checking the respective checkboxes. As you drag an element, an indicator line corresponding to the cursor position is displayed on the rulers.

---

**Side Ruler Doesn’t Reflect Printed Position**

Note that the side ruler does not indicate absolute vertical position in the printed document, as sections expand/collapse when printed to accommodate the actual data printed.

---

**Snap and Alignment Tools.** The snap and alignment tools help you to precisely align elements relative to each other or to the section dividers. Typically, this precise alignment is the last step in completing your template modifications. Refer to Aligning Elements Using “Snap” and the Toolbar (page 609) for more information.

---

**Sizing Elements**

To quickly size an element, drag the side border handles as needed. You can then use additional sizing/aligning tools to fine-tune the size and position relative to other elements.

**To use drag and drop sizing:**

1. Select the element you wish to resize.

2. Select one of the handles on either side of the element and drag it in or out until the element reaches the needed size.
Modifying or Creating a Template

Use the X-Y position guides and top ruler to help you size the element in the same manner used when positioning it.

---

### Re-Sizing Height

The height of most elements is determined by its content and cannot be adjusted manually.

---

### Re-Sizing Width

When re-sizing the width of an element, always ensure that you are allowing enough space for the information that will be appearing in this element in the printed document.

---

The alignment tools can also help with final, precise sizing of an element relative to other elements or to the width of the section. Refer to Aligning Elements Using “Snap” and the Toolbar (page 609) for more information.

---

### Changing Fonts, Field Labels and Other Attributes

To change the attributes of an element you must access the properties dialog window for that element.

**To access Properties:**

1. Select the element you wish to modify.
2. From the toolbar, select **PROPERTIES**.

*Or*

Double-click the element.

3. From the **Properties** window you can change fonts, add borders to an element, select what fields appear in a group element, turn on or off displaying a group label, and change a group label.

4. When done making changes, select **OK**.

The following example is from the **Store Information** group element in the **Document Heading** section of a Sales Receipt template. The properties available for other elements may vary.

---

⚠️ **Warning: Changing Fonts**

40-column documents may not support larger font sizes of non-standard fonts. Be sure to preview and/or test the new design.

Not all font attribute are supported when printing tags and non-Avery labels. Be sure to test-print your template changes to ensure they are printing to your satisfaction.
Navigate through the tabbed pages on the dialog, making changes as needed. As you make changes the sample preview at the bottom shows you how they will look.

If you are displaying a field label or a group label to the left of a data field, you can adjust the width of the space for the label by adjusting the Label Fixed Width on the Group Label tab.

Field Labels and Group Labels

When set to be displayed, the Field/Group Label will be printed on the document. This helps to identify what type of information is being displayed. For example, if an address is being displayed, it might be helpful to identify if it is a billing or shipping address.
Customizing an Item List or Style Grid

The group of fields for listing items on documents is slightly different from other field groups. As shown in the following image, for an item list, there are three lines of information that can be displayed for an item. Each of these lines have different options for available data fields. Multiple lines can be helpful, especially if you are using a 40-column printer. You can add, remove and arrange the fields on each line, change fonts, and revise heading and field labels in the same manner as you assign and arrange fields in other groups.

The columns of information can be rearranged by simply dragging a column heading or data field to the preferred position as shown below left.

Field widths can be adjusted by dragging the field dividers as shown above right.

Field Labels

When selected to be displayed, labels for the first row of information are placed as a “heading” above the associated field. Labels for information fields appearing in the second and third lines are displayed within the same field as the actual information, such as Department: Baseball. These labels can be revised or not displayed at all as you prefer.
Using a style grid instead of a standard item list can be a great space saver on documents. To use a style grid, simply select it from the drop-down list at the top of the Properties window.

Fields are selected for the style grid in the same manner as for the item list. To change the axis for the grid, select the Style Grid Details tab.
Aligning Elements Using “Snap” and the Toolbar

Snap Alignment

Snap alignment allows you to perfectly align the edges or two or more elements. When “Snap” is selected and two elements are placed with their borders overlapping, the edge of the second element will automatically align with the edge of the element it is placed near.

Although using the snap option will align elements to each other, the display is not an accurate representation of how the printed document will appear. It is recommended that you test your modified templates before implementing them for general use.

To turn on/off snap alignment:

1. With a template displayed, select PROPERTIES in the lower left corner.
2. Select or clear the SNAP OVERLAPPING OBJECTS TO THEIR EDGES checkbox.
3. Select OK.

Alignment Tools

Alignment tools can be used on individual elements, or they can be used on multiple elements at the same time. When used on multiple elements, the first element selected is referred to as the “anchor element.” Other selected elements will be oriented to the position of the anchor element according to the alignment tool selected.

You can also align selected elements to the top, right, left, bottom or center of the section in which it appears.

Relative Alignment

Actual alignment on the printed documents may vary according to the printable area and margin settings for your printer. It is always recommended to test your template by printing sample documents before putting a template into general use.

To use the alignment tools:

1. Select the element or elements you wish to align. To select multiple elements, hold down the \textless SHIFT\textgreater key while clicking each one.

When selecting multiple elements, remember that the first element selected is the anchor element. Other elements will be adjusted relative to it.
2. Click the down arrow on the right side of the alignment button.
3. From the drop-down menu displayed, select the alignment function to perform.

You can also select **SHOW ALIGN TOOLBAR** to add the tools to the toolbar. See the following explanations of how the different alignment tools operate.

- **Align Left**: Align the left edges of all selected elements with the left edge of the anchor element, or the left edge of the selected elements with the left edge of the section.

- **Align Top**: Align the top edges of all selected elements with the top edge of the anchor element, or align the top edge of the selected elements with the top edge of the section.

- **Align Right**: Align the right edges of all selected elements with the right edge of the anchor element, or align the right edge of the selected elements with the right edge of the section.

- **Align Bottom**: Align the bottom edges of all selected elements with the bottom edge of the anchor element, or align the bottom edge of the selected elements with the bottom of the section.

- **Align Vertical Center**: Align the center of all selected elements with the vertical center of the anchor element, or align the center of the selected elements with the vertical center of the section.

- **Align Horizontal Center**: Align the center of all selected elements with the horizontal center of the anchor element, or align the center of the selected elements with the horizontal center of the section.

- **Make Same Width**: Adjust the width of all selected elements to match the width of the anchor element or to make the width of the selected elements match the width of the section.
Print Designer Hints and Tips

Undoing Changes
The easiest way to correct a mistake is to select UNDO from the toolbar. This feature allows you to go back through changes made to the template design up to the last time the template was saved.

Saving Modifications
Save often as you work. However, keep in mind that saving clears the “Undo” memory; once you have saved you will not be able to “undo” to a previous state. A good practice is to change something, preview it (see below) to be sure it looks as you intended, and then save. Use SAVE AS to save the template with a different name, thus preserving the original template unchanged.

Previewing Templates
You can more accurately view an example of the printed output by selecting PREVIEW to display your document design in the Previewer. Features available in the Previewer include the ability to navigate, view, or print your document design.

Zooming your View
You can adjust the viewing magnification in the designer window by zooming out to see more of the page, or by zooming in to see an area more clearly.
Use the In and Out buttons to zoom in or out, or select a magnification from the drop-down menus.

Printing Tags and Labels
Due to printer specifications, there is very little room for error in template designs for tags and non-Avery labels. Neither the design view nor the print preview are able to completely predict how the design will print on the actual label or tag.

To ensure your modifications to these templates will function properly, be sure to test these from the area of the program from which they are normally accessed. For example, if you modify the tag template, go to inventory and print some sample tags and test bar codes to make sure they scan properly.
If you are printing tags on a Zebra printer, the **CALIBRATE** button is added in Print Designer.

When you change label types, or anytime printing is misaligned on labels, you should calibrate the Zebra printer by selecting the **CALIBRATE** button. Several labels will be fed through the printer during this operation. When calibration is complete, you can roll the labels back into the printer to avoid waste.

**Working with Bar Codes**

Print Designer provides three bar code fields for you to use on tag templates: **Item #**, **UPC**, and **Lookup** (alternate lookup field in inventory). Two barcode formats (standard and compact) are available and can be selected from the barcode element properties dialog. This dialog also provides descriptions of the barcode format usage.

The default tag templates use the item number bar code field. Using the item number for bar codes has several advantages:

- You can print bar-coded tags for any item in inventory, even if you do not have a vendor-provided UPC code
- The smaller bar codes created from item numbers fit better on smaller tag sizes
- If a tag bar code is unscannable due to damage, it is quicker to manually enter an item number (also printed on the tags) than the longer UPC or alternate lookup

If preferred, you can change the bar code field on tags printed in Point of Sale to use the UPC or Lookup values instead. If you do so, also change the alphanumeric field under the bar code to match your choice, i.e. if printing a UPC bar code, change the Item # field under the bar code to the UPC field.

If you resize a bar code field after adding it to your template, especially if making it smaller, be sure to test a printed tag to be sure your scanner will accurately read it.
Importing and Exporting Templates

The **Import & Export** feature allows you to easily export your modified templates so you can import them into a new company data file or to other store locations. The export process places copies of all modified templates into a single XML file.

**To export modified templates:**

1. From the Print Designer template selection window, select **IMPORT & EXPORT**.
2. Select **EXPORT DOCUMENT TEMPLATES** and then **NEXT**.
3. Select either **EXPORT THE SELECTED DOCUMENT OR TAG** or **EXPORT ALL DOCUMENTS AND TAGS** and select **NEXT**.
4. Select the destination location for the template file and select **SAVE**.
5. Select **CLOSE**.
   
   Your modified templates are now in an XML file and are ready to be copied to another workstation for import.

**To import modified templates:**

1. From the Print Designer selection window, select **IMPORT & EXPORT**.
2. Select **IMPORT DOCUMENT TEMPLATES** and then **NEXT**.
3. Browse to the XML file containing the template information and select it.
4. Select **OPEN** and then select **CLOSE**.
   
   Be sure to assign the imported templates in workstation printing preferences as preferred. Refer to Chapter 3 General Printing Information (page 39) for more information about assigning templates for printing.

---

**Importing Templates**

You can also import print templates by selecting **UTILITIES ➤ IMPORT PRINT TEMPLATES** from the File menu.
Customizing Reports

Point of Sale Report formats, filters, and display options can be modified to better suit your needs and then memorized so that they can be run whenever needed.

Refer to Modifying Report Options (page 466) for details on how to modify report formats and content.
Section X: Appendices and Index

APPENDIX A: Preferences ........................................ 617
APPENDIX B: Information Fields ............................... 643
APPENDIX C: Configuring Firewalls ......................... 669
APPENDIX D: POS Compatible Equipment ................. 681
Index .................................................................. 685
## Preferences

Preferences Overview .................................................. 618
Conventions ...................................................................... 618
Keyboard Commands in Preferences ................................. 619

Company Preferences ...................................................... 620
General ........................................................................... 621
General - Store Info ......................................................... 623
General - My Field Labels ................................................ 623
Financial ................................................................. 624
Financial - Accounts – Basic ........................................... 625
Financial - Accounts – Advanced ....................................... 626
Merchant and Gift Card Services ....................................... 626
Merchant and Gift Service – Communication Setup .......... 627
Multi-Store (Pro Multi-Store) ............................................. 628
Inventory ........................................................................ 629
Pricing ............................................................................ 630
Purchasing ....................................................................... 630
Receiving ........................................................................ 631
Sales ............................................................................. 631
Customers ...................................................................... 633
Customer Orders - Layaways, Sales Orders, Work Orders (Pro) 634
Sales Tax ........................................................................ 634
E-mail Documents (Pro) .................................................... 635
Ratings & Trends ............................................................... 635
Integrated Applications .................................................... 636

Workstation Preferences ................................................... 636
General ........................................................................... 637
Software Updates ............................................................... 637
Hardware ........................................................................ 637
Cash Drawer ..................................................................... 638
Modem .......................................................................... 638
Bar Code Scanner ............................................................ 638
Card Reader (MSR) ............................................................ 639
Customer Pole Display .................................................... 639
Touchscreen Monitor ........................................................ 639
Physical Inventory Scanner ............................................... 640
PIN Pad .......................................................................... 640
Available Printers ............................................................. 640
Documents & Printers ....................................................... 641
Print Options .................................................................... 641

---

*QuickBooks Point of Sale*
Preferences Overview

Preference settings are used to configure Point of Sale to work with your hardware and to customize many of the Point of Sale features to best suit the needs of your business. Many of the basic preference settings are initially configured as you complete the Setup Interview process, but can also be directly edited at anytime.

There are two types of preferences: company and workstation. In company preferences, you can configure the settings and define the options that are shared by all Point of Sale workstations on a network. Workstation preferences define workstation-specific settings and options, including hardware setup and printing configuration.

Conventions

This appendix is divided into two sections, with one section devoted to company preferences and the other to workstation preferences. Each section is in a table format with three columns: Preferences, Options, and Functions.

- The **Preferences** column includes each preference's descriptive name as it appears on screen.
- The **Options** column lists the possible settings for the preference. When you see ☑, ☐ in the Option column, it means the choices are made by selecting or clearing a checkbox. Selecting a checkbox enables a feature, clearing the checkbox disables it.
  (d) Indicates the default setting, where applicable. If you see ☑, ☐(d) it means the default for that preference checkbox setting is unchecked.
- The **Functions** column gives brief descriptions of how each setting will affect the program. How a preference setting affects program functionality may be explained in further detail in the User Guide section pertaining to that particular function.
Keyboard Commands in Preferences

<↑↓> (Preference menu) Move cursor up/down the preference menu displaying each page as it is chosen.

<LETTER> (Preference menu) Displays the next page that starts with the letter pressed.

<TAB> Cycle through preference settings on the displayed page.

<SPACE BAR> Select or clear checkbox preference setting.

<F4> Display drop-down menus associated with the selected preference setting.

⚠️ Undoing and Resetting Preference Changes

Two options are available from the I Want To menu in preferences: UNDO CHANGES cancels all changes since your last save, and RESET TO DEFAULT SETTINGS reverts all preferences to their original settings. Note that both options affect all preferences in your current module (company or workstation), not just the preference page you are currently viewing. Be especially careful using the RESET TO DEFAULT SETTINGS option, as it reverts all preferences setting, including your sales tax setup if in company preferences, to the original program values.

⚠️ Warning: Editing Some Company Preferences Requires Closing Open Windows

Editing some company preferences, either directly or through the Setup Interview, requires that other open program windows be closed. If you select save in preferences with open windows, Point of Sale will alert you and give you a chance to close them before continuing. A good practice is to close all open windows before editing preference settings.

⚠️ Pro Multi-Store

Headquarters sets most company preferences that are shared by all stores. Refer to Chapter 31 Multi-Store Basics (page 533) for more information on the company preferences that can be set at a remote store.
Company Preferences

This is the general procedure for editing company preferences.

Refer to the following pages for a description of each individual preference setting.

1. Suggested: Close all open Point of Sale windows, except the main screen (Navigator).
   You can view, switch to, or close currently open windows by selecting them from the Window menu at the top of your screen.

2. From the Edit menu, select PREFERENCES ➤ COMPANY.

3. From the list on the left of the screen (sample shown to the right here), choose the preference area you want to edit.
   The corresponding page is displayed.

4. Edit the preference settings as necessary.

5. Select SAVE.
   Or select CANCEL to exit without saving changes.
# General

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Require users to log in</th>
<th>☑, ☐ (D)</th>
<th>Select to require employees to use their login name and password. Once turned on, employee access to program features and data will be restricted by the rights of their assigned security group. When turning this requirement on, you are prompted to enter a System Administrator (SysAdmin) password. Only the SysAdmin user will be able to change this setting in the future. If logins are not required, all employees have total access to all of Point of Sale features. Refer to Chapter 5 Data and Program Security (page 65) for more information on using security in Point of Sale.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Automatically logout user after each sale</th>
<th>☑, ☐ (D)</th>
<th>Select to automatically log out currently logged in employee upon saving a receipt. This is useful for workstations shared by multiple cashiers. This option is only available if employees are required to login.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Warn when editing documents, items, or customers</th>
<th>☑ (D), ☐</th>
<th>Confirm edits to documents, items, or customers if you attempt to leave activity without saving.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Warn when deleting documents, items, or customers</th>
<th>☑ (D), ☐</th>
<th>Confirm deletions of documents, items, or customers before carrying out the action.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Bring back all one time messages</th>
<th>☑, ☐ (D)</th>
<th>Selecting DO NOT SHOW ME AGAIN from a message dialog prevents the message from being displayed. Selecting this preference will bring back all such messages.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Select Features to Use</strong></th>
<th></th>
<th></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>I want to track customers</th>
<th>☑ (D), ☐</th>
<th>Disabling this option removes the customer tracking options and fields from the program interface and menus. (Pro) Disabling this option will also remove availability of sales orders, layaways and work orders.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>I want to record shipping addresses on sales receipts (Pro)</th>
<th>☑ (D), ☐</th>
<th>Disabling this option will remove shipping address and related fields from customer records and sales forms.</th>
</tr>
</thead>
</table>

| I create Customer Sales Orders (Pro) | ☑ (D), ☐ | Disabling this option will remove customer sales orders availability and remove the unused features from the interface and menus. |
### Appendix A:

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>I create Customer Layaways (Pro)</td>
<td>☑ (D), ☐</td>
<td>Disabling this option will remove layaway availability and remove the unused features from the interface and menus.</td>
</tr>
<tr>
<td>I create Customer Work Orders (Pro)</td>
<td>☑ (D), ☐</td>
<td>Disabling this option will remove work order availability and remove the unused features from the interface and menus.</td>
</tr>
<tr>
<td>I want to use “styles” to help organize my inventory (Pro)</td>
<td>☑ (D), ☐</td>
<td>Disabling this option will remove item style availability in inventory and remove the unused features from the interface and menus.</td>
</tr>
<tr>
<td>I want to track employee hours (Pro)</td>
<td>☑ (D), ☐</td>
<td>Disabling this option will turn off the employee Time Clock feature.</td>
</tr>
<tr>
<td>I create Purchase Orders when buying and/or receiving merchandise</td>
<td>☑ (D), ☐</td>
<td>Disabling this option will remove purchase orders availability and remove the unused features from the interface and menus.</td>
</tr>
</tbody>
</table>

### Data Safeguard

| Automatically create backups of company data | ONCE A DAY WHEN EXITING POINT OF SALE (D) EVERY DAY AT <TIME> TO <FOLDER> | By default, a backup of your company data is made once per day when you exit the program from the Server Workstation. Use this setting to schedule a backup instead at a time and to a folder of your choosing. **Important:** Read the information in the help sidebar about requirements for scheduled backups before making changes to this setting. (Pro) If desired, select the checkbox to **INCLUDE ITEM IMAGES**... in your backup file. Note: This option may significantly increase the time and size of your backup. |
### General - Store Info

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store Headings</td>
<td>USER-DEFINED</td>
<td>This information is printed across the top of documents.</td>
</tr>
<tr>
<td>Use Image as default Logo</td>
<td>☑, ☐(D)</td>
<td>Select the checkbox and then SPECIFY to browse for graphic files to use as your logo on printed documents. You can add several and switch between them to be printed on documents. Graphic formats supported are .bmp, .gif and .jpg. File sizes greater than 100 KB may slow printing; maximum size is 1.5 MB. Maximum logo width is 248 pixels on a 40-column receipt printer, or 381 pixels on letter-size receipts. The logo will be scaled if necessary to fit. (Pro) You can use Print Designer to resize and place logos or to use different logos on each printed document.</td>
</tr>
</tbody>
</table>

### General - My Field Labels

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Attribute 1 (Attr)</td>
<td>ATTRIBUTE (D)</td>
<td>Define your own label for this item field to best describe your merchandise. The label you specify is used throughout the program.</td>
</tr>
<tr>
<td></td>
<td>USER-DEFINED</td>
<td></td>
</tr>
<tr>
<td>Inventory Attribute 2 (Size)</td>
<td>SIZE (D)</td>
<td>Define your own label for this item field to best describe your merchandise. The label you specify is used throughout the program.</td>
</tr>
<tr>
<td></td>
<td>USER-DEFINED</td>
<td></td>
</tr>
<tr>
<td>Inventory Name</td>
<td>ITEM NAME (D)</td>
<td>Define your own label for this item field to best describe your merchandise. The label you specify is used throughout the program and printed on sales receipts.</td>
</tr>
<tr>
<td></td>
<td>USER-DEFINED</td>
<td></td>
</tr>
<tr>
<td>Inventory Description</td>
<td>ITEM DESCRIPTION (D)</td>
<td>Define your own label for this item field to best describe your merchandise. The label you specify is used throughout the program.</td>
</tr>
<tr>
<td></td>
<td>USER-DEFINED</td>
<td></td>
</tr>
<tr>
<td>Custom Fields (Pro)</td>
<td>USER-DEFINED</td>
<td>Define custom field labels for item, customer, employee and vendor records. Your custom label is displayed throughout the program. If integrated with QuickBooks financial software, the information in custom fields is shared, provided they are named exactly the same in both programs.</td>
</tr>
<tr>
<td>Restore to Defaults</td>
<td>SELECTION</td>
<td>Select at the bottom of the page to revert all field labels to the program default values.</td>
</tr>
</tbody>
</table>
## Financial

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use with QuickBooks Financial Software</td>
<td>☑, ☐ (D)</td>
<td>Select to allow the exchange of data between Point of Sale and QuickBooks financial software.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The rest of the financial preferences below are only available if this option is selected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to Chapter 27 Financial Exchange Basics (page 479) for more information on Financial Exchange.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>QuickBooks must be running and the financial company file you intend to share data with open to establish the initial connection.</td>
</tr>
<tr>
<td>QuickBooks Company file</td>
<td>AUTO-FILLED</td>
<td>Once your connection to QuickBooks is established, Point of Sale fills these fields with the path and name of your QuickBooks company file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select SET UP QUICKBOOKS CONNECTION NOW to establish the connection.</td>
</tr>
<tr>
<td>Send receipts and vouchers with:</td>
<td>DETAILED ITEM DESCRIPTIONS (for all receipts and vouchers)</td>
<td>Select to send item and customer detail on all receipts and vouchers, to send for charge account transactions only, or to send summarized information for both.</td>
</tr>
<tr>
<td></td>
<td>DETAILED ITEM DESCRIPTIONS FOR CHARGE ACCOUNT TRANSACTIONS ONLY</td>
<td>Refer to Chapter 30 Customizing Financial Exchanges (page 519) for more information.</td>
</tr>
<tr>
<td></td>
<td>SUMMARIZED ITEM TOTALS (D)</td>
<td></td>
</tr>
<tr>
<td>Send discounted items with</td>
<td>NET VALUE (D)</td>
<td>Select how you wish the sale of discounted items to be sent to QuickBooks. By default, discounts are not sent and are not accounted for separately in QuickBooks.</td>
</tr>
<tr>
<td></td>
<td>SEPARATE ORIGINAL AND DISCOUNTED VALUES</td>
<td></td>
</tr>
<tr>
<td>Customer name order</td>
<td>LAST, FIRST (D)</td>
<td>Use this option to match the customer name order to the way you display names in QuickBooks.</td>
</tr>
<tr>
<td></td>
<td>FIRST LAST</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TITLE FIRST LAST</td>
<td></td>
</tr>
<tr>
<td>Employee Hours (Pro)</td>
<td>☑, ☐ (D)</td>
<td>Requires QuickBooks 2008. If using Time Clock to record employee hours worked, select to send the time records and specify the hourly payroll item to be used for the time entries created in QuickBooks. Only payroll items previously created in QuickBooks are available for selection. This option is only available if time tracking is set up in both programs.</td>
</tr>
</tbody>
</table>
# Financial - Accounts – Basic

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Item Accounts</td>
<td>USER-DEFINED</td>
<td>Specify default Income, Cost of Goods (COGS), and Asset accounts for each item type. With a few exceptions for income accounts, all of your QuickBooks accounts are available for selection from the drop-down list in each field. The accounts specified here are assigned to each item added to inventory and affect how item transactions are posted to QuickBooks. You can manually assign different accounts to individual items in inventory, if necessary. Select <strong>APPLY ACCOUNTS TO EXISTING ITEMS</strong> at the bottom of the page to implement account changes on all existing items. Use this option with caution: ALL existing items will be set to these accounts, overwriting any manual changes you have made. Note: Service and non-inventory items default to expense accounts in the COGS account field. Typically these items have no cost associated with them, but if they do (such as when you sub-let the service) you can select accounts other than the defaults. <em>Refer to Custom Mapping of Accounts (page 524) for more information.</em></td>
</tr>
<tr>
<td>Automatically create sub-accounts based on DEPARTMENT DEPARTMENT THEN STORE (PRO MULTI-STORE) STORE THEN DEPARTMENT (PRO MULTI-STORE)</td>
<td>DEPARTMENT DEPARTMENT THEN STORE (PRO MULTI-STORE) STORE THEN DEPARTMENT (PRO MULTI-STORE)</td>
<td>Have Point of Sale automatically create sub-accounts in your QuickBooks financial software. <em>Refer to Map QuickBooks Accounts by Department or Store (page 526) for more information.</em></td>
</tr>
</tbody>
</table>
## Financial - Accounts – Advanced

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account mapping</td>
<td>USER-DEFINED</td>
<td>Each account/field in Point of Sale must have a corresponding account in QuickBooks specified, to which data is transferred. You can accept the default account mappings or define your own mapping structure by choosing from each of the lists in the QB Account column. (Only accounts previously defined in your financial software are available for selection.) Select <strong>RESET TO DEFAULTS</strong> if you have customized mappings but want to return the default chart of accounts. Refer to Custom Mapping of Accounts (page 524) for more information.</td>
</tr>
</tbody>
</table>

## Merchant and Gift Card Services

(Also see Sales (page 631) preferences for defining allowed credit card types.)

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merchant Service</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Merchant Number</td>
<td>PROVIDED BY QUICKBOOKS POS MERCHANT SERVICE</td>
<td>Enter the QuickBooks POS Merchant Number you receive via e-mail. Be sure to complete your communication setup (see next page) before selecting the <strong>VERIFY</strong> button to verify the merchant number. <em>Do not enter an account number if using a different merchant service.</em></td>
</tr>
<tr>
<td>Do not allow manual transactions that fail address verification</td>
<td>☑️, ☐️ (D)</td>
<td>Select to disallow manual credit card transactions when the ZIP Code and/or street address provided by the customer does not match bank records. Select the “What is This” link on the preference window for more information.</td>
</tr>
<tr>
<td>Do not allow manual transactions that fail card verification</td>
<td>☑️, ☐️ (D)</td>
<td>Select to disallow manual credit card transactions when the card verification code does not match bank records. Select the “What is This” link on the preference screen for more information. <em>Note: Some card issuers deny such transactions regardless of this setting.</em></td>
</tr>
</tbody>
</table>
### Company Preferences

#### Merchant and Gift Service – Communication Setup

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept debit/ATM card payments</td>
<td>✔️, ☐ (D)</td>
<td>Select to allow customer payment by debit/ATM card. Also specify if you allow cash back and specify a maximum (up to $200). PIN debit payments/cash back require a PIN pad device. Refer to PIN Pad (page 640) for information on configuring a PIN pad. This setting applies to users of other merchant services as well as to users of the QuickBooks POS Merchant Service.</td>
</tr>
</tbody>
</table>

#### Gift Card Service

| Gift Card Account Number | PROVIDED BY QUICKBOOKS POS GIFT CARD SERVICE | Enter the Gift Card account number you receive via e-mail. Be sure to complete your communication setup (see next page) before selecting the VERIFY button to verify the validity of the number. |

#### Merchant and Gift Card Service - Shared Preference

| Automatically print and save receipt upon credit, debit, or gift card approval | ✔️, ☐(D) | Select to have receipts automatically print as soon as transaction approval is received. This allows you to return to servicing the customer while approval is pending. |

#### Merchant and Gift Service – Communication Setup

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use this computer to connect for all credit, debit, and gift card transactions.</td>
<td>☐(D), ☐</td>
<td>All card transactions are processed through one workstation. To enable this function on this computer, select the checkbox. The selected computer must be equipped with a modem or Internet connection. If the box is checked and grayed out, then this computer is already assigned for these transactions. Default: Server Workstation.</td>
</tr>
</tbody>
</table>

| Communication Setup | SECURE INTERNET CONNECTION | Select an option for communication with QuickBooks POS Merchant and/or QuickBooks Gift Card Service. SECURE INTERNET CONNECTION provides an IP-based connection through your Internet Service Provider (ISP). A persistent (always on) Internet connection is recommended for this option. Select INTERNET CONNECTION SETUP for assistance in configuring an IP connection. The DIRECT-DIAL option supports high speed and advanced modem technologies using most modem's default settings. |
## Multi-Store (Pro Multi-Store)

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Store Type</td>
<td>CHANGE TO REMOTE</td>
<td>This page summarizes your store type information. You can use this page to change a store from Headquarters to remote. <strong>Read the information on this page carefully, as changing store types at any time other than the initial installation requires additional steps to protect your data.</strong></td>
</tr>
<tr>
<td>Store Codes/Classes</td>
<td>USER-DEFINED</td>
<td>(Headquarters only) Enter your total number of stores, and then assign a unique alphanumeric code to each of them. This code is displayed throughout the program and on multi-store reports. <strong>Note:</strong> Changing your number of stores requires that all inventory and document windows be closed before saving. Optionally, assign a QuickBooks class to each store to allow P/L (Profit/Loss) reporting by store in your financial software. You must have configured QuickBooks to use classes to use this option in Point of Sale. Refer to <strong>Store Tracking and Profit/Loss Reporting by Class (page 541)</strong> for more information.</td>
</tr>
<tr>
<td>Store Exchange</td>
<td>USER-DEFINED</td>
<td><strong>Configuration tab:</strong> Specify a communication method for Store Exchanges with other stores, then select <strong>CONFIGURE</strong> to enter the other store’s license number and e-mail address or file transfer path. <strong>Options tab:</strong> Enter a password to encrypt Store Exchange files (required and must be the same at all stores), your “in folder” for receiving files from other stores, and optionally, schedule Store Exchanges to occur at the same time each day. Read the information and use the links in the right-side help panel for assistance with these choices.</td>
</tr>
<tr>
<td>Store Headings</td>
<td>USER-DEFINED</td>
<td><em>(Headquarters only)</em> Enter store name, address, and miscellaneous information for each store. This information is included on printed sales documents.</td>
</tr>
</tbody>
</table>
# Company Preferences

## Inventory

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>I want to associate pictures with my inventory items (Pro)</td>
<td>🟢, □(D)</td>
<td>Select to add image fields to the inventory item form and make them available in other program areas. <em>Refer to Pictures in your Item Records (Pro) (page 170) for more information.</em></td>
</tr>
<tr>
<td>Reset automatic item number sequencing when an item number is edited</td>
<td>🟢, □(D)</td>
<td>When checked, editing an item number will reset the automatic numbering sequence to start with the next available number after the edited number.</td>
</tr>
<tr>
<td>Create reorder reminders based on: (Pro)</td>
<td>AVAILABLE QUANTITY (D) ON-HAND QUANTITY</td>
<td>Specify how reorder point reminders are calculated. Using available quantities means that quantities committed to open customer orders are taken into consideration when calculating the reminders. <em>Refer to Reminders Based on Available Quantity (Pro) (page 183) for more information.</em></td>
</tr>
</tbody>
</table>

## UNIT OF MEASURE

| Unit of Measure | USER-DEFINED | Define and manage the units of measurement by which your items are purchased and sold, such as each, inch, yard, gallon, can, case, gross, etc. Once defined here, you can specify a unit for individual items in inventory. Also, specify the default unit to be assigned to new items. |

## MULTIPLE UNITS OF MEASURE (PRO)

| I want to set up multiple units of measure... | 🟢, □(D) | Buy and sell merchandise using different unit, such as case, pack or single, with the ability to assign unique UPC numbers, alternate lookups, and prices to each unit. *Refer to Multiple Units of Measure (Case-to-Unit) (Pro) (page 185) for more information.* |
| Print unit of measure information... | 🟢, □(D) | Select to insert the unit of measure information in the quantity field on printed documents. |

## DISPLAYING UNITS OF MEASURE (PRO)

| Displaying Unit of Measure | ALWAYS DISPLAY... (D) LET ME MANUALLY ADD... | Have unit of measure columns automatically appear in all documents and lists, or whether you want to add them yourself only to the areas you wish. |
## Pricing

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Price</td>
<td>REGULAR PRICE (D)</td>
<td>Select a default price from the drop-down list. This will be the price level suggested on sales at this store. Default: Regular Price. This price level can be changed as you make individual sales.</td>
</tr>
<tr>
<td></td>
<td>YOUR OTHER PRICE LEVELS</td>
<td>Name up to four (4) optional markdown price levels and a markdown % (0-99) for each. The prices for the additional price levels are calculated from the regular price. For example, if you enter a markdown of 20% for a price level, the price at that price level will be a 20% markdown compared to your regular price. Tip: For no markdown, enter 0%. To do a markup, enter a negative markdown, e.g., -10%. Note that these prices are only the default markdowns applied to new item prices. Individual item prices and markdown percentages can be manually edited in inventory. Refer to Using Price Levels (page 193) for more information.</td>
</tr>
<tr>
<td>Price Tag Code</td>
<td>USER-DEFINED</td>
<td>Enter a character to replace each number (0-9) for printing cost and received date in code on price tags. To use this feature you must select a tag template that includes the cost fields in PREFERENCES ➤ WORKSTATION ➤ DOCUMENTS &amp; PRINTERS. Templates that include the cost fields have &quot;+cost&quot; included in the template name. Refer to Printing the Cost and Last Received Date in Code on Tags (page 47) for more information.</td>
</tr>
</tbody>
</table>

## Purchasing

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase order status</td>
<td>USER-DEFINED</td>
<td>Add, delete, rename, and reposition the status options available in the Status field on purchase orders. New POs are automatically assigned the Open status; filled POs are automatically assigned the Closed status. Facilitates filtering for viewing or reporting purposes. Refer to Tracking Orders by Status (page 275) for more information.</td>
</tr>
<tr>
<td>Purchase order instructions</td>
<td>USER-DEFINED</td>
<td>Enter up to two lines of optional instructions to print on POs. These instructions are not displayed on screen.</td>
</tr>
</tbody>
</table>
## Receiving

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warn when receiving against PO past its Cancel Date</td>
<td>☑, □ (D)</td>
<td>Select to alert employees when receiving a PO with a cancel date that has passed. If not selected, the cancel date is ignored.</td>
</tr>
<tr>
<td>Enter vendor billing information in Point of Sale</td>
<td>☑, □ (D)</td>
<td>This choice affects how vouchers are sent to QuickBooks financial software. Refer to Changing How Vendor Billing Information is Handled (page 527) for more information. By default, vendor billing fields are not displayed on the Point of Sale receiving voucher form. This is because most users handle vendor billing tasks in QuickBooks financial software. If you don’t use QuickBooks, or prefer to enter billing information in Point of Sale, select this checkbox to add the billing fields to the voucher form.</td>
</tr>
<tr>
<td>Printed Voucher Message</td>
<td>USER-DEFINED</td>
<td>Enter optional default comments to print on vouchers. Voucher comments are not displayed on screen.</td>
</tr>
</tbody>
</table>

## Sales

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Order to display full name field</td>
<td>SELECTION LIST</td>
<td>Choose the order to display/print customer names on documents.</td>
</tr>
<tr>
<td>When printing group item on receipt or order (Pro)</td>
<td>PRINT GROUP PRICE ONLY PRINT ITEM PRICES ONLY (D) PRINT GROUP AND ITEM PRICES</td>
<td>Specify how you want printed receipts given to customers to show group item prices. Refer to Using Group Items (page 227) for more information.</td>
</tr>
<tr>
<td>Require a Promotional Code on receipts and customer orders</td>
<td>☑, □ (D)</td>
<td>If selected, requires an entry in the Promo Code field on a receipt/order before payment can be accepted and the document saved. Facilitates tracking of promotional activities by allowing filtering by promo codes for reporting purposes.</td>
</tr>
<tr>
<td>Require a manual media count for X/Z Out</td>
<td>☑, □ (D)</td>
<td>If selected, requires a manual count of each denomination of currency in the cash drawer when running a Z-Out Drawer Count report.</td>
</tr>
</tbody>
</table>
## Appendix A:

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
</table>
| Open Cash Drawer                 | CHECKBOXES FOR AVAILABLE TENDERS | Select the payment types for which your cash drawer will open. Defaults are: Cash, Check.  
**Note:** Requires a compatible cash drawer, properly installed through a 40-column receipt printer. |
| Discounts                        |                          |                                                                                                                                                                                                           |
| Discount reasons                 | USER-DEFINED             | Define a list of discount reasons to identify line-item discounts manually given on sales. The discount reasons defined here will be available for selection on sales receipts and are used on the Discount Summary and available to filter other reports.  
**Defaults:** Competitive, Defect, Multiple unit, Coupon, Damage, Demo Item. |
| Require a discount reason for manual discounts | ☑, ☐ (D)                | Select to require that your cashiers specify the discount reason on applicable sales. Facilitates tracking and reporting of discounts.                                                                    |
| Receipt Message                  |                          |                                                                                                                                                                                                           |
| Printed receipt message          | USER-DEFINED             | Define the text you would like to appear in the message area of printed receipts you give your customers. For example, you might want to include your return/exchange policy, store hours, or news about an upcoming event on receipts. These comments do not appear on-screen. |
| Shipping (Pro)                   |                          |                                                                                                                                                                                                           |
| Use QuickBooks Shipping Manager  | ☑, ☐ (D)                | Select to add the Shipping Manager options to arrange shipments with UPS and transfer the costs to sales receipts.  
If you wish to use Shipping Manager to make the shipments, but not transfer the cost to the receipt check the I DO NOT CHARGE MY CUSTOMERS FOR SHIPPING checkbox.  
**Note:** You must have the I WANT TO RECORD SHIPPING ADDRESSES ON SALES RECEIPTS option selected on the General preferences page for this option to be available. |
| Shipping providers               | USER-DEFINED             | Define the shipping provider(s) you will be using. Once defined here, they can be selected when adding shipping information to sales receipts and customer orders.  
**Important:** Do not include "UPS" in the name of a provider you are adding manually. This string of characters will result in errors when shipping via Shipping Manager. If adding a legitimate UPS service, select it from the predefined drop-down list in the Add a New Shipping Provider dialog. |
## Company Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Receipt Tendering</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allowed payment methods</td>
<td>ALL AVAILABLE PAYMENT METHODS</td>
<td>Select which payment methods you wish to be available on the Receipt Payment window. Default: All; Cash cannot be removed.</td>
</tr>
<tr>
<td>Default payment method</td>
<td>PAYMENT METHODS ACCEPTED</td>
<td>Select the one payment method most frequently used at this store. When going to the Receipt Payment window, this default payment method will be suggested. Default: Cash</td>
</tr>
<tr>
<td>Allowed credit card types</td>
<td>LIST OF CARD TYPES</td>
<td>If you accept credit cards, specify the card types you will take (may be restricted by your merchant service agreement). Select ✓ for a card type to make it available or clear the checkbox to not allow it. Default: Visa, MasterCard, Diners Club.</td>
</tr>
<tr>
<td>Tips</td>
<td>✓, ☐ (D)</td>
<td>Specify whether you wish to be prompted to include tips when processing credit, account charge, and gift card payment. Refer to Recording Gratuities (Tips) (page 378) for more information.</td>
</tr>
<tr>
<td>Block additional account charges</td>
<td>✓(D), ☐</td>
<td>Note: This feature requires that you be integrated with QuickBooks financial software. If selected, additional charges are blocked and a warning displayed if the account is past due more than the specified number of days. Past due information comes from your financial software. Refer to Past Due Accounts (page 319) for more information.</td>
</tr>
<tr>
<td>when past due</td>
<td>DAYS PAST DUE</td>
<td></td>
</tr>
</tbody>
</table>

## Customers

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use with QuickBooks</td>
<td>YES, NO</td>
<td>Set the default for new customers. Select YES to exchange customer information with QuickBooks, or NO if you do not want customer information automatically sent. This setting can be modified on individual customer records.</td>
</tr>
<tr>
<td>Require a customer entry on all</td>
<td>✓, ☐ (D)</td>
<td>If selected, receipts cannot be saved until a customer is listed. Facilitates tracking and reporting of customer purchases.</td>
</tr>
<tr>
<td>receipts</td>
<td>USER-DEFINED</td>
<td>Create categories of customer types for your business. You can then assign the types on customers’ records and filter reports or create mailing lists/labels based on customer type.</td>
</tr>
</tbody>
</table>
## Customer Orders - Layaways, Sales Orders, Work Orders (Pro)

Each order type has its own page in preferences, but all are the same.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
</table>
| Initial Deposit   | DO NOT REQUIRE OR SUGGEST AN INITIAL DEPOSIT D  SUGGEST AN INITIAL DEPOSIT REQUIRE AN INITIAL DEPOSIT | Select how you want to handle the initial deposit on new customer orders.  
If suggesting or requiring an initial deposit, enter a percentage (of the total amount due) to be suggested or required.  
This setting applies only to the initial deposit, subsequent deposits can be for any amount. |
| Order Status      | USER-DEFINED                                 | Add, delete, rename, and reposition the status options available in the Status field on customer orders. New orders are automatically assigned the Open status; filled orders the Closed status. Facilitates filtering for viewing or reporting purposes. Refer to Tracking Orders by Status (page 430) for more information.  
Defaults: Open, Closed, Pending |
| Printed Message   | USER-DEFINED                                 | Enter an optional text message to print on each customer order, such as your order cancellation or refund policy.                          |

## Sales Tax

Define sales tax locations, sales tax codes, and other tax options. Specify a default tax location for this store and a default department tax code for new departments. With this page displayed, press <F1> for assistance or refer to Sales Tax Overview (page 339) for specific instructions.
E-mail Documents (Pro)

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Message Text</td>
<td>USER-DEFINED</td>
<td>Select a document type from the drop-down list at the top of the window and then complete the settings and default message to use when e-mailing that document type. Repeat for each document type you will be e-mailing. Point of Sale writes this information to each e-mail it creates, but you can edit individual e-mails before sending. You can add Point of Sale data fields (shown in &lt;brackets&gt; at bottom of window) to your subject line or message, in which case the information from the matching fields on the document being sent is auto-populated when the message is created. Enter the field name and bracket just as shown.</td>
</tr>
<tr>
<td>Create attachment as</td>
<td>PDF, TEXT, EXCEL</td>
<td>Select one of the three attachment formats: <strong>PDF</strong> - recipient must have Adobe Acrobat Reader installed to view. <strong>Excel</strong> - recipient must have Microsoft Excel 2000, 2002, 2003, or 2007 installed to view. <strong>Text</strong> - plain text format that can be viewed in most text editors or Word processing applications.</td>
</tr>
</tbody>
</table>

Ratings & Trends

These preferences can be set by the Server Workstation only. Returns are subtracted from sales to calculate net sales for this feature.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show ratings and trends for items</td>
<td>☑, ☐ (D)</td>
<td>Select to turn on and then indicate the basis and time period for calculating ratings and trends for items. <strong>Based on:</strong> Ratings can be based on net profit, quantity sold, or total sales (dollars). <strong>Time:</strong> Choose the number of days in sales history that should be used for calculations. Maximum is 999; to see trends we recommend a maximum of 499 days.</td>
</tr>
<tr>
<td>Show ratings for customers</td>
<td>☑, ☐ (D)</td>
<td>Select to turn on and then indicate the basis and time period for calculating ratings for customers. <strong>Based on:</strong> Ratings can be based on net profit or total sales (dollars). <strong>Time:</strong> Choose the number of days in sales history that should be used for calculations. Maximum is 999.</td>
</tr>
</tbody>
</table>
Appendix A:

Integrated Applications

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integrated applications</td>
<td>REMOVE</td>
<td>This page lists third-party applications that have previously been granted access to your Point of Sale company data through the POS SDK. To remove an application (and thus deny further access), highlight it in the list and then select REMOVE.</td>
</tr>
</tbody>
</table>

Workstation Preferences

To configure workstation preferences:

1. Suggested: Close all open Point of Sale windows on this workstation, except the main screen (Navigator). You can view, switch to, or close currently open windows by selecting them from the Windows menu Window menu at the top of your screen.

2. From the Edit menu, select PREFERENCES ➤ WORKSTATION.

3. From the list on the left (example shown on right here), choose the preference area or hardware settings you want to edit.

4. Make changes as needed. Refer to the following tables for specific information.

5. Select SAVE.
General

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workstation Number</td>
<td>1 - 10</td>
<td>Enter a workstation number from 1 - 10. Each workstation in a store must have a unique number.</td>
</tr>
<tr>
<td>Security: Automatically logout</td>
<td>☑, ☐ (D)</td>
<td>This option is applicable only if requiring security logins. Enable security logins in Company Preferences. Refer to General (page 621) company preferences. If selected, automatically logs out a user after the specified period of time has passed. Default time: 15 minutes.</td>
</tr>
<tr>
<td>Minutes until user is automatically logged out</td>
<td>USER-DEFINED</td>
<td>Select to reset Point of Sale screen layouts to the default appearance. This will result in the loss of all customizations made to list column, order, size, etc.</td>
</tr>
<tr>
<td>Appearance</td>
<td>RESET NOW</td>
<td>Select to display the Reminders icon and message each time Point of Sale is started on this workstation if reminders are available.</td>
</tr>
</tbody>
</table>

Software Updates

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updater Preference</td>
<td>USER-DEFINED</td>
<td>The UPDATER PREFERENCES button on this page provides access to a separate update application where you can specify how you want to be notified of Point of Sale updates. Additional information and assistance is available in the Updater Preferences window. Refer to Updating QuickBooks Point of Sale (page 12) for more information.</td>
</tr>
</tbody>
</table>

Hardware

Refer to Appendix D Compatible Hardware (page 681) for a list of hardware compatible with Point of Sale 7.0.
### Cash Drawer

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash Drawer</td>
<td>INSTALLED RECEIPT PRINTERS AND CASH DRAWER CONNECTION</td>
<td>A cash drawer must be connected through a receipt printer. From the first list, select the receipt printer you have installed. In the second list, select the cash drawer connection that matches your printer model. Note: The printer driver name installed in Windows may vary from the model number on the actual printer. If your receipt printer is not listed, use the printer instructions to add it to the Windows printer list. Select HARDWARE SETUP WIZARD to install this device. Select OPEN CASH DRAWER to test the operation of the cash drawer.</td>
</tr>
</tbody>
</table>

### Modem

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modem</td>
<td>USER-DEFINED</td>
<td>Select the modem to be used to process credit, debit, and gift card transactions with the QuickBooks POS Merchant or Gift Card Services. You must also select the direct dial communication option at Merchant and Gift Service – Communication Setup (page 627). Select ADD MODEM if your modem is not listed. You must restart your computer after adding a new modem.</td>
</tr>
</tbody>
</table>

### Bar Code Scanner

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Code Scanner</td>
<td>✓, □ (D)</td>
<td>Select the checkbox if you have a bar code scanner attached to this workstation. Select HARDWARE SETUP WIZARD if you need to install this device. Select TEST BAR CODE SCANNER to verify it is functioning properly.</td>
</tr>
</tbody>
</table>
### Card Reader (MSR)

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader (MSR)</td>
<td>USER-DEFINED</td>
<td>Select your installed MSR card reader from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select <strong>HARDWARE SETUP WIZARD</strong> if you need to install this device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select <strong>TEST CARD READER</strong> to verify it is functioning properly.</td>
</tr>
</tbody>
</table>

### Customer Pole Display

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pole display model</td>
<td>DISPLAY MODELS</td>
<td>Select your model of pole display from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select <strong>HARDWARE SETUP WIZARD</strong> if you need to install this device.</td>
</tr>
<tr>
<td>Connected to</td>
<td>USER-DEFINED</td>
<td>Select the port the pole display is connected to (a serial port, which is also called a COM port, or a USB port).</td>
</tr>
<tr>
<td>Message displayed between sales Alignment</td>
<td>USER-DEFINED</td>
<td>Enter a message to display anytime a receipt or customer order is not actively being made. Use the options in the drop-down menu to specify how you want the message aligned on the display. Selecting <strong>SCROLL</strong> in the Alignment field allows additional characters to be displayed (50 versus 20 in fixed alignment).</td>
</tr>
<tr>
<td>Message displayed during sales</td>
<td>QTY/PRICE/TOTAL (D) DESC1, QTY, PRICE DEPT/QTY/PRICE</td>
<td>Select a message to display while making a receipt or customer order. An example is displayed. Select <strong>TEST POLE DISPLAY</strong> to verify it is functioning properly.</td>
</tr>
</tbody>
</table>

### Touchscreen Monitor

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable touchscreen features</td>
<td>☑, ☐ (D)</td>
<td>Select to use touchscreen capabilities in Point of Sale. When selected, the specifically configured touchscreen navigation and data entry aids are displayed in point-of-sale areas of the program. Select <strong>HARDWARE SETUP WIZARD</strong> if you need to install this device.</td>
</tr>
</tbody>
</table>
### Physical Inventory Scanner

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory scanner model and port</td>
<td>SUPPORTED MODELS</td>
<td>Select your physical inventory scanner model from the drop-down list. Specify the virtual COM port to which the device is attached. It may be necessary to use Windows Device Manager to identify your hardware and assign the COM Port. Search Windows help for additional information about accessing and using Device Manager. Select <strong>HARDWARE SETUP WIZARD</strong> if you need to install this device.</td>
</tr>
</tbody>
</table>

### PIN Pad

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIN pad model</td>
<td>SUPPORTED MODELS</td>
<td>Select your PIN pad model from the drop down list. Select <strong>HARDWARE SETUP WIZARD</strong> if you need to install this device. Select <strong>TEST PIN PAD</strong> to verify it is functioning properly.</td>
</tr>
</tbody>
</table>

### Available Printers

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>POS printer list</td>
<td>ADD PRINTER</td>
<td>This page confirms the printers that you have installed and available to use with Point of Sale. If a printer you want to use isn't on this list, select <strong>HARDWARE SETUP WIZARD</strong> to install it now.</td>
</tr>
</tbody>
</table>
Documents & Printers

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>USER-DEFINED</td>
<td>Specify the following for each document type listed: <strong>Printer</strong>: Select from the drop-down list of your installed printers. <strong>Template</strong>: Select a document template to be used. Select PREVIEW to see what each available template looks like or PRINT TEST PAGE to verify your template selection and the printer is working together. <strong>Copies</strong>: Indicate the default number of copies to be printed. <strong>Note</strong>: These settings can be changed at the time of printing, based on your print options settings below. If you need to install a printer, select HARDWARE SETUP WIZARD.</td>
</tr>
<tr>
<td>Shipping Manager Label Printer (Pro)</td>
<td>N.A.</td>
<td>If you use Shipping Manager, select SHIPPING MANAGER SETUP to open this application and set up a printer for your shipping labels.</td>
</tr>
</tbody>
</table>

Print Options

<table>
<thead>
<tr>
<th>Preference</th>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt for gift receipt with each sale</td>
<td>☑, ☐ (D)</td>
<td>Select to be prompted to print a gift receipt with the item, price, and payment detail excluded.</td>
</tr>
<tr>
<td>Pause between printing to allow tearing off printed receipt</td>
<td>☑ (D), ☐</td>
<td>If selected, pauses briefly after the first receipt is printed, allowing time to tear it off before the second copy is printed. This is for users with printers that do not cut each receipt automatically.</td>
</tr>
<tr>
<td>Print two copies of receipts tendered by account charge</td>
<td>☑ (D), ☐</td>
<td>Automatically print two copies of all sales receipts that are paid for by charge to customer account. If you are using 2-ply receipt paper, you may wish to disable this option.</td>
</tr>
<tr>
<td>Print dialog</td>
<td>☑ (D), ☐</td>
<td>Select to display the Print Options dialog and allow changes to the printer, template, and number of copies when printing. Select the specific documents for which you want this option. <strong>Note</strong>: On some document types, the Print Option dialog is always displayed when printing.</td>
</tr>
<tr>
<td>Information Fields Overview</td>
<td>644</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>Conventions</td>
<td>644</td>
<td></td>
</tr>
<tr>
<td>Document and Record Information Fields</td>
<td>645</td>
<td></td>
</tr>
<tr>
<td>Common Information Fields</td>
<td>645</td>
<td></td>
</tr>
<tr>
<td>Item Information Fields</td>
<td>647</td>
<td></td>
</tr>
<tr>
<td>Department Information Fields</td>
<td>652</td>
<td></td>
</tr>
<tr>
<td>Adjustment Memo Information Fields</td>
<td>652</td>
<td></td>
</tr>
<tr>
<td>Quantity Adjustment Memo Fields</td>
<td>652</td>
<td></td>
</tr>
<tr>
<td>Cost Adjustment Memo Fields</td>
<td>653</td>
<td></td>
</tr>
<tr>
<td>Common Adjustment Memo Fields</td>
<td>654</td>
<td></td>
</tr>
<tr>
<td>Vendor Information Fields</td>
<td>654</td>
<td></td>
</tr>
<tr>
<td>Purchase Order Information Fields</td>
<td>655</td>
<td></td>
</tr>
<tr>
<td>Voucher Information Fields</td>
<td>657</td>
<td></td>
</tr>
<tr>
<td>Customer Information Fields</td>
<td>660</td>
<td></td>
</tr>
<tr>
<td>Receipt Information Fields</td>
<td>662</td>
<td></td>
</tr>
<tr>
<td>Customer Order Information Fields</td>
<td>665</td>
<td></td>
</tr>
<tr>
<td>Transfer Slip Information Fields</td>
<td>667</td>
<td></td>
</tr>
</tbody>
</table>
Information Fields Overview

Point of Sale documents and records contain a number of information fields. Some of these fields appear only in the document or record, other fields are shared between various areas in Point of Sale. This appendix provides the fields with their descriptions and uses.

Conventions

If a list field included in this table isn’t visible on your screen, you can customize your list columns to include it. Refer to Customizing Columns in Lists (page 586) for more information.

While fields in each table are in alphabetical order, those fields unique to Pro and Pro Multi-Store levels appear at the end of each section. Related fields are grouped where possible.

- **System Configuration**

  Depending upon system and/or preference settings, some of these fields will function differently. If there are notes about preferences or security settings in the Usage column, please refer to the applicable sections of this guide for more information about those settings.

- **Field Label Symbols**

  Symbol | Description
  --- | ---
  [ ] | Fields shown in brackets are automatically populated with suggested or read-only data by the program. If read-only, these fields cannot be directly edited.
  * | Field label can be customized to meet your needs. Refer to Item Field Labels (page 589) for more information.
# Document and Record Information Fields

## Common Information Fields

This table lists the name and use of common fields in Point of Sale documents and records.

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Fields</td>
<td>Address fields, used for billing and for shipping.</td>
</tr>
<tr>
<td>Street</td>
<td></td>
</tr>
<tr>
<td>City, State</td>
<td></td>
</tr>
<tr>
<td>ZIP</td>
<td></td>
</tr>
<tr>
<td>Address Name</td>
<td>This is a label assigned to individual shipping addresses when you are using multiple shipping addresses. This provides easier identification for addresses.</td>
</tr>
<tr>
<td>[Associate]</td>
<td>The currently logged-in user. The user who created any document except receipts and sales orders in Point of Sale. Populated with the logged-in user if security is used. If security is not used, select a name from the drop-down list of defined employees.</td>
</tr>
<tr>
<td>Associate</td>
<td>Used to identify the employee to be paid a commission on the sale.</td>
</tr>
<tr>
<td></td>
<td><em>At the top of the form:</em> Suggested as the logged-in user (if security used) but can be edited to identify the sales associate for the receipt. If you change the associate after listing items, you are asked if you want to assign this associate to the items already listed.</td>
</tr>
<tr>
<td></td>
<td><em>In the item list:</em> Suggested as the same employee listed at the top of the form, but editable item-by-item. This allows commissions to be paid to more than one employee on a single receipt.</td>
</tr>
<tr>
<td></td>
<td>Refer to [Tracking Employee Commissions (Pro) (page 60)] for more information.</td>
</tr>
<tr>
<td>Comment</td>
<td>Optional field to record a comment for the document.</td>
</tr>
<tr>
<td>[Date] Date</td>
<td>The date the document was created. Defaults to today’s date for new documents.</td>
</tr>
<tr>
<td></td>
<td>You can change the date as necessary on the receipt form. <em>Never change your computer’s system date for this purpose; doing so could result in lost data!</em></td>
</tr>
<tr>
<td></td>
<td>If you use employee security groups, you can determine who is allowed to change this date.</td>
</tr>
<tr>
<td>E-Mail</td>
<td>Contact e-mail address. Entering an e-mail address allows you to e-mail the contact from her record and to e-mail documents or letters from within Point of Sale (Internet connection required).</td>
</tr>
</tbody>
</table>
### Field Usage

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name Fields</strong></td>
<td>Name fields for vendor contact. Contact person's title, e.g. Mr., Mrs.</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>Contact person's first name.</td>
</tr>
<tr>
<td><strong>First</strong></td>
<td>Contact person's last name.</td>
</tr>
<tr>
<td><strong>Last</strong></td>
<td>Alternate contact name.</td>
</tr>
<tr>
<td><strong>Alt Contact</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Phone/FAX</strong></td>
<td>Three telephone/FAX numbers can be entered in the Phone, Alt Phone, and Phone 2 fields.</td>
</tr>
<tr>
<td><strong>[QB Status]</strong></td>
<td>If integrated with QuickBooks financial software, displays the exchange status of the record or document with your financial software: NOT POSTED if the information has not yet been sent to your financial software or if the record is marked inactive, COMPLETED (if the information has been sent,) UNBILLED PURCHASES (merchandise has been received on a voucher but has yet to be billed) or ERROR (attempting to send resulted in an error). Refer to [Verifying the Exchange of Individual Transactions (page 490)](page 490) and [Entering Vendor Billing Information (page 291)](page 291) for more information.</td>
</tr>
<tr>
<td><strong>[Time]</strong></td>
<td><em>(Document History list)</em> The time the document was created.</td>
</tr>
<tr>
<td><strong>Pro Fields</strong></td>
<td>Define and use custom fields to record other information important to your business. These fields can be added to your lists, used to filter the list and certain reports, or added to printed document templates. This information will be shared with your financial software. However, the custom fields in both programs must be named exactly the same for information to be exchanged. Refer to [Custom Fields (Pro) (page 590)](page 590) for more information.</td>
</tr>
</tbody>
</table>
## Item Information Fields

<table>
<thead>
<tr>
<th>Basic Field</th>
<th>Usage</th>
</tr>
</thead>
</table>
| Alternate Lookup | A user-defined item identifier that can be used to list items on documents and to filter your item list. This field can contain text descriptions, catalog numbers, etc. Alternate Lookups must be unique and should not duplicate an item number or UPC code, as this would result in inefficiency when using these identifiers to list items on documents. Refer to Item Identifiers (page 166) for more information.  
(Pro) If multiple vendors are being used for an item, each can be assigned a unique alternate lookup. |
| Attribute*      | A field used to describe an item characteristic, typically color, material, pattern, a second size, etc. 1 to 12 characters.                                                                            |
| [Available Quantity] | The quantity available for immediate sale. Calculated by subtracting the quantity committed on active customer orders from the on-hand quantity.                                                               |
| [Average Unit Cost] | The average cost of the currently on-hand units of the item. The average unit cost is updated by receiving vouchers, cost adjustment memos, or manually. If this field is manually edited, Point of Sale creates an adjustment memo to send to QuickBooks financial software. Refer to Handling Item Cost and Price (page 189) for more information. |
| Dept Name       | The department to which the item belongs. Required. Departments serve to categorize merchandise for efficient viewing, reporting, and purchasing.  
To search for or look up/add a department, select 📧 or press (<F4>) from the Department field.                                                                 |
| Item Name*      | The principal description the item. Required field. Printed on receipts and most reports. (Pro) Also used as the style description. As such, it must be the same for all items in a style.                                             |
| Item Description* | A secondary description field used for recording additional information for an item, such as a vendor's catalog number. Also can be used to record additional information while making a sale.                               |
| Doc Qty         | Document Quantity: Used to enter the quantity of an item to be listed on a document. Displayed only when accessing inventory from a document to select items.  
(Pro) You can also switch to the Style window and enter document quantities in the style grid cells when coming to inventory from a document. |
<p>| [Item #]        | Item Number: The row number that identifies each item. Assigned by Point of Sale and not editable. Used to lookup or scan items when listing on documents. Printed in bar code on merchandise price tags printed from within Point of Sale. Refer to Item Identifiers (page 166) for more information. |
| [Item Type]     | Used to designate the type of inventory item. Default is INVENTORY. Refer to Item Types (page 139) for more information.                                                                                 |</p>
<table>
<thead>
<tr>
<th>Basic Field</th>
<th>Usage</th>
</tr>
</thead>
</table>
| [Margin %]      | The profit expressed as a percentage of the price. If defined in a department record, the margin is auto-filled for new items assigned to that department. Updated when costs change on a receiving voucher. Editable.  
Manually editing the margin in inventory automatically causes your price(s) and your markup to be recalculated.  
Margin % $=\frac{(\text{price} - \text{cost})}{\text{price}} \times 100$  
Refer to Handling Item Cost and Price (page 189) for more information.    |
| [Markup%]       | The item profit expressed as a percentage markup over the cost. Works in the same manner as Margin %. Editable.  
Manually editing the markup in inventory results in the margin and your price(s) being recalculated by Point of Sale.  
Refer to Handling Item Cost and Price (page 189) for more information.    |
| MSRP            | Manufacturer’s suggested retail price. Enter a MSRP manually if you want this reference price to be printed on tags to demonstrate savings to customers.  
Refer to Printing Tags and Labels (page 43) for more information.        |
| [On-Hand Quantity] | The quantity of the item currently on hand at this store. Automatically updated each time an item is received, sold, transferred, or when adjusted on a memo. A manual entry in this field results in the creation of a quantity adjustment memo by Point of Sale. |
| [On Order]      | Quantity of the item listed on open purchase orders yet to be received. Displayed in the item list.  
(Pro) This value can also be viewed along with a list of open POs by selecting on order from the Quantities area of the item form. |
| [Order Cost]    | The current order cost of an item. The order cost is suggested on purchase orders and vouchers and is automatically updated when a voucher is updated with a new item cost.  
(Pro) If multiple vendors are being used for an item, each can be assigned a unique order cost. |
| [Price Levels]  | Optional item price levels, each a markdown price from your Regular Price. Used to offer different prices to different customer groups (employee, wholesale, etc.) or for other purposes, such as promotional sales.  
You define price level names and markdown percentages in company preferences and they are automatically calculated from your Regular Price and recalculated when the Regular Price price is changed. All price level prices can be manually edited as needed for individual items.  
Refer to Using Price Levels (page 193) chapter for more information. |
| Print Tags      | This field specifies that you want to print price tags for the item. Clear the checkbox if you do not want tags printed for the item. Default is selected. |
### Basic Field Usage

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>QuickBooks Accounts</strong></td>
<td>Item mappings to QuickBooks financial software cost of goods sold, income, and asset accounts. Defaulted to the item accounts specified in company preferences for each item type, but can be edited for individual items by selecting a different account from the drop-down list. Refer to Assigning Item Accounts for Financial Exchange (page 169) for more information. PREFERENCES ➤ COMPANY ➤ FINANCIAL ➤ ACCOUNTS ➤ BASIC: Specify the default COGS, Income, and Asset accounts for each item type.</td>
</tr>
<tr>
<td><strong>[COGS]</strong></td>
<td></td>
</tr>
<tr>
<td><strong>[Income]</strong></td>
<td></td>
</tr>
<tr>
<td><strong>[Asset]</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Reorder Point</strong></td>
<td>User-specified quantity at which an item should be reordered (or rebuilt in the case of assembly items). When the sum of the on-hand quantity and on-order quantity, or the available quantity of an item falls to or below this point, the item is listed on the Reorder Reminder screen and reorder/build reports. For assembly items, this is referred to as the Build Point. Refer to Using Item Reorder Points (page 182) for more information. (Pro Multi-Store) The reorder point is based on the company quantities.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>The size of an item. 1 to 12 characters. This field can also be used to describe a second item attribute other than size, if needed.</td>
</tr>
<tr>
<td><strong>[Tax Code]</strong></td>
<td><em>Tax Code Name:</em> A drop-down list containing each of the tax code names defined in company preferences. By default, each new item is assigned a default tax code as specified in the associated department. Edit by selecting a different tax code as necessary. INVENTORY ➤ DEPARTMENT LIST. Select a tax code for each department (the default specified below is suggested). PREFERENCES ➤ COMPANY ➤ SALES TAX ➤ DEFINE TAX CODES: Define tax codes in the table. Select a default tax code that will be suggested for all new departments.</td>
</tr>
<tr>
<td><strong>Un-orderable</strong></td>
<td>This field is used to indicate that you no longer want to order this item. Its reorder point is ignored and the item is not added to reorder reminders. If selected, and you try to list the item on a PO, you will be alerted but can still order the item, at your discretion. Typically used to remove seasonal items from the reorder reminders list.</td>
</tr>
<tr>
<td><strong>Unit of Measure</strong></td>
<td>This can be used to indicate the measurement or quantity by which the item is sold, such as each, inch, yard, gallon, case, gross, etc. Select a unit that has been defined in company preferences or ADD NEW from the drop-down list. Once defined, can be used to filter the item list or reports. PREFERENCES ➤ COMPANY ➤ INVENTORY ➤ UNIT OF MEASURE: Add, delete, or rearrange the order of units of measure. (Pro) Units of measure can be added to your printed documents and tags using the Print Designer. Refer to Multiple Units of Measure (Case-to-Unit) (Pro) (page 185) for more information.</td>
</tr>
</tbody>
</table>
### Basic Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UPC</strong></td>
<td><em>Universal Product Code:</em> The item's unique UPC/EAN/ISBN identifier. This field must be 13 characters. If a shorter number is entered, the program will apply an algorithm to fill the 13-character field. If a longer number is entered, it is truncated to 13 characters. Entering a UPC code allows you to list items on documents by scanning or typing the code from a manufacturer-supplied tag. <strong>Refer to Item Identifiers (page 166) for more information.</strong> <em>(Pro)</em> If using multiple vendors or multiple units of measure for an item, each can have a unique UPC.</td>
</tr>
<tr>
<td><strong>Vendor</strong></td>
<td>The vendor from whom you purchase the item. To search for or look up/add a vendor, type the vendor name or a search keyword and select or press <code>&lt;F4&gt;</code> from the Vendor field.</td>
</tr>
</tbody>
</table>

### Pro Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Available Quantity</strong></td>
<td>Point of Sale will calculate from on-hand quantities, quantities on layaways and work orders, and quantities on purchase orders to show you what your actual available quantities are. <strong>Refer to Available Quantities (Pro) (page 188) for more information.</strong></td>
</tr>
<tr>
<td><strong>Base Unit</strong></td>
<td>When using multiple units of measure, this is the smallest unit quantity by which an item is stocked or sold.</td>
</tr>
<tr>
<td><strong>Custom Fields 1-5</strong></td>
<td>Custom item fields can be used to enter any other item information you need to track. Once defined, the fields can be used to filter lists and reports, and can be added to your printed documents using Print Designer. <strong>Refer to Custom Fields (Pro) (page 590) for more information on using these fields.</strong></td>
</tr>
<tr>
<td><strong>Eligible for Commission</strong></td>
<td>Checkbox. Identifies the item as qualifying for commission earnings on sales. Default is checked (eligible). Clear the checkbox if associates are not to be paid a commission on sales of this item. For commissions to be calculated on sales, employees must have a commission rate assigned in their employee record. <strong>Refer to Tracking Employee Commissions (Pro) (page 60) for more information about employees and commission tracking.</strong></td>
</tr>
<tr>
<td><strong>Open Purchase Orders for this Item</strong></td>
<td>List of open purchase orders for the item and the total quantity on order. Select <strong>AVAILABLE</strong> from the Quantities area of the item form. <em>(Pro Multi-Store)</em> For you, the open PO list is combined with the Store Quantities dialog; accessible by selecting <strong>AVAILABLE</strong> from the Quantities area of the item form.</td>
</tr>
<tr>
<td><strong>Order By</strong></td>
<td>When using multiple units of measure, the quantity by which items are usually ordered.</td>
</tr>
<tr>
<td><strong>Picture Name</strong></td>
<td>The name(s) assigned to item picture(s).</td>
</tr>
<tr>
<td><strong>Qty in Assembly Qty in Group</strong></td>
<td><em>(In Assembly/Group grid)</em> Use to enter the quantity of a component item included in an assembly or group item. <strong>Refer to Chapter 13 Item Styles, Assemblies, and Groups (Pro) (page 211) for more information.</strong></td>
</tr>
</tbody>
</table>
Document and Record Information Fields

<table>
<thead>
<tr>
<th>Pro Field</th>
<th>Usage</th>
</tr>
</thead>
</table>
| Select a Style Template | Used to assign a predefined attribute/size template to a style grid. Select a template from the drop-down list or select add new to create a new template.  
Refer to Working with Item Styles (page 212) for more information. |
| Sell By            | When using multiple units of measure, the quantity by which items are usually sold to customers. |
| Serial # Tracking  | Specify if you want to be prompted to enter a serial number when the item is listed on documents. Select PROMPT to be prompted to enter a serial number. Select OPTIONAL and you are not prompted, but you can still enter a serial number on the document at your discretion.  
Refer to Serial Number Tracking (Pro) (page 149) for more information. |
| Vendors - Alternate 2 - 5 | (Additional Info tab) Fields for entering one preferred and up to four alternate vendors for an item, each with a unique UPC, Alternate Lookup, and order cost.  
Refer to Using Multiple Vendors for an Item (Pro) (page 263) for more information. |

<table>
<thead>
<tr>
<th>Pro Multi-Store Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Company Total] [Cmp Qty]</td>
</tr>
<tr>
<td>Quantities for Store # &lt;n&gt;</td>
</tr>
<tr>
<td>[Store On-Hand Quantities]</td>
</tr>
</tbody>
</table>

Field Length and Printing

Item information fields may sometimes allow for more characters than will fit on a printed document. If a document template does not have enough space for all characters, the field will be truncated. For example, the Size field allows for 12 characters. However, on some documents, only eight characters are printed.
Appendix B:

Department Information Fields

This table lists the name and use of each field available in department records.

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dept Code</td>
<td>Department Code: An optional, unique code (1-3 characters) for identifying each department. Displayed on price tags and can be used to search for a department from a lookup field.</td>
</tr>
<tr>
<td>Dept Name</td>
<td>Department Name: A descriptive name for the department to assist in easy identification. The department name is a required field.</td>
</tr>
<tr>
<td>Margin %</td>
<td>Default profit margin for use with a pricing formula to set new item prices. You can enter either a margin or a markup percentage and Point of Sale calculates the other. If you enter a markup, your entry may be rounded so that a corresponding margin (whole number) can be assigned. Default = 0%. Refer to Using a Department Pricing Formula (page 159) for more information.</td>
</tr>
<tr>
<td>Markup %</td>
<td></td>
</tr>
<tr>
<td>Tax Code</td>
<td>The default department tax code specified in company preferences is suggested. Edit for individual departments as needed. When a new item is added to inventory within this department, the tax code selected here is suggested for the item.</td>
</tr>
</tbody>
</table>

Adjustment Memo Information Fields

The following tables list the fields that are available on memo forms and in the adjustment history lists. The three tables discuss the fields on quantity memos, on cost memos, and finally common fields shared by both memo types.

Fields that have an obvious purpose or item fields whose purpose is explained in Item Information Fields (page 647) have been omitted from these tables.

Quantity Adjustment Memo Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Old Qty]</td>
<td>Item quantity on hand prior to the adjustment. From inventory.</td>
</tr>
<tr>
<td>New Qty</td>
<td>Enter the adjusted quantity. This will be the quantity on hand for this item after saving the memo.</td>
</tr>
<tr>
<td>[Diff Qty]</td>
<td>Difference in quantity for the item: New Qty – Old Qty.</td>
</tr>
</tbody>
</table>

Fields in Totals Area and Adjustment History List
### Document and Record Information Fields

#### Cost Adjustment Memo Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Old Qty]</td>
<td>Total quantity on hand for all items listed on the memo before adjusting.</td>
</tr>
<tr>
<td>[New Qty]</td>
<td>Total quantity on hand for all items listed on the memo after adjusting.</td>
</tr>
<tr>
<td>[Qty Change]</td>
<td>Total difference in quantity for all items on the memo: <strong>New Qty – Old Qty</strong>.</td>
</tr>
<tr>
<td>[Value Change]</td>
<td>Total difference in inventory value due to the changes recorded on the memo. Calculated using the cost of items listed on the memo and their change in quantity. For example, if an item costs $5.00, and the quantity changes from 5 to 4, the value change is -$5.00. If the quantity changes from 5 to 7, the value change is $10.00.</td>
</tr>
</tbody>
</table>

#### Pro Fields

| Serial #               | Optional. Used to record serial number(s) for the adjusted quantities. Read more about serial number tracking in Serial Number Tracking (Pro) (page 149). |

#### Pro Multi-Store Fields

| [Store]                | Headquarters only. Select the store for which you are making the adjustment memo. Default is Headquarters store. Editable. |

### Cost Adjustment Memo Fields

#### Fields in Item List

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Old Cost]</td>
<td>Average unit cost of item prior to adjustment.</td>
</tr>
<tr>
<td>New Cost</td>
<td>Enter the adjusted average unit cost. This entry will be the average unit cost for this item after saving the memo. Decimal cost entries are allowed.</td>
</tr>
<tr>
<td>[Diff Cost]</td>
<td>Difference in cost for the item: <strong>New Cost – Old Cost</strong></td>
</tr>
<tr>
<td>[Current Qty]</td>
<td>This dynamic field shows the current item quantity in inventory, even when viewing former cost memos (i.e. not the quantity at the time memo was created).</td>
</tr>
</tbody>
</table>

#### Fields in Totals Area and Adjustment History List

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Old Value]</td>
<td>The total value (cost) of all items listed on the memo prior to the adjustment. Item <strong>On-hand Qty x Old Cost</strong>, summed for all items.</td>
</tr>
<tr>
<td>[New Value]</td>
<td>The total value (cost) of all items listed on the memo after the adjustment. Item <strong>On-hand Qty x New Cost</strong>, summed for all items.</td>
</tr>
<tr>
<td>[Value Change]</td>
<td>Total difference in value (cost) for all items on the memo: <strong>New Value – Old Value</strong></td>
</tr>
<tr>
<td>[Qty On Hand]</td>
<td>Total combined quantity on hand for all items listed on the memo.</td>
</tr>
</tbody>
</table>
## Common Adjustment Memo Fields

The following table alphabetically lists the general fields on memos.

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Memo #]</td>
<td><em>(Adjustment History list)</em> Sequential number from 1 to 99,999 assigned by Point of Sale.</td>
</tr>
<tr>
<td>Reason</td>
<td><em>(Required field)</em> The reason for the adjustment. Type in a reason or select one from the drop-down list. Refer to <em>Actions that Generate Adjustment Memos</em> <em>(page 246)</em> for examples.</td>
</tr>
<tr>
<td>[Source]</td>
<td>The action or module that created the memo: manually created memo <em>(MANUAL)</em>, reversed memo <em>(REVERSE)</em>, physical inventory <em>(PHYSICAL INVENTORY)</em>, inventory adjustment <em>(INVENTORY)</em>, Assembly Item <em>(ASSEMBLY)</em>.</td>
</tr>
<tr>
<td>[Status]</td>
<td>Shows the memo status: REGULAR, REVERSING, or REVERSED. Refer to <em>Actions that Generate Adjustment Memos</em> <em>(page 246)</em> for more information on the reversing entries.</td>
</tr>
<tr>
<td>[Type]</td>
<td>The memo type and inventory value being adjusted: QUANTITY or COST.</td>
</tr>
</tbody>
</table>

## Vendor Information Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account #</td>
<td>Your account number with the vendor.</td>
</tr>
<tr>
<td>Company</td>
<td>Vendor company name.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Select this checkbox to hide unused vendors from the active vendor list and to stop exchanging the vendor’s information with QuickBooks financial software. Refer to <em>Making a Vendor Inactive</em> <em>(page 257)</em> for more information.</td>
</tr>
<tr>
<td>[Terms]</td>
<td><em>(Terms of Payment)</em>: Default payment terms for the vendor. These terms are suggested on POs and receiving vouchers made for the vendor. Refer to <em>Vendor Payment Terms</em> <em>(page 260)</em> later in this chapter for more information.</td>
</tr>
<tr>
<td>Vendor Code</td>
<td>Optional, alphanumeric code, up to 3 characters, identifying each vendor. Can be used to display the vendor on reports and lists.</td>
</tr>
<tr>
<td>Vendor Notes</td>
<td>Optional notes, such as shipping lead time, FOB shipping point, etc.</td>
</tr>
</tbody>
</table>
### Field Information Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vendor Website</strong></td>
<td>Record the vendor’s website address. Select <strong>GO TO WEB</strong> to visit the vendor’s website from the record (Internet connection required).</td>
</tr>
<tr>
<td><strong>Custom Fields 1-5</strong></td>
<td>Custom item fields can be used to enter any other vendor information you need to track. Once defined, the fields can be used to filter lists and reports, and can be added to your printed documents using Print Designer. Refer to Custom Fields (Pro) (page 590) for more information on using these fields.</td>
</tr>
</tbody>
</table>

### Purchase Order Information Fields

Item fields whose purpose is explained in Item Information Fields (page 647) have been omitted from this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Addresses</strong></td>
<td>The billing address and the shipping address you wish the vendor to use for the order.</td>
</tr>
<tr>
<td>[Cost]</td>
<td>The cost at which an item is being ordered on the purchase order. Suggested as the Order Cost from inventory, but can be edited. Two decimal places displayed: up to five decimal places can be entered and are stored.</td>
</tr>
<tr>
<td><strong>Date Fields</strong></td>
<td>Order Date and Ship Date are suggested as the current date. All dates are editable. Select <strong>&lt;F4&gt;</strong> to access the pop-up calendar.</td>
</tr>
<tr>
<td></td>
<td><strong>Cancel Date:</strong> Optional date after which delivery is to be refused. You can set the preference below to be alerted when receiving against a purchase order whose cancel date has passed. You can still receive the merchandise at your discretion.</td>
</tr>
<tr>
<td></td>
<td><strong>Payment Due Date:</strong> Tentative due date calculated by adding the net due days specified in the vendors terms to the Ship Date. If the vendor terms or Ship Date are edited on the purchase order, the payment due date is adjusted accordingly. Used for reporting and planning purposes only.</td>
</tr>
<tr>
<td><strong>Discount</strong></td>
<td><strong>Discount:</strong> The dollar amount of a discount, applied to the PO subtotal. Disc %: Percentage discount applied to the purchase order subtotal. Entering a value in either field causes the other to be calculated and displayed.</td>
</tr>
<tr>
<td></td>
<td><strong>[Ext Cost]</strong> For an ordered item, quantity <strong>Ordered</strong> multiplied by the <strong>Cost</strong> for that item. If ordering items with fractional cent costs, you can enter the quantity and extended cost, and Point of Sale will calculate and display the unit cost. Two decimals displayed; up to five decimal places can be entered and are stored.</td>
</tr>
<tr>
<td><strong>Fee</strong></td>
<td>A fee applied to the purchase order. For example, a special handling fee might be applied to an order. Enter the amount.</td>
</tr>
</tbody>
</table>
### Appendix B: QuickBooks Point of Sale

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instructions [Printed PO Instructions]</td>
<td>Instructions (on PO form): Free-form text entry field allowing you to record miscellaneous information regarding the purchase order. Select the icon adjacent to the field to enter longer comments. Printed PO Instructions (not displayed on form): One or two lines of instructions that appear on the printed PO only. Defined in PREFERENCES &gt; COMPANY &gt; PURCHASING &gt; PO Instructions.</td>
</tr>
<tr>
<td>[No of Items]</td>
<td>In the PO List: The total number of different items (not units) ordered on the PO.</td>
</tr>
<tr>
<td>[PO #]</td>
<td>Default sequential number assigned by the program. Editable. (Pro) If you generate POs from a customer order, the PO number is created from the customer order number and a prefix, e.g. SO121. Refer to Generating Purchase Orders from Customer Orders (page 424) for more information.</td>
</tr>
<tr>
<td>On Order</td>
<td>In the PO item list: Quantity of the item currently on order. Updated with this POs order quantity upon saving.</td>
</tr>
<tr>
<td>Ordered</td>
<td>Order Quantity: In the purchase order item list. The ordered quantity of an item. Suggested as one (1) or the Doc Qty transferred from inventory. Editable.</td>
</tr>
<tr>
<td>[Payment Due Date]</td>
<td>Calculated date field. Ship Date + Net Due Days from terms. Included for planning and reporting purposes. Example: If Ship date is 9/10/05 and terms include Net Due in 20 days, calculated payment due date is 9/21/05.</td>
</tr>
<tr>
<td>[Due] [Qty Due]</td>
<td>In the PO item list: The item quantity remaining to be received. In the PO Totals area: The total purchase order quantity (all items) remaining to be received. Updated by receiving vouchers that reference the purchase order. Qty Due = Qty Ordered – Qty Received</td>
</tr>
<tr>
<td>[Qty Ordered]</td>
<td>In the PO totals area: The total PO quantity (units, all items) ordered.</td>
</tr>
<tr>
<td>[Qty Received]</td>
<td>In the PO item list: The item quantity already received. In the PO Totals area: The total purchase order quantity (units, all items) already received. Updated by receiving vouchers that reference the purchase order.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the purchase order. Automatically set to OPEN on new POs and CLOSED on filled purchase orders. You can also set the status to PENDING. Used to track your purchase orders and filter the PO list and reports. Editable. You can define your own status entries and use them to track purchase order progress. Refer to Tracking Orders by Status (page 430) for more information.</td>
</tr>
<tr>
<td>[SubTotal]</td>
<td>The the sum of item extended costs on the PO before applying any discounts or fee.</td>
</tr>
<tr>
<td>[Terms]</td>
<td>Vendor’s payment terms for the purchase. Suggested as the default terms from the vendor’s record. Editable. Refer to Vendor Terms on Purchase Orders (page 272) for more information.</td>
</tr>
</tbody>
</table>
### Document and Record Information Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
</table>
| **[Total]**            | The total purchase order amount after discounts and fees are applied to the subtotal.  
                         | \[ \text{Total} = \text{Subtotal} - \text{Discount} + \text{Fee} \] |
| **[Unfilled %]**       | In the PO Totals area: The percentage of the total PO quantity (all items) that has not yet been received. Updated by receiving vouchers that reference the PO.  
                         | \[ \text{Unfilled \%} = (\text{Qty Due} / \text{Qty Ordered}) \times 100 \] |
| **Vendor**             | Enter the vendor from whom you are purchasing the merchandise. Required. |

**Pro and Pro Multi-Store Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address</strong></td>
<td>The addresses you wish the vendor to use for billing and for shipping on the order. Select the addresses from the drop-down lists. The Ship To address is normally the store for which the order is being made and during Store Exchange the purchase order will be sent to that store.</td>
</tr>
<tr>
<td><strong>Customer</strong></td>
<td>If applicable, the customer from the associated customer order.</td>
</tr>
<tr>
<td><strong>Customer Order #</strong></td>
<td>If applicable, the associated customer order from which the PO was generated. Refer to Generating Purchase Orders from Customer Orders (page 424) for more information.</td>
</tr>
</tbody>
</table>

### Voucher Information Fields

Fields that have an obvious purpose or item fields whose purpose is explained in Item Information Fields (page 647) have been omitted from this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
</table>
| **[Message, Printed]** | One or two lines of optional message text that print on all vouchers (not displayed on-screen). Printed voucher messages are defined in company preferences.  
                         | PREREFERENCES ➞ COMPANY ➞ RECEIVING ➞ Voucher Default Message. |
| **Cost Fields**        | Voucher Cost: The cost at which an item is being received. Suggested as the Order Cost from inventory or, if applicable, the PO Cost from a referenced PO. Editable.  
                         | Extended Cost: The quantity received multiplied by the Voucher Cost for an item. Editable.  
                         | If you receive items with decimal costs, you can enter the quantity received and extended cost and Point of Sale will calculate and display the unit cost (only two decimals displayed, but five stored). See Numeric Fields (Cost, Price and Quantity) (page 87). |
### Appendix B:

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Billing Fields</strong></td>
<td>Optional fields that affect the way in which vouchers are sent to QuickBooks financial software. Refer to <strong>Entering Vendor Billing Information (page 291)</strong> for more information on these fields.</td>
</tr>
<tr>
<td>[Payee Name]</td>
<td><strong>Payee Name:</strong> Who is to be paid for the merchandise. Defaults to the vendor listed at the top of the voucher, but can be edited.</td>
</tr>
<tr>
<td>Already Paid</td>
<td><strong>Already Paid:</strong> Select this checkbox if you have already prepaid for the items, such as with a credit card.</td>
</tr>
<tr>
<td>Terms</td>
<td><strong>Terms:</strong> Terms of payment. From the payee’s record or, if applicable, from a referenced PO. Can be changed on individual vouchers.</td>
</tr>
<tr>
<td>Bill Date</td>
<td><strong>Bill Date:</strong> Enter the billing date from the vendor’s invoice. Based on the billing date and terms, the Invoice Due date is calculated and displayed.</td>
</tr>
<tr>
<td>Invoice Due</td>
<td></td>
</tr>
<tr>
<td>Invoice/Ref#</td>
<td><strong>Invoice/Ref#:</strong> The invoice or reference number from the vendor’s bill.</td>
</tr>
</tbody>
</table>

| **Discount Fields**    |                                                                                                                                                                                                       |
| Discount               | **Discount:** Enter a discount amount to be subtracted from the voucher subtotal. If you enter a discount amount, Point of Sale calculates and displays the discount percentage. Discounts entered on a referenced PO are proportionally brought to a voucher. |
| Discount %             | **Discount %:** Enter a discount percentage to be applied to the voucher subtotal. If you enter a discount percentage, Point of Sale calculates and displays the discount amount. Discounts entered on a referenced PO are proportionally brought to a voucher. |

| Fee                    | Enter any fee amount related to the voucher, such as an order fee. When the voucher references a PO with a fee entered, you are alerted and can transfer the fee to the voucher at your discretion. |

| Freight                | Enter any freight charges applicable to the voucher.                                                                                                                                                   |

| Invoice/Ref #          | See **Billing Fields**.                                                                                                                                                                               |

| **Order Qty Difference** | The difference between the original order quantity and the received quantity.                                                                                                                        |
| [Original Order Qty]   | The quantity that was ordered for the item.                                                                                                                                                          |

| PO #                   | The number of the PO that the voucher is referencing for each item. Entering a PO # brings information from the PO to the voucher and allows you to select items from the PO to receive.                     |

| [Qty]                  | The quantity of an item received (or returned) on a voucher. Suggested as one (1), or, if applicable, the quantity brought from a referenced PO. Editable.                                               |

| [Status]               | **Receiving History list:** Indicates the status of voucher as: **REGULAR**, **REVERSED**, or **REVERSING**. Refer to **Reversing a Voucher (page 297)** for more information.                  |

| [SubTotal]             | The sum of all extended item costs before discounts, fees, and freight charges are applied.                                                                                                           |

| [Total]                | The voucher total cost after discounts, fees, and freight charges are applied.                                                                                                                        |

<p>| [Type]                 | <strong>Receiving History list:</strong> Type of voucher: <strong>RECEIVING</strong> or <strong>RETURN</strong>.                                                                                                                            |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>Required field. The vendor from whom the merchandise is being received. If referencing a PO, brought from the PO.</td>
</tr>
<tr>
<td>[Voucher #]</td>
<td>Receiving History list: Sequential document number, assigned by Point of Sale.</td>
</tr>
<tr>
<td>Voucher Cost</td>
<td>See Cost Fields.</td>
</tr>
<tr>
<td><strong>Pro and Pro Multi-Store Fields</strong></td>
<td></td>
</tr>
<tr>
<td>Cust. Order #</td>
<td>When receiving against purchase orders that were generated from customer orders, the associated customer order number for which the item was ordered.</td>
</tr>
</tbody>
</table>
| Custom Fields 1-5 | Custom item fields can be used to enter any other customer information you need to track. Once defined, the fields can be used to filter lists and reports, and can be added to your printed documents using Print Designer.  
Refer to Custom Fields (Pro) (page 590) for more information on using these fields. |
| Customer     | When receiving against purchase orders that were generated from customer orders, the name of the customer for the associated customer order. |
| Serial #     | Voucher item list: Field used to record serial numbers of received items. Items can be designated as requiring a serial number entry in inventory (by selecting the PROMPT option in the Serial # Tracking field), in which case you will be prompted to enter a serial number for each unit of the item received. Refer to Serial Number Tracking (Pro) (page 149) for more information. |
| [Store]      | (Pro Multi-Store) The store receiving or returning merchandise. At Headquarters, can be changed to create a voucher for any store. At remote stores, this field defaults to the local store. |
# Customer Information Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Accept Checks?</strong></td>
<td>Clear the checkbox if you want to be alerted when taking payment by check from this customer. If requiring employee logins, an employee with sufficient security rights (Owner, Manager, Asst. Manager) can still accept the check, at their discretion, but an Associate-level employee can not. If not requiring logins, any employee can accept the check. Default: Selected (accept checks).</td>
</tr>
<tr>
<td><strong>Account Fields</strong></td>
<td>Customer's current charge account limit, balance, and remaining credit available. Account limit and balance. Refer to In-Store Charge Accounts (page 316) for more information.</td>
</tr>
<tr>
<td><strong>CHARGE ACCOUNT</strong></td>
<td>Select the checkbox if you wish to provide an in-house customer charge account.</td>
</tr>
<tr>
<td><strong>Customer Type</strong></td>
<td>Create categories of customer types in company preferences or by selecting ADD NEW from the Customer Type field drop-down list. Assign the types to individual customers. You can then filter reports or create mailing lists/labels based on customer type, as well as share this information with your financial software. Refer to Tracking Customers by Type (page 313) for more information.</td>
</tr>
</tbody>
</table>
| **Customer Discounts** | To have Point of Sale automatically suggest a discount on all sales to this customer, select:  
  • **APPLY A FIXED PERCENTAGE DISCOUNT TO ALL ITEMS**, and enter a discount percentage, or  
  • **USE A DISCOUNTED PRICE LEVEL FOR THIS CUSTOMER**, and select one of your predefined price levels from the drop-down list. The discount can be applied or not to each sale, at your discretion. Default: No Discount. Refer to Using Customer Discounts and Price Levels (page 311) for more information. |
<p>| <strong>Customer ID</strong> | Automatically assigned to new customers, can be generated for pre-existing customers, and can be used to print scannable ID cards. This format is 13 digits long constituting of a two-digit system digit (04), a five-digit store number, a five-digit customer number, and a check-digit. For example, the first customer ID number generated in your store (or store 1 if Multi-Store) would be 04 00001 00001 4. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name &amp; Contact Info</td>
<td>Enter first and last names, title, company, phone numbers, and e-mail address as appropriate. Last name is a required field. The customer’s name displayed on the bottom of sales receipts and printed on documents is comprised of first name, last name, and title in the order specified in PREFERENCES ▶ COMPANY ▶ SALES ▶ Order to display full name field. (Pro) Recording an e-mail address allows you to e-mail customer orders as attachments to your customers.</td>
</tr>
<tr>
<td>Notes</td>
<td>Use to record optional customer information, such as birth date, requested items, sizes, etc. Customer notes are not exchanged with QuickBooks financial software.</td>
</tr>
<tr>
<td>Sales Tax Information</td>
<td>If this customer qualifies for special sales tax handling, specify either: • USE THIS TAX LOCATION WHEN SELLING TO THIS CUSTOMER, and select one of your pre-defined tax locations from the drop-down list, or • TAX-EXEMPT, select the checkbox if no sales tax should be collected on normally taxable sales. With the first choice, Point of Sale will prompt you to change the tax location on sales to this customer. If the customer is flagged as tax-exempt, Point of Sale will automatically change the tax rate on the sale to 0%. Refer to Handling Special Customer Sales Tax (page 312) for more information.</td>
</tr>
<tr>
<td>QuickBooks Information</td>
<td>(Display and use of these fields requires that you also use QuickBooks Financial Software.) Use with QuickBooks: If you want to exchange the customer’s information with QuickBooks financial software. If you do not want to exchange the customer information with your financial software, clear the checkbox. PREFERENCES ▶ COMPANY ▶ CUSTOMERS ▶ USE WITH QUICKBOOKS: ☒ YES or NO. Specify whether the USE WITH QUICKBOOKS option should be selected by default for new customers. In the Customer List: Displays the exchange status of the record with QuickBooks financial software. Refer to Verifying the Exchange of Individual Transactions (page 490) for more information.</td>
</tr>
<tr>
<td>Rewards Fields (Pro)</td>
<td>Customer fields associated with the Customer Rewards Program. Refer to Customer Rewards Program (Pro) (page 323) for more information.</td>
</tr>
<tr>
<td>Track Rewards [Issued]</td>
<td></td>
</tr>
</tbody>
</table>
Appendix B:

Tip: Recording and Using Other Customer Information

The Phone 2 field can be used to record information other than a second phone number and then that information could be used to sort, search, and look up customers by entering that information. For example, if you record customer numbers in the Phone 2 field, you could then sort the customer list, search for a customer, or enter a customer on a sales receipt by entering the customer number.

Receipt Information Fields

Note that item-specific fields are only available in the receipt item list (on the receipt form) and are included only if they differ from the inventory Item Information Fields (page 647). Fields whose purpose is obvious or common to all modules have been omitted from this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Cashier]</td>
<td>If security is used, the Cashier field is auto-filled with the name of the logged-in user and cannot be changed. If not using security, select a name from the drop-down list of defined employees.</td>
</tr>
<tr>
<td>Customer Information:</td>
<td>(Optional fields used when tracking customers.) Customer name. You can specify the combination and order for the first name, last name, and title to be displayed in the Customer Information area of the receipt screen and on printed receipts.</td>
</tr>
<tr>
<td>[Name]</td>
<td>PREFERENCES ➤ COMPANY ➤ SALES ➤ Order to display full name field: Specify the order, and optionally title, to display full name on receipts.</td>
</tr>
<tr>
<td>[Address]</td>
<td>Once a customer is listed, additional information, such as the accept checks status, account balance/limit, assigned discounts or price level, and purchase history is accessible from the I Want To menu.</td>
</tr>
<tr>
<td>Cost Fields</td>
<td>Cost = The average unit cost of the item as recorded in inventory. Receipt Cost = Extended cost by receipt item (Qty x Cost). Display fields only; not editable.</td>
</tr>
<tr>
<td>[Cost]</td>
<td></td>
</tr>
<tr>
<td>[Receipt Cost]</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Usage</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Discount Fields:**       | **Discount %**  
**Discount**  
**Unit Discount**  
**Ext Discount**  
**Discount Reason**  
Used to record item discounts (in the item list) or global discounts (in the receipt totals area). A global discount is taken from the receipt subtotal and is not spread across the listed items.  
**Disc %:** item or global discount  
**Discount** (amount): global discount only  
**Unit Discount:** item discount only, discount amount per unit sold  
**Extended Discount:** item discount only (Qty x Unit Discount)  
**Discount Reason:** item discount, select type from drop-down list  
See Manual Item Discounts (page 360) and Global Discounts (page 361) for more information. |
| **[Message, Printed]**     | Printed, not displayed on-screen  
User-definable message(s) that are printed on the copy of the receipt given to your customers. For example, you could use the message field to print "We Appreciate Your Business" or your return policy on every receipt.  
PREFERENCES ➤ COMPANY ➤ SALES ➤ RECEIPT MESSAGE ➤ Printed Receipt Customer Message: Define messages to be printed on each receipt. |
| **[Payment]**              | Displayed in sales history list. The payment type used for the receipt. If more than one payment type was used, Split is displayed.  
Price Fields:  
**[Price]**  
**[Ext Price]**  
**[Custom Price Levels]**  
**[Price Level]**  
**[Original Price]**  
Receipt item list. **Price** = the unit price at which an item is being sold after any line-item discount or price level changes.  
**Extended Price** = Qty x Price. **Custom Price Levels** (your custom names displayed) = the item price at each of your markdown price levels. **Original Price** = Price at active price level for reference; does not change if discounts given.  
**Totals area:** **Price Level** indicates the active price for the receipt (Regular Price or one of your markdown price levels). Suggested as the default price specified in company preferences. Select a different price level from the drop-down list to change the active price for the receipt.  
The Price, Extended Price, and Price Level fields can be edited to give the customer a different price or discount. If you enter an item quantity and an extended price, Point of Sale will calculate a new unit price for you.  
Refer to Changing the Receipt Price Level (page 359) and Manual Item Discounts (page 360) and for more information. |
| **Promo Code**             | Used to record a miscellaneous code on a receipt, such as the advertisement the customer saw your merchandise in.  
For example, if you are having a big mail promotion to celebrate your business anniversary, you could record an entry of **Anniv** for all sales made during the promotion. Later, you could run a sales report, filtered on the **Promo Code** field, to evaluate the effectiveness of the promotion. An entry in the Promo Code field can be required.  
PREFERENCES ➤ COMPANY ➤ SALES ➤ Require a promo code entry:  
If selected, an entry in Promo Code field on receipts is required before they can be saved. |
## Appendix B:

### Receipt Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Receipt #]</td>
<td>Sales history list only. Sequential number assigned to receipts as they are created.</td>
</tr>
<tr>
<td>[Receipt Type]</td>
<td>Sales history list only. Indicates type of receipt: Sale, Return, Payout, or Deposit.</td>
</tr>
<tr>
<td>[Status]</td>
<td>Sales history list only. Indicates status of receipt: Regular, Reversed, or Reversing. &lt;br&gt; Refer to <strong>Reversing Receipts</strong> (page 411) for more information on reversing receipts.</td>
</tr>
<tr>
<td>[Subtotal]</td>
<td>Totals area: The sum of the Extended Prices for all items listed on the receipt.</td>
</tr>
</tbody>
</table>

#### Tax Fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
</table>
| [Tax Location] | Tax Location: Tax location used for sale; displayed in the status bar at the bottom of the window. Suggested as the default tax location specified in company preferences. Can be changed by choosing SELECT TAX LOCATION from the I Want To menu.  

Receipt item list: Tax Code = the item tax code; as specified in inventory can be changed at time of sale. Tax % = the tax rate applied to item. Tax = the tax amount collected per item unit. Extended Tax = the total tax amount for the item (Qty x Tax).  

Totals area: Tax % = Sales tax percentage applied to the entire receipt. If sold items are being taxed at different rates, this field is blank and disabled. Tax = total sales tax collected on the sale. <br> Refer to **Sales Tax Overview** (page 339) for more information. |
| [Tax Code]  |                                                                                                                                        |
| [Tax %]     |                                                                                                                                        |
| [Tax]       |                                                                                                                                        |
| [Ext Tax]   |                                                                                                                                        |
| [Total]     | The receipt total (i.e., the subtotal less global discounts, plus taxes and shipping). Calculated field. Not editable.                   |

### Pro and Pro Multi-Store Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
</table>
| Commission Fields | Receipt item list: Commission % = Percent commission specified on associate’s employee record. Commission = Amount of commission payable to the associate on the item sale. Eligible for Commission = checkbox indicates if item sale is eligible for payment of commission. From item record in inventory.  

Refer to **Tracking Employee Commissions (Pro)** (page 60) for more information. |
| [Commission %] |                                                                                                                                        |
| [Commission]  |                                                                                                                                        |
| [Eligible for Commission] |                                                                                                                                        |
| Serial #     | Field used to record serial numbers of sold items. Items can be designated as requiring a serial number entry in inventory (by selecting the PROMPT option in the Serial # Tracking field on the item record), in which case you will be prompted to enter a serial number for each unit of the item sold.  

Refer to **Serial Number Tracking (Pro)** (page 149) for more information. |
## Pro and Pro Multi-Store Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipping Information</td>
<td><strong>Totals Area</strong>: Enter <strong>Ship Date</strong> and <strong>Shipping</strong> amount for the sale.</td>
</tr>
<tr>
<td>Ship Date</td>
<td>Shipping Information window: Select <strong>SHIPPING INFORMATION</strong> from the I Want To menu to enter additional shipping information, such as the provider (<strong>Ship By</strong>), Tracking #, and a Shipping Address. You can also print a packing slip and shipping label from the Shipping Information window. <strong>PREFERENCES ➤ COMPANY ➤ SALES ➤ Shipping</strong>: Define shipping providers and specify one as the default, which is suggested on receipts. The list of providers is available for selection on the Shipping Information window when making a sale.</td>
</tr>
<tr>
<td>Shipping/Ship $</td>
<td></td>
</tr>
<tr>
<td>Ship By</td>
<td></td>
</tr>
<tr>
<td>Tracking #</td>
<td></td>
</tr>
<tr>
<td>Shipping Address</td>
<td></td>
</tr>
<tr>
<td><strong>Store</strong> (Pro Multi-Store)</td>
<td>The store from whose inventory the merchandise is being sold/returned. At Headquarters, can be changed to create a receipt for any store. At remote stores, this field defaults to the local store and cannot be changed.</td>
</tr>
</tbody>
</table>

## Customer Order Information Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assigned</strong></td>
<td>Work Order: Select the employee to whom the service job is assigned. Suggested as the logged in employee. As the work progresses, this field can be edited as necessary. This field can be used to filter work order reports.</td>
</tr>
<tr>
<td><strong>[Balance Due]</strong></td>
<td>The balance remaining on the order. <strong>Balance due</strong> = Total – Deposit Balance.</td>
</tr>
<tr>
<td><strong>Customer</strong></td>
<td>Required on all customer orders. Once deposits have been taken, the customer on an order cannot be changed.</td>
</tr>
<tr>
<td><strong>Date Fields</strong></td>
<td></td>
</tr>
<tr>
<td><strong>[Order Date]</strong></td>
<td>Most dates are suggested as today’s date, but can be edited. Select the icon next to a date field to access a selection calendar. <strong>Order Date</strong> = Date order was placed. <strong>Due Date</strong> = Used on work orders to record the expected completion date.</td>
</tr>
<tr>
<td><strong>[Due Date]</strong></td>
<td></td>
</tr>
<tr>
<td><strong>[Deposit Balance]</strong></td>
<td>The sum of all deposits received, less any deposits already applied as payment on a receipt or refunded. Select <strong>PAYMENT HISTORY</strong> from the I Want To menu to open the Deposits window and view the list of deposits taken/used.</td>
</tr>
<tr>
<td><strong>[Dep Receipt #]</strong></td>
<td>Deposit Receipt Number, on Deposits window. The sequential number assigned to the receipt used to record a deposit, taken or used.</td>
</tr>
<tr>
<td><strong>Description of problem</strong></td>
<td>Work orders. This field is used to record information related to the services to be performed and any special instructions. Select the <strong>EDIT INSTRUCTIONS</strong> icon if more space is needed to record instructions.</td>
</tr>
</tbody>
</table>
## Appendix B:

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Instructions</strong></td>
<td><em>Layaways, Sales Orders:</em> Free-form text entry field allowing you to record miscellaneous information regarding the purchase order. Select the icon adjacent to the field to enter longer comments.</td>
</tr>
<tr>
<td><strong>Message (Printed)</strong></td>
<td>Printed order message (not displayed on-screen). Messages can be different for each order type. Defined in <strong>PREFERENCES &lt;ORDER TYPE&gt; Printed Message</strong>. Examples: “Have a great day!”, “Thanks for your business!”, “All custom orders are non-refundable”</td>
</tr>
<tr>
<td><strong>No of Items</strong></td>
<td><em>In the customer order lists:</em> Number of items (not units) on the order, e.g. if customer ordered two sweaters and one pair of jeans, the number of items is two (not three, which is the <strong>Total Ordered</strong> quantity).</td>
</tr>
<tr>
<td><strong>[Order #]</strong></td>
<td>Layaway #, SO #, or WO #. Auto-filled by Point of Sale in sequential order using a separate sequence for each order type.</td>
</tr>
<tr>
<td><strong>[Payment]</strong></td>
<td><em>Deposit window (Payment History):</em> The payment method (cash, credit card, check, etc.) used to make a deposit.</td>
</tr>
<tr>
<td><strong>Promo Code</strong></td>
<td>The promotional code to identify the source of the customer or order.</td>
</tr>
<tr>
<td><strong>Qty Fields - Item List</strong>&lt;br&gt; Ordered&lt;br&gt; [Sold]&lt;br&gt; [Due]&lt;br&gt; [On Order]**</td>
<td><em>On the order form item list:</em> <strong>Ordered</strong> = Enter the quantity ordered by the customer. Suggested as one (1) or the Doc Qty transferred from inventory. <strong>Sold</strong> = The quantity that has been sold on a sales receipt. <strong>Due</strong> = Quantity remaining to be sold to customer. <strong>Ordered - Sold</strong> = Due. <strong>On Order</strong> = Reference field from inventory; lets you know if there are pending POs for the item and the quantity on order.</td>
</tr>
<tr>
<td><strong>Qty Fields - Order Lists</strong>&lt;br&gt; [Total Ordered]&lt;br&gt; [Total Due]**</td>
<td><em>In the customer order lists:</em> <strong>Total Ordered</strong> = Total order quantity (all items). <strong>Total Due</strong> = Total quantity remaining to be sold to customer.</td>
</tr>
<tr>
<td><strong>[Reverse]</strong></td>
<td>Payment History screen. If a receipt used to take a deposit has been reversed, Reversed is displayed in this field. Receipts that reverse a deposit receipt are also shown, and display Reversing in this field.</td>
</tr>
<tr>
<td><strong>Shipping</strong></td>
<td><em>Sales and work orders:</em> Enter an amount for shipping charges, if applicable. You can select <strong>SHIPPING INFORMATION</strong> from the I Want To menu to enter other shipping information, such as a provider (list of providers can be defined in company preferences) and shipping address.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>The current status of the customer order. Automatically set to <strong>OPEN</strong> on new orders and <strong>CLOSED</strong> on filled orders. Used to track your orders and filter the order list and reports. Refer to <strong>Tracking Orders by Status (page 430)</strong> for more information. <em>Pro</em> If you use orders to provide quotes, you can assign the status of <strong>PENDING</strong> so that your on-hand and available quantities are not affected.</td>
</tr>
</tbody>
</table>
Transfer Slip Information Fields

The following table alphabetically lists the fields that are available on transfer slips or in the transfer history list. Item fields whose purpose is explained in Item Information Fields (page 647) have been omitted from this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unfilled %</td>
<td>Order lists: Percentage of order not yet sold to customer, based on total order quantities. Unfilled % = Total Sold/Total Ordered x 100.</td>
</tr>
<tr>
<td>Carrier</td>
<td>Used to record the carrier name that transported the merchandise.</td>
</tr>
<tr>
<td>[Cost] [Ext Cost]</td>
<td>Slip item list: Auto-filled as the current item cost from inventory and extended cost for the slip (Qty x Cost). Not editable.</td>
</tr>
<tr>
<td>[ETA]</td>
<td>Estimated Time of Arrival. Optional field used to convey an estimate of when the transferred merchandise will arrive at the destination store. Defaults to today's date.</td>
</tr>
<tr>
<td>Freight</td>
<td>Used to record freight charges related to the transfer. This provides a record of these charges to compare to a freight bill later.</td>
</tr>
<tr>
<td>[From Store]</td>
<td>Source store of merchandise being transferred. By default, the store number/code for the store making the slip. Headquarters can select a different store from the drop-down list to create a slip for that store.</td>
</tr>
<tr>
<td>[No of Items]</td>
<td>Transfer history list: Number of different items transferred (not unit quantity).</td>
</tr>
<tr>
<td>Qty</td>
<td>Slip item list: The item quantity being transferred.</td>
</tr>
<tr>
<td>Serial #</td>
<td>Slip item list: For recording item-specific serial numbers, if serial number tracking is being used.</td>
</tr>
<tr>
<td>[Slip #]</td>
<td>Transfer history list: Sequential number of transfer slips made. Each store has a separate numbering sequence. Not editable.</td>
</tr>
<tr>
<td>[Status]</td>
<td>Transfer history list: Status of the slip: REGULAR, REVERSED, or REVERSING. Refer to Reversing a Transfer Slip (page 560).</td>
</tr>
<tr>
<td>To Store</td>
<td>Destination store for the transferred merchandise. Select a store number/code from the drop-down list. Must be different than the From Store.</td>
</tr>
<tr>
<td>[Total Cost]</td>
<td>The total extended cost of all items listed on the slip.</td>
</tr>
<tr>
<td>[Total Qty Transferred]</td>
<td>Transfer history list: Total unit quantity, all items, transferred by slip.</td>
</tr>
</tbody>
</table>
Overview

Originally, the term firewall referred to a fire-resistant barrier that was used to prevent the spread of fires. Similarly, firewalls in the computer world are also used to prevent the spread of something that could be damaging to your system, your information, or your privacy. Computers communicate with each other over a network or the Internet by sending and receiving information through different ports (channels). Hackers try to gain access to other computers through these ports, or they create programs that try to do this for them. Firewalls are used to prevent this from happening.

Firewalls monitor communication traveling through your computer’s ports and block any communication that they do not know is safe. This provides you with an essential component of the protection you need to minimize your exposure to dangers from malicious users on the Internet. In order to ensure that desired communication is not blocked, you may sometimes need to instruct your firewall program to allow communication from certain programs. You may also need to specify the particular ports that will be used. How this is done will vary depending upon the particular firewall you are using.

There are many different firewalls available to you, and they can be either software or hardware firewalls (for example, many routers have built-in firewalls.)

On a typical network, there is a single point of connection to the Internet (such as the network server) and this is normally the only point requiring a firewall. Many network administrators feel that in such a situation there is no need to activate firewalls on every workstation to guard against communication from one workstation to another. A good firewall located on the server or other single point of access to the Internet is most often viewed as adequate protection. It is recommended that you consult a qualified network administrator to review your particular network setup for purposes of implementing the best protective measures for your situation.

Point of Sale uses some of the ports on your computer to complete various tasks. Your firewall may need to be specifically told that these activities should be allowed. The following documentation provides an overview of the various Point of Sale activities that may trigger firewall interference, and some examples to assist in configuring the most common software firewall programs.
Firewalls and Point of Sale

Firewalls may need to be configured on the server to allow other workstations to access the Point of Sale company data over the network. When a firewall application senses a possible threat, it will typically generate a pop-up window that requires user interaction to determine how to handle the situation. You may need to be logged into Windows as an administrator to see these messages. Examples for some of these pop-up windows are provided on the following pages.

If you are on a Client Workstation, accessing the company data on the Server Workstation across the network, the pop-up window might occur on the Server Workstation and the firewall program on that computer would put the action on “hold” until someone on the Server Workstation indicates the correct action to take.

For this reason, when first installing and running Point of Sale on a Client Workstation, it is important that the Server Workstation is either easily accessible, or that the Server Workstation is manned and that the person manning it is in step-by-step communication with the person installing the Client Workstation. It is also recommended that during installation, you are logged into the computer with Windows administrator rights.

Each firewall program presents its interface in a slightly different manner; each provides its own phrase for asking what you would like to do regarding the action it views as a possible threat. When a window pops up on your computer screen, you will see some form of the question, “What do you want to do about this?” That question will be followed by a list from which you choose the correct action. This list might include such options as allow, grant, deny, block, permit, or some similar instruction. Once you have selected to allow, grant or permit the action, there should not be a prompt the next time the same action is performed. However, permitting one action from one file will not automatically enable all actions from anywhere in the Point of Sale program. Permission must be granted separately for each type of action. If firewall messages continue to appear, it may be necessary to manually configure the firewall to allow access through the required ports.

If you are unable to access the Point of Sale company data and you know you have an enabled firewall on the Server Workstation, try the steps provided in the following pages for configuring your firewall to allow the connection.

Keep Your Firewall Software Up To Date

Many common firewall programs will recognize Point of Sale activities and will allow Point of Sale connections. Update your firewall software as the first step to resolving firewall issues. This will need to be repeated each time Point of Sale is updated.
The following screen shots display possible pop-up windows from two of the most popular firewall applications.

**McAfee® Personal Firewall Plus:**

![McAfee Personal Firewall Plus](image)

**Norton™ Personal Firewall:**

![Norton Personal Firewall](image)
Port of Sale Activities

The following activities in Point of Sale may result in triggering a firewall reaction:

- Communicating between Point of Sale and the Point of Sale database (can occur on both the Server and Client workstation.)
- Converting data from a previous version
- Credit/debit/gift card processing
- Downloading program updates/web installation
- Registration and licensing

Quick Reference

<table>
<thead>
<tr>
<th>Default Port</th>
<th>Executable</th>
<th>Accessed by (Server/Client Workstations)</th>
<th>When Accessed</th>
</tr>
</thead>
<tbody>
<tr>
<td>443</td>
<td>EFTSvr.exe</td>
<td>Both</td>
<td>Throughout operation</td>
</tr>
<tr>
<td>8443</td>
<td>EFTSvr.exe</td>
<td>Both</td>
<td>Merchant Service transactions</td>
</tr>
<tr>
<td>2638</td>
<td>DataImporter.exe</td>
<td>Server only</td>
<td>Through operation</td>
</tr>
<tr>
<td></td>
<td>EFTSvr.exe</td>
<td>Both</td>
<td>Conversion from previous version</td>
</tr>
<tr>
<td></td>
<td>QBDBMgrN.exe</td>
<td>Server only</td>
<td>Changing currently running database (such as switching to/from practice mode.)</td>
</tr>
<tr>
<td></td>
<td>QBPOSDBServiceEx.exe</td>
<td>Both</td>
<td>Startup</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Detecting change to QBSettings.ini</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Help &gt; Manage my license</td>
</tr>
<tr>
<td>46206</td>
<td>EFTSvr.exe</td>
<td>Both</td>
<td>Merchant Service transactions</td>
</tr>
<tr>
<td></td>
<td>QBPOS.exe</td>
<td></td>
<td></td>
</tr>
<tr>
<td>46207</td>
<td>EFTSvr.exe</td>
<td>Both</td>
<td>Through operation</td>
</tr>
<tr>
<td></td>
<td>QBDBMgrN.exe</td>
<td>Server only</td>
<td>Changing currently running database (such as switching to/from practice mode.)</td>
</tr>
<tr>
<td></td>
<td>QBPOS.exe</td>
<td>Both</td>
<td></td>
</tr>
<tr>
<td>46208</td>
<td>EFTSvr.exe</td>
<td>Both</td>
<td>Through operation</td>
</tr>
<tr>
<td></td>
<td>QBDBMgrN.exe</td>
<td>Server only</td>
<td>Changing currently running database (such as switching to/from practice mode.)</td>
</tr>
<tr>
<td></td>
<td>QBPOS.exe</td>
<td>Both</td>
<td></td>
</tr>
<tr>
<td>46209</td>
<td>QBPOSDBServiceEx.exe</td>
<td>Both</td>
<td>Item picture requests</td>
</tr>
</tbody>
</table>
Configuring Firewalls

If you use a firewall, you may receive an alert that Point of Sale is requesting access to the Internet or to connect to other computers. The message may identify any of the above as the program that is trying to establish communications, as well as Adaptive Server Anywhere Network Server. Select the option to allow access always. This should prevent this message in the future.

**Windows XP Firewall**

If you are using the Windows XP integrated firewall, Point of Sale can automatically configure the firewall for you.

**To automatically configure the Windows XP Internet Connection Firewall (ICF):**

1. Restart Point of Sale on the server workstation.
   The Windows firewall is detected on startup, and Point of Sale prompts you to authorize automatic configuration.

2. Select **AUTOMATICALLY CONFIGURE** to allow automatic configuration.
   If you answer **NO**, you can still manually configure the firewall as described below. You will continue to receive the firewall message each time you start Point of Sale on the server until the firewall is configured to allow communication.

---

**Windows XP Integrated Firewall**

When running the Windows XP Integrated Firewall, users may not be prompted unless they have Windows administrator rights. Have the user log in as an administrator if Point of Sale cannot connect to the database and no firewall alerts appear.
**Windows XP Service Pack 2: Simplified Firewall Configuration**

1. From the Control Panel, select **WINDOWS FIREWALL**.
2. On the General tab, make sure that **DON'T ALLOW EXCEPTIONS** is NOT checked.
3. From the Exceptions tab, select **ADD PROGRAM**.
4. Select your version of QuickBooks Point of Sale and select **OK**.

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
<th>External Port</th>
<th>Internal Port</th>
<th>Traffic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Intuit Entitlement Client v5 (TCP) (Server)</td>
<td>8028</td>
<td>8028</td>
<td>TCP</td>
</tr>
<tr>
<td></td>
<td>Intuit Entitlement Client v5 (TCP) (Client)</td>
<td>8027</td>
<td>8027</td>
<td>TCP</td>
</tr>
<tr>
<td>2</td>
<td>Intuit Entitlement Service Discovery v5 (UDP)</td>
<td>8027</td>
<td>8027</td>
<td>UDP</td>
</tr>
<tr>
<td>3</td>
<td>QBPOS_Practice</td>
<td>46208</td>
<td>46208</td>
<td>TCP</td>
</tr>
<tr>
<td>4</td>
<td>QBPOS_Real</td>
<td>46207</td>
<td>46207</td>
<td>TCP</td>
</tr>
<tr>
<td>5</td>
<td>QBPOS_TCP</td>
<td>2638</td>
<td>2638</td>
<td>TCP</td>
</tr>
<tr>
<td>6</td>
<td>QBPOS_UDP</td>
<td>2638</td>
<td>2638</td>
<td>UDP</td>
</tr>
<tr>
<td>7</td>
<td>QBPOSEFTSERVER_TCP</td>
<td>8443</td>
<td>8443</td>
<td>TCP</td>
</tr>
<tr>
<td>8</td>
<td>QBPOSEFTSERVER_TCP</td>
<td>46206</td>
<td>46206</td>
<td>TCP</td>
</tr>
<tr>
<td>9</td>
<td>QBPOSEFTSERVER_TCP</td>
<td>46208</td>
<td>46208</td>
<td>TCP</td>
</tr>
</tbody>
</table>
McAfee Personal Firewall Plus: Manual Configuration

The configuration panel for McAfee is displayed below. To access this screen, select START ➤ PROGRAMS (or ALL PROGRAMS) ➤ McAfee ➤ PERSONAL FIREWALL PLUS. Select the INTERNET APPLICATIONS tab.

If any executable file used in the Point of Sale program has the wrong setting, you can correct it here. Highlight the executable in the list and select ALLOW FULL ACCESS. If the executable file is not on the list, select NEW ALLOWED APPLICATION in order to add and configure the file.

The executable files to include are:

- DataImporter.exe
- EftSvr.exe
- QBDBMgr.exe
- QBDBMgrN.exe
- QBPOS.exe
- QBPOSDBServiceEx.exe
Norton Personal Firewall: Manual Configuration

The configuration panel for Norton is displayed below. To access this screen, select START ➤ PROGRAMS (or ALL PROGRAMS) ➤ NORTON INTERNET SECURITY ➤ NORTON INTERNET SECURITY. Select the PROGRAMS tab. Next, select PERSONAL FIREWALL and CONFIGURE. Then select the PROGRAMS tab.

If any executable file used in the Point of Sale program has the wrong setting, you can correct it here. Change the INTERNET ACCESS setting to PERMIT ALL. If the executable file is not on the list, select ADD in order to add and configure the file.

The executable files to include are:

- DataImporter.exe
- EftSvr.exe
- QBDBMgr.exe
- QBDBMgrN.exe
- QBPOS.exe
- QBPOSDBServiceEx.exe
ZoneAlarm® Pro Firewall: Manual Configuration

The configuration panel for ZoneAlarm Pro is displayed below. To access this screen, select START ➤ PROGRAMS (or ALL PROGRAMS) ➤ ZONE LABS ➤ ZONE ALARM PRO. Select PROGRAM CONTROL on the right and then select the PROGRAMS tab.

If any executable file used in the Point of Sale program is not checked as TRUSTED, you can correct it here by clicking the setting and selecting ALLOW. If the executable file is not on the list, select ADD in order to add and configure the file.

The executable files to include are:

- DataImporter.exe
- EftSvr.exe
- QBDBMgr.exe
- QBDBMgrN.exe
- QBPOS.exe
- QBPOSDBServiceEx.exe
General Troubleshooting Tips

Possible Server Workstation Problems

When encountering connection difficulties on a Server Workstation, the first step is for the user to sign onto the machine as a user with Windows administrator rights.

Problems can occur due to any of the following:

- The database application is not running on the Server Workstation
- The Point of Sale company data has been deleted or renamed
- A firewall is interfering with program communications
- TCP/IP not installed
- You are attempting to change the current database being accessed by the server while a client is logged into a different database (only one database can be run at a time)
- The Server Workstation is not running the same level or version of Point of Sale as another workstation that is currently accessing the database (if different sub-version, a prompt will be displayed)
- The Client Workstation is still logged into the database and thereby preventing Restore, Open Database or Rename Database functions
- A needed component or service in Windows has been disabled or deleted
- QBPOSDBSrvUser
- The selected database is not a Point of Sale database

Possible Client Workstation Problems

When encountering connection difficulties on a Client Workstation, the first step is for the user to sign-on to the Client Workstation as a user with Windows administrator rights AND that an administrator also sign-on to the Server Workstation.

Problems can occur due to any of the following:

- The Server Workstation is not running
- The database application is not running on the Server Workstation
- The Point of Sale company data has been deleted or renamed
- A firewall is interfering with program communications
- TCP/IP not installed
- An invalid database name has been entered
- The Client Workstation is not running the same level or version of Point of Sale as another Workstation that is currently accessing the database (if different sub-version, a prompt will be displayed)
- More workstations are running than is allowed by license (a message will be displayed)
- A different database is already running (only one database can be run at a time)
- A needed component or service in Windows has been disabled or deleted
- Other network connectivity issue
- The selected database is not a Point of Sale database

**Port Filters**

Windows XP allows TCP/IP and UDP ports to be filtered. To determine if this is the source of the problem, do the following:

1. Right-click **NETWORK PLACES** and select **PROPERTIES**.
2. Right-click **LOCAL AREA CONNECTION** and select **PROPERTIES**.
3. Select **TCP/IP**.
4. Select **PROPERTIES**.
5. Select **ADVANCED**.
6. Select **OPTIONS**.
7. Select **TCP/IP FILTERING**.
8. Select **PROPERTIES**.

If **Permit Only** is checked in any category that is needed for Point of Sale, or required ports are not in the list, the same problems will occur as with a firewall.
QuickBooks Point of Sale has been designed to work seamlessly with select industry-leading retail hardware. Although the program may operate with various other hardware peripherals, Intuit does not provide hardware support for equipment not sold by Intuit. This table of compatible equipment is provided as a guideline only. While all hardware devices sold by Intuit are guaranteed to work together, you should check with individual manufacturers to determine inter-compatibility for devices not sold by Intuit.

For the most up-to-date equipment information, search the in-program Help index using the keyword Equipment and/or contact the equipment vendor. For a complete list of supported hardware, or to purchase supported hardware directly from Intuit, call 1-800-926-6066. The following hardware has been tested with Point of Sale v7.0 and equipment listed in **bold type** is available for purchase from Intuit. Equipment sold by Intuit may be subject to change.

### Bar Code Scanners

<table>
<thead>
<tr>
<th>Type/Model</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>HHP Imageteam 3800LR USB</td>
<td></td>
</tr>
<tr>
<td>Welch Allyn (Handheld) IT-3220</td>
<td></td>
</tr>
<tr>
<td>Symbol LS1908T USB</td>
<td></td>
</tr>
<tr>
<td>Symbol Cyclone M2007 Omni-directional Scanner USB</td>
<td></td>
</tr>
<tr>
<td>Metrologic Voyager BT MS9535 Bluetooth Wireless</td>
<td></td>
</tr>
<tr>
<td>Metrologic QuantumT MS3580 Omni-directional Scanner USB</td>
<td></td>
</tr>
<tr>
<td>Metrologic Voyager MS9520 PS/2</td>
<td></td>
</tr>
<tr>
<td>HHP SR IT5600</td>
<td></td>
</tr>
<tr>
<td>HHP Imageteam 3800LR PS/2</td>
<td></td>
</tr>
<tr>
<td>Symbol LS1902T PS/2</td>
<td>Configure using setup barcode instructions included with Symbol documentation. Scanner is &quot;keyboard wedge,&quot; type &quot;IBM AT.&quot; Configure carriage return &quot;&lt;CR&gt;&quot; to end of all scans.</td>
</tr>
</tbody>
</table>
**Cash Drawers**

Use of a cash drawer requires a receipt printer through which it connects to computer. Not all cash drawers are compatible with all receipt printers.

<table>
<thead>
<tr>
<th>Type/Model</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>MMF VAL-u Line Cash Drawer</td>
<td></td>
</tr>
<tr>
<td>M-S Cash Drawer CF-Media</td>
<td></td>
</tr>
<tr>
<td>MMF ECD200</td>
<td></td>
</tr>
<tr>
<td>APG Series 100</td>
<td></td>
</tr>
<tr>
<td>APG T371-BL16195</td>
<td></td>
</tr>
<tr>
<td>APG T371-DG1616</td>
<td>(For use with Dell T200 printer)</td>
</tr>
</tbody>
</table>

**Card Readers (MSR: Used for credit, debit and gift cards)**

<table>
<thead>
<tr>
<th>Type/Model</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magtek 21040110</td>
<td></td>
</tr>
<tr>
<td>ID Innovations PS2 MSR</td>
<td></td>
</tr>
<tr>
<td>ID Innovations MSR USB</td>
<td></td>
</tr>
<tr>
<td>Cherry Keyboard MSR - G81-7920LUBBUS-2</td>
<td>May require additional configuration to work with Point of Sale.</td>
</tr>
<tr>
<td>Cherry Keyboard Small G86-62410UAGSA</td>
<td>May require additional configuration to work with Point of Sale.</td>
</tr>
<tr>
<td>Cherry Keyboard MSR MY 7000 USB</td>
<td>May require additional configuration to work with Point of Sale.</td>
</tr>
<tr>
<td>Cherry Keyboard MSR MY 7000 PS/2</td>
<td>May require additional configuration to work with Point of Sale.</td>
</tr>
<tr>
<td>ID Tech Mini Mag USB DEL3331-33UB</td>
<td>May require additional configuration to work with Point of Sale.</td>
</tr>
<tr>
<td>Logic Controls MR 3010</td>
<td></td>
</tr>
<tr>
<td>ELO KE MSR D63505-000</td>
<td></td>
</tr>
<tr>
<td>ELO Touchscreen 1522L USB with MSR</td>
<td></td>
</tr>
<tr>
<td>ELO Monitor/MSR F05973-000 Serial/USB</td>
<td></td>
</tr>
<tr>
<td>ELO Touchscreen 1529L with MSR</td>
<td></td>
</tr>
</tbody>
</table>
**PIN Pads**

<table>
<thead>
<tr>
<th>Type/Model</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ingencio i3070 Integrated PIN Pad (Available January, 2008)</td>
<td>USB connection adapter included. Install driver per instructions included with device.</td>
</tr>
<tr>
<td>Ingencio eNcrypt 2100 w/integrated card swipe</td>
<td></td>
</tr>
<tr>
<td>Ingencio 3010 w/o swipe</td>
<td></td>
</tr>
</tbody>
</table>

**Pole (Shopper) Displays**

<table>
<thead>
<tr>
<th>Type/Model</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logic Controls LD 9900 USB</td>
<td>Serial pole displays may conflict with other serial devices, such as modems or printers even if the other device is not turned on or connected. It may be necessary to reassign other devices to different ports.</td>
</tr>
<tr>
<td>Partner Tech CD7220</td>
<td></td>
</tr>
<tr>
<td>Logic Controls LD 9900 PUSB</td>
<td></td>
</tr>
<tr>
<td>Logic Controls LD 9000, LD 9000U USB</td>
<td></td>
</tr>
<tr>
<td>Logic Controls PD 3000</td>
<td></td>
</tr>
<tr>
<td>Partner Tech CD7220 USB-B</td>
<td></td>
</tr>
</tbody>
</table>

**Physical Inventory Scanner**

<table>
<thead>
<tr>
<th>Type/Model</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metrologic SP5500 Optimus S (USB)</td>
<td></td>
</tr>
<tr>
<td>Cipher Labs 8000 USB</td>
<td></td>
</tr>
</tbody>
</table>

**Receipt Printers**

<table>
<thead>
<tr>
<th>Type/Model</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Citizen CT-S300</td>
<td></td>
</tr>
<tr>
<td>Star TSP 100 series USB</td>
<td></td>
</tr>
<tr>
<td>Star TSP 600 series</td>
<td></td>
</tr>
<tr>
<td>Star TSP 600 series USB</td>
<td></td>
</tr>
<tr>
<td>Dell T200 USB</td>
<td>Compatible drivers for Windows Vista are not available at this time.</td>
</tr>
</tbody>
</table>
Appendix D: Compatible Hardware

<table>
<thead>
<tr>
<th>Type/Model</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Star TSP 700</td>
<td>Requires Star &quot;Raster&quot; driver. Defaults to partial paper cut, but can be changed to full cut in Windows printer preferences.</td>
</tr>
<tr>
<td>Epson TM88III</td>
<td>Recommend using the TM88II driver. Compatible drivers for Windows Vista are not available at this time. See Note 1.</td>
</tr>
<tr>
<td>Epson TM88IV USB</td>
<td></td>
</tr>
<tr>
<td>Epson TM88IV PUSB</td>
<td></td>
</tr>
<tr>
<td>HP Laser Jet 4200 PCL 6</td>
<td></td>
</tr>
<tr>
<td>HP Laser Jet 4600 PCL 6</td>
<td></td>
</tr>
</tbody>
</table>

**Tag Printers**

<table>
<thead>
<tr>
<th>Type/Model</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zebra Tag Printer LP2824 USB</td>
<td>For all tag printers:</td>
</tr>
<tr>
<td></td>
<td>• Recalibrate printer before large print jobs to avoid tag waste. See Note 3.</td>
</tr>
<tr>
<td></td>
<td>For the Cognitive Del Sol:</td>
</tr>
<tr>
<td></td>
<td>• Use Windows NT/2000 driver with XP (as of this document date, no XP driver was available).</td>
</tr>
<tr>
<td></td>
<td>• Changing tag stock size causes calibration variation; recommend sticking to one size or recalibrating before each print job.</td>
</tr>
<tr>
<td></td>
<td>• Unplug power to printer for several seconds to reset if calibration is ineffective.</td>
</tr>
<tr>
<td></td>
<td>• Compatible drivers for Windows Vista are not available at this time.</td>
</tr>
<tr>
<td>Zebra Tag Printer LP2844 USB</td>
<td></td>
</tr>
<tr>
<td>Zebra Tag Printer LP2824P</td>
<td></td>
</tr>
<tr>
<td>Cognitive Del Sol DD24</td>
<td></td>
</tr>
</tbody>
</table>

**Printer Notes**

- If using the Epson ADT driver, installing the Epson Status API driver module in addition will allow the cash drawer to open without feeding paper to the printer.
- When printing a large number of tags the print buffer may overflow, causing the error message “Error found while printing the document” and prompting to retry or cancel the job. Ignore this message! The message will disappear as the buffer catches up and all tags will print correctly. Printing fewer tags at one time will eliminate this message.

**Driver Notes**

Drivers for compatible equipment, current as of the testing date, are included on your Point of Sale program CD in the extras folder. Contact the equipment vendor to see if updated drivers are available.
Index

A

account mapping (QuickBooks) 524
accountant
  find a ProAdvisor 24
  sharing data with 16
account, customer
  account charges report 318
  applying payments in QuickBooks 507
  customer charges 400
  in-store charge accounts 316
  past due 319
active price 359, 663
activity logs
  Financial Exchange 494
  Store Exchange 575
activity tolerance 440
adding
  custom security groups 73
  customers 305
  data entry basics 86
  Data Import Wizard 124
  departments 156
  employees 56
  importing data from QuickBooks 118
  item styles 215
  items 164
  new records from lookup fields 90
  special order items 174
  store quantities 546
  vendors 254
  workstation licenses 10
address verification 386, 387, 626
address verification, credit card 389
adjusting prices 193, 196, 198
adjustments
  accessing memos 244
  auto-generated memos 246
  canceling or holding memos 247
  creating a memo 245
  for physical inventory 242
  history 248
  in multi-store 553
  listing items 91
  locating a memo 248
  memo fields 652
  memo types 244
  printing memos 250
  reversing memos 249
  sending to QuickBooks 506
  to inventory 243
Administrator, security 67
alternate lookups 166, 167, 647
assembly items 222, 223
  adding and building 223
  breaking 225
  build point 649
  editing 226
  in multi-store 549
  selling 353
ATM/debit cards
  payments 392
attribute 162, 647
  element attributes in Print Designer 605
automatic update
  preferences 637
available quantity 182
available/committed quantity 188
average unit cost 189, 288
AVS 389

B

backing up your data 76, 441
  automatic 78
  manual backups 79
  restoring from backup 81
  scheduled backups 79
  to an alternate location 78
backorder
  defining order status types 433
  sales order items 417
bank deposits
  in QuickBooks 493
bar code scanner
  list of compatible 681
  preferences 638
bar codes 46
  printing on tags 166
  scanning 90
  scanning physical inventory 241
billing information
  on receiving vouchers 503
vendors, entering 527
breaking assembly items 225
build point 649
buying
  additional Point of Sale licenses 10
  higher program level 6
  supplies from Intuit 42, 44

C

calibrating tag printer 43

canceling
  credit card payments 390
  receipt 333

card reader
  credit card sales 385
  debit/ATM sales 384
  list of compatible 682
  preferences 639


card verification codes 386

card verification, credit cards 389

case-to-unit 185

cash drawer
  list of compatible 682
  media counts 453
  opening 335
  pay-outs 336
  pay-outs, posting to QuickBooks 502
  preferences 638
  reconciliation 453

cash drawer (X/Z-Out) reports
  at End of Day 442
  overview 446

cash in drawer
  account mapping 514


cash in drawer account
  bank deposits 493
  catalog 164, 254

chain stores, see 'Pro Multi-Store'

change
  giving 376

changing
  password 71
  receipt price level 359
  tax code or location at time of sale 364

charge accounts 316
  see 'account, customer'

chart of accounts 488, 524

check payments 399
  'accept checks’ setting 660

class tracking, multi-store 541

client workstations
  merging licenses 10
  see also 'QuickStart Guide'

columns
  customizing 100, 586
  resizing 588
  sorting 100

combining items 178

commissions
  on receipts 371
  tracking 60

committed quantity 182

communication setup
  Merchant and Gift Services 627
  Store Exchange 564

company data
  backing up 76
  creating 15
  optimizing/Clean Up 17
  renaming 17
  working with 15

company preferences 620

e-mail documents 635

field labels 623

Financial Exchange 624

general 621
  in multi-store 536
  inventory 629

Merchant and Gift Services 626

multi-store 628

pricing 630

ratings & trends 635

receiving 631

sales 631

sales tax 634

company reports, multi-store 539

compatible equipment 681

compressing company data 17

Connection Wizard, QuickBooks 485

copy
  customer 306
  items 165
  receipt 349
  vouchers 296

correcting, see 'reversing'

cost
Index

adjustments 243
average unit cost 189, 288
decimal costs 87
in multi-store 547
in pricing formulas 159
item 189
margin and markup 191
on POs 271
order cost 271, 288
printing in code on tags 47
updating 288
counting inventory 232
creating, see 'adding'
credit card
  address verification 389
credit cards
  address verification 386, 626
cancel payment 390
card readers 682
card verification 386, 389, 626
fraud prevention 386
payment by 385
preferences 386, 626
QB POS Merchant Service support 24
QuickBooks POS Merchant Service 385
reports 457
reversing payment 390
sending merchant batch 442
setting up, see 'QuickStart Guide'
settling batches 391
voice authorizations 390
void payment 390
currency fields 87
custom fields
  defining 590
  employees 57
  inventory 148
  vendors 646
custom order items 95
Customer
  discounts 360
customer display, setup 639
customer letters 130
customer orders
  accessing 416
  basic procedures 419
copying 429
creating 419
deleting 431
deposit history 424
deposits, in QuickBooks 508
deposits, refunding 423
deposits, taking 422
editing 429
e-mailing 426
filling 426
generate PO from 424
in multi-store 539
information fields 665
listing items 91
locating 428
maintaining 428
overview 416
printing 435
reminders 145
reports 435
special order items 95, 420
tracking by status 430
typical usage 417
work orders 431
customer rewards
  redeeming 362
customers
  accessing 304
  account balances/limits 506
  account charges 400
  account payments 507
  adding 305
  charge accounts 316
  custom fields 590
deleting 309
  discounts and price levels 311
editing records 308
exchanging with QuickBooks 506
exporting 127
fields 660
ID cards/numbers 322
importing 124
in multi-store 537
labels, printing 50
listing on receipts 357
locating records 306
loyalty program 323
merge duplicates 310
name order sent to QuickBooks 530
overview 304
payments on account 507
printing records 321
purchase history 313
reports 321
rewards program 323
sales on account 316
sales tax 312
shipping address 305
shipping address on receipt 365
tracking by type 313
customizing
documents 593
field labels 623
Financial Exchange 520
item field labels 589
list columns 586
Navigator 584
Point of Sale 415, 497, 519, 545, 561, 581
remove features 621
toolbars 585
CVC, credit cards 389

D
Dashboard reports 475
data
backing up 441
entering and editing 86
protection 74
restoring from a backup 81
setting up security 54
data exchange
between stores 569
with QuickBooks 480
Data Export Wizard 127
Data Import Wizard 124
data protection 74
backing up 76
system and network 75
data recovery, QuickBooks 516
dates and times
entering 87
on reports 87
debit/ATM cards
about PIN pads 384
canceling or reversing sale 394
payments 385
preferences 392
QB POS Merchant Service support 24
QuickBooks POS Merchant Service 385
reports 457
settling batches 395
decimal costs 87
decimal quantities 87, 182
deleting
customer orders 431
customers 309
departments 158
employees 58
items 177
items from documents 97
items from styles 218
memorized reports 469
purchase orders 277
styles 218
vendors 258
departments
adding 156
creating 156
deleting 158
department codes 155
editing 157
fields 645, 652
locating records 157
overview 154
planning 154
printing 160
deposits
bank, in QuickBooks 493
on cash drawer (X/Z-Out) reports 455
on cash drawer (Z-Out) reports 446
on customer orders, history 424
on customer orders, refunding 423
on customer orders, taking 422
refunding 423
sending to QuickBooks 508
detailed posting to QuickBooks 520
discount pricing 205, 361
defining 207
deleting 209
editing 209
make inactive 209
Discounts
customer 360
discounts
customer rewards 362
customers 311
discount pricing 205
global discounts 361
item 360
Index

on POs 272
priority on sales 363
reports 460
vendor, on voucher 289
documents
customizing 593
deleting listed items 97
editing receipt items 97
history 34
holding 37
listing items 91
searching for 31
types 136
drawer count history 456
drivers, for hardware 684
duplicates
duplicate inventory items 178
duplicate inventory items in Pro Multi-Store 550
duplicate item reminders 142
merge customers 310
merge vendors 258
merging items 178
merging items in Multi-Store 551

purchase orders 273
Windows e-mail client 127, 128
employees
accessing 55
adding 55, 56
assigning security groups 71
commissions 60
custom fields 57, 590
deleting 58
edit 58
hours, sending to QuickBooks 511
hours, tracking 61
in multi-store 536
passwords, assigning 56
password, changing 71
print list 59
reports 59
sales commissions 371
security 54
security groups 71
working with 55
End of Day
backup company data 76
basic steps 441
cash drawer (X/Z-Out) reports 442
in multi-store 444
overview 440
QuickBooks Financial Exchange 443, 488
sending Merchant Service batch 442
equipment 681
compatible 681
drivers 684
notes 684
preferences 637
error messages 23
Financial Exchange, resolving 494
Store Exchange 575
exchanges, see 'returns'
export/import
Data Export Wizard 127
Data Import Wizard 124
export item pictures 129
exporting lists to Excel 127
exporting reports to Excel 465
import pictures for items 125
print templates 613
with QuickBooks 480

E
edit
assembly items 226
billing information, on vouchers 291
cost, item 138, 177, 190
customer order 429
customer records 308
departments 157
history documents 35
in lists 86, 103
items in inventory 176
items listed on documents 97
items on receipts 355
price levels 195
price, item 191
purchase order 277
quantity, item 138, 177
styles 217
vendors 256
vouchers 296
EFT reports 456
e-mailing documents
customer orders 426
preferences 635
Index

F
features
  removing 584
  why not available? 592
fees
  charging on sales 173
  on POs 272
  on vouchers 289
fields
  adjustment memos 652
  custom 590
  custom field labels 589, 623
  customer orders 665
  customers 660
  dates 87
  discount pricing, Price Manager 206
  entering data 86
  item 647
  lookup 90
  markdown, Price Manager 199
  purchase orders 655
  quantity 87
  read-only 86
  receipt 662
  suggested entries 87
  transfer slips 667
  vendor 654
  voucher 657
fill status
  customer orders 430
  purchase orders 275
filtering
  cash drawer (X/Z-Out) reports 448
  dates and times on reports 87
  defining criteria 108
  lists 106
  manage memorized 115
  on reports 108
  wildcards and masks 112
Financial Exchange
  see also 'QuickBooks Financial Exchange'
    activity log 494
    connection wizard 485
    customizing 520
    daily exchanges 488
    detailed posting 520
    Financial Center 484
    how POS data is posted 498
    in multi-store 541
    inactive items 522
    initiating 488
    mapping accounts 524
    mapping item accounts 525
    overview 480
    preparing QuickBooks 483
    receiving vouchers 503
    remote data sharing 486
    resolving errors 494
    verifying transactions 490
    viewing QuickBooks transactions 490
Financial History 34
find
  customer order 428
  customers 306
  items 175
  memos 248
  purchase order 273
Quick Find (items, customers, sales documents) 33
records or documents 31
vendor record 255
firewalls, configuring 669
font size 583
forms, working with 105
fraud prevention, credit card 386
freight
  on transfer slips 512, 558
  on vouchers 289
G
gift baskets 222
Gift Card Service
  checking card balances 397
  communication setup 627
  preferences 626
  reports 398, 458
  support 24
gift cards
  non-service 395
  redeeming 397
  selling/recharging 395
gift certificates, selling or redeeming 402
gift receipts 380
global discounts 361
gratuites 378
group items
  assemblies and groups 222
in multi-store 549
selling 353
using groups 227
groups, security 71

H

hardware 681
compatible 681
drivers 684
notes 684
preferences 637
Headquarters Store
choosing 535
definition 534
help
community message boards 23
ersors & troubleshooting 23
feature not available 592
find a ProAdvisor 24
in-program help 22
Merchant & Gift Card Services 24
support website 23
history
customer 313
customer purchases 313
documents 34
edit or reverse documents 35
inventory adjustments 248
item 146
receiving 295
sales 404
transfer 559
vendor 260
holding
documents 37
receipt in progress 333
un-holding held documents 37
vouchers 292

I

icon bars, see ’toolbars’
ID cards, customers 322
images
for items 170
for styles 221
importing 125
send to remote store 572
importing
non-QuickBooks data 124
pictures for items 125
print templates 51
QuickBooks data 118
vendor catalog 164, 254
IMS (Innovative Merchant Solutions) 385
inactive items, QuickBooks 522
information fields 643
Information Panel 103
Ingenico PIN pads 384, 640
initializing remote stores 569
Innovative Merchant Solutions 385
installing Point of Sale 7
Integrated Applications
list of 636
integrated applications in QuickBooks 444
Intuit
buying supplies from 42
community message boards 23
inventory/items
adding items 164
adjustments 243
alternate lookups 167
assembly 549
assembly items 222, 223
available/committed quantity 188
average unit cost 189
combining two items 178
copying items 165
cost and price 189
cost and quantities 138
custom fields 148, 590
customizing description labels 589
decimal quantities 182
deleting items 177
directory items 176
exporting 127
group items 222, 227
identifiers 166
importing 124, 164
    non-QuickBooks data 124
pictures 125
item basics 162
item fields 647
item history 146
item identifiers 166
item styles 212
item types 139
item views 140
list limit, QuickBooks 523
listing on documents 91
locating items 175
mapping item QuickBooks accounts 169
mapping QuickBooks item accounts 525
margins and markups 191
merge items 178
multiple item vendors 263
non-inventory items 173
numbers 166
numbers on tags in bar code 90
on receipts 350
order cost 189
overview 136
pictures 170, 221, 572
preferences 629
price levels 191, 193
Price Manager 196
price rounding 204
prices 191
prices, updating 289
print tags 43, 44, 151
Pro Multi-Store 546
receiving at new cost 288
reminders 142
reorder points 182, 267
reorder reminders 143
service items 173
set of items 222
special order items 95, 174
styles 212
taking a physical inventory 232
tax codes 168
total number of items 104
tracking quantities 182
transferring between stores 557
unorderable items 183
view quantities at other stores 546, 553
invoice/bill
entering 527
on receiving vouchers 291, 503
invoicing customers 316
items
see ‘inventory/items’

K
keyboard navigation and shortcuts 28
kits, assembly and group items 222
knowledge base 23

L
labels
  custom templates 611
customer 50
customize item field labels 589
ordering from Intuit 42
shipping 365
labor charges 173, 432
layaways
  see also ‘customer orders’
  basic procedures 419
  creating 419
  overview 416
  reports 435
  typical usage 417
layouts
  custom field labels 589
  custom fields 590
  customizing columns 100, 586
  reverting to default 588
Learning Center 18
letters
  printing letters 131
  writing letters 130
levels of Point of Sale 6
licensing
  buying additional licenses 10
  merging licenses 10
  synchronizing with Intuit 11
linked QuickBooks documents 34
linking QuickBooks accounts, see ‘mapping’
listing customers on documents 357
listing items on documents 91
lists
  columns 100
  customizing columns 586
  edit mode 86, 103
  filtering 106
  list summary 104
  searching 31
  sorting 100
  statistics 104
  working with 100
locating
  customer orders 428
  customers 306
  items 175
  purchase order 273
Quick Find (items, customers, sales documents) 33
saved receipts 404
log in/out 69
log in second user 70
preferences 68, 621, 637
requiring 68
logos
customizing on printed documents 602
printing on documents 591
logs
Financial Exchange 494
Store Exchange 575
lookup fields 90
loyalty rewards 362
loyalty, customer 323
M
magnetic stripe reader, see ‘card reader’
milabags
password security 564
manage saved reports 469
manager override 70
mapping
default QuickBooks mappings 513
exported data 127
imported data 124
payment types 515
QuickBooks accounts 524
QuickBooks sales taxes 529
margins and markups 191
in pricing formula 159
in pricing formulas 191
markdown price levels 311
marking down prices, see ‘Price Manager’
masks
in filters 112
media counts 453
memorizing
filters 115
report options 468
memos
see also ‘adjustments’
creating 245
sending to QuickBooks 506
merchandise returns
from customers 379, 407
to vendors 299
Merchant Service
see also ‘QuickBooks POS Merchant Service’
communication setup 627
preferences 626
reports 457
support 24
merge duplicates
customers 310
items 178
items (Pro Multi-Store) 550
vendors 258
merge, licenses 10
message boards 23
modem, preferences 638
modifying
column lists 100, 586
report options 466
mouse navigation 29
MSRP, on tags 47
multiple units of measure 185
multiple vendors
for items 263
on POs 263
on vouchers 293
multi-select 102
multi-store 534
see also ‘Pro Multi-Store’
allowed activities by store 542
communication methods 628
preferences 628
N
navigation 28
forms 105
keyboard shortcuts 28
lists 100
mouse & touchscreen 29
Navigator 26
Navigator 26
customizing 584
new item reminders 142, 144, 548
non-currency media 447
non-inventory items 173
non-tolerant activities 8
O
Office integration 124, 126
old price 199
open windows 26, 30
optimizing company data 17
order cost 189, 288
on POs 271
order documents 136
ordering supplies 42
override 70
Index

P

paid outs 447, 450
passwords
  changing own 71
  defining 56
  entering 69
payment terms
  exchanging with QuickBooks 527
  on POs 272
  on vouchers 291
  vendor 511
payment type mappings 515
payments
  by ATM/debit 392
  by check 399
  by credit card 385
  by gift card 397
  by gift certificate 402
  by or on customer account 400
  canceling credit card sales 390
  correcting 377
  deposits on customer orders 422
  giving change 376
  on receipts 372
  reports 456
  reversing 412
  split payment 375
pay-outs 336, 447
  from cash drawer 336
  posting to QuickBooks 502
petty cash pay-outs 336
photos
  for items 170
  for styles 221
  importing 125
  send to remote store 572
physical inventory
  apply changes 241
  basic steps 232
  entering counts 234
  in multi-store 554
  manually entering counts 235
  overview 232
  store count worksheet 233
  using a physical inventory scanner 237
physical inventory scanner
  list of compatible 683
  setup 640
  unrecognized scans 240
pictures
  for items 170

for styles 221
importing 125
send to remote store 572
PIN pads
  list of compatible 683
  setup 640
  using for debit/ATM sales 384
Point of Sale
  buying additional licenses 10
  community message boards 23
  customizing 415, 497, 519, 545, 561, 581, 582
  find a ProAdvisor 24
  getting help 22
  home page 26
  installing 7
  learning 18
  levels 6
  Merchant Service 24
  navigating 28
  practice 20
  removing features 584
  security 54
  unlock to higher level 11
pole display
  list of compatible 683
  setup 639
practice Point of Sale 20
preferences 582, 617
  ATM/debit 392
  automatic update 637
  company 620
  credit card 386
  equipment 637
  field labels 623
  Merchant & Gift Card Services 626, 627
  multi-store 628
  overview 618, 644
  pricing 630
  QuickBooks Financial Exchange 624
  remove features 621
  sales 631
  sales tax 634
  workstation 636
price change reminders 142
price changes, creating 199
price changes, editing 202
price changes, restore prices 204
price changes, viewing 201
price discounts, defining 207
price discounts, deleting 209
price discounts, editing 209
price levels 193
active price 359, 663
assign to customers 311
changing on sale 359
copying prices from/to 199
customer 312
old price 199
preferences 630
Price Manager
accessing 197
adjusting prices 198
copy prices between price levels 199
create price changes 199
define discounts 207
delete discounts 209
discert pricing 205
discert Pricing fields 206
diit discounts 209
diit price changes 202
manually entering markdowns 198
markdown fields 199
markdown prices 198
overview 196
print markdown tags 48
restore prices 204
rounding prices 204
view price changes 201
price tags 43, 44, 151, 279, 300
markdown tags 48
ordering from Intuit 44
styles supported 43
prices
active price 359, 663
company preferences 630
discount pricing 205
in multi-store 547
item 189, 191
margin and markup 191
markdowns 198
old price 199
price change reminders 144, 547
price levels 193
pricing formulas 159, 191
printing tags 43, 44, 151, 300
regular price 191
rounding 204
updating when costs change 193, 289
Print Designer
adding/removing elements 601
aligning elements 609
changing fonts 605
create a new template 599
custom tags and labels 611
default templates 598
element attributes 605
example text 600
field labels 605
footer spacing 597
hints and tips 611
import/export templates 613
item list/style grid properties 607
modifying a template 599
positioning an element 603
recommended sequence 600
resizing template sections 597
sizing an element 604
template elements 597
template sections 595
template spacing 596
print templates
importing 51
Printers
list 640
printers
list of compatible 683
tag, compatible 684
printing
customer labels 50
customer orders 435
define options 641
employee list 59
for other stores 48
general instructions 40
item list 151
label templates, customizing 611
letters 131
markdown price tags 48
purchase orders 278
receipts 380
records or documents 42
tag styles, supported 43
tag templates, customizing 611
tags 43, 44, 151
tags, from POs 279
tags, from voucher 300
tags, ordering from Intuit 44
Pro Multi-Store
activities by store 542
assembly and group items 549
choosing a Headquarters 535
company preferences 536
cost and prices 547
creating POs 555
customer orders 539
customers 537
employees and security  536
End of Day  444
Financial Exchange  541
initializing remote stores  569
inventory  546
new item reminders  548
overview  534
physical inventory  554
price changes  547
purchasing and receiving  554
quantities, adjusting  553
quantities, entering or viewing  546
receiving  555
recording sales  537
reports  539
resolving duplicate items  550
special order items  549
Store Exchange
  activity log  575
  methods  564
  overview  569
  receive mailbag  573
  send mailbags  569
  setup  628
store tracking by class  541
transfer history  559
transferring items  557
updating Point of Sale  540
view open PO list  546
viewing open POs  267
viewing other store quantities  553
ProAdvisor, finding  24
purchase history
  customers  313
  item  146
  vendors  260
purchase orders (PO)
  accessing  267
  creating  268
  deleting  277
  deleting listed items  271
  discounts and fees  272
  editing  277
  editing items  271
  e-mailing to vendors  273
  fields  655
  fill status  276
  for multiple vendor items  263
  generate from customer orders  424
  in multi-store  554
  listing items  91, 269
  locating  273
maintaining  273
order cost  271
overview  266, 267
PO list  273
printing  278
printing tags from  279
receiving against  284
receiving from  275
reorder points  267
special order items  95
Suggest POs  279
tracking by status  275
unorderable items  271
vendor payment terms  272
viewing open POs  267
purchasing
  see also ‘purchase orders’
  creating POs  268
  in multi-store  554
  receiving against PO  284
  reports  461
  vendor history  260
  vendors  254
  vendors, adding  254
purging company data  17

Q
QB Status field  490
quantities
  adjustments  243
  counting  232
  editing  138, 177
  entering decimal quantities  87
  tracking item  182
quantity
  available/committed  188
quantity discounts  205
Quick Find  33
QuickBooks
  see also ‘QuickBooks Financial Exchange’
  integrated applications  444
QuickBooks Financial Exchange
  activity log  494
  adjustment memos  506
  bank deposits  493
  cash drawer pay-outs  502
  class tracking by store  541
  connection wizard  485
  custom sales tax mappings  529
  customer accounts  316
  customer name order  530
customer order deposits 508
customers 506
customizing 520
daily exchanges 488
data shared 482
detailed posting 520
dependent time tracking 511
End of Day exchange 441, 488
entering vendor bills 291
Financial Center 484
importing QuickBooks data 118
in multi-store 541
inactive items 522
initiating 488
item account, defaults 524
item list limit, QuickBooks 523
linking accounts, see 'mapping'
mapping accounts 524
mapping item accounts 169, 525
overview 480
payments on account 507
posting POS transactions 498
preferences 624
preparing QuickBooks 483
QB Status field 490
receiving vouchers 503
recover QuickBooks 516
remote data sharing 486
resolving errors 494
reviewing imported data 122
sales & return receipts 498
summarized vs. detailed posting 520
transfer slips 512
vendor billing information 527
vendor payment terms 511
vendors 510
verifying transactions 490
viewing linked documents 34
viewing QuickBooks transactions 490
QuickBooks POS Gift Card Service
applying for 24
checking card balances 397
reports 398, 458
selling or redeeming cards 395
setup 626
QuickBooks POS Merchant Service
applying for 24
ATM/debit payments, taking 392
ATM/debit preferences 392
credit card payments, taking 385
credit card preferences 386
reports 457
sending merchant batch 441, 442
settling credit card card batches 391
setup 626
quotes, on sales orders 418
R
read-only fields 86
receipt
  editing 406
receipt printers
  list of compatible 683
  notes 683
ordering supplies from Intuit 42
receipts
  basic procedure, new receipt 348
  canceling and holding 333
  canceling credit card payments 390
  copying 349
  customer, listing 357
  customizing 593
  deleting receipt items 356
  discounts, customer 357
  discounts, discount pricing 205
  discounts, global 361
  discounts, item 360
  discounts, mixing 363
  editing listed items 97
  editing sales items 355
  fields 662
  gift receipts 380
  giving change 376
  in multi-store 537
  items on 350
  listing customer 357
  listing items 91
  locating saved 404
  overview 330
  payment by ATM/debit 392
  payment by check 399
  payment by credit card 385
  payment by gift card 397
  payment by gift certificate 402
  payment by or on account 400
  payments, correcting 377
  payments, split 375
  payment, recording 372
  pay-outs 336
  preferences 631
  printed messages 632
  printing 380
  returns and exchanges 379, 407
Index

reversing 411
  in multi-store 538
sales commissions 371
sales history 404
sales tax, changing on sale 364
sales tax, collecting 339
sales tax, configuring 342
saving 333
selling assembly/group items 353
sending to QuickBooks 498
serial numbers, recording 370
service and non-inventory items 352
shipping information 365
special order items 95, 353
receiving
  creating vouchers 283
  in multi-store 555
  items on a PO 284, 287
  preferences 631
  same item from multiple vendors 293
  vendor history 260
receiving history 295
  in multi-store 555
reconciliation
  cash drawer 453
  reports 456
records, searching for 31
recover QuickBooks 516
redeeming gift cards 397
refunding
  deposits on customer orders 423
  returns and exchanges 407
registering Point of Sale 9
reminders 142
  customer order items received 427
  duplicate items 550
  fill customer orders 145
  inventory 142
  new items 144, 548
  preferences 637
  price changes 144, 547
  reorder items 143, 182
remote data sharing, QuickBooks 486
remote store
  allowed activities 542
  definition 534
remove features 621
reorder points 182, 267
reorder reminders 142, 143
reports
  account charges 456
  cash drawer (X/Z-Out) reports 446
check payments 456
customer list 321
customer orders 435
Dashboard 475
debit/ATM card 457
employee list 59
employees 59
entering dates & times 87
filtering 108
Gift Card Service 398, 458
gift certificate payments 456
in multi-store 539
manage saved reports 469
memorizing 468
modify options 466
multi-store, by QuickBooks class 541
overview 460
payment reports 456
reconciliation 456
running 463
running multiple 470
sales 460
sales charts 471
sales tax 460
security 461
types 460
restoring data 81
restricting program access 54
return vouchers
  see also 'vouchers'
sending to QuickBooks 505
returns
  from customers 379, 407
  to vendors 299
reversing
  adjustment memos 249
  history documents 35
  receipts 411
    in multi-store 538
  transfer slips 560
  vouchers 297
rewards
  redeeming 362
Rewards Manager 323
rewards, customer 323
right-click menus 100
rounding prices 204

S

sales
  see also 'receipts'
Index

in multi-store 537
mapping QuickBooks item accounts 525
preferences 631
reports 460
returns and exchanges 379, 407
taking payments 373
sales charts/graphics 471
sales history 404
copy receipt 349
in multi-store 538
locating a receipt 404
reprinting receipts 380
reversing a receipt 411
sales orders
see also ‘customer orders’ 416
basic procedures 419
creating 419
overview 416
quotes 418
reports 435
special orders 417
typical usage 417
sales reports, cash drawer (X/Z-Outs) reports 446
sales tax
by customers 312
changing on sale 364
codes 340
collecting on sales 339
configuring 342
customer tax categories 312
locations 341
on receipts 364
on shipping amounts 339
preferences 634
price-dependant 343
QuickBooks mappings 529
reports 460
setting up 339
saved documents, history 34
scanning
bar codes 90
searching for records 31
security
add custom groups 73
assign custom group rights 72
employees 55
groups 71
in multi-store 536
log in/out 69
logging in second user 70
login requirements 68
manager override 70
overview 54
passwords 56
password, changing 71
preferences 621, 637
protecting your data 74
system administrator 67
select multiple records 102
selling
see also ‘receipts’
special order items 95
sending information between stores 569
see also ‘Store Exchange’
serial numbers
on vouchers 293
recording on sales 370
tracking 149
service items 173
on work orders 432
service jobs 418, 431
set of items 222
settling credit card transactions 442
setup
see ‘QuickStart Guide’
company preferences 620
workstation preferences 636
shipping information, on sales 365
Shipping Manager
shipping from receipt 367
shopper display, compatible 683
shortcuts, keyboard 28
slips, see also ‘transfers’ 557
special order items 95, 174
converting to inventory item 175
in multi-store 549
on receipts or customer orders 353
spreading costs 290
status
of purchase orders 275
of QuickBooks connection 484
of QuickBooks exchange 490
of work orders 433
tracking customer orders 430
store count worksheet for PI 233
store credit 316
Store Exchange
activity log 575
auto-recovery 576
communication methods 564
data sent 562
methods 564
overview 562, 569
password security 564
Index

preferences 628
receiving files 573
running 569
scheduling 577
sending files 569
sequence 444
Store Exchange Center 565
store P/L (profit/loss) reporting 541
store types
    activities by 542
    Headquarters and remote 534
stores, see 'Pro Multi-Store'
styless
    adding 215
    creating templates 219
    deleting items 218
    deleting styles 218
    editing 217
    editing templates 220
    grids 214
    templates 219
    working with 212
Suggest POs 279
suggested entry fields 87
summarized posting to QuickBooks 520
summary
    list summary 104
supplies
    ordering from Intuit 42, 44
support
    Merchant & Gift Card Services 24
    resources 22
synchronizing license 11
Sysadmin user 67

T

tag printers
    calibrating 43
    list of compatible 684
    notes 684
tags
    bar codes 46
    custom templates 611
    markdown tags 48
    ordering from Intuit 44
    price tag code 630
    printing 43, 44, 151
    printing cost in code 47
    printing from POs 279
    printing from vouchers 300
    printing MSRP 47
    printing the MSRP 47
    tag styles, supported 43
tax
    see 'sales tax'
tax codes
    assigning to items 168
technical support
    error messages 23
    message boards 23
    ProAdvisor 24
templates
    importing print templates 51
    modifying for documents 599
    style 219
tendering receipts 372
terms
    vendor payment terms 260
    vendors, exchange with QuickBooks 511
    vendor, on POs 272
    vendor, on vouchers 291
Time Clock 61
time entries 89
tips 378
toolbars, customizing 585
tools
    Data Export Wizard 127
    Data Import Wizard 124
    Store Exchange 569
    user information 8
touchscreen 86
    enable 639
    navigation 29
tracking, customers 304
transactional documents 136
    see also 'history'
transfers
    accessing transfer slips 558
    creating transfer slips 558
    fields, transfer slip 667
    history 559
    listing items in transfer slips 91
    overview 557
    reversing transfer slips 560
    sending to QuickBooks 512
    troubleshooting 23

U

unbilled purchases 490
un-holding held documents 37
unit cost
    average unit cost 189, 288
Index

unit of measure 629, 649
  multiple units of measure 185
unlock to higher level 11
unordered items 183, 271
UPC codes 166, 650
  scanning UPcs 90
updates and upgrades
  multi-store 540
  unlock to higher level 11
updating
  apply changes to physical inventory 241
  costs 288
  markdowns
  prices 193, 289
user information 8

V

vendors
  accessing your vendor list 254
  adding 254
  billing information, entering 527
  catalog, importing 164, 254
  creating a PO for 268
  custom fields 590
  deleting 258
  editing 256
  exchanging with QuickBooks 510
  exporting 127
  fields 654
  history 260
  importing 124
  locating record 255
  making inactive 257
  merge duplicates 258
  multiple for item 263, 293
  overview 254
  payment terms 260
  payment terms, on POs 272
  payment terms, on vouchers 291
  returns to 299
  voice authorizations, credit cards 390
voiding
  credit card payment 390
  gift card payments 379, 407
vouchers
  copy 296
  costs and prices 288
  creating 283
  editing 296
  editing items 287
  entering billing information 527
fields 657
freight, fees, discounts 289
holding/un-holding 292
invoice/bill, vendor 503
items 287
listing items 91
overview 282
printing 300
printing tags from 300
receiving history 295
referencing a PO 287
reversing 297
saving 294
sending to QuickBooks 503
spreading costs 290
updating inventory 294
vendor billing information 291

W

warranty service, on work orders 432
Windows e-mail client 127, 128
work orders
  see also 'customer orders' 416
  assigning to employees 433
  basic procedures 419
  creating 419
  overview 416
  printed message 434
  tracking the status of 433
  typical usage 418
  using 431
  using service items 432
  warranty service 432
workstation preferences 636
  automatic update 637
  equipment 637
  general 637
  print options 641
writing letters 130

X

X for Y pricing 205
X/Z-Out reports 446
  at End of Day 442
  basic steps 447
  options and filters 448
  overview 446
  POS actions 449
  store close 441
terminal 447
Index

Z

Zip Codes
  filtering by  111
Z-Out reports  446, 450
  see also 'X/Z-Out reports'
  basic steps  447
  cash drawer reconciliation  453
  drawer count history  456
  media counts  453
  types  450